Some examples and graphics depicted herein are provided for illustration only. No real association or connection to ServiceNow products or services is intended or should be inferred.

If you have comments about this documentation, submit your feedback to:

docfeedback@servicenow.com

Company Headquarters
2225 Lawson Lane
Santa Clara, CA 95054
United States
(408)501-8550
# Table of Contents

Helsinki Release Notes.................................................................5  
Features and changes by product..............................................5  
   IT Service Management release notes.................................6  
   IT Operations Management release notes.........................13  
   Business Management release notes.................................22  
   Application Development release notes.............................31  
   ServiceNow Platform release notes.....................................32  
   Service Management release notes.....................................54  
   Security Operations release notes.....................................62  
   Performance Analytics and Reporting release notes.............65  
Available versions (Helsinki).....................................................73  
   Helsinki Patch 12 Hot Fix 1...............................................76  
   Helsinki Patch 12.............................................................77  
   Helsinki Patch 11b Hot Fix 1..............................................90  
   Helsinki Patch 11.............................................................91  
   Helsinki Patch 10...........................................................106  
   Helsinki Patch 9 Hot Fix 5a.................................................143  
   Helsinki Patch 9 Hot Fix 4a.................................................144  
   Helsinki Patch 9 Hot Fix 3a.................................................145  
   Helsinki Patch 9 Hot Fix 2a.................................................146  
   Helsinki Patch 9 Hot Fix 1a.................................................148  
   Helsinki Patch 9a..............................................................149  
   Helsinki Patch 9.............................................................151  
   Helsinki Patch 8 Hot Fix 1..................................................173  
   Helsinki Patch 8.............................................................174  
   Helsinki Patch 7 Hot Fix 5..................................................185  
   Helsinki Patch 7 Hot Fix 4..................................................186  
   Helsinki Patch 7 Hot Fix 3..................................................188  
   Helsinki Patch 7 Hot Fix 2..................................................189  
   Helsinki Patch 7.............................................................190  
   Helsinki Patch 6 Hot Fix 3..................................................209  
   Helsinki Patch 6 Hot Fix 1..................................................211  
   Helsinki Patch 6.............................................................212  
   Helsinki Patch 5 Hot Fix 3..................................................241  
   Helsinki Patch 5 Hot Fix 1..................................................242  
   Helsinki Patch 5.............................................................243  
   Helsinki Patch 4 Hot Fix 5..................................................284  
   Helsinki Patch 4 Hot Fix 4..................................................285  
   Helsinki Patch 4 Hot Fix 3..................................................286  
   Helsinki Patch 4 Hot Fix 2..................................................287  
   Helsinki Patch 4 Hot Fix 1..................................................288  
   Helsinki Patch 4.............................................................290  
   Helsinki Patch 3 Hot Fix 13...............................................333  
   Helsinki Patch 3 Hot Fix 11...............................................334  
   Helsinki Patch 3 Hot Fix 10...............................................336  
   Helsinki Patch 3 Hot Fix 6...............................................337  
   Helsinki Patch 3 Hot Fix 5...............................................340  
   Helsinki Patch 3 Hot Fix 2...............................................342  
   Helsinki Patch 3.............................................................343  
   Helsinki Patch 2 Hot Fix 6...............................................393
Helsinki Release Notes

The Helsinki release contains new functionality and fixes to existing functionality. Patch releases and hotfixes provide problem fixes and are released on an as-needed schedule.

Path to successful upgrades

Learn - Find out what’s new and changed in Helsinki

Prepare - Choose your target version and prepare for your upgrade

Upgrade - Review the upgrade process and upgrade your instance

- Features and changes by product
- Browser support
- Accessibility 508 compliance

- Available versions (Helsinki)
- Upgrade and migration tasks by application or feature

- Upgrade to Helsinki
- Upgrade your instance
- Upgrade planning checklist (Helsinki)

Features and changes by product

Review the new features and changes in this release by product.
New features and products in Helsinki

The Helsinki release includes new features and products.

- Normalization Data Services release notes
- Service Portal release notes

Updated features and products

Other products were changed and updated in the Helsinki release. For more information, refer to the release notes topics, which are organized by product area.

IT Service Management release notes

IT Service Management has new and updated features in the Helsinki release.

Asset Management release notes

ServiceNow® Asset Management application enhancements and updates in the Helsinki release.

Activation information

Active by default.

New in the Helsinki release

**Asset-CI mapping and synchronization**

Synchronize asset records and CI records by mapping their fields, states, and statuses to each other. Changes made to one record trigger the same updates on the corresponding record, ensuring consistent reporting. You can synchronize default and custom mappings.

You can create the following mappings:

- Asset and CI fields. For this mapping, synchronization happens both ways. Changes to the asset or CI record are updated to the logically mapped record.
- Asset State and Substate fields to the CI Hardware Status and Substatus fields. The Hardware Status field is visible only for hardware CIs. When you create the mapping, you can set the synchronization direction from the asset, CI, or both.
- Asset State and Substate fields to the CI Install Status field. The CI Install Status field does not have a Substatus field and must be used for CIs other than hardware. When you create
ServiceNow Helsinki Helsinki Release Notes

the mapping, you can set the synchronization direction from the asset, CI, or both.

**Salvage value and expenditure type for hardware models**

For a hardware model, salvage value and expenditure type (Capex or Opex) attributes are added.

**Activity updates for assets**

The Activities tab of an asset is updated if:

- Changes are made to the Assigned to, Managed by, Reserved for, State, or Substate fields of the asset.
- The asset is a hardware asset or a software asset, and it is created or updated by a purchase order.
- The asset is a hardware asset and a transfer order associated to it enters the Initiated, Cancelled, or Received stage.

Change Management release notes

ServiceNow® Change Management application enhancements and updates in the Helsinki release.

Helsinki upgrade information

For information about determining which plugins to activate when upgrading from the Geneva release, see [Upgrade Change Management](#).

Activation information

Active by default.

New in the Helsinki release

**Mass updates to CIs**

To enable mass updates to a set of CIs for a specific class, activate the Change Management - Mass Update CI plugin (com.snc.change_management.mass_update_ci).

⚠️ **Warning:** Before you activate the Change Management - Mass Update CI plugin, make sure the [Change Management State Model](#) is already activated. If not, the existing state model and change types are replaced, which can have severe consequences.

The Change Management - Mass Update CI plugin is not activated by default for new or upgraded instances.
Changed in this release

• If the Change Management - Mass Update CI plugin is activated, the Bulk CI Update, CI Class, and Proposed Changes fields can be restricted to only Normal and Emergency changes under the current change types. Under the legacy change types, these fields can be restricted to only Comprehensive and Emergency change types.

  Note: These fields are unavailable for the current Standard change type and the legacy Routine change type.

• Conflict detection can be manually canceled from the change request.
• Affected CIs can be added to the Affected CIs related list only in the New state.

Incident Management release notes

ServiceNow® Incident Management application enhancements and updates in the Helsinki release.

Activation information

Active by default.

New in the Helsinki release

Incident Management state model

An incident state model that matches best practices. It provides the following incident states by default:

• New
• In Progress
• On Hold
• Resolved
• Closed
• Canceled

The On Hold state has the following reasons associated with it:

• Awaiting Caller
• Awaiting Evidence
• Awaiting Problem Resolution
• Awaiting Vendor

Note: While this new state model is available by default for new instances, it is not available on upgrade. Refer to KB0564465 for further details.
Changed in this release

• Incident notification email templates are updated with improved formatting.
• The Impact field was removed from the Create Incident record producer. The Impact field was removed because it is not best practice to ask self-service users to determine the impact of an incident. Instead, self-service users can specify the urgency of an incident in the Urgency field.

  Note: This change is available by default for new instances. It is not available for upgraded instances.

• The default list view of an incident, except a closed one, has been updated to the following order:
  • Number
  • Opened
  • Short Description
  • Caller
  • Priority
  • State
  • Category
  • Assignment Group
  • Assignee
  • Updated
  • Updated by

  Note: The updated list view is available by default for new instances. It is not available for upgraded instances.

On-Call Scheduling release notes

ServiceNow® On-Call Scheduling application enhancements and updates in the Helsinki release.

Activation information

You can activate the On-Call Scheduling (com.snc.on_call_rotation) plugin if you have the admin role.

Browser requirements

The updated calendar view is available on only Internet Explorer 10 or later. Any older versions of Internet Explorer display the legacy calendar view.

New in the Helsinki release

- **On-call calendar view**

  A new on-call calendar view replaces the legacy view. It provides an on-call manager with daily, weekly, and monthly views of the selected rotation and roster schedules.

  The new on-call calendar view is enabled by default for instances that are upgrading from any previous release. To
On-call properties
The following properties have been introduced:

- com.snc.on_call_rotation.log.level
- com.snc.on_call_rotation.show_legacy_calendar

Note: Set to true to see the legacy calendar.

- com.snc.on_call_rotation.cover.color
- com.snc.on_call_rotation.timeoff.color
- com.snc.on_call_rotation.contrast

Procurement release notes
ServiceNow® Procurement application enhancements and updates in the Helsinki release.

Activation information
You can activate the Procurement plugin that provides core procurement capabilities.

New in the Helsinki release

Enter asset details and reserve them when you receive the purchase order
You can enter details for hardware and software assets when you receive the assets. At the same time, you can also reserve hardware assets.

Create assignments for software items when you source the request
When you source software assets, you can assign the rights of the software license to users or devices.

Changed in this release

- You can create only hardware assets before sourcing. See Create an asset and reserve it for the requester.

Service Catalog release notes
ServiceNow® Service Catalog application enhancements and updates in the Helsinki release.

Activation information
Active by default.
New in the Helsinki release

**Multi-catalog management**
Catalog ownership has been implemented using the catalog_admin and catalog_editor roles. The catalog administrator defines managers and editors.

**Diagnostic and debugging utilities**
A diagnostic related link has been added to catalog items to show the health of the item. Debugging of catalog UI policies has also been added.

**Additional REST and scoped APIs**
Additional Service Catalog APIs have been added for debugging. REST responses can be monitored for troubleshooting.

Changed in this release

- **Order guide enhancements**: Support for mapping order guide variables with items has been added. The two-step checkout process has been improved to order only items added by the order guide. A three-step order guide checkout process has also been added.
- **Shopping cart improvements**: The shopping cart has been enhanced to include a single consolidated order button instead of multiple order button options.
- **Variable improvements**: Support for a reference qualifier has been added to the List Collector variable to limit records. Support for glide list UI has also been added to the List Collector variable.
- **List v3**: Service Catalog currently does not support List v3.

Service Level Management release notes

ServiceNow® Service Level Management application enhancements and updates in the Helsinki release.

Activation information

Active by default.

New in the Helsinki release

**Cancel and Resume SLA conditions**
The resume and cancel conditions can be specified in the SLA definition. These conditions are also reflected in the SLA timeline.

**Retroactive pause field in SLA definition**
The retroactive pause for an SLA can be specified in the start condition of an SLA definition.

**Schedule source and Timezone source fields in SLA definition**
The schedule source and time zone source can be specified in the SLA definition.

Changed in this release

- The following SLA Engine properties have been removed:
• com.snc.sla.schedule.source
• com.snc.sla.timezone.source
• com.snc.sla.retroactive_pause

• If you are on the 2010 SLA engine, you cannot view the Retroactive pause field.
• The SLA properties you can view are based on the SLA engine that you are using.
  For example, if you are on the 2011 SLA engine, then you can view only SLA 2011 properties.
  You cannot view SLA 2010 properties such as Compatibility Breach.

Subscription Management release notes
ServiceNow® Subscription Management application enhancements and updates in the Helsinki release.

Activation information
Active by default.

New in the Helsinki release

Subscription enforcement for ServiceNow Store apps
By default, the system monitors and reports on usage of subscription applications and suites but does not block users who are not subscribed. If a developer enables subscription enforcement for a ServiceNow Store app, then users who are not subscribed are blocked from performing fulfiller actions in the app.

Flexible method for allocating users to per-user subscriptions: User sets
In earlier releases, you allocated users either by role or by group. The method could become complex and is no longer used. In this release, you can allocate users using either or both of the following methods:

• Allocate users individually.
• Add user sets to the subscription. A user set is a pool of users that you define. For example, all fulfiller users from the IT department. When you add a user set to a subscription for a ServiceNow application or application suite, all users in the set are subscribed.

After you allocate users to the subscription, you can add or remove user sets and individual users as needed. In addition, you can exclude an individual user to ensure that the user is not subscribed.

If you allocated users to a subscription in an earlier release, the subscribed users are auto-migrated to new user sets.
Overview of the auto-migration process

Note: This section applies only if you used the Subscription Management application in an earlier release.

Because the application now manages allocation to subscriptions with user sets instead of roles and groups, the system auto-migrates subscribed users from earlier releases into user sets. The system performs the following process when you upgrade:

1. Create a user set for each role that contained the subscription role. Use the following Name for each user set: Users with roles that contained <RoleName> subscription role
2. Create a user set for each group that contained the subscription role. Use the following Name for each user set: Users in groups that contained <GroupName> subscription role
3. Add the new user sets to the appropriate subscription.
4. If any users are set to the Pending state, allocate the users individually.
5. Activate the Auto-sync user sets option for the subscription to periodically update all user sets to reflect updates in users and groups.

IT Operations Management release notes

IT Operations Management has new and updated features in the Helsinki release.

Cloud Management release notes

ServiceNow® Cloud Management application enhancements and updates in the Helsinki release.

Activation information

Cloud Management requires a separate subscription and must be activated by ServiceNow personnel.

New in the Helsinki release

- **Amazon Web Services (AWS) Config integration**
  Real-time events from cloud providers can be received so that changes are reflected immediately instead of waiting for the next discovery. Cloud users can view updates to cloud resources as they occur.

- **Combined cost and usage reports**
  Cost and usage reports include all providers. Reports can also be enhanced with the Performance Analytics Content Pack for Cloud Management plugin.

- **Addition of Microsoft Azure generic VM catalog item**
  A sample VM catalog item using the ARM template (Azure VM instance – Advanced) has been added.

- **Discovery reconciliation**
  If a Microsoft Azure or AWS resource is removed outside of the instance and cannot be discovered, its state is marked empty. It is automatically
Changed in this release

• VMware vCenter integrated into Discovery framework: A discovery schedule and on-demand discovery are supported for VMware vCenter.
• Microsoft Azure and VMware vCenter underutilized resource reports: Metrics are generated hourly and used to calculate the daily average utilization (a cost is associated with data storage). Diagnostics must be enabled on the Azure Portal only.
• AWS enhanced generic EC2 catalog item: The AWS generic EC2 catalog item has been enhanced.
• AWS tagging integrated into generic tagging framework: AWS tagging has been enhanced to display keys and values. However, previous tags with sys_ids are still supported.
• Microsoft Azure discovery integrated into Discovery: Microsoft Azure installation is unnecessary for discovery through Discovery.

Credentials release notes

Credentials product enhancements and updates in the Helsinki release.

Credentials, such as user names and passwords, or certificates, are required to gain access to a computer or network device for ServiceNow Discovery or to perform work on a computer using Orchestration.

New in the Helsinki release

**External storage for basic auth credentials**

Basic auth credentials support external credential storage. Currently the only external credential storage system integrated with the ServiceNow® platform is the CyberArk vault.

**Testing credentials**

Test your credentials directly from the Credentials record without launching a Discovery or an Orchestration workflow. You can test the credentials before saving them for all credential types except Amazon Web Services. If the instance cannot connect to the specified target, the system displays an informative error message.

Discovery release notes

ServiceNow® Discovery application enhancements and updates in the Helsinki release.

Activation information

Discovery is available as a separate subscription from the rest of the ServiceNow platform and requires the Discovery plugin. To purchase a subscription, contact your ServiceNow account manager or sales representative.
New in the Helsinki release

**Managing virtual machines removed from VMware vCenter**

When a VMware vCenter CI, such as a virtual machine, is removed on vCenter, the ServiceNow instance marks it as “stale” in the CMDB, either by running Discovery or by collecting vCenter events.

**Discovery domain separation**

All configuration item (CI) data collected by Discovery is domain separated, as well as data from other, selected tables.

**Pattern designer for Discovery**

The pattern designer creates sequences of commands that Discovery uses to discover devices and applications. The pattern designer replaces the probes and sensors of the current Discovery logic and includes a robust tool for debugging patterns. The Discovery application comes with a set of preconfigured patterns that cover most of the commonly used devices and applications.

**Relationship between an Amazon Web Services (AWS) EC2 instance and the host CI**

Discovery creates a Virtualized by::Virtualized relationship between the cmdb_ci_ec2_instance record and a Windows or Linux host after Discovery runs on the host.

**DNS name resolution for F5 BIG-IP Global Traffic Manager (GTM)**

Discovery can resolve the DNS name of the F5 GTM hardware and the DNS names of all the servers associated with the load balancer that receive distributed traffic.

**SNMP probe parameter**

An SNMP probe parameter enables the use of simplified retrieval and handling of scalar values from SNMP devices.

**Discovery quick start**

The Discovery quick start is an optional guided process for configuring the MID Server, creating credentials, and scheduling a simple discovery.

**MAC address verification**

A system property called glide.discovery.enable_mac_address_verification prevents Discovery from generating incorrect device information when the IP address of a device changes during Discovery. The system passes the MAC address of each device being discovered to the MID Server to determine if the IP address for that device has changed.

Changed in this release

- **Application Profile Discovery (APD)** is deprecated. Instances upgraded from a previous release can continue to use APD, but the feature is not available for new instances.
- Identification of VM instances, templates, and virtual machines in vCenter has changed. In addition to improvements to mapping VM instance and templates to virtual machines, Discovery identifies VM
instances and templates using the vCenter Instance UUID + the VM Instance UUID. These elements were identified formerly using only the correlation ID, which was merely the BIOS UUID in a different format. In certain circumstances, this method resulted in duplicate CIs. For details, see the Multiple VM instances or VM templates can be mapped to the same configuration item (CI) record [KB0565052] article in the HI Knowledge Base.

- The Discovery of VMware Workstation is no longer supported.

Event Management and Service Analytics release notes

Enhancements and updates to ServiceNow® Event Management and ServiceNow® Service Analytics applications in the Helsinki release.

Event Management helps you identify health issues across the datacenter on a single management console.

Service Analytics enhances Event Management by providing alert data analysis and reports. Service Analytics provides alert aggregation and root cause analysis (RCA) for discovered business services.

Activation information

The Event Management plugin (com.glideapp.itom.snac) requires a separate subscription and must be activated by ServiceNow personnel. This plugin includes demo data and activates related plugins if they are not already active.

The Service Analytics plugin does not require a subscription but it must be activated by ServiceNow personnel. This plugin includes demo data. Request the Service Analytics plugin through the HI Customer Service System. The Event Management plugin must be activated before the Service Analytics plugin can be activated.

New in the Helsinki release

- **Bi-directional integration with third-party monitoring tools**

  Your instance can update alerts in the source from where the alert was derived. There is default implementation for SCOM.

- **JavaScript replaces Apache Groovy**

  You can write connectors in JavaScript. Apache Groovy is supported for existing connectors but deprecated for new connectors.

- **Additional default connectors**

  Integration with VMware vRealize Hyperic and VMware vRealize Operations connectors is provided by default.

- **Alert correlation**

  You can configure correlation rules to determine which alerts are related, based on the CI that triggered the alert. The alert console displays only a designated primary alert among a set of correlated alerts, helping you locate the root of the problem that caused the alert.

- **SLAs for business services and CIs**

  You can create SLAs for business services and CIs based on alert severity. SLAs help you
measure how well your organization resolves conditions that trigger alerts.

**CI maintenance and alerts**

If a change request is scheduled for a CI or the CI is in maintenance mode, alerts for that CI do not show in the alert console. You can also manually place an alert into maintenance mode.

**RCA configurations**

Service Analytics provides pre-defined RCA configurations. You can also create a custom RCA configuration to define which alerts are included in RCA. Apply two RCA configurations to real historical data so you can compare the analysis and decide which configuration is most optimal and deploy it.

**CMDB property to be used for grouping the alerts used in alert aggregation**

The sa_analytics.agg.learner_group_by_property property for Service Analytics enables the Alert Aggregation Learner to group alerts by a specified property and learn the alerts according to the grouping. Patterns can then be learned for a group, such as by datacenter.

**Service Analytics reports**

- **Value report**, which consists of the following reports:
  - Alert Group Compression: Calculations of effectiveness of alert aggregation.
  - Alert Group Feedback: Summary of feedback to correlated alert groups.
  - Alert Coverage: Summary of numbers and percentage of alerts aggregated into correlated alert group.

- **RCA Config Comparison Report**: Compares the results of two RCA configurations that were used to analyze actual historical data. After comparing the results, you can decide which configuration is the optimal one for your environment and deploy it.

- **Learned Patterns Report**: Metrics for RCA learned patterns that you can sort by frequency of CI/MetricName pair, number of times that a CI/MetricName pair appears in a learned pattern, and calculated score for a learned pattern.

**Domain separation**

Support for domain separation in RCA and alert aggregation in Service Analytics.

**Changed in this release**

- Remote incident (task) integration. Event Management generated tasks, such as incidents and change requests, can be managed on Service Analytics remote instances or also on third-party remote incident management tools. You can set URLs and credentials for remote incident creation.
in the properties record. You can use a predefined configuration to work with a remote ServiceNow instance.

- Improved maintenance lookup. Approved change records can be selected to determine the maintenance status of an alert
- The sa_analytics.rca_enabled property must be set to True to enable Service Analytics RCA.
- In Service Analytics, you can add or remove alerts from correlated alert groups to make them more accurate and complete.
- The correlated alert group name in Service Analytics was changed to include the metric name of the alert with highest severity in the group.
- You can view or create an incident directly from a correlated alert group list view in Service Analytics.

**MID Server release notes**

ServiceNow® MID Server enhancements and updates in the Helsinki release.

**Helsinki upgrade information**

- To ensure that your MID Servers can upgrade successfully, run a series of manual tests for free disk space, access to the download server, and file permissions on the MID Server host. For details, see [Test the MID Server before an upgrade](#).

  **Important:** After all MID Servers have been upgraded to Geneva or higher, complete the post-upgrade steps listed in the Workaround section of [KB0597396](#).

- The MID Server application is downloadable from the ServiceNow service instance. The MID Server is upgraded automatically when you upgrade the instance. However, you can configure the version number to control MID Server upgrades. The MID Server is configured to check with the ServiceNow instance hourly to determine whether it needs to upgrade. This configurable behavior allows the MID Server to upgrade automatically when the instance upgrades.
- In Helsinki, the MID Server can run SSH commands using either the J2SSH client or the proprietary ServiceNow® SNCSSH client. When you upgrade from Dublin or earlier, the MID Server property that controls the SSH client selection is not active in your upgraded instance, and the MID Server will use the J2SSH client by default. To enable the SNCSSH client, you must add the mid.property.ssh.use_snc MID Server property and set it to true. Instances upgraded from Eureka or later have the SNCSSH client enabled by default, and no configuration is required. For details, see [MID Server properties](#).

**New in the Helsinki release**

- **MID Server long polling**
  Instead of querying the ECC Queue every 5 seconds, the MID Server subscribes to messages published by the Asynchronous Message Bus (AMB), which notifies the MID Server that there is work waiting for it in the queue.

- **MID Server domain separation enhancements:**
  - All [MID Server artifacts](#) are domain separated.
• Administrators can create versions of specific **MID Server policies** that only MID Servers in a specific domain can use.

**Sudo support for ServiceNow SSH**

ServiceNow SSH supports the use of sudo as root in long-running scripts. When properly configured, SSH can be run with sudo against individual commands within a probe to prevent long running commands from failing when the MID Server disconnects.

**Changed in this release**

- The **VMware vCenter event collector** was expanded to support additional events by default and allow users to subscribe to new events easily. These changes let the CMDB reflect the current state without having to wait for the next full vCenter discovery to run.

**Orchestration release notes**

ServiceNow® Orchestration application enhancements and updates in the Helsinki release.

**Activation information**

The Orchestration (com.snc.runbook_automation) plugin is available as a separate subscription from the rest of the ServiceNow platform. To purchase a subscription, contact your ServiceNow account manager. The account manager arranges the plugin activation on your production and sub-production instances, generally within a few days.

**New in the Helsinki release**

**Microsoft Azure activity pack**

*Azure AD activities* add or remove users to Azure Active Directory, manage security group membership, and assign or remove Office 365 licenses for individual users.

**Workday activity pack**

*Workday activities* can change employee information in Workday and gather information from Workday to update ServiceNow records or pass data to other external systems. A workflow is included that updates or creates a ServiceNow sys_user record and creates an Active Directory account.

**Active Directory activity**

*Remove User from Group* activity removes a user from a group in Windows Active Directory.

**External credential storage for activity designer templates**

*REST, SOAP,* and *JDBC* activity templates were updated to use credentials stored on the Credentials [discovery_credentials] table. As a result, activities created with these templates
can use external credential storage systems for authentication.

Client Software Distribution enhancements

- Entitled users can order software from the service catalog on behalf of another user.
- Administrators can revoke unentitled software installations through SCCM if the software is a member of an SCCM collection.
- Extension points in CSD allow customers to implement their own software deployment process from providers such as Casper, Altiris, or LANDesk. Advanced configuration procedures are provided in separate documentation that is intended for developer use only.

Activity designer input testing enhancements

- The input testing feature in the Orchestration activity designer provides filtering capabilities for the variables list.
- You can display different variable views, reset values to their defaults, and clear all test values.
- Reopen the test form from a parsing rule, substitute different test values, and create a different payload.
- Copy the entire payload to the parsing rules.

Encryption support for the activity designer

You can protect sensitive data passed from Orchestration activities by encrypting input and output variables in activity designer templates. A data type of Encrypted was added to the designer template to allow encryption of input variables. When an output variable is encrypted in the template, the input payload of the corresponding ECC Queue is encrypted. Output variables passed to a downstream activity as input variables maintain their encryption throughout processing.

Auto-mapping of REST activity output variables

The ServiceNow activity designer lets you map parameter values in a REST test payload to variables in the Outputs stage automatically.

Basic authentication credentials for SOAP and REST activities

The Credentials [discovery_credentials] table supports Basic Authentication credentials which can be used to override SOAP or REST message credentials in activity designer templates.

Changed in the Helsinki release

- JDBC data sources are replaced in activity templates with JDBC credentials from the Credentials [discovery_credentials] table. A table called JDBC Connection [jdbc_connection] contains the credential strings that custom JDBC Orchestration activities must connect to various target
databases. The Helsinki upgrade process replaces the JDBC data sources with the new JDBC connections. Existing JDBC custom activities are converted to use the new connections and credential records.

- The **SOAP Request activity** is deprecated and unavailable for all new workflows. Workflows from a previous version that use SOAP Request can continue to do so. To call a SOAP message in a new workflow, the best practice is to create a custom activity using the [SOAP activity designer template](https://service-now.com).

- The **Run Command** activity is deprecated and unavailable for all new workflows. Workflows from a previous version that use Run Command can continue to do so. To use this functionality in a new workflow, create a custom activity using the [SSH provider template](https://service-now.com) in the activity designer.

- The **Run Probe** activity is deprecated and unavailable for all new workflows. Workflows from a previous version that use Run Probe can continue to do so. To use this functionality in a new workflow, create a custom activity using the [Probe template](https://service-now.com) in the activity designer.

- A category in the Workflow Editor called **Orchestration - Deprecated** contains non-scoped activities that are allowed in new workflows, but discouraged.

- Activity designer tabs were replaced with a **stage indicator**. Click-able stages at the top of the activity designer form indicate the current stage of the activity with a blue underscore. Designers can move in either direction through the stages.

### Password Reset release notes

ServiceNow® Password Reset application enhancements and updates in the Helsinki release.

#### Activation information

**Note:** The Password Reset application is not available during upgrade.

Password Reset is available as a separate subscription from the rest of the ServiceNow platform and requires the Password Reset plugin. The plugin activates related plugins if they are not already active and includes example verifications. For more information, contact your ServiceNow account representative.

### New in the Helsinki release

- **Optional verifications for self-service password reset**

  You can specify that a particular type of verification is required or is not required for a user set. Use the Apply to all users setting on the Process form.

- **Strengthened verification with required verification count**

  You can require users to perform a minimum number of verifications when attempting to reset a password. Use the Number of security questions required during the password reset request property setting. See [Set Password Reset properties](https://service-now.com).

- **More flexible and capable SMS verification option**

  Use NotifyNow to send SMS codes for enrollment and verification: Users can enroll for SMS verification using ServiceNow Notify via Twilio SMS Messaging. Notify is a fast, configurable, and reliable way to deliver SMS messages. Notify supports international phone numbers and does not require an SMS service provider.
Domain separation

The Password Reset application enforces absolute domain separation, enabling you to customize business process definitions and user interfaces for each domain. You still have the flexibility to maintain global processes and global reporting in a single instance.

Support for Active Directory domain history policies

Active Directory domains can be configured to include a history policy that ensures that users do not reuse passwords. The Microsoft Reset Password APIs do not currently honor AD domain history policies. To resolve the issue and honor the policy, ServiceNow created the Enforce history policy option that performs a reset and then a change. The process effectively changes the password two times in AD, and the history records both changes. See the Enforce history policy option in Configure and test the Password Reset connection to a credential store.

Changed in this release

- Improved verification experience for mobile: Improved password reset experiences for mobile, tablet, and desktop with single-page verification actions that eliminate scrolling, clicks, and line breaks.

Service Mapping release notes

ServiceNow® Service Mapping application enhancements and updates in the Helsinki release.

Activation information

Service Mapping is available as a separate subscription and requires activation by ServiceNow personnel. The following plugins are activated automatically when Service Mapping is activated: IP-based Discovery, Service Modeling, and REST IP Provider.

Service Mapping, in combination with Event Management and Discovery provides the functionality that was provided by ServiceWatch in earlier releases.

New in the Helsinki release

Domain Separation

Service Mapping supports domain separation. In ServiceNow deployments using domain separation, tenants can install MID Servers and run service discovery only inside their datacenter. The results are displayed only for relevant tenants and to users in the global domain.

Business Management release notes

Business Management has new and updated features in the Helsinki release.
Demand Management release notes

ServiceNow® Demand Management application enhancements and updates in the Helsinki release.

Activation information

Demand Management is activated by default with the activation of the Project Portfolio Suite with Financials (com.snc.financial_planning_pmo) plugin for new instances.

If you upgrade to the Helsinki release, then the Demand Management (com.snc.demand_management) plugin is upgraded only if it is active prior to the upgrade. Otherwise, you must activate the Project Portfolio Suite with Financials plugin after the upgrade to activate the Demand Management plugin.

Browser requirements

If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the workbench.

New in the Helsinki release

*Project Portfolio Suite with Financials*

The Project Portfolio Suite with Financials plugin integrates Financial Management and Project Portfolio Suite, for financial and budget planning for projects, portfolios, and programs. The plugin adds these features to Demand Management:

- The *portfolio workbench*, which lets you manage end-to-end financial planning and tracking for all projects and demands in a portfolio. You can select projects and demands to include in the budget plan, fund the selected projects and demands, and then track the budgeted cost versus the actual cost.
- *Cost plans*, which capture the capital and operational costs of projects and demands.

*Expected Start and Due Date fields*

The expected start date and due date can be specified for a demand. The demand duration can then be displayed on program and portfolio workbenches.

Financial Management release notes

ServiceNow® Financial Management application enhancements and updates in the Helsinki release.

Helsinki upgrade information

New roles and application menus are introduced in the Helsinki release.

- The Financial Management application menu: The application is split into these application menus:
• Cost Transparency: Cost models, the workbench, general ledgers, and other items related to cost allocations.
• Financial Planning: Budgets and all items related to budgeting.

• User roles: The Cost Transparency and Financial Planning applications each have an administrator and analyst role. See User roles installed with Financial Management

Important: Users with the financial_mgmt_admin, financial_analyst, or financial_mgmt_user roles cannot access the Cost Transparency and Financial Planning application menus and modules after you upgrade to Helsinki. Reassign the new roles to your users.

Activation information

To purchase a subscription, contact your ServiceNow account manager. After purchasing the subscription, activate the plugin within the production instance.

You can evaluate the feature on a sub-production instance without charge by requesting it from the HI Customer Service System.

Browser requirements

If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the workbench.

New in the Helsinki release

- **Budget preview**
  You can preview a budget before you promote it.

- **Budget models**
  You can create financial models for budgeting, costing, or both. You can also create multiple budget models and create a segment hierarchy unique to each budget model.

- **Fiscal calendar**
  The following new types of fiscal calendars are supported: 13-period, 445, 454, and 544.

- **Integration with PPS**
  Financial Management supports portfolio budgets that you can create in Project Portfolio Suite. You must have the Project Portfolio Suite with Financials plugin active to use this integration.

- **Capital and operating expenses**
  Expenses are classified into capital expenses and operating expenses.

Changed in this release

• The Financial Management application menu: The application is split into these application menus:
  • Cost Transparency: Cost models, the workbench, general ledgers, and other items related to cost allocations.
  • Financial Planning: Budgets and all items related to budgeting.
• User roles: The Cost Transparency and Financial Planning applications each have an administrator and analyst role. See *User roles installed with Financial Management*

• Segment definitions: You can create segment definitions from the workbench. See *Manage segments*.

• Account numbers: Account numbers are no longer associated with budget keys and budget definitions. They are associated with budget items and budget forecasts. See *Add items to a budget plan* and *Promote a budget plan to a forecast*.

• Allocation tables: The itfm_allocation and itfm_allocation_aggregate tables replace the itfm_cost_allocation and itfm_cost_allocation_aggregate tables. See *Tables installed with Financial Management*.

• Budget keys: Budget keys are based on a budget model, the segments specified in the model, and the data in the General Ledger Staged Data (itfm_gl_data_staged) table. In the Geneva release, budget keys are called account codes. See *Budget keys*.

• Budget console: The budget console displays data in groups, including capital and operating expenses. See *The budget console*.

• Buckets: You can split buckets by customizable attributes. See *Split buckets*.

Governance, Risk, and Compliance (GRC) release notes

ServiceNow® Governance, Risk, and Compliance (GRC) application enhancements and updates in the Helsinki release.

Helsinki upgrade information

After activating the Compliance UCF plugin, submit a request on the ServiceNow HI Service Portal to validate GRC subscription and set up a UCF CCH account. For details, refer to *Policy and Compliance UCF upgrade instructions*.

Activation information

Each of the GRC-related plugins is available as a separate subscription:

• GRC: Policy and Compliance Management (com.sn_compliance)
• GRC: Risk Management (com.sn_risk)
• GRC: Audit Management (com.sn_audit)

New in the Helsinki release

*Policy and Compliance Management*  
GRC: Policy and Compliance Management replaces legacy IT compliance functionality. It includes a centralized process for creating and managing policies, standards, and internal control procedures that are cross-mapped to external regulations and best practices. The application also provides structured workflows for the identification, assessment, and continuous monitoring of control activities.

*Risk Management*  
GRC: Risk Management has been rearchitected to provide a centralized process to identify, assess,
respond to, and continuously monitor enterprise and IT risks that can negatively impact business operations. It also provides structured workflows for the management of risk assessments, risk indicators, and risk issues.

**Audit Management**

The GRC: Audit Management provides a centralized process for internal audit teams to automate the complete audit life cycle. Project-driven audits let auditors quickly scope engagements, conduct fieldwork, collect control evidence, and track audit observations.

**Changed in this release**

- *Legacy functionality (com.snc.governance) has been deprecated.*
- The common applications, **GRC: Profiles [com.sn_grc] and GRC: Common [com.sn.grc.common]** were rewritten to provide profiling, continuous monitoring, and issue management functionality to all GRC applications.

**Policy and Compliance UCF upgrade instructions**

Users require a separate subscription to the Network Frontiers Unified Compliance Framework Common Controls Hub (UCF-CCH) to download content from the UCF-CCH. Activate the Compliance UCF plugin (com.sn.comp.ucf) plugin and submit a request on the ServiceNow® HI Service Portal to validate the GRC subscription and set up a UCF-CCH account.

*Note:* A subscription to Network Frontiers UCF-CCH is not required for using the GRC Policy & Compliance application.

Network Frontiers has released a new method for allowing authenticated users to download content from the UCF Common Controls Hub (CCH) website. The UCF-CCH integration APIs are different from those of the previous XML-based UCF content library and requires an updated ServiceNow® UCF plugin for ServiceNow® GRC integration. Verification of the UCF CCH account is necessary before users can configure shared lists of authority documents and download them to their ServiceNow® instance.

*Note:* If your GRC effective contract date is before December 1, 2016, you are entitled to a free UCF CCH account for the period of December 1, 2016 through November 30, 2018. For customers on Helsinki (Patch 7 and above), or Istanbul and whose effective GRC contract start dates start on Dec 1, 2016 or after, you need to arrange your own subscription if your organization plans on using Unified Controls Compliance as the provider of your controls library. For more information about establishing a UCF CCH account, see [Unified Compliance](#).

**Role required:** admin

1.  #unique_132.
2.  Sign in to the [Hi Service Portal](#).
3.  Click Get Help.
4. Click Create an Incident.

5. Select Issue Type Request.
6. Select Category Hi Administration.
7. Describe the issue and provide the following information:
   • Enter “I have activated the new GRC: Compliance UCF (com.sn_comp_ucf) plugin. I am requesting that you validate my subscription and open a UCF CCH account on my behalf”.
   • Include your company name and company account number.
   • Include the requester’s name, business email address and phone number.

Note: By providing your company and requester contact information, you authorize ServiceNow customer service to contact and share that information with Network Frontiers, a third party, in order to complete your UCF CCH account enrollment.

8. Attach screen shots, logs, etc., as necessary.
9. Select affected instances. Enter your company’s GRC instance.
10. What is the business impact? Select your answer.
11. How many users does this affect? Select your answer.
12. When did you experience this issue? Select today’s date.
13. Click Report the issue.
ServiceNow HI customer support initiates the UCF-CCH account creation and enrollment process and will contact the requester when the process is complete.

Project Management release notes

ServiceNow® Project Management application enhancements and updates in the Helsinki release.

Activation information

Project Management is activated by default with the activation of the Project Portfolio Suite with Financials (com.snc.financial_planning_pmo) plugin for new instances.

If you upgrade to the Helsinki release, then the Project Management (com.snc.project_management_v3) plugin is upgraded only if it is active prior to the upgrade. Otherwise, you must activate the Project Portfolio Suite with Financials plugin after the upgrade to activate the Project Management plugin.

Browser requirements

If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the portfolio, program, and project workbenches.

New in the Helsinki release

**Project Portfolio Suite with Financials**

Project Portfolio Suite with Financials integrates Financial Management and Project Portfolio Suite for easier financial and budget planning for projects, portfolios, and programs. The plugin adds these features to Project Management:

- The portfolio workbench, which enables you to manage end-to-end financial planning and tracking for all projects and demands in a portfolio. With the portfolio workbench, you can select projects and demands to include in budget plan, fund the selected projects and demands, and then track the budgeted cost versus the actual cost.
- Cost plans, which capture the capital and operational costs of projects and demands.
- Integration with Financial Management, which helps in creating budgets for portfolios.
- Related lists to help manage all aspects of financial planning from the Portfolio and Project forms.
- The portfolio manager role, which enables you to manage portfolios.

**Program management**

Program Management helps you logically group and monitor related projects or demands under a single entity. It enables you to define program task milestones, anticipated risks, and issues. You can...
track all the projects and demands in a program using \textit{program workbench}.

\textbf{Project reporting}

Project managers can report the status of their projects on a weekly basis. The reports can be printed or can be sent to stakeholders as attachments.

\textbf{Gantt chart}

Project, program, and portfolio managers can track the schedule of their respective projects by filtering the projects by any criteria from the project list view.

\textbf{New dashboards}

The \textit{program manager dashboard}, \textit{project manager dashboard}, and \textit{portfolio manager dashboard} are added. They display the details of programs, projects, and portfolios to the respective program managers, project managers, and portfolio managers.

\section*{Changed in this release}

\begin{itemize}
  \item A project manager can add multiple agile phases and multiple test phases to a project.
  \item Projects in Microsoft Project 2013 can be imported.
  \item The portfolio timeline view is deprecated, as the portfolio workbench replaces its functionalities.
\end{itemize}

\section*{Release Management release notes}

ServiceNow\textsuperscript{\textregistered} Release Management application enhancements and updates in the Helsinki release.

\section*{Activation information}

Release Management is activated by default with the activation of the Project Portfolio Suite with Financials (com.snc.financial_planning_pmo) plugin for new instances.

If you upgrade to the Helsinki release, then the Release Management (com.snc.demand_management) plugin is upgraded only if it is active prior to the upgrade. Otherwise, you must activate the Project Portfolio Suite with Financials plugin after the upgrade to activate the Release Management plugin.

\section*{Changed in this release}

\begin{itemize}
  \item The project recalculation engine is extended to support release and other planned tasks.
  \item The Gantt chart visualization for releases is upgraded to be similar to the Gantt chart visualization for projects.
\end{itemize}

\section*{Resource Management release notes}

ServiceNow\textsuperscript{\textregistered} Resource Management application enhancements and updates in the Helsinki release.
Activation information

Resource Management is activated by default with the activation of the Project Portfolio Suite with Financials (com.snc.financial_planning_pmo) plugin for new instances.

If you upgrade to the Helsinki release, then the Resource Management (com.snc.resource_management) plugin is upgraded only if it is active prior to the upgrade. Otherwise, you must activate the Project Portfolio Suite with Financials plugin after the upgrade to activate the Resource Management plugin.

Browser requirements

If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the workbench.

Changed in this release

- Enhancements to resource workbench
  - Incoming requests and forecasts for a resource group can be viewed for a specified time period.
  - Resource requirements for programs and portfolios can be viewed.
  - Resource allocations for programs and portfolios can be made.

- Enhancements to resource management reports
  - Single interface to view availability, utilization, and allocations for resource groups and individual resources.
  - Current allocations, utilization rates, and the availability of resources can be viewed.

- Deprecated reports
  - Resource reports monthly
  - Resource reports detailed

Application Development release notes

Application Development has new and updated features in the Helsinki release.

Studio release notes

ServiceNow® Studio application enhancements and updates in the Helsinki release.

Activation information

Active by default.
New in the Helsinki release

**Delegated development**
Delegated development lets administrators use Studio to manage development users and the application content they can access.

**Scoped administration**
Scoped administration lets organizations protect sensitive application data by restricting how users acquire application-specific roles.

**Application access settings**
Application designers can configure application access settings for the entire application.

**Source control integration**
Application developers can integrate with a GIT source control repository to save and manage multiple versions of an application.

ServiceNow Platform release notes
The ServiceNow Platform has new and updated features in the Helsinki release.

User interface release notes
Enhancements and updates to the ServiceNow® user interface (UI) in the Helsinki release.

UI16 is the most recent of the supported UI versions. These release notes apply to UI16 only. There are no enhancements to the previous UI versions, called UI15 and UI11.

Activation information
UI16 is the default user interface for new instances. For upgraded instances, you can activate the UI16 plugin (com.glide.ui.ui16) if you have the admin role.

Browser requirements
See [Generally supported browsers](#).

New in the Helsinki release

**Activity stream mentions**
Get someone’s attention on a record by mentioning them with the @ character in an activity stream. By default, users receive email notifications when they are mentioned. If [Connect](#) is enabled, users can receive additional notifications.

Changed in the Helsinki release

- Clicking an avatar in an activity stream opens a popover that contains the profile information of the user. If Connect is enabled, the popover contains a shortcut to send the user a direct message.
The help icon ( ) in the banner frame opens help options in a sidebar, rather than a popover.

The system settings menu, which is available in the banner frame, contains some new and reorganized options. The Lists section is added.

The form personalization icon is updated ( ). In previous releases, the icon looks like a gear.

You can delete an item from your favorites by pointing to the item in the favorites tab of the application navigator and clicking the delete icon (-).

Configuration Management Database (CMDB) release notes

ServiceNow® Configuration Management Database (CMDB) application enhancements and updates in the Helsinki release.

Activation information

Active by default.

New in the Helsinki release

**CMDB Health**

Tools and dashboards for monitoring and viewing CMDB health reports. CMDB health is monitored in these major categories:

- **Completeness**: Measures the percentage of required and recommended fields that are populated in CIs.
- **Correctness**: Measures the percentage of CIs that pass pre-defined data integrity rules such as identification rules, orphan CI rules, and stale CI rules.
- **Compliance**: Uses audit tests to measure the level that the CMDB data adheres to pre-defined certificates.
- **Relationships**: Measures the health of CI relationships in terms of indicators such as orphan and duplicate relationships.

**CI Class Manager**

A central location for exploring the CMDB class hierarchy, the CI definition, CI health, and other CI-related items. Enables creation of CI-related definitions, such as identifiers.

Changed in this release

- Desired State Certification (com.snc.certification_desired_state) plugin:
  - Activated by default.
  - This plugin requires the Certification Core (com.snc.certification_core) plugin, which is also activated by default.
• Added the glide.allow.new_cert_follow_on_task system property. When this property is set to false, the same follow on tasks can be used for the same failure, across multiple audit runs.

• Relationship types: Added the Prevent duplicate relation type business rule that prevents the creation of relationship types in which the parent or child descriptor are identical.

• Identification and reconciliation:
  • If Domain Support - Domain Extensions is active, the identification engine enforces domain separation.
    • During the identification process, only CIs in which the domain ID is identical to the domain of the currently logged user, are processed.
    • Duplicate CIs across domains, including parent and child domains, are not considered duplicate CIs by the identification engine.
  • Users with the admin role can create reconciliation and staleness rules to reconcile stale CI attributes by an authorized data source with lower priority. You can use details about the last data source that writes to each attribute that is captured in the Data Source History (cmdb_datasource_last_update) table.
  • Users with the admin role can configure how the identification engine handles duplicate CIs.
  • These system properties were added to control how identification processes a small set of duplicate CIs:
    • Skip Duplicate (glide.identification_engine.skip_duplicates): If true, the identification process selects the oldest of the duplicates as a match, and updates the CI.
    • Skip Duplicate Threshold (glide.identification_engine.skip_duplicates.threshold): The maximum number of CIs that can be in a set of duplicate CIs to allow processing, according to the Skip Duplicate setting.

• History timeline view: Added a timeline for the related records of the CI, and added notation for baselines on the timeline.

• Extended CMDB (com.snc.extended_cmdb) plugin: Updated various table definitions to allow categorization of various extended CMDB tables within new and existing CMDB plugins. The following CMDB plugins were added:
  • CMDB Mainframe (com.snc.cmdb.mainframe)
  • CMDB Radio Category (com.snc.cmdb.radio.category)
  • CMDB Telecom Category (com.snc.cmdb.telecom.category)
  • CMDB Test Equipment (com.snc.cmdb.test.equiment)

Many of the tables from the Extended CMDB plugin were added to the core Configuration Management (CMDB) (com.snc.cmdb) plugin, or to one of the newly added plugins. The following table lists those changes:

<table>
<thead>
<tr>
<th>Table Label</th>
<th>Table Name</th>
<th>Change in Helsinki</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Hardware</td>
<td>cmdb_ci_personal_hardware</td>
<td>Deleted</td>
</tr>
<tr>
<td>Circuits</td>
<td>cmdb_ci_circuits</td>
<td>Deleted</td>
</tr>
<tr>
<td>Computer Display Monitor</td>
<td>cmdb_ci_display_monitor</td>
<td>Deleted</td>
</tr>
<tr>
<td>Personal Hardware</td>
<td>cmdb_ci_personal_hardware</td>
<td>Deleted</td>
</tr>
<tr>
<td>Circuits</td>
<td>cmdb_ci_circuits</td>
<td>Deleted</td>
</tr>
<tr>
<td>Computer Display Monitor</td>
<td>cmdb_ci_display_monitor</td>
<td>Deleted</td>
</tr>
<tr>
<td>Router Hardware</td>
<td>cmdb_ci_router_network</td>
<td>Deleted</td>
</tr>
<tr>
<td>Switch Hardware</td>
<td>cmdb_ci_switch_network</td>
<td>Deleted</td>
</tr>
<tr>
<td>Table Label</td>
<td>Table Name</td>
<td>Change in Helsinki</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Desktop PC</td>
<td>cmdb_ci_desktop_pc</td>
<td>Deleted</td>
</tr>
<tr>
<td>Laptop PC</td>
<td>cmdb_ci_laptop_pc</td>
<td>Deleted</td>
</tr>
<tr>
<td>PC Peripherals</td>
<td>cmdb_ci_peripherals_pc</td>
<td>Deleted</td>
</tr>
<tr>
<td>Rugged Laptop PC</td>
<td>cmdb_ci_rugged_laptop_pc</td>
<td>Deleted</td>
</tr>
<tr>
<td>Workstation PC</td>
<td>cmdb_ci_workstation_pc</td>
<td>Deleted</td>
</tr>
<tr>
<td>Converged Personal Data Assistant</td>
<td>cmdb_ci_converged_pda_personal</td>
<td>Deleted</td>
</tr>
<tr>
<td>Personal Data Assistant</td>
<td>cmdb_ci_pda_personal</td>
<td>Deleted</td>
</tr>
<tr>
<td>Service Account</td>
<td>cmdb_ci_service_account</td>
<td>Deleted</td>
</tr>
<tr>
<td>IHS Web Site</td>
<td>cmdb_ci_ihs_alias</td>
<td>Deleted</td>
</tr>
<tr>
<td>IIS Web Site</td>
<td>cmdb_ci_iis_alias</td>
<td>Deleted</td>
</tr>
<tr>
<td>ODBC Data Source</td>
<td>cmdb_ci_odbc_dsn</td>
<td>Deleted</td>
</tr>
<tr>
<td>Oracle Alias</td>
<td>cmdb_ci_oracle_alias</td>
<td>Deleted</td>
</tr>
<tr>
<td>Account</td>
<td>cmdb_ci_account</td>
<td>Deleted</td>
</tr>
<tr>
<td>CICS Region</td>
<td>cmdb_ci_cics</td>
<td>Deleted</td>
</tr>
<tr>
<td>File Share</td>
<td>cmdb_ci_file_share</td>
<td>Deleted</td>
</tr>
<tr>
<td>Process</td>
<td>cmdb_ci_process</td>
<td>Deleted</td>
</tr>
<tr>
<td>Resource Bundle</td>
<td>cmdb_ci_resource_bundle</td>
<td>Deleted</td>
</tr>
<tr>
<td>Started Task</td>
<td>cmdb_ci_started_task</td>
<td>Deleted</td>
</tr>
<tr>
<td>Server Rack</td>
<td>cmdb_ci_rack_server</td>
<td>Deleted</td>
</tr>
<tr>
<td>Server Terminal</td>
<td>cmdb_ci_terminal_server</td>
<td>Deleted</td>
</tr>
<tr>
<td>High End Plotter</td>
<td>cmdb_ci_high_end_plotter</td>
<td>Deleted</td>
</tr>
<tr>
<td>Standard Plotter</td>
<td>cmdb_ci_standard_plotter</td>
<td>Deleted</td>
</tr>
<tr>
<td>Color Printer</td>
<td>cmdb_ci_color_printer</td>
<td>Deleted</td>
</tr>
<tr>
<td>Standard Printer</td>
<td>cmdb_ci_standard_printer</td>
<td>Deleted</td>
</tr>
<tr>
<td>Server Hostname</td>
<td>cmdb_ci_server_hostname</td>
<td>Deleted</td>
</tr>
<tr>
<td>UNIX Package</td>
<td>cmdb_ci_unix_package</td>
<td>Deleted</td>
</tr>
<tr>
<td>Content Engine</td>
<td>cmdb_ci_ce_network</td>
<td>Deleted</td>
</tr>
<tr>
<td>Content Services Switch</td>
<td>cmdb_ci_css_network</td>
<td>Deleted</td>
</tr>
<tr>
<td>Network Interface Shelf</td>
<td>cmdb_ci_interface_shelf_nw</td>
<td>Deleted</td>
</tr>
<tr>
<td>Network Probe Hardware</td>
<td>cmdb_ci_network_probe_network</td>
<td>Deleted</td>
</tr>
<tr>
<td>Network Terminal Server</td>
<td>cmdb_ci_terminal_network</td>
<td>Deleted</td>
</tr>
<tr>
<td>Access Server Hostname</td>
<td>cmdb_ci_access_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Content Engine Hostname</td>
<td>cmdb_ci_ce_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>CSS Hostname</td>
<td>cmdb_ci_css_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>CSU/DSU Hostname</td>
<td>cmdb_ci_csu_dsu_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Firewall Hostname</td>
<td>cmdb_ci_firewall_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Table Label</td>
<td>Table Name</td>
<td>Change in Helsinki</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>--------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Hub Hostname</td>
<td>cmdb_ci_hub_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Modern Hostname</td>
<td>cmdb_ci_modem_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Network Probe Hostname</td>
<td>cmdb_ci_nw_probe_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Router Hostname</td>
<td>cmdb_ci_router_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Switch Hostname</td>
<td>cmdb_ci_switch_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>UPS Hostname</td>
<td>cmdb_ci_ups_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Wireless Access Point Hostname</td>
<td>cmdb_ci_wap_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Server Peripherals</td>
<td>cmdb_ci_peripherals_server</td>
<td>Deleted</td>
</tr>
<tr>
<td>LINUX Hostname</td>
<td>cmdb_ci_linux_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>UNIX Hostname</td>
<td>cmdb_ci_unix_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>VMWare Hostname</td>
<td>cmdb_ci_vmware_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Windows Hostname</td>
<td>cmdb_ci_windows_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Z/OS Hostname</td>
<td>cmdb_ci_z_os_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>AIX Hostname</td>
<td>cmdb_ci_ibm_aix_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>HP UNIX Hostname</td>
<td>cmdb_ci_hp_unix_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>SUN UNIX Hostname</td>
<td>cmdb_ci_sun_unix_host</td>
<td>Deleted</td>
</tr>
<tr>
<td>Alias</td>
<td>cmdb_ci_alias</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>UNIX Cluster</td>
<td>cmdb_ci_unix_cluster</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Mainframe Hardware</td>
<td>cmdb_ci_mainframeHardware</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Personal Computer</td>
<td>cmdb_ci_pc_hardware</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Batch Job</td>
<td>cmdb_ci_batch_job</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Display Hardware</td>
<td>cmdb_ci_display_hardware</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Imaging Hardware</td>
<td>cmdb_ci_imaging_hardware</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Scanner</td>
<td>cmdb_ci_scanner</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Firewall Hardware</td>
<td>cmdb_ci_firewall_network</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Intrusion Detection System</td>
<td>cmdb_ci_ids_network</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Modern Hardware</td>
<td>cmdb_ci_modem_network</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Wireless Access Point</td>
<td>cmdb_ci_wap_network</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Server Hardware</td>
<td>cmdb_ci_server_hardware</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Network Appliance Hardware</td>
<td>cmdb_ci_net_app_server</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Server Chassis</td>
<td>cmdb_ci_chassis_server</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Server Tape Unit</td>
<td>cmdb_ci_tape_server</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Printing Hardware</td>
<td>cmdb_ci_printing_hardware</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Multi-function Printer</td>
<td>cmdb_ci_mfp_printer</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Personal Printer</td>
<td>cmdb_ci_personal_printer</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Plotter</td>
<td>cmdb_ci_plotter</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Table Label</td>
<td>Table Name</td>
<td>Change in Helsinki</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Monitoring Equipment</td>
<td>cmdb_ci_monitoring_hardware</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Network Appliance Hostname</td>
<td>cmdb_ci_net_app_host</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Network Hostname</td>
<td>cmdb_ci_network_host</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Port</td>
<td>cmdb_ci_port</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>CSU/DSU</td>
<td>cmdb_ci_csu_dsu_network</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>FDDI Cards</td>
<td>cmdb_ci_fddi_network</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Hub Hardware</td>
<td>cmdb_ci_hub_network</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>WAN Accelerator</td>
<td>cmdb_ci_wan_accel_network</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>DNS Alias</td>
<td>cmdb_ci_dns_alias</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Logical Partition</td>
<td>cmdb_ci_lpar</td>
<td>Added to Core CMDB</td>
</tr>
<tr>
<td>Mainframe Printer</td>
<td>cmdb_ci_mainframe_printer</td>
<td>Added to Mainframe</td>
</tr>
<tr>
<td>Mainframe Controller</td>
<td>cmdb_ci_controller_mainframe</td>
<td>Added to Mainframe</td>
</tr>
<tr>
<td>Mainframe CPU</td>
<td>cmdb_ci_cpu_mainframe</td>
<td>Added to Mainframe</td>
</tr>
<tr>
<td>Mainframe DASD</td>
<td>cmdb_ci_dasd_mainframe</td>
<td>Added to Mainframe</td>
</tr>
<tr>
<td>Mainframe Memory</td>
<td>cmdb_ci_memory_mainframe</td>
<td>Added to Mainframe</td>
</tr>
<tr>
<td>Mainframe Peripheral</td>
<td>cmdb_ci_peripheral_mainframe</td>
<td>Added to Mainframe</td>
</tr>
<tr>
<td>Mainframe Tape Unit</td>
<td>cmdb_ci_tape_mainframe</td>
<td>Added to Mainframe</td>
</tr>
<tr>
<td>Mainframe Terminal</td>
<td>cmdb_ci_terminal_mainframe</td>
<td>Added to Mainframe</td>
</tr>
<tr>
<td>Radio Hardware</td>
<td>cmdb_ci_radio Hardware</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Antenna</td>
<td>cmdb_ci_antenna_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Conventional Radio</td>
<td>cmdb_ci_conventional_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Feed Line</td>
<td>cmdb_ci_feedline_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Microwave Radio</td>
<td>cmdb_ci_microwave_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Mobile Radio</td>
<td>cmdb_ci_mobile_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Multiple Address Systems Radio</td>
<td>cmdb_ci_mas_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Portable Radio</td>
<td>cmdb_ci_portable_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Radio Console</td>
<td>cmdb_ci_console_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Radio Control Station</td>
<td>cmdb_ci_control_station_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Repeater Radio</td>
<td>cmdb_ci_repeater_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Trunking Radio</td>
<td>cmdb_ci_trunking_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Unlicensed Microwave Radio</td>
<td>cmdb_ci_unlicensed_radio</td>
<td>Added to Radio Category</td>
</tr>
<tr>
<td>Telecommunications Hardware</td>
<td>cmdb_ci_telecom_hardware</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Transport Hardware</td>
<td>cmdb_ci_transport_hardware</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Voice System Hardware</td>
<td>cmdb_ci_voice_hardware</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Fiber Optic Terminal Equipment</td>
<td>cmdb_ci_fote_transport</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Optical Multiplexer</td>
<td>cmdb_ci_omux_transport</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Channel Bank</td>
<td>cmdb_ci_channel_bank_transport</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Table Label</td>
<td>Table Name</td>
<td>Change in Helsinki</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Digital Access Cross Connects</td>
<td>cmdb_ci_dacs_transport</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Fiber Optic Equipment</td>
<td>cmdb_ci_optical_transport</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Frame Relay Access Device</td>
<td>cmdb_ci_frad_transport</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Multiplexer</td>
<td>cmdb_ci_mux_transport</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Transport Interface Shelf</td>
<td>cmdb_ci_iface_shelf_transport</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Transport Terminal Server</td>
<td>cmdb_ci_terminal_transport</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Key Telephone System</td>
<td>cmdb_ci_key_system_voice</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Private Branch Exchange</td>
<td>cmdb_ci_pbx_voice</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Voicemail</td>
<td>cmdb_ci_voicemail_voice</td>
<td>Added to Telecom Category</td>
</tr>
<tr>
<td>Test Equipment</td>
<td>cmdb_ci_test_eq_hardware</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Audio Test Set</td>
<td>cmdb_ci_audio_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Battery Analyzer</td>
<td>cmdb_ci_battery_azer_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Bit Error Rate Test Set</td>
<td>cmdb_ci_ber_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Communications Analyzer</td>
<td>cmdb_ci_comm_analyzer_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Data Error Analyzer</td>
<td>cmdb_ci_data_analyzer_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>DS1 Test Set</td>
<td>cmdb_ci_ds1_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>DS1/DS3 Test Set</td>
<td>cmdb_ci_ds1_ds3_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>DS1/DS3/OC3 Test Set</td>
<td>cmdb_ci_ds1_ds3_oc3_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>DS3 Test Set</td>
<td>cmdb_ci_ds3_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Frequency Counter</td>
<td>cmdb_ci_freq_counter_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Frequency Selective Levelmeter</td>
<td>cmdb_ci_freq_meter_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>ISDN Test Set</td>
<td>cmdb_ci_isdn_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Microwave Frequency Counter</td>
<td>cmdb_ci_mw_freq_cntr_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Microwave Test Set</td>
<td>cmdb_ci_mw_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Optical Time Domain Reflctometer</td>
<td>cmdb_ci_otdr_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Oscilloscope</td>
<td>cmdb_ci_oscilloscope_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Power Meter</td>
<td>cmdb_ci_power_meter_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Signal Generator</td>
<td>cmdb_ci_signal_gen_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Spectrum Analyzer</td>
<td>cmdb_ci_spectrum_azer_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Time Domain Reflctometer</td>
<td>cmdb_ci_tdr_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Transmission Test Set</td>
<td>cmdb_ci_transmission_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
<tr>
<td>Wattmeter</td>
<td>cmdb_ci_wattmeter_test_eq</td>
<td>Added to Test Equipment</td>
</tr>
</tbody>
</table>

Connect release notes

ServiceNow® Connect enhancements and updates in the Helsinki release.
Helsinki upgrade information

With Geneva and Helsinki you have the option to upgrade from legacy chat to Connect Support. When Connect Support is enabled, users designated as support agents have access to the support tab of the Connect sidebar.

Legacy chat and Connect Support cannot be used concurrently. Starting with Helsinki Patch 2, when you activate Connect Support, the system automatically sets the state of all Chat Queue Entry (chat_queue_entry) records to Closed Complete. This ends any open help desk chats.

If you use the legacy chat feature to provide help desk support, close any open help desk chats before activating Connect Support.

Activation information

Connect is active by default on new instances. For upgraded instances, you can activate the Connect plugin (com.glide.connect) if you have the admin role.

You can activate the Connect Support plugin (com.glide.connect.support) if you have the admin role. This plugin includes demo data. If you are currently using the legacy chat feature to provide help desk support, close any open help desk chats before activating Connect Support. Legacy chat and Connect Support cannot be used concurrently. Starting with Helsinki Patch 2, when you activate Connect Support, the system automatically sets the state of all Chat Queue Entry (chat_queue_entry) records to Closed Complete. This ends any open help desk chats.

User interface requirements

UI16 or UI15 is required to use Connect.

Browser requirements

- The latest public release of Firefox or Firefox ESR
- The latest public release of Chrome
- Safari version 6.1 and later
- Internet Explorer version 10 and later
  - Edge mode is supported.
  - Compatibility mode is not supported.
  - Setting Security Mode to High (via the Internet Options Security tab) is not supported.
  - Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.

New in the Helsinki release

- **Audio notifications**
  Connect can generate audio notifications to alert users of activity. Audio notifications are enabled for all conversations by default. Users can customize their audio notification settings the same way as any other Connect notification type.

- **Activity stream mentions**
  When someone mentions you in the activity stream of a record you are not following in
Connect, you receive Connect notifications you enabled globally, except for email notifications. You receive a different email notification, which is configured outside of Connect. If you are following the record in Connect, you only receive notifications according to your notification preferences for the record conversation.

**Connect Properties page**

Administrators can access the Connect Properties page, which lists several Connect configuration properties in one convenient place. Most of the properties impact Connect Support and Connect Chat.

**Connect Support Properties page**

Administrators can access the Connect Support Properties page, which lists several Connect Support configuration properties in one convenient place.

**Connect Support metrics**

Administrators can activate a homepage and Performance Analytics dashboards, which contain helpful Connect Support metrics.

Changed in the Helsinki release

- **General Connect enhancements:**
  - Minor design changes improve accessibility and user experience.
  - Clicking an avatar in a conversation opens a popover that contains profile information for the user and a shortcut to send a direct message.
  - Conversations display link previews, including inline videos, GIFs, and images. Administrators control this functionality with the new `connect.retrieve_external_link_content` property, which they can disable on the Connect Properties page.
  - Conversations display improved record previews, which include the assignee avatar and the time of the most recent update.
  - If a user does not have access to a record shared in a conversation, the user sees a security constraint message in place of the record preview.
  - Connect mini windows can be closed by pressing the Escape key.
  - When you receive new messages in a collapsed conversation, the Connect mini window header turns blue and pulses briefly for easy identification.
  - You can click an attachment in a Connect mini window to open a preview.
  - The Connect Chat module is added to the Self-Service application menu. The module opens the Connect workspace.
  - The Actions module, which provides administrators with access to Connect actions, is available with Connect by default. Previously, Connect Support was required to access the module.
  - The Action Icons module is added to the Collaborate application menu under Administration. The module provides a glossary of icons that administrators can use for Connect actions.

- **Connect Chat enhancements:**
  - For record conversations, only users who have access to the record can be added as members.
  - For record conversations, attachments sent in the conversation are added as attachments to the underlying record.

- **Connect Support enhancements:**

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Administrators can configure the number of seconds a user must be inactive in a support conversation before the system displays idle messages. They can control this functionality with the new connect.support.idle.count_down and connect.support.idle.delay properties on the Connect Support Properties page.

• Connect Support adds the Document table and Document ID fields to the Chat Queue Entry (chat_queue_entry) table. When an agent creates an incident from a support conversation, these fields are set to reference the incident.

Connect Support upgrade information

Connect Support upgrade information for the Helsinki release.

Upgrading to Connect Support from legacy chat

With Geneva and Helsinki you have the option to upgrade from legacy chat to Connect Support. When Connect Support is enabled, users designated as support agents have access to the support tab of the Connect sidebar.

Legacy chat and Connect Support cannot be used concurrently. Starting with Helsinki Patch 2, when you activate Connect Support, the system automatically sets the state of all Chat Queue Entry (chat_queue_entry) records to Closed Complete. This ends any open help desk chats.

If you use the legacy chat feature to provide help desk support, close any open help desk chats before activating Connect Support.

Core platform release notes

ServiceNow® core platform enhancements and updates in the Helsinki release.

Activation information

Active by default.

New in the Helsinki release

*Canceled transaction logging to a table*: The system logs canceled transactions to a table. This feature can be turned off using a system property.

*Application quota rules*: You can specify a quota rule to limit the number of events or jobs that can run in the scope of an application within a specified time.

*ECMAScript 5 support*: You can use ES5 JavaScript features in scripts. The ‘use strict’ directive is supported.

Changed in this release

• The MySQL Connector/J driver is no longer included with the deployment. The MariaDB Connector/J driver is now part of the deployment.

• Quota Rules are called Transaction Quota Rules.
• The GlideSystem isMobile() method is available to scoped applications.

Data import and export release notes
Enhancements and updates to data importing and exporting in the Helsinki release.

Activation information
Active by default.

New in the Helsinki release

XLSX support
Import Sets and Export Sets support XLSX files in addition to XLS files. Use XLSX files in place of XLS whenever possible for optimal performance.

Changed in this release

• Enable additional debug logging for SFTP and SCP data sources with the glide.import.sftp.debug and glide.importscp.debug properties.
• When creating an Easy Import template, you can include all columns from the table in the template, or only those columns that appear in the list.
• You can limit the maximum XML import file size using the glide.db.impex.XMLLoader.max.file.size.mb property. This property specifies a maximum file size of 100 MB by default.

Dependency Views release notes
ServiceNow® Dependency Views feature enhancements and updates in the Helsinki release.
Dependency Views provide maps that graphically display configuration items that support business services and the relationships between the configuration items.

Activation information
The Dependency Views module is active in all instances and includes demo data.

Browser requirements
The Dependency Views module supports the latest version or service pack of the following browsers:
• Firefox with the latest ESR
• Chrome version 25 or later (latest version recommended)
• Safari version 6 or later
• Microsoft Internet Explorer (IE), with these requirements and limitations:
  • Dependency Views requires IE version 9 or later.
  • You cannot export images from a Dependency Views map using Internet Explorer as your browser.
When you save a map view, Dependency Views does not make a thumbnail image. You can navigate to the saved map view using the version number.

New in the Helsinki release

**Dependency types**
Create dependency types to filter and customize what the map displays.

**Display related business services map**
Double-click a related business service in a Dependency Views map to display the business service map in the Event Management dashboard.

Changed in this release

- The Filter CIs By Audit Failure filter is available. It is based on CMDB health audit results. You can use this filter to hide CIs that failed the CMDB health audit.
- To access a Dependency Views map from either the navigation menu, a script API, or a URL, the minimum role required is dependency_views. Some operations that are related to icons, indicators, and menu actions require the ecmdb_admin role. Some operations that are related to properties and dependency types require the admin role.
- Dependency Views enforces ACL permissions on CIs, and visually hides them and their relationships from the map when the permission requirement is not met.
- The Filters control was renamed to Settings.
- Legacy BSM is no longer supported.

Edge Encryption release notes

ServiceNow® Edge Encryption application enhancements and updates in the Helsinki release.

Activation information

The Edge Encryption plugin (com.glide.edgeencryption) is available as a separate subscription.

New in the Helsinki release

**Rotate keys without taking the proxy offline**
You can manage encryption keys from the instance. It is no longer necessary to maintain encryption key information in the proxy properties files.

**Pattern based encryption**
You can define string patterns that are replaced with tokens before being sent to the instance.

**Proxy upgrade support**
You can upgrade a proxy without manually taking the proxy offline. The upgrade process handles shutting down and starting up the proxy for minimal down time.
Changed in this release

- You can mark a string field that has an index to be encrypted using the order-preserving or equality-preserving encryption types.

Email and notifications release notes

Enhancements and updates to email and notifications in the Helsinki release.

Activation information

Active by default.

Browser requirements

To preview notifications, Internet Explorer version 9 or later is required if you want to use Internet Explorer.

New in the Helsinki release

Notification preferences

User notification preferences have been redesigned to provide a better user experience. Users can more easily see which notifications they are receiving for each of their devices, based on the table that the notification is based on. Users can also see which subscribable notifications they have chosen to subscribe to. See Select notifications and Add personal subscriptions.

Email archiving

By default, email messages are kept on the instance for a total of two years: one year in the Email table, and one year in the Email archive table. Then the email records are deleted. Administrators can control when and how long emails are archived with archiving and destruction rules. See Email retention.

Guided setup release notes

Guided setup is available for certain ServiceNow® applications in the Helsinki release.

You are guided through activities to set up applications and shown your progress through the activities. Each activity provides you with the following resources:

- Contextual embedded help
- Guided tours
- Contextual documentation on the ServiceNow product documentation site

For an example, see .
Activation information

The Guided Setup for ServiceNow applications plugin (com.snc.guided_setup) is active by default for new provisioned instances. If an instance is upgraded to the Helsinki release, then the plugin must be activated to enable ITSM guided setup.

Browser requirements

Use one of the following browsers with the guided setup:

- Internet Explorer 10 or later
- Google Chrome 33 or later
- Mozilla Firefox 28 or later
- Apple Safari 6 or later

Knowledge Management release notes

ServiceNow® Knowledge Management application enhancements and updates in the Helsinki release.

Helsinki upgrade information

Review the content in the Knowledge upgrade best practices community page at All things Upgrade considered on Knowledge v2 to v3.

Activation information

Knowledge Management has changed with Knowledge v3, which is enabled by default for all instances. For migration information, see Knowledge Management v3 migration.

New in the Helsinki release

Knowledge homepage enhancements

Each knowledge base shows the number of articles and questions. There are also layout changes on the top navigation bar.

Changed in this release

- Search page enhancements: There are layout changes to the search page in addition to the ability to filter out articles and questions.
- Import articles enhancements: The dialog box for KB and category selection is shown before the file upload.

Lists release notes

Enhancements and updates to lists in the Helsinki release.
List v3 is a new feature, which provides several enhancements to UI16 lists. These release notes apply to List v3 lists only. There are no enhancements to the previous version of lists, called List v2. For more information, see *Comparison of List v2 and List v3*.

**Activation information**

You can activate the List v3 plugin (com.glide.ui.list_v3) if you have the admin role. This plugin activates related plugins if they are not already active.

---

**Note:** List v3 may impact performance and should be tested thoroughly prior to activation on a production instance.

**User interface requirements**

List v3 requires UI16. In UI15 and UI11, all lists display in List v2. Even when List v3 is enabled, some UI16 lists may display in List v2. For details, see *List v3 compatibility*.

**Browser requirements**

- The latest public release of Firefox or Firefox ESR
- The latest public release of Chrome
- Safari version 6.1 and later
- The latest public release of Microsoft Edge
- Internet Explorer version 10 and later
  - Edge mode is supported.
  - Compatibility mode is not supported.
  - Setting Security Mode to High (via the Internet Options Security tab) is not supported.

**New in the Helsinki release**

- **Split mode**
  
  Split mode lets users view lists and forms side by side in a split pane layout. In split mode, records are listed in a compact format.

- **Redesigned filter interface**
  
  The list filter interface is redesigned for a better user experience, including a cleaner look and enhancements to the dot-walking interface.

- **Multiple levels of sorting**
  
  The list sorting interface lets users add multiple levels of sorting. For example, users can sort a list of incidents by state, then sort incidents of the same state by date opened.

- **Enhanced list grouping**
  
  The list grouping interface makes it easier to visualize and compare list data at a glance with quick filtering options and graphical breakdowns of grouped data.

- **List calculation previews**
  
  The list calculation interface makes it possible to preview calculations instantly and configure calculations for all columns at once.
Changed in this release

- UI policies are enforced during list editing.
- Avatars appear in columns that reference the User (sys_user) table. If user presence is enabled, online indicators appear on the avatars.
- The personalize list gear icon is replaced by the Personalize List Columns option in the list title menu. The list personalization interface is improved.
- It is no longer necessary to avoid using reference fields as the first list column. Links in the first column of a list now open the record from the current list, even if the first column is a reference field.

If the first column is a reference field, the open reference value icon ( ) appears by each value. Click the icon to open the record from the referenced table.
- Paging controls are moved from the top of the list to the list footer, which is pinned to the bottom of the page for easy access.
- The tagging interface is redesigned.
- The following list options are added to the list title menu for better organization.
  - Personalize List Columns (previously represented by a gear icon to the left of the first list column)
  - List Layout (previously in the list column menu under Configure option)
  - List Calculations (previously in list column menu under Configure option)
  - List Control (previously in list column menu under Configure option)
  - Configure (previously in list column menu)
  - Import (previously in list column menu)
  - Export (previously in list column menu)
  - Update All (previously in list column menu)
  - Update Selected (previously in list column menu)
  - Create Application Files (previously in list column menu)
  - Import XML (previously in list column menu)

- The following options are removed from the list title menu.
  - Filters (click the Load Filter button in the filter interface to access saved filters)
  - Group By
  - Show (moved to list footer)
  - Refresh List (replaced by a refresh icon ( ) in the list title bar)

- The list action check box to select all records is moved to the top of the list.
- The list action choice menu appears only when one or more records are selected.
- The reference icon displays a record preview when clicked, rather than pointed to.
  - On forms, the reference lookup icon ( ) opens the reference lookup list in a popover, rather than a pop-up window.
- The date picker is redesigned.

Mobile release notes

Mobile product enhancements and updates in the Helsinki release.

Access the user interface on a mobile device.
Mobile device requirements

You can access the platform on your mobile device using either a web browser or the native app. Access the web browser using any mobile device or tablet. The native app is currently only available to Apple devices operating iOS9 and higher and Android devices operating 4.4 (KitKat) and higher.

New in the Helsinki release

Native tablet app
Access the platform UI from the native tablet app. The native tablet app has been designed with the same look and feel as the native phone app.

Mobile browser update
Select the option to use the new mobile browser UI. The new mobile browser UI mimics the native app for a similar user experience.

Cross-release communication
If you upgrade the native app to the latest version but still want to access a Geneva instance, you can. Additionally, you can access a newer platform version from an older version of the app.

Changed in this release

- Blur the UI when the app is in the background on a mobile device.
- Change notification settings for mobile versus the standard platform.

Normalization Data Services release notes
Normalization Data Services Client is a new application in the Helsinki release.
Normalization Data Services Client helps maintain consistency for table fields that refer to a company name. For details, see Normalization Data Services.

Activation information
You can activate the Normalization Data Services Client (com.glide.data_services_canonicalization.client) plugin if you have the admin role. This plugin does not include demo data.

Notify release notes
ServiceNow® Notify application enhancements and updates in the Helsinki release.

Activation information
The Notify plugin (com.snc.notify) requires a separate subscription. This plugin includes demo data and activates related plugins if they are not already active.
New in the Helsinki release

Twilio short code integration

Notify automatically pulls short code numbers along with E.164 numbers from the configured Twilio account in Notify. Short codes can be used for integration with incoming and outgoing SMS-based workflows with Notify. Twilio Short Code enables high volume limits for sending SMS. It also comes with five-digit to six-digit numbers based on the region in which the short code number is obtained.

Platform security release notes

ServiceNow® platform security enhancements and updates in the Helsinki release.

New in the Helsinki release

Domain separation upgrade to domain paths

Domain paths is the only domain query method for all instances. Domain numbering is no longer used. All Domain Separated customers with a domain query method other than Domain paths will automatically be upgraded to the Domain paths method as the final part of the Helsinki upgrade process. For assistance or questions regarding the Domain paths upgrade please contact ServiceNow support.

Warning: Do not modify your domain hierarchy during the upgrade or migration process.

OAuth client credentials

OAuth supports the client credential grant type. This grant type specifies that the consumer of the resource uses the client ID and client secret already configured in the application registry.

Platform upgrades release notes

Enhancements to the platform upgrade process for the Helsinki release.

Activation information

Platform feature. Active by default.
Changed in this release

- The Upgrade Monitor page has been redesigned. The redesign provides more useful information about the status of the upgrade progress and makes clear what the next steps are to resolve any issues.

Plugin activation release notes

Plugin enhancements and updates in the ServiceNow release.

Changed in this release

- Helsinki introduces a new type of dependency for plugins. In these cases, the plugin works, but certain features that do not apply to your system are not installed. For more information, see ServiceNow plugins.

Service Portal release notes

ServiceNow® Service Portal is a new application in the Helsinki release.

Create modern and engaging web interfaces for services and applications running on the ServiceNow platform. For details, see the .

Activation information

Service Portal is not active by default.

Browser requirements

- Modern browsers
- Internet Explorer version 10 and later

Changes in this release

This is an initial release, however any changes made to release patches are listed below.

- getCatalogItem scriptable API: In Helsinki Patch 9a, the getCatalogItem(String itemID) method is being changed to getCatalogItem(String itemID, boolean isOrdering), which includes the old method but calls the new method, passing false to the isOrdering parameter.

  The isOrdering parameter indicates whether the system does a create roles security check or a write roles security check on a Service Catalog item’s variables. By default the system does a check on write roles. When users are first ordering an item or have it in their cart, the parameter checks the create roles. If users aren’t in the process of ordering, for example, if they were looking at a requested item to see the variables associated with that item, then the parameter checks the write roles.

  This change affects the SC catalog item widget, the order guide widget, and the shopping cart widget. Any users who have cloned those widgets or who have a widget that uses the
Surveys and Assessments release notes
Enhancements and updates to the ServiceNow® Assessments and Surveys applications in the Helsinki release.

New in the Helsinki release

**Attachment data type**
Use the attachment data type to create a survey or assessment question that lets users attach one or more files.

**Update sets**
Use update sets to move survey and assessment data from one instance to another.

**Multiple line descriptions for assessment records**
Use table titles to create assessment descriptions that include information from multiple fields on an assessable record and are displayed on multiple lines.

System Diagnostics release notes
ServiceNow® System Diagnostics application enhancements and updates in the Helsinki release.

New in the Helsinki release

**Slow Mutex Locks**
The Stats section of System Diagnostics includes Slow Mutex Locks.

**Slow Events Logs**
The Stats section of System Diagnostics includes Slow Events Logs.

Time Card release notes
ServiceNow® Time Card feature enhancements and updates in the Helsinki release.

Activation information

Administrators can activate the Time card management (com.snc.time_card) plugin.
Time Card is also activated by default with the activation of the Project Portfolio Suite with Financials (com.snc.financial_planning_pmo) plugin for new instances.

Changed in this release

- Time card users have view-only access to the Project (pm_project) and Project Task (pm_project_task) tables, so they can create time cards for projects and project tasks.
- The Project/Project Task category is added in the time card form. See [Create a time card](#).
Update sets release notes
Enhancements to update sets for the Helsinki release.

Activation information
Platform feature. Active by default.

Changed in this release
• Update sets now include any customer-created indexes for the tables included in the update set.

Visual Task Boards release notes
Enhancements and updates to ServiceNow® Visual Task Boards in the Helsinki release.

Activation information
Visual Task Boards are active by default on new instances. For upgraded instances, you can activate the Visual Task Boards plugin (com.glide.ui.vtb) if you have the admin role.

User interface requirements
UI16 or UI15 is required to use Visual Task Boards.

Browser requirements
• The latest public release of Firefox or Firefox ESR
• The latest public release of Chrome
• Safari version 6.1 and later
• Internet Explorer version 10 and later
  • Edge mode is supported.
  • Compatibility mode is not supported.
  • Setting Security Mode to High (via the Internet Options Security tab) is not supported.
  • Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.
• Access Visual Task Boards on your mobile device using either a browser or the native mobile app. See Supported devices for the mobile browser or Supported devices for the mobile app for more information.

New in the Helsinki release
 Modify the query for an existing board
For flexible and guided boards, which display cards from a task table, the board owner can edit the filter conditions that determine which tasks the board tracks. For example, you can edit the filter
so the board shows only active incidents, rather than all incidents.

**Lane field pivots**

For flexible and guided boards, the board owner can change which field on the underlying table defines the lanes. For example, you can change the lane field so the lanes represent incident states, rather than assignees. Lane field pivots also make it possible to convert a flexible board to a guided board or vice versa.

**Drag and drop lanes**

Board members can rearrange lanes simply by dragging them. Arrow icons no longer appear at the bottom of each lane.

**Archive all cards in a lane**

Board members can archive all the cards in a lane at once, rather than individually.

**Changed in the Helsinki release**

- Minor design changes improve accessibility and user experience.
- Visual Task Boards can display up to 2,000 cards by default. This increased limit applies to all board types and, for upgrades, overwrites any custom card limits that were configured.
- Several options are consolidated under a new menu ( ), which appears in each lane header. The lane menu provides access to the following actions:
  - Add Task
  - Archive All Tasks
  - Hide Lane
  - Delete Lane
- The board information popover displays additional details.
  - Table name (flexible and guided boards only)
  - Lane field (flexible and guided boards only)
- The ability to view the list on which a flexible or guided board is based has changed. The Show List link appears by the table name in the board information popover, and navigates away from the board to the list. This link replaces a button in the board header, which opened a list within the board interface.
- Pressing the Escape key while dragging a card or lane cancels the move.
- The default background color is gray for all board types.

**Web services release notes**

Web services enhancements and updates in the Helsinki release.

**New in the Helsinki release**

**Excel web service XLSX support**

The Excel web service supports exporting to the XLSX file format in addition to the XLS format.
Use XLSX in place of XLS whenever possible for optimal performance.

**Example REST client apps**

Several example REST client applications and source code are available to demonstrate integrations using REST web services.

**Web service API analytics**

Track and analyze web service API usage, such as REST and SOAP web services.

**Changed in this release**

- The `glide.soap.invalidate_session_timeout` and `glide.soap.request_processing_timeout` properties enforce a minimum value of 5 seconds, and a maximum value of 1200 seconds.
- You can configure web service import sets to process `insertMultiple` operations asynchronously by activating the `Insert multiple asynchronous mode` business rule.
- Outbound SOAP messages support WS-Security using Basic Auth, in addition to X.509 certificates.
- The `odbc` role was added as a convenient way to grant access to an instance through the ODBC driver. This role contains the `soap_query` role needed to make ODBC requests, and the `itil` role needed to access core tables such as `Incident`.
- You can submit a multi-factor authentication token with basic auth credentials to perform REST requests using an MFA-enabled user account.
- Web service sessions time out if inactive for longer than the limit set by the `glide.integration.session_timeout` property.

**Workflow release notes**

ServiceNow® Workflow application enhancements and updates in the Helsinki release.

**Activation information**

Platform feature. Active by default

**New in the Helsinki release**

**Edit the workflow activity properties form**

Users can customize the layout of workflow activity forms, including individual activity variables.

**Changed in this release**

- The workflow activity properties forms are organized into sections with explanatory annotations, making it easier to create new and edit existing activities.

**Service Management release notes**

Service Management has new and updated features in the Helsinki release.
Customer Service Management release notes

ServiceNow® Customer Service Management application enhancements and updates in the Helsinki release.

Activation information

You can activate the Customer Service Management plugin (com.sn_customerservice) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

New in the Helsinki release

| **Bi-directional account relationships** | Define the types of relationships that exist between customers and partners. Then use these defined relationship types to create relationship records between selected accounts, either partner-to-account or account-to-account. |
| **Account hierarchy** | Define a parent-child hierarchy between accounts and display the relationship in a tree map on the parent Account form. Use this hierarchy to allow contacts of parent accounts to access information in the child accounts. |
| **Contact relationships** | Use a contact relationship to add a contact from a different account to either of the accounts in an established account relationship. |
| **Account teams** | Define responsibilities for team members, assign the responsibilities to employees for specific account teams, and use them in your processes, such as sending notifications and assigning cases. |
| **Asset contact relationships** | Assign an asset to a customer contact who is responsible for managing that asset. Then, if required, limit access to the asset to the assigned user. |
| **Special handling notes** | Write brief messages about records. These notes can be displayed in an embedded list, related list, or pop-up window when you access a form. |
| **Targeted communications** | Create and publish content to targeted lists of both internal and external customers. To handle time- |
sensitive content, set dates to publish and retire content automatically.

**Knowledge product entitlements**
Designate the knowledge bases and knowledge articles that customers can view from the customer portal.

**Contact self-registration**
Customer contacts can submit registration requests from the customer portal.

**Request password reset**
Customer contacts can change their password or request a new password from the customer portal login screen.

**Manage customer profiles**
Customer contacts can view and manage their profile information on the customer portal.

**Customer notification preferences**
Customer contacts can set preferences for phone and email notifications on the customer portal.

**Delegated asset administration**
Customer and partner administrators can manage their assets and those of their customers by creating asset contact relationships and assigning assets to specific contacts.

**Facilities Service Management release notes**
ServiceNow® Facilities Service Management application enhancements and updates in the Helsinki release.

**Activation information**
The Facilities Service Management (com.snc.facilities_service_automation) plugin is available as a separate subscription. There are other facilities plugins that are provided with the subscription.

**Browser requirements**
If you are using Internet Explorer, you must use version 9 or later to use the Enterprise Move Planning tool and the interactive maps. You can also use any of the other generally supported web browsers.

**New in the Helsinki release**

- **Enterprise move**
Facility teams use Enterprise Move to plan and execute move scenarios in support of large or complex employee move requests.

**Changed in this release**

- *Parse and save area of spaces.*
- *Create a facilities schedule blackout* to prevent work from being performed in spaces, floors, buildings, campuses, and/or zones for a scheduled time period.
• Allow a space to be owned or charged back to multiple departments.
• Show any task on the interactive map.
• Add any catalog item to the map.
• Find an asset or CI.
• Create advanced saved filters to highlight spaces, based on conditions not supported by the simple user interface.
• Create map labels for any defined facilities space type.

Field Service Management release notes

ServiceNow® Field Service Management application enhancements and updates in the Helsinki release.

Activation information

The Field Service Management (com.snc.work_management) plugin is available as a separate subscription. This plugin activates related plugins if they are not already active.

Browser requirements

The central dispatch feature is supported on the following browsers:
• The latest public release of Firefox
• The latest public release of Chrome
• Safari version 6 and later
• Internet Explorer version 10 and later

New in the Helsinki release

Central dispatch

Dispatchers can assign and dispatch tasks to available field service agents using drag-and-drop capabilities. Intelligent agent recommendations are provided based on availability, location, and skills. The central dispatch board also provides search and filter capabilities, which helps dispatchers focus on specific tasks and agents.

Simplified parts sourcing

Use parts directly from personal stockrooms when working on a work order task without creating a part requirement and sourcing. Links are provided in the mobile user interface for creating a part requirement, using an asset, and removing an asset.

HR Service Management release notes

ServiceNow® HR Service Management application enhancements and updates in the Helsinki release.
Helsinki upgrade information

For information on changes in the Helsinki release that require your consideration before you upgrade, see Human Resources upgrade information.

Activation information

HR Service Management is available as a separate subscription. The Human Resources Application: Core (com.snc.hr.core) plugin provides basic HR features, and there are several other plugins that are provided with the subscription.

Following is a list of each additional plugin and the features it provides.

- Human Resources Application: Service Portal (com.snc.hr.service_portal) activates the employee self-service HR Service Portal. HR Service Portal is the external portal used for recruiting and pre-employment activities. It is used to interact with new employees after they are hired and before they start.
- Human Resources Application: HR Connect (com.snc.hr.hr_connect) sets up an HR chat queue and makes it available on the HR Service Portal. Your organization must activate Connect.
- Human Resources Application: Workday Integration (com.snc.hr.wday) provides two-way integration with the Workday solution for your organization.
- Human Resources Application: Reporting Overview (com.glideapp.report.hr.overview) provides the Overview and Overview Reporting dashboards.

Browser requirements

HR Service Portal requires Internet Explorer version 10 or later. The Manage HR Catalog and Manage HR Skills modules require Internet Explorer version 9 or later.

New in the Helsinki release

**HR Service Portal**

The Employee HR Service Portal is based on Service Portal. This single context-based portal supports the hire-to-retire process by adjusting the catalog items and knowledge content based on employment status.

- Allows HR to modify the layout, configure, and brand the employee portal experience to your specifications with the use of prebuilt HR widgets. Widgets define the user experience and streamline the interactions between an employee and HR.
- The My To Do List widget provides an indicator and launching point for any open employee tasks, such as reviewing and signing a document with the e-signature capability. It provides visibility into task due dates.
- The HR To Do List widget provides a visual indicator of the tasks that HR, Facilities, and IT are completing. It shows the activity in
progress, expected completion dates, and completion statuses.

- Additional widgets include Top Rated Articles, My Profile, My Team/Contacts, My Cases, Suggested Reading, Information, and Map/Weather. If no content exists for a widget, the widget is not displayed.

**Documentation completion and e-signature**

- HR can create, load, and define a document in the system.
- Implemented e-signature capabilities, which let users sign documents by entering their user names and passwords, typing their names, or drawing their names.
- Signature pad submission lets a user sign a single document and attach it to a document task. E-signature submission, on the task UI page, is attached to the HR case.

**PDF generator**

Augmented the PDF generator plugin to handle multiple PDF templates. Also included the ability to preview a template and edit content before generating a PDF document. The final signed document can be saved to the case for retrieval in the future.

**HR services implementation and automation**

20 prebuilt HR modules are provided across common HR areas. These modules are Benefits, Payroll, Employee Relations, HR Systems, and Employee Data Management.

- HR services use currency, percentage, and SSN widget types. Tables for medical, disability, insurance, and retirement benefits have been added. Also, an Angular page to manage the task model (to match the case model) is added. Includes explicit KB mapping to each service, letting you define the exact KB article to display to employees, eliminating the need for employees to search for related information.

**Catalog management**

Allows catalog administration pages to handle multiple depth categories. HR users with the role [hr_admin] can edit categories and items using the Manage HR Catalog module to allow the mapping of documents to catalogs.

**Changed in this release**

- HR task management: Implemented the ability to configure onboarding tasks and KB content based on employee profile criteria and includes a property defining a completion date.
• Improved ease of use and setup: Added improvements to ease the use and setup of HRSM, including validation of configuration alerts for HRSM and a more modern HR agent interface. Interface includes HR workbench view for case management, using List v3 implementation.
• Workday integration enhancements: Added Time Type and Employment End Day info to the HR Profile (hr_profile) table.
• Security enhancements: Secured client-callable script includes by removing impersonate checks. Added a property controlling the ACL impersonate checks on tasks, cases, attachments, images, audits, and history lines.
• User and profile enhancements: Removed common fields between the HR Profile (hr_profile) and Sys User (sys_user) tables.
• Assigned state: The assigned state was removed from the base system. When you have customizations that use the assigned state, import it into your current version. Go to your previous instance, copy your custom assigned state (export to XML), and import it to your current instance.

Human Resources upgrade information

Human Resources application upgrade information for the Helsinki release.

Added Human Resources Service Portal and Overview plugins

In Helsinki, the employee portal is built on top of the new HR Service Portal technology. This single context-based portal supports the hire-to-retire process by adjusting the catalog items and knowledge content based on employment status.

When activated, the Service Portal plugin allows HR employees to modify the layout, configure, and brand the employee portal experience to their specifications. Prebuilt HR widgets are used to define the user experience and streamline the interactions between an employee and HR.

The Overview plugin provides a Human Resources Overview module for HR to get a big-picture view of cases and case states. HR can add content to the module and modify the module layout if desired.

HR services and implementation

The Helsinki release provides 20 prebuilt HR Services across common HR centers of excellence, such as Benefits, Payroll, Employee Relations, HR Systems, and Employee Data Management.

Table 1: Helsinki includes 20 prebuilt HR services

<table>
<thead>
<tr>
<th>Prebuilt service</th>
<th>Service items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benefits</td>
<td>• Beneficiaries</td>
</tr>
<tr>
<td></td>
<td>• Medical benefits</td>
</tr>
<tr>
<td></td>
<td>• Dental benefits</td>
</tr>
<tr>
<td></td>
<td>• HR policy questions</td>
</tr>
<tr>
<td></td>
<td>• General HR requests</td>
</tr>
<tr>
<td></td>
<td>• Employee relations questions</td>
</tr>
<tr>
<td></td>
<td>• HR systems questions</td>
</tr>
<tr>
<td></td>
<td>• Career questions</td>
</tr>
</tbody>
</table>
When you roll out the Helsinki Human Resources application, you want to evaluate the new HR Catalog and catalog items and update it with your custom catalog items.

HR Portal appears in the Self-Service menu, and is a refreshed portal for employees to use to interact with HR. It is based on the ServiceNow Content Management (CMS) application, and it is preconfigured with the Helsinki catalog categories and catalog items.

If you have not customized your HR Catalog, or the predefined items in Helsinki are sufficient, you can use the HR Portal when you upgrade. If the HR Portal is customized with your catalog items, engage someone in your organization with developer skills for CMS. If you do not have a developer with those skills, contact your ServiceNow account manager.

You can deactivate the HR Portal module until you are ready to make it available to your employees.

Human Resources templates

The Helsinki release offers both updated HR templates and new templates. If your organization created HR templates, the following takes place during the upgrade:

- Fuji HR templates that you created or modified are preserved in their Fuji state.
- Fuji templates that you did not modify are overwritten with Geneva enhancements during the upgrade from Fuji.
- You receive new templates that are predefined for Helsinki.

Review these templates as part of evaluating and preparing your HR catalog as described.

HR categories

In Fuji, HR case categories were in a choice list (sys_choice) table. In Geneva, HR categories are in a new Category (hr_category) table. During the upgrade, the categories are matched as closely as possible based on the Value field in the record.

For example, the Fuji category with the label Career Guidance has a value of Career. In the Helsinki HR category record, the label and value are both Career. Therefore, after the upgrade, HR cases that were assigned the Career Guidance category are assigned to the Career category.

If you had created custom categories in Fuji, they are added to the (hr_category) table during the upgrade and remain assigned to the HR cases.

Assignment rules

The Assignment Lookup Rules module in Fuji is called Assignment Rules. During the upgrade, only active assignment rules are preserved. If you have any assignment rules in Fuji that you are not using but want to preserve, you can take either of the following actions.

- Mark them active before you upgrade and then inactivate them in Helsinki.
- Note how they are set up and recreate them after the upgrade.
Note: The assigned state was removed from the base system. When you have customizations that use the assigned state, import it into your current version. Go to your previous instance, copy your custom assigned state (export to XML), and import it to your current instance.

Security Operations release notes

New in the Helsinki release, the ServiceNow® Security Operations Suite delivers security incident response, vulnerability response (including Qualys integration), and threat intelligence capabilities for the security practitioner.

Visibility into the state of an organization’s security can finally be achieved leveraging many of the same workflow and reporting capabilities ServiceNow is known for. By implementing this NIST compliant workflow in a security context, we can also free up the security analyst to spend more time finding advanced threats and less time on manual coordination and collaboration among the broader IT organization.

Security Incident Response release notes

ServiceNow® Security Incident Response application enhancements and updates in the Helsinki platform release.

Activation information

An administrator can activate the Security Incident Response (com.snc.security_incident) plugin.

Browser requirements

See Generally supported browsers.

New in the Helsinki platform release

- **Dashboards for CISO and Security Manager**
  Chief security officers and security managers can view dashboards that target specific security metrics based on criticality, service impact, or SLAs related to their roles.

- **Affected users added to security incidents**
  Often, security incidents can be targeted at users or groups, as opposed to CIs. Multiple incidents for the same affected user can be an indication of a greater problem.

- **Business Criticality calculator**
  The business criticality calculator uses an aggregate of other severity calculators to calculate the potential impact on your business that is posed by a security incident or vulnerability.

- **Generic transform map**
  Data sources, such as Splunk, provide additional information that is not part of the base system table definition. When new fields are exposed in the Security Incident table, those fields are auto-
populated without needing to modify the import definition.

**Splunk integration**

Integration with Splunk via a Splunkbase application lets security analysts and responders create events or incidents in Security Incident Response. This function enables teams to collaborate on the downstream response to an incident while tracking all the runbook responses and hand-offs in ServiceNow Security Operations. ServiceNow Security Operations for Splunk is available at [https://splunkbase.splunk.com/](https://splunkbase.splunk.com/).

### Changed in this release

- **Administrator lockdown on by default**: The administrator lockout feature is enabled by default. A security role is required to access security features and records.
- **Role change**: sn_si.agent has been changed to sn_si.analyst.
- **Performance Analytics plugin**: Performance Analytics functionality has been split into its own plugin, because Performance Analytics dashboards require separate licensing.
- **Post-incident review is automatically generated**: When the post incident review (PIR) reaches the Review state, the report is automatically generated. When a security assessment is taken, the report is generated again.
- **UI simplifications**:
  - New menu items are tailored for Security Analysts.
  - Additional entries were added to integrate with common-used filters.
  - Menu entries are role-sensitive so that users with different roles are presented with tailored, optimized navigation menus.

### Threat Intelligence release notes

ServiceNow® Threat Intelligence is a new application in the Helsinki platform release.

Threat Intelligence integrates with ServiceNow Security Operations to include an Indicator of Compromise (IoC) threat table that is linked to security incidents and configuration items or assets. This IoC functionality helps you determine whether a threat has been seen before in other security incidents or on other systems. It gives you context when assessing the severity of an alert or incident.

Threat Intelligence enables support for multiple threat feeds, the ability to query multiple sources for reputational ratings. It supports STIX format and TAXII exchange profiles.

See [Threat Intelligence](#) for more information.

### Activation information

An administrator can activate the Threat Intelligence (com.snc.threat) plugin.

### Browser requirements

See [Generally supported browsers](#).
Vulnerability Response release notes

ServiceNow® Vulnerability Response application enhancements and updates in the Helsinki platform release.

Activation information

An administrator can activate the Vulnerability Response (com.snc.vulnerability) plugin.

Browser requirements

See Generally supported browsers.

New in the Helsinki platform release

- **Vulnerability-centric view and remediation**: Vulnerabilities can be reviewed and addressed as an aggregated grouping of CIs. This grouping facilitates enhanced bulk response actions on entire groups of CIs to accelerate the remediation of vulnerabilities.

- **Time-boxed acceptance of vulnerabilities with approval workflow**: Each vulnerability can be ignored for a specific amount of time, so you can defer addressing it or accept the risk.

- **SLA support for vulnerable items and vulnerabilities**: Examples of SLAs associated with both vulnerable items and vulnerabilities have been provided. The examples include deadlines based on the severity of the vulnerabilities.

- **Integration with external vulnerability scanners**: A framework for integrating with external vulnerability scanners has been added, including a reference implementation for the Qualys vulnerability scanner. Scans from these scanners can be requested from within Vulnerability Response.

- **Business Criticality calculator**: The business criticality calculator uses an aggregate of other severity calculators to calculate the potential impact on your business that is posed by a security incident or vulnerability.

Changed in this release

- **Performance Analytics plugin**: Performance Analytics functionality has been split into its own plugin, because Performance Analytics dashboards require separate licensing.
- **Vulnerability rollup**: Vulnerable items can be handled at the vulnerability level. You can ignore a vulnerability, postpone an action, or perform a change at the vulnerability level instead of at the vulnerable item level.
- **Enhancements to dashboards**: Many reports were added to Vulnerability Response dashboards, including the following reports:
• Open vulnerable items by CI
• Open vulnerable items by vulnerability
• Ignored vulnerable items expiring this week
• Vulnerabilities discovered timeline
• Most vulnerable CI model
• Most vulnerable software publishers
• Vulnerable item aging

Performance Analytics and Reporting release notes
Performance Analytics and Reporting have new and updated features in the Helsinki release.

Dashboards release notes
ServiceNow® Dashboards feature enhancements and updates in the Helsinki release.

Activation information
• Dashboards are included with a Performance Analytics for Incident Management. Collecting data from other tables becomes available with a Performance Analytics Premium license.
• Performance Analytics content packs, which contain preconfigured dashboards, are available without enabling Performance Analytics Premium. However, data for these packs cannot be collected until Performance Analytics Premium has been enabled.

Browser requirements
Responsive dashboards are not supported on Internet Explorer 7 and 8.

New in the Helsinki release

Responsive dashboards
Responsive dashboards help you easily find widgets that you want to add to dashboards. Drag-and-drop to move and resize widgets. Existing dashboards are not affected.

To use responsive dashboards, you must activate the Responsive canvas plugin.

Dashboard groups
Organize dashboards into groups.

Interactive filters for empty and non-empty fields
Create an interactive filter that filters for empty and non-empty fields.

Application overview homepages
Improved overview homepages are available for multiple applications such as Incident, Problem, Change, Knowledge Management, CMDB, and Customer Service.
Changed in this release

• **Exclude items from a choice list** for interactive filters.

• Widgets show a filter icon ( ) when they are following an interactive filter.

• Add reports to responsive dashboards with the Reports category, instead of selecting Gauges (table name).

• **Set dashboards as your Home** instead of homepages.

• Two new system properties enable administrators to optimize widget rendering on responsive dashboards.

• The look and feel of homepages has been updated.

• Administrators can more easily manage dashboards with the newDashboard Admin module.

Performance Analytics release notes

ServiceNow® Performance Analytics application enhancements and updates in the Helsinki release.

Helsinki upgrade information

For information on changes in the Helsinki release that require your consideration before you upgrade, see [Performance Analytics upgrade information](#).

Activation information

Content packs may be activated without Performance Analytics Premium. However, data for these packs cannot be collected until Performance Analytics Premium has been enabled. Performance Analytics Premium requires an additional subscription.

Browser requirements

The animations that play when a visualization loads are not supported in Internet Explorer.

New in the Helsinki release

- **Heatmap widget**
  
  Visualize scores broken down by two separate metrics in a color-coded pivot table.

- **Interactive breakdown widgets**
  
  When you view a breakdown widget on a dashboard, you can change the widget visualization and breakdown.

- **In-form analytics**
  
  Access context-sensitive analytics based on the current record when viewing a form.

- **Content packs**
  
  New content packs enable you to track and analyze key metrics for common applications. Content packs provide necessary dashboards, indicators, breakdowns, widgets, and other configuration records. Optional in-form analytics
packs let you access the content pack data directly from application forms.

Changed in this release

• Workbench widget:
  • View collected records on a workbench widget.
  • Specify a default primary indicator for a workbench widget. The default primary indicator and associated secondary indicators appear first when viewing the widget.
  • Use the tab button to scroll through secondary indicators in a workbench process widget.

• Data collection:
  • The com.snc.pa.dc.keep_scores_for and com.snc.pa.dc.keep_snapshots_for properties were replaced with the com.snc.pa.dc.keep_scores_for.frequency and com.snc.pa.dc.keep_snapshots_for.frequency properties. The new properties let you define how long to keep scores and snapshots for each indicator frequency.
  • Specify how many periods, such as days or weeks, to collect and store data for each indicator using the Collection periods section of the Indicator form.
  • Data collection jobs do not collect scores or snapshots that the cleanup job would immediately delete, as specified in the com.snc.pa.dc.keep_snapshots_for.frequency property or the Collection periods indicator.
  • Data collection jobs have the Job ID value PAJob, letting you more easily identify data collection jobs in lists.
  • Data collection jobs use less system memory when collecting scores and snapshots.
  • You must specify an Owner to run data collection jobs. In previous releases, the Owner field could be empty.

• Clean PA collections scheduled job:
  • The Clean PA collections job runs at 05:00 by default, which was changed from 02:00.
  • Users with the pa_admin role can access and modify the Clean PA collections scheduled job from the Performance Analytics application menu.
  • The Clean PA collections scheduled job automatically deletes scores and snapshots that do not have an associated indicator or breakdown.

• Domain Separation support:
  • Properties that begin with com.snc.pa can be set only by administrators in the global domain.
  • Data collection jobs can be modified only by users with the pa_admin role. If domain separation is enabled, the pa_admin user must also be a member of the domain that contains the job, or the domain of the Run as user.

• Performance Analytics REST API:
  • The Performance Analytics REST API supports the sysparm_include_score_notes parameter to retrieve notes added to scores.
  • The Performance Analytics REST API supports the sysparm_include_aggregates parameter to retrieve available aggregates for an indicator when an aggregate has already been applied.
  • The Performance Analytics REST API includes the name and label of the facts table, the encoded query, the format of the selected unit, and the indicator frequency when you query scorecard data.

• Performance Analytics Mobile App:
  • The Performance Analytics mobile app is now part of the standard platform mobile app.
• The Performance Analytics mobile app supports landscape mode in addition to portrait mode.
• The Performance Analytics mobile app displays units based on the defined indicator unit format.
• Access the list of records associated with a scorecard from that scorecard in the Performance Analytics mobile app.

• Configure a formula indicator so that breakdowns do not apply to certain elements in the formula.
• Specify targets and thresholds on 2nd-level breakdowns.
• Create an indicator source using an existing report source.
• The Show data labels field is available for breakdown widgets.
• Compare changes in collected records for an indicator using real-time data, in addition to historical data.
• View real-time scores in breakdowns on a detailed scorecard, and on the workbench process widget.
• Configure which columns appear when viewing the Records tab of a detailed scorecard.
• The com.snc.pa.premium property lets you disable Performance Analytics Premium.
• A link to the detailed scorecard for an indicator is available on the Indicator form.
• An additional template for last score widgets is available.
• Additional sorting options are available for breakdown widgets.
• Configure formula indicators to apply time series aggregations to the formula result, or to formula components individually.
• Indicators filtered by a breakdown use standard platform formatting instead of slashes to display the filtered indicator name.
• Pivot scorecard breakdown widgets let you specify a label for displayed indicators, a breakdown element filter, and which axis the indicators and breakdown elements appear on.
• Score type widgets load asynchronously to improve dashboard load speed.
• Elements within widgets such as text and visualizations resize automatically when the size of the widget changes.
• The guided indicator setup workflow displays lists and filters using List v3, and includes a summary page that lets you review changes.
• The Job Indicator exclude breakdowns slushbucket displays only breakdowns associated with the selected indicators.
• The pa.job.threshold.reached event includes the sys_id of the threshold that was reached.
• The Percentages field is available for breakdown widgets that use the stacked column visualization. Select Percentage of elements to display the percentage of the total score for each stacked segment.
• Visualizations display an animation when they first load or are refreshed.

Performance Analytics upgrade information

Performance Analytics upgrade information for the Helsinki release.

Maintain scores and snapshots per frequency

The duration that scores and snapshots are maintained now differs for each indicator frequency.

The properties com.snc.pa.dc.keep_scores_for.frequency and com.snc.pa.dc.keep_snapshots_for.frequency replaced the properties com.snc.pa.dc.keep_scores_for and com.snc.pa.dc.keep_snapshots_for. The new properties accept a semicolon-separated list of numbers; each number indicates how many periods to keep scores or snapshots for an indicator frequency.

The length of each period depends on the indicator frequency. For example, daily scores are kept for 732 days by default, or weekly scores for 105 weeks.
Review these properties after upgrading to Helsinki. If you set a custom value for either com.snc.pa.dc.keep_scores_for or com.snc.pa.dc.keep_snapshots_for, Performance Analytics uses the custom values for all frequencies in the com.snc.pa.dc.keep_scores_for.frequency and com.snc.pa.dc.keep_snapshots_for.frequency properties.

Note: This may cause non-daily periods to be stored for longer than expected. For example, if you set a custom value of 900 days for com.snc.pa.dc.keep_scores_for, after upgrade scores for all frequencies will be stored for 900 periods, such as 900 days for daily scores and 900 months for monthly scores. Modify the new properties to adjust how long to maintain scores and snapshots.

You can also specify the number of periods to maintain scores and snapshots for individual indicators using the Collection periods section of the Indicator form.

Reporting release notes

ServiceNow® Reporting feature enhancements and updates in the Helsinki release.

Helsinki upgrade information

For information on changes in the Helsinki release that require your consideration before you upgrade, see Reporting upgrade information.

Activation information

Platform feature. Active by default. Some advanced reporting functionality is available only when Performance Analytics Premium has been licensed.

New in the Helsinki release

- **Map reports**
  Map reports enable you to plot geographical data on a map. Data on maps can be viewed as a heatmap or pinned locations.

- **Updated calendar reports**
  An updated version of calendar reports provides better interactivity and improved look-and-feel.

- **Real-time updating of single score widgets on dashboards**
  Single score widgets that use count aggregation and have been added to a dashboard can be configured to update in real time.

The following podcast provides more information on new features in the Helsinki release of Reporting.

Changed in this release

- Reports can no longer be made into gauges. Reports are added to dashboards and homepages from the Reports category instead of the Gauges category. Gauges still exist in other parts of the ServiceNow platform. The gauge_maker role is deprecated.
- The new Decimal precision field enables administrators to specify how many decimal places are displayed on a report. This field exists in the style options of applicable reports.
• When scheduling list reports, you can export to the Excel XLSX format in addition to XLS. Use the XLSX format instead of XLS for optimal performance.
• The Heavy, Most used, and Unused tabs have been removed from the View / Run module. Administrators can view this information in the new Report Statistics module. The properties that configured these tabs have been removed.
• Two new system properties enable you to define the maximum number of events displayed in calendar reports.
• On calendar reports, events that have no end date have a duration of one hour and appear on the calendar. Previously, these events did not appear on calendar reports.
• On calendar reports, events that started more than 30 days before the first day visible on the calendar are no longer displayed for performance reasons.
• The Left align legend text style option was added for reports that have legends. By default, this option is not selected and the legend text is centered.
• Only the creator of a report can set the report visibility to Me, ensuring that the report creator retains access to the report.
• For the Export settings report option, the Export settings field has been renamed to Export report details.
• When configuring a Stack by on a report, you can dot walk to fields.
• Apply style options to report drilldowns.
• When you export a report with a legend to PDF, PNG, or JPG, the entire legend is exported. Previously, large legends were sometimes truncated. Large legends with 50 or more items can still be truncated.
• Report legends no longer have a border by default. Users can choose to display the legend border in the style options for the report.
• The new Series name field allows you to customize the legend name of additional data series that you add to reports. For more information, see Using multiple datasets in a report.
• Service catalog variables that are included in a variable set can now be reported on in the same way as the other service catalog variables.
• Custom chart creation is now deprecated. Multiple data set functionality is now found in the report builder when Performance Analytics Premium is enabled. See Using multiple datasets in a report.
• Data collection based on scripts or formulas is now a function of Performance Analytics. See Performance Analytics data collection and cleanup.

Reporting upgrade information

Reporting upgrade information for the Helsinki release. Review this information to ensure users retain access to reports after upgrade.

In Fuji, the logic behind how sys_report ACLs were applied changed. If you upgrade from a release before Fuji to Fuji or later without the Report Security - enforce access control checks plugin enabled, changes in report access may occur. For example, users without the admin role may lose read access to reports because of security constraints.

Because the Report Security plugin overrides ACL customizations, it is not enabled by default upon upgrade. You must enable it manually.

Follow these steps to enable the plugin. You can enable it before or after upgrade.

1. Activate the Report Security (com.glideapp.report_security) plugin on a sub-production instance and test to ensure activation does not cause changes to existing reporting functionality.

2. After testing is completed, activate the plugin in production.
If changes in reporting functionality persist after you activate the plugin, this may be because ACLs were improperly updated because of customizations. Manually update your `sys_report` ACLs to comply with the ACLs below.

**sys_report create ACL**

```javascript
var userID = current.user.toString();
var answer = false;
var isMe = gs.getUserID() == userID;
var isGlobal = userID == "GLOBAL";

if (gs.hasRole('report_admin'))
    answer = true;
else if (isGlobal)
    answer = gs.hasRole('report_global');
else if (current.user == 'group')
    answer = gs.hasRole('report_group');
else
    answer = gs.hasRole(current.roles);

function isGroup()
{
    var grpList = gs.getUser().getMyGroups();
    var myGrps = '';
    for (var i = 0; i != grpList.size(); i++) {
        if (i != 0) myGrps += ', '
        myGrps += grpList.get(i);
    }

    var myUserId = gs.getUserID();
    var gr = new GlideRecord('sys_report_users_groups');
    gr.addQuery('report_id', current.getUniqueValue());
    var qc = gr.addQuery('user_id', myUserId);
    if (myGrps != '')
        qc.addOrCondition('group_id', 'IN', myGrps);
    gr.query();
    if (gr.getRowCount() > 0)
        return true;
    return false;
}
```

**sys_report delete ACL**

```javascript
var answer = false;
var userID = current.user.toString();
var isMe = gs.getUserID() == userID;
var isGlobal = userID == "GLOBAL";

if (isMe || gs.hasRole('report_admin'))
    answer = true;
else if (isGlobal)
    answer = gs.hasRole('report_global');
else if (isGroup())
    answer = gs.hasRole('report_group');
else
    answer = gs.hasRole(current.roles);
```

function isGroup()
{
    var reportUserId = current.user.toString();
    if (reportUserId != "group")
        return false;

    var grpList = gs.getUser().getMyGroups();
    var myGrps = ';';
    for (var i = 0; i != grpList.size(); i++) {
        if (i != 0) myGrps += ', ';
        myGrps += grpList.get(i);
    }
```

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
myGrps += grpList.get(i);
}

var myUserId = gs.getUserID();
var gr = new GlideRecord('sys_report_users_groups');
gr.addQuery('report_id', current.getUniqueValue());
var qc = gr.addQuery('user_id', myUserId);
if (myGrps != '')
    qc.addOrCondition('group_id', 'IN', myGrps);
gr.query();
if (gr.getRowCount() > 0)
    return true;
return false;
}

sys_report read ACL

answer = false;
var userID = current.user.toString();

var isUser = gs.getUserID() == userID;
if (isUser) {
    answer = true; // my own report
} else {
    var isGlobal = userID == "GLOBAL";
    if (isGlobal)
        answer = gs.hasRole(current.roles);
    else
        answer = isGroup();
}

function isGroup() {
    var reportUserId = current.user.toString();
    if (reportUserId != "group")
        return false;

    var myUserId = gs.getUserID();
    var grpList = gs.getUser().getMyGroups();
    var myGrps = '';
    for (var i = 0; i != grpList.size(); i++) {
        if (i != 0) myGrps += ',';
        myGrps += grpList.get(i);
    }

    var gr = new GlideRecord('sys_report_users_groups');
    gr.addQuery('report_id', current.getUniqueValue());
    var qc = gr.addQuery('user_id', myUserId);
    if (myGrps != '')
        qc.addOrCondition('group_id', 'IN', myGrps);
    gr.query();
    if (gr.getRowCount() > 0)
        return true;
    return false;
}

sys_report write ACL

var answer = false;
var userID = current.user.toString();
var isMe = gs.getUserID() == userID;
var isGlobal = userID == "GLOBAL";

if (isMe || gs.hasRole('report_admin'))
    answer = true;
else if (isGlobal)
    answer = gs.hasRole('report_global');
else if (isGroup())
    answer = gs.hasRole('report_group');

function isGroup(){
    var reportUserId = current.user.toString();
    if (reportUserId != "group"){
        return false;
    }

    var grpList = gs.getUser().getMyGroups();
    var myGrps = '';
    for (var i = 0; i != grpList.size(); i++) {
        if (i != 0) myGrps += ',';
        myGrps += grpList.get(i);
    }

    var myUserId = gs.getUserID();
    var gr = new GlideRecord('sys_report_users_groups');
    gr.addQuery('report_id', current.getUniqueValue());
    var qc = gr.addQuery('user_id', myUserId);
    if (myGrps != '')
        qc.addOrCondition('group_id', 'IN', myGrps);
    gr.query();
    if (gr.getRowCount() > 0)
        return true;
    return false;
}

Available versions (Helsinki)

The Helsinki family includes Enterprise patches and hot fixes, as well as releases for Password Reset, ODBC, and Mobile.

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Q1 2019 Patching Program Targets

<table>
<thead>
<tr>
<th>Release</th>
<th>Patch target option</th>
<th>Release notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kingston</td>
<td>Kingston Patch 12</td>
<td>Kingston</td>
</tr>
<tr>
<td>London</td>
<td>London Patch 4 Hot Fix 2</td>
<td>London</td>
</tr>
</tbody>
</table>

- Targets are subject to change prior to patching. Target versions change only if absolutely necessary.
• ServiceNow will occasionally add an additional letter to some patch and hot fix names (for example, Helsinki Patch 9a). Please consult the release notes for the list of fixes included in each version.

Available versions

For patch release notes that are not yet listed below, refer to KB0656793.
For publicly available hot fix and security patch release notes that are not yet listed below, refer to KB0598632.

<table>
<thead>
<tr>
<th>Release version</th>
<th>Release type</th>
<th>Released on</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helsinki Patch 12 Hot Fix 1</td>
<td>Hot fix</td>
<td>2017/12/05</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 12a</td>
<td>Security patch</td>
<td>2017/09/29</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 12</td>
<td>Patch</td>
<td>2017/08/24</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 11b Hot Fix 1</td>
<td>Hot fix</td>
<td>2017/08/03</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 11b</td>
<td>Security patch</td>
<td>2017/07/17</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 11a</td>
<td>Security patch</td>
<td>2017/06/28</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 11</td>
<td>Patch</td>
<td>2017/06/09</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 10</td>
<td>Patch</td>
<td>2017/05/04</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 9 Hot Fix 1c</td>
<td>Hot fix</td>
<td>2018/01/23</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 9 Hot Fix 5a</td>
<td>Hot fix</td>
<td>2017/07/12</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 9 Hot Fix 4a</td>
<td>Hot fix</td>
<td>2017/06/29</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 9 Hot Fix 3a</td>
<td>Hot fix</td>
<td>2017/05/18</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 9 Hot Fix 2a</td>
<td>Hot fix</td>
<td>2017/05/14</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 9 Hot Fix 1a</td>
<td>Hot fix</td>
<td>2017/04/04</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 9a</td>
<td>Hot fix</td>
<td>2017/03/24</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 9</td>
<td>Patch</td>
<td>2017/02/14</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 8 Hot Fix 1</td>
<td>Hot fix</td>
<td>2017/02/27</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 8</td>
<td>Patch</td>
<td>2016/12/15</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 7 Hot Fix 5</td>
<td>Hot fix</td>
<td>2017/06/07</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 7 Hot Fix 4</td>
<td>Hot fix</td>
<td>2017/04/25</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 7 Hot Fix 3</td>
<td>Hot fix</td>
<td>2017/03/20</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 7 Hot Fix 2</td>
<td>Hot fix</td>
<td>2016/01/27</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 7</td>
<td>Patch</td>
<td>2016/11/17</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 6 Hot Fix 3</td>
<td>Hot fix</td>
<td>2016/12/02</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 6 Hot Fix 1</td>
<td>Hot fix</td>
<td>2016/10/28</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 6</td>
<td>Patch</td>
<td>2016/10/20</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 5 Hot Fix 3</td>
<td>Hot fix</td>
<td>2016/02/08</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Release version</td>
<td>Release type</td>
<td>Released on</td>
<td>Availability</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>--------------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Helsinki Patch 5 Hot Fix 1</td>
<td>Hot fix</td>
<td>2016/11/01</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 5</td>
<td>Patch</td>
<td>2016/09/21</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 4 Hot Fix 5</td>
<td>Hot fix</td>
<td>2017/04/12</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 4 Hot Fix 4</td>
<td>Hot fix</td>
<td>2017/01/31</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 4 Hot Fix 3</td>
<td>Hot fix</td>
<td>2017/01/05</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 4 Hot Fix 2</td>
<td>Hot fix</td>
<td>2016/10/25</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 4 Hot Fix 1</td>
<td>Hot fix</td>
<td>2016/09/15</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 4</td>
<td>Patch</td>
<td>2016/08/31</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 3 Hot Fix 13</td>
<td>Hot fix</td>
<td>2016/01/27</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 3 Hot Fix 11</td>
<td>Hot fix</td>
<td>2016/11/01</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 3 Hot Fix 10</td>
<td>Hot fix</td>
<td>2016/11/01</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 3 Hot Fix 9</td>
<td>Hot fix</td>
<td>2016/10/20</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 3 Hot Fix 7</td>
<td>Hot fix</td>
<td>2016/09/30</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 3 Hot Fix 6</td>
<td>Hot fix</td>
<td>2016/09/29</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 3 Hot Fix 5</td>
<td>Hot fix</td>
<td>2016/09/20</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 3 Hot Fix 3 (Express only)</td>
<td>Hot fix</td>
<td>2016/09/08</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 3 Hot Fix 2</td>
<td>Hot fix</td>
<td>2016/08/29</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 3</td>
<td>Patch</td>
<td>2016/08/05</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 2 Hot Fix 6</td>
<td>Hot fix</td>
<td>2017/06/01</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 2 Hot Fix 5</td>
<td>Hot fix</td>
<td>2016/10/26</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 2 Hot Fix 4</td>
<td>Hot fix</td>
<td>2016/09/19</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 2 Hot Fix 3</td>
<td>Hot fix</td>
<td>2016/08/25</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 2 Hot Fix 2</td>
<td>Hot fix</td>
<td>2016/08/17</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 2 Hot Fix 1</td>
<td>Hot fix</td>
<td>2016/08/04</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 2</td>
<td>Patch</td>
<td>2016/07/07</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 1 Hot Fix 3</td>
<td>Hot fix</td>
<td>2016/08/31</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 1 Hot Fix 2</td>
<td>Hot fix</td>
<td>2016/08/09</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 1 Hot Fix 1</td>
<td>Hot fix</td>
<td>2016/07/07</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 1</td>
<td>Patch</td>
<td>2016/06/10</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 0 Hot Fix 4</td>
<td>Hot fix</td>
<td>2016/07/19</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 0 Hot Fix 3</td>
<td>Hot fix</td>
<td>2016/06/09</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 0 Hot Fix 2</td>
<td>Hot fix</td>
<td>2016/05/23</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Helsinki Patch 0 Hot Fix 1</td>
<td>Hot fix</td>
<td>2016/05/18</td>
<td>Unavailable</td>
</tr>
</tbody>
</table>
### Helsinki Fixes

<table>
<thead>
<tr>
<th>Release version</th>
<th>Release type</th>
<th>Released on</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helsinki Fixes</td>
<td>Feature</td>
<td>2016/04/28</td>
<td>Unavailable</td>
</tr>
</tbody>
</table>

Note: Refer to the PDF attachment in [KB0565309](#) for all other Helsinki fixes.

- **Available:** Any user can upgrade to the version. “Available” versions will appear on the [Instance Upgrade Management Dashboard](#).
  ServiceNow QPP targets and patches are immediately available. Users do not need to request an entitlement to schedule an upgrade to these versions.
- **Available by request:** [Contact ServiceNow Customer Support](#) for approval to upgrade to the version.
- **Unavailable:** The release version is not available.

### Mobile versions

For the latest iOS and Android mobile application release notes, refer to [KB0598602](#).

### Password Reset Windows Application releases

For the latest Password Reset Windows Application release notes, refer to [KB0598975](#).

### ODBC Driver releases

For available ODBC release notes that are not yet listed below, refer to [KB0540707](#).
The [ODBC Driver patch release notes](#) contain problem fixes for supported and legacy ODBC Driver patch versions.

### Helsinki Patch 12 Hot Fix 1

Helsinki Patch 12 Hot Fix 1 provides fixes for the Helsinki release.

For Helsinki Patch 12 Hot Fix 1:

- **Build date:** 11-27-2017_1318
- **Build tag:** glide-helsinki-03-16-2016_patch12-hottfix1-11-20-2017

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).

For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).

Note: This version is approved for FedRAMP.
Fixed problem in Helsinki Patch 12 Hot Fix 1

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow PRB1237836</td>
<td>Change requests raised with a Risk level of Critical do not move to Open/Approved even after all the approvals are in places</td>
<td>Join activities do not complete when the deprecated Rollback activity is used in the path up to the Join activity. The newer Rollback To activity still works successfully.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 12 Hot Fix 1

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 12
- Helsinki Patch 11b Hot Fix 1
- Helsinki Patch 11b
- Helsinki Patch 11a
- Helsinki Patch 11
- Helsinki Patch 10
- Helsinki Patch 9 Hot Fix 5a
- Helsinki Patch 9 Hot Fix 4a
- Helsinki Patch 9
- Helsinki Patch 8
- Helsinki Patch 7
- Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- Helsinki Patch 5
- Helsinki Patch 4
- Helsinki Patch 3
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 12

The Helsinki Patch 12 release contains fixes to these problems.

Helsinki Patch 12 was released on August 24, 2017. 

Build date: 08-21-2017_1152
Build tag: glide-helsinki-03-16-2016__patch12-08-08-2017
ServiceNow QPP targets and patches are immediately available. Users do not need to request an entitlement to schedule an upgrade to these versions.

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).

For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).

Note: This version is approved for FedRAMP.

### Security-related fixes

Helsinki Patch 12 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 12, refer to [KB0634662](#).

### Notable fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Transaction and Session Management</strong> PRB105691</td>
<td>Unclaimed transaction, whose underlying request gets recycled while waiting in queue, is left in the active transaction list</td>
<td>When an instance is running a large UI activity with presence enabled, the following error appears in the localhost logs: ‘Cancelling unclaimed (waiting) transaction’. This transaction will stay in the Active Transactions list until restart.</td>
<td></td>
</tr>
<tr>
<td><strong>Service Catalog</strong> PRB652351 KB0610420</td>
<td>RITM records are intermittently created without their variables</td>
<td>Variables are either being deleted or (more likely) are not even being created for some RITM records. This issue is not reproducible on demand. But based on the final outcome, the steps to reproduce are: 1. Order a Catalog Item. 2. Check whether variables are created. Note that sometimes the RITM is created without the variables.</td>
<td></td>
</tr>
<tr>
<td><strong>Service Catalog: Service Portal Widgets</strong> PRB91203</td>
<td>Date field submitted through an Order Guide on Service Portal reverts back to the current date</td>
<td>A date field whose value is a future date that is submitted through an Order Guide on Service Portal reverts back to the current date if the date format is set to anything else other than yyyy-MM-dd.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Persistence</td>
<td>A specific StackOverflowError during a query can leave a node in the corrupt state</td>
<td>During a database query, a specific StackOverflowError can lead to incorrect data deletion or insertion. Due to the unpredictable nature of the error, symptoms are varied and could include any or none of the following: • Multiple scheduled jobs (sys_trigger table) are mysteriously deleted. • Business rule records are mysteriously inserted (sys_scripts).</td>
<td></td>
</tr>
<tr>
<td>Configuration Management Database (CMDB)</td>
<td>&quot;Model too big&quot; exception in Service Model on svc_model_obj_element is breaking the whole service computation</td>
<td>The error should appear without causing computation to fail.</td>
<td></td>
</tr>
</tbody>
</table>

**All Other Fixes**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approvals</td>
<td>PRB1104750</td>
<td>Approval rule is not triggered when there is a condition</td>
<td>Approval rule is not triggered when there are existing approvals in the approval table on an update of a record.</td>
<td></td>
</tr>
<tr>
<td>Archiving</td>
<td>PRB868529</td>
<td>Archival rule on a table hierarchy does not archive the related records of children in the hierarchy</td>
<td>The archival plugin allows only one archive rule per table hierarchy. When an archive rule is defined on a parent table in a hierarchy to archive/delete related records, the archival will only archive records in the parent and child tables in the hierarchy. It will not archive/delete the related records of child tables.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Asynchronous Message Bus     | PRB1020423       | Long-running AMB unsubscribe transactions can result in business rules not running for the rest of the session | If your unsubscribe transaction is slow enough to get cancelled while we are loading table descriptors for variables tables (var_ *), your session may be left with workflow turned off. | 1. Navigate to a form.  
2. Invalidate the cache.  
3. Navigate away from the form. |  

| Change Management PRB833334  | KB0623301         | Orphaned change tasks are created when using ‘Copy Change’ on a Change Request with change tasks | If users “Copy Change” on a change request that has change tasks, and leave form without saving/updating, the tasks are saved, but the change is not, leaving orphaned change Tasks. | 1. Navigate to Change Open and open a change request that has change tasks that are created from workflow and manually.  
For more information, see the product documentation topic Configure change management.  
2. Click Copy Change.  
3. After the form of the newly created change request is displayed, click the browser’s Back button.  
4. Navigate to change_task_list.do.  
Note the newly created change tasks where Created from is manual that are not associated to a change record. |  

| Cloud Management Application  | PRB1020295       | For some VPCs, AWS VPC name is not displayed and it shows the actual VPC ID in the name field | VPC gets the right name, and then gets overwritten back to VPC ID when the DescribeInstances response is handled. Both the AWS console and the CloudCheckr tool are in sync and reporting the correct information. |  

| Cloud Management Application  | PRB712654         | Azure Discovery creates a lot of duplicate image records in Azure resource(cmdb_ci_azure_resource) table | After Discovery is run, there are 10,000+ image records in the cmdb_ci_azure_resource table. However, there are only 400+ images discovered in the image table. |  

© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Management Database (CMDB) PRB743045</td>
<td>Service Modeling</td>
<td>“Model too big” exception in Service Model on svc_model_obj is breaking the whole service computation</td>
<td>The error should appear without causing computation to fail.</td>
<td></td>
</tr>
</tbody>
</table>
| Core Platform PRB899686 | | A group can be its own parent, leading to infinite recursion | Prevent Recursion is a base system business rule on sys_user_group that protects against recursion. However, it can be bypassed when business rules are turned off. This can be caused by ‘A is parent of A’ scenario or a more extended loop, such as ‘C > B > A > C’. | 1. Deactivate the business rule Prevent Recursion on sys_user_group.  
2. Create a User Group (sys_user_group) where the Parent field is pointing to the group itself, creating a self-referencing group.  
3. Impersonate a user in the group, or add one if necessary.  
4. Open the My Group’s Work module.  
5. Navigate to System Logs Errors.  
Notice the StackOverflowError message. |
<p>| Customer Service Management PRB1107640 | Customer Service | Approval workflow is not working as expected when a plugin is active | This issue occurs when the customer service management demo data plugin is installed and there is more than one approval group in the approvals workflow. If users have the sn_customerservice.customer role, they do not need to wait for other approvers to approve a record. Then, the workflow activity is approved. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Customer Service Management PRB748503 | Customer Service  | Activating the Customer Service plugin results in contract records having a default scope of Customer Service instead of the global scope | Contract records have a default global scope regardless of whether customers are using the contracts list or form view. However, after customers activate the Customer Service plugin, if they open a contract record and go to Configure > Related list, the slush bucket incorrectly sets the application scope as customer service for the default view instead of the global scope. | 1. Install the Contract Management plugin.  
   For more information, see the documentation topic Activate a plugin.  
2. Navigate to Contract Contracts All and open any Contract record.  
3. Right-click in the header and choose Configure Related Lists.  
   You should be able to add or remove the related list for Default view.  
4. Install the Customer Service plugin.  
5. Navigate to Contract Contracts All and open any Contract record.  
6. Right-click in the header and choose Configure Related Lists.  
   You are no longer able to add or remove the related list for Default view within the Global application.  
   The Default view is in the Customer Service application but Global is the current application.  
7. Edit this related list:  
   a. Click Edit this View in Customer Service.  
   b. Choose any related list and click Save.  
   The following error is displayed: “Invalid ‘Table’ selected on the Related List record. The ‘Contract’ table is in application ‘Global’, but the current application is ‘Customer Service’.” |
<p>| Domain Support PRB855867 |  | DWR GenerateOperation is not creating updated DWR for tables which have the sys_overrides column | Domain path/code has been modified, but not all records have been updated with the new domain code/path. This is causing issues in the instance, such as reports are not appearing or the form is not showing the correct fields. |  |
| Edge Encryption PRB1035510 |  | Mass encryption fails for large datasets | Using Edge Encryption to encrypt big datasets at the same time can fail on certain areas with large attachments. |  |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Encryption</td>
<td>PRB701649</td>
<td>EdgeProxy fails to find a newer version of SafeNet API libraries</td>
<td>When SafeNet API libraries are upgraded to the newest version by copying corresponding JAR files into proxy/lib folder, proxy fails to find and load these libraries.</td>
<td></td>
</tr>
<tr>
<td>Edge Encryption</td>
<td>PRB706530</td>
<td>On the proxy, Safenet key type is ‘nae’ instead of ‘safenet’</td>
<td>Users see the error message “Unsupported Key Type” for SafeNet key”.</td>
<td></td>
</tr>
<tr>
<td>Event Management</td>
<td>PRB1080896</td>
<td>Fix alert correlation does not work as expected in domain-separated environments</td>
<td>If an alert’s domain is a child of the alert correlation rule’s domain, the rule is not visible for the alert.</td>
<td></td>
</tr>
</tbody>
</table>
| Human Resources Service Management | PRB1068127 | After enabling the HR plugin, the generate document UI action does not create the PDF and attach it to the case | 1. Activate the HR Core plugin.  
2. Create a new HR case:  
   Category: Employment Verification  
   PDF template: Employee Verification Letter in USA  
3. Impersonate Timothy Janski and click Start Work.  
4. Click Generate Document.  
5. Click Sign.  
6. Provide a signature.  
7. Click Accept.  
The document is not generated and attached to the HR case. | |
<p>| Import / Export | PRB944813 | Large CSV/JDBC/XLS imports hold memory through Import process | When importing data from large CSV, JDBC, or XLS files, memory usage increases and does not go down. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management with KCS PRB707431</td>
<td>Knowledge Management</td>
<td>When attaching a knowledge article to an incident, the use_count field for the attached knowledge article does not increment</td>
<td>On an incident form, related KB articles are shown in ‘Related Search Results’. When users click Attach or Preview and Attach to Incident, the Use Count field does not increment, even though a new record is inserted into the ‘Knowledge Use’ table.</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management V3 PRB718166</td>
<td>Knowledge Management V3</td>
<td>Creating a new KB article with instant ‘Publish Workflow’ publishes the article twice</td>
<td>If a Knowledge Base ‘Publish Workflow’ is set to ‘Instant’, after a new KB article is submitted and published, that particular article will be published twice. In the history, notice that this publishing occurs in two separate updates at the same time.</td>
<td></td>
</tr>
</tbody>
</table>
| MID Server PRB718011 | CyberArk | VMware Discovery does not work with CyberArk. VMware needs to add DomainName to account (identical to windows) - without a domain prefix, it cannot log in. | 1. Integrate with CyberArk.  
2. Add a VMware credential in CyberArk.  
3. Add the credential in ServiceNow.  
4. Discover the IP that hosts VCenter. |
| MID Server PRB886536 | CyberArk | AMB Client on the MID Server does not work in all environments. Need a way to revert to old MID Server polling frequency |

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Reset Application PRB1104617</td>
<td>Password Reset</td>
<td>After the deletion of a device from the enrollment page, clicking Submit redirects page to ‘Notification Preference’ with bad device reference</td>
<td>When an SMS device is deleted from a password reset enrollment, the exit screen returns to a device notification form rather than the enrollment successful screen.</td>
<td></td>
</tr>
</tbody>
</table>
| Password Reset Application PRB956033 | | activate_desktop_plugin.js can cause out of memory issues because the collision detector is restarted | | 1. Activate the com.glideapp.password_reset.addon.orchestration plugin.  
2. Upgrade the instance.  
The CollisionDetector is unnecessarily restarted before the next plugin is upgraded. |
| Persistence PRB741410 | | Before Query business rule works differently when using glide aggregate count | Under certain conditions, single score reports can display blank or incorrect data.  
If a Before Query business rule is configured on a table with one or more addOrCondition filter conditions, a single score report on that table generates an invalid SQL, and the OR condition is not in the right place. As a result, the single score reports or widgets display incorrect data.  
When the user drills down on the report, a list loads with the correct results. | |
<p>| Platform Performance PRB1058404 KB0623334 | Query hash values mismatch after upgrading | After upgrading to Helsinki or later, customers may experience query hints not being applied (that had previously been added to improve performance of specific queries). Queries that used to run fast will now be significantly slower. | Refer to the listed Known Error KB article for details. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Incident Response</td>
<td>Security Incident Response</td>
<td>When a report is scheduled on table sn_si_incident, the attachment of the report does not show all records or all fields. However, users can see all records and value when only the report is run or from the list view.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Catalog</td>
<td></td>
<td>When a report is scheduled on table sn_si_incident, the attachment of the report does not show all records or all fields. However, users can see all records and value when only the report is run or from the list view.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Level Agreement (SLA)</td>
<td></td>
<td>SLA retroactive start/pause - Incorrect timing calculation when attaching a Task SLA that is in a Paused stage at the time of attaching</td>
<td>When a Task SLA is in a Paused stage at the time of attaching, the last temporal piece of paused time is incorrectly added when calculating the elapsed time.</td>
<td>1. Create a P5 incident with state New. 2. Change the priority to P3. 3. As soon as the incident is created (within the first minute), move the state to On Hold. 4. Move the state to In Progress. 5. As soon as you complete step 4 (within the first minute), move the state back to On Hold again. 6. Wait a few minutes, and then change the incident’s priority to P1. The Task SLA will attach with the correct Stage (Paused) but with the wrong ‘Business Elapsed time’, ‘Business elapsed percentage’ and ‘Business time left’. The ‘Has breached’ flag is incorrectly set to True.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>ServiceNow Store Site</td>
<td>PRB1109494</td>
<td>Issue with UTF-8 support to upload files</td>
<td>After an app is uploaded, the app title shows up as ‘???’ if it contains Japanese characters.</td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB723439, KB0622405</td>
<td>Mandatory field alert is not translated</td>
<td>The alert texts “The following mandatory fields are not filled in” and “The following fields are incomplete” are not translated in the Service Portal.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>
| Survey Management             | PRB666195        | Selecting a choice for the mandatory question adds an asterisk symbol (grey in color) to non-mandatory questions | | 1. Login as an admin.  
2. Click View surveys in the left navigation, and create a new survey.  
3. Navigate to the survey created and click Survey designer.  
4. Add template control to the survey and add 3 questions to it. Make first question as mandatory and other two as non-mandatory.  
5. Save the changes and publish the survey.  
6. Go back to the survey, click Assign survey and assign it back to the user logged in.  
7. Select My Assessments & Surveys from the left navigation, and click Take survey of the survey created in steps above. Verify that there is an asterisk symbol for the first question and the 2nd and 3rd questions do not have any asterisk mark.  
8. Select any option for the first question. Notice that selecting a choice for the mandatory question adds asterisk symbol (grey in color) to non-mandatory questions. |
<p>| Survey Management             | PRB742422        | Survey will not be created by trigger condition | Survey trigger condition does not work on migrated surveys via update set. |                    |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey Management PRB955317</td>
<td></td>
<td></td>
<td>In Hebrew, creating a survey with question type ‘numeric scale’ results in ‘1’ appearing as ‘1.0’ in all rows</td>
<td>1. Activate the I18N:Internationalization plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Create a new survey that contains a question of type numeric scale.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Test this survey. The scale shows the numbers as 1 2 3 4 5 6 7.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Change the language to Hebrew.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Test the survey again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The scale shows the numbers as 1.0 2 3 4 5 6 7.</td>
</tr>
<tr>
<td>UI Components PRB914839 Tablet</td>
<td>Tablet UI Support - iPad with iOS 6+</td>
<td>Tablet UI bug - searching list fields</td>
<td>When accessing a field list in the Tablet UI, users are unable to search via the search fields. A “Processing...” message displays permanently, covering up parts of the search fields.</td>
<td>1. Install the tablet UI plugin and navigate to $tablet.do.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Navigate to IncidentsOpen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Click on any incident.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Inside that incident, click on the watch list magnifying glass.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Expected behavior: The “Processing...” message will go away after a few seconds, and the fields will be searchable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Actual behavior: The “Processing...” message stays up permanently, and the fields are not searchable.</td>
</tr>
<tr>
<td>Workflow PRB1042822</td>
<td></td>
<td></td>
<td>If the workflow has the rollback to activity, join activity is getting hung in different languages.</td>
<td>1. Install the tablet UI plugin and navigate to $tablet.do.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Navigate to IncidentsOpen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Click on any incident.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Inside that incident, click on the watch list magnifying glass.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Expected behavior: The “Processing...” message will go away after a few seconds, and the fields will be searchable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Actual behavior: The “Processing...” message stays up permanently, and the fields are not searchable.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Workflow PRB922 | | Switch activity is not getting conditions in Workflow editor when the session language is other than English | If the customer is using a different language other than English, Switch workflow activity may not work correctly. | 1. Activate/Install the Hungarian language plugin (I18N: Hungarian Translations).
2. Go to any catalog item (e.g., Apple iPad 3), and add a “Select box” type variable with at least 2 question choices.
3. Open the corresponding workflow of catalog item in ‘workflow editor’.
4. Change the session language to ‘Hungarian’.
5. Checkout the workflow and add the ‘Switch’ activity anywhere in the workflow (Alaptevékenységek Feltételek Kapcsoló).
6. In the “Switch” activity, select type = ’Variable’ and add the recently created ‘Select box’ variable.
7. Submit the ‘Switch’ activity. Notice the question choices appear.
8. Repeat the same steps with ‘English’ session.

The Switch activity shows desired conditions.|

Other Helsinki Patch 12 information

- Software Asset Management
  - **Activating Software Asset Management**
    The Software Asset Management plugin (com.snc.software_asset_management) must be activated by ServiceNow personnel. This plugin includes demo data and activates related plugins if they are not already active.

Fixes included with Helsinki Patch 12

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 11b Hot Fix 1**
- **Helsinki Patch 11b**
- **Helsinki Patch 11a**
- **Helsinki Patch 11**
- **Helsinki Patch 10**
- **Helsinki Patch 9 Hot Fix 5a**
Helsinki Patch 11b Hot Fix 1

The Helsinki Patch 11b Hot Fix 1 release contains fixes to these problems.

For Helsinki Patch 11b Hot Fix 1:  
Build date: 08-01-2017_1745  
Build tag: glide-helsinki-03-16-2016_patch11b-hotfix1-07-28-2017

ServiceNow QPP targets and patches are immediately available. Users do not need to request an entitlement to schedule an upgrade to these versions.

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Fixed problem in Helsinki Patch 11b Hot Fix 1

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approvals</td>
<td>Approval rule is not triggered when there is a condition in Helsinki Patch 11</td>
<td>Approval rule is not triggered when there are existing approvals in the approval table on an update of a record.</td>
</tr>
<tr>
<td>PRB1104750</td>
<td>Approval rule is not triggered when there is a condition in Helsinki Patch 11</td>
<td>Approval rule is not triggered when there are existing approvals in the approval table on an update of a record.</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 11b Hot Fix 1

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.
Helsinki Patch 11

The Helsinki Patch 11 release contains fixes to these problems.

Helsinki Patch 11 was released on June 9, 2017.  
Build date: 06-05-2017_1744  

ServiceNow QPP targets and patches are immediately available. Users do not need to request an entitlement to schedule an upgrade to these versions.

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Security-related fixes

Helsinki Patch 11 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 11, refer to KB0623092.

Notable fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI Components</td>
<td>PRB656644 KB0564218</td>
<td>Font size in TinyMCE HTML editor in Geneva is not consistent with WYSIWYG standard</td>
<td>Prior to Geneva, text in the TinyMCE HTML editor defaulted to 10pt. Then, if the text was updated to 10pt through the font size option, it remained the same size as the default one (this is consistent with WYSIWYG). Now in Geneva, the default text starts as (seemingly) 10pt, but if the text is updated to 10pt it looks like it has been updated to 14pt. This is not consistent with WYSIWYG. Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Lists</td>
<td>PRB668634</td>
<td>Related lists do not load when glide.ui.list_v3.related_list is set to ‘true’</td>
<td>1. Set the glide.ui.list_v3.related_list system property to true. 2. Make sure you are in tabbed mode. 3. Go to the Incident table. 4. Go to any record. 5. Ensure you only have one related list on the form. Notice the related list does not load.</td>
</tr>
<tr>
<td>Survey Management</td>
<td>PRB701182 KB0597922</td>
<td>The ‘Cancel Expired Assessments’ job cancels surveys before the due date if the date format is dd/MM/yyyy</td>
<td>If you change the date format of your Helsinki instance to dd/MM/yyyy, the ‘Cancel Expired Assessments’ Job performs incorrect date comparisons, which causes surveys that are not yet due to be cancelled. Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>
| Discovery        | PRB725029                                     | Configurations are being created with the name 

```
[OBJECT OBJECT]
```

(\[OBJECT OBJECT\])                                                                 | Configuration items are being created with the name “\(\{OBJECT OBJECT\}\).\(\{OBJECT OBJECT\}\)”                                                                                     | 1. Connect to a MID server. 2. Perform Quick Discovery on any of your Windows Cls. Note that the Discovery log shows “Exactly one match was found in the CMDB: \(\{OBJECT OBJECT\}\).\(\{OBJECT OBJECT\}\)”.

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Authentication PRB654728 |  | Patching or update results in SAML2 installation exit activation, even though MultiSSO is active | There are 3 record producers in ChangeStandard ChangeStandard ChangeTemplate Management:  
• Propose a new Standard Change Template  
• Modify a Standard Change Template  
• Retire a Standard Change Template  
These record producers have a read-only protection policy that prevents users from changing the record producer names. | Refer to the listed Known Error KB article for details. |
| Change Management PRB718552 KB062172 | Change Management - Standard Change Catalog | Some base system record producers have a read-only protection policy that prevents them from being renamed | The default Standard Change Proposal workflow has a Run Script activity called Validate Categorization, and the “Success” condition has the following condition:  
```
activity.answer=='Success'
```
The condition should be:  
```
activity.answer == 'success'
```
The StdChangeUtils script will only return lowercase values. | |
<p>| Change Management PRB704664 | Change Management - Standard Change Catalog | Standard Change Proposal workflow is not set up correctly | | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Contextual Search | Contextual search fails | PRB725034                               | Contextual search fails, and exceptions appear in the logs.                                       | 1. Go to incident.do.  
2. Paste the following string in the Short description field:  
   HSRVBWD1 Disk Free: C:\ 4 % (Free Space) is below the error limit of 5 % in Free Space  
The contextual search fails, and exceptions appear in the logs. |
| Knowledge Management V3 | Relevancy score is getting calculated as -1 when searching select articles from the knowledge homepage. | PRB910622                               | Knowledge base search is not working as expected. Though search results are ordered by the relevance/rank, records with higher rank are given a relevancy number of -1, which puts them at the very bottom of the search results that can span multiple pages. This issue occurs on the knowledge reach results page when the property glide.knowman.search.show_relevancy is set to true. | 1. Go to the property glide.knowman.search.show_relevancy and set its value to true (/ nav_to.do?uri=sys_properties.do?sys_id=99b08383d713210013ab49547e610307).  
2. Create and publish a knowledge article with the short description “Test of PRB910622 - 07 JUNE 2017 Workflow states EXTERNAL KNOWLEDGE BASE”.  
3. Navigate to Knowledge › Create New.  
   • Short description: “Test of PRB910622 - 07 JUNE 2017 Workflow states EXTERNAL KNOWLEDGE BASE”  
   • Knowledge base: Knowledge  
   • Right-click on the header and click Save.  
   • Click Publish.  
4. Navigate to Knowledge › Homepage.  
5. Search for “Test of PRB910622 - 07 JUNE 2017 Workflow states EXTERNAL KNOWLEDGE BASE”.  
Notice that the “Relevancy” value for the knowledge article is -1. If you reduce the search on step 4 for “Test of PRB910622” the issue will no longer be reproducible. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Platform PRB717578</td>
<td>When domain separated is enabled, form caches should key entries more effectively</td>
<td>ActionManager (UI actions) should define syscache.ui_action as the private cacheable instead of sys.ui_action. In addition, ActionManager domain selection should retrieve the domain from the record, not the session. Domains for the sys_choice cache should also be implemented correctly.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Core Platform PRB753517</td>
<td>GlideWrapFactory is using the wrong scope</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Core Platform PRB963801</td>
<td>When a glide_list field is made from choice entries instead of referenced records, forms do not always load completely</td>
<td>glide_list fields are most commonly used to refer to records in another table. For example, the ‘watch list’ field lists user records (“users”) who should be notified about updates to a ticket. If a glide_list is not configured to reference any table, it gets its values from sys_choice records. Users can configure choices for the field, and then from the table’s form, they can select one or more of the choices to be included in the list. This type of glide_list is susceptible to a concurrency issue with cached choice lists. It works directly with the cached choice list, so if two threads run this same code at the same time, they can corrupt the cached list and lead to NullPointerExceptions, for example. This can break the form that the glide_list is part of.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Core Platform | PRB913389 | List field and slushbucket do not retain language translations | If a display field is a translated text/field which puts the values into a list field to be displayed in a many to many list, the text/field is not translated. A many to many list will have values in the list that are not translated into the current session language. A many to many list looks like the pop up when you click on the gear wheel in the corner of list. | 1. Navigate to an incident, right-click the header, and click Form layout to add a new field:  
   - Name: KB  
   - Type: list  
   - Refers to: kb_knowledge_base table  
   2. Change the language to French.  
   3. Navigate to Bases de connaissances. Check that you have a translation for the knowledge base name.  
   4. Open an incident, and choose a value for the field KB and save.  
   5. In the same incident, click the lock on the KB field > Add/Remove Multiples.  
   6. Move one value in French from the left to the right.  
   Note the value in the right column is in English, and there are no results when you search in French.  
   7. Save.  
   The value in the KB field is showing in English and not in French. |
<p>| Discovery | PRB642152 | For large discoveries, the logs are filled with errors such as &quot;No discovery source passed to ObjectSource&quot; | | |
| Discovery | PRB690012 KB0598562 | CIM_ERR_INVALID_PARAMETER: CIM_HostedShare is displayed during storage discovery | | |
| Discovery | PRB709239 KB0622394 | Sensor error when processing Windows - Storage : TypeError: Cannot convert null to an object | When the ProviderName from the WMI property ‘Win32_MappedLogicalDisk. ProviderName’ is empty, the “Windows - 2008 Storage” probe payload, the sensor will get the error: “TypeError: Cannot convert null to an object” | Refer to the listed Known Error KB article for details. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery PRB718623</td>
<td>Windows credentials with special characters do not work when used by new PowerShell implementation (affects test credential and WinRM)</td>
<td>The new PowerShell API, which is used by WinRM and test credential, does not correctly handle Windows credentials where there is a PowerShell-specific special character such as &quot;$&quot; in the username or password. This will cause authentication failures with targets even though the credentials are correctly defined.</td>
<td>1. Create a windows credential for an associated device that has a special character such as &quot;$&quot; as part of the password. 2. Run test credential against the device. Notice the credential test fails, even though this is the correct credential. As part of verifying the credential is correct, running a normal quick discovery on the target (as long as WMI is being used and not WinRM). This should result in a successful authentication and discovery of the device, and there should be an IP affinity created with the credential that failed the test in step 2.</td>
<td></td>
</tr>
<tr>
<td>Discovery PRB725029</td>
<td>Core Automation com.snc.discovery.ip_based</td>
<td>CIs are being created with the name &quot;[OBJECT OBJECT]. [OBJECT OBJECT]&quot;</td>
<td>Configuration items are being created with the name &quot;[OBJECT OBJECT]. [OBJECT OBJECT]&quot;</td>
<td>1. Hop on to an instance and connect to a MID server. 2. Perform Quick Discovery on any of your Windows CIs. Note that the Discovery log shows &quot;Exactly one match was found in the CMDB: [OBJECT OBJECT]. [OBJECT OBJECT]&quot;.</td>
</tr>
<tr>
<td>Discovery PRB733653</td>
<td>Linux - Storage sensor for computers with lots of disks will run instance node out of memory and cause a restart</td>
<td>Node performance is noticeably affected when running large sensors.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Discovery PRB905030</td>
<td>Discovery source attribute is not populated for Windows cluster and Hyper-V CI</td>
<td>When Discovery creates a 'Windows Cluster' CI in the cmdb_ci_win_cluster table, the sensor does not fill in the discovery_source field as &quot;ServiceNow&quot;. It is inserted with empty value. CIs created by Discovery on cmdb_ci_hyper_v_cluster and cmdb_ci_hyper_v_server also have an empty discovery_source as well.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Domain Support PRB734803 |                  | Optimize domain hierarchy change updates | Changing a domain hierarchy uses inefficient queries. These should be optimized for scalability and performance. | 1. Create a domain-separated table with many records (e.g. 100 million or more) and assign most of them to the global domain.  
2. To trigger the domain path updater job, change the domain hierarchy.  
This takes over 10 minutes to complete, and other operations to the table are blocked. |
| Domain Support PRB852436 |                  | Forced update on domain record results in unnecessary recalculations of the domain code and path | Changing the domain’s code and path can potentially turn into an expensive operation that updates millions of records in other tables. |                                                                                                                                 |
| Domain Support PRB674160 | SLA 60           | Record domain is not honored when creating new records with the ‘sys_domain’ value populated | When creating a new record with the ‘sys_domain’ value set to a specific domain, this domain is not honored for picking all the processes/data. Instead, the user domain session is used. |                                                                                                                                 |
| Domain Support PRB756920 |                 | Table upgrades and the Domain Hierarchy Validation job that invoke domain path validation on large tables cause database performance issues | When the Domain Hierarchy Validation job runs its nightly validation (also seen on table upgrades) on large tables that are domain separated, severe performance issues can occur on the database such as longer response times and semaphore exhaustion across all nodes. | Refer to the listed Known Error KB article for details.                                                                 |

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filters</td>
<td>PRB744029</td>
<td>For instances running Oracle DB, when glide.secondary.query.sysid is set to true, Errors occur when filtering against tags Queries using the Tags feature return a “column ambiguously defined” error when the glide.secondary.query.sysid property is enabled on an instance using Oracle.</td>
<td>On an instance running Oracle DB: 1. Set the glide.secondary.query.sysid property to true. 2. Create some tags from any task record. 3. Run a query against the tag. A DB syntax error occurs: “column ambiguously defined”.</td>
<td></td>
</tr>
<tr>
<td>Incident Management</td>
<td>PRB756822</td>
<td>When a resolved incident is reopened, the Resolved By and Resolved fields are not cleared or updated</td>
<td>When an incident is resolved for the first time, the ‘Resolved’ and ‘Resolved by’ fields are populated. If the incident is reopened, these fields do not get cleared. Then, when the incident is once again moved to the ‘Resolved’ state, the original ‘Resolved’ and ‘Resolved by’ values still persist. These fields are not updated with new values.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Knowledge Management</td>
<td>PRB962869</td>
<td>Knowledge search text is no longer translatable/translated by default</td>
<td>In earlier Helsinki versions, the knowledge search box (“Search Knowledge”) on the Knowledge homepage is translated by default. In Helsinki Patch 10 and later releases, the search box says “Search (minimum 3 characters)”. This text cannot be translated.</td>
<td>In a Helsinki Patch 10 and later instance, navigate to /$knowledge.do. The search box has the text “Search (minimum 3 characters)”, instead of “Search Knowledge” which is translated by default depending on which language plugin is activated.</td>
</tr>
<tr>
<td>Knowledge Management</td>
<td>PRB673022</td>
<td>Output warning message occurs when opening the New Knowledge Record form without admin role</td>
<td>When a non-admin user tries to create a kb_knowledge article, they will notice errors in the logs.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Knowledge Management</td>
<td>Knowledge Management</td>
<td>PRB829734</td>
<td>CMS - In Knowledge, the ‘Copy permalink’ link does not display upon page load of a KB article</td>
<td>When a knowledge article is loaded through the CMS, the ‘Copy Permalink’ and other elements are cut off. These can only be accessed by tabbing through to the bottom of the page.</td>
</tr>
</tbody>
</table>
|  |  |  |  | 1. In an OOB instance, go to the ESS.  
2. Click Knowledge.  
3. Search for an article and click on it.  
The “Copy permalink” link does not appear. |
| Knowledge Management | Knowledge Management | PRB670593 | In IE11, the scroll bar overwrites the content displayed with Knowledge search from Incidents | In IE11, the top-right of kb_view and kb_find pages are covered by IE’s scroll bar. |
|  |  |  |  | 1. Navigate to Contextual SearchTable Configuration.  
2. Select the incident.  
3. Uncheck active.  
4. Create an incident. In the short description, type system, then select the knowledge book at the end of the field.  
Notice the vertical scrollbar overlaps on the far right. |
| Knowledge Management | Social Q&A | PRB754340 | Favorite button is broken on Knowledge questions | The Favorite button is broken on Knowledge questions. However, the button outline appears when a user hovers over the space next to the back button on the form header. |
| Live Feed |  | PRB667106 | Oracle DB - Connect/Live Feed throws exception | For instances using Oracle DB, Connect/Live Feed throw an exception: “Syntax Error or Access Rule Violation detected by database (ORA-00932: inconsistent datatypes: expected - got CLOB).” |
| MID Server |  | PRB671308 | Using SFTP to import files specified by relative path often fails | If a user imports data to an instance using SSH File Transfer Protocol and the specified paths are relative, the import often fails. The State in the progress bar shows Complete, but the completion code displays the following error: com.glide.db.impex.datasource.DataSourceException: java.io.IOException: Problem opening a handle to remote file: Issued_moves.xls |
|  |  | KB0598970 |  | Use SFTP to transfer files or load data into an instance using relative paths. |

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistence</td>
<td>PRB719141</td>
<td>The record watcher fails upon a predicate pair between (&lt;x&gt;\text{ISEMPTY}) and (&lt;x&gt;\text{ISNOTEMPTY})</td>
<td>The record watcher structure is defective when the following two predicates are registered: * (&lt;\text{field}&gt;\text{ISEMPTY}) * (&lt;\text{field}&gt;\text{ISNOTEMPTY}) in the general case: * (&lt;\text{field}&gt;=\langle x \rangle) * (&lt;\text{field}&gt;=\langle x \rangle)</td>
<td>1. Create a single-score report for unassigned incidents. * Table: Incident * Aggregation: Count * Condition: Assigned to is empty 2. Create a single-score report for assigned incidents. * Table: Incident * Aggregation: Count * Conditions: Assigned to is not empty 3. Open a PA dashboard and add a tab. 4. Click Add Content. 5. Select Reports Incident, and then the name of the report created in step 2. Add it to the page. 6. Repeat step 6 for the report created in step 3. 7. Click Edit, and then the cogwheel on each widget (“Edit Widget”). Check Show real-time updates. 8. Open the incident list in a separate tab, find an unassigned incident, and add an assignee. Observe that the count increases for both widgets (you would expect unassigned to decrease). 9. Find an assigned incident and remove the assignee. Observe that the count decreases for both widgets (you would expect unassigned to increase). 10. Refresh the dashboard. Note that counts are now reflected accurately.</td>
</tr>
<tr>
<td>Platform Performance</td>
<td>PRB945880</td>
<td>Clicking View Map on a Service Mapping Business Service form triggers cache flush and instance becomes unusable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform Security</td>
<td>Contextual Security PRB711306</td>
<td>Excessive number of records on <code>sys_user_role_contains</code> table can cause the RoleManagementListener.java to stall an upgrade - duplicate of PRB626808</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reporting</td>
<td>PRB696928</td>
<td>Interactive filters are broken when glide.ui.escape_all_script is true in canvas/legacy dashboard</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Server Side Scripting | PRB634999 | Dot-walking through a reference to tags field results in Syntax Error or Access Rule Violation | If a user configure a list to add a dot-walk to the tags field of a reference, the list no longer displays properly. The user receives these listed errors when viewing the list:  
  - MySQL: Syntax Error or Access Rule Violation detected by database (Unknown column ‘task4.sys_tags’ in ‘field list’)  
  - Oracle: Syntax Error or Access Rule Violation detected by database (ORA-00904: "TASK1"."sys_tags": invalid identifier) | |
| Service Desk: Call | Service Desk Call PRB724388 KB05986601 | Service Request from a New Call is not created, and the screen is blank if the description is long and contains special characters | New Call passes parameters via URL to create Service Requests. If the New Call has long description text that contains special characters and TinyURL is invoked, it fails to encode them. The Service Request is not created, and a blank screen instead of the shopping cart is displayed on the first step of this process. | Refer to the listed Known Error KB article for details. |

© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Agreement (SLA) PRB898575</td>
<td></td>
<td>Displaying the ‘Repair SLAs’ UI action can be slow when a large number of contract SLAs is defined</td>
<td>The condition to display (or not display) the UI action link can trigger the compacting or expanding of rows. However, only a count is needed, not the actual records.</td>
<td></td>
</tr>
<tr>
<td>Service Level Agreement (SLA) PRB709382 KB0622898</td>
<td>SLA</td>
<td>“Repair SLAs” - Repairing SLAs does not work when SLA Definitions are in domains different than the current one</td>
<td>On a domain separated instance where the SLA Definition records have been created/updated to be in specific domains, using “Repair SLAs” will only work if your current session domain is the same as the domain of the Task (or Tasks) that the SLAs are being repaired for.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Service Mapping PRB832751</td>
<td></td>
<td>Under certain circumstances, Discovery processing is very slow or stuck</td>
<td>When Service Mapping discovery is run for multiple services (or all services), the discovery job may slow down due to the service recomputation jobs being processed. As a result, discovery tasks can time out.</td>
<td></td>
</tr>
<tr>
<td>Service Mapping PRB922651</td>
<td></td>
<td>Pattern Debugger: ‘Retrieve file’ and ‘Run Command’ from a step inside a library does not work when using variables</td>
<td>An error occurs, and the variable appears to be evaluated as empty. These do work when a constant expression is used (simple string). For example, if the variable config_directory is “/tmp” and the following is used: $config_directory + ”/a.conf”, then retrieving the file returns an error. Otherwise, if “/tmp/a.conf” is used, then the file is returned as expected.</td>
<td>1. Debug some pattern. 2. From inside a library step, add parse file or parse command step. 3. Add an expression (path or command) using variables. 4. Click Retrieve file or Run Command. An error will appear.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Service Portal   | PRB724097        | Read-only referenced variables cannot be previewed by users who have read access to the referenced record | Clickthrough on reference fields in the Service Portal are disabled, even if the system property glide.sc.variable.reference.clickthrough is set to true. | 1. Go to any catalog item (e.g. Blackberry).  
2. Add a reference variable to the item and point it to a table such as sys.user.  
3. Make the field be read-only via a catalog UI policy dependent on “replacement” variable if “yes” is selected as an option.  
4. In the Service Portal, open the catalog item.  
5. Select a value in the reference field (any user).  
6. Select yes as the “replacement” option. (This will turn the reference field to read-only).  

Expected behavior: Even if the field is read-only, the clickthrough property should allow the user to open reference field variables.  
Actual behavior: The property is ignored and the reference field clickthrough is disabled via CSS. |
| Update Sets      | PRB963605        | Extremely large SysUpdateLog prevents update set from committing | Users cannot commit update sets that contain workflows.                                                                                      | 1. Create 200,000 blank sys_variable_value records.  
2. Import a remote update set with a published workflow.  
3. Preview the remote update set.  
4. Commit the remote update set  

Expected result: The update set commits with no errors.  
Actual result: The Update set does not commit properly and has errors in the localhost log similar to “FAILED TRYING TO EXECUTE ON CONNECTION”. |
| Upgrade Engine Issues | PRB951491        | Collision detector loads update names for sys_metadata_delete records, which as a result can run the node low on or out of memory | If an instance has a high number of sys_metadata_delete records (e.g. 6 million), the node suffers from performance degradation. |  

© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Web Services  | PRB733418 KB0621503 | SOAP insertMultipleResponse yields inconsistent results when invoked simultaneously | 1. Ensure that the Insert Multiple Web Service plugin is active.  
For more information, see Activate a plugin.  
2. Install a SOAP client such as SoapUI and launch it.  
3. Prepare two requests for https://<instance name>.service-now.com/imp_location.do?WSDL under “insertMultiple” and ensure that pre-emptive authentication is set on both requests.  
   imp_location comes with a base system transform map, but any table with a transform map will work.  
4. Execute REQUEST 01.  
5. While REQUEST 01 is still executing and is not complete (very important), at the same time execute REQUEST 02.  
   Observe that REQUEST 02 completes but the response is empty while REQUEST 01 completes with a good response. Note that REQUEST 01 includes 202 response items. |

Fixes included with Helsinki Patch 11

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 10
- Helsinki Patch 9 Hot Fix 2a
- Helsinki Patch 9
- Helsinki Patch 8
- Helsinki Patch 7
- Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- Helsinki Patch 5
- Helsinki Patch 4
- Helsinki Patch 3
- Helsinki Patch 2
• Helsinki Patch 1
• Helsinki Fixes

Helsinki Patch 10

The Helsinki Patch 10 release contains fixes to these problems.

Helsinki Patch 10 was released on May 4, 2017. Build date: 04-19-2017_0850
Build tag: glide-helsinki-03-16-2016__patch10-04-19-2017

ServiceNow QPP targets and patches are immediately available. Users do not need to request an entitlement to schedule an upgrade to these versions.

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Security-related Fixes

Helsinki Patch 10 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 10, refer to KB0622459.

Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI)</td>
<td>Icons are incorrect after upgrading from Geneva to Helsinki</td>
<td>After upgrading from Geneva to Helsinki (where the icon fonts have changed), users continue to use the old Geneva icon font, and all icons throughout the interface are incorrect. This issue occurs because the server does not recognize that the icon fonts have changed.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Problem</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Discovery</td>
<td>Large number of rows in the Discovery Log (discovery_log) and TCP Connection (cmdb_tcp) tables can cause performance issues during an upgrade</td>
<td>Starting with the Helsinki release, the sys_domain and sys_domain_path fields were added to the Discovery Log (discovery_log) and TCP Connection (cmdb_tcp) tables. Upgrades of instances that have large numbers of rows in these tables can lead to performance issues when the upgrade process adds and populates the new fields.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>PRB755422</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>KB0621168</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edge Encryption</td>
<td>Selecting ‘Update All’ or ‘Update Selected’ in a list view nullifies Edge Encryption encrypted fields</td>
<td>This issue only affects Edge Encryption customers who have tables with Edge Encryption encrypted fields and active encryption configurations for these fields. Data loss can occur when attempting to update records with edge encrypted fields. This is due to a defect in the handling of the multiple update function in a list view. When a user updates several records with encrypted fields in list view using Update All or Update Selected, the contents of the encrypted fields are lost once Update is clicked.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>PRB762588</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>KB0621513</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Service Portal PRB878189 | In Service Portal, catalog item variables are read-only for non-roled users        | When the variables in a catalog item have write_roles configured, and a non-roled user tries to create a request using the catalog item, all of the variables are read-only in Service Portal. However, the variables in the catalog item in the normal catalog UI are not read-only. The Catalog desktop UI checks create_roles when ordering, and it later checks write_roles in the variable editor. However, Service Portal checks write_roles in both places. The fix for this PRB resulted in an API change to the getCatalogItem method. For details, refer to KB0621849. | 1. As an admin user, navigate to Maintain Items.  
2. Open the Sales Laptop catalog item.  
3. From the related list, open the Additional software requirements variable.  
4. Add the Write roles field to the form if it is not already there.  
5. Add the admin role to the variable (so that the admin is required to write to the variable).  
6. Click Update.  
7. Impersonate an ESS user.  
8. Navigate to the Service Portal.  
9. Search for and view the Sales Laptop catalog item.  

Expected behavior: Variables are writable in the normal UI and Service Portal.  
Actual behavior: Variables are read-only in Service Portal. They are writable only in the normal UI. |
| Asynchronous Message Bus PRB732813 | After upgrading to Helsinki, HttpClient thread count grows on the MID Server | MID Server can go down due to a thread leak that causes the MID Server to run out of memory and go down.                                                                                                      | Refer to the listed Known Error KB article for details.                                                                                                                                                       |
| User Interface (UI) PRB689186 | With List v3, the sys_user table list fails to load if the name field starts with a dot followed by a space | In List v3, if the name field for a record from sys_user table starts with `<dot/period><space>(the rest of the name)` (for example, `. restofname`) and that record is displayed in the current list, the list fails to load. | 1. Create a new sys_user record with name that starts with `. “  
• Do not use the quotation marks: `<dot/period><space>(the rest of the name)`  
• Note whether the name field is displaying first then last or last then first.  
• Make sure that the name field starts with (without quotation marks) `.  
`(the rest of the name)` .  
2. Make sure that sys_user list is using List V3.  
3. Navigate to sys_user.list.  
4. Make sure that the new record is being displayed in the current list. If it is not, sort or navigate to the record.  
There will be errors on the server and client. Refer to the listed Known Error KB article for details. |
## ServicePortal

**PRB720717 KB0610428**

Variable sets with containers in order guides with cascade variables enabled cause excessive memory usage.

**Stepsto reproduce**

1. Create an order guide, making sure to select the Cascade variables option.
2. Attach any normal item to that order guide (for example, access) via the rules. There are no conditions necessary.
3. Create a variable set with containers (start/split/end) and attach them to the order guide directly.
4. View the order guide in the portal. Note the drastic increase in memory usage. (This is even more pronounced in IE.)
5. Remove the variable set from the order guide and view it again. Note that there is no longer a drastic increase in memory consumption.
6. Add the variable set back on, but this time uncheck the Cascade variables box.
7. View the order guide again and note that there is no drastic increase in memory consumption.

## UserInterface (UI)

**PRB654424**

Setting ‘glide.ui.escape_all_script’ to ‘true’ blanks out Timezone, Date, and Time format choice lists on Basic Configuration.

**Stepsto reproduce**

1. Set the system property glide.ui.escape_all_script to true.
2. Navigate to SystemBasic Configuration.
3. Save the Basic Configuration page.

The System Date & Time Formats are cleared out. All date values show "??" for their values.

## All Other Fixes

**Problem**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approvals</td>
<td>PRB874762</td>
<td>ApprovalAction is triggering an OR query (similar to PRB817692)</td>
<td>The database encompasses very taxing on the database.</td>
<td>1.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Navigate to sn_grc_issue.do.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The form opens up with a browser console error: &quot;Uncaught SyntaxError: missing ) after argument list&quot;.</td>
<td>Expected behavior: There should be no errors in the console.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Actual behavior: There is an &quot;Uncaught SyntaxError: missing ) after argument list&quot; error in the console.</td>
<td></td>
</tr>
<tr>
<td>Authentication</td>
<td>PRB716685</td>
<td>logout_redirect.do causing SAML signed authentication failure</td>
<td>After upgrading from Fuji to Geneva or Helsinki, some customers who have signed SAML requests are unable to log in using SAML. For example, after an upgrade from Fuji to Geneva or Helsinki, authentication fails.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>KB0621521</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Management</td>
<td>PRB722939</td>
<td>On a change request, the related list of emergency changes is not visible after upgrading</td>
<td>After upgrading, some users can no longer see the related list of emergency changes on a change request.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Workflows</td>
<td>KB0621869</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Chat PRB721263                | Connect          | Notification for user when a Connect Support chat transferred request from queue to queue is not visible in Helsinki | In Geneva, when a user receives a transfer request from queue to queue, there used to be a notification pop-up on the header or the Connect Support sidebar (depending on whether it was expanded or collapsed) for the user receiving this request. In Helsinki, there is no notification pop-up. The only way for a user to see that there is a request is if they have the Collapse Support sidebar expanded and they are on the ‘Support’ tab. | In a Helsinki instance:  
1. Navigate to chat_queue.list, open a record, and click Support Link.  
2. Once you are redirected to a chat support queue, write any comment and Send.  
3. Impersonate a Chat admin (e.g. Beth Anglin). You will see the comment in the Connect sidebar.  
4. Click Accept once the chat window pops up in the bottom of the screen. Select the nav icon (three bars on the bottom left) and select Transfer.  
5. Click Transfer next to the agent in that queue that you wish to transfer the chat to (e.g. David Loo).  
6. Impersonate David Loo.  
Expected behavior (Geneva): A notification pops up in the header next to “Toggle Connect Sidebar” icon if the Connect sidebar is collapsed, or next to the support icon (headset) if it is expanded.  
Actual behavior (Helsinki): No notification icon appears in the header or support icon, whether the Connect sidebar be expanded or collapsed. The only way for the user to see the incoming transfer request is if the Connect sidebar is open in the Support section. |
| Chat PRB825291                | Connect          | Connect throws 500 error when resetUnreadCount is called on an empty conversation |                                                                                                                                                                                                             |  
1. Run discovery twice.  
2. Go to the Azure resource cmdb_ci_azure_resource table. There are duplicate records with a Storage Blob resource type in the table. Processing these duplicate records will take a long time. |

© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Management Application PRB859533</td>
<td>Cloud Management v1: VM instances have empty names and states from AWS configuration events</td>
<td>Incoming messages are not processed because they contain single quotes, and the CMDB is not updated. Empty names and states are also appearing.</td>
<td>This issue can occur for users with many accounts configured with the AWS Configuration (for example, 30 accounts). Due to the heavy load of messages coming in, some events will get dropped.</td>
<td></td>
</tr>
<tr>
<td>Configuration Management Database (CMDB) PRB719314</td>
<td>‘CMDB Health Dashboard - Relationship Score Calculation’ job causes nodes to go OOM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Certification PRB744168</td>
<td>Slow performance with Data Certification</td>
<td>Users are experiencing slow performance when executing Data Certification. It can take up to 10 seconds to certify a single certification element, which negatively impacts the execution time for multiple certification elements. The data certification process can take minutes instead of seconds.</td>
<td>Activate the ‘Data Certification (com.snc.certification_v2)’ plugin. 1. Navigate to cert_task.list. 2. Choose a record in the Work in Progress state (with a ‘percent complete’ below 100%). 3. Under Certification Task, certify elements. The data certification process can take minutes to execute completely. This process should only take several seconds.</td>
<td></td>
</tr>
<tr>
<td>Dependency Views (BSM Map) PRB752732</td>
<td>Next-Gen BSM, Keylines Business Service Maps Nodes are not grouped in Dependency Views</td>
<td>Users are seeing all nodes when the virtual group should be controlled by the user. The fix for this PRB adds the glide.bsm.max_levels and glide.bsm.show_virtual_node_children properties. See Properties installed with Dependency Views for details.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Discovery PRB667360</td>
<td>Sensor error when processing Linux - Storage: The undefined value has no properties</td>
<td>A sensor error occurs on a Linux storage processor when the fiber channel HDB <code>fcAdapter</code> field in an ECC input record does not have a model description field (blank) or if it has no embedded spaces. The sensor is trying to split the string via regex into two parts, based on the first space character.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Discovery PRB718782 KB0622023</td>
<td>Memory issues when processing load balancer exploration sensors with large payloads (SNMP - Netscaler - System and SNMP - F5 BIG-IP - System)</td>
<td>Load balancer sensors can be cancelled and/or cause memory problems on a given node with very large payloads (e.g. above 2MB, typically containing several thousand OID values or more). The fix for this PRB adds the result_format parameter. This parameter returns JSON formatted payloads for the SNMP - F5 BIG-IP - System and SNMP - Netscaler - System probes. See SNMP probe parameters for details.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Discovery PRB72267</td>
<td>Incorrect and missing object IDs interfere with UCS Discovery</td>
<td>Incorrect and missing object IDs interfere with UCS Discovery</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Discovery PRB7586</td>
<td>Configuration Management (CMDB) unexpected behavior for Cisco UCS Discovery</td>
<td>Some users are experiencing instance overloading, duplicate UCS systems, and other Cisco UCS Discovery issues.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Domain Support PRB580998</td>
<td>The sys_report table should not have the sys_overrides field on it</td>
<td>The MSP extensions plugin is adding “sys_overrides” to the sys_report table. The sys_overrides field is a “process table only” field, that reverses the flow of data visibility on a table so that processes can be consumed by child domains. The issue with using this field on any “Data” table is that users lose access to child domain data while in their “default” domain. Any impersonation of the user by the system will fail to access data on these tables and could break processes.</td>
<td>1. An ITIL user schedules a report in a child domain. 2. The system impersonates the user and is in the users default domain. This will cause an error.</td>
<td></td>
</tr>
<tr>
<td>Domain Support PRB593994</td>
<td>GlideRecord.updateMultiple() sets domain fields to “global”</td>
<td>GlideRecord.updateMultiple() on a GlideRecord causes the domain fields to be overwritten with “global” regardless of their original values. This is because GlideElementDomainId sets fValueSet incorrectly even when no value has been set (just the default of global), which causes GlideRecord to update the column in the database.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edge Encryption PRB717547</td>
<td>Edge Encryption mass encryption job fails on fields with long column names</td>
<td>When a table contains a long column name (e.g. 36 characters long), Edge Encryption’s mass encryption job fails.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edge Encryption PRB916539 KB0622239</td>
<td>When the number of connections increases, the Edge Encryption proxy experiences extreme slowness</td>
<td>Edge Encryption proxies can run extremely slowly. This issue occurs when concurrent user sessions drive up the number of simultaneous user connections to the instance through the proxy. There are also no logs to indicate the proxy’s processing.</td>
<td>1. Start up an Edge Encryption proxy and connect to an instance. 2. Simulate users going through the proxy and using connection-intensive pages, such as Service Portal and Knowledge. Notice that after a certain threshold, response times become extremely slow in the browser.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Email Subscription Based Notifications PRB7143 KB0621603</td>
<td>Cannot enable notification preferences for a mandatory notification on non-primary email devices</td>
<td>The notification preferences page causes the mandatory notifications to display as though all devices will receive the notification. The user cannot switch off preferences for any of the devices. In addition, only devices with a cmn_notif_message for a mandatory notification receive the notification.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Event Management PRB714234</td>
<td>Threshold performance issues</td>
<td>Threshold rules can take a lot of time to run. For example, it takes 22 seconds to execute a user query that occurs 3500 times a day.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Event Management PRB742365 | Incident creation business rule race condition is affecting Alert Rule execution | If an alert has a before business rule that may take a lot of time, it may cause alert rules not to work for that alert. | 1. Create a business rule that sleeps for a minute.  
2. Create an alert rule that should catch the alert.  
3. Create an alert.  
The incident is not created. |
<p>| Event Management PRB877957 | OOM on impact calculation of many services (e.g. 3000) | Some users are experiencing recurring excessive memory usage. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Foundation       | PRB926088        | 'sm_m2m_somodel_stmodel' table contains invalid references to non-existent so_model’s and st_model’s | 'sm_m2m_somodel_stmodel' has invalid references to non-existent so_model’s and st_model’s, which should have been handled by SMCore’s cascade delete rules on the fields. These cascade rules prevent future invalid records, but do not work on records that are already invalid. Some ways the user can have these invalid records:  
• Come from an earlier release (before Geneva) with invalid records  
• Use update set containing invalid records  
• Scripting invalid records | |
<p>| Finance Service Management | PRB747302 | Finance Service Management | Upon upgrade, Finance templates revert to OOB settings | If a user changes the assignment group in a Finance template, removes the default task, and upgrades the instance, then the assignment group reverts to the OOB value and the OOB default task returns. |
| Financial Management | PRB733373 | Financial Management | Levels of hierarchies cause the allocation setup to become out of order | In the allocation setup, the chart of account is out of order and segments are displayed in an unusual order. Navigate to Cost TransparencyWorkbenchLoad Allocation Setup. Note the chart of account goes out of order in the allocation setup. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Forms   | PRB691859       | onChange client scripts run when a live update is received | When a field is changed in one client session, it also changes automatically for all sessions viewing that form. | 1. Create a client script ‘onChange’ to throw an alert when some field gets changed.  
2. Log into the same instance with another user (in a different browser or in incognito mode).  
3. Navigate to the same form for both sessions.  
4. Make a change in one of the sessions to trigger the client script created in step 1.  
5. Save the record.  
Verify in the other session that user also gets the alert popup. |
| Governance, Risk and Compliance | PRB905229 | UCF Configurations records do not load properly when glide.ui.escape_text is set to ‘false’ | When the system property ‘glide.ui.escape_text’ is set to ‘false’, the form interface for UCF configurations does not render properly. | 1. Install the plugin “GRC: Compliance UCF”.  
2. Set the system property glide.ui.escape_text to false.  
3. Navigate to Unified Compliance Integration.  
4. Open the UCF record.  
The page is not properly rendered. |
| JS/HTML Editor | PRB668524 | CodeMirror: For long scripts, there is a time lag between typing a character and the time it appears on the screen | For long scripts, there is a time lag between the time of typing characters using the keyboard until the time it appears on screen. This impacts users in development that write customized scripts in the instance. | 1. Go to the AddRelationshipAjax script include: /nav_to.do?uri=sys_script_include.do?sys_id=6fb09c8a0a0a0b4400589a9a72da4fe5.  
2. On line 2 of the script, type a comment. For example, you can use basic lorem ipsum characters. Make sure to type it - do not copy and paste.  
3. Observe the timing between the time you enter a character and the time it appears on the screen.  
Expected behavior: There should not be any lag between the user typing the character and the character appearing on the screen.  
Actual behavior: Longer scripts exhibit longer lag times. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Knowledge Management PRB690891 | Knowledge Management | Unable to search on tags through Knowledge search | Tags assigned to a user or a group are not visible on the Knowledge home page under the Tags section. When clicking on the tag, the system only redirects to KBs that are visible to everyone. The tag is not respected. | 1. Go to a KB article.  
2. Add a tag (e.g. tag1) to the article, and make it visible to Abel Tuter.  
3. Go to another KB and add a new tag (e.g. tag2), but this time, make this tag visible to everyone.  
4. Impersonate Abel Tuter.  
5. Navigate to Self-ServiceKnowledge Knowledge.  
6. Check the Categories section.  

You can see both tag1 and tag2. When you go to the Tags tab, only tag2 (which is visible to everyone) is visible. You cannot see tag1, which is visible to Abel Tuter. |
| Knowledge Management PRB709014 | Knowledge Management V3 | In Knowledge V3, the page never finishes loading when a user enters two numbers or letters (or a combination of both) into the homepage search | This issue occurs in Knowledge V3. When a user enters two numbers or letters into the homepage search, the search begins, but it keeps spinning and never returns any results. The page turns white with two columns and a spinning circle in the left column. | In an instance with Knowledge V3:  
1. Navigate to Knowledge Homepage.  
2. In the search field, type F5 and hit the Enter key on your keyboard.  

The page turns white with two columns and a spinning circle in the left column that never stops spinning. No search results are returned. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Knowledge Management | Knowledge Management | V3 | In Windows Edge browser, Knowledge v3 import button does not upload documents as expected for Geneva and Helsinki. | On a Geneva instance as an admin:  
1. Navigate to KnowledgeHome Page.  
2. Click Import.  
The system will ask you to browse the document to be uploaded.  
3. Select the document and click Open, or double-click on the document.  
A dialog window opens, asking for additional details.  
4. Click Import.  
Expected behavior: The system should ask the user to select the document. Once the user clicks Open or double-clicks on the document, a dialog window should open, asking for additional details.  
Actual behavior: Nothing happens.  
On a Helsinki instance as an admin:  
1. Navigate to KnowledgeHome Page.  
2. Click Import.  
A dialog window opens, asking you to import files by dragging and dropping a Word file or clicking to select.  
3. Click + Click to Select.  
Expected behavior: The system should ask you to browse for the document.  
Actual behavior: Nothing happens. |

© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Knowledge Management | Knowledge Management | Nested KB category names are truncated in the ‘Filter by Type’ list | The ‘Filter by Type’ column does not display the entire nested KB category name. The KB category name gets cut off after 24 characters. | 1. In Geneva, navigate to Knowledge Knowledge base.
2. Open the Knowledge knowledge base.
3. Go to the Knowledge Categories tab and click New.
4. Create a KB category with a long name, such as “New Knowledge category Level 1” and save it.
5. Expand the category you created and create a nested one.
6. Create a nested KB category with a long name, such as “New Knowledge category Level 2” and save it.
7. Navigate to Articles Create New to create a new article with the following values:
   - Knowledge base: Knowledge
   - KB category: New Knowledge category Level 1 > New Knowledge category Level 2
8. Save the article and publish it.
10. Search for the article you just published.
Note that the Filter by Type column on the right doesn’t show the entire nested KB category length, which gets cut off after 24 characters. |

<table>
<thead>
<tr>
<th>Knowledge Management</th>
<th>When a large number of KB categories is present, opening the KB homepage is slow</th>
<th>In an instance with many records in the kb_category table (e.g. 27000 records):</th>
</tr>
</thead>
</table>
| PRB716861 | | 1. Navigate to Knowledge Base Homepage.
2. Click a knowledge base that contains many categories.
It takes more than 1 minute to load the page. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Knowledge Management PRB729784 | | User gets file parsing error when uploading .docx word document on Knowledge Base. Alternative text breaks the import function. | If a .docx file contains pictures with alternative text, the Knowledge Article import function may not work correctly. | 1. Navigate to Knowledge Base Homepage.  
2. Click Import Articles.  
3. On the import window, drag a Word file that contains an image with alternative text.  
4. Click Import.  

Expected behavior: The document is imported.  
Actual behavior: The file failed to import, and the following error message appears: 'Import completed with error'.

| Knowledge Management PRB746462 | | Import issues with large Word docs: 'import completed with error' 'Unknown error', and content is lost. | Large Word documents (3.5MB) are not always completely imported into the instance. A knowledge base record will be created for the imported file, but its content will be lost. This issue occurs when using the 'Import Articles' button on the Knowledge v3 homepage. | As a user with elevated privileges:  
1. Navigate to Knowledge Homepage.  
2. Click Import Articles.  
3. In the box labeled Drop Word files here, drag-and-drop a large Word file (3.5 MB or more).  
4. Select the Knowledge knowledge base.  
5. Click Import.  

Users receive the error messages 'import completed with error' 'Unknown error'.

<p>| Legal Service Management PRB711447 | Legal Service Management Marketing Service Management | Fuji upgrade: Legal &gt; Self-Service &gt; Contract Review and Management items are reset to OOB | Upon some Fuji upgrades, Legal &gt; Self-Service &gt; Contract Review and Management items are reset to their out-of-box settings. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Lists   | PRB690509      | List v3 related list - Viewing a record and using Next and Previous to step through the list displays the wrong records | Upon clicking any link in a related list and using Next and Previous to scroll through the list of records, the user is taken to the wrong place. | 1. Activate the List v3 plugin.  
2. Enable List v3 for related lists.  
3. Navigate to a record with multiple related lists.  
4. Navigate to the second or greater related list.  
5. Cause that list to have multiple records in it.  
6. Click the (i) icon to go to the record and click open record, or click the text link in the first column.  
7. On the record that opens, click the Next arrow to go to the next record.  
Depending on the previous related list from the original record, you either get “Record not found” or a record from the table in the previous related list. |
| Marketing Service Management | PRB875951 | After upgrade, Marketing custom states are deleted | 1. Install the Marketing Service Management plugin.  
2. Create a custom state for a Marketing Request (sn_sm_marketing_request.state)  
3. Create a marketing request and set it to that state.  
4. Upgrade the instance.  
The custom state is deleted. State flows are references with a cascade rule of clear, and they are also be broken. |
| MID Server | PRB718616 | Uptime probe hangs under J2SSH | The Linux uptime probe hangs when it is run under J2SSH. | 1. Run DiscoverNow on a server CI.  
2. Check the time it takes to run the discovery job.  
Expected behavior: For 15/16 commands, it should take less than 2 minutes to finish.  
Observed behavior: It takes 16 minutes to complete. The first 15 commands are completed in less than a minute while “uptime; date +%s” eventually times out, which in this case was 15 minutes. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile PRB7193</td>
<td>Mobile UI, NG shared components</td>
<td>Clearing and adding options to a choice field multiple times in a client script does not work as expected</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mobile PRB739983</td>
<td>Mobile UI</td>
<td>In mobile, users are unable to scroll in read-only text fields</td>
<td>Only read-only fields are affected - users are able to scroll in non-read-only fields. This issue is reproducible in the mobile UI and the mobile app.</td>
<td>In the mobile UI or mobile app:</td>
</tr>
<tr>
<td>Performance</td>
<td>Performance Analytics Application</td>
<td>Upgrade time increased while creating an index on pa_score during an upgrade</td>
<td>After we drop the base system index (indicator, breakdown, element, start_at) and create a new one that contains the second breakdown and second element (indicator, breakdown, element, breakdown_level2, element_level2, and start_at), during the next upgrade of the instance to a release before Istanbul, the base system index is recreated because the index is still in the table definition. This can increase the upgrade time significantly depending on the number of records that the pa_scores table contains.</td>
<td>1. Go to System PropertiesMobile UI Properties.</td>
</tr>
<tr>
<td></td>
<td>PRB717668 KB0621068</td>
<td></td>
<td></td>
<td>2. Enable the updated mobile Web Experience available in Helsinki.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Open an existing incident and change the view to mobile.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Add the field Description, and add a long description here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Make the field read-only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Go to this URL to switch to the Mobile UI: https://(instancename).service-now.com/$m.do#</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7. Open the incident.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Notice that is not possible to scroll down to read the full description.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Performance Analytics PRB680224</td>
<td>Pivot scorecard visualization always displays only the first 10 elements of the breakdown</td>
<td>Make sure to have collected scores in the instance. 1. Login as admin. 2. Navigate to Performance Analytics Dashboards. 3. Click on edit dashboard and Add content. 4. Select Performance Analytics Breakdown. 5. Create a new widget with visualization “Pivot scorecard” and breakdown “Assignment Group”. 6. Save and on the related list add 3 indicators that are using that breakdown (e.g. Number of open incidents). 7. Save and reload the dashboard. Notice that only the first 10 elements are displaying with values.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Performance Analytics PRB702680 KB0596910</td>
<td>PACollectionCleaner is executing a long running query to count the total amount of rows in tables pa_scores and pa_snapshots. The standard behavior of the platform TableCleaner is to count all records of a table. In cases of pa_scores and pa_snapshots, the table can contain a large number of rows and therefore the count query can take several minutes.</td>
<td>1. Run the Clean PA collections job (PACollectionCleaner). 2. Monitor the database to find a query like SELECT count(*) AS recordcount FROM pa_scores pa_scores0.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Performance Analytics PRB737260</td>
<td>The PA Breakdowns widget breaks if the breakdown name contains special characters</td>
<td>Install the Performance Analytics Premium plugin. 1. Log in as admin. 2. Navigate to Performance Analytics Breakdowns. 3. Create a new breakdown with name that contains an apostrophe or ampersand (’ or &amp;). 4. Create a widget with this new breakdown, and add it to a dashboard. Expected result: The widget and chart should be displayed correctly. Actual result: The widget is not displayed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Persistence</td>
<td>PRB684316</td>
<td>Deleting a non-empty table that extends sys_metadata does not remove sys_metadata records for rows in that table</td>
<td>If a table extending sys_metadata is deleted and there were rows in that table, then the sys_metadata records corresponding to the rows in that table are not removed.</td>
<td>1. Create a new table that extends sys_metadata.</td>
</tr>
<tr>
<td></td>
<td>KB0622001</td>
<td></td>
<td></td>
<td>2. Navigate to that table and create a new record in it. Note the sys_id of the the record you just created.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Delete the table (without deleting the record in it).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Navigate to sys_metadata and search by sys_id using the id from step 3.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>Note that the record has not been removed.</strong></td>
</tr>
<tr>
<td>Persistence</td>
<td>PRB756253</td>
<td>When a task column is moved into offrow storage, it breaks certain database views that include tables that extend task</td>
<td>Using the view in a report or via ‘Try it’ results in an error: “Syntax Error or Access Rule Violation detected by database (Unknown column ‘XXXX.XXXX’ in ‘on clause’) ”.</td>
<td>1. Activate the ‘Database Column Offrow Migration’ plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Create a string column on task with length of 4000.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. On the Dictionary record for the new column, click the Move Column Offrow related link, and click Start to confirm the action.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Now open one of the following database view records, and click Try it:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• incident_sla</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• incident_metric</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• incident_time_worked</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• problem_metric</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• task_survey_detail</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>You receive an error message: “Syntax Error or Access Rule Violation detected by database (Unknown column ‘task_survey_detail0.sys_id’ in ‘on clause’) ”.</strong></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Platform Security PRB731078</td>
<td>Role Management V2: No data displays in the ‘Audit Roles Granted by Group’ related list on sys_user_group</td>
<td>This issue occurs because the sys_audit_role table is not correctly associating entries to the groups the roles came from. The fix for this PRB adds the glide.role_management.v2.audit_roles property, which allows the Audit Roles table to create audit records when user roles change after the Contextual Security: Role Management V2 plugin is installed. For details, see Enable role auditing with Contextual Security: Role Management Enhancements.</td>
<td>1. Navigate to the sys_user_group table.&lt;br&gt;2. Open the HR record.&lt;br&gt;3. Right-click the form header and click Configure Related Lists.&lt;br&gt;4. Add the ‘Audit Roles Granted by Group’ related list.&lt;br&gt;5. In the Roles related list, add or remove a role to the group.&lt;br&gt;The form will reload with addinformessages.&lt;br&gt;6. Scroll down to the Audit Roles related list.&lt;br&gt;There are no records. Expected behavior: There is a link to each sys_audit_role record that was created, because a user received or lost a role associated to this group. Actual behavior: No information is shown. The sys_audit_role records created are not associated to the group.</td>
<td></td>
</tr>
<tr>
<td>Platform Security PRB752083</td>
<td>Upon login, users are redirected to banner image/product icon instead of a homepage</td>
<td>In UI16, uploading a banner image causes a login navigation issue. Because the system attachment (image) files are protected, users who do not have the image already cached are incorrectly directed to the image file after login.</td>
<td>1. Upload a new image for use as glide.product.image or use Basic Configuration UI16 to upload a new banner image.&lt;br&gt;For more information, see Customize the logo in system properties.&lt;br&gt;2. Log out.&lt;br&gt;3. Clear your browser cache (Shift + Click Refresh for Chrome) or use an incognito browser.&lt;br&gt;4. Log in again. Instead of the homepage being displayed, the main frame is redirected to banner image.</td>
<td></td>
</tr>
</tbody>
</table>
| Platform Security PRB904608        | Contextual Security: Role Management Enhancements | fix_sys_user fix script should not run during upgrade | On an instance with the com.glide.role_management.inh_count plugin activated, the fix_sys_user_has_role fix script should not run during an upgrade. The fix script can cause the upgrade to stall for instances with large number of sys_user_has_role records. | **Contextual Security: Role Management Enhancements** fix_script should not run during upgrade. The fix script can cause the upgrade to stall for instances with large number of sys_user_has_role records.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Management</td>
<td>PRB665776</td>
<td>Activating the Project Management Import plugin when the Project Management plugin (com.snc.project_management_v3) is active results in data loss because the records in the pm_project and pm_project_task tables are deleted.</td>
<td>Activating the Project Management Import plugin drops all data from the Project and Project Task tables</td>
<td></td>
</tr>
</tbody>
</table>
| Project Management | PRB671437 | Cost Plan breakdown is incorrect for resource plans with weekly distribution when the plan date is across Daylight Savings Time | 1. Set the User/System timezone to PST.  
2. Perform all the prerequisites for financial planning.  
3. Create a project.  
4. Create a resource plan between October 10 to December 10 with weekly allocations.  
5. Open the cost plan created for the resource plan, and verify the cost and cost plan breakdown. | Expected behavior: The cost plan breakdown correctly displays the cost.  
Actual behavior: The cost plan breakdown displays an incorrect cost.  
1. Create a resource plan for the same project between 2016-09-01 and 2016-11-01.  
2. Check the cost plan.  
Expected behavior: The total cost is $8000.  
Actual behavior: The total cost is displayed as $7500. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management PRB697330 |  | Cannot ‘Close Complete’ project task with manual calculation due to a modified actual start date | If the actual start date is modified for a manual calculation project’s a project task, the user will no longer be able to close off the task as ‘Closed Completed’. | 1. Create a new project (pm_project.do) and fill out the mandatory fields.  
2. Set the calculation to Manual and save the record.  
3. Create a new project task via the related list, filling out the necessary mandatory fields. Save.  
4. Set the project task’s state to Work in Progress and save.  
5. Change the Actual start date to a date in the future (increase by 1 day) and save.  
6. Change the Actual start date again (increase by another day) and save.  
7. Change the state for the project task to Close Complete and then save.  
Expected behavior: The project task is closed without issues.  
Actual behavior: The user is unable to close the project task as completed.  
The following error messages appear: “Cannot change the planned end date of closed task. Invalid update” |
<p>| Project Management PRB708985 |  | When the Project template is used, attachments do not stay on the project task | When a template is created for a project, the project template has project tasks. If a project task contains an attachment in the template, the attachment is added to the project record, but not to the project task. |  |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management PRB714855 |                  | Planned duration calculation is incorrect when there is a holiday scheduled during that week | When a week contains a holiday, the planned duration calculation is incorrect. For example, if the ‘8-5 weekdays excluding holidays’ schedule is used, and a user creates a new project with a planned start date of 2016-11-07 08:00:00 and a planned end date of 2016-11-07 17:00:00, the duration should be 1 day. However, the duration is set to 1 day 2 hours because 2016-11-11 is Veteran’s Day. | 1. Create a project using the “8-5 weekdays excluding holidays” schedule.  
2. Set the planned start date to 2016-11-07 08:00:00, and set the planned end date to 2016-11-07 17:00:00.  
Expected behavior: Duration should be 1 day.  
Actual behavior: Duration is set to 1 day 2 hours. |
| Project Management PRB716372 | Project Management | Non-admin users cannot see data for Project Task Link (pm_project_task_link) table. | A user with the project_manager role is able to create records for the pm_project_task_link table. However, they are not able to view these records because the Project Task Link (pm_project_task_link) table is missing a ‘read table level’ ACL. | Prerequisites  
• The High Security plugin is activated with the default setting Deny.  
• The Project Management plugins are activated.  
• The Project Task Link related list is configured on the Project Task form.  
Steps to reproduce  
1. Impersonate any user with the project_manager role.  
2. Go to any existing project, and create and save a new Project Task.  
The ‘Create Change and link from Project Task’ related link should appear on the form. Observe that even though the Project Task Link record is created, neither the Project Task Link related list nor the table data is displayed on the form. This occurs because the table is missing a ‘read table level’ ACL for this table.  
3. Now create a table level Read ACL for this table.  
4. Reload the Project Task record.  
The Project Task Link related list is displayed, including the data generated. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Project Management</td>
<td>PRB721813</td>
<td>Updating a Project record’s state to ‘Work in Progress’ is saved as two updates</td>
<td>The same users will get notified twice for what should be a single event.</td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
<td>Steps to reproduce</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>Project Management</td>
<td>PRB743947</td>
<td>Schedule calculation is incorrect if the schedule is set for 8.5 hours</td>
<td>If a schedule is set for 8.5 hours (for example, from 8:00-12:00 and 1:00-5:30), the end date calculations are incorrect.</td>
</tr>
<tr>
<td>Portfolio</td>
<td></td>
<td></td>
<td>Steps to reproduce</td>
<td></td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
<td>Helsinki: In list view “current.sys_class_name” evaluates as undefined, causing ACLs to fail for dot-walked fields</td>
<td>The history shows two entries for the project entering the ‘Work in progress’ state.</td>
</tr>
<tr>
<td>Problem Tasks</td>
<td></td>
<td></td>
<td>Steps to reproduce</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>Project Portfolio Management</td>
<td>PRB710682</td>
<td>Helsinki: In list view “current.sys_class_name” evaluates as undefined, causing ACLs to fail for dot-walked fields</td>
<td>If a schedule is set for 8.5 hours (for example, from 8:00-12:00 and 1:00-5:30), the end date calculations are incorrect.</td>
</tr>
<tr>
<td>Portfolio Tasks</td>
<td></td>
<td></td>
<td>Steps to reproduce</td>
<td></td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
<td>Helsinki: In list view “current.sys_class_name” evaluates as undefined, causing ACLs to fail for dot-walked fields</td>
<td>The history shows two entries for the project entering the ‘Work in progress’ state.</td>
</tr>
<tr>
<td>Problem Tasks</td>
<td></td>
<td></td>
<td>Steps to reproduce</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>Project Portfolio Management</td>
<td>PRB720499</td>
<td>Helsinki: In list view “current.sys_class_name” evaluates as undefined, causing ACLs to fail for dot-walked fields</td>
<td>The history shows two entries for the project entering the ‘Work in progress’ state.</td>
</tr>
<tr>
<td>Portfolio Tasks with Financials</td>
<td></td>
<td></td>
<td>Steps to reproduce</td>
<td></td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
<td>Helsinki: In list view “current.sys_class_name” evaluates as undefined, causing ACLs to fail for dot-walked fields</td>
<td>The history shows two entries for the project entering the ‘Work in progress’ state.</td>
</tr>
<tr>
<td>Script</td>
<td></td>
<td></td>
<td>Steps to reproduce</td>
<td></td>
</tr>
<tr>
<td>PPMFundManager</td>
<td></td>
<td></td>
<td>Helsinki: In list view “current.sys_class_name” evaluates as undefined, causing ACLs to fail for dot-walked fields</td>
<td>The history shows two entries for the project entering the ‘Work in progress’ state.</td>
</tr>
</tbody>
</table>

1. Open pm_project_task_list.do.
2. Configure the list layout and add the dot-walked field Project (Sub tree root). Short Description.
3. As an admin you will be able to see the short description field.
4. Impersonate it_project_user.
5. Open the project task list.

You will no longer see the short description.

1. Set up a financial calendar to follow the normal calendar (1 year, 4 quarters, 12 months).
2. Go to fm_expense_line, and enter an expense with the date March 31. Then, relate the expense to a task.
3. Change the state of the expense line to Processed.
4. Open the cost_plan_breakdown and filter on the task selected in step 2.

Notice that the cost of the invoice is allocated to both March and April.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Management</td>
<td>Resource Management</td>
<td>Empty rows are shown in resource availability reports when there are more than 1000 data points</td>
<td>A background worker thread executes scheduled jobs. However, these scheduled jobs could execute a script that refers to some data in a different domain. The problem here is that since it does not reset the session domain when it picks up a new scheduled job, the glide record queries that it might make across different domains could thus fail.</td>
<td>1. Create a resource group with more than 20 members. 2. Navigate to Resource reports. 3. Select: • Report type: Availability • Entity type: Group • Group: Created in step 1 • Members: all members • Zoom level: Weekly • Report duration: 1 Year 4. Click Run.</td>
</tr>
<tr>
<td>Scheduled Job Processing</td>
<td></td>
<td>A worker thread does not reset its session domain before executing a scheduled job</td>
<td>When a user with a large number of groups tries to create a Security Incident template from a list takes longer than 1000 seconds</td>
<td>1. Navigate to Security Incident Templates. 2. Create a new security incident template. Observe slowness. 3. Open a record in the list of incident templates. Observe slowness.</td>
</tr>
<tr>
<td>Problem Description</td>
<td>Steps to reproduce</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| **Security Incident Response PRB825032** | 1. Activate the ‘Security Incident Response’ plugin.  
2. Navigate to Security Incident Administration Configuration.  
4. Open a Security Incident record.  
Notice that the ‘Add Activity’ UI action button shows up on the form.  
5. Under Add-ons, turn off the Enable Task Activities option.  
The UI action button still shows up on the form.  
Expected behavior: The UI action button should not show up when ‘Enable Task Activities’ is turned off.  
Actual behavior: The UI action button always shows up. |
| **Security Incident Response PRB916379** | Vulnerability Response Concurrency issues with Vulnerability Response integrations via MID Server |
| **Security Incident Response PRB916402** | Qualys Vulnerability Integration Issues with platform XML loader that processes the Qualys detection XML  
The platform XML loader that processes the Qualys detection XML only reads the first 10 target elements to determine what fields should be processed. |
<p>| <strong>Server Side Scripting PRB753842</strong> | Very large filter scripts are compiled even when com.glide.script.interpreted.mode = true, causing metaspace memory issues | Refer to the listed Known Error KB article for details. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog</td>
<td>KB0596397</td>
<td>Variables section is cut off on request Item page, and the HTML text field not displayed</td>
<td>Variables section is cut off on request Item page, and the HTML text field is not shown if the item has an HTML type variable.</td>
<td>1. Log in to a local instance as an admin.</td>
</tr>
<tr>
<td>PRB668537</td>
<td></td>
<td></td>
<td></td>
<td>2. Navigate to Service Catalog Definitions Maintain Items.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Create a new item, right-click in the header to choose Configure &gt; Form Layout, and add some variables of different types (for example, Multiple choice, Check box, and so on).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Add a variable of type HTML and click Save.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Order the item, and access the Request Number on Order Status page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Click the Request Item number and verify the variables section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7. For additional testing, try the following scenario:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>a. Open the Request Item page and open the request using TryIt page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>b. Right-click in the header and choose Configure Form Layout.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>c. In the slushbucket, move the VI editor from the selected to the available list and and from the available to the selected list. Note the result each time when you change the VI editor position.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The variable section is cut off, and the HTML variable name appears but not the related text field.</td>
<td>------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog    | PRB678314       | ‘Continue Shopping’ button does not get set correctly when the catalog was accessed | When a user has a list of content in CMS that points to sc_cat_item records, the catalog view and catalog sys ID do not get set correctly. This causes the default of order_things to get used for ‘Continue Shopping’, instead of what is specified in the sites related list on the catalog record itself. | In a Geneva or later instance:  
1. Navigate to the Order Things page in CMS.  
2. Rename the URL from order_things to be order_things_oob and save.  
3. Navigate to Maintain CatalogsService Catalog Sites.  
4. Update the “CMS Homepage” and “CMS ‘Continue Shopping’ page” fields for the Employee Self-Service entry to be order_things_oob.  
   This will allow the “Continue Shopping” button to point to the order_things_oob URL, which is valid because of the changes made in step 2.  
5. Create a new CMS page for the Employee Self-Service site.  
6. Use the Add Content feature to add the “Order Computers” list block to the page.  
   This is a list block that adds active=true and category=hardware sc_cat_item records to the list.  
7. Preview the CMS page.  
8. Click one of the links in the page and add the item to your cart.  
9. Click Continue Shopping.  
 Users get a page not found error against order_things. |
<p>|                    |                 | through sc_cat_item content type via list block                                   | If a user has changed or removed the order_things page, they will see a ‘page not found’ error.                                                                                                           |                                                                                                                                                                                                                 |
| Service Catalog    | PRB708945       | Container is not hiding if a checkbox variable is the last one which is getting  |                                                                                                                                                                                                            |                                                                                                                                                                                                                 |
|                    |                 | hidden using UI policy                                                            |                                                                                                                                                                                                            |                                                                                                                                                                                                                 |
| Service Mapping    | PRB691830       | The identification engine can fail, and the map does not show all items           | This issue occurs when a DNS cluster is detected both on the MID Server and using the cmdb_ip_address_dns_name table.                                                                                     |                                                                                                                                                                                                                 |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Mapping</td>
<td>PRB730839</td>
<td>Under certain conditions, Service Mapping discovery fails when using SSH</td>
<td>The SSH layer used by Service Mapping fails to connect to the UNIX system when the .profile script is prompting for additional input.</td>
<td>Configure a user on a Linux system so there is a .profile script asking for some input during login. Note that Service Mapping fails to discover this system using SSH.</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB798800</td>
<td>When two distinct CIs in different services are connected to the same clustered CI, both source hosts appear as associated with both services in svc_ci_assoc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Service Mapping   |                   | Service Watch fix script prolongs upgrades, and security constraints prevent selection of Service field | Issues:  
  • Upgrade duration is significantly longer due to a Service Watch fix script.  
  • During fix script execution, security constraints appear to prevent users from selecting the Service field.  

The following procedure only applies after upgrades from Geneva and when the Event Management plugin (com.glideapp.itom.snac) is active before the upgrade.  

In order to activate the fix for this PRB:  
1. Log in as an admin user.  
2. Navigate to System Definition Scheduled Jobs.  
   If you are unable to find the job, no additional action is required.  
4. If the job exists, open it.  
5. Click Execute Now. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>PRB701701</td>
<td>Record producer</td>
<td>When creating a record (for example, an incident) via a record producer in Service Portal, the variables are added to the variable editor in a different order than when they were created via the regular Service Catalog. The record created by Service Portal puts the variables in order without respecting the variable sets. The records created outside of Service Portal respect the order of the variable sets.</td>
<td></td>
</tr>
</tbody>
</table>
| PRB711870        | Service Portal   | Activity Stream   | For some upgraded instances, the activity stream is not visible in incidents. This issue does not affect zbooted instances.                                                                                | 1. Navigate to the HI Service Portal.  
2. Open an incident.  
Note that the activity stream is not displayed.                                                                 |
| PRB714724        | Service Portal   | Multiple instances| When a dropdown (select) box is populated via addOption and -- None -- is added, multiple instances of -- None -- appear in the list even though ‘Unique values only’ is selected in the variable configuration. | Refer to the listed Known Error KB article for details.                                                |
| PRB714879        | SCSS Bootstrap    | Currency symbol   | In Service Portal, the form widget request record’s price field does not have the currency symbol.                                                                                                      | 1. Open any service request (sc_request) in an instance which has a price configured.  
2. Copy the sys_id.  
3. Open the same using the following in the Service Portal: <instance>/sp?id=form&table=sc_request&sys_id=<sys_id>  
Notice the price field does not contain the currency symbol.                                         |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal         | Catalog client scripts cannot be fetched from a scoped application | A custom Catalog Item page inside of a scoped Service Portal does not fetch or execute the UI policies or catalog client scripts. It errors out because the script includes that do this are not accessible to all scopes. | 1. Create a scoped application and switch to that scope.  
2. Clone the SC Cat Item page.  
3. Clone the SC Cat Item widget.  
4. Use the cloned widget in the cloned page’s SC catalog item widget instance.  
5. Try to use that cloned page to fetch a catalog item with a UI policy or catalog client script. |
| Service Portal         | NG shared components | Service Portal catalog reference field behaves strangely when search term includes a period (dot / .) | In Service Portal, if a user runs a search for a string that contains periods in the catalog reference field, everything up to and including the first period is dropped from the query, and everything else is treated as a contains. For example, searching for hello.stuff.1 ends up doing a LIKE '%stuff.1%' | 1. Go to the User table.  
2. Pick a few users and change their IDs to these:  
• first.last.1  
• first.last.2  
• second.last.3  
• second.last.4  
• stuff.last.3  
4. Update the variable attribute’s value to:  
ref_auto_completer=AJAXTableCompleter,ref_ac_columns=user_name,ref_ac_columns_search=true  
When you search “first.last.”, it should only return two entries, not five. |
| Service Portal         | ticket conversations widget limits journal fields to 100 entries | If there are more than 100 entries in the Ticket Conversations widget, the user cannot see the subsequent comments.  
To activate the fix for this PRB in Helsinki and Istanbul, create the system property glide.service_portal.stream_readable and set it to true. When this property is set to true, Service Portal will first prune Activity fields a user cannot read before generating the journal entry stream. For details, see Ticket Conversations widget. | 1. Configure a Service Portal page with the Ticket Conversations widget.  
2. Set up an incident with an Additional Comment as the oldest journal entry, where the Caller is an end user with no role.  
3. Add 99 work notes, totaling 100 journal entries.  
As an admin user, all conversations are included in the widget. As an end user with no role, only the Additional Comment is visible. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Applications PRB649982</td>
<td></td>
<td>The <code>g_form.setDisplay/</code> and <code>setMandatory</code> is not working in scoped catalog client scripts</td>
<td>The problem exists in <code>scoped_object_generators.js</code>. Using <code>g_form.setDisplay/</code> and <code>setMandatory</code> functions in scoped catalog client does not work as expected. This occurs when a user prepends “variables” before the field name for any form operations.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Transaction and Session Management PRB713504</td>
<td></td>
<td>Canceling a homepage can cause CellRenderThread to wait indefinitely</td>
<td>Under the right cancellation circumstances, the CellRenderThread can get stuck.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Unified Compliance Framework (UCF) PRB749587</td>
<td></td>
<td>The root UCF control (control 0) fails to download</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Upgrade Engine Issues PRB828187</td>
<td></td>
<td>Upgrading the <code>com.snc.service</code> plugin overwrites changes made to the <code>sys_user</code> Dictionary record</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Usage Analytics</td>
<td>PRB715421</td>
<td>Subscription Management notifications are confusing</td>
<td>In Helsinki, Subscription Management has two types of notifications: 1. Users are notified every time their instance receives a new subscription record. This notification is sent for existing subscriptions as well as new subscriptions. 2. Users are notified about overallocation once a month if the ‘Allocated’ value is greater than the ‘Purchased’ value. Both of these notifications are confusing and should be disabled.</td>
<td>In an instance with Subscription Management: 1. Do one of the following: • Allocate too many users to a subscription • Have too many discovered nodes, devices, or servers for a Discovery subscription • Exceed an All User subscription by having excessive active users 2. Reach the start of a new month (the messages are generated on the first day of each month around ~6am). Note a message is sent to all admins if no admin has the usage_admin role (otherwise, the messages are only sent to usage_admin).</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB647551</td>
<td>List v3 Components Error when accessing System Properties &gt; Basic Configuration module</td>
<td>An ampersand value in the sys_user choices of the time_zone element breaks the “Basic Configuration” module. Users see the error: “The entity name must immediately follow the ‘&amp;’ in the entity reference”.</td>
<td>1. Add a new choice to the time_zone element of sys_user. 2. Navigate to sys_choice.list. 3. Click New. 4. Complete the fields with the following data: • Table = User [sys_user] • Element = time_zone • Label = Test &amp; Test • Value = Test &amp; Test 5. Make sure the Inactive field is unchecked. 6. Save the record. 7. Try to navigate to the System Properties Basic Configuration module. There is a blank page with the error “The entity name must immediately follow the ‘&amp;’ in the entity reference.”</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB672994</td>
<td>Fixed queries are not part of the export query in v3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Other Helsinki Patch 10 information

- **Contextual Security**
  - **Audit user roles**
    
    If the Contextual Security: Role Management Enhancements plugin is installed, you must Enable role auditing with Contextual Security: Role Management Enhancements.
  
  - **Enable role auditing with Contextual Security: Role Management Enhancements**

    Set a system property to allow the Audit Roles table to create audit records related to user roles.

- **Dependency Views**
  
  - **Properties installed with Dependency Views**

### Visual Task Boards

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| PRB7392 | Visual Task Boards | VTB notification emails are sent from "do-not-reply@sn.com". | The expected sent-from address is "@servicenow.com". | 1. Trigger a notification email from VTB.  
2. Note that the sent-from address is @sn.com. |

### Vulnerability Response

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRB8875</td>
<td>Threat Intelligence Security Support Common</td>
<td>Process Scan Queue job triggers unoptimized SQL statements</td>
<td>These slow queries can result in performance issues.</td>
<td></td>
</tr>
</tbody>
</table>

### Workflow

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| PRB675705 | Workflow Common | Stage field on the task table does not show the workflow stages in the current format when adding the field from an extended table | The Stage field on the task table does not show the workflow stages in the current format when adding the field from an extended table. | 1. Navigate to System PropertiesUI Properties.  
2. For the property Allow base tables list to include extended table, select Yes.  
3. Click Save.  
4. In the Application Navigator, type task.list in the Filter navigator and click enter or return on your keyboard.  
5. Create a filter for requested items by specifying the following: (Number) (starts with) (RITM).  
6. Click the menu icon and select List Layout.  
7. Add the Stage (Requested Item) column to the Selected list.  
8. Click Save.  

Note that the stage column just added displays as a string field rather than as a workflow stages field. |
Two Dependency Views properties were added in Helsinki Patch 10:

- glide.bsm.max_levels: Maximum level depth from the root CI that is initially displayed in Dependency Views maps. Level depth is the graph distance between the root CI and a node.
- glide.bsm.show_virtual_node_children: Show children of virtual groups. Display the continuation of the map underneath virtual group. Virtual links are used to connect virtual groups to their child nodes.

- Discovery
  
  - SNMP probe parameters
  
  The result_format parameter was added in Helsinki Patch 10. This parameter returns JSON formatted payloads for the SNMP - F5 BIG-IP - System and SNMP - Netscaler - System probes.

- Service Portal
  
  - Ticket Conversations widget
  
  Limit the number of journal entries that appears in the ticket conversation widget using the glide.service_portal.stream_entry_limit system property. The default number is 100. To change the entry limit, in the navigation filter type sys_properties.list, then search for the property in the list.

Fixes included with Helsinki Patch 10

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 9 Hot Fix 3a
- Helsinki Patch 9 Hot Fix 1a
- Helsinki Patch 9a
- Helsinki Patch 9
- Helsinki Patch 8 Hot Fix 1
- Helsinki Patch 8
- Helsinki Patch 7 Hot Fix 5
- Helsinki Patch 7 Hot Fix 4
- Helsinki Patch 7 Hot Fix 3
- Helsinki Patch 7
- Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- Helsinki Patch 5
- Helsinki Patch 4 Hot Fix 5
- Helsinki Patch 4
- Helsinki Patch 3
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.
Helsinki Patch 9 Hot Fix 5a

The Helsinki Patch 9 Hot Fix 5a release contains fixes to these problems.

For the Helsinki Patch 9 Hot Fix 5a release:

- Build date: 7-10-2017_1147
- Build tag: glide-helsinki-03-16-2016_patch9-hotfix5a-07-08-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

---

Note: This version is approved for FedRAMP.

---

Fixed problem in Helsinki Patch 9 Hot Fix 5a

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Encryption</td>
<td>PRB701649 EdgeProxy fails to find a newer version of SafeNet</td>
<td>When SafeNet API libraries are upgraded to the newest version by copying</td>
</tr>
<tr>
<td></td>
<td>API libraries</td>
<td>corresponding JAR files into proxy/lib folder, the proxy fails to find and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>load these libraries.</td>
</tr>
<tr>
<td>Edge Encryption</td>
<td>PRB706530 On the proxy, Safenet key type is ‘nae’ instead</td>
<td>Users see the error message &quot;Unsupported Key Type&quot; for SafeNet key”.</td>
</tr>
<tr>
<td></td>
<td>of ‘safenet’</td>
<td></td>
</tr>
<tr>
<td>Reporting</td>
<td>PRB696928 Interactive filters are broken when glide.ui.escape_all_script is true in canvas/legacy dashboard</td>
<td></td>
</tr>
</tbody>
</table>

---

Fixes included with Helsinki Patch 9 Hot Fix 5a

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 9 Hot Fix 4a
- Helsinki Patch 9 Hot Fix 3a
- Helsinki Patch 9 Hot Fix 2a
- Helsinki Patch 9 Hot Fix 1a
- Helsinki Patch 9a
- Helsinki Patch 9
- Helsinki Patch 8
- Helsinki Patch 7 Hot Fix 2
- Helsinki Patch 7
- Helsinki Patch 6
Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- Helsinki Patch 5 Hot Fix 3
- Helsinki Patch 5
- Helsinki Patch 4 Hot Fix 3
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 13
- Helsinki Patch 3
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 9 Hot Fix 4a

The Helsinki Patch 9 Hot Fix 4a release contains fixes to these problems.

For the Helsinki Patch 9 Hot Fix 4a release: Build date: 06-22-2017_0915
Build tag: glide-helsinki-03-16-2016__patch9-hotfix4a-06-21-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 9 Hot Fix 4a

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistence</td>
<td>‘Before Query’ business rule works differently when using glide aggregate count</td>
<td>Under certain conditions, single score reports can display blank or incorrect data. If a ‘Before Query’ business rule is configured on a table with one or more addOrCondition filter conditions, a single score report on that table generates an invalid SQL, and the OR condition is not in the right place. As a result, the single score reports or widgets display incorrect data. When the user drills down on the report, a list loads with the correct results.</td>
</tr>
</tbody>
</table>
Fixes included with Helsinki Patch 9 Hot Fix 4a

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 9 Hot Fix 3a
- Helsinki Patch 9 Hot Fix 2a
- Helsinki Patch 9 Hot Fix 1a
- Helsinki Patch 9a
- Helsinki Patch 9
- Helsinki Patch 8
- Helsinki Patch 7 Hot Fix 2
- Helsinki Patch 7
- Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- Helsinki Patch 5 Hot Fix 3
- Helsinki Patch 5
- Helsinki Patch 4 Hot Fix 3
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 13
- Helsinki Patch 3
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 9 Hot Fix 3a

The Helsinki Patch 9 Hot Fix 3a release contains fixes to these problems.

For the Helsinki Patch 9 Hot Fix 3a release: Build date: 05-15-2017_2246
Build tag: glide-helsinki-03-16-2016__patch9-hotfix3a-05-15-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.
Fixed problem in Helsinki Patch 9 Hot Fix 3a

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asynchronous Message Bus PRB732813 KB0621950</td>
<td>After upgrading to Helsinki, HttpClient thread count grows on the MID Server</td>
<td>MID Server can go down due to a thread leak that causes the MID Server to run out of memory and go down.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 9 Hot Fix 3a

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 9 Hot Fix 2a**
- **Helsinki Patch 9 Hot Fix 1a**
- **Helsinki Patch 9a**
- **Helsinki Patch 9**
- **Helsinki Patch 8**
- **Helsinki Patch 7 Hot Fix 2**
- **Helsinki Patch 7**
- **Helsinki Patch 6**

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- **Helsinki Patch 5 Hot Fix 3**
- **Helsinki Patch 5**
- **Helsinki Patch 4 Hot Fix 3**
- **Helsinki Patch 4**
- **Helsinki Patch 3 Hot Fix 13**
- **Helsinki Patch 3**
- **Helsinki Patch 2**

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- **Helsinki Patch 1**
- **Helsinki Fixes**

**Helsinki Patch 9 Hot Fix 2a**

The Helsinki Patch 9 Hot Fix 2a release contains fixes to these problems.

For the Helsinki Patch 9 Hot Fix 2a release:

- Build date: 05-13-2017_0602
- Build tag: glide-helsinki-03-16-2016__patch9-hofix2a-05-12-2017

For more information about how to upgrade an instance, see *Upgrade to Helsinki.*
For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 9 Hot Fix 2a

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Platform PRB963801</td>
<td>When a glide_list field is made from choice entries instead of referenced records, forms do not always load completely</td>
<td>glide_list fields are most commonly used to refer to records in another table. For example, the ‘watch list’ field lists user records (“users”) who should be notified about updates to a ticket. If a glide_list is not configured to reference any table, it gets its values from sys_choice records. Users can configure choices for the field, and then from the table’s form, they can select one or more of the choices to be included in the list. This type of glide_list is susceptible to a concurrency issue with cached choice lists. It works directly with the cached choice list, so if two threads run this same code at the same time, they can corrupt the cached list and lead to NullPointerExceptions, for example. This can break the form that the glide_list is part of.</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 9 Hot Fix 2a

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 9 Hot Fix 1a
- Helsinki Patch 9a
- Helsinki Patch 9
- Helsinki Patch 8
- Helsinki Patch 7 Hot Fix 2
- Helsinki Patch 7
- Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- Helsinki Patch 5 Hot Fix 3
- Helsinki Patch 5
- Helsinki Patch 4 Hot Fix 3
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 13
- Helsinki Patch 3
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
• Helsinki Fixes

Helsinki Patch 9 Hot Fix 1a

The Helsinki Patch 9 Hot Fix 1a release contains fixes to these problems.

For the Helsinki Patch 9 Hot Fix 1a release:

Build date: 03-31-2017_0731
Build tag: glide-helsinki-03-16-2016_patch9-hotfix1a-03-28-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 9 Hot Fix 1a

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow PRB901089</td>
<td>ODBC driver and SOAP queries are slower in Helsinki due to Workflow stage fields</td>
<td>Certain ODBC driver and SOAP queries are running more slowly in Helsinki than they did in Eureka. Users may notice latency when making a single query that returns multiple rows containing a Workflow stage field. To activate the fix for PRB901089 on Helsinki Patch 9 Hot Fix 1a instances, set the property glide.workflow.PRB901089 to true.</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 9 Hot Fix 1a

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

• Helsinki Patch 9a
• Helsinki Patch 9
• Helsinki Patch 8
• Helsinki Patch 7 Hot Fix 2
• Helsinki Patch 7
• Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

• Helsinki Patch 5 Hot Fix 3
• Helsinki Patch 5
• Helsinki Patch 4 Hot Fix 3
• Helsinki Patch 4
• Helsinki Patch 3 Hot Fix 13
• Helsinki Patch 3
• **Helsinki Patch 2**

  Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

• **Helsinki Patch 1**

• **Helsinki Fixes**

**Helsinki Patch 9a**

The Helsinki Patch 9a release contains fixes to these problems.

For the Helsinki Patch 9a release:

  - **Build date:** 03-22-2017_2340
  - **Build tag:** glide-helsinki-03-16-2016__patch9-hotfix0a-03-17-2017

ServiceNow QPP targets and patches are immediately available. Users do not need to request an entitlement to schedule an upgrade to these versions.

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).

Note: This version is approved for FedRAMP.
Fixed problem in Helsinki Patch 9a

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>In Service Portal, catalog item variables are read-only for non-roled users</td>
<td>When the variables in a catalog item have write_roles configured, and a non-roled user tries to create a request using the catalog item, all of the variables are read-only in Service Portal. However, the variables in the catalog item in the normal catalog UI are not read-only. The Catalog desktop UI checks create_roles when ordering, and it later checks write_roles in the variable editor. However, Service Portal checks write_roles in both places. The fix for this PRB resulted in an API change to the getCatalogItem method. For details, refer to KB0621849.</td>
</tr>
</tbody>
</table>

Steps to reproduce

1. As an admin user, navigate to Maintain Items.
2. Open the Sales Laptop catalog item.
3. From the related list, open the Additional software requirements variable.
4. Add the Write roles field to the form if is not already there.
5. Add the admin role to the variable (so that the admin is required to write to the variable).
6. Click Update.
7. Impersonate an ESS user.
8. Navigate to the Service Portal.
9. Search for and view the Sales Laptop catalog item.

Expected behavior: Variables are writable in the normal UI and Service Portal.
Actual behavior: Variables are read-only in Service Portal. They are writable only in the normal UI.

Other Helsinki Patch 9a information

Service Portal and the `getCatalogItem scriptable API`

- Changes were made to the getCatalogItem method in order to support the same functionality in Service Catalog and Service Catalog in Service Portal.
- The getCatalogItem class was changed from `getCatalogItem(String itemID)` to `getCatalogItem(String itemID, boolean isOrdering)`. For details, refer to KB0621849.

Fixes included with Helsinki Patch 9a

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 9
- Helsinki Patch 8
- Helsinki Patch 7 Hot Fix 2
- Helsinki Patch 7
- Helsinki Patch 6
Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- Helsinki Patch 5 Hot Fix 3
- Helsinki Patch 5
- Helsinki Patch 4 Hot Fix 3
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 13
- Helsinki Patch 3
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 9

The Helsinki Patch 9 release contains fixes to these problems.

Helsinki Patch 9 was released on February 14, 2017. Build date: 02-07-2017_2304
Build tag: glide-helsinki-03-16-2016__patch9-01-27-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.
For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Security-related Fixes

Helsinki Patch 9 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 9, refer to KB0621356.

Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat</td>
<td>When a Connect conversation is in full view, requests flood the default semaphore queue and cause other requests to be rejected on the affected node (429 errors)</td>
<td>In full view, Connect conversations shake when the conversation is long enough to introduce the scrollbar. When the scrollbar shakes, many GET requests occur and cause 429 errors because there are too many requests currently in the queue.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>
| User Interface (UI)                    | User preferences are incorrectly being set to false, breaking homepages and related lists | Related lists are disabled for the user until an accepted value is entered. This causes errors when loading homepages and dashboards.                                                                              | 1. At the bottom of a browser console, enter `CustomEvent.fireAll(undefined,false);`
2. Refresh the browser and click the gear icon.
Note that in General, Home has no default selections – neither Homepages nor Dashboards were selected.
Refer to the listed Known Error KB article for details.                                                                                           |
<p>| Performance Statistics and Graphs     | Blank lists might display when trying to view a table                             | Many operations, like loading the list view for a table, are timed for building performance metrics. An issue with this timing causes the transaction it is timing to error out.                                         | One possible symptom is seeing a blank list when trying to visit a table despite not failing any ACLs. The issue resolves itself in a few hours or days. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) | Activity stream does not load if relationship changes are in the feed and modifications were made by an invalid or nonexistent user | Activity stream does not load if relationship changes are in the feed and modifications were made by an invalid or nonexistent user | 1. Impersonate an admin user (e.g. Fred Luddy).  
2. Navigate to Incident > Open.  
3. Select any Incident and note its number.  
4. Right-click in the form header and choose Configure > Related Lists.  
5. Add Task->Parent to the Selected list and click Save.  
6. Go to the Tasks related list on your Incident and click Edit.  
7. Move any Task to selected and click Save.  
   An activity stream entry for your relationship change is displayed.  
8. Delete / change the user ID from the admin account (e.g. Fred Luddy).  
9. Reload the Incident from step 3.  
Note that instead of the user ID for the invalid account being displayed, the activity stream does not load, and NPE errors are listed in the logs. |
| Edge Encryption | A network outage can cause the proxy server to give up trying to connect back to the instance | This issue only affects Edge Encryption users. Users should be able to set the connection retry interval and retry limit for the proxy server.  
The fix for this PRB allows users to set the retry interval and limit with the edgeencryption.register.retry.count property. The default value for the connection retry interval is 5 seconds, and the default value for the retry limit is 0. When the retry limit is set to 0, the proxy server will attempt to reconnect until a connection is established.  
See Edge Encryption general properties for details. |
All Other Fixes

<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication</td>
<td>SAML 2 memory utilization</td>
<td>The SAML 2 plugin is storing an array of request IDs in the HTTP session. Usually the array is small with only one item, but a Rhino NativeArray object is being stored. The retained size of a Rhino NativeArray object with one item is approximately 120K. Only SAML users are affected by this issue.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Chat</td>
<td>Connect, Connect Support, NG shared component</td>
<td>Using ‘Chat Live with Support’ on the iOS mobile app causes user messages to be erased as they type</td>
<td>Using the iOS mobile app: 1. Navigate to Service Portal › Home. 2. Hit the Menu button in the top right and tap Chat Live with Support. 3. Send the first question in the chat. 4. Then, starting typing and sending messages. Eventually, messages will begin to get erased as you type. For example, if you start typing “test test test”, suddenly you will be typing in an empty text field.</td>
<td></td>
</tr>
<tr>
<td>Chat</td>
<td>Chat Legacy Chat in Helsinki, the chat client user does not see responses until the chat window is reopened</td>
<td>This issue occurs when a user launches chat using a link within a CMS page. This is done using the format outlined in Link syntax. When the CMS page is loaded within the nav frame, the chat window loads. However, the user will not get the initial response from the queue or any responses from the support tech. If the caller closes the chat window and starts another chat, the issue no longer occurs. When the CMS page is loaded outside of the nav frame, the issue does not occur at all.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Configuration Management (CMDB) PRB717738 | Configuration Management (CMDB) | **CMDB Health Dashboard - Correctness** is not getting updated | On the CMDB dashboard, the user can click the add content (+) symbol, but there are no drop zones to place the selected widget. | 1. Open a CI record, and then click the Dashboard button.  
2. Click the add content (+) icon.  
You can select a widget, but there are no drop zones to place the widget in the dashboard. |
<p>| Configuration Management (CMDB) PRB709868 | Configuration Management (CMDB) | Unable to add or modify widgets on the CMDB Dashboard | This issue occurs when metrics reach the maximum failures. |
| Configuration Management (CMDB) PRB719770 | Configuration Management (CMDB) | Incorrect values for metric scores and total processed CIs on the CMDB Health Dashboard | |
| Currency PRB675746 | Unique key violation is seen when record watcher is enabled on tables with currency field | When the record watcher is enabled on tables with currency values and are update synced, unique key violation errors occur. | |</p>
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Currency | PRB744 | 73 | Currency values are rounded to integers when the user’s locale is `jp-JP`. | Using IE11:  
1. Set the browser language setting to `jp-JP`, and rank it above other languages (such as English).  
2. Log in to an OOB instance.  
3. Navigate to any price-related items (e.g., Service Catalog > Hardware items).  

Note that the prices are displayed with the `$` prefix, and the values are rounded up. |

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
</table>
|  |  |  | Currency values are displayed incorrectly. This issue occurs when using IE11 with the browser language set to `jp-JP`, as the priority (i.e. above other languages or as the only preference). Items are displayed with either of these issues:  
• The item has a `'$'` prefix, and its price is rounded up. For example, if an item’s price is `100.99`, it displays as `101`.  
• The item has a `'¥'` prefix, but the decimal digits are incorrect (e.g. 4 digits).  

To activate the Helsinki fix, create and set the system property `glide.currency_price.set_fraction_digits` to true. This will format currency values with a maximum of 2 fraction digits regardless of the locale. The default false will retain old behavior.  

In Istanbul, currency/price fields support up to 4 fraction digits. When the property `glide.currency_price.use_all_fraction_digits` is set to `true`, display values returned by currency/price fields are formatted to return up to 4 fraction digits in any locale. The minimum number of fraction digits is determined by the locale. For example, if a `jp-JP` user enters values with fraction digits (1-4), then that number of fraction digits are shown. If no fraction digits are not entered, then none are shown.  

See the Istanbul product documentation for details:  
• [Currency values in lists](#)  
• [Currency properties](#)  

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Service</td>
<td>Targeted Communications</td>
<td>Targeted</td>
<td>In Targeted Communications, BCC’d email recipients are listed in the ‘To’ list instead of the ‘BCC’ list.</td>
<td>1. As a publication author, create a recipient list (e.g. Consumers). 2. Create a publication and add the recipient list that you created. Expected behavior: The email recipients should be in the ‘BCC’ list. Actual behavior: Once the publication is published, the recipients are notified.</td>
</tr>
<tr>
<td>Service Management</td>
<td>PRB698747</td>
<td>/recipients are listed in ‘To’</td>
<td>In Targeted Communications, BCC’d email recipients are listed in the ‘To’ list instead of the ‘BCC’ list.</td>
<td></td>
</tr>
<tr>
<td>Discovery</td>
<td>PRB714435</td>
<td>Session pool fails to unblock borrowers when returning failed connections</td>
<td>Apache Commons Pool does not check for blocked borrowers when returning objects that fail with testOnReturn enabled.</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>PRB673943</td>
<td>System property glide.email.forward_from_prefix update not functioning as expected</td>
<td>If the <code>glide.email.forward_from_prefix</code> property is set with a value of ‘from:’ (without the quotes), and if the email starts with ‘from:’ (without the quotes, no leading spaces, or characters), the email is not treated as a Forward. It is treated as a new email instead. If there are leading spaces or any other text before ‘from:’ or ‘From:’), the email is correctly treated as a Forward. The expectation is that if the email has “from:” or “From:” anywhere in the body, it will be treated as a forward. This is the message in the logs: Classified as new; Email looked like a forward, but was not marked as such because no keys from property glide.email.forward_from_prefix were found.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Financial Management</td>
<td>PRB742326</td>
<td>Allocation Engine is generating lines very slowly</td>
<td>For some users, the ITFM Allocation Engine and its jobs run for a long time. For example, the Allocating Expenses job took 36 hours for a user. The long job duration occurred because millions of allocation lines were being generated for the user, and inserting the millions of lines took a long time. The ITFM product documentation was updated with details on this PRB fix, which provides the ability to generate allocation lines as needed.</td>
<td>• Create a cost model with the Cost Model form &lt;br&gt;Under Financial Model form fields, see Choose Segments for GL Expense Lines for details on this new field that allows you to choose segments to generate the GL expense lines in the itfm_allocation table. &lt;br&gt;• Create a breakdown relationship &lt;br&gt;After creating a cost model, define a breakdown relationship between required segments to view cost lines generated between the segments. &lt;br&gt;• Generate controlled cost lines &lt;br&gt;After creating a breakdown relationship, generate controlled cost lines. Before Helsinki Patch 9 and in Istanbul, cost lines generated in itfm_allocation_aggregates were a multi-model data enabling you to view cost split in any segment combination, which did not assist in performance or save the database space.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Forms            | PRB733103        | Activity stream appears as empty | Some users are experiencing issues with the activity stream - users cannot view work notes and additional comments. This issue affects any journal fields (e.g. work notes, comments, or custom types). | 1. Perform a cache flush.  
2. Open an incident and fill the Short description with: Here’s a test.  
3. Submit the incident.  
4. Go to /incident.list.do.  
5. Open any other incident.  
Note the activity stream remains empty. Errors appear in the developer console. |
| Governance, Risk and Compliance | PRB722431 | Manual indicators may error with ‘GRC indicator nightly run’ | When there is an active Manual indicator that has no ‘reference table’ set, the GRC indicator nightly run scheduled job will prematurely error and stop. | Activate the Governance, Risk, and Compliance (GRC) (com.snc.governance) plugin with demo data.  
1. Navigate to Policy & Compliance › Indicators.  
2. Create new a Collection:  
   • Frequency: Daily  
   • Type: Manual  
   • Item: <any>.  
3. Go to Scripts - Background and run:  
   new IndicatorEngine().runAllIndicators();  
Expected behavior: The appropriate indicator tasks are created. Actual behavior: The IndicatorEngine stops prematurely and errors. |
| Import / Export | PRB678591        | After Geneva upgrade, columns in Excel export auto-wrap and do not automatically resize the width to fit all content in one line | In Fuji, columns in Excel exports were resized automatically to fit the width of all content in one line on an Excel export. This behavior changed in Geneva - all columns are exported as a fixed width by default, and the text for each field wraps to the next line. | In a Fuji instance  
1. Open any list report.  
2. Export the report to Excel.  
   The column width automatically resizes.  
In a Geneva instance  
1. Open any list report.  
2. Export the report to Excel.  
   The column width is fixed with text wrapping. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge</td>
<td></td>
<td></td>
<td>Table styling from imported doc file is stripped out when document is imported into Knowledge.</td>
<td>When a document is imported into Knowledge, the imported file loses its table styling. The table structure is still present and works as expected, but its styling is lost.</td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td></td>
<td>KB header that has Attach to (Task) button is not available for certain users due to conditions in ‘kb_view_common’ UI Macro.</td>
<td>When users try to attach a knowledge article from the short description in an incident form, the header on the kbpop window is hidden, and the user does not have the option to attach the KB article to the incident.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Knowledge Management V3 | Knowledge Management V3 | When ESS users access the Knowledge homepage, categories intermittently do not show up | ESS users are experiencing intermittent issues with categories on the Knowledge homepage. When some ESS users click the ESS link to the Knowledge page, no categories are loaded. Sometimes, all categories load correctly. | This issue occurs intermittently.  
1. Log in to an instance as an admin user.  
3. Make one knowledge base active, and make the remaining knowledge bases inactive.  
4. Navigate to ESS.  
5. Press command and click the knowledge link 20-30 times continuously on that page. This will cause 20-30 tabs to open.  
In some of these tabs, the categories do not load.  
Expected behavior: The categories load on the knowledge base home.  
Actual behavior: The categories do not load. |
| Knowledge Management V3 | Knowledge Management V3 | Users can select knowledge base to 'Import Articles' even though they do not have contribution access to that KB | When a user tries to import an article using the ‘Import Article’ button found on the Knowledge homepage, they are able to select a knowledge base that they do not have contributing access to. | Part 1: Give access to the ‘Import Articles’ button to Adela (demo user).  
1. Log in as a user with elevated privileges.  
2. Navigate to Knowledge > Administration > Knowledge Bases.  
3. Click on the IT knowledge base.  
4. Under the Can Contribute section, click on the user criteria The ACME North America IT Department.  
5. Uncheck the Match All checkbox, and add Adela Cervantsz to the Users field.  
Part 2: Reproduce the issue.  
1. Impersonate Adela Cervantsz.  
2. Navigate to Self-Service > Knowledge.  
3. Click Import Articles.  
4. Click on the dropdown list field Knowledge Bases.  
Note that the ‘Knowledge’ KB is one of the options, even though the user do not have ‘contribute’ access to the Knowledge KB. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge \ Management</td>
<td>Knowledge Management V3</td>
<td>Resizing issues with Knowledge pages</td>
<td>Knowledge pages are not always resized properly - some pages are cut off. In addition, the Knowledge ESS script should only run when knowledge pages are being rendered.</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management PRB721929</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Knowledge Management PRB687945</td>
<td>Knowledge Management V3 KB0596764</td>
<td>Users with knowledge admin role do not have read/write access to all knowledge bases</td>
<td>Users with knowledge admin role should have read/write access to all knowledge bases regardless of user criteria.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Language and Translations PRB720903</td>
<td></td>
<td>Additional Helsinki translations</td>
<td>Some translations need to be added for user-facing messages.</td>
<td></td>
</tr>
<tr>
<td>Performance Analytics PRB726997</td>
<td>Performance Analytics</td>
<td>Records not appearing when the Records tab is selected</td>
<td>When the Records tab is selected, records are not shown. Instead, the chart is still displayed. This issue may also affect users who are viewing a detailed scorecard from a different timezone. To reproduce this issue, set a job to collect for Number of open incidents in the ‘Pacific/Auckland’ timezone and view the scorecard as a user from the Amsterdam timezone. Even though collection happens until yesterday, the record tab is not shown for yesterday’s score.</td>
<td>1. Collect for the indicator until today (i.e. set the value Relative End to 0). 2. Open the indicator and turn off real-time scores. 3. Click today’s date in the graph. 4. Click the Records tab. Expected result: The Records tab shows the records that contribute to the score. Actual result: The Records tab is selected but the Chart is displayed. No records are shown.</td>
</tr>
<tr>
<td>Persistence PRB675240</td>
<td></td>
<td>Update or Insert incident causes “Lock Wait TimeOut Exceeded, try restarting transaction” due to update set changing default value or adding boolean field</td>
<td>Long-running transactions updating the task table can fail when new fields are added to the Incident form. The system does not batch or limit the UPDATE that initially populates the default value when fields are first created, resulting in an UPDATE statement that always targets the entire table. These long-running updates can block reads against that table and can cause an outage.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Platform Security PRB735958</td>
<td>Virtual tables do not work with read-only mode</td>
<td>A symptom of this issue is that an instance’s plugin list appears as empty.</td>
<td>1. Navigate to v_plugin_list.do. Note table is empty. 2. Clear the cache. 3. Reload the plugins.</td>
<td></td>
</tr>
<tr>
<td>Platform Security PRB734805</td>
<td>User roles are deleted when ‘glide.role_management.use.inh_count’ is true without Role Management V2 plugin</td>
<td>When the property ‘glide.role_management.use.inh_count’ is manually created on an instance without activating the Role Management V2 plugin (com.glide.role_management), it ends up deleting entries in the sys_user_has_role table that are marked with ‘inherited’ true.</td>
<td>On an instance that does not have Role Management V2 plugin, create a new system property ‘glide.role_management.use.inh_count’ set to true. Notice that as you make changes to the user roles, some of the inherited roles are automatically deleted.</td>
<td></td>
</tr>
<tr>
<td>Project Management PRB710090</td>
<td>Scroll focuses to the top when certain changes are made to a task via the planning console</td>
<td>If a user makes a change such as updating a task’s dependencies, the planning console will focus scroll to the top of the page.</td>
<td>Ensure the PPM plugin is activated with demo data. 1. Open the planning console and select a project with at least 20 tasks. 2. Expand the tasks so that a scroll bar appears. 3. Scroll down as far as possible and connect a task dependency to another task.</td>
<td>Actual behavior: The loading progress icon should appear, and the user should stay in the same location while making the update. Expected behavior: The loading progress icon should appear, and the user should stay in the same location while making the update.</td>
</tr>
<tr>
<td>Reporting PRB718174</td>
<td>When using the MAP type, incorrect data and indexes can result in performance issues</td>
<td>This issue affects users who have a database with large amounts of data containing: • invalid location fields • mapping that does not have the same literals for countries</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scheduled Job Processing PRB732745</td>
<td>GlideSchedulerWorker occasionally throws NullPointerException</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Security Incident Response</td>
<td>Security Incident Response</td>
<td>Security Incident Response plugin is causing issues with attachments and work notes</td>
<td>The Security Incident Response plugin is stopping user access to journal fields on any non-task table.</td>
<td></td>
</tr>
<tr>
<td>Service Catalog</td>
<td>PRB679719</td>
<td>In scriptable order guides, variables in a variable set do not cascade</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| PRB669691 | Attachments are removed from requested items | The ‘Order Now’ function does not carry over attachments from the cart to the requested item. | 1. Go to a catalog item order page.  
2. Add an attachment to it and click Order Now.  
3. Open the generated requested item. Note there is no attachment associated with it. | |
<p>| Service Catalog | PRB691890 | Forms do not display correctly in list or form view when hovering over some reference icons | In a list or form view, if a user hovers over a reference icon with a sys_popup view containing a variable editor, the form ‘moves’ or ‘bounces’ on the screen. If the variable editor is removed from the equation, the issue does not occur. | Refer to the listed Known Error KB article for details. |</p>
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog</td>
<td></td>
<td>Cart layouts</td>
<td>If Price, Quantity or Subtotal are unchecked, the Item Ordering Widget is not visible.</td>
<td>1. Navigate to Maintain Cart Layouts › Shopping Cart Widget.&lt;br&gt;2. Uncheck Visible and save.&lt;br&gt;3. Navigate to Maintain Cart Layouts › Item Ordering Widget.&lt;br&gt;4. Fill in the form in the Components section as follows:&lt;br&gt;• Price - Uncheck&lt;br&gt;• Recurring price - Check&lt;br&gt;• Quantity - Uncheck&lt;br&gt;• Subtotal - Uncheck&lt;br&gt;• Recurring subtotal - Check&lt;br&gt;• Delivery time - Check&lt;br&gt;5. Go to a Catalog Item.&lt;br&gt;Notice the entire Item Ordering Widget is not visible. If you check any one of the check boxes for Price, Quantity or Subtotal, then the Item Ordering Widget is visible.</td>
</tr>
<tr>
<td>PRB712453</td>
<td>KB0621186</td>
<td>are not functioning correctly</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Catalog</td>
<td></td>
<td>Unable to select text in read-only variables using Firefox</td>
<td></td>
<td>1. Find a catalog item with a string variable on it, or add a string variable to an existing catalog item.&lt;br&gt;2. Configure the variable form and add the write roles field.&lt;br&gt;3. Add a write role of Admin to the variable.&lt;br&gt;4. As admin, order your item and provide a value for the variable.&lt;br&gt;5. Using Firefox, log in as a non-admin user with access to view the requested item.&lt;br&gt;6. Try to copy the text in the read-only variable.&lt;br&gt;Note that you cannot select or copy text.</td>
</tr>
<tr>
<td>PRB705073</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Mapping</td>
<td></td>
<td>Service Mapping performance issues</td>
<td>Some users are experiencing performance issues with Service Mapping. When changes occur around the same time in multiple business services, the service model re-computations take a long time and occupy all worker threads.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>--------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB752105</td>
<td>Business Service Map: Connecting to existing service/ create new service is disabled on connection leading from NAT.</td>
<td>Upon right-clicking on an outgoing connection from NAT, users should be able to connect to an existing service or create a new service.</td>
<td></td>
</tr>
</tbody>
</table>
| Service Portal   | PRB730090        | Catalog item quantity selector is not displayed for non-admins | This issue occurs when the glide.sc.allow.quantity property is empty. | Activate the ‘Service Portal for Enterprise Service Management’ plugin.  
1. Impersonate an admin user.  
2. Navigate to Service Catalog › Catalog Definitions › Maintain Items.  
3. Open the catalog item Apple iPhone 5 and click Try it.  
   Notice that the quantity choice list is showing correctly.  
4. Impersonate an itil user and notice that even for this user, the quantity choice list shows up.  
5. Navigate to Service Portal (/sp) and open the catalog item.  
   The quantity should show up for the itil user in Service Portal, but it does not. It only displays for the admin user. |
| Service Portal   | PRB715696 KB0610264 | Service Catalog subcategories do not display when no item is on the category level | Service Portal Service Catalog categories and their subcategories do not display when there is no item on the category level. | 1. Create a catalog category with no items associated to it.  
2. Create a subcategory in that category and associate items to it.  
3. View the category or a list of categories including yours in the standard Service Catalog.  
   Note that Category (empty) and subcategories (not empty) display.  
4. View the category or a list of categories including yours in the Service Portal Catalog.  
   Note that the Category does not display and neither do subcategories. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Studio</td>
<td>PRB636482</td>
<td>Scoped apps: Activity Formatter not supported for configuration</td>
<td>The activity formatter is global and available to all task tables. To configure it for a specific table, users must create a system property formatted as follows: glide.ui.{MY CUSTOM TABLE}_activity.fields. However, in a scoped application, it is {MY SCOPE}.glide.ui.{MY CUSTOM TABLE}_activity.fields. This does not work properly.</td>
<td></td>
</tr>
<tr>
<td>Transaction and Session Management</td>
<td>PRB717011</td>
<td>Cancelling a transaction due to database connection exhaustion leads to infinite loop and StackOverflowError.</td>
<td>When there are no database connections available, each thread will enter a slow recursive loop. The thread tries to obtain a connection, fails, cancels the current transaction, tries to log about the cancellation, requires a database connection, and so on. Eventually, the thread will encounter a StackOverflowError.</td>
<td></td>
</tr>
<tr>
<td>Update Sets</td>
<td>PRB636890</td>
<td>Field Label is not captured in update set if created through 'Form Layout'</td>
<td>If a new field is created by going to Configure &gt; Form Layout, a sys_dictionary and sys_documentation record are created. However, if you look at the update set you are currently working in, you will only see the insert of the sys_dictionary record. If a new field is created by going to Configure &gt; Table and inserting a new row in the Table Column related list, both records are created as expected. In addition, both records are captured in the sys_update_xml table as a customer update. There is inconsistency between these two methods that should result in the same output.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Update Sets</td>
<td>System Update Sets Preview</td>
<td>Error when previewing/committing update set with an unusually formatted payload</td>
<td>Some specific update set payloads that have been formatted with line breaks can cause errors when previewing/committing. This PRB only addresses updates with line breaks in the payload element AND the payload starts with: <code>&lt;record_update&gt;</code> <code>&lt;sys_dictionary ...</code></td>
<td></td>
</tr>
</tbody>
</table>
| Upgrade Engine Issues | | When the scheduler is backed up with queued jobs, the upgrade job can be delayed | Customer expectations of a prompt upgrade are not met when their scheduler is backed up with queued jobs. | 1. Create a large amount of (>1000) schedule jobs (sys_trigger) with scripts that runs for a few seconds (e.g., with script 'gs.sleep(2000);') with priority <= 100 (lower number means higher priority).  
2. Schedule them to be ran at the same time in the near future.  
3. Wait for the time the jobs are scheduled to be ran.  
4. Monitor the sys_trigger table and the background job related localhost log.  
Expected result: The Upgrade job that runs every 1 hour shouldn’t be delayed too much.  
Actual result: The scheduler is busy processing the scheduled jobs in step 1. The Upgrade job in sys_trigger that is supposed to run every 1 hour to check if the instance needs to be upgrade is delayed to run due to the scheduler being backed up with queued jobs. | |
<p>| Upgrade Engine Issues | Upgrade monitor is stuck in finalizing stage for a long time when the scheduler is backed up with queued jobs | In the finalizing stage, the upgrade monitor waits for the upgrade to be summarized. However, the upgrade summary job’s priority is relatively low, and there are other jobs with the same or higher priority that were scheduled before or during the upgrade. Thus, the upgrade summary job is scheduled to run very late and the upgrade monitor is stuck in the ‘finalizing’ stage for a long time. | |</p>
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI)</td>
<td>PRB679644 KB0610408</td>
<td>List v3 ignores the glide.ui.goto system property</td>
<td>On Helsinki instances, List v3 ignores the glide.ui.goto system property.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Platform Security</td>
<td>PRB734805</td>
<td>User roles are deleted when glide.role_management.use is true without Role Management V2 plugin</td>
<td>When the property glide.role_management.use is manually created on an instance without Role Management V2 plugin (com.glide.role_management), it ends up deleting entries in the sys_user_has_role table that are marked with ‘inherited’ true.</td>
<td>On an instance that does not have Role Management V2 plugin, create a new system property glide.role_management.use.inh_count set to true. Notice that as you make changes to the user roles, some of the inherited roles are automatically deleted.</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB664085 NG shared components</td>
<td>Multiple user updates on a record create duplicate activity stream timestamps on the form and list stream</td>
<td>Records created from Parent/Child templates may not be linked by the correct field. For example, Change Task records may be linked to a Change Request record by the Parent field, instead of the Change Request field, which may not be displayed on the Change Task &gt; Change Request related list.</td>
<td>1. Log into two different browser sessions as user A and user B. 2. As user A, type a comment. Do not refresh the page. 3. As user B, update the short description. Do not refresh the page. Note that double entries appear on the form and list activity streams. If you refresh the page, the duplicate disappear.</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB692578 KB0598164</td>
<td>Records created via Parent and Child Templates are not properly linked</td>
<td></td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB657559 KB0564244</td>
<td>Template Dialog has double save buttons with UI advanced property enabled</td>
<td>When the system property glide.ui.advanced is set to true, two Save UI Action buttons are visible when creating a new template for Incident.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Visual Task Boards</td>
<td>Visual Task Boards</td>
<td>Visual Task Boards that point to overlapping vtb_task records can prevent non-admins from seeing cards</td>
<td>If a user creates a task board against the vtb_task table and then another user creates a task board that includes overlapping records with the first, the boards will no longer display all the cards unless the user is logged in as an admin. The VTBTaskSecurity script includes that is used to evaluated read ACL security for vtb_task records does not handle the case where vtb_task records may be referenced in more than one card.</td>
<td>1. Impersonate an ITIL user. 2. Navigate to Self-Service &gt; Visual Task Boards. 3. Click Create Freeform Board. Using the freeform format ensures that the vtb_task table is utilized. 4. Create one task for each lane (To Do, Doing, and Done). 5. Add Beth Anglin as a member. 6. Impersonate Beth Anglin. 7. Navigate to Self-Service &gt; Visual Task Boards. 8. Open the board you created in step 3. 9. Ensure that you can see the tasks created in step 4 while logged in as Beth Anglin. 10. Still logged in as Beth, in the Application Navigator, type vtb_task.list in the Filter navigator field and press enter or return on your keyboard. 11. Create a new visual task board by right-clicking next to the column header Number and selecting Show Visual Task Board. 12. Impersonate the ITIL user from step 1. 13. Navigate to Self-Service &gt; Visual Task Boards. 14. Open the board created in step 3. Note that 2 of the 3 cards are missing. All of the cards are displayed for users logged in as admin.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Visual Task Boards PRB716040 | Visual Task Boards | Upgrading from Fuji to Geneva does not replace the script includes are not replaced. Instead, a new script include is created with the same name and a new sys ID. | When users upgrade from Fuji to Geneva, the ‘VTBTaskSecurity’ script includes are not replaced. Instead, a new script include is created with the same name and a new sys ID. | Make sure that the Visual Task Boards plugin is activated.  
1. Provision a Fuji instance (e.g. Fuji Patch 10).  
2. Navigate to System Definitions > Script Includes > script include with name VTBTaskSecurity and sys ID ‘55112d03eb30310007e48c1cf106fe23’.  
3. Upgrade the instance to Geneva Patch 7.  
   Once the upgrade is complete, notice that there are now two script includes with the same name and different sys IDs (one with ‘55112d03eb30310007e48c1cf106fe23’ and the other with ‘c0e5f973c300020038e7fe0712d3aeed’).  
   Expected behavior: There should be only one script includes with that name.  
   Actual behavior: There are two script includes with the same name. |
| Web Services PRB723438 | SOAP requests for records that contain workflow stage display values may execute slower after Eureka | When using ODBC to query the sc_req_item table, the individual SOAP calls to /sc_req_item.do?redirectSupported=true&SOAP&displayvalue=all take longer in Helsinki than they did in Eureka. | 1. Order an item from the service catalog that uses a workflow for fulfillment AND that workflow uses stages.  
2. Create a SOAP request that queries for the record produced in step 1.  
3. Measure the time it takes to complete step #2, and compare this time to a Eureka instance.  
   The SOAP request will take longer for instances running post-Eureka versions.  
   Note: For most instances, the difference is only a 10–20ms per record. However, in some instances with a large amount of possible stage values, the difference can be significant. |

Other Helsinki Patch 9 information

- Edge Encryption
  - **Edge Encryption general properties**

The edgeencryption.register.retry.count allows users to set the maximum number of times the proxy will ping the instance to try to register. The default is 0 (no limit).
• Financial Management
  • Create a cost model with the Cost Model form
    Under Financial Model form fields, see Choose Segments for GL Expense Lines for details on this new field that allows you to choose segments to generate the GL expense lines in the iftm_allocation table.
  • Create a breakdown relationship
    After creating a cost model, define a breakdown relationship between required segments to view cost lines generated between the segments.
  • Generate controlled cost lines
    After creating a breakdown relationship, generate controlled cost lines. Before Helsinki Patch 9 and in Istanbul, cost lines generated in iftm_allocation_aggregates were a multi-model data enabling you to view cost split in any segment combination, which did not assist in performance or save the database space. To overcome this, Generate Controlled Cost Lines functionality is introduced for you to control the required allocation lines per your business needs.

• Knowledge Management
  • Select user criteria for a knowledge base
    The CanRead and CanContribute flowcharts were updated to include the knowledge_admin user role.

Fixes included with Helsinki Patch 9

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.
  • Helsinki Patch 8
  • Helsinki Patch 7 Hot Fix 2
  • Helsinki Patch 7
  • Helsinki Patch 6

  Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

  • Helsinki Patch 5 Hot Fix 3
  • Helsinki Patch 5
  • Helsinki Patch 4 Hot Fix 3
  • Helsinki Patch 4
  • Helsinki Patch 3 Hot Fix 13
  • Helsinki Patch 3
  • Helsinki Patch 2

  Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

  • Helsinki Patch 1
  • Helsinki Fixes
Helsinki Patch 8 Hot Fix 1

Helsinki Patch 8 Hot Fix 1 provides fixes for the Helsinki release.

For Helsinki Patch 8 Hot Fix 1:

- Build date: 02-22-2017_2247
- Build tag: glide-helsinki-03-16-2016_patch8-hotfix1-02-22-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 8 Hot Fix 1

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistence</td>
<td>PRB756253</td>
<td>When a task column is moved into offrow storage, it breaks certain database views that include tables that extend task.</td>
<td>1. Activate the ‘Database Column Offrow Migration’ plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Using the view in a report or via ‘Try it’ results in an error: &quot;Syntax Error or Access Rule Violation detected by database (Unknown column ‘XXXX.XXXX’ in ‘on clause’)&quot;.</td>
<td>2. Create a string column on task with length of 4000.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. On the Dictionary record for the new column, click the Move Column Offrow related link, and click Start to confirm the action.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Now open one of the following database view records, and click Try it:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• incident_sla</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• incident_metric</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• incident_time_worked</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• problem_metric</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• task_survey_detail</td>
</tr>
</tbody>
</table>

You receive an error message: "Syntax Error or Access Rule Violation detected by database (Unknown column ‘task_survey_detail0.sys_id’ in ‘on clause’)".

Fixes included with Helsinki Patch 8 Hot Fix 1

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 8
- Helsinki Patch 7
- Helsinki Patch 6 Hot Fix 3
Helsinki Patch 8

The Helsinki Patch 8 release contains fixes to these problems.

Helsinki Patch 8 was released on December 15, 2016.

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Security-related Fixes

Helsinki Patch 8 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 8, refer to KB0598876.

Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI) PRB693251 KB0596952</td>
<td>IE11: Applying a Microsoft MS16-084 critical patch breaks URLs containing JavaScript calls</td>
<td>After installing the MS16-084 patch, if you access a Fuji, Geneva, Helsinki instance using Internet Explorer 11 and try to apply a template to a record, the pop-up window for selecting templates is blank. The changes to the security settings are blocking any URLs which contain a <code>javascript()</code> function call. For more information, see Microsoft Security Bulletin MS16-084.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Usage Analytics PRB684790 KB0598198</td>
<td>UsageAnalytics Count Persistor can cause out of memory when processing certain count config definitions</td>
<td>On user instances, the scheduled job UsageAnalytics Count Persistor can run each app node out of memory several times in a matter of seconds, due to processing certain count config definitions (records on the usageanalytics_count_cfg table).</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Cloud Management Application PRB719336 KB0598789</td>
<td>Amazon Web Services (AWS) describemages probes can cause nodes to run out of memory when processed</td>
<td>Nodes that have excessive memory usage are experiencing performance degradation. This issue affects users who are running Discovery schedules for Amazon Web Services (AWS) accounts.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Problem</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Service Portal PRB707434 | Date format not honored in Service Catalog part of Service Portal (gs.nowDateTime) | While in the Service Portal and interacting with the Service Catalog’s Date variables, the value do not honor the date format set via the glide.sys.date_format property. | In a Helsinki instance:  
1. Navigate to System Properties › Basic Configuration.  
2. Change the glide.sys.date_format property to dd-MMM-yy.  
3. Edit the Create an Incident record producer and add a Date variable.  
4. Navigate to the Service Portal › Service Catalog › Can we help you? › Create an Incident.  

Expected result: The value should be in the format of dd-MMM-yy (e.g. 18-Aug-16).  
Actual result: The value is in the format of yyy-MM-dd (e.g. 2016-08-18). |

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Authentication PRB709544 | | On the HI Service Portal unauthenticated page, a login popup appears | This popup appears very quickly in in Safari, and it appears after some time in other browsers. The following console error appears: Failed to load resource: the server responded with a status of 401 (Unauthorized) | 1. Log out of your instance.  
2. In Safari, go to your instance’s URL.  
3. Without logging in, leave the page as-is for 5–10 minutes.  

Note this message in the console: Failed to load resource: the server responded with a status of 401 (Unauthorized) |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Core, Change Request</td>
<td>Change Management</td>
<td>“Affected CIs” related list on Incident form triggers a warning on the logs: Script (ChangeProposed): (init) Unknown parameter passed in: (object GlideRecord)</td>
<td>For a OOB instance with the related list CIs Affected (task.ci) added to the Incident Form, each time the incident is loaded and there is a CI on the list of Affected CIs, the following warning message appears in the logs: “WARNING *** WARNING *** *** Script (ChangeProposed): (init) Unknown parameter passed in: (object GlideRecord)”</td>
<td>1. Open an incident form record. 2. Add the Affected CIs related list to the form. 3. Add a CI. 4. Save the record and copy the URL. 5. Navigate to System Logs &gt; Utilities &gt; Node Log File Tailer. 6. Open a new tab, paste the URL that you copied in step 4, and open the URL. 7. Navigate to the Node log file tailer. In the logs, the following error message appears: *** Script (ChangeProposed): (init) Unknown parameter passed in: (object GlideRecord)</td>
</tr>
<tr>
<td>Change Management - Risk Assessment</td>
<td>Change Management - Risk Assessment</td>
<td>Change Risk Assessment popup on submit is not being saved correctly</td>
<td>This issue can only be reproduced in Windows 7 (32 bit) and Chrome 54. When a change’s risk assessment is filled in and submitted, and the user views the record in the Risk Assessment related list, there is no Completed by or date stored. When a user tries to execute Risk Assessment, it errors out with a message saying the Risk Assessment must be completed. The Helsinki Patch 8 fix for PRB723003 also includes a fix for PRB726440.</td>
<td>Prerequisites  • Ensure you are using a 32 bit Windows 7 VM;  • Download Windows 7 and install as 32bit on VMware fusion [here].  Steps to reproduce  In a Geneva instance: 1. Install the 'Change Management - Risk Assessment’ plugin with demo data. 2. Set the form to load related lists on demand. 3. Create a Change record with category Software and click Submit. 4. Click Fill Out Risk Assessment. 5. Fill in the survey and click Submit. 6. Load the related lists to see the Risk Assessment list. See that the record is there; however, no “Completed by” or “Completed date” is populated. 7. Click Execute Risk Assessment. Note the message “A risk assessment is required...”</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Cloud Management Application</td>
<td>PRB663054</td>
<td>AWS Discovery fails to discover images in US regions</td>
<td>Discovery fails while discovering Amazon Web Services when public images are in the payload. The Discovery log shows the following: “Sensor error when processing &lt;a href='ecc_queue.do?sys_id={SYS_ID}'&gt;AWSRESTProbe/https:{URL}&lt;/a&gt;: Payload attachment exceeds the limit of 5242880 bytes set by system property com.glide.attachment.max_get_size.”</td>
<td>1. Activate AWS and run Discovery. By default, both public and private images on AWS are retrieved in the payload. 2. Go to to the Discovery Status record and look at the Discovery logs.</td>
</tr>
<tr>
<td>Discovery</td>
<td>PRB715059</td>
<td>In CyberArk, getting a credential by IP where the IP is a substring of another fails</td>
<td>For the CyberArk integration, if the credential ID is blank or cannot be found, it falls back to looking up the IP address. If the IP address lookup is a substring of another, it fails. For example, if we have 10.1.1.0 and we also have 10.1.1.011, it fails. This is a CyberArk limitation.</td>
<td></td>
</tr>
<tr>
<td>Edge Encryption</td>
<td>PRB709440</td>
<td>Three known use cases can cause false Edge Encryption proxy outage alerts</td>
<td>Three known use cases can cause false Edge Encryption proxy outage alerts. In each case, the string “No Edge Encryption proxy online” appears in the instance logs, which triggers the outage alert. These three use cases can cause false outages: • A proxy starts up for the first time (Intermittent). When a brand new proxy connects to a freshly zbooted instance, it takes some time to start up after its registration, which can sometimes exceed the default 25-second outage time. • GlideCacheManager.invalidate() is called by a script. • An operation like upgrade script flushes the glide cache.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Edge Encryption | PRB750703        | HTTP response code 504 and cross origin errors recorded when connecting through the Edge Encryption proxy | When browsing through the Edge Encryption proxy, the browser records HTTP 504 response codes and CORS errors. The issue affects using POSTing records to the instance and clients using .NET as a source library. | 1. Connect to an instance through an Edge Encryption proxy.  
2. View the browser developer tools.  
Note that there are occasional HTTP 504 response codes for presence calls: /amb/connect. They also contain occasional CORS errors. |
| Edge Encryption | PRB716526        | List view of large tables (11M+ records) via proxy results in 504 gateway timeout error | When viewing large tables via proxy (e.g. a table that has more than 11 million records), the user receives a 504 gateway timeout error. Navigating to this same list view directly through the instance works as expected. | In Chrome:  
1. Set up and register a proxy for an instance that has large tables (e.g. more than 11 million records).  
2. Via the instance, open task.list.  
This works as expected and will show you the total number of records (e.g. total of 11,107,452 records).  
3. On the proxy, open Developer Tools > Console in Chrome.  
4. Via the proxy, open task.list.  
Expected result: task.list should render correctly when used via the proxy.  
Actual result: The task list is not rendered, and the user sees an iframe with an empty <body>. The following error messages appears in the console:  
"https://<name-of-instance>/task_list.do?sysparm_cancelable=true Failed to load resource: the server responded with a status of 504 (Gateway Timeout)" |
| Event Management | PRB724612        | When drilling down from EM dashboard, Service Map displays very slowly | Service Maps load very slowly when they are accessed via drill down from the Event Management Dashboard. | 1. Navigate to Events Management > Dashboard > Drill down to a service that has a big hierarchy of CIs.  
2. Change the time in time bar (i.e. slide the pointer).  
The tree is refreshed within 10-20 seconds instead of being refreshed immediately. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Management</td>
<td>Project Portfolio Suite with Financials</td>
<td>‘Budget cost’ field does not roll up the cost after making changes under Project Budget (related list)</td>
<td>The ‘Budget cost’ field is in the ‘Financials’ related list. This field is automatically populated from the project budget breakdowns in the cost plan breakdown table. When project funds are allocated for a fiscal year, the cost plan breakdown stores the budget allocation for each fiscal period. These amounts are rolled up and stored in the budget cost. However, on some instances, the budget field behaves differently. It does not roll up the cost after any changes are made under the project budget.</td>
<td>In a Helsinki instance: 1. Create any project, providing all necessary fields. 2. Create a Cost plan for the cost project and save it, which loads the cost breakdown related list immediately. 3. Create a Project budget. 4. Make some changes to the Project budget. Expected behavior: Amounts should be rolled up and stored in the budget cost. Actual behavior: Changes made to the project budget will change the Budget field value under cost plan. However, it does not update the value for field ‘Budget cost’ under ‘Financials’.</td>
</tr>
<tr>
<td>Import / Export</td>
<td></td>
<td>Journal fields “Additional comments” and “Work notes” cannot be exported in report</td>
<td>When you try to export the incident_sla report in Excel, all columns except the journal fields “Additional comments” and “Work notes” are downloaded.</td>
<td>1. Go to incident_sla.list and select any Incident. 2. Add a comment to the incident to ensure that one of the Incidents in the report has a comment. 3. Create a list report for the table incident_sla. 4. Add the Task.Additional Comments and Task.Work Notes to the columns list. 5. Run the report and export the list to a csv, excel, or pdf file. Notice that the journal fields Additional comments and Work notes are not being exported.</td>
</tr>
<tr>
<td>Live Feed</td>
<td>Live Feed, NG shared components</td>
<td>Live Feed does not load in Helsinki, and users are reporting performance degradation</td>
<td>1. Make sure Live Feed has a few feeds and members. 2. In a Helsinki instance using Internet Explorer, navigate to Live Feed. Notice it takes a very long time for Live Feed to load in Internet Explorer.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Mobile           | PRB709403        | In mobile UI client scripts, current roles are unavailable on the g_user object | 1. Create a client script that checks roles on g_user, for example:  
   ```java
   if (g_user.hasRole('admin'))
   {
       alert('Hello Admin');
   }
   ```  
   2. Log in to the mobile app as an admin.  
   The message is not displayed. |
| Performance Analytics | PRB686412 | “Daily Incident Collection” job is throwing NullPointerException at (Script.java:90) | This intermittently results in inconsistent behavior in Performance Analytics. |
| Platform Miscellaneous | PRB689641 | Large number of REST sessions in Helsinki | Some users are seeing the creation of a large number of REST sessions and unnecessary prompts for local logins. This issue is related to Chat, VTB, Presence, and other message-based features. |
| Platform Performance | PRB705025 | After upgrading to Helsinki, downloading attachments is slower than in Fuji | In Helsinki instances, users are experiencing downloads that are 2-3 times slower than they were in Fuji. |
| Project Management | PRB664936 | Assigned To reference icon in Scrum Tasks (rm_scrum_task) form returns no rows when Scrum Story has Project but no Team selected for the Story | SDLC Scrum Task form has a bug where it does not return any values in the Assigned To reference popup when the associated story for the scrum task has a value selected for Project but no value for Team selected.  
1. Create a new Story with a value for Project selected but no Team selected within the Story. Or, select any existing such record.  
2. Create a new Scrum Task for the story, or if one exists, open it.  
3. Click the Assigned to reference popup for the field.  
Note it comes up with no values. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Resource Management | PRB723145 | Resource workbench does not respond when there is a large number of overlapping resource plans | When there are many overlapping resource plans, the workbench takes a long time to load and becomes unresponsive. | 1. Create a large number of resource plans (around 70) for a single group with overlapping durations in a single year.  
3. Select Group and choose the group for which resource plans were created.  
Notice that it takes more than 15 seconds to load the workbench, and after that the page goes unresponsive. |
<p>| Security Applications | Security Incident Response | PRB719383 | PIR renders data in unreadable format | The PIR does not render data correctly - the data is there, but it is not formatted correctly. |
| Service Catalog | PRB668698 | Variable derived (dot-walked) from a catalog item will not appear on a list report if user does not have catalog_admin role | A variable that is derived (dot-walked) from a catalog item will not appear on a list report if the user does not have the catalog_admin role. This problem occurs if you run a report on the sc_req_item table and dot-walk into the Variables (+) element to select a catalog item and a variable within that catalog item. | Refer to the listed Known Error KB article for details. |
| Service Catalog | PRB712741 | UI Policy not working for hiding variables in non-doc type UI | | |</p>
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog</td>
<td>PRB713494</td>
<td>Record producer</td>
<td>When a record producer with a variable of type Yes/No or Multiple Choice with 'none' included is used to produce a record, the variable returns &quot;undefined&quot; instead of an empty string.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>PRB702974</td>
<td>KB0598709</td>
<td>variables are</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>returning</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;undefined&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>instead of an</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>empty string</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Catalog</td>
<td>PRB718193</td>
<td>Excessive memory</td>
<td>When trying to discover horizontally and top-down, the system shows an error that says, “unable to establish ssh connection to server…./” . It cannot identify the app, but it can identify other apps on the server. For example, it is possible to connect to the MID Server and then connect using SSH to another server. Horizontal discovery was able to discover Apache and Tomcat servers, but not the app.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>utilization from</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>shared cache</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>due to catalog</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>item categories</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB702974</td>
<td>Unable to</td>
<td>When a user modifies the DNS name and the user manually adds a connection to the old DNS name, the result is a floating DNS cluster that is not connected to the business service.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>establish SSH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>connection from</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MID Server to</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>other server</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Floating” CI’s</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>with no relation</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>to any Entry</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>point in a BS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Portal   | PRB714152        | 152              | If a requested item is ordered as part of an order guide from Service Portal, the Order Guide field on the Requested Item form does not show the order guide name. | In a Helsinki instance:  
1. Open the Service Portal home page.  
2. Navigate to Service Catalog > Can We Help You?  
3. Select New Hire (/sp?id=sc_cat_item_guide&sys_id=6690750f4f7b4200086eeed18110c761). This is an OOB Order Guide.  
4. Enter all mandatory fields.  
5. Click Submit. You will get a small pop-up near the header: “Created REQ0010011 - track using ‘Requests’ in the header or click here to view”.  
6. Open this REQ and associated RITM. In the RITM form, the Order Guide field is empty.  
If this same request is submitted from Service Catalog (outside Service Portal), the Order Guide is populated correctly. |
|                  | KB0598301        | NG shared component | On Service Portal, files larger than 25mb cannot be uploaded and no error message is displayed. | 1. Navigate to System Definition > Plugins.  
2. Find and open the record for Human Resources Application: Service Portal.  
4. Click Activate.  
5. When the activation process is complete, click View Plugin List.  
6. Navigate to HR - Case Management > HR Service Portal.  
7. Under Browse HR Service Catalog, click General Inquiries.  
8. Click General Inquiries.  
9. In What is your question, type some text.  
10. Add an attachment larger than 25mb. Note that no file is uploaded and no error message is displayed. |
Other Helsinki Patch 8 information

Credentials

Configure the CyberArk credential identifier: Create the unique key that CyberArk can use to identify specific credentials in the external repository

Steps 6 and 7 have been updated. Step 6 now includes a detailed breakdown on how to format the Credential ID field.

Fixes included with Helsinki Patch 8

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- *Helsinki Patch 7*
- *Helsinki Patch 6 Hot Fix 3*
- *Helsinki Patch 6*

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- *Helsinki Patch 5 Hot Fix 1*
- *Helsinki Patch 5*
- *Helsinki Patch 4 Hot Fix 4*
- *Helsinki Patch 4*
- *Helsinki Patch 3 Hot Fix 11*
- *Helsinki Patch 3*
- *Helsinki Patch 2*

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- *Helsinki Patch 1*
- *Helsinki Fixes*

Helsinki Patch 7 Hot Fix 5

Helsinki Patch 7 Hot Fix 5 provides fixes for the Helsinki release.

For Helsinki Patch 7 Hot Fix 5: Build date: 06-03-2017_1040
Build tag: glide-helsinki-03-16-2016_patch7-hotfix5-06-02-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.
Fixed problem in Helsinki Patch 7 Hot Fix 5

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asynchronous Message Bus</td>
<td>After upgrading to Helsinki, HttpClient thread count grows on the MID Server</td>
<td>MID Server can go down due to a thread leak that causes the MID Server to run out of memory and go down.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>PRB732813</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>KB0621950</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 7 Hot Fix 5

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 7 Hot Fix 4
- Helsinki Patch 7 Hot Fix 3
- Helsinki Patch 7 Hot Fix 2
- Helsinki Patch 7
- Helsinki Patch 6 Hot Fix 1
- Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- Helsinki Patch 5
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 10
- Helsinki Patch 3 Hot Fix 9

The PRBs in HP3HF9 were also fixed in *

- HP6: PRB709212
- HP7: PRB622583

- Helsinki Patch 3
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 7 Hot Fix 4

Helsinki Patch 7 Hot Fix 4 provides fixes for the Helsinki release.

For Helsinki Patch 7 Hot Fix 4:

<table>
<thead>
<tr>
<th>Build date: 04-13-2017_0938</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build tag: glide-helsinki-03-16-2016_patch7-hotfix4-04-12-2017</td>
</tr>
</tbody>
</table>

For more information about how to upgrade an instance, see Upgrade to Helsinki.
For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 7 Hot Fix 4

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction and Session Management PRB713504</td>
<td>Canceling a homepage can cause CellRenderThread threads to wait indefinitely</td>
<td>Under the right cancellation circumstances, the CellRenderThread can get stuck.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 7 Hot Fix 4

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 7 Hot Fix 3
- Helsinki Patch 7 Hot Fix 2
- Helsinki Patch 7
- Helsinki Patch 6 Hot Fix 1
- Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- Helsinki Patch 5
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 10
- Helsinki Patch 3 Hot Fix 9

The PRBs in HP3HF9 were also fixed in *

- HP6: PRB709212
- HP7: PRB622583

- Helsinki Patch 3
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes
Helsinki Patch 7 Hot Fix 3

Helsinki Patch 7 Hot Fix 3 provides fixes for the Helsinki release.

For Helsinki Patch 7 Hot Fix 3:

<table>
<thead>
<tr>
<th>Build date:</th>
<th>03-17-2017_0942</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build tag:</td>
<td>glide-helsinki-03-16-2016__patch7-hotfix3-03-15-2017</td>
</tr>
</tbody>
</table>

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).

For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).

**Note:** This version is approved for FedRAMP.

### Fixed problem in Helsinki Patch 7 Hot Fix 3

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Management Application PRB859533</td>
<td>Cloud Management v1: VM instances have empty names and states from AWS configuration events</td>
<td>Incoming messages are not processed because they contain single quotes, and the CMDB is not updated. Empty names and states are also appearing.</td>
<td>This issue can occur for users with many accounts configured with the AWS Configuration (for example, 30 accounts). Due to the heavy load of messages coming in, some events will get dropped.</td>
</tr>
</tbody>
</table>

### Fixes included with Helsinki Patch 7 Hot Fix 3

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- [Helsinki Patch 7 Hot Fix 2](#)
- [Helsinki Patch 7](#)
- [Helsinki Patch 6 Hot Fix 1](#)
- [Helsinki Patch 6](#)

**Note:** PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- [Helsinki Patch 5](#)
- [Helsinki Patch 4](#)
- [Helsinki Patch 3 Hot Fix 10](#)
- [Helsinki Patch 3 Hot Fix 9](#)

The PRBs in HP3HF9 were also fixed in *

- HP6: PRB709212
- HP7: PRB622583

- [Helsinki Patch 3](#)
- [Helsinki Patch 2](#)
Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 7 Hot Fix 2

Helsinki Patch 7 Hot Fix 2 provides fixes for the Helsinki release.

For Helsinki Patch 7 Hot Fix 2:

- Build date: 01-23-2017_0940
- Build tag: glide-helsinki-03-16-2016_patch7-hotfix2-01-17-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 7 Hot Fix 2

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Management</td>
<td>Allocation Engine is generating lines very slowly</td>
<td>For some users, the ITFM Allocation Engine and its jobs run for a long time.</td>
</tr>
<tr>
<td>PRB742326</td>
<td></td>
<td>For example, the Allocating Expenses job took 36 hours for a user. The long job duration occurred because millions of allocation lines were being generated for the user, and inserting the millions of lines took a long time.</td>
</tr>
</tbody>
</table>

To maximize the engine’s performance and database space, the fix for PRB742326 provides the ability to generate allocation lines as needed. The cost model provides the additional options below to generate controlled allocation lines.

<table>
<thead>
<tr>
<th>Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Generate controlled cost lines</td>
<td>The itfm_allocation_aggregate table will only generate lines with the amount aggregated at the account level. To include sub-bucket information in the generated lines, select Include sub-bucket info.</td>
</tr>
<tr>
<td>Breakdown Relationships</td>
<td>In Breakdown Relationships, the user must explicitly define breakdowns as needed. This will generate additional breakdown allocation lines in itfm_allocation_breakdown to report on the relationship split between two segments.</td>
</tr>
<tr>
<td>Choose segments for GL expense lines</td>
<td>Choose the segments for which general ledger (GL) expense lines are needed to report on the related GL lines for that segment. The expense lines for segments are in the itfm_allocation table.</td>
</tr>
</tbody>
</table>
Fixes included with Helsinki Patch 7 Hot Fix 2

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

• Helsinki Patch 7
• Helsinki Patch 6 Hot Fix 1
• Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

• Helsinki Patch 5
• Helsinki Patch 4
• Helsinki Patch 3 Hot Fix 10
• Helsinki Patch 3 Hot Fix 9

The PRBs in HP3HF9 were also fixed in *

• HP6: PRB709212
• HP7: PRB622583

• Helsinki Patch 3
• Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

• Helsinki Patch 1
• Helsinki Fixes

Helsinki Patch 7

The Helsinki Patch 7 release contains fixes to these problems.

Helsinki Patch 7 was released on November 17, 2016.

Build date: 11-08-2016_1607
Build tag: glide-helsinki-03-16-2016_patch7-11-02-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Security-related Fixes

Helsinki Patch 7 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 7, refer to KB0598510.
Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified Compliance Framework (UCF) PRB715856</td>
<td>Add Helsinki support for the new UCF API with REST API and OAuth</td>
<td>UCF is deprecating their former API, and UCF support for the new API needs to be added to Helsinki. The old UCF related plugins should be replaced with the new UCF plugin.</td>
<td>Note: If your GRC effective contract date is before December 1, 2016, you are entitled to a free UCF CCH account for the period of December 1, 2016 through November 30, 2018. For customers on Helsinki (Patch 7 and above), or Istanbul and whose effective GRC contract start dates start on Dec 1, 2016 or after, you need to arrange your own subscription if your organization plans on using Unified Controls Compliance as the provider of your controls library. For more information about establishing a UCF CCH account, see Unified Compliance.</td>
</tr>
</tbody>
</table>

For UCF upgrade information, refer to [Policy and Compliance UCF upgrade instructions](#). For other details, refer to the following topics:

- Configure the UCF integration
- Staging tables and transform maps for UCF download customization
- Download a UCF shared list
### Authentication PRB703022

**Description:**
After an upgrade from Java 6 to Java 8, which is required in the Helsinki release, LDAP requests produce the following error: “Certificates does not conform to algorithm constraints.” or “Connection reset”

A rollback to Java 6 is not possible. Java 8 forces TLS V1.2 and also deprecates some cipher suites, which does not work with certain LDAP servers with SSL enabled.

The SSL connection functions correctly via OPENSSL with no issues.

**Steps to reproduce:****
1. Create a new node with no modified wrapper.conf adjustments.
2. Upgrade from Geneva to Helsinki.
3. Test the LDAP connection on the node.

### Service Catalog PRB691181

**Description:**
This issue occurs in Geneva Patch 7 instances.

### Import / Export PRB674142

**Description:**
Export to Excel fails if there are more than 32,000 rows when exporting to XLS or with hundreds of rows when exporting to XLSX, and one of the columns is of type currency.

**Steps to reproduce:****
1. Navigate to a list containing more than 32000 rows.
2. Ensure that a Currency field is in the list.
3. Right click on the header and select Export > Excel (.xlsx).

The export fails.

### All Other Fixes

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asynchronous Message Bus PRB717454</td>
<td></td>
<td>After upgrading to Helsinki, &quot;HttpClient&quot; thread count is growing on MID Server after Asynchronous Message Bus subscription failures</td>
<td>After upgrading to Helsinki, many &quot;HttpClient&quot; threads are running on the MID Server. This contributes to issues such as &quot;OutOfMemoryError&quot; messages and SCCM jobs not being processed.</td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Authentication | OAuth 2.0 | User who has oauth_admin role does not have write/read access to the oauth_entity_profile table | 1. Give Abel Tuter the oauth_admin role.  
2. Log in as Abel Tuter.  
3. Navigate to oauth_entity_profile.list.  
Note that the security constraint message appears. |
| Change Management | | In a standard change catalog, having equals signs ‘=’ in template values produces an error message upon submission | If a mandatory field for the submission of a standard template contains an equals sign ‘=’, the test for the field will fail with an error message.  
This error message appears when the listed fields include an equals sign (e.g. “Change Request values” have not been provided: Short description, Description, Implementation plan’).  
The error occurs even though there are values present along with the equals sign - the field is read as though it does not contain a value. |
| Change Management | Change Management - Standard Change Catalog | | In a Geneva instance:  
1. Navigate to Standard Change  
   Template Management  
   Propose a new Standard Change Template.  
2. Fill in the fields Short Description, Description, Implementation Plan and include ‘=’.  
3. Click Request Approval.  
An error message appears: “Change Request values” have not been provided: Short description, Description, Implementation plan |
| Chat | | Legacy chat in Helsinki: Default message for Wait Time is not displayed in chat window | When an end user initiates the chat, the displayed message is: “You are currently in position 1 in the queue.  
Your approximate wait time is 7 Seconds.”  
However, this message is not displayed when using legacy chat in Helsinki.  
In Fuji, the message is displayed correctly. |
<p>| | | | Refer to the listed Known Error KB article for details. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Chat PRB71684 | Connect, Connect Support | No audio notifications when a user enters a queue | In Connect, there is very inconsistent behavior for audio and desktop notifications. When desktop and audio notifications are set, notifications show up, disappear, and show up again. Audio notifications are also inconsistent, especially when related to transfers. | 1. Activate the Connect Support plugin.  
2. Turn on all the Connect-related notifications.  
3. Open 3 internet browsers.  
   • On browser 1, log in as Abel Tuter.  
   • On browser 2, log in as David Loo.  
   • On browser 3, log in as Beth Anglin.  
4. Verify all these users have notifications related to Connect ‘set’.  
5. Start a support conversation from Abel (e.g. in the HR support queue / $chat_support.do?queueID=aeb40252d7133100816403548e610363).  
   Issues:  
   • The desktop notifications showed up for David Loo to signify a new support conversation in the queue. But, none appeared for Beth.  
   • When the conversation is transferred to Beth, there is no audio notification and no desktop notification / no audio notification.  
   • Switch the sessions for the agents. Beth Anglin and David Loo start receiving the desktop and audio notifications.  
   • Transfer the conversation to David Loo. Afterwards, audio notifications for transfers do not work. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Chat       | PRB698659        | Legacy chat - ‘invite user’ notification alert only works if the browser is refreshed | When using the ‘invite user’ feature in Geneva, the alert notification does not work for legacy chat.                                                                                                                                                                  | 1. Activate the Chat plugin.  
2. Open 3 different internet browsers.  
   - Browser 1: Impersonate Beth Anglin and navigate to chat_desktop.do.  
   - Browser 2: Impersonate David Loo and navigate to chat_desktop.do.  
   - Browser 3: Impersonate Abel Tuter and navigate to ess and click Service Desk Chat. Send a test message.  
3. As Beth Anglin, click Answer to start the chat with Abel Tuter.  
4. As Beth Anglin, click on the cog wheel and select Invite user.  
5. Invite David Loo.  
   In David Loo’s chat_desktop screen, no alert notifications are visible.  
6. Refresh the David Loo’s browser window.  
   The notification is now visible.  
Perform the same steps in a Fuji instance. Alert notifications work as expected.                                                                                                                                                                                                 |                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |
| Chat       | Connect, Connect Support | $chat_support.do breaks out of frame in Helsinki | In Geneva instances, navigating to $chat_support.do opens the page in the frame if launched from a module or the app navigator search bar. In Helsinki instances, the page briefly opens in the frame but then breaks out of the frame. | 1. Enable Connect Support.  
2. In type filter text, type $chat_support.do and press enter.  
   Expected behavior: The page opens in frame.  
   Actual behavior: The page opens in frame then breaks out.                                                                                                                                                                                                                   |                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB PRB712669</td>
<td>Configuration Management (CMDB)</td>
<td>If a record contains the new CI Relations formatter, the printer-friendly version page is misaligned</td>
<td>The printer-friendly version page for records that contain the new CI Relations formatter is incorrectly formatted because the fields are misaligned.</td>
<td>In a Helsinki instance: 1. Navigate to Configurations › Base Items › Computers, and open any record. Make sure that the record is using the new CI Relations formatter (by default it is located under the Configuration section). 2. Click the settings icon (cogwheel to the right of user name) and click Printer-friendly version. A new tab/window pops up. 3. Click Click to Print button.</td>
</tr>
<tr>
<td>Data Certification PRB627979</td>
<td>“Row select” does not select all data for Data Certification</td>
<td>Prior to Fuji, when a row is selected to certify certain fields for a certification task, it selects all the checkboxes on this row. This is no longer the case in Fuji where each checkbox in a row needs to be manually selected. However, if the certifications within the certification task form is directly reloaded (via the Refresh List UI context), this works as expected: selecting a row now checks every checkboxes within that row.</td>
<td>1. Activate the Data Certification plugin and load demo data. 2. Navigate to Data Certification › Tasks › All Tasks and open a task that is work in progress. 3. Scroll to the element Certifications required for Certification Task TSK0000000. 4. Select a row in this list. Note that it does not select any check boxes for the row.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Financial Management PRB673930</td>
<td>Financial Management PRB713540</td>
<td>Long loading time of Allocations Setup page in ITFM Finance Workbench exceeds the default maximum run time, causing an error</td>
<td>The Allocation Setup page of the Financial Management Workbench ($itfm_workbench.do) can take a long time to load for large data sets, anywhere between 10 and 15 minutes. Because the background request to /xmlhttp.do to load the Allocation Setup page takes a large amount of time, it exceeds the default value 30000 (30 seconds) for the com.glide.request.max_run_time_ms system property. Subsequent requests are then returned by GlideRequestManager with the HTTP status “202 Accepted” with no content. Processing this status causes a “Lost connection to the server” message to appear.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Financial Management KB0584391</td>
<td></td>
<td></td>
<td>In one instance, there are Business Cost Centers whose costs rolling up to the Business Service are not reflected in the total (in Workbench UI). However, the totals correctly reflect these costs in Reporting (Allocation Lines).</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Financial Management          | PRB702918        | Accounts are not rolling up | Partial amounts of un-rolled up accounts are getting rolled up to the next level during allocation engine execution.                                                                                       | 1. Navigate to the Cost Transparency Workbench.  
2. Create a Hierarchy (ITSS (ITS Shared Service) › Business Service › Business Unit).  
3. Allocate a Bucket amount to Accounts in ITSS, Business Service. Do not roll up some amount accounts from ITSS and leave the amount as is.  
4. Run the allocation engine.  
The user sees amounts which were intentionally left in ITSS accounts roll up to Business Unit for unknown reason. The amounts need to be ITSS itself. |
| HR Service Management         | PRB717179        | Workday field maps are lost on upgrade from Geneva to Helsinki | Workday sync creates the sys.user record as expected, with a user’s first and last name. However, the corresponding hr_profile is missing the first and last name. Inspecting the XML for the hr_profile record shows that the fields exist, but they are not populated. |                                                                                                                                                                                                                  |
| Knowledge Management          | PRB687331        | Images are lost after importing article through Knowledge portal | PRB667232 addressed several formatting issues in Helsinki Patch 1, but there are still some formatting issues when importing a Microsoft Word Document into Knowledge. The problematic formats are color font and center alignment. | 1. Log in to a Helsinki Patch 1 instance as admin.  
2. Navigate to Self-Service › Knowledge › Import Articles.  
3. Upload a Word file that contains colored text and center alignment.  
4. Select the knowledge base IT and click Import.  
5. View the article.  
The word document has lost its text color and middle alignment. |
| Knowledge Management          | PRB701381        | When importing MS Word doc into Knowledge, some formatting is lost (color and center alignment) | PRB667232 addressed several formatting issues in Helsinki Patch 1, but there are still some formatting issues when importing a Microsoft Word Document into Knowledge. The problematic formats are color font and center alignment. | 1. Log in to a Helsinki Patch 1 instance as admin.  
2. Navigate to Self-Service › Knowledge › Import Articles.  
3. Upload a Word file that contains colored text and center alignment.  
4. Select the knowledge base IT and click Import.  
5. View the article.  
The word document has lost its text color and middle alignment. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Knowledge Management PRB687334 |                  | Bullet number format is not retained after importing article into knowledge portal | After an article is imported into the knowledge portal, numbering restarts in the numbered list. | 1. Navigate to Knowledge.  
2. Click Import Articles.  
3. Click and drag a Word file into the dialog box.  
4. Fill in the Knowledge base and Category.  
5. Click Import. The file imports and the article is displayed.  
In the KB content, numbering restarts in the numbered list. |
| Live Feed PRB67067 KB0595732 |                  | Requests to /api/now/live_feed/conversations are slow if a user is a member of many conversations | The issue is more visible for the users who have around 100 records in live_group_profile and live_group_member tables, where it may take 20-30 seconds for live feed to load. | Refer to the listed Known Error KB article for details. |
| Persistence PRB71844 KB0598302 |                  | GroupBy on double dot-walked fields do not work correctly | On Helsinki Patch 6, this issue manifests differently (in a broader way) in Oracle than in MySQL.  
- In Oracle, any aggregate queries run on columns with aliases (when field names are longer than 30 characters) will return no data.  
- In both Oracle and MySQL, joins on aggregate queries using dot walk when the path (caller_id.department.business_unit) is longer than 32 characters returns empty strings for the name of the group fields in any database. | Refer to the listed Known Error KB article for details. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Platform         | Performance PRB671391 | Error message 'Illegal access to method close() in class com.glide.size_aware.SizeAware ServletOutputStream’ |                                                                                             | 1. Navigate to System Applications > Applications and go to the form for a scoped application.  
2. Make some change to the application (e.g. change the short description) and Save the change.  
3. Click Publish to Update Set.  
4. Click Publish on the dialog.  
5. When it is finished, click Done on the progress dialog.  
6. Click Export to XML and Save the file.  
7. Click Merge with Another Update Set on the app form.  

Expected behavior: No error message appears.  
Actual behavior: A red error message shows at the top: "Illegal access to method close() in class com.glide.size_aware.SizeAware ServletOutputStream’." |
| Procurement PRB700214 | Procurement Purchase Orders are always consolidated When a user sources a request, POs are being consolidated even when the ‘Consolidate PO’ box is unchecked. |                                                                                             | 1. Impersonate a procurement user.  
2. Order a DELL Alienware M17x from the Service Catalog.  
3. Navigate to the catalog task for the request  
4. Source the item and do not check the Consolidate PO check box.  
   Note your PO number in the request.  
5. Order a second Alienware M17x from the Service Catalog and follow the same steps.  

Notice the second order is added to the same PO even though the Consolidate PO check box was not selected. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Record Certification Core PRB712817 | Certification Core | After Helsinki upgrade, users receive roles that were previously removed from the ITIL containing role | After an upgrade to Helsinki, deleted relationships between roles resurface. | In a Geneva instance:  
1. Install the Architecture Compliance plugin.  
2. Verify ITIL role is added with another inherited role: Certification.  
3. Delete this relationship.  
4. Schedule an upgrade to Helsinki.  
After the Helsinki upgrade, this deleted role will be seen with the ITIL role. |
| Reporting PRB675508 |                  | Using ‘Export to PDF’ for a form that contains an empty Translated HTML field will provoke an Exception | Export from a Form that contains a field of type ‘Translated HTML’ with empty value on that field. |                                                                                                                                                     |
| Reporting PRB697412 |                  | View not respected in list for pie, donut, or funnel report with a view defined    | When creating a pie or donut or funnel report with a view defined for the drill down, the view is not respected in the list. | 1. Create a pie report on the incident table.  
2. Click on the settings cog wheel and set the drilldown view to self-service.  
3. Save the report.  
4. Click on one of the pie pieces.  
Expected behavior: The list opens in the self-service view.  
Actual behavior: The list opens in the default view. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Server Side Scripting PRB667239 | In Lists and Reports, values from dot-walked reference field are repeated in empty rows starting in Geneva | When reports or lists contain a significant number of reference fields, the value of a dot-walked reference field may be repeated for subsequent rows where that field is empty. | 1. Access incident_list.do and create a new view named Example.  
2. Switch to the Example view.  
3. Right-click to Configure > List Layout.  
4. Modify the list layout to include the following fields: Number, Assigned to, Assignment group, Caller, Closed by, Company, Configuration item, Domain, Location, Opened by, Parent, Parent.Assigned to.  
5. Save changes and return to the list of incidents and sort by Number (a to z).  
6. Update the Parent field for INC0000002 with any task that has a populated Assigned to field (e.g. PRB0000001).  
7. Refresh the list of Incidents.  
The Parent.Assigned to field in records below INC0000002 will display the same user. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog PRB667014 | | Check box adds an incorrect price to an item when the single currency system property is set to true and the user country code is non-US | 1. Log in to your ServiceNow instance as an admin.  
2. Navigate to System Properties and set the glide.i18n.single_currency property to true.  
3. Create an item with a price and recurring price.  
4. Add Service Catalog as a catalog and the category Can we help you? and save the changes.  
5. Add a check box variable and a price (for example, 10) in the Price if checked and Recurring price if checked fields.  
6. Save the changes.  
7. Navigate to User Administration > Users.  
8. Select a user and change the country code of the user to non-US (e.g. Japan) and save the changes.  
9. Log in to your ServiceNow instance and impersonate the user.  
   • Navigate to the Service Catalog Home page.  
   • Select the Can we help you? category and search for the item created in Steps 2 through 4.  
10. Click the item and verify the “Order this item” section without selecting the check box.  
   Note the prices shown.  
11. Select the check box and verify the “Order this item” section.  
Selecting the check box adds the incorrect price to the item. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog<br>PRB697378<br>KB0597939 | | Variables displayed under the summarizer on the shopping cart page do not follow the order defined in the catalog item | Fields are displayed in a random order and do not follow the assigned order. | 1. Enable two-step checkout.  
   - Go to Catalog Policies › Properties.  
   - Enable Use the two step catalog checkout model and click Save.  
2. Create a catalog item with a minimum of three variables.  
3. Define an order for the variables.  
4. Create a catalog order.  
   - Open the catalog item.  
   - Populate the variables with some value.  
   - Click Order Now.  
5. On the shopping cart page, click the right-facing arrow (icon-vcr-right) to open the item summarizer.  
   The variables appear in random order rather than the defined order. |
| Service Portal<br>PRB71464 | Human Resources Application: Core | When a user creates a HR Case from the HR Service Portal, the ‘is_catalog’ field is not set to ‘true’ | In the HR Service Portal, the ‘is_catalog’ field is set to ‘false’ in some cases and ‘true’ in others. | |
| Service Portal<br>PRB713048<br>KB0610283 | SCSS Bootstrap Theme | Fonts and glyph icons do not display as expected in Helsinki | Service Portal: Fonts and glyph icons in .woff2 font file resource in /sp-fonts folder cannot be found on instances upgraded to Helsinki. | To determine whether an instance is affected:  
1. Navigate to System Definition › Plugins and activate the Service Portal plugin.  
2. Open a browser window to a Service Portal (for example, /sp).  
   If the browser throws a 404 error failing to download /sp-fonts/glyphicons-halflings-regular.woff2, the instance is affected. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal   | Human Resources Application: Service Portal, SCSS Bootstrap Theme | IE10: Service Portal pages do not show full content if the height is greater than the browser window | When filling out a record producer with mandatory fields in Service Portal, labels for fields in red appear below the submit button to indicate that there are missing mandatory fields. The fields (and the box in which they appear) disappear and change in size when there are no more mandatory fields without information. When this occurs in IE10 under the right circumstances, the frame will resize and be unable to resize. | 1. Open IE10 and resize the window or increase the zoom so that the field are not all visible.  
2. Open record producer with at least one mandatory field.  
3. Resize or zoom as explained in the description.  
4. Fill out the mandatory fields.  

Expected behavior: The mandatory field labels should disappear but if the frame changes it should leave all the fields and buttons visible at least by scrolling.  
Actual behavior: Once the last mandatory fields are filled out the frame resizes and can obfuscate the submit button without being able to scroll. |
| System Applications | Studio                             | In Studio, delegated developer VCS requests are failing | This issue occurs in Studio v2.99.7. After giving a user the appropriate roles and delegating them as a developer of scoped application, any VCS requests other than GET requests are failing. | 1. As admin, create an app and link it to source control.  
2. Give user Abel Tuter the appropriate roles (source control, rest service, etc.) and make them a delegated dev of your scoped app.  
3. Log in as Abel Tuter and navigate to your app.  
4. Attempt to make a commit, apply stashed changes, etc.  

VCS requests fail. |
| Text Search      |                                    | The text indexer triggers whichever logic is associated to a variable during the indexing process | The text indexer encounters delays when processing a "Lookup Select Box" variable that is associated with the sys_user table. The variable has a defined choice list that will fetch all sys_user records. This causes a performance issue for the indexer and prevents it from completing work. | 1. Create an incident from the Service Catalog.  
2. Update the incident, which triggers a text_index update event on the incident table.  

When this event is getting processed, the indexer is loading large data rows. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| UI Policy/Client Script      | PRB658414        | Catalog UI policy displays the sys_id instead of the display value                 | After a user upgraded from Fuji to Geneva, they noticed that many Catalog Conditions were not displaying the correct value in the Catalog UI policy. Instead of displaying the display value, they show the sys_id. In addition, the magnifying glass is not available in the condition filter. | In an OOB new Fuji instance:  
1. Open the Catalog UI policies list (catalog_ui_policy_list.do).  
2. Open the record with the short description "Hide Reason Details (DB Restore)".  
3. Try to add a filter condition: cmdb_ci IS.  
   Note that the magnifying glass is available and you can pick up the value.  
4. In an OOB Geneva instance, perform the same action.  
   Note that you can only type in a value for cmdb_ci, and the magnifying glass icon is not available. |
| User Interface (UI)          | PRB711333        | Modal that appears when hovering over "i" icon on List v2 and records is not indicating user can hold "Shift" key to lock modal for scrolling | When a user hovers their mouse over the "i" icon on List v2 or a record, a modal/popover appears. However, this modal does not tell the user that they can lock the modal to scroll down the page for more information. |                                                                                                       |
| User Interface (UI)          | PRB710758        | After upgrading from Fuji to Geneva, editing a Report Definition introduced a significant delay | Editing a report that queries CMDB_CI to add PARENT+ dot walked fields is significantly slower in Geneva than it was in Fuji.                                                                                                       | 1. Set the system property glide.ui.list.allow_extended_fields to true.  
3. Set the report table to cmdb_rel_ci (CI Relationship (cmdb_rel_ci) table).  
4. Add Parent + to the Available field.  
5. Click ‘+’ between the slush buckets to expand the column to view dot-walked fields.  
   A Chrome browser error appears, requesting user to ‘kill’ or ‘wait’ for the transaction to complete. If you wait, the fields become visible for editing. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI)</td>
<td>TinyMCE HTML Field Editor</td>
<td>HTML fields do not render content when dot-walked to other records</td>
<td>When dot-walking to an HTML field on a form, the TinyMCE container and HTML text do not appear. Only the field label and the icons to expand(+) / collapse(-) the field appear.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Workflow</td>
<td>fix_use_new_screqitemrenderer.xml</td>
<td>fix_use_new_screqitemrenderer.xml</td>
<td>The fix script takes too long on upgrades. This was introduced by PRB658995. The fix script should ignore inactive contexts.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Published version of workflow included with plugins reverts to OOB version</td>
<td>The published version of workflows is reverted to the OOB version, and user data is being overwritten.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
</tbody>
</table>

Other Helsinki Patch 7 information

Governance, Risk, and Compliance (GRC): UCF

UCF is deprecating their former API, and UCF support for the new API has been added to Helsinki in Helsinki Patch 7. The old UCF related plugins have been replaced with the new UCF plugin. For UCF upgrade information, refer to Policy and Compliance UCF upgrade instructions.

Note: If your GRC effective contract date is before December 1, 2016, you are entitled to a free UCF CCH account for the period of December 1, 2016 through November 30, 2018. For customers on Helsinki (Patch 7 and above), or Istanbul and whose effective GRC contract start dates start on Dec 1, 2016 or after, you need to arrange your own subscription if your organization plans on using Unified Controls Compliance as the provider of your controls library. For more information about establishing a UCF CCH account, see Unified Compliance.

For other details, refer to the following topics:

- Configure the UCF integration
- Staging tables and transform maps for UCF download customization
- Download a UCF shared list

Fixes included with Helsinki Patch 7

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 6 Hot Fix 1
- Helsinki Patch 6
Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- **Helsinki Patch 5**
- **Helsinki Patch 4**
- **Helsinki Patch 3 Hot Fix 10**
- **Helsinki Patch 3 Hot Fix 9**

The PRBs in HP3HF9 were also fixed in *

- HP6: PRB709212
- HP7: PRB622583

- **Helsinki Patch 3**
- **Helsinki Patch 2**

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- **Helsinki Patch 1**
- **Helsinki Fixes**

**Helsinki Patch 6 Hot Fix 3**

The Helsinki Patch 6 Hot Fix 3 release contains fixes to these problems.

Helsinki Patch 6 Hot Fix 3 was released on December 2, 2016.  
Build date: 12-01-2016_1039  
Build tag: glide-helsinki-03-16-2016__patch6-hotfix3-11-30-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.
Fixed problem in Helsinki Patch 6 Hot Fix 3

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal   | PRB714152         | If a requested item is ordered as part of an order guide from Service Portal, the Order Guide field on the Requested Item form does not show the order guide name. | In a Helsinki instance:  1. Open the Service Portal home page.  
2. Navigate to Service Catalog > Can We Help You?  
3. Select New Hire (/sp?id=sc_cat_item_guide&sys_id=6690750f4f7b4200086eeed18110c761). This is an OOB Order Guide.  
4. Enter all mandatory fields.  
5. Click Submit.  
You will get a small pop-up near the header: “Created REQ0010011 - track using ‘Requests’ in the header or click here to view”.  
6. Open this REQ and associated RITM.  
In the RITM form, the Order Guide field is empty.  
If this same request is submitted from Service Catalog (outside Service Portal), the Order Guide is populated correctly. |

Fixes included with Helsinki Patch 6 Hot Fix 3

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 6 Hot Fix 1
- Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

- Helsinki Patch 5
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 7
- Helsinki Patch 3 Hot Fix 6

This release includes the HP3HF6 PRBs that were also fixed in HP6. *

- HP4: PRB692216
- HP6: PRB713556, PRB711226, PRB713397

- Helsinki Patch 3 Hot Fix 5
- Helsinki Patch 3
- Helsinki Patch 2 Hot Fix 4
- Helsinki Patch 2
Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

Helsinki Patch 1

Helsinki Fixes

Helsinki Patch 6 Hot Fix 1

The Helsinki Patch 6 Hot Fix 1 release contains fixes to these problems.

Helsinki Patch 6 Hot Fix 1 was released on October 28, 2016.
Build date: 10-25-2016_1048
Build tag: glide-helsinki-03-16-2016__patch6-hotfix1-10-25-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 6 Hot Fix 1

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Persistence | GroupBy on double dot-walked fields do not work correctly | On Helsinki Patch 6, this issue manifests differently (in a broader way) in Oracle than in MySQL.  
• In Oracle, any aggregate queries run on columns with aliases (when field names are longer than 30 characters) will return no data.  
• In both Oracle and MySQL, joins on aggregate queries using dot walk when the path (caller_id.department.business_unit) is longer than 32 characters returns empty strings for the name of the group fields in any database.  
The fix for this PRB reverts PRB635272. | Refer to the listed Known Error KB article for details. |
| PRB718448   |                   |                                                                                                                                                                                                           |                                         |
| KB0598302   |                   |                                                                                                                                                                                                           |                                         |

Fixes included with Helsinki Patch 6 Hot Fix 1

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

• Helsinki Patch 6

Note: PRB635272, which is in Helsinki Patch 6, is not included in Helsinki Patch 6 Hot Fix 1 or later releases.

• Helsinki Patch 5
Helsinki Patch 4
Helsinki Patch 3 Hot Fix 7
Helsinki Patch 3 Hot Fix 6

This release includes the HP3HF6 PRBs that were also fixed in HP6. *

• HP4: PRB692216
• HP6: PRB713556, PRB711226, PRB713397

Helsinki Patch 3 Hot Fix 5
Helsinki Patch 3
Helsinki Patch 2 Hot Fix 4
Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

Helsinki Patch 1
Helsinki Fixes

Helsinki Patch 6

The Helsinki Patch 6 release contains fixes to these problems.

Helsinki Patch 6 was released on October 20, 2016.  
Build date: 10-06-2016_1705  
Build tag: glide-
helsinki-03-16-2016__patch6-10-05-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.
For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Security-related Fixes

Helsinki Patch 6 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 6, refer to KB0598105.

Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistence</td>
<td>PRB617735</td>
<td></td>
<td>Task Table flattening or Task Table extensions can exceed the row size limit of 8126, causing Task hierarchy errors and task table functionality degradation. For instances using a MySQL database, we use MySQL’s InnoDB engine (Antelope version) for the tables our platform creates. This InnoDB engine version allows us to define a table schema where the row size can theoretically surpass the 8126 byte limit. While all field types can contribute to the row size limit, usually any table with many large string (mediumtext) columns is more likely to be at risk. Refer to the listed Known Error KB article for details.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>KB0584932</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Persistence PRB711225 **KB0597661** | Database pool sweeper job causes hanging database connection | The database connection hangs due to a concurrent execution on the same database connection by:  
- a database pool sweeper thread  
- a thread handling regular transactions  
If this occurs when cache loading, it can cause an incomplete cache to be built (for example, TableDescriptor). This can surface as various symptoms:  
- Banner text shows as the word "null" (invalid table name: sys_script)  
- System uses UI15 for all users when they expect UI16 (invalid table name "sys_user_preference")  
- Node unreachable, blank page, 401’s etc. (invalid field name “sys_scope.scope”)  
- Fields display as the field name instead of field labels (invalid table name: sys_documentation)  
- Integrations receiving HTTP 401 (invalid table name: sys_user)  
- Users unexpectedly logged out after logging in (invalid table name: sys_user)  
These issues are always preceded by a series of SEVERE errors during the GlideSweep on threads that are being “cleaned.” The errors are preceded by a warning message similar to the following:  
```
com.glide.db.pool.DBPoolSweeperJobStatus@15cd039
WARNING ***
WARNING ***
caught error
``` | Refer to the listed Known Error KB article for details. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) | PRB713556 **KB0598416** | Using AMB Client on the parent frame from the contained frame causes a memory leak in IE11 | In Geneva and forward in Internet Explorer 11, the iexplore.exe process consumes more and more memory with each page load, constituting a memory leak. The memory leak stems from the asynchronous message bus that powers many live features in UI16. When this feature is used on pages containing iframes, there is a bug in Internet Explorer 11 that causes the browser to maintain unnecessary information in memory. The fix works around the Internet Explorer 11 memory leak by handling the message bus connections differently. | 1. Open an instance using Internet Explorer 11.  
2. Open the task manager to observe Internet Explorer memory usage.  
3. Navigate to an incident form.  
4. Use the arrow keys on the top right to move between incident forms. Notice Internet Explorer memory usage continues to climb by 10 - 20 megabytes per page. If you continue to navigate between pages, Internet Explorer will crash after going through a large number of forms. |
| Import / Export | System Import Sets | Import Set Deleter job causing instances to run low or out of memory, causing performance issues on the affected node | The Import Set Deleter job cleans records in the import tables. A problem that was fixed in Fuji addressed out of memory exceptions that arise from MultipleDelete, which Import Set Deleter utilizes. However, the fixes did not completely prevent memory concerns for the Import Set Deleter job. | 1. Create a large number of import sets (for example, 10,000). Each import set needs to have a nominal load (for example, 2,000) of records to be imported.  
2. Navigate to System Import Sets > Scheduled Cleanup.  
3. Change Days from 7 to 0.  
4. Click Execute now. The deleter job runs on all import sets. Note that memory consumption increases substantially while the deleter job is running. The job is loading GlideRecords, but it only needs the names of staging tables. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Persistence   |                  |                   | After creating a field with column name longer than 30 characters, when a user tries to Group By that field, they always receive (empty) as a label of the group.                                             | 1. Create a field with the following information:  
   - Longer than 30 characters (e.g. u_service_or_configuration_item)  
   - Type String  
   - Length 100 on the Task table  
   Notice that the field is created in the database as 'u_service_or_configuration_item, varchar(100), YES, , null, '.  
2. Go to the Task table and update this field with some values (e.g. test1, test2).  
3. Go back to task.list.  
4. Right-click on the field u_service_or_configuration_item and select Group By Service or configuration item.  
   The created Groups all have the name 'empty'.                                                                                                                                                                                     |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat</td>
<td></td>
<td>In Connect chat,</td>
<td>$chat_support.do will pop up, but it continues to load for many seconds or minutes.</td>
<td></td>
</tr>
<tr>
<td>PRB706520</td>
<td></td>
<td>window shows up</td>
<td></td>
<td>1. Create a chat queue.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>right away but</td>
<td></td>
<td>2. Run a script to insert thousands of chat_queue_entry records where chat_queue_entry.queue equals the above queue’s sys id.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>takes a long</td>
<td></td>
<td>3. Load $chat_support.do?queueID=XXXX.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>time to completely load</td>
<td>Notice that the request to all?queueID=XXXX can take many seconds or minutes.</td>
<td></td>
</tr>
<tr>
<td>CMDB</td>
<td>CMDB IdentificationEngine mutex causing performance drag</td>
<td>Under load, the IdentificationEngine single mutex is causing heavy congestion, resulting in canceled discoveries.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRB668185</td>
<td></td>
<td>The fix for this PRB includes support for distributed locking to help with scaling. This is guarded by the property glide.identification_engine.distributed_locking, which is off by default. If you encounter this PRB, add this system property and set it to true.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1. Run many discoveries at once such that the instance is saturated and the ECC queue input latency starts to rise.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. In a node, examine stack traces on a worker thread. If the run time is over 30 seconds, pick a different one.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Refresh the stack trace several times. Note the performance issues shown in the logs. Instead of a very high proportion waiting for the IdentificationEngine mutex, there should be a dispersal of various different code locations.</td>
</tr>
<tr>
<td>CMDB</td>
<td>Configuration Management (CMDB)</td>
<td>CI relations do not show in the user form</td>
<td>In Fuji instances, the User CI relations do show in the user form. However, adding a new relation does not work. There are some issues with the new user CI relations for the new relation formatter.</td>
<td></td>
</tr>
<tr>
<td>PRB709232</td>
<td></td>
<td></td>
<td></td>
<td>1. Log in to a Helsinki instance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Add CI Relations to any form (e.g. incident).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>CI Relations do not load on the form.</td>
</tr>
<tr>
<td>CMDB</td>
<td>Configuration Management (CMDB)</td>
<td>Relationship formatter has trouble loading when the max level is changed in Settings</td>
<td>The relationship formatter keeps spinning and does not load.</td>
<td></td>
</tr>
<tr>
<td>PRB713895</td>
<td></td>
<td></td>
<td></td>
<td>1. Navigate to the relationship formatter and click Settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Click Filter Relations By Relationship Type and choose a different one.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Dependency Views (BSM Map)</td>
<td>Next-Gen BSM</td>
<td>In Helsinki BSM maps, groups cannot be collapsed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRB697783</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Dependency Views (BSM Map) | Next-Gen BSM | Creating a global default view for BSM Maps does not work | | 1. Navigate to BSM Map View.  
2. Create some filters and save the BSM Map View.  
3. Now, try to make this view the default for all users using these instructions.  
Note this does not work with the Next Generation BSM.  
The results for the different BSM types are:  
• Pre-Eureka: The Global User preference works here.  
• Eureka and later: The Global User preference does not work.  
• Fuji and later (Next Generation BSM): The Global User preference does not work. |
<p>| PRB700427 | | | | |
| Dependency Views (BSM Map) | Next-Gen BSM | In the BSM map view, the full node names should be displayed | In the Geneva and Helsinki BSM maps, the full CI name is not displayed. In the legacy BSM view, the CI name was fully displayed. | |
| PRB700597 | | | | |
| Dependency Views (BSM Map) | Next-Gen BSM | In Geneva/Helsinki, BSM map does not create multiple layers of the groups that can be expanded/collapsed | In Geneva and Helsinki, the BSM map does not create multiple layers of groups that can be expanded/collapsed at any time. This capability makes the map much more usable. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Domain Support PRB671435 |  | Geneva domain reference picker does not sort domain names alphabetically | After upgrading from Fuji to Geneva, the domain reference picker no longer sorts domain names alphabetically. | 1. Log in to a demo Geneva instance as administrator.  
2. Navigate to System Definition > Plugins.  
3. Activate the Domain Support - Domain Extensions Installer plugin and wait for completion.  
4. Once the homepage is refreshed, click the gear icon in the upper right of the screen.  
Expand the domain picker and observe that the domain names are not sorted. |
| Edge Encryption PRB693348 |  | Default keys are reset to NULL after an instance upgrade | | 1. Activate the Edge Encryption plugin.  
2. Set default 128 and 256-bit keys on the instance.  
3. Create a proxy and register it with the instance.  
The keys should be available and the proxy is online.  
4. Shut down the proxy.  
5. Upgrade the instance.  
6. In the instance, navigate to Encryption Key Configuration > Set Default Keys.  
Expected result: Default keys should be retained after an upgrade.  
Actual result: The default keys have been cleared out by the upgrade process. |
<p>| Email PRB673936 |  | Inbound email attachments are not working as expected | Inbound email attachment file names are not being decoded before they are evaluated against the white list in glide.attachment.extensions. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Management PRB688973</td>
<td></td>
<td>In SNEventSender, NullPointerExceptions occur when AdditionalInfo field is empty</td>
<td>This issue applies to integrations which send events to the Event Management ‘Event’ table. For these integrations, if the Additional Info field is empty, NullPointerExceptions fill the log.</td>
<td>1. Create an Event Management ‘Event’ using a custom connector or the Web Service API. 2. Leave the Additional Info field empty. Note the NullPointerExceptions in the log.</td>
</tr>
<tr>
<td>Event Management PRB711443 KB0597594</td>
<td></td>
<td>Alert rule causes incidents to be created for closed alerts</td>
<td>Alert rules cause incidents to be automatically created and associated to a closed alert.</td>
<td>1. Navigate to Event Management &gt; Alert Rules. 2. Create a new alert rule. a. Configure the required filter. b. Mark Auto Open as true and choose the task type. c. Save the alert rule. The alert rule runs on the insert of a new alert and on any update of an existing alert. The alert rule runs on closed alerts as well, so a new incident may be created and associated to a closed alert.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Filters PRB667321 | | Survey is not firing when the condition is ‘is one of’ and the choice list values are mixed case | | 1. Add a field (of type Choice) to the sys_user_group table with four options:  
  • Name: Support Type  
  • Choices: First Choice, Second Choice, Third Choice, Fourth Choice  
  2. Create a trigger condition for incident table. Add two conditions:  
  • State is Resolved  
  • AND  
  • Assignment Group.Support Type ‘IS ONE OF’ First Choice, Second Choice, Third Choice.  
  3. Update the CAB Approval group to have the Support Type as ‘First Choice’.  
  4. Create an incident with the assignment group set to CAB Approval.  
  5. Set the status to Resolved.  

Expected behavior: An assessment instance is created.  
Actual behavior: There is no assessment instance. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| HR Service Management PRB706117 KB0598025 | Human Resources Application: Core | When upgrading, HR demo data defaults are reactivated and overwrite customizations | If HR demo data is customized or categories deactivated in base system content, the content might revert to the base system defaults after upgrading. | 1. Modify the base system content in one of the following categories, or deactivate the data:  
   - HR Categories  
   - Workday scheduled job  
   - Surveys  
   - HR Case and Task templates  
   - Document templates  
   - HR skills  
   - Connect action  
   - Chat queue  
   - HR Portal preferences  
   - HR groups  

2. Upgrade the instance.  
   Note that the records have reverted back to the base system default data values. |

| HR Service Management PRB706465 | Human Resources Application: Core | ‘Auto Populate Fields’ client script not populating the Location and Department when entering ‘Opened for’ form field | In the HR Case table, a user can be entered into the ‘Opened for’ field. Per the ‘Auto Populate Field’ client script, the location and department fields should auto-populate according to the selected user’s records, but they do not. | Prerequisites  
   - Install the ‘Human Resources Application: Core’ plugin.  
   - In Users, search for a user who has a record for location and department. For example, Abel Tuter (Location - SHS quadra 5, Bloco E., Brasilia; Department - Product Management).  

Steps to reproduce  
1. Navigate to HR > Case Management > Create a New Record.  

2. Enter a user’s name in the Opened For form field (e.g. Abel Tuter).  
   The Location and Department fields should auto-populate from the user’s record, but they do not. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| HR Service Management   | Human Resources  | Some Helsinki     | Some unnecessary SM Core roles were deleted incorrectly during role cleanup. During Helsinki, roles were removed in PRB647312. However, the hr_agent role was incorrectly deleted. Roles that were removed in PRB647312 should not be completely deleted - the role XML file should simply be removed. | In a Helsinki Patch 2 instance:  
1. Go to the hr_category list and open the record named Employee Relations.  
2. Change the field Active = true and remove the template from the Template field.  
3. Upgrade the instance to Helsinki Patch 3.  
4. In the Helsinki Patch 3 instance, open the Employee Relations category record. Note you will see Active = false, and the template has been added back. |
| PRB71153                | Application: Core|               |                                                                                                                                                                                                 |                                                                                                                                                                                                                 |
| PRB71171                | Human Resources  | HR category       | After patching from Helsinki Patch 2 to Helsinki Patch 3, customized HR Category records (hr_category) are updated back to an out of box state.                                                                 | In a Helsinki Patch 2 instance:  
1. Go to the hr_category list and open the record named Employee Relations.  
2. Change the field Active = true and remove the template from the Template field.  
3. Upgrade the instance to Helsinki Patch 3.  
4. In the Helsinki Patch 3 instance, open the Employee Relations category record. Note you will see Active = false, and the template has been added back. |
<p>| PRB71171                | Application: Performance Analytics, Human Resources Application: Workday Integration, Human Resources Application: Core, Human Resources Application: HR Connect | After patching from Helsinki Patch 2 to Helsinki Patch 3, customized HR Category records (hr_category) are updated back to an out of box state. |                                                                                                                                                                                                 |                                                                                                                                                                                                                 |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Language and Translations PRB710293 |  | Some portions of Service Portal are untranslated when using Portuguese |  | Prerequisites  
1. Activate Service Portal.  
Steps to reproduce  
1. Navigate to Service Portal › Service Portal Home.  
2. From Settings, change the Language to French.  
Notice that when you reload the Service Portal homepage, the section names are correctly shown in French.  
3. From Settings, change the Language to Portuguese.  
Notice that the same names in Service Portal are shown in English.  
Expected behavior: All sections should be shown in Portuguese when this language is selected in Service Portal.  
Actual behavior: Some sections are shown in English. |
| Language and Translations PRB710509 |  | Some Czech and Finish text is not correctly translated |  | 1. Install the plugin: com.snc.i18n.czech.  
2. Change the language to Czech.  
3. Navigate to Self Service › Knowledge › HR.  
Expected behavior: Czech translations in knowledge fields are correct.  
Actual behavior: Some OOB Czech translations in Knowledge fields are not entirely correct. |
<p>| Lists PRB679551 KB0597770 | List v3 Components | ‘Time Ago’ option is not displayed correctly in List v3 | When the date format is changed, the ‘Time Ago’ date/time option does not display correctly in List v3. | Refer to the listed Known Error KB article for details. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server PRB665442</td>
<td>Rekeying MID server is unsuccessful after Geneva upgrade: Unexpected IOException loading keystore</td>
<td>During an upgrade to Geneva, which is the release that introduced MID Server validation, if you delete the keystore and then restart the MID Server, it will not be able to properly decrypt the mid.instance.password in config.xml because the keys to decrypt it are then gone. Refer to the listed Known Error KB article for details.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>MID Server PRB711179</td>
<td>SFTP Data Sources with com.glide.sftp.use_snc set to true can hang</td>
<td>If the com.glide.ftp.use_snc property is set to true (for example, after upgrading an SFTP server), scheduled SFTP exports might hang.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
</tbody>
</table>
| NotifyNow PRB712876 | Notify - Twilio Driver | Notify forces the maximum number of conference call participants to be 40, but this should be configurable | The Notify plugin currently sets the Twilio conference maxParticipants limit to 40. This information is used by Twilio to restrict the maximum number of participants in a conference call, regardless of the order they join. Users should have the option to configure the number of conference call participants. | 1. Install the Notify plugin.  
2. Set up the Twilio configuration with Account SID and Token.  
3. Configure one of the numbers with Notify On Task Group (OOB notify group).  
4. Set property glide.notify.task.phone_number to the phone number configured in Step 3.  
5. Go to any incident and click Start Conference Call.  
6. Select more than 40 participants.  
Notify limits the conference call participants to 40. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Performance Analytics PRB701865 | Overall percentages display twice in Breakdown widgets with Visualization ‘Column’ and percentage indicator settings | In Helsinki instances, a Breakdown widget with Visualization ‘Column’ and percentage indicator settings shows the overall percentage twice instead of showing the Percentage for the breakdown element and then the overall percentage. | In a Helsinki instance:  
1. Create a new widget.  
   - Type: Breakdown  
   - Visualization: Column  
   - Indicator: % of incidents resolved by first assigned group  
   - Breakdown: Priority  
   DISPLAY SETTINGS  
   - Show data labels: true  
   BREAKDOWN SETTINGS  
   - Percentages: Percentage of elements  
2. Create meaningful incidents records that were resolved today and within the same Assignment Group. In addition, create meaningful incidents resolved today but on a different Assignment Group.  
3. Collect the related PA Jobs so there are scores to show on the widgets.  
4. Add the widget to a dashboard.  
   The widget is displayed with each column showing the overall percentage twice. |  

| Performance Analytics PRB712738 | Performance Analytics DataCollector should not use glide.memory.watcher.log_threads_threshold to kill the job | Run data collection with very little memory. Expected result: This property should not be used to decide the memory.  
Actual result: When memory exceeds glide.memory.watcher.log_threads_threshold, it is killed. |  

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistence</td>
<td>PRB662286</td>
<td>Syntax error or access rule violation detected by database (ORA-00904: &quot;sys_id&quot;: invalid identifier) with sys_rollback_incremental</td>
<td>The following errors appear in the logs:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016-02-12 12:03:11 (809) glide SYSTEM TableAccessPolicy not found for 'sys_rollback_incremental', using default public policy</td>
<td>2016-02-12 12:03:11 (822) glide SYSTEM DBTable.create() for: sys_rollback_incremental</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016-02-12 12:03:12 (297) glide SYSTEM WARNING *** WARNING *** Unable to resolve ElementDescriptor from elementName, continuing anyway: sys_id</td>
<td>2016-02-12 12:03:12 (297) glide SYSTEM Creating index(es): CREATE INDEX &quot;XPVZOFO_SI&quot; ON &quot;SYS_ROLLBACK_INCREMENTAL&quot; (&quot;number&quot;, &quot;sys_id&quot;) COMPUTE STATISTICS</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2016-02-12 12:03:12 (300) glide SYSTEM SEVERE *** ERROR *** Error creating index</td>
<td>com.glide.db.GlideSQLException: FAILED TRYING TO EXECUTE ON CONNECTION 0: CREATE INDEX &quot;XPVZOFO_SI&quot; ON &quot;SYS_ROLLBACK_INCREMENTAL&quot; (&quot;number&quot;, &quot;sys_id&quot;) COMPUTE STATISTICS Syntax Error or Access Rule Violation detected by database (ORA-00904: &quot;sys_id&quot;: invalid identifier) at com.glide.db.DBIError.wrapAndThrow at com.glide.db.DBIError.handleException at com.glide.db.DBI.executeStatement at</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Persistence | PRB705323        | Fields are ‘broken’ in a TPH table after moving multiple elements (which share the same storage alias) into offrow storage | Make sure the plugin "Database Column Offrow Migration" is activated. This includes the UI elements necessary to move columns offrow.                                                                               | 1. Create a new table extending task.  
2. Add 6 mediumtext fields (xxlarge string fields) to task.  
3. Add 6 mediumtext fields (xxlarge string fields) to the new task extension.  
4. Create a row in the new task extension, populating >768 characters into each of the 12 mediumtext fields that you created.  
5. Save/Submit the record.  
6. Attempt to use the Task Table, or flatten the task table if it was not yet flattened.  
   Users see an error displayed on the page.  
7. Right-click a column you created (e.g. col1) and navigate to Configure Dictionary > Move Column Offrow. Only users with elevated privileges will be able to see this option.  
8. Click Start.  
9. Go to another table’s form with an element that shares the same storage alias as col1. Move that column offrow.  
   Note that either col1 or col2 are missing from their corresponding table forms. Users are unable to save data even if that field does render. |
| Persistence | PRB709375        | Oracle DB: Exception (ORA-00932: inconsistent datatypes: expected - got CLOB) upon sync of service with model | Upon each sync of the business service with the business model, users get ORA-00932 errors.                                                                                                                   | 1. Create or open a business service.  
2. Trigger sync with business model.  
   An error occurs: ORA-00932: inconsistent datatypes: expected - got CLOB |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform Performance PRB671499</td>
<td>Angular AMB Services, NG shared components</td>
<td>Session timeout broken by active AMB requests</td>
<td>AMB sends are treated as user traffic and keep a session alive. As you can see in the Steps to Reproduce, we issue these AMB requests periodically as part of record presence, thus breaking session timeout while on a form.</td>
<td>1. Open up any user record form. &lt;br&gt;2. Leave the browser open. The session never times out.</td>
</tr>
<tr>
<td>Platform Security PRB700518</td>
<td>Contextual Security: Role Management Enhancements</td>
<td>Groups do not propagate roles on some instance nodes</td>
<td>Adding a person to a group does not give the person roles from the group.</td>
<td></td>
</tr>
<tr>
<td>Project Management PRB706638</td>
<td>Project Management</td>
<td>Project Task related list is not appearing</td>
<td>If Phase Type column is not there in the Project Task form, it hides the Project Task related list.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Project Management | Project Management | When importing a MS project file, we are not able to import into an existing project. When we click the magnifying glass to choose an existing project the list is blank. This occurred after upgrading to Helsinki. We are currently in UAT for Helsinki. | When importing a MS project file, users are unable to import an existing project. Upon clicking the magnifying glass to choose an existing project, the list is blank. | 1. Navigate to Project > Administration > Import Project.  
2. Click the magnifying glass on the ‘(Optional) Choose an existing project to import into’ field. Notice the search comes back empty.  
3. Click New at the top of the form.  
4. Create a test Project.  
5. Repeat steps 1 and 2.  
Notice the search still comes back empty. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Management</td>
<td>PRB711623</td>
<td>The top_task field is being set to the sub_tree_root value and this corrupts the project hierarchy.</td>
<td>The top_task field is incorrectly set to the sub_tree_root value, which corrupts the project hierarchy. PRB676527 was opened because the sub_tree_root was incorrectly set to the top_task value. However, in some Helsinki instances, not only is the sub_tree_root set incorrectly to the top_task value, but the top_task value is also being incorrectly set to what should be the sub_tree_root value.</td>
<td>In a Fuji instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1. Activate the Project Portfolio Suite plugin and load demo data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Navigate to the HR Service Management Portal project (PRJ0010009).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. On the Project Tasks related list, configure the list to show the Top Project and Project (sub_tree_root).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Next, go down to the Sub Projects related list and click Edit to add three Sub Projects into the PRJ0010009 hierarchy.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Use the slushbucket to add the Compensation Tool, Consultant Off-boarding, and Consultant On-boarding projects to the HR Service Management Portal project.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. From the Sub Projects related list, select the PRJ0090845 - Compensation Tool.</td>
</tr>
</tbody>
</table>

**Expected result:**

- In the Project Tasks related list, the correct Top project is shown (top_task is PRJ0010009 - HR Service Management Portal project).
- In the Project Tasks related list, the correct Project is shown (sub_tree_root is PRJ0090845 - Compensation Tool).

In a Helsinki instance

1. Repeat the steps above.
2. Notice the incorrect behavior below.

**Actual result:**

- Error messages are thrown.
- The rollup field is incorrectly set on two of the subprojects.
- In the Project Tasks related list, the Top project (top_task) is set to PRJ0090845 (invalid, this is the sub_tree_root value).
- In the Project Tasks related list, the...
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Reporting PRB689636 | Printer-friendly version not working with reports | • For pie charts, the printer-friendly option (in the cog wheel/settings) results in a blank page with a ‘Click to Print’ button. The Chrome console shows an error: SetupSeries not defined.  
• Bar charts experience this same issue. For bar charts, the Chrome console shows this error: Failed To Load Resource 400: Bad Request. | In a Helsinki instance:  
Pie charts  
1. Navigate to Report > All Contracts by Type report (a pie chart type report).  
2. Click the cog wheel (settings).  
3. Click Printer Friendly Version.  
Note there is a blank page with a ‘Click To Print’ button. If you enable Chrome Console (COMMAND+OPTION+J), you will see an error:  
Uncaught ReferenceError: setupSeries is not defined  
Bar charts  
1. Change the pie chart to a bar chart.  
2. Run the report.  
3. Click the cog wheel (settings).  
4. Click Printer Friendly Version.  
Note the page is blank without a ‘Click To Print’ button. The Chrome console shows this error: Failed To Load Resource: 400 (Bad Request). |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Reporting PRB711073 |                  | For map type reports where the set map is set to Michigan, display results are not included in the map | When the map is set to Michigan, results appear outside the map instead of within it. | In a Helsinki instance:  
   1. Navigate to the cmn_location table.  
   2. Create a new Michigan location and fill in these values:  
      • Name: 〈MI location〉  
      • Street: 〈MI address〉  
      • City: 〈MI city〉  
      • State: MI  
      • ZIP/Postal code: 〈MI zip code〉  
      • Country: United States  
      • Latitude: 〈MI coordinate〉  
      • Longitude: 〈MI coordinate〉  
   3. Open the task table  
   4. Open any record and add the location to the form by personalizing the form layout.  
   5. Assign Ann Arbor to any task.  
   6. Open the report module to create a new report with these conditions:  
      • Table: Task  
      • Type: Map  
      • Map data: Task by location  
      • Aggregation: Count  
      • Set map: Michigan  
   7. Run the report. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog PRB712547</td>
<td>Service Catalog</td>
<td>When system date format is not default, ITIL users are unable to update a form that has a Date variable with the write role</td>
<td>When a Date variable has the write role configured and the system date format is customized, ITIL users are unable to save/update the form. The browser will display the following message: “The following fields contain invalid text: ‘&lt;Variable_question&gt;’”</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Mapping</td>
<td></td>
<td>Service Mapping is making multiple redundant calls to CyberArk in case there are unresolved external credentials.</td>
<td>In case there are unresolved windows credentials defined as external (CyberArk), Service Mapping makes multiple redundant calls during sessions with a Windows server. This attempts to resolve those credentials. These redundant calls should be removed because they result in significant delays and load on CyberArk.</td>
<td></td>
</tr>
<tr>
<td>PRB711462</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Service Portal   |                  | Catalog UI policy action does not run on-load in Service Portal for conditions on the checkbox variable type | Catalog items with a CheckBox variable type that used to show another field via a catalog UI policy are not working the same on Service Portal. For example, a catalog item has the following:  
  • Field A (CheckBox)  
  • Field B (Single Line Text)  

On load, Field B is hidden. It only appears after Field A is set to true (selected). This works correctly within the Service Catalog. On the Service Portal, the action within the Catalog UI policy only runs when selecting and clearing Field A. | Refer to the listed Known Error KB article for details. |
<p>| PRB712274        |                  |                                                                                    |                                                                                                                                                                                                          |                                                                                      |
| KB0597772        |                  |                                                                                    |                                                                                                                                                                                                          |                                                                                      |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>PRB712489</td>
<td>g._form.setValue to empty is broken for reference fields in Service Portal</td>
<td>The _form.setValue(&quot;&quot;) is broken and throws a JavaScript error in the console for Service Portal.</td>
<td>1. Create an onChange client script on incident.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Set the assigned to field to empty when the assignment group is changed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• UI Type should be both.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Example: g._form.setValue(&quot;assigned_to&quot;, &quot;);</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Using instance-name.service-now.com/sp?id=form&amp;table=incident&amp;sys_id={value}, open an incident record which has the assignment group populated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Empty the assignment group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>You should see the error message in the console:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>js_includes_sp.jsx?v=Wed_Sep_14_11_29_44_PDT_2016&amp;lp=Wed_Sep_14_11_42_35_PDT_2016&amp;c=3_51:68822 Uncaught TypeError: Cannot set property 'length' of undefined</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB713432</td>
<td>Content Item which should open in a new tab no longer opens at all</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| System Applications PRB709288 | | User sees error while deleting a scoped column on a global table | | 1. Create a new application.  
2. Make sure you are on this application.  
3. Navigate to an existing table (e.g. incident).  
4. Create a new column on this table. This column should automatically have a column name of “x something”.  
5. Now click Delete to delete the column you just created.  

Users see the following error:  
Invalid ‘Table’ selected on the Field Label record. The ‘Incident’ table is in application ‘Global’, but the current application is ‘<name of your application>’. The ‘Table’ field can only select ‘Global’ tables with read and alter access enabled. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Tables and Dictionary PRB690378 | System Applications Core | Cannot delete a scoped column added to an existing non-scoped table | If a scoped column is added/created to an existing non-scoped table, this column can only be deleted by users with elevated privileges. | 1. Create a new application.  
2. Make sure you are on this application (you should be automatically switched to it after it is created).  
3. Navigate to an existing table (e.g. incident).  
4. Create a new column on this table. This column should automatically have column name of ‘x_something’.  
5. Impersonate an admin user (whether or not this user has elevated security privileges does not matter here) and make sure you are still in the custom application.  
6. Try to delete the dictionary record for this column on form view.  
   Note there is no delete button.  
7. Try to delete the dictionary record for this column on list view.  
   Note the delete list action is grayed out.  
8. Try to delete the dictionary record from the incident table column’s embedded list.  
   Note there is no red “X” icon.  
   There is no way to delete this column. |
| User Interface (UI) PRB713397 | Safari 10.0.1 redirects users to UI11 | When a user logs into their Fuji, Geneva and Helsinki instances from Safari version 10.0.1, they are redirected to UI11 instead of UI16. | 1. Set user agent string to: ‘Mozilla/5.0 (Macintosh; Intel Mac OS X 10_12_1) AppleWebKit/602.2.7 (KHTML, like Gecko) Version/10.0.1 Safari/602.2.7”’.  
2. Log in to the instance.  
   UI11 appears. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Vendor Ticketing PRB681734 | Vendor Ticketing | During Helsinki upgrades and activation of the Vendor Ticket plugin, the plugin overwrites the incident form layout’s section 0 (including customizations) | During a Helsinki upgrade, the incident form layout is updated. The Vendor Ticket plugin updates the form layout and resets it with the OOB configuration. Upgrading to Helsinki or activating the Vendor Ticket plugin will prevent users from seeing mandatory fields on the incident form. | On an OOB Helsinki instance:  
1. Modify the incident form layout’s (section 0).  
2. Activate the Vendor Ticket plugin.  
3. Check the incident form.  
   Expected behavior: The incident form’s layout should not be affected.  
   Actual behavior: The incident form’s layout changes to the OOB form layout. |
| Visual Task Boards PRB713197 | Visual Task Boards | When a record is updated and an AMB message is received on the client, Angular is not notified of the change | After a record is updated in Helsinki, an AMB message is received on the client. Although the changes are processed (i.e. update assigned to on card/record), Angular is not notified about the change because the necessary events are never triggered. |                                                                                                                                                  |
| Web Services PRB670591 |                  | Scripted Web service using XMLDocument2 does not return a proper response when the Web service is in an application scope | Scoped applications for a scripted Web service return extra tags in the response. This prevents the user from being able to customize the SOAP response. | The response adds extra tags in the SOAP response element that prevents the integration from working properly:  
<soapResponseElement><mycontent>contents</mycontent></soapResponseElement>  
Users expect the response to come back as follows:  
</SOAP-ENV:Envelope> |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Web Services | PRB680873        | While reading request input stream and an exception is thrown, REST API does not log the exception’s cause | In the REST API, if an exception is caught while reading from the request input stream, it is caught and turned into a ServiceException. It then gets logged as a ServiceException, but the original exception (the cause) is not logged. This makes it impossible to know what went wrong while reading the request stream. | 1. Use a proxy testing tool to make a request where the server will hang trying to read from the request stream.  
2. Kill the transaction from the client side. This should trigger an exception on the server. Note the exception is logged as a ServiceException and not the original cause. |

Other Helsinki Patch 6 information

ServiceNow Platform: Available system properties

Two properties were introduced in Helsinki Patch 6: glide.import.error_message.generic and glide.export.escape_formulas.

Fixes included with Helsinki Patch 6

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 5
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 7
- Helsinki Patch 3 Hot Fix 6

This release includes the HP3HF6 PRBs that were also fixed in HP6. *

- HP4: PRB692216
- HP6: PRB713556, PRB711226, PRB713397

- Helsinki Patch 3 Hot Fix 5
- Helsinki Patch 3
- Helsinki Patch 2 Hot Fix 5

The PRBs in HP2HF5 were also fixed in *

- HP4: PRB692216
- HP5: PRB702120
- HP6: PRB713397

- Helsinki Patch 2 Hot Fix 4
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
• **Helsinki Fixes**

**Helsinki Patch 5 Hot Fix 3**

The Helsinki Patch 5 Hot Fix 3 release contains fixes to these problems.

For the Helsinki Patch 5 Hot Fix 3 release:

- **Build date:** 02-04-2017_1927
- **Build tag:** glide-helsinki-03-16-2016_patch5-hotfix3-02-03-2017

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).

For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).

Note: This version is approved for FedRAMP.

### Fixed problem in Helsinki Patch 5 Hot Fix 3

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Statistics and Graphs PRB698328</td>
<td>Blank lists might display when trying to view a table</td>
<td>Many operations, like loading the list view for a table, are timed for building performance metrics. An issue with this timing causes the transaction it is timing to error out. One possible symptom is seeing a blank list when trying to visit a table despite not failing any ACLs. The issue resolves itself in a few hours or days.</td>
</tr>
</tbody>
</table>

### Fixes included with Helsinki Patch 5 Hot Fix 3

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 5 Hot Fix 1**
- **Helsinki Patch 5**
- **Helsinki Patch 4 Hot Fix 1**
- **Helsinki Patch 4**
- **Helsinki Patch 3**
- **Helsinki Patch 2**

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- **Helsinki Patch 1 Hot Fix 2**
- **Helsinki Patch 1**
- **Helsinki Fixes**
Helsinki Patch 5 Hot Fix 1

The Helsinki Patch 5 Hot Fix 1 release contains fixes to these problems.

For the Helsinki Patch 5 Hot Fix 1 release:

- Build date: 10-30-2016_1652
- Build tag: glide-helsinki-03-16-2016_patch5-hotfix1-10-28-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>PRB689641</td>
<td>Large number of REST sessions in Helsinki</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Some users are seeing the creation of a large number of REST sessions and</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>unnecessary prompts for local logins. This issue is related to Chat, VTB,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Presence, and other message-based features.</td>
<td></td>
</tr>
<tr>
<td>Authentication</td>
<td>PRB709544</td>
<td>On the HI Service Portal unauthenticated page, a login popup appears</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>This popup appears very quickly in in Safari, and it appears after some</td>
<td>1. Log out of your instance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>time in other browsers. The following console error appears:</td>
<td>2. In Safari, go to your instance’s URL.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Failed to load resource: the server responded with a status of 401 (</td>
<td>3. Without logging in, leave the page as-is for 5-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unauthorized)</td>
<td>minutes. Note this message in the console:</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 5 Hot Fix 1

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 5
- Helsinki Patch 4 Hot Fix 1
- Helsinki Patch 4
- Helsinki Patch 3
- Helsinki Patch 2
Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1 Hot Fix 2
- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 5

The Helsinki Patch 5 release contains fixes to these problems.

For the Helsinki Patch 5 release:

- Build date: 09-15-2016_0944
- Build tag: glide-helsinki-03-16-2016__patch5-09-08-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Security-related Fixes

Helsinki Patch 5 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 5, refer to KB0597668.

Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade Engine Issues PRB680155</td>
<td></td>
<td>In Helsinki instances, the Upgrade Monitor can be stuck in the ‘finalizing’ state</td>
<td>The Upgrade Monitor hangs because the ‘text index events process’ job prevents the job from summarizing and finishing the upgrade history to be scheduled. This issue occurs in Helsinki instances. For example, this issue can be reproduced in freshly zBooted instances that are immediately upgraded. The upgrade takes place before the upgrade history of the previous zBoot is marked as finished. After the upgrade finishes, only the upgrade history record for the zBoot is marked as finished, but the upgrade history record for the upgrade is never marked as finished. This causes the Upgrade Monitor to be stuck in the ‘Finalizing’ state.</td>
<td>As an admin user, log in to a Helsinki instance that recently upgraded. Expected result: The upgrade is complete and should go to the admin home page. Actual result: The finalizing screen is shown as if the upgrade was still running.</td>
</tr>
<tr>
<td>Service Portal PRB682246</td>
<td></td>
<td>Service Portal ignores multiple column variable layouts in catalog</td>
<td>Catalog uses containers to allow users to control the layout of the variables of their catalog items, letting them create variables that appear in multiple columns. Service Portal appears to ignore these containers, causing everything to display in a single column. The fix for this PRB causes the two-column layout of containers to render first. Afterwards, the two-column layout of nested variable sets is rendered. Note that compared to the platform view of a catalog item, Service Portal does not render nested containers. Only variables and variable sets can be displayed inside a container.</td>
<td>1. On a catalog item or record producer, add a container_start variable with layout = 2 columns, alternating sides. 2. Add a few variables in order after the above container. 3. Add a container end variable at the end. 4. Open the catalog item or the record producer in the new Helsinki Service Portal. You will notice that the fields appear in single column and not in 2 columns, as defined in the container.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Software Asset Management PRB704167</td>
<td></td>
<td>SAM Counter performance issues in cleanupInstalls()</td>
<td>Log files show a large amount of time spent in cleanupInstalls.</td>
<td>After the scheduled job for SAM Counter is executed, users can observe performance degradation of the SAM Counter execution. The log files show that a large amount of time is spent in cleanupInstalls: com.glide.script.GlideRecord.updateMultiple(GlideRecord.java:5158) com.snc.software_asset_management.SAMCounter.cleanupInstalls(SAMCounter.java:345) com.snc.software_asset_management.SAMCounter.doCounter(SAMCounter.java:121)</td>
</tr>
<tr>
<td>System Applications PRB664108</td>
<td></td>
<td>Scoped apps can have a dependency of 'Global', which causes errors that abort app installation</td>
<td>If the app dependencies list contains “Global” when the application is Published, then the subsequent install of the app will encounter an error such as the following: “Aborting upgrade of application: &lt;Application Name&gt;, application depends on plugins which are not available on this instance: global”</td>
<td></td>
</tr>
<tr>
<td>Tables and Dictionary PRB628659</td>
<td></td>
<td>Form Designer creates child sys_choice records even if they are not changed</td>
<td>In a Fuji instance: 1. Open an incident form and right-click Configure Form Designer. 2. Move a random field on the form (e.g. move comments above worknotes). 3. Click Save. 4. Close the window. 5. Navigate to sys_update_xml.list. Note that 6 records created in sys_update_xml for fields that were not changed in the form designer (e.g. sys_choice for urgency,priority and contact_type and impact). Following these same steps on an earlier release only results in one record in sys_update_xml for form layout.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------</td>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Performance Analytics         | Responsive canvas| Canvas-based dashboards show up blank                  | After upgrading, creating a Canvas-based dashboard results in a blank page. | 1. Upgrade a Geneva instance to Helsinki.  
2. Make sure the Canvas plugin is active.  
3. Create a new dashboard with a Canvas on it.  
4. Make sure the Template Bar is available in the platform.  
The entire Canvas iframe is hidden. |
| Surveys PRB682066 KB0597506   | Assessment       | ‘Take Survey’ link in notification email for public survey throws unauthorized error | If a notification email is sent using Survey trigger conditions, accessing the Take Survey link as a Guest user throws the error “You are not authorized to take this survey” even though the survey is public. | Refer to the listed Known Error KB article for details. |

**All Other Fixes**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Change Management PRB703883   | Change Management - Mass Update CI, Change Request, Best Practice - Bulk CI Changes | Proposed changes are saving directly into CMDB instead remaining as a proposed change | The relationship is not saved as a proposed change and is saved directly to the CMDB instead. | 1. Create a change.  
2. Go to the Affected CI’s section.  
3. Right-click on the CI > select Proposed Change.  
4. Add the CI relationship.  
5. Save.  
The relationship is not saved as a proposed change and is saved directly to the CMDB instead. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat</td>
<td></td>
<td></td>
<td>This ability exists in legacy chat. In Geneva, agents are able to add more technicians to support conversations from the chat popups in ITIL view.</td>
<td>In a Geneva instance:</td>
</tr>
<tr>
<td>PRB690992</td>
<td></td>
<td></td>
<td>In a Geneva instance:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. In ITIL view, accept a session from a queue.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Open it in a mini window.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click Add users.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. From the dropdown, select a user to add.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Click Enter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>In a Helsinki instance:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. In ITIL view, accept a session from a queue.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Open it in a mini window.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Try to add more users as you did in the Geneva instance.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Expected behavior: The agent is able to add more users to a conversation. Actual behavior: Notice that in the Helsinki instance, you cannot add more users because the icon is missing.</td>
<td></td>
</tr>
<tr>
<td>Chat</td>
<td></td>
<td></td>
<td>When transferring a chat from one agent to the other, and the end user closes the chat before it is accepted by the transferred agent, the “Accept” or “Decline” notification stays open and does not let the agent know that the user has left the chat.</td>
<td>1. Ensure that the Collaboration and Collaboration Queue plugins are enabled.</td>
</tr>
<tr>
<td>PRB706302</td>
<td></td>
<td></td>
<td>2. Create a queue with David Loo and Beth Anglin as queue agents.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Impersonate Beth and allow her to accept the chat.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Using the hamburger icon on the left side of the chat window, transfer this chat to David.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. Impersonate ‘ITIL User’, end the chat, and close the window.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7. Impersonate David and Accept the transfer.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Notice that the ‘Accept’ or ‘Decline’ window still appears. When the agent clicks Accept, nothing happens.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chat</td>
<td>PRB709726</td>
<td>chat_queue_entry.wait_time is set to the current date if an end user abandons their chat</td>
<td>Expected behavior: The wait_time is set to the current time and date when the conversation was closed. Actual behavior: The wait_time is set to be the difference between the opening and abandon time.</td>
<td>1. Install Connect Support. 2. Go to a queue. 3. Start a support conversation. 4. Click End chat. 5. Go to the underlying chat_queue_entry record.</td>
</tr>
<tr>
<td>Cloud Management</td>
<td>PRB686327</td>
<td>If cloning encounters an error, it has no way to recover</td>
<td>• Duplicate server: If it was already created but Orchestration timed out, the MID Server tries to clone it again and fails due to the duplicate name. This leaves WF stuck.  • Invalid UUID: Cannot find template when UUID fails</td>
<td></td>
</tr>
<tr>
<td>Cloud Management</td>
<td>PRB686476</td>
<td>Issues with provisioning rules</td>
<td>Operator tasks after provisioning rules fail and require a significant amount of work from operator to move on.  • Not populating values that were successfully obtained by the rules  • Cannot re-run provisioning rules after resolving issue and closing task. This eaves a VMWare operator stuck with a server that requires a significant amount of work to get it to the next phase.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Cloud Management PRB69505B</td>
<td>‘Discover now’ for a particular Discovery schedule (VMware) is using the wrong MID Server in Helsinki</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cloud Management PRB70513B</td>
<td>Change Request WF is not getting triggered for resources that are under change conditions</td>
<td>When a user clicks the Update Lease UI action, nothing happens.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cloud Management PRB710042</td>
<td>AWS and Azure resources getting tagged with blank application</td>
<td>This occurs when there are records in application or service table with empty names.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contextual Search PRB688075</td>
<td>Customized email template was reverted to OOB settings upon Geneva upgrade</td>
<td></td>
<td>In a Geneva instance: 1. Go to Email template: <code>&lt;instance_name&gt;/nav_to.do?uri=sysevent_email_template.do?sys_id=8f910b5ec0a80164009a5a484f6091b59a80164009a5a484f6</code> 2. Delete the content in the ‘Message’ field. 3. Save. 4. Upgrade the instance. Note the record is reverted to its out-of-box content.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Currency                       | Procurement      | Purchase order totaling is incorrect when user country code is using currency other than USD | When you create a purchase order, add line items to it that you explicitly set to GBP, and then view that same purchase order as a GBP user, the total is incorrect.                                      | 1. Load the Procurement plugin with demo data.  
2. Navigate to Procurement › Purchase Orders.  
3. Create a new purchase order.  
4. Add two purchase order line item records in the related list, set the currency to pounds, and make sure the amount includes cents.  
   Note the cost field accurately reflects the total of the two items.  
5. Go to the user record for beth.anglin.  
6. Add the Country code field to the form.  
7. Change the value for the beth.anglin Country code field to United Kingdom.  
8. Impersonate Beth Anglin.  
9. View the same purchase order you created in step 3.  
10. Change the amounts in the POL items, choosing GBP as currency.  
   Note that the total cost is incorrect.                                                                 |                                                                                                                                                                                                 |
| Delegated Development          | wf_context.list  | wf_context.list requires workflow_editor role to read records                     | Users are unable to view records in wf_context.list without the workflow_editor role. In previous releases, this role was not required to view these records.                                             | 1. In access control, open wf_context - read.  
2. Remove the workflow_creator role and add a test role (e.g. asset).  
   Expected behavior: Users can view records without the workflow_editor role.  
   Actual behavior: Users cannot view records without the workflow_editor role. Users need to have both the workflow_creator and asset roles to access wf_context.list. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design and Experience Organization PRB709179</td>
<td></td>
<td>'Uncaught ReferenceError: amb is not defined' from initAngularForm function in public pages causes client scripts to not be executed</td>
<td>Public pages can fail due to AMB JavaScript code that is executed and expects an AMB object (connection) to exist. This unhandled exception causes the execution of client scripts and UI policies to fail to be executed.</td>
<td></td>
</tr>
<tr>
<td>Discovery PRB662539</td>
<td></td>
<td>Discovery cannot collect data on an MSSQL application in a Windows cluster when using the identification engine</td>
<td>When discovering a clustered MSSQL application, the identification engine displays an following error in the system logs, and the CI is not created. Refer to the listed Known Error KB article for more details on the error.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td></td>
<td>KB0597452</td>
<td></td>
<td>The error message that appears in the Helsinki Discovery log is: Error message: “Failed to insert classified application of type: cmdb_ci_db_mssql_instance”</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This occurs because the cmdb_ci_appl table has a hosting “Runs on::Runs” relationship with the cmdb_ci_hardware table. The Windows cluster table (cmdb_ci_win_cluster) is not extended from the cmdb_ci_hardware table, and therefore produces a missing dependency error.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note that there is a race condition between when the Windows - ADM sensor finishes running and the Windows - Cluster sensor finishes running, since they launch asynchronously. If the cluster is already created, this issue occurs when Discovery fails to insert the application.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Discovery | Configuration Management (CMDB) | ORA-00932: inconsistent datatypes: expected - got CLOB Identifying applications on Oracle | CMDB Identification Engine Identity Rules cannot evaluate attributes that are of type CLOB on instances hosted on Oracle. The following message appears in the localhost log: Syntax Error or Access Rule Violation detected by database (ORA-00932: inconsistent datatypes: expected - got CLOB) | Prerequisites • Use an instance that is Geneva or later. • The instance should be running on Oracle. • Only the Discovery plugin should be activated. • Ensure that Discovery is not using CMDB IE (system property glide.discovery.use_cmdb_identifiers = false). 

Steps to reproduce 1. Run Discovery against a target with a running Microsoft IIS Web Server. Note that one cmdb_ci_microsoft_iis_web_server record is created with a Runs On::Runs relationship. 2. Rerun Discovery. Note that there is still only one cmdb_ci_microsoft_iis_web_server record for this host. 3. Update the system property to have Discovery use CMDB IE (glide.discovery.use_cmdb_identifiers = true). Rerun Discovery. Note that there is now a duplicate cmdb_ci_microsoft_iis_web_server pointing to the same cmdb_running_process, and the ORA-00932 message appears in the log. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Encryption</td>
<td></td>
<td>It is possible to create an encryption pattern on the instance when the local</td>
<td>• User should not be able to create/edit patterns through a proxy that does not have a DB</td>
<td>1. As a user with elevated privileges, activate the Edge Encryption plugin.</td>
</tr>
<tr>
<td>PRB655631</td>
<td></td>
<td>database is not being used, and the user is not informed</td>
<td>configured. • User should not be able to create/edit patterns through a proxy that has a DB, if there is another proxy without a DB online. • Once one or more patterns are active, a proxy without a DB should not be able to connect to the instance. • A proxy without a DB can connect to the instance if there are NO active patterns.</td>
<td>2. Configure a proxy without a DB connection (2.1.1 for Helsinki instances). 3. Make one tokenization pattern active. You will need to use a proxy with a DB. 4. Confirm the proxy without DB cannot connect to the instance when there are active patterns. 5. Make all tokenization patterns inactive. You will need to use a proxy with a DB. 6. Confirm proxy without a DB can connect to the instance when there are no active patterns. 7. Confirm that, via proxy without a DB, security_admin user cannot create new tokenization patterns. 8. Configure a second proxy with a DB connection and register it with the same instance as the proxy without the DB. 9. Confirm that even via proxy with a DB, security_admin user still cannot create new tokenization patterns as long as there is one online proxy without a DB. 10. Shut down the first proxy without the DB. 11. Confirm the second proxy with DB can now create and edit tokenization patterns.</td>
</tr>
<tr>
<td>Filters</td>
<td>PRB687999</td>
<td>UI issues on filter’s field selection for List v3 on IE / Windows Edge browser</td>
<td>In IE / Windows, there are UI issues on the filter’s field selection. Specifically, there is a filter dropdown in IE11 when using List v3. The chevron arrows to drill down are not aligned with the field options.</td>
<td>In List v3: 1. Navigate to incident.list. 2. Create a filter for caller. Note the arrows do not align with the fields.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Financial Management</td>
<td>PRB709517</td>
<td>In ITFM, data does not appear/calculate in allocation buckets for future fiscal periods</td>
<td></td>
<td>Pre-requisites</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Log into a Helsinki instance with demo data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Activate the Financial Management plugin installed with demo data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Expected behavior: Amounts show for the listed business units.</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Actual behavior: No amounts are listed for any business units.</td>
<td>1. Log into the instance as a user with elevated privileges (e.g. admin).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. In the Data Definition step, select a future fiscal period (e.g. FY17: Q2).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Click the Allocation Setup step to open that screen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Change Total Amount Assigned to Business Unit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Expected behavior: Amounts show for the listed business units.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Actual behavior: No amounts are listed for any business units.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Forms Designer   | Designer Common, NG shared components                  | When form labels are filled with international languages or special characters (e.g., Japanese), the form labels are not rendered | For example, updating labels in Japanese via the Form Designer can result in HTML-encoded strings being inserted as labels rather than the Japanese characters.                                                                 | In a Helsinki instance:  
1. Activate the Japanese translations plugin.  
2. Once the plugin is activated, create a new custom table with 2 string fields (test1 and test2).  
3. Navigate to the table list view and click New.  
5. Open Form Designer on the form with the 2 test fields and change them to the following:  
   • test1 to: 名前  
   • test2 to: ホソダ  
6. Click Save.  
7. Close the Form Designer and refresh the form to see the newly renamed fields.  
8. Open Form Designer again.  
9. Delete a character without modifying the other label, and save again.  
10. Refresh the form.  
Note that one label is HTML-encoded, and the one that you modified is saved correctly. |
| PRB681264        |                                                        |                                                                                     |                                                                                                                                                                                                           |                                                                                                                                                                                                                                         |
| Forms Designer   |                                                        | Form Design errors upon save when saving forms with choice lists in certain configurations | When selected, Form Design takes too long to upload. After making changes and selecting ‘Save’, the save pop-up takes too long.                                                                 | 1. Navigate to Incident list.  
2. Select a form and click Configure > Form Design.  
   Notice this is taking too long to load.  
3. Add a field and select Save.  
The pop-up displays and stays open. If user closes the pop-up and then closes the window, the pop-up displays that the changes were not saved.                                                                 |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms PRB710207</td>
<td>UI16, NG shared components</td>
<td>Loading hundreds of activity stream entries causes heavy burden on the client to render them</td>
<td>Notice that the incident takes a lot longer to load because of the number of templates. Internet Explorer is especially impacted by this issue.</td>
<td>1. Add 250 entries to an incident. 2. Load the incident.</td>
</tr>
<tr>
<td>Forms PRB710210</td>
<td>NG shared components</td>
<td>Unnecessary XHR on forms with activity stream</td>
<td>Load any existing incident. Notice the XHRs for extra messages, set preference, and templates.</td>
<td>1. Create an incident. 2. Add 250 worknotes to it. 3. Load the incident.</td>
</tr>
<tr>
<td>Forms PRB710576</td>
<td>NG shared components</td>
<td>Activity stream uses unoptimized template code, which causes load time to be high</td>
<td>Note that loading the incident takes a long time.</td>
<td>1. Create an incident. 2. Add 250 worknotes to the incident. 3. Load the form.</td>
</tr>
<tr>
<td>Forms PRB710578</td>
<td>NG shared components</td>
<td>Activity stream is primary focus of form data for some users, but loads asynchronously and takes longer</td>
<td>Notice that it takes a long time to load and can be held up by other XHR requests.</td>
<td>1. Load an incident. 2. Add 250 worknotes to the incident. 3. Load the form.</td>
</tr>
<tr>
<td>HR Service Management PRB706511</td>
<td>The Service Catalog widget should allow options to set the page redirection URL</td>
<td>The Human Resources Service Portal calls the SC catalog page from Service Portal. This page needs to be passed for redirection as a parameter or otherwise needs to handle the redirection from the HR widget.</td>
<td>1. Load an incident. 2. Add 250 worknotes to the incident. 3. Load the form.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| HR Service Management PRB709752 | SCSS Bootstrap Theme | In the iPhone app, the input fields on the user profile do not display properly in the vertical orientation | The input fields and buttons do not fit inside the popover. | In the iPhone app:  
1. Open the HR Service Portal.  
2. Tap the menu icon, and select your name from the menu.  
3. Tap the menu icon again to close the menu.  
4. In your profile, tap any field (e.g. Email or Bio).  
Note that the input fields and buttons are not properly displayed. |
| Knowledge Management PRB668010 KB0596765 | Knowledge Management V3 | New property to hide import button on knowledge home page | Users who have not yet migrated to Knowledge v3 and are using legacy Knowledge v2 need the ability to configure the visibility of the Import/Import Articles button. Because Knowledge v2 does not use User Criteria, users are not prevented from selecting the Knowledge Base.  
For details, refer to:  
• Other knowledge properties  
• Import a Word document to a knowledge base | Refer to the listed Known Error KB article for details. |
| Knowledge Management PRB675599 | Knowledge Management V3 | Clicking the back button on the knowledge form when in IE11 or Firefox always selects the Tags tab | Note that this issue does not occur in Chrome. | Using IE11 or Firefox:  
1. Navigate to the Knowledge homepage and select any article.  
2. Click on the back button.  
Observe that the Tags tab is selected instead of Categories. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Knowledge Management PRB677532 | | Categories that do not belong to the knowledge base being searched are being returned in the filter when they should not be | Search within specific knowledge bases in Knowledge v3 is confusing to end users, due to categories outside of the knowledge base being returned in the filter. | 1. Activate the Human Resources Application: Core plugin with demo data to create the Human Resources Knowledge Bases.  
Note that the resulting knowledge bases all include categories named Policies.  
2. Navigate to Self-Service › Knowledge.  
3. Click on Human Resources General Knowledge.  
4. Search for policy.  
   The left filter panel shows 3 or 4 Policies categories. Search also returns categories outside of ‘Human Resources General Knowledge’. If you click a category that does not belong to ‘Human Resources General Knowledge’, the results disappear, which confuses users.  
Expected behavior: Categories should be displayed in a hierarchical tree format to be able to determine which knowledge base the categories belong to.  
Actual behavior: Search within a specific knowledge base returns categories from other knowledge bases. |
| Knowledge Management V3 PRB707453 | Knowledge Management V3 | Frame gets shortened - Order an item in Service Catalog | After you select an item to order, the frame gets shortened. This occurs for any users who have ‘ess’ in their URL. | 1. Navigate to Service Catalog › Service Offering › Hardware.  
2. Select Sales Laptop.  
Notice the frame is shortened, as iframe is given the style="height: 141px;" attribute. |
| Language and Translations PRB667024 | | Some column labels are not properly translating for internationalized (I18N) languages, specifically French | | 1. Activate the French I18N plugin.  
2. Switch the language to French.  
3. Drag out the Timer activity.  
Notice the labels are not translated. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server</td>
<td>PRB668759</td>
<td>J2SSH reports &lt;error&gt; rather than &lt;warn&gt; on non-zero return code and non-empty stderr</td>
<td>When SSHCommand / SSHCommandLong encounter stderr content, the &lt;error&gt; tag is supposed to be populated with the stderr content if there is a non-zero return code. Otherwise, the &lt;warn&gt; tag should be populated. SNCSSH does this correctly, but J2SSH populates the &lt;error&gt; tag in all cases where there is stderr.</td>
<td></td>
</tr>
<tr>
<td>MID Server</td>
<td>PRB669391</td>
<td>CidInstallApplicationNodeWorkflow fails with 'ChannelOutputStream is closed'</td>
<td>In J2SSH and SNCSSH, errors such as 'ChannelOutputStream is closed' appear. In this case, CID provisioning automation is failing while installing the application node.</td>
<td>Submit a request in the Service Catalog to Provision a new DBI Instance in order to run CidDbiProvisioningWorkflow. Note that it fails in CidInstallApplicationNodeWorkflow with unknown failure.</td>
</tr>
<tr>
<td>MID Server</td>
<td>PRB704679</td>
<td>Rhino creates dynamic classes when doing vCenter discovery, which breaks CyberArk hashing</td>
<td>The MID Server invokes Rhino when doing vCenter discovery, which dynamically generates new classes. These classes are then seen by CyberArk security, and access to the password vault is blocked. This occurs only if the user is using hashing with CyberArk.</td>
<td></td>
</tr>
</tbody>
</table>
| Performance      | PRB670560 KB0584394 | Navigating to a detailed scorecard from a widget when using the Chinese or Japanese language causes an "Invalid date" error and no data is displayed | | 1. Log in as admin.  
2. Set the interface language to Japanese.  
3. Navigate to Performance Analytics > Dashboards.  
4. Select a dashboard.  
5. Click on the area graph of a widget to navigate to the detailed scorecard. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Platform Runtime PRB676462 | PPM import gets stuck if no Project Name is specified during import | This is similar to PRB669159. | In a Geneva instance:  
1. Navigate to Project > Import.  
2. Choose a project to import.  
3. Import the project.  
The import does not end. The semaphore remains occupied, and logs give a WARNING such as:  
*** Unable to find Cached Schedule for Year :2048 |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform Security PRB701497</td>
<td></td>
<td></td>
<td>When High Security Settings plugin is not activated, Explicit Roles plugin causes all non-admins to lose read/write/create/delete access to most tables. When an instance has never had activated High Security Settings plugin, and the instance activates the Explicit Roles plugin (com.glide.explicit_roles), it causes non-admin users to lose read/write/create/delete access to many tables. Specifically, non-admin users lose read/write/create/delete access to tables that do not have explicit read/write/create/delete ACLs defined directly on them. This occurs because the Explicit Roles plugin introduces * ACL’s that should not exist for non-High Security Settings users. For example, this issue occurs when the Customer Service plugin (com.sn_customerservice) is activated, since it has the Explicit Roles plugin as a dependency. Users can experience this issue in multiple ways: 1. They cannot create records on affected table 2. They cannot retrieve records on affected table 3. They cannot save records on affected table Note that this issue may manifest in more scenarios, since the Explicit Roles plugin assumes that the High Security Settings plugin is active.</td>
<td>In an instance without the High Security Settings plugin enabled: 1. Activate the Customer Service plugin (com.sn_customerservice). 2. Impersonate an itil user. 3. Go to the incident list</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Project Management PRB669159 | | Unable to import a MS project | Users are unable to import a MS project. No errors are displayed - it continues to process in a loop. The instance log shows the following warnings:  
2. Import a project.  
No errors will occur - it keeps processing. |
| Project Management PRB670345 | | Export to MS Project does not always work - results in a 0-byte XML file | The project.xml file created through the ‘Export to MS Project’ in the context header menu is an empty file resulting from a failed export. | In an instance with a variety of Projects:  
1. Navigate to the list of Projects, and open a Project that is more than 0% complete.  
2. Right-click the header of the Project form and select Export to MS Project.  
3. Confirm the XML file is zero bytes.  
Note that this will occur intermittently for different Projects.  
Expected behavior: An XML file is generated that contains project information, ready to be imported to MS Project.  
Actual behavior: An empty XML file is generated. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Management PRB676666</td>
<td>Large Projects take longer than maximum execution time to delete</td>
<td>When deleting a large Project with nested child tasks, it may be cancelled and never complete because the transaction requires more time to complete the deletion than the maximum execution time allows through the User Interface (~300 seconds). For users who manage large projects, the projects cannot be deleted through the Delete UI action due to the maximum execution time. This leaves users with only the option to delete all project data manually. When attempting to delete a large Project that cancels due to maximum execution time restrictions, the user’s UI is locked up for ~300 seconds, a cancelled transaction page is displayed, and no actual deletion occurs.</td>
<td>1. Activate the Project Management v2 plugin (com.snc.project_management_v2). 2. Activate the Project Management plugin (com.snc.project_management_v3). 3. Create a large Project with child project tasks running a depth level of 4. 4. Go to the large Project record. 5. From the Project form, click Delete.</td>
<td></td>
</tr>
<tr>
<td>Project Management PRB692279</td>
<td>NumberFormatException error while upgrading to Helsinki</td>
<td></td>
<td>In a Fuji instance with Resource Management and the Project Portfolio Suite installed: 1. Create a group with no members in it. 2. Create a resource plan for the group. 3. Leave the resource plan in the Planning state. 4. Upgrade to Helsinki. Notice that the upgrade fails with a NumberFormatException.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Project Management PRB701769 |  | When changing Planned start date and Planned end date of an existing Project or Project Task record, the Planned end date and Duration value changes to a different value after saving the form. | When changing the Planned start date and Planned end date of an existing record to values other than what were previously set, the values returned upon saving are not what was defined by the user. The Planned end date and Duration get its values from somewhere else. This happens on both the Project and Project Task records. This issue occurs for pre-existing records with a defined Planned start date and Planned end date, thus affecting the Project Task created through the list edit. | 1. Create a new Project record and set the Planned end date (e.g. 20 days later).  
2. Save.  
3. Set the Planned start date to a future date (e.g. 1 day later).  
4. Set the Planned end date several days later (e.g. 5 days later).  
5. Save.  

Expected behavior: The Planned end date and Planned duration should be set to the value that was specified previously.  
Actual behavior: The Planned end date and Planned duration are set to a value smaller than what was specified previously. |

| Project Management PRB702768 | Project Management, Demand Management | Upgrading from an earlier release to Helsinki and/or Geneva is causing the system to remove the project_manager and other project related roles from existing user role assignments. | In Geneva and Helsinki, the ‘it_Project_%’ roles were introduced to replace previous legacy ‘project_%’ legacy roles. Upon upgrade, it appears that the upgrade scripts attempts to remove the legacy role assignments from users and replace it with the new roles. This causes issues within the Project Workbench and other applications. For example, when users with the it_project_manager role but not the project_manager role try to access the Project Workbench, they get the error: “You do not have sufficient privileges to view the Project Workbench.” | In a pre-Geneva instance:  
1. Activate the Project Management plugin.  
2. Provide users with the project_manager and other PM-related roles.  
3. Upgrade to Helsinki or Geneva.  

Note that users are unable to access the Project Workbench from the application navigator and receive an error instead: “You do not have sufficient privileges to view the Project Workbench.” |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management       | PRB702989        | Performance delay while loading a top project (which has 8000+ project tasks) via planning console | There is a performance delay while loading a top project via the planning console. This issue occurs in a Helsinki Patch 1 instance when trying to load a top project with 8000 tasks. The browser (e.g. Chrome, Firefox) is having a hard time keeping up. | 1. Impersonate a user with the it_program_manager and it_portfolio_manager roles.  
2. Navigate to the Program Workbench or Portfolio Workbench modules.  
3. Click these modules one by one.  
Observe that under certain scenarios in Helsinki instances, the system returns ‘Access Denied’ error instead of displaying the workbench.  
If users access the Workbench from the Portfolio and Program form records related link, this works and the Workbench loads without the ‘Access Denied’ error. |
| Project Management       | PRB710680        | Users with Program and Portfolio manager roles get Access Denied error when trying to access Program and Portfolio workbench modules | When a user with all of the Project and Portfolio related roles (including it_program_manager and it_portfolio_manager) clicks on the Portfolio Workbench or Program Workbench modules, they get an ‘Access Denied’ error. If a user opens a specific Portfolio or Program record and use the Workbench related link from the form, the Workbench loads without the ‘Access Denied’ error. | 1. Impersonate a user with the it_program_manager and it_portfolio_manager roles.  
2. Navigate to the Program Workbench or Portfolio Workbench modules.  
3. Click these modules one by one.  
Observe that under certain scenarios in Helsinki instances, the system returns ‘Access Denied’ error instead of displaying the workbench.  
If users access the Workbench from the Portfolio and Program form records related link, this works and the Workbench loads without the ‘Access Denied’ error. |
| Reporting                | PRB674860        | Multipledataset only works for admin users | 1. Log in as admin.  
2. Activate the Performance Analytics premium plugin.  
3. Impersonate any non-admin user.  
4. Create a line report.  
5. Try to add a multiple dataset.  
This is not reflected with the multiple dataset. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Reporting                    |                  | Chart on form does not filter properly on Helsinki                                  | • On Helsinki instances, reports are no longer filtered properly by values on the form when set up with the chart on the form. This occurs for all chart types.                                                   | 1. Create a BAR report on Incidents with Group by State.  
2. Save.  
3. Open a Problem  
4. Configure the chart layout by navigating to Configure > Form layout.  
5. Add * chart.  
6. In the form, configure the chart to use the newly created report.  
7. Link the Problem’s number with the incident’s problem’s number. Select:  
• Form Problem > Number  
• Incident > Problem.Number.  
Note the report is not filtered properly.                                                                                               |
<p>| Server Side Scripting        |                  | Instances which compile thousands of short JavaScript expressions may experience OOM after upgrading to Helsinki |                                                                                                                                                                                                             |                                                                                                                                                                                                                  |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Server Side Scripting | Redirect panel is not working in Helsinki | The Redirect Panel fails to redirect to the specified page and gives a blank screen. Within the script, if you use wizard variables to build the URL and pass them to answer directly, then it fails as the answer is not recognizing the wizard variable values as string. | 1. Create a new panel of type Redirect Panel and attach it to any wizard.  
2. Make sure that you have a redirecting URL with some wizard variables used in it.  
3. Now, attach this to any wizard, and configure it to be called on some condition when you click the Next button.  
4. Run the Wizard.  
5. Select the condition that calls this newly created panel and click Next.  
It should call the URL built in the redirect panel, but it fails and shows a blank screen.  
Note the error below in the logs:  
org.mozilla.javascript.ConsString cannot be cast to java.lang.String:  
java.lang.ClassCastException: org.mozilla.javascript.ConsString cannot be cast to java.lang.String:  
com.snc.expert.ExpertInstance.next(ExpertInstance.java:297)  
com.glide.processors.AProcessor.runProcessor(AProcessor.java:412)  
com.glide.processors.AProcessor.processTransaction(AProcessor.java:187)  
com.glide.processors.ProcessorRegistry.process(ProcessorRegistry.java:165)  
com.glide.ui.GlideServletTransaction.process(GlideServletTransaction.java:49)  
com.glide.sys.ServletTransaction.run(ServletTransaction.java:34)  
java.util.concurrent.ThreadPoolExecutor.runWorker(ThreadPoolExecutor.java:1142)  
java.util.concurrent.ThreadPoolExecutor$Worker.run(ThreadPoolExecutor.java:617)  
java.lang.Thread.run(Thread.java:745) |  |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog</td>
<td>PRB704076</td>
<td>Receiving error message: 'The following fields contain invalid text: &lt;FIELD NAME&gt;'</td>
<td>Suddenly switching tabs multiple times results in mismatched date/time formats. This results in the error 'The following fields contain invalid text: &lt;FIELD NAME&gt;' being thrown. The sys_original.&lt;variable_name&gt; input field should always honor users date preferences to prevent this issue.</td>
<td></td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB702999</td>
<td>Browser gets stuck when clicking 'View map' in business service</td>
<td>On the 'ScanMail' business service, when upon clicking the 'View map' button, the browser gets stuck and stops responding.</td>
<td>1. Go to business service. 2. Then, search for ScanMail. 3. Click View Map. Note the browser gets stuck and must be force-quit.</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB704804</td>
<td>Oracle DB instance: Syntax Error or Access Rule Violation detected by database (ORA-00932: inconsistent datatypes: expected - got CLOB)</td>
<td>Oracle DB instances see the following error message: “Syntax Error or Access Rule Violation detected by database (ORA-00932: inconsistent datatypes: expected - got CLOB)”</td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB669559</td>
<td>The ‘Activity Stream’ column is missing in Current Contract page</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>NG shared components</td>
<td>Need modal where a user provide some inputs</td>
<td>A modal dialog with input text fields should appear on the form when triggered through a mobile client script.</td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB678800</td>
<td>Service Portal is unusable when question_answer table is populated in millions of rows</td>
<td>This affects users who have millions of rows in the question_answer table.</td>
<td>For users with millions of rows in the question_answer table, Service Portal times out and does not load.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Portal PRB689759 | | Form widget should not show the attachment icon if user cannot upload attachment | | In a Helsinki instance:  
1. Log in as Joe Employee.  
2. Go to the Form widget for a closed Incident (i.e. Joe can read but not write).  
Note that the attachment icon is there when it should not. |
| Service Portal PRB698352 | NG shared components | List collectors do not display correctly if the referenced records’ display values have commas | | In Service Portal:  
1. Create a list collector with lastname, firstname in a displayed field.  
2. Note that the list collector does not display correctly. |
| Service Portal PRB700684 | SCSS Bootstrap Theme | Journal field background color is not supported | For partners, the worknotes text area does not have the correct color (yellow). | 1. Impersonate a partner.  
2. Click My Issues.  
3. Open an Incident from the list.  
Note that the worknote text area is transparent color, instead of the correct yellow background color. |
2. Navigate to /$spd.do and open a page in the designer.  
Expected behavior: The text should be visible and clickable for all languages.  
Actual behavior: Preview/Edit and Widgets/Pages text wraps when the translated strings are too long. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal PRB701539 | | Attachments to a catalog item are attached to the request rather than the requested item | Attachments to a catalog item are attached to the request rather than the requested item. When requesting the same item in the 'backend' Service Catalog, attachments are attached to the requested item. If a user requests multiple items in one request, their attachments should go to the individual items and not the request. | In Service Portal:  
1. Navigate to Order Something > Order an item (e.g. Apple Watch).  
2. When the item opens, click Add attachments and add an attachment.  
3. Submit.  
4. Go to the backend and open the request.  
Expected behavior: The attachment is on the requested item.  
Actual behavior: The attachment is on the request. |
| Service Portal PRB703601 | | Knowledge Base articles do not support attachments | Attachments are not visible on knowledge articles. For example, when opening a knowledge article in the new Service Portal interface with the 'attachment link' option selected, it ignores this setting. The article body is opened without downloading or showing any attachments. | |
| Service Portal PRB704846 | | Users see error when searching text on Service Portal: Server Javascript error cannot convert null to an object | When users try to search text on Service Portal when sc_cat_item is added to Service Portal search groups, users see the following error instead: "Server Javascript error cannot convert null to an object." | 1. Add the sc_cat_item table to the sp_search_group table  
2. Impersonate an ESS user (e.g. Abel Tuter).  
3. Go to the Service Portal page.  
4. Search for something.  
Note that you receive the error "Server Javascript error cannot convert null to an object." |
<p>| Service Portal PRB704859 | | SP choice list should require value or use default_value if type is set to 'must specify a default value' | | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal PRB706265</td>
<td></td>
<td>Order Guide description is not being shown</td>
<td></td>
<td>1. Go to the New Hire order guide in Service Portal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Go to the same order guide in the normal UI.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note that the Description is not shown in Service Portal.</td>
</tr>
<tr>
<td>Service Portal PRB706632</td>
<td></td>
<td>Reference qualifiers can fail on Service Portal</td>
<td>Reference qualifiers fail on Service Portal for sc_cat_item variables.</td>
<td>In a Helsinki instance:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1. Open a sc_cat_item record (e.g. Apple iPad 3).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Create a new variable for the item on type List Collector.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Go to the Type Specification section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Configure the item_option_new form so that the ‘Reference’, ‘Use reference qualifier’ ‘Reference qual condition’, and ‘Reference qual’ fields are displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>You can now configure a simple List Collector variable for the item.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Use any table to test (e.g. Incident).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Open the Apple iPad 3 in the UI. Notice that the reference qualifier on the item is enforced.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7. Open the same item on the Service Portal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Notice that the reference qualifier is not enforced.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Service Portal PRB707257 |                  | In Service Portal, articles are still present in Knowledge Base after 'Valid to' date has passed | In Service Portal, articles are still present in Knowledge Base after 'Valid to' date. This should be adapted in widgets for KB Categories, search, and the article itself. | With a KB article whose 'Valid to' date has already passed:  
1. Navigate to Knowledge › Published › ⟨KB article⟩.  
   Note that the 'Valid to' date has already passed.  
2. Navigate to Knowledge › Homepage.  
3. Search for ⟨KB article⟩.  
   No results are shown, which is the expected behavior.  
4. In the Service Portal, search for ⟨KB article⟩.  
   Note that you are able to view the article, which is the unexpected behavior. |
| Service Portal PRB707375 |                  | Knowledge article count on category are incorrect in Service Portal⟨kb_view2⟩ - it shows '−1' | The Service Portal homepage kb_view2 does not work properly when there are more than 500 articles (independent of the article stated) on the associated Knowledge Base. The portal will show all category counts as '−1' instead of the number or articles under the categories. | In a Helsinki instance with 500 or more KB articles:  
1. Log in as an admin user.  
2. Navigate to System Definition › Plugin.  
4. Create a Portal by following these steps:  
   a. Navigate to Service Portal › Portals.  
   b. Click New.  
   c. Enter the values  
      • Title: Test  
      • URL suffix: test  
      • Homepage: kb_view2  
      • Knowledge Base: IT  
   d. Save.  
5. Navigate to ⟨instancename⟩.service-now/test.  
   Note that the category counts are '−1'. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal PRB707455 |  | Form widget should show “Record not found” if record not found |  | 1. View an Incident in the Form widget.  
2. Change one character of sys_id in the URL to a g.  
3. Reload.  
Note that the user sees errors, instead of informing the user that the record was not found. |
| Service Portal PRB709057 |  | Duplicate stage values in Requested Items widget |  | 1. In Service Portal, navigate to the item iPad 3.  
2. Order 2 of them.  
3. Navigate to the ?id=sc_request page for the new request.  
Note that the requested item has two ‘Waiting for Approval’ stages. |
| Service Portal PRB709201 |  | sp-angular-provider.script needs a larger max_length to prevent Oracle from truncating scripts |  | Using Oracle:  
1. Activate Service Portal.  
2. Try to put more than 4000 characters in the sp-angular-provider.script field.  
Note that you cannot. As a result, OOB scripts are getting truncated. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal PRB709401 | Human Resources Application: Service Portal | Service Portal in iPhone app displays catalog categories differently than in the regular browser | In a baseline instance, if you use the iPhone app to view the Order Something page in the Service Portal, you will see all available categories, including those restricted by role (e.g., the categories that exist in the Admin Home catalog). However, if you use the browser to view the same page, you will not see the Admin Home catalog categories. | 1. Activate Service Portal for Enterprise Service Management.  
2. Log in as an ITIL user.  
3. Using a browser (either mobile or desktop), go to the Service Portal.  
4. Click Order Something.  
   Note the categories that are displayed in the SC Categories widget.  
5. Using the native iPhone app, go to the Service Portal.  
6. Tap Order Something.  
   Note the categories that are displayed in the SC Categories widget.  

These categories come from the Admin Home catalog, which should only be available to user with elevated privileges. |
| Service Portal PRB709411 | sp_admin does not have read/write access to sp_instance_menu table and sp_ng_template table | Users with the sp_admin role do not have read/write access on the sp_rectangle_menu and sp_ng_template tables. | In a Helsinki instance:  
1. Assign the sp_admin role to any user.  
2. Impersonate that user and navigate to sp_ng_template.LIST.  

Expected behavior: These tables are accessible by sp_admin to make edits.  
Actual behavior: sp_admin role does not have read/write access to these tables. |
| Service Portal PRB709820 | SCSS Bootstrap Theme | In the iPhone app, the vertical line that appears in Service Portal activity streams does not align properly | The line overlaps any comments or worknotes. | In the iPhone app:  
1. Open a Service Portal.  
2. Open a record that contains an activity stream, such as a request.  
3. Scroll down to the Activity portion.  
4. Add a comment or worknote if there is none present.  

Note that a grey vertical line intersects the comment in the stream. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal   |                  | Service Portal Home mobile module incorrectly links to $sp.do, should link to /sp | In a Helsinki instance:  
1. Log in as admin.  
2. Go to /sys_ui_module.do?sys_id=e02cedb3931231001a1e11f867 | Note the URL is $sp.do when it should be /sp instead.                                                        |
| PRB709901        |                  |                   |                                                                             |                                                                                                              |
| Service Portal   |                  | Long, unbroken title is not wrapped in ticket conversation widget header | When entering a long string of text as the description for a new incident in the Service Portal, the text is not wrapped or truncated when it is re-displayed in the detail page. | In Service Portal:  
1. Click Get Help > Create Incident.  
2. Select urgency as 3-Low.  
3. Enter a long, unbroken string in the field Please describe your issue below.  
4. Click Submit.  
5. At the top of the page, click Requests.  
6. Select the latest incident you created in the dropdown list.  
Expected behavior: This text should be wrapped or truncated to fit the light gray rectangular box.  
Actual behavior: In the displayed page, the description text is displayed over the whole width of the browser window and is hidden under the block “Your request has been submitted”. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>PRB710610</td>
<td>Some variable types do not work in Variable Sets</td>
<td>When using an order guide, the values that are selecting on the order guide are disappearing once selected. This occurs on the variables that are of type Multiple choice. This issue is only present on Service Portal, and works as expected in Service Catalog and within the platform if checked through the ‘Try it’ button.</td>
<td>In a Helsinki instance: 1. Create a variable set of type Multiple Choice and name it sntest1. 2. Navigate to Maintain Items and find Apple Macbook Pro 15. 3. In the Maintain Items related lists, navigate to Variable Sets › Edit › add sntest1. 4. Navigate to Service Catalog › Order Guides › Create New order guide (e.g. Testing Rule Base). 5. Fill out necessary information such as Catalog and Category and add the same variable set sntest1. 6. Navigate to the Rule Base section › Create new.   • In the Condition field, add this condition: choice_list_1 is one.   • Include this item: Apple Macbook Pro 15”.   • Submit. 7. Navigate to Service Portal, type Testing Rule Base in the search box, and click on it. 8. From choice list 1, select ---- › one. Expected behavior: When you select an option in the order guide, the selection should not disappear (e.g. options ‘two’ and ‘three’). Actual behavior: The selection disappears once the option is clicked (e.g. option ‘one’).</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Portal</td>
<td></td>
<td>Picture does not display on a catalog item if it is included in the Service Portal</td>
<td>Catalog items from order guides in the Service Portal do not display pictures.</td>
<td>In a Helsinki instance:</td>
</tr>
<tr>
<td>PRB710893</td>
<td></td>
<td>Ordering Guide</td>
<td></td>
<td>1. Navigate to the Apple MacBook Pro 15&quot; catalog item and confirm that it has a picture.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Search for it on Service Portal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note that the picture displays as expected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Now, add this item to one of the order guides.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note that the picture does not display anymore.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Expected behavior: Catalog items display a picture in Service Portal, even if they are included in Order guides.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Actual behavior: In Service Portal, catalog items do not display a picture if they are a part of order guide.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This issue is only present in Service Portal. It works as expected in Service Catalog and if you click Try it.</td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td></td>
<td>Report Outage record producer displays errors upon load</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRB711154</td>
<td></td>
<td></td>
<td></td>
<td>1. Navigate to /sp.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. In the search bar, type report outage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Notice the following errors on the page:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• org.json.JSONException: JSONObject[&quot;containers&quot;] not found.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Script source code logged to console</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Failing widget: 'SC Catalog Item' (0fd6a6f247230200ba13a559)</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Service Portal PRB711291 |                  | Duplicate request gets created in order guides on Service Portal | Duplicate request gets created in order guides on Service Portal when using rule base, List collector and Catalog UI policy. | Using Service Portal:  
1. Go to the New Hire Test order guide.  
   - URL in form: /nav_to.do?uri=sc_cat_item_guide.do?sys_id=48622e374fa522007e539d9f0310c7a6  
   - URL in portal: /sp?id=sc_cat_item_guide&sys_id=48622e374fa522007e539d9f0310c7a6  
2. Fill in the form with the following values:  
   - type_of_device: Laptop  
   - Software: Dreamweaver, Adobe Acrobat Pro  
   - sn: do not fill this field in  
3. Click Submit.  
   Note that the popup will show: "The following fields are incomplete: sn".  
4. Then, remove Adobe Acrobat Pro from the software.  
   Notice included items only have "Dreamweaver" now.  
5. Click Submit again.  
Expected behavior: Only 1 request is created with 1 request item.  
Actual behavior: Instead, 2 duplicate requests are created. |
<p>| Update Sets PRB639879 |                  | Update sets containing Japanese content result in errors and cannot be applied properly | Update sets that contain tables and labels created in Japanese give errors when a user attempts to apply them to another instance, and the update sets cannot be applied properly. |                                                                                     |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Sets</td>
<td>PRB655182</td>
<td>Users get error when trying to merge update sets for an app installed from the store</td>
<td>Users are unable to merge update sets of a scoped application when that application was installed from the app store. They receive the following error: “You cannot merge update sets for an application you cannot edit”. However, users are able to add and edit records in the updates sets being merged.</td>
<td>In Fuji&lt;br&gt;Source instance&lt;br&gt;1. In a Fuji instance, create a scoped application.&lt;br&gt;2. Navigate to sys_app.list and click on the app you created.&lt;br&gt;3. Click Make app available on other instances. Target instance&lt;br&gt;1. In another Fuji instance, install the application you just created in the source instance.&lt;br&gt;2. In the target instance, create a couple of update sets for the installed application.&lt;br&gt;3. Try to merge those update sets. You will get the error “You cannot merge update sets for an application you cannot edit.”</td>
</tr>
<tr>
<td>User Interface</td>
<td>Lists v2</td>
<td>List v2 list actions and Related List actions do not render correctly in Firefox</td>
<td></td>
<td>In Firefox:&lt;br&gt;1. Log into a fresh instance as admin.&lt;br&gt;2. Verify the List v3 plugin is inactive and the List v2 plugin is active.&lt;br&gt;3. Navigate to any list (e.g. task.list).&lt;br&gt;4. Scroll to the bottom and click the list action dropdown. Note all list actions are rendered in a row. This issue also occurs on related list actions.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB675382</td>
<td>When two users edit the same record where a timer field is used, the timer field changes to NaN</td>
<td>When searching in the Service Catalog widget in Service Portal, the results show icons for Service Catalog items but not for record producers. This is inconsistent with the Service Catalog category view, where the icons are used for both and it is not possible to configure the widget to display no images.</td>
<td>1. Add a picture and icon to Employee Onboarding IT a picture and icon. 2. Add it to the Service Catalog catalog under any category. 3. Go to <code>&lt;instance&gt;.service-now.com/sp</code>. 4. In the search, enter Employee. Expected behavior: When viewing the catalog in the Service Catalog under whichever category it was placed, the icon is visible. Actual behavior: Note that several entries have icons, but Employee Onboarding IT does not.</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB705283</td>
<td>Icons for Order Guides are not displaying in search in Service Portal</td>
<td></td>
<td>1. Open the same record with a timer variable as two different users at the same time. 2. Edit the record as the first user. Note that for the second user, the timer briefly shows NaN in the three timer fields. 3. Make an edit as the second user. NaN will appear for the first user.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| User Interface (UI) PRB709634 | g_form.getOptions do not work on the self-service portal, and there is no alternative to get the display value of select box fields | Using g_form.setValue() and then g_form.getDisplayValue() for a choice list in Service Portal will return the sys_id of the record instead of the display label. | **In Service Portal:**  
1. Find a catalog item with a select box variable (e.g. Ask a question - 66c313e7c0a8016b008ebe1a8e3d97f5).  
2. Create an onChange catalog client script for the Urgency select box.  
3. In the script, write the following code:  
   ```javascript  
   console.info('you selected: ' + g_form.getDisplayValue('urgency'));  
   ```  
4. When you open the catalog item in Service Portal and change the urgency select box, look at your browser console.  
   You will see a sys_id or number instead of the label from the select box. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Flexible Visual Task Boards PRB692391 |                  | Flexible Visual Task Board does not show cards that were on the removed list       | Flexible Visual Task Boards do not show cards of filtered tasks that are unassigned or reassigned. However, cards are shown if type of the board is set to Guided.                                                | 1. Create a Flexible VTB.  
2. Filter the board as follows:  
• Table = Task(task)  
• Active is true  
• Assignment Group is Database or  
• Assigned to is Beth Anglin or  
• Assigned to is Abel Tuter  
3. Assign a incident to Beth Anglin with the Assignment group set to Database.  
Notice that the VTB has the incident card.  
4. Reassign the incident to another user and remove the assignment group.  
Notice that the incident card is removed from the VTB.  
5. Assign the same incident to Beth Anglin with the Assignment group set to Database.  
Notice that the card is not filtered back into the VTB, and removed is set to true. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| PRB698542 | Visual Task Boards | The Visual Task Board Task fields added in the VTB view is not displayed on the Task Card detail form | 1. Create a free form board.  
2. Add a task.  
3. Navigate to vtb_task.list.  
4. Open the newly created task from step 2.  
5. Right-click on the form header > Configure Form Layout.  
6. Change the view from Default to VTB.  
7. Add additional fields (e.g. created and created by fields).  
8. Go to the Visual Task Boards.  
9. Refresh the page. | **Expected result:** The fields selected in the VTB view should be displayed in the task card.  
**Actual result:** The additional fields selected in the VTB view are not displayed in the task card. |
| PRB681220 | SSH activity after Timer activity (wait time > 0) in a workflow will result in error | In 5 seconds after the Timer is up, it will try to run the SSH File Read activity. However, the SSH activity will result in an error with the following message: “Command field is empty or command field contains syntax error on syncFile. Fix this and try again.” | | |

**Other Helsinki Patch 5 information**

**Knowledge Management**

glide.knowman.import.hide_import_functionality is a new property that hides the import button on the knowledge home page. For details, refer to:

- [Other knowledge properties](#)
- [Import a Word document to a knowledge base](#)
Fixes included with Helsinki Patch 5

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 4 Hot Fix 1**
- **Helsinki Patch 4**
- **Helsinki Patch 3**
- **Helsinki Patch 2 Hot Fix 5**

This release includes the HP2HF5 PRBs that were also fixed in HP5. *

- HP4: PRB692216
- HP5: PRB702120
- HP6: PRB713397

- **Helsinki Patch 2**

  Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- **Helsinki Patch 1 Hot Fix 2**
- **Helsinki Patch 1**
- **Helsinki Fixes**

Helsinki Patch 4 Hot Fix 5

The Helsinki Patch 4 Hot Fix 5 release contains fixes to these problems.

For the Helsinki Patch 4 Hot Fix 5 release:  
Build date: 04-11-2017_1316  
Build tag: glide-helsinki-03-16-2016_patch4-hotfix5-04-05-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.
Fixed problem in Helsinki Patch 4 Hot Fix 5

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Edge Encryption PRB916539 | When the number of connections increases, the Edge Encryption proxy experiences extreme slowness | Edge Encryption proxies can run extremely slowly. This issue occurs when concurrent user sessions drive up the number of simultaneous user connections to the instance through the proxy. There are also no logs to indicate the proxy’s processing. | 1. Start up an Edge Encryption proxy and connect to an instance.  
2. Simulate users going through the proxy and using connection-intensive pages, such as Service Portal and Knowledge. Notice that after a certain threshold, response times become extremely slow. |

Fixes included with Helsinki Patch 4 Hot Fix 5

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 4 Hot Fix 4
- Helsinki Patch 4 Hot Fix 3
- Helsinki Patch 4 Hot Fix 2
- Helsinki Patch 4 Hot Fix 1
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 2
- Helsinki Patch 3
- Helsinki Patch 2 Hot Fix 3
- Helsinki Patch 2 Hot Fix 1
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 4 Hot Fix 4

The Helsinki Patch 4 Hot Fix 4 release contains fixes to these problems.

For the Helsinki Patch 4 Hot Fix 4 release: Build date: 01-26-2017_1701  
Build tag: glide-helsinki-03-16-2016_patch4-hotfix4-01-26-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.
Fixed problem in Helsinki Patch 4 Hot Fix 4

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Encryption</td>
<td>HTTP response code 504 and cross origin errors recorded when connecting through the</td>
<td>When browsing through the Edge Encryption proxy, the browser records HTTP 504 response codes and CORS errors. The issue affects using POSTing records to the instance and clients using .NET as a source library.</td>
<td>1. Connect to an instance through an Edge Encryption proxy.</td>
</tr>
<tr>
<td>PRB750703</td>
<td>Edge Encryption proxy.</td>
<td></td>
<td>2. View the browser developer tools.</td>
</tr>
</tbody>
</table>
<pre><code>                                                             |                                                                                     | Note that there are occasional HTTP 504 response codes for presence calls: /amb/connect. They also contain occasional CORS errors.                                                                                                                                                                                                                                  |                                                                                                                                                                                                                                          |
</code></pre>

Fixes included with Helsinki Patch 4 Hot Fix 4

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 4 Hot Fix 3
- Helsinki Patch 4 Hot Fix 2
- Helsinki Patch 4 Hot Fix 1
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 2
- Helsinki Patch 3
- Helsinki Patch 2 Hot Fix 3
- Helsinki Patch 2 Hot Fix 1
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 4 Hot Fix 3

The Helsinki Patch 4 Hot Fix 3 release contains fixes to these problems.

For the Helsinki Patch 4 Hot Fix 3 release:

Build date: 12-29-2016_1335
Build tag: glide-helsinki-03-16-2016_patch4-hotfix3-12-28-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.
Fixed problem in Helsinki Patch 4 Hot Fix 3

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Services</td>
<td>SOAP requests for records that contain workflow stage display values may execute slower after Eureka</td>
<td>When using ODBC to query the sc_req_item table, the individual SOAP calls to /sc_req_item.do?redirectSupported=true&amp;SOAP&amp;displayvalue=all take longer in Helsinki than they did in Eureka.</td>
<td>1. Order an item from the service catalog that uses a workflow for fulfillment AND that workflow uses stages.</td>
</tr>
<tr>
<td>PRB723438</td>
<td></td>
<td>The SOAP request will take longer for instances running post-Eureka versions.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: For most instances, the difference is only a 10-20ms per record. However, in some instances with a large amount of possible stage values, the difference can be significant.</td>
<td></td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 4 Hot Fix 3

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- [Helsinki Patch 4 Hot Fix 2](#)
- [Helsinki Patch 4 Hot Fix 1](#)
- [Helsinki Patch 4](#)
- [Helsinki Patch 3 Hot Fix 2](#)
- [Helsinki Patch 3](#)
- [Helsinki Patch 2 Hot Fix 3](#)
- [Helsinki Patch 2 Hot Fix 1](#)
- [Helsinki Patch 2](#)

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- [Helsinki Patch 1](#)
- [Helsinki Fixes](#)

Helsinki Patch 4 Hot Fix 2

The Helsinki Patch 4 Hot Fix 2 release contains fixes to these problems.

For the Helsinki Patch 4 Hot Fix 2 release: Build date: 10-17-2016_1358
Fixed problem in Helsinki Patch 4 Hot Fix 2

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) PRB713397 | Safari 10.0.1 redirects users to UI11 | Users who log in to their Fuji, Geneva, and Helsinki instances from Safari version 10.0.1 are redirected to the legacy UI11 instead of UI16. | 1. Set user agent string to: "Mozilla/5.0 (Macintosh; Intel Mac OS X 10_12_1) AppleWebKit/602.2.7 (KHTML, like Gecko) Version/10.0.1 Safari/602.2.7".  
2. Log in to the instance.  
UI11 appears. |

Fixes included with Helsinki Patch 4 Hot Fix 2

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 4 Hot Fix 1
- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 2
- Helsinki Patch 3
- Helsinki Patch 2 Hot Fix 3
- Helsinki Patch 2 Hot Fix 1
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 4 Hot Fix 1

The Helsinki Patch 4 Hot Fix 1 release contains fixes to these problems.

For the Helsinki Patch 4 Hot Fix 1 release:  
Build date: 09-03-2016_0931  
Build tag: glide-helsinki-03-16-2016_patch4-hotfix1-09-01-2016
For more information about how to upgrade an instance, see Upgrade to Helsinki.
For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 4 Hot Fix 1

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>Service Portal ignores multiple column variable layouts in catalog</td>
<td>Catalog uses containers to allow users to control the layout of the variables of their catalog items, letting them create variables that appear in multiple columns. Service Portal appears to ignore these containers, causing everything to display in a single column. The fix for this PRB causes the two-column layout of containers to render first. Afterwards, the two-column layout of nested variable sets is rendered. Note that compared to the platform view of a catalog item, Service Portal does not render nested containers. Only variables and variable sets can be displayed inside a container.</td>
<td>1. On a catalog item or record producer, add a container_start variable with layout = 2 columns, alternating sides. 2. Add a few variables in order after the above container. 3. Add a container end variable at the end. 4. Open the catalog item or the record producer in the new Helsinki Service Portal. You will notice that the fields appear in single column and not in 2 columns, as defined in the container.</td>
</tr>
<tr>
<td>PRB682246</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 4 Hot Fix 1

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 4
- Helsinki Patch 3 Hot Fix 2
- Helsinki Patch 3
- Helsinki Patch 2 Hot Fix 3
- Helsinki Patch 2 Hot Fix 1
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1
- Helsinki Fixes
Helsinki Patch 4

The Helsinki Patch 4 release contains fixes to these problems.

For the Helsinki Patch 4 release:

- Build date: 08-27-2016_1002
- Build tag: glide-helsinki-03-16-2016__patch4-08-10-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Security-related Fixes

Helsinki Patch 4 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 4, refer to KB0597395.

Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) PRB702543 | NG shared components | High CPU utilization is correlated to Record Presence transactions | Analysis of servers with high CPU utilization has determined that Record Presence can significantly increase CPU load. It has been observed that turning Record Presence off can lead to a 25% reduction in CPU load. | 1. Toggle Record Presence off and on while hundreds of users interact with an app node.  
2. Notice the difference in CPU load. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Tables and Dictionary PRB652054 | Label override bug for label name when using form designer | On the same table with the label override, if fields are moved around using the form designer, and the label that has an override is a field such as ‘short description’, all of the respective child tables where that field is derived from (e.g. TASK) will have their short description labels changed to reflect the new label. | 1. Using the short description field, create a new label record off of the incident table.  
2. Make the label name ‘test’ and save the record.  
3. Go to the dictionary entry for the task_short_description field and scroll down to the label related list.  
Notice that there is now a label record for the short description field with a value of ‘test’ on the incident table.  
4. Go to an incident record.  
Notice that the short description label now shows up as test (this is expected since we are doing a label override).  
5. Using the form designer, adjust the order of any two fields by dragging and changing the order of the fields.  
6. Click Save.  
7. Now go to any table other than incident that extends task.  
Notice that the short description on the incident form has been changed to Test. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms PRB666131 KB0583973</td>
<td></td>
<td>If field preceding activity stream is read-only, the stream does not show inputs</td>
<td>If Additional Comments and Work Notes are on a separate section of the form or not followed by the Activities (filtered), and there is a read-only field (for ITIL users) before the Activities (filtered), the fields do not display for ITIL users. Conditions to get the problem: 1. Must be ITIL user 2. Journal fields must be in different section than activity formatter, or not following the activity formatter does not follow the journal fields 3. There must be a read-only field for the ITIL user before the activity formatter</td>
<td>1. Log in as an administrator. 2. Open an incident form, navigate to Configure &gt; Form Layout, and create a new form section. 3. Add the following fields to the new section: Additional Comments, Work Notes, and Activities (filtered). 4. Verify that the newly created fields are displayed. 5. Impersonate an ITIL non-admin user. 6. Open an incident. Note that the Additional Comments and Work Notes input fields are not displayed. 7. End the impersonation and go back to the administrator session. 8. Remove the Activities (filtered) field from the affected form section. 9. Impersonate an ITIL non-admin user. Note that the Additional Comments and Work Notes input fields are displayed.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Core Platform</td>
<td>Transaction Quotas</td>
<td>Security Incident Response plugin is causing issues with large transforms.</td>
<td>The Security Incident Response plugin is causing issues with large transforms. The load of the imports gives an error (see Steps to reproduce).</td>
<td>In a Geneva instance:</td>
</tr>
<tr>
<td>PRB669163</td>
<td></td>
<td></td>
<td>1. Loading data in a Geneva instance without activating the 'Security Incident Response' plugin works as expected.</td>
<td>Load data without activating the 'Security Incident Response' plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Loading the data with the plugin 'Security Incident Response' activated leads to the error 'Transaction cancelled: maximum number of business rules exceeded'.</td>
<td>Note that data is imported successfully.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Load the data.</td>
<td></td>
</tr>
</tbody>
</table>

Note the error 'Transaction cancelled: maximum number of business rules exceeded':

```
com.glide.sys.TransactionCancelledException:
Transaction cancelled: maximum number of business rules exceeded
```
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) PRB663730 | Activity formatter filter on Geneva Incident form is missing the option ‘All’ on the options list | This option used to be available in Fuji. The *Geneva activity formatter* product documentation does not contain information about the exclusion of this feature. If a Geneva instance is reverted to UI15, the functionality is still available. | In an OOB Geneva instance:  
1. Impersonate Fred Luddy.  
2. Navigate to Incident > Assigned to me.  
3. Click on the incident INC0000052.  
4. On the right side of the Activity field, click on the filter icon.  

Note that the Option ‘All’ is missing. |
| MID Server PRB665835 | ECC Message creation might end up blocking all ECC Queue processing | The ECC Queue monitor, which processes a list of ECC messages (ECCQueueMonitor.processMessages), creates an instance of eccmessage. However, this method does not copy factory variables. If ECCMessage.update is called, which in turn uses factory variable, the MID Server throws NullPointerException. It may try to reprocess the same ECC message, leaving the MID Server perpetually stuck. |  |  |
| Core Platform PRB609866 | When downloading an attachment with special characters in the name, the file name is changed to ‘download’ | When downloading an attached file with special characters present in the name (using Chrome or IE), the file name is changed to ‘download’. This issue is not reproducible in Firefox, and the file extension does not change. | Using Chrome or IE:  
1. Go to an incident form and open an incident.  
2. Attach a document with special characters (e.g. Chinese characters or ‘EspecificaciónTécnica.doc’).  
3. Click the attached file to download it.  

Expected behavior: File name is kept after download.  
Actual behavior: The file name changes to download.doc. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal PRB691597</td>
<td></td>
<td>Service Portal variables max. length are inconsistent with normal Catalog UI</td>
<td>The single-line text and wide variables only permit 40 characters, which is inconsistent with the normal Catalog UI. In addition, field-mapped variables max. length are also inconsistent with the normal Catalog UI.</td>
<td></td>
</tr>
<tr>
<td>User Interface (UI) PRB692215 KB0597917</td>
<td></td>
<td>Safari 10.x in MacOS Sierra sends users to UI11</td>
<td>When a user logs into certain versions of a Fuji, Geneva, and Helsinki instance using Safari 10.0 (Mac Sierra beta version), they are redirected to UI11/UI14. The user agent off of the new Safari 10 is: &quot;Mozilla/5.0 (Macintosh; Intel Mac OS X 10_12) AppleWebKit/602.1.38 (KHTML, like Gecko) Version/10.0 Safari/602.1.38&quot;.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>

All Other Fixes

<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Logic Processing PRB700675 KB0597337</td>
<td></td>
<td>Issue with GlideElementPhoneNumber and updateMultiple</td>
<td>Using multipleUpdate() with a phone number field causes the phone number field to be set to null.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>
| Change Management PRB689023          |                  | After upgrade from Fuji to Helsinki, CIs in the CMDB are missing Save or Submit buttons | On an instance upgraded to Helsinki which does not have the new Change Management plugin installed:  
1. Navigate to the Configuration Items list (cmdb_ci.list).  
2. Click New.  
Note the Submit UI action is not present. |                                      |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Chat PRB691776   | Support chat - Messages from a user in a lower-level domain will not appear immediately in the chat queue | For chats to appear, a refresh is required. | 1. As ACME.employee, open the URL to the ACNME support queue as a user. (You must construct URL manually or have a shortcut already established to it.)
2. As ACME.employee, view the incoming chat request in the queue.
3. As MSP.itil, accept the chat.
4. As MSP.itil, acknowledge the chat with a message.
5. As ACME.employee, type a message back to MSP.itil.
6. As MSP.itil, respond to the message.
Actual result: Users have to refresh in order to see and respond to messages.
Expected result: Users are able to see each other’s messages immediately. |
| Chat PRB702095   | chat_queue_entry records are not closed properly when an end user closes the conversation | chat_queue_entry records are not updated correctly when an end user closes their own support chat. The business rules for calendar_duration and the active field are not run. | 1. Install Connect Support with demo data.
2. As Joe Employee, start a support conversation.
3. As Beth Anglin (in another browser), accept the chat.
4. As Joe, close the support conversation.
5. Switch to System Administrator and view the chat_queue_entry record.
Notice calendar_duration is not set, the record is still marked "active", and the closed_at value has not been updated. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB PRB675704 Configuration Management (CMDB)</td>
<td></td>
<td>‘Show CI Timeline’ UI action can result in ‘RP is not defined’ error</td>
<td>The action navigates to the previous page and the following message is found in the log: org.mozilla.javascript.EcmaError: “RP” is not defined.</td>
<td>1. Navigate to a CI. 2. Right-click on the header &gt; History &gt; Timeline.</td>
</tr>
<tr>
<td>CMDB PRB679085</td>
<td></td>
<td>NullPointerException error when loading the CI Relations formatter on a customized cmdb_ci tables whose name do not start with cmdb_ci</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Dependency Views (BSM Map) PRB675752 | Next-Gen BSM | Export Image and Load View not supported for IE11 and Firefox | In Dependency Views > View Map, the ‘Load View’ and ‘Export Image’ features are not compatible with IE11. | Using IE11:  
1. Log in as an admin.  
2. Navigate to Dependency Views > View Map.  
3. Click the menu (hamburger) icon > Export Image.  
Note that this feature is not supported for IE11 or Firefox. |
| Dependency Views (BSM Map) PRB692554 |  | Dependency CI name and group names are cut off when small screen resolution and test failed | When comparing maps, some of the CI names are cut off with the extension/suffix of “…”. This breaks most of the tests. |  |
| Dependency Views (BSM Map) PRB700595 | Next-Gen BSM | Space used to display map in BSM View Map in Helsinki is not appropriate | To display the BSM map, the new BSM uses much more space, making the map less readable. In the legacy BSM map view, space was used more optimally. |  |
| Discovery PRB661411 |  | Duplicate ‘discovery.phase.complete’ events can sometimes be triggered, which can cause duplicate “Run after” Discovery Schedules to be triggered |  |  |
| Discovery PRB671545 |  | After Geneva upgrade, the MID Server throws NPE on any ecc_queue command that does not have a source specified | The ECCQueueMonitor tests each ecc_queue entry for a source, to see if the source is restarted. When there is no source specified in a queue, as is the case with the heartbeat for example, a NullPointerException is thrown. | 1. Download and install a Fuji MID Server.  
2. Configure the MID Server to point to a Geneva instance, forcing the MID Server to upgrade.  
3. After the upgrade, watch the agent log on the MID Server.  
You will start to see NullPointerExceptions coming from SystemCommandExecutor line 56. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Discovery        | PRB68335B       | Certain probes cannot be selected from slushbucket for Triggers probe on Discovery Classification | For the related list ‘Triggers probes’ from a Discovery Classification record, the options are restricted to records with `sys_class_name`=“discovery_probes”. MultiProbes, AWS Probe, Azure Probes, and others cannot be selected. This prevents Discovery administrators from specifying a new probe to trigger that is not of `sys_class_name`=“discovery_probes”. | In an instance with the Discovery plugin (com.snc.discovery) active:  
1. Navigate to Discovery Definition > CI Classification > SNMP > Firewall.  
2. Under the related list Triggers probes, click Edit.  
3. Search for a probe that extends discovery_probes. Some probes do not appear as available options. Some examples:  
   • MultiProbe: AIX - Identity, Unix - ADM  
   • AWS Probe: AWS EC2 - DescribeInstances  
   • SNMP Probe: SNMP - Classify, SNMP - Netware  

With SQL Debugging, the following message appears:  
```
[glide.3] /*...*/
SELECT ... FROM (discovery_probes discovery_probes0 INNER JOIN sys_metadata sys_metadata0 ON discovery_probes0.`sys_id` = sys_metadata0.`sys_id`) WHERE sys_metadata0.`sys_class_name` = 'discovery_probes' ORDER BY discovery_probes0.`name` limit 0,102
```
On an instance where this works as expected, the message is:  
```
[glide.1] /*...*/
SELECT ... FROM (discovery_probes discovery_probes0 INNER JOIN sys_metadata sys_metadata0 ON discovery_probes0.`sys_id` = sys_metadata0.`sys_id`) ORDER BY discovery_probes0.`name` limit 0,102
```
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery</td>
<td></td>
<td>Geneva - Linux CPU core count is not always correct</td>
<td></td>
<td>On a Geneva instance:</td>
</tr>
<tr>
<td>PRB683929</td>
<td></td>
<td></td>
<td></td>
<td>1. Install the Edge Encryption plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Install and configure the Edge Encryption proxy.</td>
</tr>
<tr>
<td>Edge Encryption</td>
<td></td>
<td>Setting edge_encryption to ‘true’ attribute on an edge-encrypted field has no effect - clear text insert is not allowed when it should be</td>
<td>Setting edge_encryption_clear_text_allowed to the ‘true’ attribute on an edge-encrypted field allows the insertion of unencrypted data. This functionality is broken - clear text data inserts are not allowed even when the attribute is present and set to true.</td>
<td></td>
</tr>
<tr>
<td>PRB670270</td>
<td></td>
<td></td>
<td></td>
<td>4. From the Asset list view, click the hamburger icon &gt; Dictionary &gt; Comments &gt; Advanced View.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Add edge_encryption_clear_text_allowed=true attribute (comma-separated), and update.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. From the proxy: add a new record and verify Comments are encrypted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7. From the instance: add new record, verify that it was created properly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8. Upgrade the instance to Helsinki.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>9. Try to update the record from the instance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Notice that the update fails.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Forms PRB603857 |                 | Autocomplete issues with double-byte character set (DBCS) (Japanese and Chinese) | When double-byte alphabets are used in the Caller field, the Caller Option field does not appear. | 1. Start Windows 7 in a VM.  
2. Navigate to Control Panel \ Region and Language.  
3. Set the Language to Japanese.  
The language bar appears after the change.  
4. In a ServiceNow instance, navigate to Incident \ Caller Option.  
5. a. Single-byte characters:  
Choose “半角英(#(P))” in the language bar. Type “ab” in Caller field. The Caller Option appears.  

Note: “半角英 #(P)” is single-byte alphabets.  

Double-byte characters:  
Choose “全角英 #(L)” in the language bar. Type “ab” in Caller field.  

Note: “全角英 #(L)” is double-byte alphabets.  

b. Type “fn” key + F10 (Mac keyboard).  
Double-byte “ab” is converted to single-byte “ab”.  

Note: the Caller Option does not appear right away.  

c. Hit Space key and the backwards key.  
Then, the Caller Option appears. |
| Human Resources Application: Service Portal PRB69883 |                 | Breadcrumb link goes missing after you click ‘Service Catalog’ link in Service Portal | The ‘sc_view’ page in Service Portal: Core does not seem to contain any breadcrumbs. | 1. Navigate to the HR Service Portal.  
2. Open any catalog item by navigating to Benefit \ 401k.  
3. From the breadcrumbs, click Service Catalog.  

Notice that the whole link goes missing. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| HR Service Management | HR Profile module has active is true filter - needs to be updated to user.active | PRB70468          | HR Profile module currently has Active is true filter (bad), but it should be user.active = true instead. | 1. Install HR core plugin.  
2. Navigate to HR profile module.  
Notice that filter is active = true and nothing is returned (bad). It should be be user.active = true instead. |
| Import / Export       | When importing groups from LDAP, one group is dropped | PRB684827         | When importing groups from LDAP, one group is consistently dropped on the import and another group is imported twice on the staging table. | Refer to the listed Known Error KB article for details.                                                  |
| Knowledge Management  | Vertical scroll bar is not enabled for $knowledge.do inside iframe in ESS portal | PRB660783         | This issue also occurs when navigating to /ess/knowledge_splash.do.           | Refer to the listed Known Error KB article for details.                                                  |
| Knowledge Management  | Knowledge Search does not return results after clicking on the “Home” button | PRB668730         | When using knowledge search and searching for a keyword (e.g. “vpn”), the results show up. Afterwards, if a user clicks on the “Home” button and tries to search again by typing “vpn”, they see the message “Your search did not return any results for vpn”. | 1. Go to the knowledge homepage.  
2. Type in vpn and click Enter.  
   The results show up.  
3. Click the Home button.  
4. Re-type vpn in the search.  
   The message “Your search did not return any results for vpn” shows up. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Knowledge Management | PRB675065 | Knowledge Management | Knowledge article ampersand error when escape text is false, knowledge attachment has & in title and is displayed on article | 1. Set escape text to false: `/nav_to.do?uri=sys_properties.do?sys_id=a7e8db450a0a0b0a308ab5de097b58ab23f45be100860f413100b800a30d501a6b3`  
2. Bring up any article in edit mode (e.g. `/nav_to.do?uri=kb_knowledge.do?sys_id=022830860f413100b823f45be100b800a30d501a6b3`).  
3. Check the Display attachments checkbox and Save.  
4. Add an attachment to the article that has an & in the file name.  
5. Click View Article.  
Expected behavior: You can see the article.  
Actual behavior: You see an ampersand error (this varies based on the positioning of ampersand and version). |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Knowledge Management V3                 | Knowledge Management V3 | The “Most Useful” section on the Knowledge home page does not sort properly       | The ‘Most Useful’ section on the Knowledge homepage does not display articles based on the kb_feedback.useful field. This field is set when a user votes that a knowledge article is helpful.                                                                 | 1. Navigate to the Knowledge home page. Note the articles that are displayed in the Most Useful section.  
2. Navigate to the kb_feedback table.  
3. Add the Useful column to the list (if not already displayed).  
4. Filter the list by:  
   • Article.Published=True  
   • Article.Knowledge_Base.Active=True  
   • Useful=Yes  
5. Group the articles by Article.Short description.  
6. Compare the articles on this kb_feedback list to what was displayed in the Most Useful section on the Knowledge home page. The articles in the Most Useful section are not displayed by Article.Published=True, Article.Knowledge_Base.Active=True, and Useful=Yes with the articles with the highest Useful=Yes count at the top of the section. (Note that the number of items shown in the section is governed by glide.knowman.content_block_limit.) |
<p>| Knowledge Management V3                 | Knowledge Management V3 | kb_home and kb_find do not render if knowledge base names include ampersand (&amp;) and glide.ui.escape_text is false | Knowledge homepage (kb_home) and search page (kb_find) do not render if knowledge base names include an ampersand (&amp;) and glide.ui.escape_text is false. This problem is reproducible in Geneva and Helsinki.                                                                 | Refer to the listed Known Error KB article for details. |
| KnowledgeManagement PRB679376           | Knowledge Management V3 | kb_home and kb_find do not render if knowledge base names include ampersand (&amp;) and glide.ui.escape_text is false | Knowledge homepage (kb_home) and search page (kb_find) do not render if knowledge base names include an ampersand (&amp;) and glide.ui.escape_text is false. This problem is reproducible in Geneva and Helsinki.                                                                 | Refer to the listed Known Error KB article for details. |</p>
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge v3</td>
<td></td>
<td>Knowledge v3 filter options not shown for non-admins when the property named glide.invalid_query.returns_no_rows is set to True.</td>
<td>When glide.invalid_query.returns_no_rows is set to True, the knowledge filters (knowledge base, categories) are not shown. Knowledge search page ($knowledge.do). This unexpected behavior only occurs for non-admin users.</td>
<td>In a Geneva instance: 1. Enable a system property named glide.invalid_query.returns_no_rows and set it to true (create it if necessary). 2. Impersonate a non-admin user. 3. Navigate to Knowledge &gt; Homepage (or $knowledge.do). 4. Search for a keyword. Note that filters (knowledge base, categories) are not shown. However, if glide.invalid_query.returns_no_rows is set to false, the filters display as expected.</td>
</tr>
<tr>
<td>Language and Translation</td>
<td></td>
<td>Service Portal translations need to be added to Helsinki.</td>
<td>The fix for this PRB adds translations for Service Portal to Helsinki.</td>
<td></td>
</tr>
<tr>
<td>MID Server</td>
<td></td>
<td>SNC_SSHSession status is still OK after session being closed by server.</td>
<td>When a SNC SSH session is closed by the SSH server, the session status is still OK. Since the session is pooled and its status is OK, the next time a probe gets a bad session, it will think it is a good one. This causes an error in the MID Server log.</td>
<td>1. Run a SSHCommand probe against a Linux machine. 2. After the probe is finished, reboot the Linux machine. 3. Run the probe against the same Linux machine. Expected result: Step 3 should return the result. Actual result: You see the following error message in the MID Server log: SSHCommand SEVERE *** ERROR *** Error opening SSH exec job: Error; job finished with status ERROR: Problem in SSH session, job aborted: Session closed during channel open</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server</td>
<td>PRB689004</td>
<td>NullPointerException when JDBC connection string embeds username/password directly in connection string</td>
<td>Using the JDBCProbe and GigDBUtil script include to create an XML to get/send data to an Oracle Database works as expected in Fuji, but in Helsinki it causes an error.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td></td>
<td>KB0597413</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MID Server</td>
<td>PRB691899</td>
<td>SCPRelay fails with error, “Target directory <code>/your/path/here</code> does not exist or is not writable or executable.”</td>
<td>When copying a file or files with SCPRelay, the probe may fail to find the path specified for the target device. It erroneously looks on the source to validate the path of the target.</td>
<td>Use SCPRelay to transfer a file into a directory that does not exist on the source. The check for the existence and writability of the target directory fails, causing the command to fail.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>MID Server</td>
<td>CyberArk</td>
<td>PRB704676</td>
<td>For SSH credentials, Discovery supports basic (username/password) and SSH Keys. In order to support users with multiple credentials on the same IP address, a fix was introduced that would validate that the credential returned was of the correct type. Prior to this fix, if you ask for basic credentials and only SSH Keys are available, SSH Keys were returned. The types are now validated from CyberArk. However, this does not account for users who create custom credential types. These will not work, as they are neither SSH or SSH Keys types. The fix for this PRB adds a configurable parameter (ext.cred.check_ssh_type) to the config.xml MID Server file that enables you to enable/disable the check for credential type. The default is off, which was the old behavior. See the following topics for details:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• <a href="#">CyberArk integration configuration</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• <a href="#">Configure the MID Server for CyberArk</a></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Mobile PRB690498 | Subcategory      | Incorrectly shows values for all Categories when Category is null | The dependency from Subcategory to Category does not work on mobile UI, whereas it works as expected on the desktop UI. | In a Helsinki instance:  
1. Open any Incident form.  
2. Switch view to Mobile.  
3. Configure the form layout, including the Subcategory field below the existing Category field.  
4. Activate the Mobile UI: /$m.do.  
5. Open an incident form, and click the Category drop-down choice list.  
6. Set the Category to Null.  
7. Expand the Subcategory drop-down list.  
Notice all subcategories are shown. In the desktop UI this would show an empty list, only populated after the parent Category is set. |
| Orchestration PRB682428 | Enable AD user object activities are not setting UAC to correct values | When running the Enable or Disable AD user object activities, the functions in the activedirectory.psm1 module are not setting the useraccountcontrol values correctly. | 1. Activate the Orchestration plugin.  
2. Open the Workflow Editor.  
3. Create a workflow that includes the Enable or Disable AD User Account activity.  
4. Fill out the required fields.  
5. Run the workflow. |
<p>| Persistence PRB662782 KB0597336 | MySQLCancel may kill future query if the current one has already finished before the kill statement was issued | Due to a bug in the MySQL Server, the kill query ‘PID’ statement may kill a future query on this connection if the current query has already finished before the kill statement was issued. | Refer to the listed Known Error KB article for details. |</p>
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform Security</td>
<td>PRB702008</td>
<td>Password 2 columns still have short lengths after Helsinki upgrade</td>
<td>1. Short Password 2 columns are not getting their lengths changed to 255 upon upgrade. This will break when storage encryption is activated with following error: 2016-07-22 10:12:10 (377) main SYSTEM StorageEncrypter: Starting re-encryption for table: sys_email_account column: password 2016-07-22 10:12:10 (432) main SYSTEM SEVERE *** ERROR *** StorageEncrypter: Failed to decrypt string starting with: {ht:2+Nv3O...</td>
<td>Issue 1 1. Create a short password2 column. 2. Upgrade the instance. Note the short password2 column still exists.</td>
</tr>
<tr>
<td>Policy and Compliance</td>
<td>GRC: Audit Management</td>
<td>‘Update All’ in the test template does not apply changes to the test plans as expected</td>
<td>After creating a Test template in a Policy statement, if a user makes some changes, they need to save the record first in order to click Update All (this is intermittently reproducible). However, even if the record is saved, those changes are not applied correctly to the test plans.</td>
<td>Issue 2 1. Set the password2 business rule to active = false. 2. Upgrade the instance. Note the business rule is in a state where active=false and has read-only protection policy.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Management PRB690164</td>
<td>Project Management, Project Portfolio Suite</td>
<td>Adding key_milestone column to the planned_task table takes over 2 hours on upgrade of large dataset</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Reporting        | PRB674589        | PDFReportPivot    | High memory is caused by a background thread. PDFReportPivot is stuck in addRows things. | 1. Create a report with the following values:  
   - Table: sys.audit  
   - Type: Pivot Table  
   - Row: Document Key  
   - Column: Document Key  
   - Aggregation: Count  
   - No. groups: Show all  
2. Click Save.  
   Note there is no `Export to PDF`. If the table is large enough, the UI transaction will be canceled. But a record in sys_report table will be generated.  
3. Go to sys_report, select the record you just inserted and click Edit report.  
   Then, the `Export to PDF` choice will show up.  
4. Click Edit report.  
   OOM will occur. The OOM issue also occurs when scheduling a big pivot table PDF report such as this. |

```
2016-04-26 05:46:39 (047)
glide.background.generation.4409af0513871200dc983262f244b0cf
SYSTEM WARNING ***
WARNING *** Large Table: Table handling an extremely large result set: 387763
Query that got us here is:
TABLENAME = sys_report_summary_line
ENCODED_QUERY = summary=1379a3451387120dc983262f244b0cf
com.glide.db.QueryWarning.warn(Quad
com.glide.db.DBQuery.loadResultSet(DBQuery.java:2297)
com.glide.db.DBQuery.executeAndReturnTable(DBQuery.java:237)
com.glide.db.DBAction.executeNormal(DBAction.java:197)
com.glide.db.DBAction.executeAndReturnException(DBAction.java:166)
com.glide.db.RDBMSQueryContext.executeQuery(RDBMSQueryContext.java:46)
com.glide.db.DBQuery.execute(DBQuery.java:1782)
com.glide.db.meta.Table.queryBasic(Table.java:189)
glide.script.GlideRecordITable.query(GlideRecordITable.java:77)
glide.script.GlideRecord.query0(GlideRecord.java:2982)
glide.script.GlideRecord.query(GlideRecord.java:2707)
glide.ui.chart.dataset.SummaryTableReader.getSummaryLines(SummaryTableReader.java:200)
glide.ui.chart.dataset.SummaryTableReader.get(SummaryTableReader.java:26)
glide.report.PDFReportPivot.generateHeader(PDFReportPivot.java:58)
glide.report.PDFReportPivot.generate(PDFReportPivot.java:33)
glide.generators.ReportPDFExporter.generate(ReportPDFExporter.java:23)
glide.generators.BackGroundGenerationThread.run(BackGroundGenerationThread.java:67)
Thread dump:  
“glide.background.generation.4409af0513871200dc983262f244b0cf”  
prio=10 tid=0x53370c00  
nid=0x22bd0 runnable  
[0x4f6ad000]  
java.lang.Thread.State:  
RUNNABLE  
at com.itextpdf.text.pdf.FontSelector.process(FontSelector.java:103)  
at com.glide.generators.PDFFont.process(PDFFont.java:105)  
at glide.report.PDFReportPivot.addCell(PDFReportPivot.java:144)  
at glide.report.PDFReportPivot.addMissingData(PDFReportPivot.java:136)  
at glide.report.PDFReportPivot.addRowValues(PDFReportPivot.java:120)  
at glide.report.PDFReportPivot.addRows(PDFReportPivot.java:109)  
at glide.report.PDFReportPivot.generate(PDFReportPivot.java:34)  
at glide.generators.ReportPDFExporter.generate(ReportPDFExporter.java:23)  
at glide.generators.BackGroundGenerationThread.run(BackGroundGenerationThread.java:67)  
```
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog</td>
<td></td>
<td>Catalog UI policies do not work if write role is applied to variables used in the condition for non-admin users.</td>
<td>Catalog UI policies do not work if the write role is applied to variables used in the condition for non-admin users. For the variable with ‘nobody’ write roles on the RITM record, g_form.getValue() returns Choice Text instead of Choice Value.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>PRB668721</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>KB0597431</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Catalog</td>
<td>Service Catalog</td>
<td>The Display/Hide List button disappears on Related Lists in tabbed view when the incident variable editor is present on the incident form.</td>
<td>After configuring the incident form layout to include the incident variable editor, related lists no longer show the display/hide list button while in tabbed view. The incident variable editor appears to be attaching a style sheet, which causes the issue.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>PRB670586</td>
<td>Plugin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>KB0595994</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Catalog  | PRB679673       | Select Box variable that is filled by a Catalog Client Script will show as empty when accessing it from the RITM form. | Using a Select Box variable filled by a Catalog Client Script will show as empty when accessing it from the RITM list. The list for the Select Box works as expected when opening the Catalog Item. After it is submitted, the RITM form will incorrectly show this variable as empty. Even though the variable is stored in the sc_item_option_mtom table, the variable is not shown in the form, and the list for the Select Box variable in the RITM form is empty / blank. | In a Helsinki instance:  
1. Navigate to an OOB Catalog Item (e.g. Acrobat).  
2. Create a new variable for it with the following:  
   - Type: Select Box  
   - Question: Select Box Variable  
   - Name: select_box_variable  
3. Save.  
4. Create a new Catalog Client Script as follows to fill the new variable with all users from a department (e.g. Development).  
   - Name: Fill new variable list  
   - Type: onLoad  
   - Applies to: A Catalog Item  
   - Script:  
     ```javascript  
     function onLoad()  
     {  
         var filter = '221f3db5c6112284009f4becd3039cc9';  
         var gr = new GlideRecord('sys_user');  
         gr.addQuery('department', filter);  
         gr.query();  
         while (gr.next())  
         {  
             g_form.addOption('select_box_variable', gr.user_name, gr.user_name);  
         }  
         g_form.removeOption('select_box_variable', '');  
     }  
     ```  
5. Save.  
6. Try the Acrobat Catalog Item.  
   Notice the new select box is filled up with the users from the Catalog Client Script.  
7. Submit the item and access the RITM opened for it.  
   Expected behavior: We should be able to see the user assigned to this variable / RITM. You can confirm that the variable is filled in...
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog</td>
<td>PRB690516</td>
<td>Changes in behavior regarding UI policies and controlling visibility of Containers and Variables, Variable-sets within a Container.</td>
<td>When there is one UI policy that is meant to &quot;hide&quot; a container with its variables, and there is a second UI policy where if it sees the value of a certain variable within the container, it will show a different variable in that container. It breaks by showing the container and some of the variables inside, even though it is supposed to be hidden. This issue occurs after upgrading from Geneva or Helsinki instances to Helsinki Patch 1.</td>
<td></td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB697017</td>
<td>Error in the log &quot;(73)AbstractDiscoveryResults - Could not find host for ci id: e460f5a2db682 no thrown error&quot;</td>
<td>As a result of this error, Service Mapping is not calculating network paths from included CIs 30014a7d2e1f4a6d: Tomcat WAR, 200814a2e27f4a6d: Websphere EAR, etc.</td>
<td></td>
</tr>
</tbody>
</table>
| Service Portal   | PRB674495       | Exporting the list of open issues includes fields not in the view | Exporting a list to Excel or PDF might include a different set of columns from that seen in the list. | 1. Go to the Service Portal page ? id=list&t=incident&view=ess.  
2. Click the hamburger icon > select Export as Excel.  
3. Download and open the Excel file.  
The columns in the spreadsheet should be the same as those in the list, but the View is not getting passed correctly. |
| Service Portal   | PRB677431       | Service Portal Designer Keyboard shortcuts do not work on Service Portal designer | 1. Open the Service Portal Configuration > Designer.  
2. Open a page (e.g. /index).  
3. Click the properties of a widget instance (e.g. the How can we help you search bar).  
4. Change the title and try to save by using the keyboard shortcut (CTRL or CMD + S).  
Note that a browser ‘save’ dialog appears. The keyboard shortcuts seem to work in the widget editor. | |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal   | PRB677937        | Service Portal - glyphicon field type generates JS error on change in form | Users see the following JS error: "Cannot read property '$element' of undefined". This error comes from tooltip.js. | 1. In the normal UI, open the sp_instance form.  
2. Change glyph field.  
Note the JS error "Cannot read property '$element' of undefined". |
| Service Portal   | PRB681328        | Uploaded background image does not save when creating a new Service Portal carousel slide and only saves if slide is already created | The carousel widget in Service Portal allows you to show multiple slides that rotate on a timed interval basis. When creating a new slide for a carousel, you are given the ability to upload a background image for the slide at the same time. If you upload this image at the same time, after the record has saved and the page reloads, the image for the record is not set. If you upload the image again now that the record has saved, the image uploads and applies to the carousel slide successfully. | In a Helsinki instance with the ‘Service Portal for Enterprise Service Management’ plugin activated:  
1. Log into the instance as a user with elevated privileges.  
2. Navigate to the /sp URL on the instance.  
3. Click Order Something.  
4. Hold down the CTRL key, and click on the carousel in the top section of the page.  
5. In the menu that appears, click Instance Options > Carousel Slides > New.  
6. Set the Name field to PRB681328.  
7. Click Upload an image and choose any image you have on your computer. Wait for the image to upload and display on the page next to the ‘Background’ text.  
8. Click Save.  
9. Repeat steps 7 and 8.  
Expected behavior: The image saves successfully after step 8 and thus step 9 is not necessary.  
Actual behavior: The image doesn’t save successfully after step 8, and so you need to reupload the image and save the record again. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal PRB681368</td>
<td>Service Portal branding editor, page editor and widget editor do not work in Oracle instances</td>
<td>If a user’s instance is in Oracle, Service Portal widgets with server script, template, CSS, and client scripts that has more than 4,000 characters are are trimmed out. This prevents widget editing and Service Portal configuration from working properly.</td>
<td>1. Provision an Oracle instance in Helsinki. 2. Activate the ‘Service Portal for Enterprise Service Management’ plugin. 3. Go to sp_widget and check widgets with names ‘form’ and ‘Portal config’. Note the template, client script and/or server script is cut off after 4,000 characters.</td>
<td></td>
</tr>
<tr>
<td>Service Portal PRB681375</td>
<td>Relative dates on the Service Portal are hardcoded and do not look at the system date/time format</td>
<td>In a Helsinki instance: 1. Navigate to System Properties &gt; Basic configuration. 2. Check the system date, and define it as dd/MM/yyyy. 3. Open any knowledge article (e.g. KB00000007: What is a cookie?) and change the published date of the article to 01/06/2016 (1st June 2016). 4. Navigate to Service Portal &gt; Knowledge Base &gt; IT. Notice that KB00000007 shows the published date as 7d ago, which is correct. 5. Click the article. It shows the wrong published time for the same article.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Portal PRB682155</td>
<td>Service Catalog does not nest categories, and page takes long time to show when there are a lot of categories</td>
<td>In Service Portal, the Service Catalog page takes a long time to show when there are over 4,000 service records.</td>
<td>In a Helsinki instance: 1. Navigate to System Definition &gt; Scripts - Background. 2. Create multiple ‘sc_category’ records by duplicating one of them many times. 3. Now enter the URL for the Service Portal (https://&lt;instance_name&gt;.service-now.com/sp). 4. Click the Service Catalog. Note the page does not load, and it takes nearly 15-20 minutes to load.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Portal   | PRB68396         | Variables on Requested Item/Catalog Task record are missing when viewed from Service Portal. | Variables on Requested Item/Catalog Task record are missing when viewed from Service Portal. | In an instance with the Service Portal plugin active:  
1. Create a Request and add the Variable Editor to the form for this record.  
   Notice that the Variable Editor section is available on the form.  
2. View this record from the ‘Form Widget’ on Service Portal.  
   Note all the fields on the form are visible except the Variables section.  
Expected behavior: The variables section should be present.  
Actual behavior: The variables section is missing. |
| Service Portal   | PRB684486        | The action buttons on the approval widget are not rendering properly | The action buttons on the approval widget are not rendering properly | |
| Service Portal   | PRB684546        | Service Portal OOB widgets are not all using $\{\}$ for the texts, which then cannot be translated | Service Portal OOB widgets are not all using $\{\}$ for the texts, which then cannot be translated | Refer to the listed Known Error KB article for details. |
|                  | KB0597294        | For example, in the User Profile widget’s Body HTML template, the following text is not translated:  
• Line 24: at  
• Line 25: Works at  
• Line 63: User not found  
• Line 65: This user does not exist  
• Line 66: Suggestions:  
• Line 68: Contact your portal administrator.  
See PRB704707. | |

© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal   | PRB686132        | Reference icon on Service Portal is displayed regardless of the readOnly status of the reference field | The expected behavior of the UI is when a reference field is populated and configured to be readOnly, it should be hidden. | 1. Navigate to the (incident) table.  
2. Open any record.  
3. Right-click and configure dictionary on the following fields: caller_id, assignment_group, assigned_to.  
5. Open the Designer module.  
6. Configure a page to use the `simple list` widget. Use the (incident) table in the configuration.  
7. Preview the new page, and open an incident record where the caller_id, assignment_group, or assigned_to fields are populated.  

Expected behavior: The form should display the reference field content with no reference icon displayed beside it.  
Actual behavior: The form displays the reference field with no content. A reference icon is displayed that navigates to the referenced record. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal   |                  | Catalog Items of class 'Content Item' are not showing up in the new Service Portal but work as expected in the CMS portal | In a Helsinki instance:  
1. Activate the Service Portal plugin.  
2. Navigate to Service Catalog > Catalog Definitions > Maintain Items.  
3. Consider a Catalog Item Cisco Jabber 10.5 of class type Catalog Item in category ‘Software’.  
   Notice that the Catalog Item is visible in the new Service Portal under Software Category.  
4. Now modify the class of the item to Content Item.  
   Notice that ‘Cisco Jabber 10.5’ is no longer visible in the new Service Portal under Software Category.  
Expected behavior: ‘Cisco Jabber 10.5’ is visible in the Service Portal.  
Actual behavior: The Catalog Item ‘Cisco Jabber 10.5’ is not visible. |
| PRB686410        |                  |                  |             |                    |
| Service Portal   | Service Portal   | Service Portal   | When page-specific CSS (under Edit Page Properties) exists, CSS rules are not parsed and do not render in preview. | In a Helsinki instance:  
1. Open the Service Portal Designer.  
2. Select a page.  
3. Click Edit Page Properties.  
4. Add CSS under the Page Specific CSS field.  
5. Save.  
Expected behavior: CSS rules should be evaluated and rendered in the preview.  
Actual behavior: CSS rules are not parsed or rendered. |
| PRB689764        | Designer         |                  |             |                    |

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal   | Connect Support and Service Portal Integration | While adding Connect Support widget to Service Portal page, the widget gets added but is not visible. | If you click the area where you added the widget, the Connect Support app opens up. | In a Helsinki instance:  
1. Activate the Service Portal for Enterprise Service Management plugin.  
2. Activate the Connect Support and Service Portal Integration plugin. (This plugin requires Connect Support plugin as well.)  
4. Navigate to the Service Portal (index) page.  
5. Drag and drop the Connect Support widget beneath any of the widgets.  
6. Navigate to ‘Service Portal Home’.  
Note the widget was not added. However, if you click on the place where you added it, a Connect Support window opens. This does not occur for other widgets. |
| Service Portal   | Human Resources Application: Service Portal | Organization Chart widget in Service Portal Designer does not display as expected and cannot be edited. | The Organization Chart widget appears to be broken. When added to a portal page in the Service Portal Designer, users cannot see it, nor can they move or configure it. It appears to display properly in the portal. | 1. Navigate to Service Portal > Service Portal Configuration > Designer > User Profile (hrsp_user_profile).  
2. Search for the Organization Chart widget and drag it onto the page.  
Expected behavior: The widget is displayed, can be moved around, etc.  
Actual behavior: The widget is not displayed.  
Note: The widget is there - if you view the ‘my profile’ page in the HR portal as an admin or lower user, the organization chart will populate. If you add another instance of the widget to the page, both will show up. If you remove one of them, neither will show even though one is still there. |
### Service Portal PRB690497

**Problem category:** SPForm checks for policy on HR widgets and the value is empty

**Description:**
The Java class SPForm.java checks for the Policy on the form and also for forms that have empty values. There are three SP script includes that are unavailable for scoped apps, which is causing this issue:
- MobilePolicyBuilder
- SysForm
- SysSection

### Service Portal PRB690563

**Problem category:** Widget instance title, color, max_number cannot easily be configured for the 'My Requests' widget

**Steps to reproduce:**
1. Navigate to /sp?id=requests.
2. CTRL+right-click the My Requests widget.

Note that you cannot set the title, color, or max records.

### Service Portal PRB691208

**Problem category:** Using g_form.setValue inside of a g_modal confirm callback throws a $digest already in progress error

**Steps to reproduce:**
1. Create a sample catalog item with a single reference field variable.
2. Create an onChange client script for the reference field.
3. Use the following script:
   ```javascript
   g_modal.confirm("Are you sure?", "Do you want to change the value to: "+ newValue + "?", function(result) {
     if (!result)
       g_form.setValue("reference_field_variable_name_here", oldValue);
   });
   
   4. Use the catalog item in the catalog view in Service Portal.

Note the following error in the browser console:
```
Uncaught Error: [$rootScope:inprog] $digest already in progress
```
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>PRB691356</td>
<td>Select boxes with different fields and displaying choices based on one value using a catalog client policy work in the Catalog and not Service Portal</td>
<td>The issue is present in select box functionality in Service Portal pages. However, the same select box works as expected when tried from the normal Service Catalog.</td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB691606</td>
<td>Widget field on Variable form should only show for UI macro variable type</td>
<td>The Widget field on the Variable form should only show for UI macro variable type. It needs a UI policy.</td>
<td>Go to the Variable (item_option_new) form in the normal UI. The Widget field should be hidden when the variable type is anything other than Macro.</td>
</tr>
</tbody>
</table>
| Service Portal   | PRB691650        | Human Resources Application: Service Portal Duplicate pages in HR plugin result in double breadcrumbs | The HR plugin contains a duplicate page ID, 'sc_category’, which causes the page to have double breadcrumbs. The page needs to be removed from the HR plugin. | 1. Install the Service Portal Plugin and HR plugin at the same time.  
2. Go to UI16. The page 'sc_category’ should not have any containers that belong to the HR plugin. The page should only have two containers. |
| Service Portal   | PRB691661        | Related list links from Form widget do not inherit view from the form | This is inconsistent with the normal UI, where view is inherited. | 1. Open an existing Problem record in the id=form page. Make sure the Problem has related Incidents.  
2. Append &view=itil to the URL.  
3. Click the link for the Incidents related list to view the list of related Incidents. The URL should also have &view=itil in the URL, but it does not. |
<p>| Service Portal   | PRB691963        | lookup.label is not used for variable types ‘Lookup Select Box’ and ‘Lookup Multiple Choice’ | On the Service Portal catalog item page, a variable type of lookup select box is using the mobile view to determine the display label, not the lookup.label specified on the variable. |                     |</p>
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>Service Portal Social QA</td>
<td>Variable labels are not translated in the “Options” section of ticket fields widget</td>
<td>See PRB704707.</td>
<td>Using Service Portal in a language other than English:</td>
</tr>
<tr>
<td>PRB692379</td>
<td></td>
<td></td>
<td></td>
<td>1. Use the Create new Incident record producer. Note that variable labels are translated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Submit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. View the resulting Incident in the id=ticket page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note that the variable labels in the Options section of the ticket fields widget are in English, not your current language.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the widget editor, if you open a widget that has dependencies, a JavaScript error might appear in the console</td>
<td>If you open the form widget you will see the following error in your browser’s JavaScript console: Uncaught SyntaxError: Unexpected token o in JSON at position 1</td>
<td>1. Open /sp_config?id=widget_editor&amp;sys_id=fd1f4ec347730200ba13a5554ee490c0.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Look at your browser console.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In Subscribed Questions, header color cannot be set from instance options</td>
<td>When using the designer, a user cannot change the panel header color of the ‘My Subscribed Questions’ widget. Clicking the edit icon will result in an empty module.</td>
<td>1. Make sure you have the plugin ‘com.glide.service-portal.sqanda’ installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Go to /sp?id=sqanda_new_question and ask a new question.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Go to /sp and make sure your question shows up on the homepage in a panel titled ‘My Subscribed Questions’.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Hold control + right-click on that panel and select Page in Designer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. In the designer, click the edit arrow on the ‘My Subscribed Questions’ panel. Observere there is no field to edit the Bootstrap color.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB692894</td>
<td>Variable attributes to show additional columns do not work if the column is not on the list (ref_auto_completer=AJAXTableCompleter, ref_ac_columns=street, ref_ac_columns_search=true, ref_ac_display_value=false)</td>
<td>In the Service Portal, when using the following Variable attributes of a variable to show additional columns from the cmn_location table in a form field (see below), only show in the portal after they are added to the Default List Layout of the cmn_location table. ref_auto_completer=AJAXTableCompleter, ref_ac_columns=street, ref_ac_columns_search=true, ref_ac_display_value=false</td>
<td>In a Helsinki instance: 1. Activate this record OOB producer “Ask a Question”: /sc_cat_item_producer.do?sys_id=66c313e7c0a8016b008ebe1a8e3d97f5. 2. Add a variable:  • Type: Reference  • Question: Location  • Reference: Location(CMN_location)  • Use reference qualifier: Simple  • Attributes: ref_auto_completer=AJAXTableCompleter, ref_ac_columns=street, ref_ac_columns_search=true, ref_ac_display_value=false</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB694504</td>
<td>Attribute HTML needs to follow the Web Content Accessibility Guidelines</td>
<td>The attribute HTML requires the inclusion of the lang attribute with the current language to follow the Web Content Accessibility Guidelines.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Portal PRB694964 | Service Portal Social QA | After activating ‘Service Portal Social QA’ plugin, users are able to create scoped applications | The Create button is enabled, and the user can create a scoped application. | 1. Log in as admin.  
2. Impersonate abel.tuter.  
   Note the following message is displayed: “Insufficient privileges to create custom applications.” The Create button is also disabled.  
5. Log in as admin.  
6. Impersonate abel.tuter.  

<p>| Service Portal PRB696043 | | If you select include ‘on page load’, the module is listed in all portals | If you select include ‘on page load’, it should display a list of portals to select the portal in which you would like to load the module. | |
| Service Portal PRB696436 | Mobile UI | Catalog UI policies to set field read-only are getting applied on fields in Order Guides in Service Portal, even though ‘Applies on a Catalog Item view’ is not checked | Catalog UI policies are not working as expected on Service Portal order guides. | |</p>
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal   | NG shared       | Inconsistency on placeholder ‘required’ | On catalog items, when creating a UI policy to set a field as mandatory, the placeholder ‘required’ is added. However, the placeholder style are inconsistent. It is only displayed when a user creates a variable of type ‘date/time’. If it is a single-line text variable, the placeholder will not be displayed up, even if the field is set to mandatory by creating a UI policy. When the a field is set to mandatory based on a UI policy condition, the placeholder will not be displayed at all, but the field will be mandatory. | 1. Go to the Repair Office Equipment catalog item.  
2. Add Variable 1:  
   - Type: Date  
   - Question: Start Date  
   - Name: start_date  
   - Save.  
3. Add Variable 2:  
   a. Type: Single line text  
   b. Question: Uno  
   c. Name: Uno  
   d. Save.  
4. Set these two fields to Mandatory by creating a UI policy:  
   - On the same catalog item (Repair Office Equipment), go to Catalog UI policies > New.  
   - Short description: mandatory  
   - Save.  
5. Add a new Catalog UI policy action:  
   - Variable name: Start Date  
   - Mandatory: True  
6. Add another UI policy action:  
   - Variable name: Uno  
   - Mandatory: True  
7. Now go to the Service Portal: /sp?id=sc_cat_item&sys_id=d4254493c611227a0135f7f3b66f4bf5.  
   Notice the placeholder ‘required’ is displayed only on the date/time field. Both are mandatory fields, but it is only displayed on one of them.  
8. Set a condition to trigger the UI policy  
   - Go to the policy Mandatory  
   - On ‘Catalog Conditions’  
   - Select: Uno is not empty  
9. On the ‘Catalog UI Policy Actions’ section:  
   - On start_date  
   - Select: false  
   - Save.  
10. Go to the Service Portal: /sp?id=sc_cat_item&sys_id=d4254493c611227a0135f7f3b66f4bf5.  
   Type anything on the field Uno so that the field ‘Start Date’ will not be mandatory anymore, since we triggered the condition. Notice the the field’s start date is no longer mandatory, but the placeholder ‘required’ is still visible. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td></td>
<td>ref_ac_columns</td>
<td>ref_ac_columns does not work for reference fields in Form widget</td>
<td>1. In the Service Portal, go to page ?id=form&amp;table=sc_cat_item&amp;sys_id=-1 2. Populate the catalog. 3. Click to show dropdown options for the Category field. Each category in the dropdown should also show the Catalog it belongs to, as this is defined as an additional field in the ref_ac_columns Dictionary attribute.</td>
</tr>
<tr>
<td>PRB697053</td>
<td></td>
<td>Service Catalog</td>
<td>SP catalog client scripts should include translated messages</td>
<td>Using getMessage(KEY) in a catalog client script only works if the key is already loaded or if providing a callback. The catalog client scripts should load the list of translated messages. See PRB704707. 1. Open any catalog item that can be viewed from Service Portal. 2. In the catalog item:  • Add an onload client script with the following code: alert(getMessage(&quot;my key&quot;)) .  • Add the messages field to the client script form, and add this text on its own line: my key 3. In a new tab, go to: /system_properties_ui.do?sysparm_category=i18n&amp;sysparm_title=System%20Localization. 4. Check the box for Displays translation prefix on translatable strings. 5. Using Service Portal, open the catalog item from step 1. The alert should say: &quot;MSG: my key&quot;. This indicates that the key is loading a translated message.</td>
</tr>
<tr>
<td>PRB698278</td>
<td>Service Catalog</td>
<td></td>
<td>Variables whose names match target record field names should automatically map, as in the normal Catalog.</td>
<td>1. Go to the Create a New Incident record producer in Service Portal. 2. Provide a user and short description. 3. Click Submit. The resultant Incident will not have a short description or caller values. Following the same steps through the normal catalog work as expected.</td>
</tr>
<tr>
<td>PRB698680</td>
<td>Record Producers</td>
<td></td>
<td>Variables whose names match target record field names should automatically map, as in the normal Catalog.</td>
<td>1. Go to the Create a New Incident record producer in Service Portal. 2. Provide a user and short description. 3. Click Submit. The resultant Incident will not have a short description or caller values. Following the same steps through the normal catalog work as expected.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Portal   | PRB698771        | In Firefox, upon creating a new widget, the user is not redirected to the widget edit panel | 1. In Firefox, navigate to /sp_config?id=widget_editor.  
2. Click Create a New Widget.  
3. Fill out the required fields.  
4. Click Submit Query.  
That text should also be updated.  
Expected behavior: Upon creating the widget, the user should be redirected to /sp_config?id=widget_editor&sys_id=(widget_sys_id here).  
Actual behavior: The sys_id appears to be appended to the URL for a split second, but the user is brought back to /sp_config?id=widget_editor. | |
| Service Portal   | PRB699735        | In the Widget Editor, schema options added to a widget do not appear after saving and clicking 'Edit options schema' again | In a Helsinki instance with Service Portal activated:  
1. In the widget editor, add schema options to a widget.  
2. Save.  
3. Click Edit options schema.  
Note the schema options do not appear in the widget. | |
| Service Portal   | PRB700124        | Service Portal lists do not support dot-walked columns | When viewing lists in Service Portal with dot-walked columns, the dot-walked columns are left off. This occurs when viewing a list view configured in regular client and then viewed in Service Portal.  
Note that the view has three columns in the navigator interface. | 1. Create a new list view using sc_req_item containing number, cat_item, and cat_item.category.  
2. Go to the Service Portal Designer and select SP portal.  
3. Create a new page and add a Data Table from URL definition to it, submit, and then navigate to the page.  
4. On the page created in step 3, add &table=sc_req_list&view=test_view.  
Note that the list only shows two columns. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal   | sp_editable_field | does not contain I18N translations for “Empty” | 1. Go to a user profile.  
2. Note that “Empty” is not translated for fields with no value. |
| PRB700358        | Text in 404 page of HTML widget is not translated | See PRB704707. | 1. Go to 404 page.  
2. Note that the text at top of the page is not translated. |
| Service Portal   | Service Portal not displaying -- NONE -- in dependent choice list field | The --None-- option is missing on choice fields which should start with -- None--. | 1. Navigate to an incident form in Service Portal and view, for example, the subcategory field.  
2. Note that is empty (not showing --None--), and the first “option” is empty.  
This should be --None-- to mimic the behavior of ServiceNow forms. |
| PRB701328        | There is no ‘None’ Glyph to remove a glyph once added to Service Portal | Users can add a Glyph to the Service Portal page, but they cannot remove it. | In a Helsinki instance with the Service Portal plugins activated:  
1. Navigate to the Service Portal.  
2. Click Page Editor.  
3. Add a Glyph to the page.  
Once you add a glyph, you can change the glyph, but you cannot remove it from the UI. There should be an option so that users can choose a blank icon to denote a ‘null’ glyph. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>PRB702356</td>
<td>Record producer</td>
<td>This is inconsistent with</td>
<td>1. Create a record producer with a checkbox variable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>saves false</td>
<td>the platform UI.</td>
<td>2. Order it in Service Portal, leaving the checkbox unchecked.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>checkbox</td>
<td></td>
<td>3. Look at the entry in the question_answer table. The value will be empty.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>variables as</td>
<td></td>
<td>4. Navigate to the same record producer you created in step 1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>null instead of</td>
<td></td>
<td>5. Order it in the normal catalog UI.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>‘false’</td>
<td></td>
<td>The value will be the String ‘false’.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Service Portal should be consistent with the platform UI.</td>
</tr>
<tr>
<td></td>
<td>PRB702361</td>
<td>Column</td>
<td>sp_reclassify_rectangle_to_instance.js</td>
<td>1. Look at a Dictionary entry for the sp_rectangle_menu_item.sp_rectangle_menu_item field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sp_rectangle_menu_item of table</td>
<td>incorrectly changes the reference value of sp_rectangle_menu_item.sp_rectangle_menu_item field. The reference value should be sp_rectangle_menu_item instead of sp_instance_menu_item.</td>
<td>2. The reference value should be sp_rectangle_menu_item, but it is sp_instance_menu_item.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sp_rectangle_menu_item has a reference to a table that does not exist.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PRB703062</td>
<td>sc_cat_item</td>
<td>Due to sc_cat_item, catalog Item descriptions are not rendering properly.</td>
<td>In a Helsinki instance:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>should trust and</td>
<td></td>
<td>1. Install the Customer Service Portal (com.glide.service-portal.customer-portal).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fully render the</td>
<td></td>
<td>2. Log out.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Catalog Item</td>
<td></td>
<td>3. Open the /csm portal page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>description</td>
<td></td>
<td>4. Log in as admin/admin.</td>
</tr>
<tr>
<td></td>
<td>Customer Service</td>
<td>The CS portal</td>
<td></td>
<td>Expected result: After login, the page should redirect to &quot;service-now/csm&quot;.</td>
</tr>
<tr>
<td></td>
<td>Portal PRB707330</td>
<td>login page</td>
<td></td>
<td>Actual result: After login, the page redirects to &quot;service-now/navpage.do&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(using SP login widget)</td>
<td>redirects to &quot;/navpage.do&quot; instead of &quot;/csm&quot; after login</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Surveys          | NG shared components | Image scale choice selection popup - clicking 'upload an image' does not bring up the photo upload window | This issue occurs intermittently. | 1. Log in to an instance as a Survey admin or System admin.  
2. Create a survey.  
3. Navigate to the Survey Designer section of the survey.  
4. Add an Image scale question to the survey.  
5. Click the gear icon of the Image Scale question, select any choice, and click Upload an image to upload an image to the choice.  
Note that nothing happens. |
| Usage Analytics  |                  | Issue with usage tracking for Customer Service Management in the Unrestricted user model | Users can purchase CSM licenses in the Unrestricted user model, where the total number of users in the system are counted for compliance purposes. Customer Service is used to support end customers, and the employees of the customers are stored in the system as Contacts. Contact is created as an extension of the user table, so every contact gets stored in the user table.  
Since all entries in the user table are counted for license compliance, the contacts will also be counted. However, the CSM license considers all customer contacts as requesters, and they are excluded from the user count in the Unrestricted user model. Contacts should also be excluded from the user count for license audit and compliance purposes. |
### Problem category | Affected plugins | Short description | Description | Steps to reproduce
--- | --- | --- | --- | ---
User Interface (UI) | PRB698769 | Change form wrongly shows State choices from extension tables | Specialized changes have different states than standard changes. The standard change states are: open, pending, work in progress, closed complete, closed incomplete, and duplicate. If you open a request for a different type of change that has different states, the list displays all states instead of the ones specific to that change type. | 1. Extend change_request with a new table.  
2. Go to the form of that new table and configure the choices for the State field (i.e. add a new one, remove a couple existing ones).  
3. Go to the change_request form and look at the State choices.  
The new choice from the extension table is shown, but it should not show up for a Change Request. This does not occur in the normal UI. |

Web Services | PRB671549 | Extra call to getUser in HttpAuthProcessor may not be needed and is generating 4 extra SQL calls on each inbound request | Authenticating Web Service requests with user session/cookie information results in redundant SQL calls. In a very high volume use case such as Presence, this will negatively impact the performance of the request and the database. | 1. Log into a ServiceNow instance to create a user session.  
2. Turn on Debug SQL.  
3. Try to make a Web Service call, or wait for a Presence API request.  
Note that 4 additional calls are repeatedly made to get user roles, licenses, and preference data on each request. |

### Other Helsinki Patch 4 information

**Discovery**

- [CyberArk integration configuration](#)
- **Configure the MID Server for CyberArk**: Under ‘Optional configuration parameters,’ see ext.cred.check_ssh_type.

**Fixes included with Helsinki Patch 4**

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 3
- Helsinki Patch 2 Hot Fix 5

This release includes the HP2HF5 PRBs that were fixed in HP4. *

- HP4: PRB692216
- HP5: PRB702120
• HP6: PRB713397

• Helsinki Patch 2 Hot Fix 3
• Helsinki Patch 2 Hot Fix 1
• Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

• Helsinki Patch 1
• Helsinki Fixes

Helsinki Patch 3 Hot Fix 13

Helsinki Patch 3 Hot Fix 13 provides fixes for the Helsinki release.

For Helsinki Patch 3 Hot Fix 13: Build date: 01-23-2017_0939
Build tag: glide-helsinki-03-16-2016_patch3-hotfix13-01-17-2017

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 3 Hot Fix 13

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Management</td>
<td>Allocation Engine is generating lines very slowly</td>
<td>For some users, the ITFM Allocation Engine and its jobs run for a long time. For example, the Allocating Expenses job took 36 hours for a user. The long job duration occurred because millions of allocation lines were being generated for the user, and inserting the millions of lines took a long time.</td>
</tr>
<tr>
<td>PRB742326</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To maximize the engine’s performance and database space, the fix for PRB742326 provides the ability to generate allocation lines as needed. The cost model provides the additional options below to generate controlled allocation lines.

<table>
<thead>
<tr>
<th>Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Generate controlled cost lines</td>
<td>The itfm_allocation_aggregate table will only generate lines with the amount aggregated at the account level. To include sub-bucket information in the generated lines, select Include sub-bucket info.</td>
</tr>
<tr>
<td>Breakdown Relationships</td>
<td>In Breakdown Relationships, the user must explicitly define breakdowns as needed. This will generate additional breakdown allocation lines in itfm_allocation_breakdown to report on the relationship split between two segments.</td>
</tr>
<tr>
<td>Option</td>
<td>Result</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Choose segments for GL</td>
<td>Choose the segments for which general ledger (GL) expense lines are needed to report on the related GL lines for that segment. The expense lines for segments are in the itfm_allocation table.</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 3 Hot Fix 13

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 3 Hot Fix 11**
- **Helsinki Patch 3 Hot Fix 10**
- **Helsinki Patch 3 Hot Fix 9**
  The PRBs in HP3HF9 were also fixed in *
  - HP6: PRB709212
  - HP7: PRB622583

- **Helsinki Patch 3 Hot Fix 6**
  The PRBs in HP3HF6 were also fixed in *
  - HP4: PRB692216
  - HP6: PRB713556, PRB711226, PRB713397

- **Helsinki Patch 3 Hot Fix 5**
- **Helsinki Patch 3**
- **Helsinki Patch 2**

  Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- **Helsinki Patch 1 Hot Fix 1**
  This release includes the HP1HF1 PRBs that were also fixed in HP3. *
  - HP2 and HP3: PRB687962
  - HP3: PRB686241

- **Helsinki Patch 1**
- **Helsinki Fixes**

**Helsinki Patch 3 Hot Fix 11**

Helsinki Patch 3 Hot Fix 11 provides fixes for the Helsinki release.

For Helsinki Patch 3 Hot Fix 11: Build date: 11-14-2016 _1156
Build tag: glide-helsinki-03-16-2016_patch3-hotfix11-11-11-2016

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).

For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).
Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 3 Hot Fix 11

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Management PRB723145</td>
<td>Resource workbench does not respond when there is a large number of overlapping resource plans</td>
<td>When there are many overlapping resource plans, the workbench takes a long time to load and becomes unresponsive.</td>
<td>1. Create a large number of resource plans (around 70) for a single group with overlapping durations in a single year.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Select Group and choose the group for which resource plans were created.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Notice that it takes more than 15 seconds to load the workbench, and after that the page goes unresponsive.</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 3 Hot Fix 11

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 3 Hot Fix 10**
- **Helsinki Patch 3 Hot Fix 9**
  The PRBs in HP3HF9 were also fixed in *
  - HP6: PRB709212
  - HP7: PRB622583
- **Helsinki Patch 3 Hot Fix 6**
  The PRBs in HP3HF6 were also fixed in *
  - HP4: PRB692216
  - HP6: PRB713556, PRB711226, PRB713397
- **Helsinki Patch 3 Hot Fix 5**
- **Helsinki Patch 3**
- **Helsinki Patch 2**

  Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- **Helsinki Patch 1 Hot Fix 1**
  This release includes the HP1HF1 PRBs that were also fixed in HP3. *
  - HP2 and HP3: PRB687962
  - HP3: PRB686241
- **Helsinki Patch 1**
• Helsinki Fixes

Helsinki Patch 3 Hot Fix 10

Helsinki Patch 3 Hot Fix 10 provides fixes for the Helsinki release.

For Helsinki Patch 3 Hot Fix 10: Build date: 10-27-2016_0841 Build tag: glide-helsinki-03-16-2016__patch3-hotfix10-10-23-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 3 Hot Fix 10

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Management PRB673930 KB0584391</td>
<td>Long loading time of Allocations Setup page in ITFM Finance Workbench exceeds the default maximum run time, causing an error</td>
<td>The Allocation Setup page of the Financial Management Workbench ($itfm_workbench.do) can take a long time to load for large data sets, anywhere between 10 and 15 minutes. Because the background request to /xmlhttp.do to load the Allocation Setup page takes a large amount of time, it exceeds the default value 30000 (30 seconds) for the com.glide.request.max_run_time.ms system property. Subsequent requests are then returned by GlideRequestManager with the HTTP status “202 Accepted” with no content. Processing this status causes a &quot;Lost connection to the server&quot; message to appear.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 3 Hot Fix 10

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

• Helsinki Patch 3 Hot Fix 9
  The PRBs in HP3HF9 were also fixed in *
  • HP6: PRB709212
  • HP7: PRB622583

• Helsinki Patch 3 Hot Fix 6
The PRBs in HP3HF6 were also fixed in *

- HP4: PRB692216
- HP6: PRB713556, PRB711226, PRB713397

- Helsinki Patch 3 Hot Fix 5
- Helsinki Patch 3
- Helsinki Patch 2

Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- Helsinki Patch 1 Hot Fix 1
This release includes the HP1HF1 PRBs that were also fixed in HP3. *

- HP2 and HP3: PRB687962
- HP3: PRB686241

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 3 Hot Fix 6

Helsinki Patch 3 Hot Fix 6 provides fixes for the Helsinki release.

For Helsinki Patch 3 Hot Fix 6: Build date: 09-27-2016_1256
Build tag: glide-helsinki-03-16-2016__patch3-hotfix6-09-23-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.
For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 3 Hot Fix 6

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI) PRB713397</td>
<td>Safari 10.0.1 redirects users to UI11</td>
<td>When a user logs into their Fuji, Geneva and Helsinki instances from Safari version 10.0.1, they are redirected to UI11 instead of UI16.</td>
<td>1. Set user agent string to: &quot;Mozilla/5.0 (Macintosh; Intel Mac OS X 10.12.1) AppleWebKit/602.2.7 (KHTML, like Gecko) Version/10.0.1 Safari/602.2.7&quot;. 2. Log in to the instance. UI11 appears.</td>
</tr>
<tr>
<td>Problem</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>User Interface (UI) PRB692216 KB0597917</td>
<td>Safari 10.x in MacOS Sierra sends users to UI11</td>
<td>When a user logs into certain versions of a Fuji, Geneva, and Helsinki instance using Safari 10.0 (Mac Sierra beta version), they are redirected to UI11/ U14. The user agent off of the new Safari 10 is: &quot;Mozilla/5.0 (Macintosh; Intel Mac OS X 10.12) AppleWebKit/602.1.38 (KHTML, like Gecko) Version/10.0 Safari/602.1.38&quot;.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>
| User Interface (UI) PRB713556 | Using AMB Client on the parent frame from the contained frame causes a memory leak in IE11 | In Geneva and forward in Internet Explorer 11, the iexplore.exe process consumes more and more memory with each page load, constituting a memory leak. The memory leak stems from the asynchronous message bus that powers many live features in UI16. When this feature is used on pages containing iframes, there is a bug in Internet Explorer 11 that causes the browser to maintain unnecessary information in memory. The fix works around the Internet Explorer 11 memory leak by handling the message bus connections differently. | 1. Open an instance using Internet Explorer 11.  
2. Open the task manager to observe Internet Explorer memory usage.  
3. Navigate to an incident form.  
4. Use the arrow keys on the top right to move between incident forms.  
Notice Internet Explorer memory usage continues to climb by 10 - 20 megabytes per page. If you continue to navigate between pages Internet Explorer will crash after going through a large number of forms. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
</table>
| Persistence  | PRB711226        | Database pool sweeper job causes hanging database connection. The database connection hangs, due to a concurrent execution on the same database connection by a database pool sweeper thread and a thread handling regular transactions. If this occurs upon cache loading, it can cause an incomplete cache to be built (e.g. TableDescriptor). This can surface as various symptoms:  
  - Banner text shows as the word “null” (invalid table name: sys_script)  
  - System uses UI15 for all users when they expect UI16 (invalid table name "sys_user_preference")  
  - Node unreachable, blank page, 401’s etc. (invalid field name “sys_scope.scope”)  
  - Fields display as the field name instead of field labels (invalid table name: sys_documentation)  
  - Integrations receiving HTTP 401 (invalid table name: sys_user)  
  - Users unexpectedly logged out after logging in (invalid table name: sys_user)  
  These issues are always preceded by a series of SEVERE errors during the GlideSweep on threads that are being “cleaned.” The errors are preceded by a warning message similar to the following:  
  com.glide.db.pool.DBPoolSweeperJobStatus@15cd039  
  WARNING ***  
  WARNING *** caught error involving method getWarnings on connection 4 |
Steps to reproduce

This issue occurs because of a data race between a thread which is retrieving rows from a streaming result set, and another performing database sweeper operations, specifically checking for active connections and warnings.

The stack traces for the two threads will be similar to the following:

Thread 1

java.net.SocketInputStream.socketRead0(Native Method)
java.net.SocketInputStream.read(SocketInputStream.java:170)
org.mariadb.jdbc.internal.common.packet.RawPacket.nextPacket(RawPacket.java:82)
org.mariadb.jdbc.internal.common.queryresults.StreamingSelectResult.next(StreamingSelectResult.java:85)

Thread 2

java.io.BufferedReader.readLine(BufferedReader.java:336)
org.mariadb.jdbc.internal.common.packet.RawPacket.nextPacket(RawPacket.java:82)
org.mariadb.jdbc.internal.mysql.packet.MySQLRowPacket.getRow(MySQLRowPacket.java:86)
org.mariadb.jdbc.internal.common.queryresults.StreamingSelectResult.next(StreamingSelectResult.java:107)
org.mariadb.jdbc.internal.common.queryresults.StreamingSelectResult.close(StreamingSelectResult.java:123)
org.mariadb.jdbc.MySQLStatement.execute(MySQLStatement.java:282)
com.glide.db.pool.DBConfigurationControllerSweeperJob.checkWarnings(DBConfigurationControllerSweeperJob.java:2)

Fixes included with Helsinki Patch 3 Hot Fix 6

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 3 Hot Fix 5
- Helsinki Patch 3 Hot Fix 2
- Helsinki Patch 3
- Helsinki Patch 2 Hot Fix 2
- Helsinki Patch 2
- Helsinki Patch 1 Hot Fix 1

This release includes the HP1HF1 PRBs that were also fixed in HP3. *

- HP2 and HP3: PRB687962
- HP3: PRB686241

- Helsinki Patch 1
- Helsinki Fixes

Helsinki Patch 3 Hot Fix 5

Helsinki Patch 3 Hot Fix 5 provides fixes for the Helsinki release.

For Helsinki Patch 3 Hot Fix 5: Build date: 09-16-2016_2041
For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 3 Hot Fix 5

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| NotifyNow  | Notify forces the maximum number of conference call participants to be 40, but this should be configurable | The Notify plugin currently sets the Twilio conference maxParticipants limit to 40. This information is used by Twilio to restrict the maximum number of participants in a conference call, regardless of the order they join. Users should have the option to configure the number of conference call participants. | 1. Install the Notify plugin.  
2. Set up the Twilio configuration with Account SID and Token.  
3. Configure one of the numbers with Notify On Task Group (OOB notify group).  
4. Set property glide.notify.task.phone_number to phone number configured in Step 3.  
5. Go to any incident and click Start Conference Call.  
6. Select more than 40 participants.  
Notify limits the conference call participants to 40. |

Fixes included with Helsinki Patch 3 Hot Fix 5

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 3 Hot Fix 2
- Helsinki Patch 3
- Helsinki Patch 2 Hot Fix 2
- Helsinki Patch 2
- Helsinki Patch 1 Hot Fix 1

This release includes the HP1HF1 PRBs that were also fixed in HP3. *

- HP2 and HP3: PRB687962
- HP3: PRB686241

- Helsinki Patch 1
- Helsinki Fixes

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Helsinki Patch 3 Hot Fix 2

Helsinki Patch 3 Hot Fix 2 provides fixes for the Helsinki release.

For Helsinki Patch 3 Hot Fix 2:

Build date: 08-18-2016 0855
Build tag: glide-helsinki-03-16-2016_patch3-hotfix2-08-17-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 3 Hot Fix 2

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistence</td>
<td>MySQLCancel may kill future query if the current one has already finished before the kill statement was issued</td>
<td>Due to a bug in the MySQL Server, the kill query &lt;PID&gt; statement may kill a future query on this connection if the current query has already finished before the kill statement was issued.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>
| PRB662782      | High CPU utilization is correlated to Record Presence transactions     | Analysis of servers with high CPU utilization has determined that Record Presence can significantly increase CPU load. It has been observed that turning Record Presence off can lead to a 25% reduction in CPU load.                                                                …………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
- **Helsinki Patch 2 Hot Fix 2**
- **Helsinki Patch 2**
- **Helsinki Patch 1 Hot Fix 1**

This release includes the HP1HF1 PRBs that were also fixed in HP3. *

- HP2 and HP3: PRB687962
- HP3: PRB686241

- **Helsinki Patch 1**
- **Helsinki Fixes**

### Helsinki Patch 3

The Helsinki Patch 3 release contains fixes to these problems.

For the Helsinki Patch 3 release:

- Build date: 08-02-2016_1236
- Build tag: glide-helsinki-03-16-2016__patch3-07-13-2016

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).

For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).

---

**Note:** This version is approved for FedRAMP.

---

### Security-related Fixes

Helsinki Patch 3 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 3, refer to [KB0596689](#).

### Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Management</td>
<td>PRB683258</td>
<td>Closing an incident in instances missing the parent_incident column will close all incidents</td>
<td>For older instances that do not have the <code>upgrade.2011_common</code> plugin, data loss can occur when closing an incident due to the “SNC - ITIL - Close Related” business rule.</td>
<td>1. Verify the <code>com.snc.bestpractice.incident</code> plugin is installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Delete the parent_incident column from the dictionary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Attempt to deactivate the ‘Prevent Recursion of Parent Incident’ business rule. Note that this rule is absent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Close an incident.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note that all incidents are closed.</td>
<td></td>
</tr>
<tr>
<td>Core Platform</td>
<td>PRB697208</td>
<td>Memory leak caused by large number of Rhino JavaAdapter classes being generated and cached</td>
<td>There is a memory leak which is caused by instantiating GlideScriptable abstract classes in Helsinki. One place where this occurs is in the OOB script include “Cart”, where there is an instantiation of one of these classes, GlideappQuestion. Caching these classes seems to be a change in behavior from pre-Helsinki Rhino.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td></td>
<td>KB0596785</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This is not isolated to the GlideappQuestion class.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Chat PRB681035 KB0610406</td>
<td>Connect Support chat message entries between two people are all shown in activity stream as one account</td>
<td>All chat messages which are posted before an incident is created will show up on the activity stream as being inserted by one person, even though there are two people messaging.</td>
<td>1. Activate the Chat, Connect, and Connect Support plugins. 2. Create a queue and select the Service Desk assignment group. 3. In one browser, log in with Abel Tuter (do not impersonate). 4. In a different browser, log in with ITIL User (do not impersonate). 5. With Abel, create a new chat in the queue. 6. Answer the chat as ITIL User. 7. Post a few chats back and forth between the two users. 8. With ITIL User, create an incident from the chat and save the incident. Expected result: The activity stream in the incident should show a chat conversation between the two people with their respective names. Actual result: You will see only the ITIL User listed for every posted chat message.</td>
<td></td>
</tr>
<tr>
<td>Service Mapping PRB687001</td>
<td>Problem with business service sync on upgrade from Geneva to Helsinki</td>
<td>After a user’s instance upgraded from Geneva to Helsinki, it was impossible to view the map of services. For remediation, a manual sync was done for all services and the map view was restored.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>CMDB PRB687008</td>
<td>In the presence of multiple duplicate records, incorrect record gets selected as candidate for matching, leading to record reclassification</td>
<td>The code for processing for de-duplicating records in CMDB works as follows: The code enumerates relations in the CMDB, based on criteria from the payload passed to the Identification Engine. The first phase creates a list of all the records involved in a certain relation with another record. The second phase refines the list down to the records that actually match the input data (thus detecting real duplicates). Finally, one of the records from the second list is used as the match for the Identification process. The problem is a code bug where the wrong list is used for the final step, thus leading to the selection of an incorrect record.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Catalog PRB686241 KB0596179</td>
<td>Catalog UI policy on a new variable on a catalog item causes error on existing request items without the new variable</td>
<td>If a new variable or UI policy is added to an existing catalog item, fulfillers still working on existing requested items see an error.</td>
<td>1. Create a new catalog item and add several variables to the item. 2. Add a UI policy on any of the variables. 3. Order the item. Note that the variables are visible in the requested item. 4. Add a new variable to the item. 5. Update the UI policy with the new variable. 6. Open the old requested item. Error message is displayed.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table Rotation/Extension</td>
<td>PRB664049, KB0595625</td>
<td>Database Rotation</td>
<td>In Table Rotation/Extension, any index name that begins with “u” and is defined on the base shard is not added to newly created shards. The main table affected is new shards of sys_email. For sys_email, each new table shard is queried by the POP Reader job. The missing index for this new shard on the “uid” column causes substantial delays with the POP Reader job.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>
| Email                    | PRB667700         | Customized        | When using custom watermark prefixes, inbound email actions do not identify a valid watermark as a reply. The fix for this PRB fixes the behavior for watermarks in emails. Refer to [Create a custom watermark prefix for email notifications](#) for details.                                                                 | 1. Go to Number maintenance to change the watermark of an incident to MSGTEST.  
2. Create an incident and find a email sent with the new watermark (e.g. MSGTEST00001).  
3. Create a new email in Outlook as follows and send back to the instance:  
   • Subject: a new email with watermark  
   • Content: adbdadf  
   • Ref: MSGTEST00001  

Expected behavior: The replied email should be classified as a “reply”, and it should recognize the custom watermark “MSGTEST”.  
Actual behavior: The replied email will be classified as “new”, and the watermark “MSGTEST” will not be recognized.                                                                                           |
<p>| JS/HTML Editor           | PRB658009, KB0565100 | TinyMCE HTML Field Editor | The TinyMCE editor is unable to process large amounts of text in Internet Explorer. This issue can also occur for ITIL users when using an email client to reply to email chains.                                                                 | Refer to the listed Known Error KB article for details.                                                                                                                                                                                                                      |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI) PRB668554 KB0596137</td>
<td>UI16</td>
<td>Duplication of banner image sys_attachment records after Geneva/Helsinki upgrade causes slow response times</td>
<td>After upgrading to Geneva and some builds of Helsinki, slow response times have been occurring when logging in and navigating in the instance. Login can take 1+ minute in some cases. This issue is due to duplicate records inserted during the upgrade from a fix script that cause the sys_attachment table to become very large. A frequent encoded query against sys_attachment triggers delays in the instance.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>User Interface (UI) PRB666912</td>
<td></td>
<td>Selecting multiple records on a list view updates unselected rows as well (List v2 only)</td>
<td>When multiple records are selected from the same column on a list view, not all selected records are updated, and other random records are updated. For example, selecting 4 records via the ‘Category’ field on the task table and then editing via list view also updates other records that were not selected to begin with. This only seems to occur when the system property glide.ui.list.detail_row is set to true, and when you are editing a table (via list view) that is unaffected by that property. This seems to be somewhat related to previously fixed PRB634893 and PRB647724, but the opposite in that the tables affected here are the ones which are not influenced by this property.</td>
<td>1. Navigate to sys_properties.list. 2. Create the property glide.ui.list.detail_row and set it to true. By default, it applies the detail_row to short_description on the task table and related tables. 3. Choose a different table that is not affected. (NOTE: Make sure this is NOT configured as a Detail Row. This issue as reported only happens if Detail Rows are not configured on the table you are editing.) 4. Select multiple records from the list column (the list column must be editable). Notice that not all records selected are changed, and for every one that did not update, another unselected record seems to update instead.</td>
</tr>
</tbody>
</table>

Note: There is also another related issue here where selecting an EVEN amount of records shows that an ODD number of records (usually X +1) will be updated. For example, selecting 4 records prompts the user that ‘5 rows will be updated.’ However, selecting 5 records prompts correctly for ‘5 rows will be updated.’ This also only occurs on tables unaffected by glide.ui.list.detail_row being set to true.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Management</td>
<td>Incident</td>
<td>The new Helsinki dictionary override on default value &quot;5&quot; for &quot;Incident.Priority&quot; field affects customizations</td>
<td>With Helsinki, we inserted &quot;sys_dictionary_override_31003e229f211 2008f97b89a442e7009,&quot; the Dictionary override of the Default value on &quot;Incident.Priority&quot; field, setting it to &quot;5&quot; (previously &quot;4&quot;). If a user does not have a custom Dictionary override on the &quot;Incident.Priority&quot; field, this file is inserted and the new default value may not align with instance customization, creating issues.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>PRB678045 KB0596337</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## All Other Fixes

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Assessment PRB667324 |                  | Word wrap for Risk Assessment options splits text into two lines | After creating a Risk Assessment, when viewing the options to the questions, they will be cut off and split into the next line. This occurs even though there seems to be a lot of space left blank in the page. | In a Geneva instance with the Risk Assessment plugin activated:  
1. Navigate to Change › Administration › Risk Assessment.  
2. Go into any Assessment Master.  
3. Under the Assessment Questions tab, create a new question.  
4. Go into that question (to add the choices).  
5. Once inside the Assessment Question, under the Assessment Question Choices tab, create a new Assessment Question choice.  
6. In the Value of this Assessment Question Choice, make sure your text is long enough (around at least 150 characters depending on window size).  
7. Select Update. This will take you back to the Assessment Question.  
8. Select Update on the Assessment Question as well. This will take you back to the Assessment Master.  
9. Select the Take Survey button.  

Note the text for the options to the question is split into two lines, even though there is plenty of empty space to the right. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management PRB67998</td>
<td>Change Management - Core, Change Management - State Model, Change Request</td>
<td>Adding a new change type per documentation is breaking the State drop-down behavior on Change form</td>
<td>The product documentation explains how to create a new Change Type. After completing all the steps, the new type is created successfully. However, the State drop-down in the change form seems to be broken. Instead of showing the expected states according to the change type, it shows all states for any change type selected.</td>
<td>In a Geneva instance, follow the steps on Add a new change type to create a new change type. Note the State drop-down displays all states instead of the expected states for the selected change type.</td>
</tr>
<tr>
<td>Chat PRB679471</td>
<td>NG shared components</td>
<td>@mention search fails in domain-separated environments</td>
<td></td>
<td>1. Enable domain separation. 2. Create two users with similar names (e.g. Carmen and Carmine). 3. Put Carmen and Carmine in domains such that they cannot see one another. 4. Impersonate a user who can see both Carmen and Carmine (i.e. member of parent domain). 5. Go to a form where @mentions are enabled (e.g. incident). 6. Type @Carm in the comment field. An NPE will be thrown in the mention service and the loading icon will spin forever.</td>
</tr>
<tr>
<td>Chat PRB684676</td>
<td>NGPresenceArray will swallow exceptions</td>
<td></td>
<td>Timed: catch block in NGPresenceArray catches Exceptions but does not check for transaction cancellation. This can lead to a stuck semaphore.</td>
<td></td>
</tr>
<tr>
<td>Chat PRB689533</td>
<td>Idle time countdown does not work</td>
<td></td>
<td></td>
<td>1. Start a support conversation. 2. Have an agent answer. 3. Wait for the idle message box to appear. 4. Move the mouse cursor into the client window. Note that the timer stops.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Chat</td>
<td>Connect</td>
<td>Messages are not captured when following a support-based record if followed quickly</td>
<td>1. Start a support conversation.</td>
<td>1. Start a support conversation.</td>
</tr>
<tr>
<td>PRB698495</td>
<td></td>
<td></td>
<td>2. Have a long support conversation of about 60 messages.</td>
<td>2. Have a long support conversation of about 60 messages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Create an incident.</td>
<td>3. Create an incident.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Although all 60 messages show up in the activity stream, not all of them</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>made it into the conversation record.</td>
<td></td>
</tr>
<tr>
<td>Cloud Management Application</td>
<td></td>
<td>AWS Cloud provisioning report appears to misinterpret the day as the month when</td>
<td>For the script include “BillingReportDateTimeUtil” and its inside functions</td>
<td>1. Provision an AWS EC2 instance.</td>
</tr>
<tr>
<td>PRB682972</td>
<td></td>
<td>“glide.sys.date_format” is not YYYY-MM-dd</td>
<td>getCurrentMonth and getCurrentYear:</td>
<td>2. Check the EBS volume created along with the instance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• GlideDateTime(gs.nowDateTime()) will return date in the default format</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>YYYY-MM-dd</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• GlideDateTime(gs.nowNoTZ()) will return date in the format specified by</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>glide.sys.date_format</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Date Time()</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NoTZ()</td>
<td></td>
</tr>
<tr>
<td>Cloud Management Application</td>
<td></td>
<td>Amazon EBS volumes “Volume Type” and “Volume Size” are not populated after it</td>
<td>The Amazon EBS volumes “Volume Type” and “Volume Size” are not populated</td>
<td>1. Provision an AWS EC2 instance.</td>
</tr>
<tr>
<td>PRB686200</td>
<td></td>
<td>has been provisioned via Service Catalog request item</td>
<td>after it has been provisioned.</td>
<td>2. Check the EBS volume created along with the instance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>It is necessary to run AWS Discovery for the account in order to populate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>these fields. Some users need these attributes to be populated in real-time</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>after the EBS volume is attached to the instance and successfully provisioned.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Until the next discovery, the EBS volume will be missing the “Volume size”</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>and “Volume type” fields, and the volume status will be reported as “attached”</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>instead of the expected “in-use”.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Cloud Management Application</td>
<td></td>
<td></td>
<td>By default, when we make the DescribeInstances/DescribeVolumes API call to AWS, AWS sends the whole set of records in a single response. If the user has a huge number of Instances in the account, and if the ServiceNow instance has a low system memory, the response is huge to process and memory usage peaks up.</td>
<td></td>
</tr>
<tr>
<td>PRB687200</td>
<td></td>
<td>Include the paging ability for AWS Discovery</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| CMDB                           |                  | CMDBMetadata should not rely on calculated field “name”, since it can get translated into other languages | When an instance’s language is changed, the CMDBMetadata cache is not reloaded. As a result, when using RelationDescriptors from this class, they appear in the wrong language. It also makes finding relations using this class quite difficult unless the user has the ID ready. | 1. Work on your instance with some language (e.g. English).  
2. Change the instance’s language (e.g. Spanish).  
3. Try to work with CMDBMetadata’s RelationDescriptors.  
You will see that their names appear in the previous language. |
<p>| PRB677848                      |                  |                   |                                                                                                                                                                                                             |                                                          |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Core Platform PRB682487 |                  | AMB Message Client Builder errors in iframe cause Service Portals to not render in iframe | 1. Authenticate to the instance and set property glide.set_x_frame_options to false. Ensure the instance has a Service Portal. 2. Create an iframe to a service portal on an external site. For example, this can be done at http://www.w3schools.com/tags/tryit.asp?filename=tryhtml_iframe to test. The code might look something like this:  
<!DOCTYPE html>  
<html>  
<body>  
<iframe src="https://<instance>.service-now.com/sp">  
</iframe>  
</body>  
</html>  
You will see various JavaScript errors in the console. One of these is from the amb.MessageClientBuilder.js script, which attempts to find properties in the top frame using window.parent. You cannot access properties in window.parent when window.parent is in a different domain - this is a security feature of all browsers. As a result, the service portal will not render. |                                                                                                                                                  |
| Core Platform PRB683749 |                  | Not able to upload app from author with a logo | 1. Log in to the app store. 2. Create an app and add a logo. 3. Publish to the store.  
Note the error:  
Saving uploaded attachments failed  
java.lang.ClassCastException: org.mozilla.javascript.NativeObject cannot be cast to java.util.HashMap |                                                                                                                                                  |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Service Management PRB658956</td>
<td>Special Handling Notes</td>
<td>Alert message does not handle formatting in Special Handling Notes</td>
<td>For example, if a user uses <code>&lt;p&gt;</code> tags in an alert type note in order to create a message with two separate lines, they are displayed as one line instead.</td>
<td></td>
</tr>
<tr>
<td>Data Certification PRB689941</td>
<td></td>
<td>Data Certification Checkbox functionality on the cert elements not working on a single row Fuji+</td>
<td>In a Fuji or later instance: 1. Activate the Data Certification plugin with demo data. 2. Go to UI11 by either turning the glide.ui.doctype property to False and log back in to the instance OR append the instance url with <code>/navpage.do?sysparm_device=desktop</code>. 3. Navigate to Data Certification » Tasks » All Tasks and select TSK0009067. 4. In the Certification list at the bottom, select a row by checking the far left checkbox. This is supposed to select the entire row, but it does not.</td>
<td></td>
</tr>
<tr>
<td>Discovery PRB683515</td>
<td>CyberArk App-IDs are hard-coded as part of the MID Server</td>
<td>CyberArk App-IDs are hard-coded as part of the MID Server, but these need to be configurable.</td>
<td>1. Run Discovery on an ACE load balancer. 2. Note that you receive the following error: “Warning TypeError: Cannot convert null to an object.” The load balancer is not discovered.</td>
<td></td>
</tr>
<tr>
<td>Discovery PRB699887</td>
<td>SSHTerminalCommandFactory script fails due to changes in DiscoveryProviderFactory</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Discovery PRB701403 | F5 - OS classification probe returns unhandled error | For the F5 - OS probe in UNIX - Classify, most devices will return the following error:  
<results  
error="bash: tmsh: command not found Exit status: 127 
probe_time="540" result_code="900000"  
<result  
error="bash: tmsh: command not found Exit status: 127 ">  
<output/>  
</result>  
This happens because the command "tmsh" is only typically installed on F5s, which also have SSH capabilities. Handling such errors also fires additional classifiers, but since the UNIX - Classify probe also has a positive result from the UNIX - OS probe, that path succeeds. | Run a Discovery of a device that is discoverable by, for example, both SSH and SNMP. The device must not have the "tmsh" command installed (this is only common on F5 devices).  
Actual result: UNIX - Classify and SNMP - Classify both succeed, and then identify and explore both. The device history record will only point to one CI, but checking the CMDB will show that both the Linux server and a Switch are created. |
| Event Management Application PRB686151 | Event Rule - In composite fields, logic \n and \r are replaced by '' | For example, in the Event.normalizeSpaces function’s composite fields, the logic \n \t and \r are removed. | 1. Create an event with a description containing new lines.  
2. Create an event rule, transforming the description in some temporary field, and then compose it back to the description.  
Note the description of Alert: there are no more new Lines there. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Management Application PRB686959 KB0596391</td>
<td></td>
<td>An empty task is created when an Event Management Alert (em_alert) record state is changed from Closed to Reopen.</td>
<td>If an Event Management alert State is changed from Closed to Reopen, and the alert does not have a linked Task, the “Reopen associated closed incident’ business rule still runs. This business rule should not run if the em_alert.incident field is empty, but it does due to: • a mistake in the condition • a get() on task using a null value, followed by an update(), causing an empty open ‘task’ record to be inserted.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Event Management Application PRB687227 KB0596148</td>
<td>ImpactCalculator job causing OOM issues</td>
<td>Performance degradation will occur on application nodes running ImpactCalculator jobs, which are triggered from the “Impact Calculator Trigger” auto script.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Facilities Service Management PRB689778 | Facilities Service Management                  | `fix_cmn_location_classifier.xml` job updates Custom Dictionary records that are References to cmn_location table and moves those from a Private scope to Global scope | On a Geneva instance:  
1. Create a custom scoped application with a table and a reference field to the cmn_location table.  
2. Activate the `com.snc.facilities_service_automation` plugin.  
3. Notice that the scope of the Dictionary record created in step 1 has changed to Global and that the package is now `com.snc.facilities_service_automation`. | On a Geneva instance:  
1. Create a custom scoped application with a table and a reference field to the cmn_location table.  
2. Activate the `com.snc.facilities_service_automation` plugin.  
3. Notice that the scope of the Dictionary record created in step 1 has changed to Global and that the package is now `com.snc.facilities_service_automation`. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Financial Management PRB684610 | Financial Management | Allocation Rollups from Segment to Segment: Percentages appear correctly, however cost allocated is double the amount it should be. | This issue is related to the Financial Management plugin in Helsinki. When performing Allocations from Workbench, the rollups do not process as expected and end up incorrectly allocating the costs in double. | In a Helsinki instance with the Financial Management plugin installed:  
1. If needed, load GL Data into the Staged Expenses table (Cost Transparency > General Ledger > Staged Expenses).  
2. Open the Cost Transparency Workbench (Cost Transparency > Workbench).  
4. Navigate to the Data Cleansing stage > click Cleanse Data.  
5. Navigate to the Bucketing stage and move some accounts to a bucket.  
6. Click Run Bucketing.  
7. Navigate to Allocation Setup.  
8. Move the bucket into an account below the “top level” account (typically this is Business Unit), and click Create to create the allocation.  
9. Click the ‘info’ icon of the account, select Equal for the Rollup Method, and add two rollups. Both should be 50%.  
10. Click Save Changes.  
11. Navigate to the Review stage > click Allocate Expenses.  

Expected result: After the Allocation Engine runs, the “Existing Allocation Aggregation” should update with the new number of allocations (which should be 2 in this case).  
Actual result: The existing Allocation Aggregation value does not change. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foundation</td>
<td>PRB67521</td>
<td>Service Management Core</td>
<td>Performance issue: System hangs when loading Facilities Request Templates form if instance has excess (75k+) CMDB (cmdb_hardware or cmdb_consumable) records. This was tested with large amounts in cmdb_hardware table. The OOB script include ‘SMTemplateHelper’ performs a GlideRecord query against these tables, and it takes a very long time to process data. The system eventually times out and does not load the form. The system should not hang while trying to handle such large CMDB data sets.</td>
<td>In a Geneva or older instance with large data sets for the cmdb_hardware_product or cmdb_consumable_product tables: 1. Activate the Facilities Service Management plugin. 2. Go to Facilities Request Templates and try to open any of the existing OOB records. The system hangs while trying to open the Facilities Request template record.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Foundation PRB681402 | Service Management Core | Unable to create a Template (Facilities Module) with system property ‘glide.invalid_query.returns_no_rows’ set to ‘true’ | When loading a catalog list to attach it to a template, the list does not load due to an invalid query. There is an Angular AJAX request on the page that runs an invalid query: `p=sc_category;q:nameSTARTSWITH^nameISNOTEMPTY^EQ;r:sc_catalog=e009c323ff031100a0a5ffffffffff37` Because there is no ‘name’ field on the ‘sc_category’ table, it will cause nothing to load when ‘glide.invalid_query.returns_no_rows’ is set to true. This causes the query to return 0 results and prevents the user from submitting a template for publishing via the Angular UI. | In a Geneva instance:  
1. Make sure that the Facilities Service Management plugin is active.  
2. Make sure the system property ‘glide.invalid_query.returns_no_rows’ is set to true - if it does not exist, it will need to be created with following:  
   - Name: `glide.invalid_query.returns_no_rows`  
   - Description: Controls how invalid GlideRecord queries are handled. By default, if a query is incorrect, such as an invalid field name, that part of the query condition is ignored and results will be based on the valid part of the query. When this property is true, invalid queries will always return no rows. When enabled, this logic can be overridden at the session level by executing `gs.getSession().setStrictQuery(false)`. To restore strict query, execute `gs.getSession().setStrictQuery(true)`.  
   - Type: True | False  
   - Value: True  
3. Go to Facilities > Catalog Knowledge > Facilities Request Templates > click New.  
4. Use ‘test’ for both the Name and Short Description fields.  
5. Click Submit.  
6. Click the dropdown for Category.  

Expected behavior: The catalog list loads in the dropdown.  
Actual behavior: The list does not load at all. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Foundation PRB68843 Service Management Core | Assign to Me button does not work without 'dispatch group' field on form | | 1. Load the Facilities Service Management plugin.  
2. Remove the 'Dispatch group' field from the Facilities Request Task form.  
3. Log in as a Facilities Management Agent.  
4. Create a Facilities Request with a Facilities Request Task on it.  
5. Click the Assign to Me button.  
Notice it does not work, and there is an error in the browser console. |
| Governance, Risk and Compliance PRB675185 | Control test condition in Control Test Definitions does not filter records from a database views table | | 1. Create or open a Control Test definition.  
2. Check Collect supporting data.  
3. Fill all mandatory columns and pick Basic for the Condition type.  
4. Fill out the condition section as follows:  
   • Table: Incident SLA (incident_sla)  
   • Fields: add some fields  
   • Control test condition: Short description Start With CPU  
5. Click Execute Now. The incorrect records are displayed.  
6. Modify the condition section as follows:  
   • Table: Incident (incident)  
   • Fields: add some fields  
   • Control test condition: Short description Start With CPU  
7. Click Execute Now. The correct records are displayed. |
<p>| HR Service Management PRB689660 | Need to broadcast an event on Service Catalog submission | Service Catalog submissions from the Service Portal should redirect to the HR ticket page. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| IT Operations Management PRB679897 | | Upgrade overwrites related list customizations for rm_enhancement | Various Fuji upgrades (e.g. Fuji Patch 5 to Fuji Patch 12 Hot Fix 1) overwrite the ‘rm_enhancement’ related list settings with the OOB settings. | 1. Configure the rm_enhancement related list, and add 2-3 related lists.  
2. Upgrade from Fuji Patch 5 to Fuji Patch 12 Hot Fix 1 (for example).  
Note the rm_enhancement related list settings are converted to OOB. |
| Knowledge Management V3 PRB686568 | Knowledge Management V3 | Knowledge search for articles with a large number of attachments is very slow in Helsinki and Geneva when compared to Fuji or earlier | In Helsinki and Geneva instances, knowledge search is unusually slow when knowledge articles have a large number of attachments included in the articles. | |
| Knowledge Management V3 PRB687490 | Knowledge Management V3 | Category picker is not working correctly | When a user navigates to Knowledge Base > Create New, and sets the Knowledge Base to Knowledge, the Category (kb_category) is read-only. | 1. Navigate to Knowledge > Create New.  
2. Choose Knowledge V2.  
Note that the Category is read-only. |
<p>| Knowledge Management V3 PRB687979 | | After migrating to Knowledge V3, tags for V2 articles are no longer displayed on homepage and the site hangs | For a user’s Knowledge V3 migration, tags were used to indicate which countries the articles are for. There were up to 144 tags per article on the knowledge home page. Since the migration completed, the site hangs when users click on the tags column on the home page, and it does not display the tags for the countries. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management PRB689027</td>
<td>Knowledge Management V3</td>
<td>Unable to search for articles with states other than published, review, or draft</td>
<td>There are users who have modified various pieces of Knowledge Management to allow them to handle custom states, specifically, allowing users to see articles in search results that were in states other than Published, Draft, and Review. However, in KBv3, the queries for search results are hard-coded in non-user-accessible places to show only Published articles. The only method of allowing users to see other states involve system properties that only allow roled access to Draft and Review states. There is no possibility of showing other states, which poses significant issues for certain users.</td>
<td>1. Add an additional state to the knowledge workflow (e.g. Technical Review). 2. Attempt to get articles in that state to show in search results. Note that it does not appear in search results.</td>
</tr>
<tr>
<td>Knowledge Management PRB689190</td>
<td>Knowledge Management V3</td>
<td>When upgrading from Fuji to Helsinki, the category list display does not honor the selected KB condition while creating a new article</td>
<td>There is no possibility of showing other states, which poses significant issues for certain users.</td>
<td>1. Upgrade a Fuji instance to Helsinki. 2. Create new knowledge bases and create categories. 3. Click Create new article &gt; Select any knowledge base. 4. Enter ** in knowledge category field. Observe the list of categories does not honor the KB selected criteria. The category list should be related to the selected knowledge base.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Knowledge Management PRB689652</td>
<td>Knowledge Management V3</td>
<td>Alphabetical sort order for category filters on browse knowledge page is not working</td>
<td>The fix for this PRB includes the following: &lt;br&gt;1. Sort order of categories on Knowledge Browse page is in alphabetical order  &lt;br&gt;2. Sort order of all the filters on Search Page is in alphabetical order  &lt;br&gt;3. Sort order of category filters on search page is based on the breadcrumb hierarchy starting from the topmost KB name/category  &lt;br&gt;4. KB name is appended to the breadcrumb from now onwards if there are multiple KB filters on search page</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management PRB691602</td>
<td>Knowledge Management V3</td>
<td>In IE11 on the knowledge category home, the user is brought to an empty page (when using Enterprise - Compatibility mode)</td>
<td>In IE11: &lt;br&gt;1. Navigate to the IE Menu &gt; Compatibility View Settings &gt; Display Internet sites in Compatibility. &lt;br&gt;2. You may need to do the following steps as well:  &lt;br&gt;   a. Click Tools in the upper toolbar.  &lt;br&gt;   b. Select Enterprise Mode.  &lt;br&gt;3. Go to the OOB knowledge IT category: /$knowledge.do?sysparm_type_filter=all&amp;sysparm_kb=a7e8a78bff0221009b20ffffffffff17&amp;sysparm_category=-1&amp;browse_type=categories</td>
<td>Note the page is blank.</td>
</tr>
</tbody>
</table>
## Problem

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Live Feed  | PRB673937        | ‘Share your thoughts’ and ‘Search Messages’ fields in Live Feed do not have a label associated to them, which poses challenges for users with vision disabilities | Accessibility features allow other applications such as VoiceOver (hit Command+F5 on keyboard to activate VoiceOver App) to identify and tab into fields within the ServiceNow platform. Controls and Fields within the ServiceNow platform need to have labels associated with them in order for applications like VoiceOver to function properly and allow easy access to such fields for users with low-impaired vision disabilities. ‘Share your thoughts’ and ‘Search Messages’ fields in Live Feed are such fields with no labels displayed. Here are some challenges that are posed when fields/controls do not have labels associated to them:  
  • VoiceOver application is not able to read the labels for such fields when Voiceover is activated.  
  • Screen readers cannot associate a label to fields which do not have labels.  
  • The font for the text when it is initially displayed until the user starts to type a value into the field, is very light in font color and difficult to read for users with vision disabilities.  
  • Once you focus into such fields, the field description (e.g. ‘Add a Comment’ in Knowledge articles) goes away, which poses further challenges. | 1. Activate the VoiceOver application by clicking Command+F5 from your keyboard.  
2. Go to Live Feed and observe the ‘Share your thoughts’ field.  
  • If you click into the field and start to enter inputs, the ‘Share Your Thoughts’ field description is no longer displayed.  
  • If you try to tab into fields using VoiceOver, the field description is no longer read if there is user-entered text. Instead, the user-entered text is read. This can be misleading for users with disabilities.  

The same issue occurs with the ‘Search Messages’ field in Live Feed. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server PRB683509</td>
<td>CyberArk Integration</td>
<td>Currently, the format .\ must be used to use a local Windows server credential. However, some users want to use the username in the username field and an empty domain name format (which is fine as well). To do this, this situation should be detected, and \ should be prepended to the credential name when the domain is empty and there is no \ in the username.</td>
<td>1. Leave the domain name blank and the username without a .&lt;br&gt;2. Note that you do not succeed with local credentials on a domain server.</td>
<td></td>
</tr>
<tr>
<td>Mobile PRB687139</td>
<td>The size of content and UI components in the OAuth login and confirmation pages is too small</td>
<td>When creating a widget of type 'time series', if you check the previous period chart, it displays numbers on the high chart's x-axis instead of dates.</td>
<td>1. Create a widget.&lt;br&gt;2. Set type Time Series.&lt;br&gt;3. Check Previous period chart.&lt;br&gt;4. Add it to a dashboard.</td>
<td></td>
</tr>
<tr>
<td>Performance Analytics PRB679718 KB0596677</td>
<td>The x axis on time charts displays numbers instead of dates</td>
<td>When collecting scores multiple times per day in a domain-separated environment, if the collection job runs on the global domain, existing scores for the day are not deleted prior to re-collecting. This leads to duplicate scores.</td>
<td>1. On a domain separated instance with no scores, run the default historic incident data collection job.&lt;br&gt;2. Check the scores table for the number of collected scores.&lt;br&gt;3. Run the historic collection job again. The number of scores should be doubled. Further investigation shows scores for the same UUID and start at date.</td>
<td></td>
</tr>
<tr>
<td>Performance Analytics PRB680809 KB0595192</td>
<td>During scores collection, if the domain is global and there are existing scores for the collection day, scores are not deleted prior to re-collection</td>
<td>When the task creation policy of a maintenance plan is set to &quot;Add to existing&quot;, the &quot;Next run time&quot; value is not recalculated after the &quot;Run on demand&quot; action is completed.</td>
<td>1. On a domain separated instance with no scores, run the default historic incident data collection job.&lt;br&gt;2. Check the scores table for the number of collected scores.&lt;br&gt;3. Run the historic collection job again. The number of scores should be doubled. Further investigation shows scores for the same UUID and start at date.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Platform Security      | PRB680719        | StackOverflow     | After upgrading to Helsinki, the system fails to initialize. For example, for a user who has a value in sys.properties of type password2 with a length 4.8K, which is storage-level encrypted, restarting the system does not work. | 1. Create a property of type password2, and set it to a huge value (e.g. 60K). Make sure that it starts with abc#, and the rest are Base64 chars.  
2. Try to restart the system.  

Note: The issue is a side-effect of implementation of the StringUtil.isBase64() method, which is using patterns, requiring a lot of stack memory.  

System initialization fails with the following exception:  

Stack:  
... StackOverflow  
at  
java.util.regex.Pattern$Loop.matchInit(Pattern.java:4806)  
at  
java.util.regex.Pattern$Prolog.match(Pattern.java:4741)  
at  
java.util.regex.Pattern$Curly.match0(Pattern.java:4279)  
at  
java.util.regex.Pattern$Curly.match(Pattern.java:4234)  
at  
java.util.regex.Pattern$Curly.match0(Pattern.java:4272)  
at  
java.util.regex.Pattern$Curly.match(Pattern.java:4234)  
at  
java.util.regex.Pattern$GroupHead.match(Pattern.java:4658)  
at  
java.util.regex.Pattern$Loop.match(Pattern.java:4785)  
at  
java.util.regex.Pattern$GroupTail.match(Pattern.java:4717)  
at  
java.util.regex.Pattern$Loop.matchInit(Pattern.java:4804)  
at  
java.util.regex.Pattern$Prolog.match(Pattern.java:4741)  
at  
java.util.regex.Pattern$Curly.match0(Pattern.java:4279)  
at  
java.util.regex.Pattern$Curly.match(Pattern.java:4234)  
... |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management PRB671552 | Demand Management | Demand Management module under PPS throws runtime exceptions due to an OOB script issue | This is due to a unique index which was added to keep Task level numbers unique. As a result, users see the error message “Unique Key violation detected by database.” | 1. Log in to the instance.  
2. Enable PPS Suite.  
3. Create a new Demand record with Category: Strategic and Type: Project.  
4. Once the Demand is created and is in the Draft state, create two test Requirements and Risk records from related records.  
5. Submit the Demand and approve it.  
6. Now use the Related Link to create a Project.  
The project is created with the error message ‘Unique Key violation detected by database.’ |
| Project Management PRB676527 |  | The planned_task sub_tree_root field is being set to top_task and not the expected subproject | The project hierarchy is still correct in terms of the relationships specified in the parent fields of all the records. However, the composite field Project is set incorrectly because the sub_tree_root field is incorrect, so user reports are not correct. | 1. Create a project hierarchy with the following structure:  
   - Master Project: make this the top task  
   - SubProject One: subproject of Master Project  
   - SubSubProject One: subproject of SubProject One  
   - SubSubProject Task One: child project task of SubSubProject One  
2. On the Project form layout, on the Project Tasks related list, add the Project(project) column to the list.  
3. Take a look at the SubSubProject One Project Tasks related list.  
Note that prior to Geneva, the Project column shows the expected sub_tree_root, which is SubSubProject One. In Geneva and later, the Project column on the related list shows Master Project. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management PRB68703 | Project Management, Project Portfolio Suite | Unable to create new Projects using Project Templates if upgrading from Fuji to Helsinki and possibly Geneva without ’Project Portfolio Suite’ plugin being active | After upgrading from Fuji or prior to Helsinki (and possibly Geneva), Fuji and prior users with the Project Management v2 or v3 plugin active but ‘Project Portfolio Management’ not active, are unable to use Project templates. An error is caused by a missing field, which is otherwise created by the Project Portfolio Management plugin. Furthermore, in Helsinki, it is not possible for customers to activate the ‘Project Portfolio Suite’ plugin (the ‘Project Portfolio Suite for ITFM’ plugin replaced this plugin in Helsinki). Since the ‘Project Portfolio Suite for ITFM’ plugin is not already available in the customer’s plugin list, a separate request needs to be made to make the ‘Project Portfolio Suite for ITFM’ plugin available on their Helsinki instances, which is inconvenient. | In an OOB Fuji instance:  
1. Activate the Project Management v2 or v3 plugin.  
2. To verify this is working in Fuji, go to Project Template and create a new project from any of the existing project templates.  
3. Upgrade the instance to Helsinki.  
4. Repeat step 2 to create a new project from template on the Helsinki instance.  
   Note the new project does not get created, and instead there is an empty project form. |
<p>| Project Management PRB69016 | Project Management, Project Portfolio Suite | Adding key_milestone column to the planned_task table takes over 2 hours on upgrade of large dataset | | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting PRB675324</td>
<td>KB0594573</td>
<td>Calendar gauges and reports on homepages no longer remember selected “Highlight based on” setting</td>
<td>The Change Calendar gauge and report design pages no longer recognize the preselected default “Highlight based on:” value. Users have to select their desired choice each time the homepage is reloaded. The configuration of the Highlight field selection is not part of the Calendar report, but is stored as preferences on the specific calendar gauge dropzone.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>
| Reporting PRB686982 |                 | Certain homepages are having new widgets added after every upgrade | After an upgrade, extra widgets are added to certain homepages (catalogs, Itil homepage, and Usage Overview). This is because the widgets were added to the update folder instead of the unload folder. This can be fixed by moving the files from one to the other. | On any instance on an older build:  
1. Through the CMS application, modify the itil homepage and remove some of the OOB widgets.  
2. Upgrade the instance to a newer version.  
3. Check the itil homepage.  
   
   Expected behavior: The itil homepage has the same widgets as the modified itil page.  
   Actual behavior: The homepage has extra widgets on it than it had before the upgrade. |
| Reporting PRB687295 |                 | Real-time auto-refreshing of single score widget does not work | In a Helsinki Patch 1 or later instance:  
1. Add a single score on a count aggregation to the dashboard (e.g. critical incidents).  
2. In the widget settings, toggle real-time auto-refresh.  
3. Remove or add a critical incident.  
   
   Note that nothing auto-changes, and it updates only after a manual refresh. |                                                                                                  |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| SDLC PRB631347 | Agile Development | UI actions scripts that contain more than 4000 characters get truncated on instances running Oracle | For example, when installing the SDLC plugin(s) in an instance that has an Oracle DB, there are UI actions that are being truncated because of the max_length in the dictionary record of the “script” field. This causes many problems because the UI actions are unusable, since the scripts are truncated and the UI actions do not work as expected. | In an instance with an Oracle database:  
1. Install the SDLC plugin(s).  
2. Note there are UI actions are truncated and unusable. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog PRB684012 |  | Using the maintain cart layouts, when no field is selected on the ordering widget, the widget gets hidden if the price is updated | 1. Set the system property ‘glide.sc.use_cart_layouts’ property to true.  
3. Go to the Components tab and deselect all the options: Price (the fields related to price e.g. recurring price, subtotal, recurring subtotal), Quantity, Delivery Time.  
4. Go to Tab and make sure only one button (either order item OR order now) is selected. Deselect all other buttons.  
5. Now, go to any catalog item (that has some price) and check the ‘use_cart_layouts’ checkbox, in order for it to use the default cart layout.  
6. Create a variable of type ‘select Box’. Add some choices and give some price to each choice.  
7. Now, try the catalog item. You can see that there are no any components in the ordering widget except order now button.  
8. Now, without the new variable, try to change the option. Note that the ordering widget is hidden. | |
<p>| Service Mapping PRB681639 |  | Merge table closure is not efficiently handling large tables | Merge table closure will consume a high amount of CPU (on the MID) when the input tables are large (&gt;5000). | |
| Service Mapping PRB682516 |  | Service Mapping CyberArk integration does not fall back to IP address | When an initial query using the object name fails, ServiceMapping fails to create a query to CyberArk using the IP address instead. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Mapping PRB684555</td>
<td>Service Mapping</td>
<td>Service Mapping fails to identify listening port correctly when using lsof on UNIX systems</td>
<td>On AIX/Solaris/HPUX, Service Mapping may use lsof to determine process listening on a given port. The lsof command issued is not filtering listening ports, so sometimes the result is, mistakenly, another process on the same machine that has established a connection to the given port.</td>
<td></td>
</tr>
<tr>
<td>Service Mapping PRB688125</td>
<td>Service Mapping</td>
<td>Service Mapping is inserting to the CMDB qualifier CIs without discovery_source field populated</td>
<td>This happens in Helsinki, in addition to upgrades from Geneva to later versions.</td>
<td></td>
</tr>
</tbody>
</table>
| Service Mapping PRB688223 | Service Mapping | During Helsinki upgrade, business services’ Traffic based Discovery flag that is set to false is not updated in the Service Model | In instances that are upgraded to Helsinki, business services that have their Traffic based discovery flag set to false, are not synced correctly with the Service Model. Instead, the TBD flag is marked as true in the model. | 1. Create a business service in a Geneva instance with the Traffic based discovery flag set to false. 
2. Upgrade to Helsinki. 
The flag will appear as false in the UI, but when running discovery, TBD connections will be added to the map. |
| Service Mapping PRB690129 | Service Mapping | Load Balancer VIPs which serve all ports should be created with port set to blank | When creating a VIP via F5 LTM pattern, and the VIPs port is 0, the CI should be created with a blank port. Currently it is set to the entry point’s port. This causes the VIP not to merge with an existing one, created by Discovery, and then lose its relation to the LB, when HD is run again on the LB. | 1. Discover an F5 VIP that shows up with port 0 on the LB. 
2. Note the pattern creates a new VIP with the entry point’s port instead of merging with the existing VIP that has a blank port. |
<p>| Service Mapping PRB690502 | Service Mapping | Error on server request updateFetchMashup. | A long query on large maps causes error 400. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal PRB665895 | Service Portal widget is confusing | This PRB fix includes improved widget usability:  
• Standardized scripts and CSS blocks  
• Update rendering and layout of widget in portal using SCSS  
• Improved Widget Editor | | |
| Service Portal PRB668463 | NG shared components | Direct links with nav_to.do in the URL are not working | | |
| Service Portal PRB678072 | Data table widget might fail to show column label | Service Portal redirects cannot be set up because the following required files are missing:  
• SPLoginRedirect (script include)  
• SPEntryPage (script include)  
• SP NavTo Processor | In a Helsinki instance:  
1. Using the instructions in [Service Portal Single Sign On, logins, and URL redirects](https://docs.servicenow.com), configure the Service Portal.  
2. Try to use the Service Portal. The Service Portal does not work properly. The processor and the script includes are missing. | |
<p>| Service Portal PRB678231 KB0595135 | Service Portal redirects cannot be set up because required files are missing | The fix for this PRB removes the SPLoginRedirect script include as well as the SP NavTo Processor from the Login &amp; Redirect process. For more information about Service Portal Redirects, see <a href="https://docs.servicenow.com">Service Portal Single Sign On, logins, and URL redirects</a>. | | |
| Service Portal PRB679658 | c.server.update() and spUtil.get() does not allow to handle errors in the widget | The widget editor always displays a “Saved” message even when saving fails. | | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal PRB683177</td>
<td>glide.sc.price.display</td>
<td>The property “glide.sc.price.display” does not work for the Service Portal catalog in Helsinki. Even if “never” is set, the prices are displayed in the category.</td>
<td>In a Helsinki instance with Service Portal installed: 1. Navigate to All properties &gt; All &gt; Filter (glide.sc.price.display). Notice that value is set to non_zero. 2. Change the property value to never. 3. Navigate to Service Catalog &gt; Hardware. Notice that the price is not shown. 4. Navigate to the CMS Portal. Notice that the price is not shown (/ess/order_hardware.do). 5. Navigate to Service Portal &gt; Order Something. Notice that prices are still shown (/sp?id=sc_home).</td>
<td></td>
</tr>
<tr>
<td>Service Portal PRB683222</td>
<td></td>
<td>The ‘KB Most Viewed’ widget in Service Portal does not display all the fields to customize it</td>
<td>Users are unable to edit or modify the OOB ‘KB Most Viewed’ widget. When editing it, only the field ‘bootstrap color’ is displayed. The fields Title, Max Number, and KB category are missing.</td>
<td>In a Helsinki instance: 1. Navigate to Service Portal Configuration &gt; Designer. 2. Select the Knowledge Base page with the “kb_view” displayed at the bottom. 3. On the ‘KB Most Viewed’ widget, click the pencil to edit it. Notice that only one field (bootstrap color) is displayed. 4. On the ‘KB Top Rated’ widget, click on the pencil to edit it. Notice all the fields that are available for customizing the widget (Title, bootstrap color, Max Number, KB category).</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Service Portal PRB683333 |                  | Service Portal does not update price when updated by checkbox variable to reflect deselection | When ordering an item in Service Portal that has a checkbox with a price associated selecting (setting it to true), this will result in the price being increased based on the value. Deselecting it should reduce the price again, but this does not happen. | In a Helsinki instance:  
1. In the Service Catalog, modify the Apple iPhone 6s item.  
2. Create a variable named Expensive with a type of Checkbox and a price, if checked, of 1000.  
3. Order the iPhone modified above.  
4. Click the Expensive checkbox to increase the price from $799.00 to $1,799.00.  
5. Click the Expensive checkbox again to decrease the price back to $799.00.  
Note that this does not behave as expected, and the price remains at $1,799.00. |
| Service Portal PRB683559 | Mobile UI        | g_user_date_time_format is not accessible in the Service Portal                      |                                                                                                                                                                                                            | In a Helsinki instance:  
1. Open any catalog item - client script.  
2. Add the below piece of code to execute onLoad.  
   ```javascript  
   var format =  
g_user_date_time_format;  
alert("format")  
```  
3. Access the catalog item.  
4. The system fires an alert.  
   This is the expected behavior.  
If you open the same catalog item in the Service Portal, the system throws the error message below in the console:  
   ```javascript  
   Error while running Client Script "Disable carrier until device available":  
   ReferenceError:  
g_user_date_time_format is not defined  
``` |
<p>| Service Portal PRB683566 |                  | Service Portal creates excessive SessionDebug on production instances               | By default, glide.spform.log_sql is true when it should be false instead.                                                                                                                                                        |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal PRB683786 | | Conversation stream does not show image attachments added before insert (e.g. from the ‘Create a New Incident’ catalog item) | | In a Helsinki instance:  
1. Navigate to Create a New Incident in the catalog in Service Portal.  
2. Add an attachment before submitting the incident.  
3. Navigate to id=ticket page for the resulting incident.  
Note that your attachment is missing from the conversation stream. |
| Service Portal PRB683998 | | Double quotes in internationalization messages generate JS error on Catalog form and Order Guide | | |
| Service Portal PRB684086 | | CSS classes set to nested rows are not getting applied | | In a Helsinki instance:  
1. Go to the Service Portal Designer.  
2. Create a set of columns within a set of columns.  
3. Apply a custom CSS class to the nested Row.  
Expected behavior: It should apply the class that was applied.  
Actual behavior: The CSS class is not applied. |
<p>| Service Portal PRB684384 SCSS Bootstrap Theme, Service Portal for Enterprise Service Management | | A new portal should use default $grid-gutter-width bootstrap value | The bootstrap variable $grid-gutter-width should be 30px, the default value. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal PRB684427 | NG shared components | getMessage in Catalog Client Script doesn’t translate text for Catalog Item | In Service Portal, the `getMessage` function does not find the correct message translation when used in a Catalog Client Script. Instead, it merely returns the value passed into it. For example, `getMessage('hola mundo')` will display "hola mundo", instead of the English translation of "hello world" for a user with English. | In a Helsinki instance:  
1. Activate the plugin for I18N Spanish Translations.  
2. Use Service Portal for Enterprise Service Management.  
3. Create a Catalog Item with the following details:  
   - Name: Test  
   - Short Description: Test  
   - Catalog: Service Catalog  
   - Category: Can We Help You?  
4. Add a Variable to a Catalog Item from a related list:  
   - Question: Test  
   - Name: test  
5. Add a Catalog client script to a Catalog Item from a related list:  
   - Name: Show Translated Message  
   - UI Type: Both  
   - Catalog Item: Test  
   - Type: onLoad  
   - Applies on a Catalog Item View: checked  
   - Active: checked  
   - Script:  
     ```javascript  
     function onLoad() {
       // Type appropriate comment here,  
       // and begin script below  
       var message =  
         getMessage("Hola Mundo");  
       g_form.showFieldMsg('test', message, 'info');
     }  
     ```  
7. Create a new message:  
   - Key: Hola Mundo  
   - Language: English  
   - Message: Hello World  
8. Navigate to /sp.  
9. Click Order Something > Can We Help You? > Test.  
Verify that "Hola Mundo" did not get translated to "Hello World". This behavior should also occur in the Special Portal, but it does not. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal PRB686126 | Service Portal | Service Portal is not using the translations for the catalog item ‘container start’ variable title | The catalog item ‘container start’ variable ‘title’ is not translated in Service Portal. The expected behavior is that it appears as it does in the Service Catalog - i.e. the translation for the current session language is used if it exists. | In a Helsinki instance:  
1. Install Service Portal and any language plugin.  
2. Create a catalog item with ‘Container Start’ and ‘Container End’ variables.  
3. In the ‘Container Start’ variable, check Display title and fill in the ‘Question’ field (which is used for the title).  
4. Create a translation of that question field value (switch language, change the question, and re-save).  
5. View the catalog item in the Service Portal.  
Note the English question is used for the container start title. |
| Service Portal PRB686402 | Service Portal for Enterprise Service Management | In the Service Portal, “Search” is not shown on home page in mobile view | In mobile, search is not visible on the Service Portal. | In a Helsinki instance:  
1. Try to access service portal via mobile in any browser: https://&lt;instance&gt;.service-now.com/$sp.do?  
2. Note the Search option is not visible in the mobile view on the home page. However, search is visible for submenus, but not on the home page. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal PRB686410    |                  | Catalog Items of class 'Content Item' are not showing up in the new Service Portal but work as expected in the CMS portal | In a Helsinki instance:  
1. Activate the Service Portal plugin.  
2. Navigate to Service Catalog › Catalog Definitions › Maintain Items.  
3. Consider a Catalog Item ‘Cisco Jabber 10.5’ of class type Catalog Item in category ‘Software’.  
4. Notice that the Catalog Item is visible in the new Service Portal under Software Category.  
5. Now modify the class of the item to Content Item.  
Notice that ‘Cisco Jabber 10.5’ is no longer visible in the new Service Portal under Software Category. | Expected behavior: ‘Cisco Jabber 10.5’ is visible in the Service Portal.  
Actual behavior: The Catalog Item ‘Cisco Jabber 10.5’ is not visible.                                                                                                                                                                                                                                                                                                                                                       |
| Service Portal PRB687156    |                  | Included items without short_description are not shown in the Order Guide          | In a Helsinki instance:  
1. Create an Order Guide with an included item, where the included item has no short description.  
Note that the item is not there on the page.                                                                                                                                                                                                                                           |                                                                                                                                                                                                                                                                                                                                                                   |
| Service Portal PRB688329    |                  | Attachment delete dialog text is not translated                                    | In a Helsinki instance:  
1. View a record in the “ticket” page.  
2. Add an attachment.  
3. Click X to delete that attachment.  
“Are you sure?” is not translated. |                                                                                                                                                                                                                                                                                                                                                                   |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td></td>
<td>Unable to hide Label variables in Service Portal Service Catalog using UI policy actions.</td>
<td>The standard UI policy that hides variables in normal instances does not apply to Service Portal.</td>
<td>In a Helsinki instance:</td>
</tr>
<tr>
<td>PRB688345</td>
<td></td>
<td></td>
<td></td>
<td>1. Navigate to Service Catalog › Catalog Definitions › Maintain Items.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Personalize the list and add the No Search field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Search for the Access item (or any item), and set No Search to true.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Navigate to /sp.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Click Service Catalog and use the search box in the top right. Type Access and hit enter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Click the Service Catalog category selector on the right.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Expected/Actual behavior: Access does NOT appear in the search results.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7. Type Access into the search box again and wait for type-ahead to appear.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Expected behavior: Access will not be in this list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Actual behavior: Access is in the list, and clicking it will take you to the Access item.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>Service Portal</td>
<td>Type-ahead search widget in Service Portal shows catalog items that are not searchable (no search = true)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRB688383</td>
<td>Designer</td>
<td></td>
<td></td>
<td>1. Edit a widget and add console.log() in the JS panel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Open the Service Portal Designer and create a new page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Add the widget from #1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Expected behavior: console.log should only execute once.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Actual behavior: It executes twice.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Portal PRB689022</td>
<td></td>
<td>Show Help and Tooltip are not showing up on the Service Portal</td>
<td>In a Helsinki instance:</td>
<td>1. Open any catalog item and create a variable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Add a Tooltip for the variable in the Questions tab.</td>
<td>3. Check the Show Help checkbox and add help text.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Click Try it to run the catalog item. Observe the Tooltip and More help are displayed.</td>
<td>5. Open the same catalog item on the Service Portal. Observe the Tooltip and More Help are not displayed.</td>
</tr>
<tr>
<td>Service Portal PRB689425</td>
<td></td>
<td>Order Guide ‘Required Information’ (mandatory variable check) does not get reevaluated if conditions change (if for example mandatory variable is no longer required)</td>
<td>With the Service Portal/Order Guides, there is a check if the items in an order guide has any mandatory fields from the SC Catalog Item widget. This is seen in the UI via the ‘Required Information’ box, where it details the mandatory variables. If you remove one of the items with a mandatory variable, the ‘Required Information’ does not get updated and still list all mandatory variables. This in turn prevents submission of the order.</td>
<td>In a Helsinki instance:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Add two yes/no variables (order 100 and 200).</td>
<td>3. Add 2 items (Apple iPad 3 and Apple iPhone 5) on rule based, and use the two yes/no variables as condition for the rule based. If variable is ‘Yes’, the item/s will show.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Add 1 mandatory variable to the Apple iPad 3 and Apple iPhone 5 items.</td>
<td>5. Use the Order Guide via Service Portal - you should see the ‘Required Information’ list the two mandatory variables.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. Change one of the Yes/No variable to ‘No’. One of the item should disappear. Note the ‘Required Information’ still lists 2 mandatory variable, where it should updated with only 1 variable.</td>
<td>7. Click Submit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note that you get an alert ‘The following fields are incomplete”, and the transaction is aborted.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Portal PRB689449</td>
<td>Service Portal Social</td>
<td>Link-button widget does not allow users to set color in Widget Options</td>
<td>In a Helsinki instance: 1. Add the link-button widget to a page. 2. Ctrl+right click on the button and edit Widget Options. Note that you are unable to specify the color.</td>
<td></td>
</tr>
<tr>
<td>Service Portal PRB689642</td>
<td>Service Portal Social</td>
<td>Requests header menu and My Requests widget show different results</td>
<td>Instead of showing different results, they should use the same query.</td>
<td></td>
</tr>
<tr>
<td>Service Portal PRB690447</td>
<td>Service Portal Designer</td>
<td>SP code failed to parse text contain en-dash (–, wider hyphen)</td>
<td>When any text in the page contains en-dash (–, wider hyphen), users see the following error: “Unccaught InvalidCharacterError: Failed to execute ‘btoa’ on ‘Window’: The string to be encoded contains characters outside of the Latin1 range”. In legacy pages, the same text parses without any errors.</td>
<td></td>
</tr>
<tr>
<td>Service Portal PRB690862</td>
<td>Service Portal Designer</td>
<td>When you drag and drop a widget to another location in the Service Portal Designer, it will duplicate the widget instead of moving it over</td>
<td>In the Service Portal Designer, moving a widget from one container to another duplicates the widget instead.</td>
<td>In a Helsinki instance: 1. Create a test page with a few containers that contain more than one column. 2. Drag and drop a widget to column 2. 3. Move the widget you just dragged to the second column container below, to another column 2. Expected behavior: The widget should be moved, not duplicated. Actual behavior: The widget is duplicated.</td>
</tr>
<tr>
<td>Service Portal PRB691113</td>
<td>NG shared components</td>
<td>Select2 element images are not available if VTB is not installed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Control Integration PRB682873</td>
<td>Cannot import new applications from source control on instances with updates missing an application reference</td>
<td>When attempting to import an application from source control for the first time, the import will fail with the message “The application has been changed since it was last imported or exported. Either export the changes or elect to lose unsaved work.” This occurs even though the application does not exist and does not have any local changes. This can be triggered by the existence of any sys_update_xml record with an empty application value. (<a href="https://%3Cinstance%3E/sys_update_xml_list.do?sysparm_query=application%3DNULL">https://&lt;instance&gt;/sys_update_xml_list.do?sysparm_query=application%3DNULL</a>)</td>
<td>1. Find or create a Git repository for an application that does not exist on the target instance. 2. Ensure that neither the repository nor the application records already exist on the target instance. 3. Go to the sys_update_xml table and clear out the application value for at least one record. 4. Attempt to import an application from source control via Studio.</td>
<td>Expected result: Application should be successfully imported, since it did not exist previously and is not actually “dirty”. Actual result: Receive error about outgoing changes.</td>
</tr>
<tr>
<td>Team Development PRB673925</td>
<td>If Team Development is turned on, and too many local changes exist, performance issue when adding new versions</td>
<td>Team Development is designed to have fairly frequent pushes and pulls, which limit the number of local changes (sys_sync_change) that will be on an instance. However, if a customer does have thousands of a specific type of local changes (e.g. Dictionary), whenever they change that type, they may encounter performance issues and latency.</td>
<td>Have 2 instances with one as the parent of the other, using Team Development: 1. On the child, create many records of the same type (e.g. Dictionary). 2. After you have created ~5000 of the same type, create/update/delete this same type of record. Note that you will experience latency and you may even get a timeout failure. One common scenario is latency when saving a report. With 22,000 “Report Users and Groups” type changes and 7,000 “List Layout” type changes, this can result in 40+ seconds of latency when saving a simple report.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB656605</td>
<td>Recent selections popup coming up in tabbed view when the first writable field is in the second tab and is a reference field</td>
<td></td>
<td>In a Fuji instance with the Procurement plugin active:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1. Go to a purchase order record(proc_po) record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Important: Ensure that your viewing the record in tabbed mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Navigate Procurement › Purchase order, and open a purchase order which has state ‘ordered’ (e.g. PO00000010, OOB).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Now we need to change the form in such a way that you remove all the writable fields from the form and move it to the second tab. In other words, the first section should be completely read-only. The first tab should also be completely read-only. The second tab should have the first writable field as a reference field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Now, go to the second tab and enter something in the first writable reference field (Abel Tuter, if it is assigned to) and save it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Go to the same field, remove the name Abel Tuter, and save the form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Click on the same reference field. You will notice the recent selection (Abel Tuter) come up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7. Go to the first tab where there is no writable field at all.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8. Go to the list of purchase orders (proc_po.list) and open the form that you just opened.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Notice the recent selections appear in the left top side.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| User Interface (UI) PRB66491B |   | Totals out of alignment for values in embedded lists in printer-friendly version of form | For embedded lists on forms with dollar amounts with a total at the bottom, using the printer-friendly version of the page does not have the dollar total line up with the amounts above. | 1. Open an incident.  
2. Right-click the grey header > Configure > Form Layout.  
3. Add Expense Line > Task to the form and save.  
4. Double-click Insert a new row, then click the green tick next to the expense line number. A 0 dollar amount is added to the list.  
5. Repeat step 4 twice more so you have 3 entries. Note that the total already does not line up.  
6. Right-click the grey header and save the form.  
7. Click the cog in the top frame.  
8. Click Printer-friendly Version.  
Expected behavior: The total of dollar values entered should be under the list of values in the embedded list.  
Actual behavior: The total is one column to the right too far. |
| User Interface (UI) PRB664972 |   | UI16 navigator is not on the right and lists are rendered from right to left for users with RTL languages (e.g. Hebrew) |   | 1. Log in as an admin user.  
2. Install the I18N Hebrew plugin.  
3. Create an admin user with the language set to Hebrew.  
4. Log in as the user created above.  
Note the navigator is on the left, and lists (e.g. incident, change, problem) are not rendered from right to left. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) PRB665734 | | Form layout is aligned to the left in Hebrew | When the instance is in Hebrew, the forms are aligned to the left instead of the right. | 1. Activate the I18N: Hebrew Translations plugin.  
2. In a new tab, go to a problem record.  
3. In this new tab, change the instance language to Hebrew.  
4. Reload the problem record.  
Note the two columns in the form layout stayed in the same position instead of switching, since the alignment in Hebrew is right to left. |
| User Interface (UI) PRB674549 | E164 Compliant Phone Number | ‘field_decorations’ dictionary attribute does not work on ‘Phone Number (E164)’ field | | 1. Create a new UI macro.  
• Name: testingMacro  
• In between the jelly tags: &lt;span&gt;testing&lt;/span&gt;  
2. Open an incident record and create a new field:  
• Name: testPhone  
• Type: Phone Number (E164)  
3. ‘Configure Dictionary’ on testPhone field.  
4. Add the attribute:  
field_decorations=testingMacro.  
Notice that the UI macro is not applied to the testPhone field. |
| User Interface (UI) PRB675919 | | System Status shows wrong dates if the date format is changed | On the Service Portal’s System Status page, the dates do not display correctly if the date format has changed to “dd.MM.yyyy”. The System status page should show the last 5 days, even if the date format has been changed. | 1. Go to sys_properties.list.  
2. Filter for Name = glide.sys.date_format.  
3. Open the system property and set it to dd.MM.yyyy (by default, it is “yyyy-MM-dd”).  
4. Save the system property.  
5. Go to the System Status page in the Service Portal: https://&lt;instance_name&gt;.service-now.com/sp?id=services_status  
Note that the dates in the status History shows the last 5 months, not the last 5 days as expected. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI)</td>
<td>PRB678994</td>
<td>Transaction timeout after attempting to save a new Facilities Request due to SMFilters script include looping</td>
<td>If customer has a location which sets the parent location as itself, it can cause the transaction times out when saving a new record. This is caused by the script include SMFilters, which is called by the business rule “Populate Group - Qualification.”</td>
<td>1. Activate the Facilities Service Management plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• SMFilters script include: /nav_to.do?uri=sys_script_include.do?sys_id=f4a5602337832000158bbfc8bcbe5dc8</td>
<td>2. Navigate to cmn_location.list and open the record California.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Navigate to facilities_request.do and set the location to San Diego.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Fill in any other mandatory fields and save.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Expected behavior: The record should be created with the location set to San Diego.</td>
<td>Actual behavior: The transaction begins to loop and times out.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Visual Task Boards | Visual Task Boards | In Geneva, VTB requires global Update UI action to be active in order for UI/Data policy validation to work |                                                                                                                                                                                                              | 1. Navigate to an Incident form > Configure Form Layout.  
2. Create a new Field (e.g. Test style), add it on the form, and save.  
3. Create a data policy on the Incident table using the field you created in step 2 (e.g. Condition is when “State is Closed or Resolved” > Make “Test Style” is Mandatory).  
4. Navigate to task.list and make a filter where Task Type is Incident.  
5. Right-click on the State column > Show Visual Task Board.  
6. Move an Incident card to the Resolved or Closed state. Observe that move fails and notice if a popup from the data policy appears or not. |
<p>| Workflow           |                  | “Excessive workflow context warning logs - Stage not found in future” error          | Users see these warnings in the wf context logs when a stage is not found in the deterministic future for stage rendering.                                                                                     |                                                                                                                                                                                                                   |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short Description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Workflow  | Graphical Workflow Support | In workflow Create Task activity, when you select "Value" for the Populate task variables from, you are not allowed to set any values | In a workflow, add a create task activity. Change the Populate task variables from Values. A Set Value is supposed to be shown, then the field and value parameters, but users do not see anything and are unable to use the set values from values option. | 1. Create a new workflow on the task table or a table extended from the task table.  
2. Add a create task activity.  
3. Change the Populate task variables from Values.  
Note there is no space to set values. |

Fixes included with Helsinki Patch 3

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 2 Hot Fix 6**
- **Helsinki Patch 2**

  Note: PRB668917, which is in Helsinki Patch 2, is not included in Helsinki Patch 3.

- **Helsinki Patch 1 Hot Fix 1**
  This release includes the HP1HF1 PRBs that were also fixed in HP3. *
  - HP2 and HP3: PRB687962
  - HP3: PRB686241

- **Helsinki Patch 1**
- **Helsinki Fixes**

**Helsinki Patch 2 Hot Fix 6**

Helsinki Patch 2 Hot Fix 6 provides fixes for the Helsinki release.

For Helsinki Patch 2 Hot Fix 6:  
Build date: 05-25-2017_1812  
Build tag: glide-helsinki-03-16-2016_patch2-hotfix6-05-25-2017

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).

For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).

Note: This version is approved for FedRAMP.
Fixed problem in Helsinki Patch 2 Hot Fix 6

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
</table>
| CMDB PRB687008 | In the presence of multiple duplicate records, incorrect record gets selected as candidate for matching, leading to record reclassification | The code for processing for de-duplicating records in CMDB works as follows:
The code enumerates relations in the CMDB, based on criteria from the payload passed to the Identification Engine. The first phase creates a list of all the records involved in a certain relation with another record. The second phase refines the list down to the records that actually match the input data (thus detecting real duplicates). Finally, one of the records from the second list is used as the match for the Identification process. The problem is a code bug where the wrong list is used for the final step, thus leading to the selection of an incorrect record. |

Fixes included with Helsinki Patch 2 Hot Fix 6

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 2 Hot Fix 5
- Helsinki Patch 2 Hot Fix 4
- Helsinki Patch 2 Hot Fix 3
- Helsinki Patch 2 Hot Fix 2
- Helsinki Patch 2 Hot Fix 1
- Helsinki Patch 2
- Helsinki Patch 1 Hot Fix 3
- Helsinki Patch 1 Hot Fix 1

This release includes the HP1HF1 PRBs that were also fixed in HP2. *

- HP2, HP3: PRB687962
- HP3: PRB686241

- Helsinki Patch 1
- Helsinki Patch 0 Hot Fix 4
- Helsinki Patch 0 Hot Fix 3

This release includes the HP0HF3 PRBs that were also fixed in HP2. *

- HP1: PRB677407, PRB680182, PRB680620, PRB670075
- HP2: PRB677407, PRB680182, PRB680620

- Helsinki Fixes
Helsinki Patch 2 Hot Fix 5

Helsinki Patch 2 Hot Fix 5 provides fixes for the Helsinki release.

For Helsinki Patch 2 Hot Fix 5:

- Build date: 10-20-2016_1321
- Build tag: glide-helsinki-03-16-2016_patch2-hotfix5-10-20-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 2 Hot Fix 5

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Server Side Scripting PRB70210 | Redirect panel is not working in Helsinki 20 | The Redirect Panel fails to redirect to the specified page and gives a blank screen. Within the script, if you use wizard variables to build the URL and pass them to answer directly, then it fails as the answer is not recognizing the wizard variable values as string. | 1. Create a new panel of type Redirect Panel and attach it to any wizard.  
2. Make sure that you have a redirecting URL with some wizard variables used in it.  
3. Now, attach this to any wizard, and configure it to be called on some condition when you click the Next button.  
4. Run the Wizard.  
5. Select the condition that calls this newly created panel and click Next.  

It should call the URL built in the redirect panel, but it fails and shows a blank screen. |
| User Interface (UI) PRB692216 KB0597917 | Safari 10.x in MacOS Sierra sends users to UI11 16 | When a user logs into certain versions of a Fuji, Geneva, and Helsinki instance using Safari 10.0 (Mac Sierra beta version), they are redirected to UI11/ U14. The user agent off of the new Safari 10 is: “Mozilla/5.0 (Macintosh; Intel Mac OS X 10_12) AppleWebKit/602.1.38 (KHTML, like Gecko) Version/10.0 Safari/602.1.38”. | Refer to the listed Known Error KB article for details. |
## Problem

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI) PRB7133</td>
<td>Safari 10.0.1 redirects users to UI11 97</td>
<td>When a user logs into their Fuji, Geneva and Helsinki instances from Safari version 10.0.1, they are redirected to UI11 instead of UI16.</td>
<td>1. Set user agent string to: &quot;Mozilla/5.0 (Macintosh; Intel Mac OS X 10_12_1) AppleWebKit/602.2.7 (KHTML, like Gecko) Version/10.0.1 Safari/602.2.7&quot;. 2. Log in to the instance. UI11 appears.</td>
</tr>
</tbody>
</table>

## Fixes included with Helsinki Patch 2 Hot Fix 5

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 2 Hot Fix 4
- Helsinki Patch 2 Hot Fix 3
- Helsinki Patch 2 Hot Fix 2
- Helsinki Patch 2 Hot Fix 1
- Helsinki Patch 2
- Helsinki Patch 1 Hot Fix 3
- Helsinki Patch 1 Hot Fix 1

This release includes the HP1HF1 PRBs that were also fixed in HP2. *

- HP2, HP3: PRB687962
- HP3: PRB686241

- Helsinki Patch 1
- Helsinki Patch 0 Hot Fix 4
- Helsinki Patch 0 Hot Fix 3

This release includes the HP0HF3 PRBs that were also fixed in HP2. *

- HP1: PRB677407, PRB680182, PRB680620, PRB670075
- HP2: PRB677407, PRB680182, PRB680620

- Helsinki Fixes

## Helsinki Patch 2 Hot Fix 4

Helsinki Patch 2 Hot Fix 4 provides fixes for the Helsinki release.

For Helsinki Patch 2 Hot Fix 4: Build date: 09-15-2016_0757
Build tag: glide-helsinki-03-16-2016_patch2-hotfix4-09-14-2016

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).
For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).
Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 2 Hot Fix 4

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
</table>
| Persistence | Database pool sweeper job causes hanging database connection | The database connection hangs, due to a concurrent execution on the same database connection by a database pool sweeper thread and a thread handling regular transactions. If this occurs upon cache loading, it can cause an incomplete cache to be built (e.g. TableDescriptor). This can surface as various symptoms:  
  - Banner text shows as the word "null" (invalid table name: sys_script)  
  - System uses UI15 for all users when they expect UI16 (invalid table name "sys_user_preference")  
  - Node unreachable, blank page, 401’s etc. (invalid field name "sys_scope.scope")  
  - Fields display as the field name instead of field labels (invalid table name: sys_documentation)  
  - Integrations receiving HTTP 401 (invalid table name: sys_user)  
  - Users unexpectedly logged out after logging in (invalid table name: sys_user)  
  These issues are always preceded by a series of SEVERE errors during the GlideSweep on threads that are being "cleaned." The errors are preceded by a warning message similar to the following:  
  com.glide.db.pool.DBPoolSweeperJobStatus@15cd039  
  WARNING ***  
  WARNING *** caught error involving method getWarnings on connection 4 |
### Steps to reproduce

This issue occurs because of a data race between a thread which is retrieving rows from a streaming result set, and another performing database sweeper operations, specifically checking for active connections and warnings.

The stack traces for the two threads will be similar to the following:

**Thread 1**

```java
java.net.SocketInputStream.socketRead0(Native Method)
...  
java.net.SocketInputStream.read(SocketInputStream.java:170)
...  
org.mariadb.jdbc.internal.common.packet.RawPacket.nextPacket(RawPacket.java:82)
org.mariadb.jdbc.internal.common.queryresults.StreamingSelectResult.next(StreamingSelectResult.java:85)
```

**Thread 2**

```java
java.io.BufferedInputStream.read(BufferedInputStream.java:336)
...  
org.mariadb.jdbc.internal.common.packet.RawPacket.nextPacket(RawPacket.java:82)
org.mariadb.jdbc.internal.mysql.packet.MySQLRowPacket.getRow(MySQLRowPacket.java:86)
org.mariadb.jdbc.internal.common.queryresults.StreamingSelectResult.next(StreamingSelectResult.java:107)
org.mariadb.jdbc.internal.common.queryresults.StreamingSelectResult.close(StreamingSelectResult.java:123)
org.mariadb.jdbc.MySQLStatement.execute(MySQLStatement.java:282)
...  
com.glide.db.pool.DBConfigurationControllerSweeperJob.checkWarnings(DBConfigurationControllerSweeperJob.java:2)
```

### Fixes included with Helsinki Patch 2 Hot Fix 4

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 2 Hot Fix 3**
- **Helsinki Patch 2 Hot Fix 2**
- **Helsinki Patch 2 Hot Fix 1**
- **Helsinki Patch 2**
- **Helsinki Patch 1 Hot Fix 3**
- **Helsinki Patch 1 Hot Fix 1**

This release includes the HP1HF1 PRBs that were also fixed in HP2. *

- HP2, HP3: PRB687962
- HP3: PRB686241

- **Helsinki Patch 1**
- **Helsinki Patch 0 Hot Fix 4**
- **Helsinki Patch 0 Hot Fix 3**

This release includes the HP0HF3 PRBs that were also fixed in HP2. *

- HP1: PRB677407, PRB680182, PRB680620, PRB670075
- HP2: PRB677407, PRB680182, PRB680620

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• **Helsinki Fixes**

### Helsinki Patch 2 Hot Fix 3

Helsinki Patch 2 Hot Fix 3 provides fixes for the Helsinki release.

For Helsinki Patch 2 Hot Fix 3:

- **Build date:** 08-22-2016_1036
- **Build tag:** glide-helsinki-03-16-2016_patch2-hotfix3-08-17-2016

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).

For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).

---

**Note:** This version is approved for FedRAMP.

---

### Fixed problem in Helsinki Patch 2 Hot Fix 3

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistence PRB662782 KB0597336</td>
<td>MySQLCancel may kill future query if the current one has already finished before the kill statement was issued</td>
<td>Due to a <a href="#">bug in the MySQL Server</a>, the kill query (PID) statement may kill a future query on this connection if the current query has already finished before the kill statement was issued.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>

### Fixes included with Helsinki Patch 2 Hot Fix 3

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 2 Hot Fix 2**
- **Helsinki Patch 2 Hot Fix 1**
- **Helsinki Patch 2**
- **Helsinki Patch 1 Hot Fix 1**

This release includes the HP1HF1 PRBs that were also fixed in HP2. *

- HP2 and HP3: PRB687962
- HP3: PRB686241

- **Helsinki Patch 1**
- **Helsinki Patch 0 Hot Fix 4**
- **Helsinki Patch 0 Hot Fix 3**

This release includes the HP0HF3 PRBs that were also fixed in HP2. *

- HP1: PRB677407, PRB680182, PRB680620, PRB670075
- HP2: PRB677407, PRB680182, PRB680620

- **Helsinki Fixes**
Helsinki Patch 2 Hot Fix 2

Helsinki Patch 2 Hot Fix 2 provides fixes for the Helsinki release.

For Helsinki Patch 2 Hot Fix 2:

Build date: 08-10-2016_1023
Build tag: glide-helsinki-03-16-2016_patch2-hotfix2-08-04-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.
For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problem in Helsinki Patch 2 Hot Fix 2

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog PRB686241</td>
<td>Catalog UI policy on a new variable on a catalog item causes error on existing request items without the new variable</td>
<td>If a new variable or UI policy is added to an existing catalog item, fulfillers still working on existing requested items see an error.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>KB0596179</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 2 Hot Fix 2

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 2 Hot Fix 1
- Helsinki Patch 2
- Helsinki Patch 1 Hot Fix 1

This release includes the HP1HF1 PRBs that were also fixed in HP2. *

- HP2 and HP3: PRB687962
- HP3: PRB686241

- Helsinki Patch 1
- Helsinki Patch 0 Hot Fix 4
- Helsinki Patch 0 Hot Fix 3

This release includes the HP0HF3 PRBs that were also fixed in HP2. *

- HP1: PRB677407, PRB680182, PRB680620, PRB670075
- HP2: PRB677407, PRB680182, PRB680620

- Helsinki Fixes
Helsinki Patch 2 Hot Fix 1

Helsinki Patch 2 Hot Fix 1 provides fixes for the Helsinki release.

For Helsinki Patch 2 Hot Fix 1:

Build date: 08-03-2016_0830
Build tag: glide-helsinki-03-16-2016_patch2-hotfix1-07-23-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problems in Helsinki Patch 2 Hot Fix 1

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI) PRB702543</td>
<td>High CPU utilization is correlated to Record Presence transactions</td>
<td>Analysis of servers with high CPU utilization has determined that Record Presence can significantly increase CPU load. It has been observed that turning Record Presence off can lead to a 25% reduction in CPU load.</td>
<td>1. Toggle Record Presence off and on while hundreds of users interact with an app node. 2. Notice the difference in CPU load.</td>
</tr>
</tbody>
</table>

Fixes included with Helsinki Patch 2 Hot Fix 1

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 2
- Helsinki Patch 1 Hot Fix 1

This release includes the HP1HF1 PRBs that were also fixed in HP2. *

- HP2 and HP3: PRB687962
- HP3: PRB686241

- Helsinki Patch 1
- Helsinki Patch 0 Hot Fix 4
- Helsinki Patch 0 Hot Fix 3

This release includes the HP0HF3 PRBs that were also fixed in HP2. *

- HP1: PRB677407, PRB680182, PRB680620, PRB670075
- HP2: PRB677407, PRB680182, PRB680620

- Helsinki Fixes
Helsinki Patch 2

The Helsinki Patch 2 release contains fixes to these problems.

For the Helsinki Patch 2 release:

Build date: 06-30-2016_1135
Build tag: glide-helsinki-03-16-2016__patch2-06-15-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Security-related Fixes

Helsinki Patch 2 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 2, refer to KB0596138.

Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Performance Analytics PRB67875B | | Scores not in current domain are wrongly deleted in collection cleaner job | After the collection cleaner is finished, all scores with indicators or breakdowns (or breakdown level2) not in global domain are deleted, which is incorrect. Only scores with invalid indicators or invalid breakdowns (or breakdown level2) domains should be removed. | 1. Create an indicator in domain "global".  
2. Run the job collector to collect indicators created in 1 for some days (e.g. 30).  
3. Create an indicator in another domain.  
4. Run the job collector to collect indicators created in 3 for some days (e.g. 30).  
5. Navigate to scheduled jobs and run ‘Clean PA collections’ manually.  
Expected behavior: None of scores collected in 2 is deleted after job finished.  
Actual behavior: All scores collected in 2 are deleted after job finished. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| MID Server PRB677827 | | Multiline commands in SSHCommand with SNCSSH and must_sudo applies sudo only to the first line of the command | | 1. Create a multiline probe, the usual source of which is activities with multiline commands. Require sudo in the activity / set must_sudo in the probe.  
2. With j2ssh, the command gets wrapped in a script and executed altogether. Sudo is applied to the whole command. This is expected behavior.  
However, with SNCSSH, the command is executed directly, causing sudo to be applied only to the first line. |
<p>| User Interface (UI) PRB679621 | | Clicking the Calendar button next to a date field for a Catalog item causes the Calendar widget to appear at the top of the page rather than near the field | When you open a Date Field variable on a Catalog item, the Calendar widget appears at the top of the page rather than near the field. | Refer to the listed Known Error KB article for details. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) PRB659934 |                  | Accessing a public report from type List deletes the default record of the report table from sys_ui_list, causing the default list for a table to revert to its system-generated version | When having a public report from type list, accessing it results a deletion of the default record from the sys_ui_list table. This means that the list layout which was configured by the administrator is lost. In addition, a record is created by the guest user on the sys_ui_list table, where the View field is empty. | 1. Clear the cache.  
2. Navigate to incident.list.  
3. Confirm that there is a list for the incident table on the default view by going to the following URL - leave this window/tab open to refresh later: sys_ui_list_list.do?sysparm_query=view%3DDefault%20view%5Ename%3Dincident  
4. Create a public list type report on the incident table.   
   • Navigate to Reports › View/Run › Create a Report.  
   • Data: Table, Incident  
   • Save.  
   • From the Save drop down arrow, click Publish › Copy Public URL.  
5. Open an incognito window or another browser to make sure you have no active sessions to the system you were in.  
6. View the URL copied in step 4, and then close that browser.  
7. Refresh the list from step 3. Note that your task list is no longer there. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management | Time card management | Time Cards “Current” page does not work correctly when the instance or user has a custom date format | If the instance or the user has a date format that is not yyyy-MM-dd, the Time Cards > My Time Cards > Current page does not function correctly.  
- The New button on this page does not put the time card in the list, and the Generate Task Cards does not create new time cards from the planned tasks assigned to the user.  
- If the user creates a time card for themselves from the All list or any of the top lists in the Time Cards application, the time card does not display on the Time Cards > My Time Cards > Current page. | |
| UI Policy/Client Script | | Currency and option field label hint display “Security does not permit writing to this field” when made read-only | Refer to the listed Known Error KB article for details. | |
| Chat | | Closing a chat session on an end user’s side does not move chat into Close_Complete | 1. Start a Support conversation.  
2. As the end user, click End chat.  
Verify that the state does not change to ‘Closed_Complete’. | |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) | | Horizontal scrolling in sections/related lists does not show scroll bar until the very bottom | In Dublin, if there are more columns off-screen, a persistent horizontal bar was present at the bottom of the frame to show that there are additional columns. In Fuji, the scrollbar does not show up until the very bottom of the frame. A user does not know that additional columns exist until they are at the very bottom of the list/page. | 1. Go to incident.list and select any record.  
2. Configure the related lists and add Catalog Task > Parent.  
3. In the related list, click Edit. Take a large chunk (15+) of records and add them.  
4. In the related list, click the gear mechanic to personalize the list layout.  
5. Add a handful of columns (7 or more) to create a necessity for scrolling.  
Notice on the form you now have to scroll to the very bottom of the related list to even know there may be additional columns in the list. |
| Problem       | Affected Plugins | Short description                                                                 | Description                                                                                                                                                                                                                   | Steps to reproduce                                                                                                                                 |
|--------------|------------------|------------------------------------------------------------------------------------|---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
| Chat PRB667004 |                  | Geneva with legacy chat: SN session timeout interval not recalculating if user types in chat | 1. Navigate to Plugins > Chat. Ensure that only legacy chat is enabled - the new Connect Support should not be enabled.  
2. Enable the following Chat debug properties:  
  • glide.chat.log = true  
  • glide.chat.debug = true  
3. Override the base system 30 minute timeout by adding the ‘glide.ui.session_timeout’ system property with value: 5.  
4. Log into Chrome as System Admin.  
5. Launch /ess and click the Chat button in the upper right.  
6. Log into another browser as Fred Luddy, launch Social IT > Chat, then Answer.  
7. As Fred Luddy, type a message BEFORE the expected 5 min timeout and note the time.  
8. The session timeout prompt will still be received 5 minutes from opening chat_desktop.do.  
Log confirms:  
2016-03-17 09:42:43 (854) http-28  
New transaction  
FE55E294119612004E822E5B1A56A23A  
#14908 /chat_desktop.do  
2016-03-17 09:47:47 (691) http-7  
Session logout (AMB)  
FE55E294119612004E822E5B1A56A23A  
2016-03-17 09:47:47 (702) http-7 SYSTEM  
Session logout  
BC5409125F79F46286CCF93527B4BD37  
2016-03-17 09:47:47 (869) http-33  
New transaction  
FE55E294119612004E822E5B1A56A23A  
#15281 /amb_login.do  
© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Chat PRB674127 | Connect Support  | Customers activating Connect Support need to have legacy chat conversations moved to the Closed Complete state | When customers who have previously used legacy chat set a conversation limit in Connect Support, some support agents are unable to accept Connect Support conversations. This is because the system stores Connect Support conversations on the same table as legacy chat conversations, Chat Queue Entry (chat_queue_entry), and legacy chat conversations use a different field than Connect Support to indicate closure. If an agent is assigned more legacy chat conversations than the number specified in the connect.support.conversation_limit property, that agent cannot accept Connect Support conversations because the legacy chat conversations are seen as active. | 1. Have a few help desk chats open as an agent using legacy chat.  
2. Activate the Connect Support plugin.  
3. Set the connect.support.conversation_limit property to 1.  
4. As an end user, initiate a Connect Support conversation.  
5. As a Connect Support agent, try to accept the conversation. The system will not allow the agent to accept new support conversations. |
| Chat PRB675171 |                  | Setting ’collaboration.frameset’ to false prevents chat windows from appearing from avatar interactions | When right-clicking on another’s avatar, an option appears called “Open a new chat”. If collaboration.frameset is false, clicking this option produces no output since the frameset appears to control the appearance of the chat window. | In a Geneva instance:  
1. Set collaboration.frameset to false.  
2. Try to open a new chat with a user using avatar interaction. The easiest way is to open a VTB and attempt to open a chat with yourself. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Chat PRB676067 | Collaborate Actions: Even after ‘Transfer’ to another queue, ‘conversation.table’ record still references the previous chat_queue_entry_record | In a Geneva instance: 1. Enable the Connect and Connect Support plugins. 2. In one browser session, impersonate Abel Tuter. 3. In another browser session, impersonate Don Goodliffe. 4. As admin, navigate to Collaborate > Actions. 5. Add this gs log entry in the script for 'Create Incident' action and Save: 
```javascript
gs.log("conversation record" + conversation.document.sys_id); ``` 6. As Abel Tuter, go to 'ess' and initiate a Service Desk chat. 7. In Don Goodliffe’s session, Transfer the chat to HR Support. 8. Impersonate Beth Anglin and Accept the HR Support chat. Create an incident and Save the incident. 9. As admin, verify the script logs. The sys_id from the log statement refers to the old chat_queue_entry instead of the new one. |
<p>| Chat PRB677031 | Connect Follow Widget has race condition when checking whether it is loaded in the frameset | The Connect Follow Widget checks the top frame for ‘nav_to.do’ in the pathname, but when a user goes directly to a frameset link, the pathname initially contains ‘navpage.do’. | 1. Go to an Incident within the frameset. 2. Copy and paste the same URL into your browser. 3. Navigate to the page. The Connect Follow Widget does not offer the &quot;Open Connect Mini&quot; option in the dropdown. Expected behavior: The Follow widget should be aware that it is in the frameset. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Chat                   | PRB678351        | When opening a record in Connect via Follow, avatars from existing notes do not render in Connect Mini and Full | Avatars do not render when a chat created off a record with existing worknotes/comments is submitted by other users. | 1. Open a record that has a few worknotes and comments submitted by users who have profile avatars.  
2. Make sure this record has not been followed before.  
3. Click on Follow and Open in Connect Mini.  

The record conversation is moved to Connect chat, and user avatars are not rendered. |
| CMDB                   | PRB678421        | Relation dashboard may have performance issues, which may cause the node to have memory issues |                                                                                   |                    |
| Configuration Management Application | PRB666439 | Edit button disappears for admin users after activating the Chef Configuration Management plugin | After you activate the Chef Configuration Management plugin, the edit button on the Roles related list for sys.user disappears for an admin user. This occurs when the admin user is viewing a user record that has the itil role if itil inherits other roles. | 1. Log in as admin.  
2. Activate the com.snc.chef plugin.  
3. Go to sys.user and open a user record.  

If the user has the itil role, the edit button does not appear. If the user does not have the itil role, give them the itil role and you will see the button disappear. |
<p>| Core Platform          | PRB680749        | SecurelyAccess unable to retrieve files when instance name contains blacklisted terms | Access to external files is restricted if the path contains one of the following blacklisted terms: sys.scripts, classes, lib, conf, and properties. If the name of an instance contains one of these terms, then any file access attempts with SecurelyAccess will be blocked. |                    |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
2. Log in as a user with the customer role to the Service Portal: http://<instance-name>/csm.  
3. Click Live Chat.  
4. Type your question and press enter. You will notice that the chat page keeps loading.  
5. Open the console window.  
Note the following error:  
Conversation 0975f8dd89102200964fb00d9a2a0a0b does not exist  
angular_includes_1.4.jsx? v=06-24-2016_1627:109 (anonymous function) |
| Demand Management PRB670592 | Project Management Project Management TeamSpace 1, Project Management TeamSpace 2, Project Management TeamSpace 3, Project Management TeamSpace 4, Project Management TeamSpace 5, Resource Management Project Portfolio Suite, Timeline Visualization, Demand Management | The role tsp1_demand_manager contains role demand_manager causing a security issue for user of team spaces | When using Demand Management in team space 11, the role tsp1_demand_manager contains role demand_manager. Anyone with the demand_manager role can access demands across team spaces if they have the correct URL. If you remove the demand_manager role from the tsp1_demand_manager, users are unable to see the demand workbench in their team space. These team spaces need to be secure from other roles in the system. | 1. Install Teamspace 1.  
2. Give a user the tsp1_demand_manager role.  
3. Impersonate the user and access the demand workbench - this should work as expected. Unimpersonate the user.  
4. Navigate to User Administration > Roles > tsp1_demand_manager.  
5. Remove demand_manager from the Contains Role related list.  
6. Impersonate the same user in step 3.  
7. Access the Teamspace 1 workbench.  
Access is denied, due to insufficient rights. |
<p>| Dependency Views (BSM Map) PRB679688 | | DV: The search map &gt; provider contains items which are null | When searching for a CI, but the CI and its permissions are sent as null values, the Dependency Views search does not function as expected. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Discovery PRB667447 | SAM Software Installation table Last Scanned and Discovery Source fields are not updated by Discovery or HTHD | During a discovery, the Software Asset Management plugin Software Installations table’s (cmdb_sam_sw_install) Last Scanned and Discovery Source fields are not updated by Discovery.  
• In Eureka: Last Scanned field is updated; Discovery Source is not.  
• In Fuji/Geneva: Neither field is updated.  
If an instance had discovered things while running Eureka, those values will not get updated or cleared after upgrading. The values will get more and more incorrect. Although cmdb_sam_sw_install does not extend cmdb/cmdb_ci, these fields would be expected to be filled in the same way as a CI. | In a Fuji or Geneva instance:  
1. Install the ‘Discovery’ and ‘Software Asset Management’ plugins.  
2. Set up a Windows MID Server.  
3. Do a quick discovery of 127.0.0.1 via the MID Server, to discover that MID Server.  
Several records will be created. Updated and Updated by will show that the MID Server just added those records, but the Last Scanned and Discovery Source fields are empty. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovery PRB672949</td>
<td></td>
<td>When multiple MID Servers start against the same instance, ECCQueueMonitor transactions fail with HTTP/1.1 429 Too Many Requests with code: 429</td>
<td>This results in two issues: 1. Probes are struck in the processing state, and the MID Server loses track of these probes. 2. There are sensors errors due to 3p scripts.</td>
<td>1. Install and set up 50+ MID Server instances. 2. Look at agent logs.</td>
</tr>
</tbody>
</table>

Note the following sensor errors:  
- When processing Unix - ADM:  
  Sensor is expecting JSON format in the output field after probe post processor script. Please check that your MID server is up to date. (sys_script_include.77801130a0a0b2500c4595ad1d1d768; line 24)  
- When processing Linux - Amazon EC2:  
  Sensor is expecting JSON format in the output field after probe post processor script. Please check that your MID server is up to date. (sys_script_include.77801130a0a0b2500c4595ad1d1d768; line 24)
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Discovery PRB674184 | File Probe Template may still execute even if a matching local file based probe does not exist | File probe templates limit what probe a MID Server may execute to probes that only exist on a file system. Starting with Geneva, even though there is an error that indicates a template does not exist, the probe is still executed. An input ecc_queue record is returned that contains both an error and the results of the probe. | In a Geneva instance: 1. Create a new Linux MID Server (or link an existing one). 2. On the MID Server host, create some file location to use where you would store these File Probe Templates (e.g. /tmp/probes). 3. In the config.xml file on this MID Server, add these following parameters: <parameter name="file_probe_template_dir" value="/tmp/probes"/> <parameter name="file_probe_template_debug" value="true"/> ("file_probe_template_dir" is the location you created from step 2 above and "file_probe_template_debug" is optional, but available to use)  
Note: Do not add "file_probe_template_capture", as this will allow you to create new records here, which is not what we want at this time. 4. In your instance, open the ecc_queue list view and create a new record here with these values:  
- Agent: mid.server. (MID Server name)  
- Topic: Command (or SSHCommand)  
- Name: ls -l  
- Source: (Can leave empty or put the localhost IP of the MID Server)  
- Queue: output  
- State: ready  
As this command runs and you get the input back, you may get the following error:  
Probe not executed. file probe template not found: Command ls -l |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain Support PRB678029 KB0594841</td>
<td></td>
<td>Upgrades to Geneva for instances with domain-separated tables results in reinstalling domain paths which extends the duration of the upgrade</td>
<td>ServiceNow engineers have identified a scenario that will cause upgrades to Geneva to take more time than normal if the domain path data is incorrect before the upgrade. The upgrade will automatically fix the errors and there will be no adverse impact to the instance; however, this problem will increase the upgrade time as the data in all the domain-separated tables are updated.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Event Management PRB675347</td>
<td></td>
<td>Bulk event send, which is being used in events sent from the MID, does not use the dedicated EM semaphore</td>
<td>In Geneva, event sending was switched from REST to sending events in bulk using SOAP. Event Management has a dedicated pool of 4 semaphores (threads) dedicated for event reception. These are defined in the sys_semaphore table. However, the definition in that table is only for the API, not the SOAP. As a result, events sent using SOAP are being received by the default semaphore pool, which can potentially cause the UI to become unresponsive.</td>
<td></td>
</tr>
<tr>
<td>Financial Management PRB673080</td>
<td>Financial Management</td>
<td>Global write ACL on sys_user table is making fields read-only after turning on Project Portfolio Suite with Financials plugin</td>
<td>The global write ACL on sys_user table ACL returns false and has no other script in it.</td>
<td>1. Install the Financial Management plugin 2. Log in as a non-admin user and navigate to a user record.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Forms   | PRB677496       | Duplicate .js include files causes degradation in form performance | 1. Open the developers console.  
2. Go to any incident record.  
3. In the search box in the console section of the developers tools, type in GlideMenu.js or CookieJar.js.  
Note these files are loaded more than once. There are 34 JavaScript files that are loading twice or more. |
| Knowledge Management | PRB658812 | Knowledge Management V3 | KMv3-style category picker not available on KB article form | 1. Go to create a new Knowledge Base article.  
2. Select Support and Troubleshooting as the Knowledge Base.  
3. Click on the magnifying glass next to the Category field.  
Notice that the KMv3-style category picker does not appear. |
| Knowledge Management | PRB666632 | Social Q&A | When asking a question, the category list is empty and a 400 Bad Request error is encountered in the logs if the selected KB contains a large number of categories | In a Geneva Patch 4 instance with a Knowledge Base with many categories (e.g. 134 categories):  
1. Navigate to Knowledge > Homepage.  
2. Click the IT category.  
3. From the ‘Create New’ dropdown, choose Question.  
4. Click the Category field dropdown.  
Expected behavior: The categories in the IT knowledge base appear in the dropdown.  
Actual behavior:  
• No categories appear in the dropdown. A ‘400 Bad Request’ error appears in the ‘Network’ area of the web console.  
• If you open /kb_category_list.do and set active = false on a large number of the categories (e.g. so there are only about 50 that are left active = true), the issue will not occur. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management PRB668485</td>
<td>Knowledge Management V3</td>
<td>Knowledge Category Picker throws error when ampersand (&amp;) is in Category name when glide.ui.escape_text = false</td>
<td>Knowledge Categories with an ampersand (&amp;) in the label cause an error when using the KB Category Picker (kb_categories_dialog) in a Knowledge form to select a category: The entity name must immediately follow the ‘&amp;’ in the entity reference.</td>
<td>1. Navigate to kb_category.list. 2. Modify the demo category Applications to Software &amp; Applications (this should be a part of the IT Knowledge Base if demo data is loaded). 3. Navigate to sys_properties.list. 4. Set glide.ui.escape_text to false. 5. Open or create a Knowledge article (kb_knowledge.list). 6. Set the Knowledge Base to IT. 7. Click the Reference icon next to Category to launch the Category Picker UI page (kb_categories_dialog). Note the following error: “The entity name must immediately follow the ‘&amp;’ in the entity reference.”</td>
</tr>
<tr>
<td>Knowledge Management PRB670482</td>
<td>Knowledge Management V3</td>
<td>Knowledge Base page is showing ‘Knowledge Featured’ and ‘Most Viewed’ blocks on Fuji but not on Geneva</td>
<td>1. In Geneva, go to an individual Knowledge base (e.g. HR or IT). 2. Go back to Knowledge Home by selecting All in the Knowledge Base selection dropdown. Observe that the ‘Featured Content’, ‘Most Viewed’ and ‘Most Useful’ links are missing on the Knowledge homepage. The same steps work in Fuji.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Knowledge Management PRB670704 | Knowledge Management V3 | Cannot select empty KB Category when using KB import tool | A user is unable to select an empty category when uploading an article to a knowledge base, using the import tool available in the top right corner. The user reported that it occurs after the first article is uploaded when they reopen the dialog. | There must be an empty knowledge base with an empty category (e.g. “Empty KB” and “Empty Category”).  
1. Navigate to Knowledge › Homepage › Import.  
2. Select a file by dragging it or selecting it from the file explorer.  
3. Open the knowledge base selector and select Empty KB.  
4. Open the category selector.  
Note there is no entry for “Empty Category.” |
| MID Server PRB667255 | | CIM hangs when disconnecting after connection to a bad HTTP server | The CIM can get into a state where it hangs for all requests on a particular MID Server. It tries to shut itself down when there are no active requests, including shutting down its HTTP client. The Apache HTTP client seems to be particular about what thread it gets shut down from and it hangs while inside a synchronized block. This results in a permanent hang. | |
| MID Server PRB676044 | | Converge failure in provisioning workflow due to __SNC_PWD_PROMPT__ error | The Converge Command (built from Run Command) fails when SNCSSH is enabled on the MID Server. |  
1. Start the Provisioning DBI Instance Workflow from the Service Catalog.  
2. Open workflow context › show workflow.  
Provisioning should be complete, but the converge activity fails. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| MID Server      |                  | MID Server should be able to handle pbrun with -u profile option | This affects customers who are upgrading from the Nebula version (where ServiceWatch was a separate app) to Helsinki, where this is integrated. When using pbrun as a privileged command, customer should be able to append -u option to it and specify a profile. The fix for PRB677354 adds support for pbrun with -u profile option. Refer to Configure the MID Server to use specific privileged commands for details. | 1. Set the MID configuration parameter mid.ssh.privileged_commands = pbrun -u admin.  
2. Add the credential pbadmin:pbadmin.  
3. Create a probe with topic = SSHCommand, ECC queue name = sudo dmidecode.  
4. Run the probe again.  
We should get correct result back instead of Permission denied. |
| MID Server      |                  | MID Server is reporting stats too aggressively, causing it to consume too many SOAP semaphores | In Helsinki per PRB664693, the rate for which the MID Server reports queue.stats was changed from 10 minutes to 2 minutes. For a customer with many MID Servers, this may lead to excessive consumption of SOAP semaphores. In addition, the data was processed by an after insert Business Rule which would prolong the time the semaphore is held. This PRB will revert the rate to 10 minutes and change the BR “MID - Process XMLStats” to be async on insert. |                                                                                     |
| MID Server      |                  | MID Server leaks memory when it fails to create SSH session | When a MID Server fails to create a SSH session, it will leak about 100 bytes of memory. The next time the MID Server fails to create a session with same key, it will be the same 100 bytes leaking, not another 100 bytes. This is related to PRB680106. | 1. Set up credentials for a MID Server.  
2. Use the MID Server to discover a Linux machine.  
3. Use JProfiler to monitor the MID Server’s memory. Look for com.service-now.mid.services.SSHSharedSessionCache in live memory.  
There will be an empty element with key and value that never be garbage collected, which is the leaking. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Mobile PRB674080 | Mobile UI | Changing components under ‘Order Status’ screen has no effect on mobile app | In a Geneva instance:  
1. Navigate to Maintain Cart Layouts and click Order Status Screen (Mobile).  
2. Under components, clear the checkboxes for ‘Order Placed Date’, ‘Request Number’ and ‘Estimated Delivery Date’.  
3. Save.  
4. If the system property ‘glide.sc.use_cart_layouts’ is not enabled, set it to true and enable it.  
5. Log in to your instance from mobile app and request a new item in the catalog.  
6. Submit the order.  
On the order status screen, you will be able to see all the three fields that you disabled (‘Order Placed Date’, ‘Request Number’ and ‘Estimated Delivery Date’).  
| | | | Note: When you try this from the mobile interface ($m.do), it works as expected. This does not work with the mobile app. |
| Mobile PRB67700 | Mobile UI, NG shared components | In mobile web), catalog items with a large amount of variables will throw a 400 when attempting to fetch the variable list | Catalog items with lots of variables will not work with reference fields. | 1. Navigate to Maintain Items and search for Ask a question.  
2. Navigate to the Variables related list.  
3. Create 5 new variables for this catalog item.  
4. Go to $m.do.  
5. Navigate to Service Catalog › Can We Help You › Ask a question.  
6. Add text to the variables on the item.  
7. Click the User reference field.  
Notice the 400 bad request. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Mobile  |                 | When logging out of the Mobile web UI on mobile devices and logging back in, the welcome.do is displayed | When the system property glide.ui.m.helsinki_mobile_enabled is set to true (or via System Properties > Mobile UI Properties), the user can be redirected to welcome.do when logging out and logging back in on a mobile device. The issue seems to only occur on a mobile device, not desktop or tablet. | 1. Navigate to System Properties > Mobile UI Properties.  
2. Tick the second option on the page (enables the updated mobile web experience, available since Helsinki) and save.  
3. Open up the instance on a mobile phone device (in the Chrome browser).  
4. Log in to the instance, making sure the URL contains /$m.do.  
5. Click Profile > Log Out.  
6. Log back into the instance again on the mobile phone device.  
Instead of being taken to the home page (http://instance.service-now.com/$m.do#/home), you are taken to the welcome.do page (http://instance.service-now.com/$m.do#/view_page).|
| Mobile  | NG shared components | In the iOS app, Japanese (and possibly all unicode) input as a comment/worknote saves corrupted values | In the iOS app, comment on an incident and save. The Japanese characters will change to unreadable corrupt characters. | |
| Mobile  |                 | When attempting to view HTML fields on the native app, the HTML field preview is not displayed | Previewing an HTML field does not work on the native application, but it does work on the mobile web. This was a new feature in Helsinki that is not functioning correctly. This is related to PRB665860. | 1. Log in to an instance with the native app.  
2. Go to an incident with an HTML field on it. If there is no HTML field, add one to the incident form.  
3. Click the preview (i) to display the HTML field rendered contents.  
Notice that the field is not previewed on the native application. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration PRB676405</td>
<td></td>
<td>Add filters on SCCM GET activities to limit the data retrieved from SCCM server</td>
<td>If SCCM Get activities retrieve the entire data set from SCCM server, the data set can be up to 25 M. The data is uploaded as an attachment onto ECC queue input record. In order to allow the activities to process the ECC queue attachment, the system property “com.glide.attachment.max_get_size” needs to be added to 25 M, which will risk running the instance out of memory.</td>
<td></td>
</tr>
</tbody>
</table>
| Performance Analytics PRB661575 | Performance Analytics | Users with pa_contributor and pa_viewer roles are able to edit scores of all indicators |                                                                                                 | 1. Create a user with the pa_contributor and pa_viewer roles.  
2. Log in as that user.  
3. Go to a scoresheet.  
Note that you can edit scores of any indicator.                                                                 |                                                                                                       |
| Performance Analytics PRB669205 | Performance Analytics | Previous period chart does not work properly | Checking the previous chart period in a widget does not display the x-axis with the labels properly. It shows 1970 and does not compare the previous period. | 1. In HI, create a widget called test with an indicator “RL: Incidents Enterprise - BU” and select the time series as quarter sum +.  
2. Make it a time series column chart, and the chart displays data for Q12016 and Q42015.  
3. Edit the widget and check the previous period chart.  
The chart shows “1970” as the x-axis. The columns are displayed in reverse order - Q12016 shows up first. Q12015 is missing in the chart. |                                                                                                       |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance</td>
<td>Analytics</td>
<td>An indicator with a default time series will lose the default series in a widget in a breakdown dashboard</td>
<td></td>
<td>1. For the indicator ‘Number of open incidents’, set the default time series to by month sum.</td>
</tr>
<tr>
<td>PRB676461</td>
<td></td>
<td></td>
<td></td>
<td>2. Create a list widget in a breakdown dashboard. The breakdown source is Incident.Priority.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Add the indicator to the list widget.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Set follow element for this indicator to true.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Go to the dashboard</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Switch the element to priority 1-critical.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Actual behavior: The default time series is not applied. The Number of open incidents / Priority = 1 - Critical.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------</td>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Performance Analytics</td>
<td></td>
<td>PA Dashboards</td>
<td>User can define colors that are missing the color code or malformed codes without a method to prevent them and/or no user readable error is displayed.</td>
<td>1. Navigate to Reports › Administration › Color Definition (sys_report_color_list.do).</td>
</tr>
<tr>
<td>PRB678225</td>
<td></td>
<td>widgets fail to load due to</td>
<td></td>
<td>2. Open any already defined color, or create new one.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Color Definition</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

One of the following occurs:

- A user can remove the color field and save that color without a color code. Then, PA Dashboard widgets fail to render when using that color.
- A user can add a trailing space to the color code and it is validated by displaying that color. Then, PA Dashboard widgets fail to render when using that color. You will see 'Loading...' messages within widgets, or not all widgets will render on the page, or you will see 'empty/white space' within widgets.

9EA371694FA71E0B41E5995F110C701
SEVERE *** ERROR ***
String index out of range: 0
java.lang.StringIndexOutOfBoundsException
String index out of range: 0
at java.lang.String.charAt(String.java:686)
at com.glide.util.ColorUtil.loadLookup(ColorUtil.java:87)
at java.lang.Integer.parseInt(Integer.java:458)
at java.lang.NumberFormatException.forInputString(NumberFormatException.java:48)
at SEVERE *** ERROR ***
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform Security PRB668917</td>
<td></td>
<td>Password2 length should be enforced to 255</td>
<td>Performance degradation occurs while using GlideRecordSecure when the record being queried contains fields such as variables, audio, userImage, currency, and possibly other fields.</td>
<td>1. Create a new table.&lt;br&gt;2. Add several currency fields to it, along with other dummy fields (e.g. name, description).&lt;br&gt;3. Create an entry under sys_relationship table:&lt;br&gt;   • Applies to table is incident&lt;br&gt;   • Queries from table is the new table created in step 1&lt;br&gt;4. Add a query such as current.addQuery(''SOME FIELD IN THE NEW TABLE'', 'SOME_VALUE_THAT_MATCHES_A_LOT_OF_RECORDS');&lt;br&gt;5. Add many records to the new table.&lt;br&gt;6. Create a list edit ACL on the new table, and add a condition and a query using some fields on the table.&lt;br&gt;   When you open an existing incident, note that the AJAX call to fetch the records under the new embedded list is taking a lot of time to get the response back. Enable SQL debugging. Note that for every currency field under every record under the new embedded list, a GlideRecord query is being made when getSpecificDisplayValue is done.</td>
</tr>
<tr>
<td>Platform Security PRB674503</td>
<td></td>
<td>Performance degradation when using GlideRecordSecure when the record being queried contains fields such as variables, audio</td>
<td>Performance degradation occurs while using GlideRecordSecure when the record being queried contains fields such as variables, audio, userImage, currency, and possibly other fields.</td>
<td>1. Create a new table.&lt;br&gt;2. Add several currency fields to it, along with other dummy fields (e.g. name, description).&lt;br&gt;3. Create an entry under sys_relationship table:&lt;br&gt;   • Applies to table is incident&lt;br&gt;   • Queries from table is the new table created in step 1&lt;br&gt;4. Add a query such as current.addQuery(''SOME FIELD IN THE NEW TABLE'', 'SOME_VALUE_THAT_MATCHES_A_LOT_OF_RECORDS');&lt;br&gt;5. Add many records to the new table.&lt;br&gt;6. Create a list edit ACL on the new table, and add a condition and a query using some fields on the table.&lt;br&gt;   When you open an existing incident, note that the AJAX call to fetch the records under the new embedded list is taking a lot of time to get the response back. Enable SQL debugging. Note that for every currency field under every record under the new embedded list, a GlideRecord query is being made when getSpecificDisplayValue is done.</td>
</tr>
<tr>
<td>Platform Security PRB681602</td>
<td></td>
<td>Too many cache misses on the role cache</td>
<td>The cache size of the roles cache is too small for many of the large instances.</td>
<td></td>
</tr>
<tr>
<td>Policy and Compliance PRB670553</td>
<td></td>
<td>Knowledge base records are created / updated when activating the IT Governance, Risk and Compliance (ITGRC) (com.snc.governance plugin</td>
<td>The following file could potentially load the demo data Knowledge Bases when GRC is installed: app-itbm/glide-app-grc/src/main/plugins/com.snc.governance_core/update/kb_knowledge_base.xml.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------</td>
<td>----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Policy and Compliance PRB674394| GRC compliance percentage is calculating incorrectly | 1. Create a control - Control 5.  
2. Create a control definitions - Control def 100.  
3. Execute the control def 100 three times with test_status=success, failure and success respectively.  
4. Since the latest test result is “success”, the compliance = 100 and non-compliance = 0.  
5. Delete the first def with status = success. | The compliance should be 100 as the latest control def is “success”, but compliance falls to zero. |                                                                                                                                                 |
| Project Management PRB664923    | Planning Console - When returning from a task or relationship detail, form is reloaded and expanded sections collapsed | Scenario 1  
1. Use the planning console to display a simple project, with a project task with children project tasks.  
2. Double-click on one of the task bars to show the detail of the record, then click the back button.  
3. On redraw, the expanded tasks are collapsed. |                                                                                                                                                 |
|                                 |                  | Scenario 2  
1. From the planning console, go to a Child Project Task, right-click, and select Edit.  
2. Make any change to the child Project Task and click Update.  
3. When the system goes back to the planning console, all of the Project Tasks and child Tasks in the Planning Console are collapsed. |                                                                                                                                                 |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting PRB678332</td>
<td>Calendar reporting 1 day shift back on date values</td>
<td>In the new calendar, “Date” type values are being converted from UTC (they are interpreted in ServiceNow as a Date Time 00:00:00 UTC) to System or User Timezone if the user overrides System Timezone. This results in a 1 day shift back for timezones that are 1 hour behind UTC. DateTime type of fields are being converted properly because they store time in UTC.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reporting PRB678754</td>
<td>AutoSysFields should be on False to prevent all reports to be seen as updated / modified</td>
<td>When upgrading to Helsinki, all reports get the modified state from that upgrade moment. All the reports will get updated, and report clean up will be useless. This is a big issue for customers that have thousands of reports.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Security Incident Response PRB677023</td>
<td>Vulnerability Response, Security Incident Response, Qualys Vulnerability Integration, Threat Intelligence</td>
<td>Contextual help URLs are incorrect</td>
<td>Some contextual help URLs in the Security Operation Applications suite are incorrect. 1. Load Security Incident Response. 2. Open a response task. 3. Click the contextual help icon. Notice the information returned is incorrect.</td>
<td></td>
</tr>
<tr>
<td>Server Side Scripting PRB668211</td>
<td>Syntax Editor  Service Portal script evaluation should support app scoping</td>
<td>All script evaluation within Service Portal currently executes in global.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Catalog PRB668222</td>
<td>Changing the user’s language while on a Catalog item can take 60+ seconds</td>
<td>On instances with large catalogs, there is a delay of 60+ seconds when a user changes their language when that entry/item is not in the cache.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Catalog PRB670617 | servicecatalog_checkout_view_v2 | generates too many requests to sc_layout | For a single item in checkout, around 77 queries are generated. All of these queries are identical to the following: 
SELECT ... FROM (sc_layout sc_layout0 INNER JOIN sys_metadata sys_metadata0 ON sc_layout0.`sys_id` = sys_metadata0.`sys_id` ) WHERE sc_layout0.`target` = 'order_status' AND sc_layout0.`active` = 1 | In a Fuji or Geneva instance: 
1. Ensure that checkout_view_2 is enabled (not 1) and SQL debug is enabled. 
2. Navigate to Service Catalog › Hardware › Apple iPhone 5. 
3. Make sure quantity is set to 1. 
4. Click Add to Cart 10 times (we want 10 separate line items, not a single line item of quantity 10). 
5. Check out and ensure that you are navigated to the UI page servicecatalog_checkout_view_v2. 
Instead of the query being made only once, each line item in the checkout view causes 50 - 100 identical queries to sc_layout. |
| Service Catalog PRB675701 | | If an item is ordered using Order Guide, the order guide column and value details are missing in the order status screen | | 1. Create a new or use an existing order guide. 
2. Give the details in the choose options screen and proceed with checkout. 
3. Observe the details shown in order status screen. 
Expected behavior: There should be a column named “Order Guide” showing the details of the order guide using which the item is being ordered. 
Actual behavior: Order guide column and details are missing in the Order Status screen. |
<p>| Service Catalog PRB682218 KB0597329 | Custom Cart Layout Column macros are not shown in Geneva Patch 7 | Custom Cart Layout Column macros, that define extra columns on the requested item list on Order Status page, do not display for Geneva Patch 7. This worked as expected in Geneva Patch 6 and Helsinki. See Configuring Widget and Column Macros. | |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Mapping</td>
<td>PRB677144</td>
<td>Add bypass to F5 behavior</td>
<td>1. Run F5 discovery with SSH credentials.</td>
<td>1. Run F5 discovery with SSH credentials. Note the device is discovered as Linux.</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB678995</td>
<td>Flash-based Pattern Debugger (in Geneva and Helsinki) does not allow for quotes in value strings</td>
<td>1. The string &quot;ls &quot; + $process.executableDir + &quot;&quot;&quot; does not pass UI validation. Users get the UI error &quot;... they don’t come in pairs ...&quot;). 2. The string &quot;ls &quot; + $process.executableDir + &quot;&quot;&quot;&quot; does not pass UI validation. Users get the UI error &quot;... they don’t come in pairs ...&quot; even though the number of quotes is even.</td>
<td></td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB679365</td>
<td>ServiceNow documentation says ‘Discovery Messages’ and ‘Traffic Based discovery’ tabs will be visible only in Edit mode</td>
<td>According to ServiceNow documentation, the ‘Discovery Messages’ and ‘Traffic Based discovery’ tabs are only visible in Edit mode. See the last item in Understand Maps. However, when users with the role ‘sm user’ log in and they only have view access, those users can see these tabs.</td>
<td></td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB679625</td>
<td>F5 fixed unknown computer + active/passive indicator</td>
<td>F5 fixed unknown computer – there is a NullPointerException in the Discovery log and the Discovery stop.</td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB668463</td>
<td>NG shared components Direct links with nav_to.do in the URL are not working</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB674244</td>
<td>Fields with internal type as “Duration” appear differently on Service Portal forms</td>
<td>In an Outage duration field, the legacy UI shows the data as “68 days 10 hours 57 Minutes”. However, the Service Portal UI displays the data as “68:10:57:47”.</td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB676007</td>
<td>Form mandatory indicators should update as you type</td>
<td></td>
<td>1. In Service Portal, go to the Ask a Question page.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB677266</td>
<td>spUtil.scrollTo is not working for Service Catalog items</td>
<td></td>
<td>2. Type in the Question field.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB677858</td>
<td>Unable to see activities from a closed incident - Error is with a few incident records</td>
<td>Certain Incidents with a lot of attachments do not show the activity stream on a Service Portal form. Instead, an error is shown which state that the Ticket Conversation widget is failing.</td>
<td>1. Navigate to /sp? id=sc_cat_item_guide&amp;sys_id=6690750f4f7b4200086eeed18110c761.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB678317</td>
<td>Service Portal - Service Status</td>
<td>Current Status widget “show outage details” option does not work properly after value changes from true to false</td>
<td>2. On the right, click Desk Set Up.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB678341</td>
<td>Switching between two portals with the same index page crashes the Branding Editor</td>
<td>This is because the check for the option assumes it is a boolean - it is a String either “true” or “false”.</td>
<td>3. View the Incident in the Service Portal id=form page.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>PRB678358</td>
<td>Service Portal Designer Widget names and Page titles are not sorted</td>
<td>In Helsinki, Service Portal Designer Widget names are not sorted in order.</td>
<td>In a Helsinki instance:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1. Navigate to Service Portal › Pages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Go to the ‘Portal Edit’ page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Click the Open In Designer related link.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Notice that on the left side, the names of the widgets present are not sorted in an order.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB678519</td>
<td>Setting glide.ui.escape_all_script to ‘true’ in a high-security setup makes the Service Portal fail on load when there are page load Dependencies</td>
<td>Opening the Service Portal after activating the ‘Service Portal for Enterprise Management’ plugin and setting the value of ‘glide.ui.escape_all_script’ to true, opens a blank page with the Uncaught Syntax Error: Unexpected token ILLEGAL errors and Uncaught Error: ($injector:modulerr) Failed to instantiate module sn.$sp errors.</td>
<td>In a Helsinki instance:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1. Activate the ‘Service Portal Enterprise Management’ plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Set the value of ‘glide.ui.escape_all_script’ to true.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Open the Service Portal (&lt;instance&gt;/sp).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The following errors are seen in the developer console:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>sp?sysparm_stack=no:2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Uncaught SyntaxError: Unexpected token ILLEGAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>js.includes_sp.jsx?v=04-21-2016_1541&amp;lp=Tue_May_24_02_24_02_PDT_2016&amp;c=2_42:6202</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Uncaught Error:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>[$injector:modulerr] Failed to instantiate module sn.$sp due to:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Error:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>[$injector:modulerr] Failed to instantiate module sp.dependencies due to:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Error:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>[$injector:nomod] Module 'sp.dependencies' is not available!</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>You either misspelled the module name or forgot to load it. If registering a module ensure that you specify the dependencies as the second argument.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Service Portal PRB678572** |                  | Unable to see the entire Description field when viewing a PRB record in HI - seeing only top line                                                                                                                | Open a PRB with the new UI. The Description field is single-line only, and any additional text cannot be seen.                                                                                                  | 1.  In HI, navigate to Home > My Issues > Problems.  
2.  Note that only the top line of the problem description can be seen.                                                                                       |
| **Service Portal PRB678585** | **Service Portal Designer** | With screen resolution < 1024px, the Service Portal Designer’s header preview button does not appear                                                                                                          |                                                                                                                                                                                                             | 1.  Go to /$spd.do.  
2.  Select a widget from the list.  
3.  Resize the window to < 1024 pixels.  
The ’Preview’ button disappears when it should not.                                                                                                 |
| **Service Portal PRB678623** |                  | Service Portal rendering of catalog items does not honor the “Display title” setting for variable sets for the item                                                                                               | In Helsinki instances, if you have a catalog item that contains variable sets that have the “Display title” field checked, the title will render in the normal catalog but not on the Service Portal when it renders the same item. | In a Helsinki instance:  
1.  Install the ‘Customer Service Portal’ plugin.  
2.  Change your application scope to Customer Service.  
3.  Bring up the Create Contact catalog item.  
4.  Add the Standard Employee Questions variable set to the variable set related list.  
5.  Go into that variable set and make sure ‘Display title’ is checked (check and save if not).  
7.  Click Service Catalog on the bread crumbs at the top.  
8.  Click Services under the categories on the left.  
9.  Click Create Contact.  
The title for the variable set is not displayed. If you view that same item outside of the Service Portal, the title is displayed correctly. |
| **Service Portal PRB679143** |                  | There should be a single-parameter signature version of $sp.getWidget                                                                                                                                         |                                                                                                                                                                                                             | 1.  Try to use $sp.getWidget("calc") in the Service Script of a widget.  
2.  See error in the Java console.                                                                                                                                                                           |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal PRB679373 | | Reference field modal does not inherit view of current form | The view should be inherited from the current form, as view inheritance is an expected, long-standing feature of the ServiceNow platform. | 1. Go to the itil view of an Incident form.  
2. Click the preview icon for the Caller reference field to view that user in a modal.  
See that you are not looking at the itil view of the sys_user form - the view should be inherited from the current form. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal | SCSS Bootstrap Theme, Service Portal for Enterprise Service Management | Service Portal takes too long to load if there are many items in the header menu | Since there is no limit in the header menu in Service Portal, if the number of items in the header menu is 100 or more, Service Portal performance is affected. Please also note that items more than 15 are not shown properly in the drop down header menu. | 1. Make sure there is a valid approval request in the ‘sysapproval_approver’ table.  
2. Execute the following background script to create the 500 records in the ‘sysapproval_approver’ table:  
   ```javascript
   var approval = new GlideRecord('sysapproval_approver');
   var newApproval = new GlideRecord('sysapproval_approver');
   approval.addQuery("state", "requested");
   approval.setLimit(1);
   approval.query();
   approval.next();
   var sysapprovalValue=approval.getValue('sysapproval');
   var count = 0;
   while (count > 500) {
      newApproval.setWorkflow(false); // do not allow BRs or Workflows to execute
      newApproval.setUseEngines(false); // do not allow approval engines to execute
      newApproval.setValue('sysapproval', sysapprovalValue);
      newApproval.setValue("state", 'requested');
      newApproval.setValue("approver", '6816f79cc0a8016401c5a33be04be441');
      newApproval.insert();
      count++;
   }
   3. Go to the Service Portal page (e.g. https://<instanceName>.service-now.com/sp?sysparm_stack=no). |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal</td>
<td>PRB679658</td>
<td>c.server.update(</td>
<td>The widget editor always displays a “Saved” message even when saving fails.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>and spUtil.get()</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>does not allow</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>to handle errors</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>in the widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB679734</td>
<td>Error messages</td>
<td>When searching in the Service Portal when the language is German, the error message below is displayed:</td>
<td>On a Helsinki instance:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>are displayed</td>
<td></td>
<td>1. Activate the German translation plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in Service Portal</td>
<td></td>
<td>3. Change language to German.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>for German users</td>
<td></td>
<td>4. Navigate to (instance.url)/sp.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Start typing in the search box.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Current behavior: The following message is displayed - “Ihre Abfragetext enthielt nur allgemeine Wörter oder nicht eindeutige Platzhalter. Schränken Sie die Suche ein, und versuchen Sie es erneut.”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Expected behavior: Unless the error condition occurs, search should work.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB680118</td>
<td>Service Portal</td>
<td>Page Editor - Page Map shows widget instance as “Rectangle 1”</td>
<td>1. Go to sp.config.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Configuration</td>
<td></td>
<td>2. Go to the page editor and open Ticket Form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pages</td>
<td></td>
<td>Notice how the untitled widget instances are still called Rectangle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB680622</td>
<td>Service Portal</td>
<td>Users should not be able to delete sp_config portal</td>
<td>Delete the sp_config portal. This should not be allowed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Configuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pages</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB680729</td>
<td>Simple List</td>
<td>Simple List widget should let you specify target View for the form</td>
<td>1. Edit a Simple List sp_instance_vlist record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>widget should</td>
<td></td>
<td>2. See that there is nowhere to specify target View for the target record when a user clicks a row in the simple list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>let you specify</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>target View for</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>the form</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Portal PRB680825 |  | ‘Included in Pages’ defined related list script needs guardrails against bad nested sp_instance record |  | 1. Activate the com.snc.hr.service_portal plugin.  
2. Try to open the My Team widget in the form or widget editor. Note that you get errors.  
3. Remove the ‘Included in Pages’ related list from widget form.  
4. Repeat step 2. Note that it works as expected. |
| Service Portal PRB681011 |  | In the SP widget editor, any changes made to a widget are not reflected in the Widget Preview section | In the SP widget editor, any changes made to a widget are not reflected in the widget preview section. Additionally, any JavaScript errors made in the widget code have the potential to break the preview. | 1. Go to the widget editor.  
2. Open any widget that has preview enabled.  
3. Try to edit the template, controller, link function or Angular Provider associated with this widget.  
Changes are not reflected into the widget preview. Also, any JavaScript errors in your code will break the preview. |
| Service Portal PRB681149 | SCSS Bootstrap Theme | Service Portal compiles SCSS files using a Java library that has a problem when using floats | This PRB fix accounts for and fixes Bootstrap CSS’ several usages of line-height. |  |
| Service Portal PRB681517 |  | Catalog items without variables cannot be submitted |  | 1. Try to order an Apple iPad 3 in the Service Portal.  
2. Note that you cannot, because the Submit button does not do anything. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Portal PRB682388| Human Resources Application: Service Portal | HR Service Portal translation issues | There are internationalization/translation issues in the HR Service Portal. | Install the HR Service Portal plugin.  
    Issue 1  
    1. Install the I18: Spanish plugin.  
    2. Change the system property to es (Spanish), log out, and log back in.  
    3. Navigate to the HR Service Portal > Catalog.  
    4. Open any catalog. Notice that Submit button on the bottom is without text.  

    Issue 2  
    1. Navigate to the HR Service Portal.  
    2. Click on the profile widget. Notice that the ‘Create New Contact’ button at the bottom is missing translation. The ‘Upload picture’ and ‘About’ text on the form is not translated either. |
| Service Portal PRB683040| Helsinki plugin dependency | Helsinki plugin dependency | The fix for PRB665894 creates a dependency between the syntax editor plugin and the Service Portal display - the `styles/GlideEditor5Includes.css` is being used in the Service Portal, which is installed as part of the syntax editor plugin. However, there is a missing plugin dependency. The content is completely different if the syntax editor plugin is not active. | In a Helsinki instance:  
    1. Go to Plugins and ensure that the Syntax Editor plugin is not activated.  
       • Note the syntax editor is missing.  
       https://xxx.service-now.com/sp_config?id=page_edit&p=sc_request&table=sp_widget&sys_id=45190787ff323100ba13fffffff71".  
    3. Go to Plugins and activate the Syntax Editor plugin.  
       • Note the syntax editor is not missing.  
       https://xxx.service-now.com/sp_config?id=page_edit&p=sc_request&table=sp_widget&sys_id=45190787ff323100ba13fffffff71". |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal PRB683295</td>
<td>/sp/anything.do redirects indefinitely</td>
<td>If a user tries to go to /sp/cache.do, Service Portal endlessly loops while loading the page.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Portal PRB684796</td>
<td>Multiline String field will not save new values</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Service Portal PRB686313 | In Service Portal, catalog item variable type "label" should render HTML | 1. As an admin, view a sys.properties record in the id=form page of the Service Portal.  
2. Try to change a Value or Choices field.  
Note the new value does not save. |
| Service Portal PRB686448 | Order Guide variables do not cascade | Cascading variables was a feature of previous versions of ServiceNow that is highly utilized with order guides. Users utilizing order guides, who more than likely will also be using cascading variables, would be affected by this. |
| Service Portal PRB686465 | Mobile UI, NG shared components | Need API to determine in a Catalog Client Script whether item is part of an order guide | A Service Portal administrator needs a way to know if the catalog item is being loaded on its own or as part of an order guide. |
| Service Portal PRB686507 | NG shared components | Some Service Portal form elements are not working |  - The reference element only searches one of the ref.ac_columns specified.  
- The glide list element should support setFilter, addItem, and removeItem.  
- Certain blacklisted APIs are fully accessible, jQuery, window, document, Angular, etc. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal PRB686965</td>
<td></td>
<td>Autocomplete in the reference picker in Service Portal Catalog Items does not behave the way the platform reference picker does</td>
<td>In a reference element field on a Service Catalog item, you can optionally define several Variable Attributes on the variable. This give a Service Catalog administrator control over what fields to display in the autocomplete dropdown for a reference element, what fields to search over, and what order to display them in. These variables should be supported by Service Portal. The available attributes are documented in Auto-Complete for Reference Fields.</td>
<td>1. Navigate to a Service Catalog item in Service Portal that has a variable that is a Reference Element and that has Variable Attributes on it. &lt;br&gt;2. When searching in the Reference Element field, notice that none of the variable attributes are respected.</td>
</tr>
<tr>
<td>Source Control Integration PRB667492</td>
<td></td>
<td>Source Control API: Prevent Applications in global scope from being added to source control</td>
<td>Applications in global scope can be added to source control. This could lead to unintended behavior and possible outages, based on action taken on uninstall/reinstall app during source control ops. If an app file (e.g. script include) that is essential to system operation is added to an app, and the app is linked to source control, then during source control operations, a user could inadvertently remove a critical app file from the instance. This could cause unintended consequences, potentially an outage.</td>
<td>1. Set the system property ‘glide.app.creator.global’ to true. &lt;br&gt;2. Navigate to System Applications › Applications › New and select Start from global. Alternatively, go to File › Create New Application in Studio. This will allow you to create a globally scoped app (subtly different from just “global”), which can be opened in Studio, linked to a repo, etc. &lt;br&gt;3. Now you can go to any app file in global scope and add it to your application and subsequently add it to source control. &lt;br&gt;Actual behavior: A globally scoped app file is added to source control and will be affected by source control operations (e.g. switch branch), causing that file to be uninstalled/reinstalled. &lt;br&gt;Expected behavior: The globally scoped app should not have been able to be exported.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-----------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>System Applications PRB679780</td>
<td>Upgrade to Helsinki failed due to stackoverflow error on checking roles</td>
<td>When there is cyclicity in sys_user_role_contains and if one of cyclic roles are involved in writes to sys_user_role_contains, sys_user_has_role, sys_group_has_role, we hit a StackOverflow error. The code responsible for it, is introduced in Helsinki. Upgrades to Helsinki or regular usage of Helsinki are susceptible to this error.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Team Development PRB673198</td>
<td>Team Development transactions can be canceled by scoped quota rules</td>
<td>Platform transactions that should not be canceled must be marked uncancelable. Otherwise, the quota rules that check scoping can cancel them. For example, Team Development operations are not uncancelable because they are being canceled in the field.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usage Analytics PRB680715</td>
<td>glide.ua.downloader.download_license and glide.platformanalytics.upload.enabled are erroneously defined in the glide.properties file</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Interface (UI) PRB675974</td>
<td>List v3 Components, NG shared components</td>
<td>Bullets are not rendered in journal fields by the [code] tag</td>
<td>When using UI16, the bullets tags <code>&lt;ul&gt;</code> / <code>&lt;li&gt;</code> are not rendered by the [code] tag on journal fields. This works as expected in UI15.</td>
<td></td>
</tr>
<tr>
<td>User Interface (UI) PRB678019</td>
<td>NG shared components</td>
<td>Initials are incorrect when emails are in parentheses</td>
<td>1. Go to the incident form. 2. Leave the following line in the Additional comments field: <code>[code]&lt;ul&gt;&lt;li&gt;Bullet 1&lt;/li&gt;&lt;li&gt;Bullet 2&lt;/li&gt;&lt;/ul&gt;[/code]</code> 3. Save. Note there are no bullets in the message that was left in the activities. When moving to UI15, you will see that it shows the bullets as expected.</td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI)</td>
<td>PRB678316</td>
<td>IE11 - List of email recipients is truncated in the activity history</td>
<td>When you send email from an incident, and fill the To and CC fields with many emails, the list of email recipients gets truncated in the activity history. This happens in IE11.</td>
<td>1. Create a new incident. 2. Email many (more than 10) users, using the email client from the incident form. 3. Reload the form and check the activity history. Note the email addresses get truncated in the activity history. This does not happen in Chrome and happens only in IE11.</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB679379</td>
<td>If user preference glide.ui11.use is set to false for an ESS user, they cannot log in</td>
<td></td>
<td>1. Change global user preference glide.ui11.use to false. 2. Clear the cache. 3. Log in as employee. See that page loading stops on &quot;Establishing Session&quot;.</td>
</tr>
</tbody>
</table>

Other Helsinki Patch 2 information

- **MID Server**: Configure the MID Server to use specific privileged commands

  Starting with Helsinki Patch 2, users can specify any privileged command for a MID Server to run, not just the supported commands.

  Starting with Helsinki Patch 2, you can use the value in this Value field to execute any privileged command, such as a customized sudo command or any privileged command in your environment. You can also use it to create special configurations of supported privileged commands. For example, you can set prbun -u admin as one privileged command to run with an admin profile. Only one of these special configurations is allowed per privileged command on a MID Server. You can configure pbrun, dzdo for a specific MID Server, but not pbrun -u admin, pbrun -u system.

- **Service Portal**
  - **Service Portal Single sign-on, logins, and URL redirects**
  - **Configure the Service Portal login page**
  - **Redirect to Service Portal after login**

    The SPEntryPage script include is available in releases for Helsinki Patch 2 and later.

  - **Debug Service Portal URL redirects**

Fixes included with Helsinki Patch 2

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 1 Hot Fix 1**
This release includes the HP1HF1 PRB that was also fixed in HP2. *
• HP2 and HP3: PRB687962
• HP3: PRB686241

• Helsinki Patch 1
• Helsinki Patch 0 Hot Fix 4
• Helsinki Patch 0 Hot Fix 3

This release includes the HP0HF3 PRBs that were also fixed in HP2. *
• HP1: PRB677407, PRB680182, PRB680620, PRB670075
• HP2: PRB677407, PRB680182, PRB680620

• Helsinki Patch 0 Hot Fix 2
• Helsinki Patch 0 Hot Fix 1
• Helsinki Fixes

Helsinki Patch 1 Hot Fix 3

Helsinki Patch 1 Hot Fix 3 provides fixes for the Helsinki release.

For Helsinki Patch 1 Hot Fix 3: Build date: 08-24-2016_0942
Build tag: glide-helsinki-03-16-2016_patch1-hotfix3-08-23-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Fixed problems in Helsinki Patch 1 Hot Fix 3

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog PRB668222 | Changing the user’s language while on a Catalog item can take 60+ seconds | On instances with large catalogs, there is a delay of 60+ seconds when a user changes their language when that entry/item is not in the cache. | 1. Enable SQL Detail.  
2. Enable the I18N: Spanish Translations plugin.  
3. Run a /cache.do.  
4. Navigate to Service Catalog › Departmental Services › Service Category Request.  
5. After loading that item, change the UI’s language to Spanish.  
Note that changing the language takes a long time. |
Fixes included with Helsinki Patch 1 Hot Fix 3

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 1 Hot Fix 2**
- **Helsinki Patch 1 Hot Fix 1**
  The PRBs in HP1HF1 were also fixed in *
  - HP2, HP3: PRB687962
  - HP3: PRB686241

- **Helsinki Patch 1**
- **Helsinki Patch 0 Hot Fix 3**
  This release includes the HP0HF3 PRBs that were also fixed in HP1. *
  - HP1: PRB677407, PRB680182, PRB680620, PRB670075
  - HP2: PRB677407, PRB680182, PRB680620

- **Helsinki Patch 0 Hot Fix 2**
- **Helsinki Patch 0 Hot Fix 1**
- **Helsinki Fixes**

**Helsinki Patch 1 Hot Fix 2**

Helsinki Patch 1 Hot Fix 2 provides fixes for the Helsinki release.

For Helsinki Patch 1 Hot Fix 2:

<table>
<thead>
<tr>
<th>Build date: 08-07-2016_0841</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build tag: glide-helsinki-03-16-2016_patch1-hotfix2-08-05-2016</td>
</tr>
</tbody>
</table>

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).

For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).

Note: This version is approved for FedRAMP.

**Fixed problems in Helsinki Patch 1 Hot Fix 2**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Management PRB702989</td>
<td>Performance delay while loading a top project (which has 8000+ project tasks) via planning console</td>
<td>There is a performance delay while loading a top project via the planning console. This issue occurs in a Helsinki Patch 1 instance when trying to load a top project with 8000 tasks. The browser (e.g. Chrome, Firefox) is having a hard time keeping up.</td>
</tr>
</tbody>
</table>
Fixes included with Helsinki Patch 1 Hot Fix 2

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- **Helsinki Patch 1 Hot Fix 1**
  The PRBs in HP1HF1 were also fixed in *
  - HP2, HP3: PRB687962
  - HP3: PRB668241

- **Helsinki Patch 1**
- **Helsinki Patch 0 Hot Fix 3**
  This release includes the HP0HF3 PRBs that were also fixed in HP1. *
  - HP1: PRB677407, PRB680182, PRB680620, PRB670075
  - HP2: PRB677407, PRB680182, PRB680620

- **Helsinki Patch 0 Hot Fix 2**
- **Helsinki Patch 0 Hot Fix 1**
- **Helsinki Fixes**

Helsinki Patch 1

The Helsinki Patch 1 release contains fixes to these problems.

For the Helsinki Patch 1 release:  
Build date: 06-05-2016_1542  
Build tag: glide-  
helsinki-03-16-2016_patch1-05-18-2016

For more information about how to upgrade an instance, see [Upgrade to Helsinki](#).

For more information about the release cycle, see the [ServiceNow Release Cycle](#). For a downloadable, sortable version of Helsinki fixed problems, see [KB0598266](#).

---

Note: This version is approved for FedRAMP.

---

Security-related Fixes

Helsinki Patch 1 includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki Patch 1, refer to [KB0594814](#).

Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Transaction and Session Management         | MID Server       | Recycled requests cause session leak issues. This results in either of these behaviors: | • MID Server stops communicating with the instance and continuously produces the socket timeout error: Accepted with code: 202  
• Stuck sessions in the transaction queue. In this case, users receive 429 “Rejecting request” errors due to the session leaks.  
This is caused by the platform holding a session sync on a transaction that has been cancelled. | Refer to the listed Known Error KB article for details. |
<p>| PRB646966                                  | PRB646966        |                                                                                    |                                                                                                                                                                                                              |                                          |
| KB0594709                                  | KB0594709        |                                                                                    |                                                                                                                                                                                                              |                                          |
| Platform Performance                       | ServletTransaction does not account for recycled requests and leaves sessions in session sync | The RESTAPIProcessor throws an exception that causes the transaction to be cancelled, but not release the session sync on the session. This results in sessions “leaking” in the queue and can eventually, in a worst case scenario, consume the whole transaction queue. The affected end user(s) experiences HTTP 429 “Rejecting request” errors. | Refer to the listed Known Error KB article for details. |
| PRB670075                                  | PRB670075        |                                                                                    |                                                                                                                                                                                                              |                                          |
| KB0594813                                  | KB0594813        |                                                                                    |                                                                                                                                                                                                              |                                          |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat PRB66353 KB0584123</td>
<td>Angular AMB Services, NG shared components</td>
<td>User presence causes performance degradation when Connect, UI16, Mobile Support, or VTB is installed due to transactions related to the Presence feature</td>
<td>ServiceNow has found an issue impacting instances configured with the Geneva release family and with the Presence feature enabled. Please note that this feature is enabled by default with UI16 in Geneva. Presence generates a high volume of requests per user. The individual presence requests are generally fast, but they are susceptible to slowness when an instance is under heavy load. A high volume of slow Presence requests will clog the default semaphore queue. In the UI, this will manifest itself as missing components (for example, the navigator does not load, or a blank page is shown). On the stats page, this will manifest itself as a default semaphore pool with a queue depth at or near 150. A large percentage of the active requests will probably be Presence transactions. Requests will return 429 errors (Too Many Requests) if they encounter a filled semaphore queue. This can lead to delays and significant performance issues for users on the instance.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Persistence PRB674257 KB0594678 |                  | Changes on Dictionary Field Type of glommed field on one of the extending tables is changing the database field type instead of changing the sys_storage_alias | If the user alters an existing column by changing the field type or the field length, data loss can occur if the field has duplicate storage aliases. On an affected version, the logic that safeguards against data loss fails to account for data in fields that are aliases of the field being modified. The following workflow illustrates the issue:  
 1. The user accesses a field on a table that is configured as an extension of another table (Table per Hierarchy).  
 2. The user then alters the field by changing either its Type or its Length.  
 3. The execution logic tests for data loss in that table only (not the entire hierarchy for the field).  
Because the test does not detect any data in other tables that are also extensions of that same base table, the workflow continues to execute, causing data loss for that field in the other tables. | Refer to the listed Known Error KB article for details. |
<p>| Platform Performance PRB677407 |                  | Mean semaphore exhausted on HI | A script error is being generated, which may be a cause for the semaphore to exhaust.                                                                                                                              | As a cust of admin, try to change the Primary/Secondary Technical/Support contacts in the core_company table. org.mozilla.javascript.JavaScriptException: The war version is not a string. (sys_script_include.976754ec7bac45001fe25a4d784d4d99; line 146) |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication</td>
<td>PRB680620</td>
<td>After upgrading to Helsinki, POP/LDAP fail with a keystore exception, and users are unable to log in</td>
<td>Unable to load certificate.</td>
<td>SAML 2.0 SP Keystore - b88267271b012000f1129140be071393: java.io.IOException: Keystore was tampered with, or password was incorrect: sun.security.provider.JavaKeyStore$JKS.engineLoad(JavaKeyStore.java:780) sun.security.provider.JavaKeyStore$JKS.engineLoad(JavaKeyStoreDelegator.java:21)</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB676627</td>
<td>Copy Page UI action does not work and should be removed</td>
<td>On the sp_page table, there is a UI action called 'Copy Page' that is supposed to copy a page record and all of its container, row, column, and instance records that are associated with it to create an exact clone of a page. However, the action fails to copy instances over, which negates the usefulness of this action. This action will be removed in Helsinki Patch 1 to prevent confusion for users.</td>
<td>1. Go to a form for any sp_page record. 2. Click the Copy Page UI action. Expected behavior: A new page record should be generated that is identical to the previous page, and new containers, rows, columns, and instances should also be created that mimic those on the original record. Actual behavior: The action partially works, but widget instances are not copied over.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Catalog PRB664557 KB0594575 | Catalog UI policies not applying to variables in a RITM / Catalog Task variable editor when read-only | Catalog UI policies and catalog client scripts set to ‘Applies on Requested Items’ or ‘Applies on Catalog Tasks’ can fail when a write-role has been specified on the variable and a user views the record while logged in as (impersonating) a user that fails the role check. | 1. Navigate to one of the following:  
- Self-Service › Service Catalog  
- Service Catalog › Catalog › Hardware › Sales Laptop  
2. Personalize the Additional software requirements variable and give it a name (for example, software_requirements).  
3. Update the Write roles field and add admin.  
4. Create a Catalog UI policy.  
5. Go back to the item.  
6. Right-click the header and select Personalize UI Policies.  
7. Create a policy with the following values:  
   - Short Description: hide software requirements  
   - On load: true  
   - Active: true  
   - Applies on a Catalog Item view: true  
   - Applies on Requested Items: true  
   - Applies on Catalog Tasks: true  
   - Actions:  
     - Name: software_requirements  
     - Read only: Leave alone  
     - Mandatory: Leave alone  
     - Visible: False  
8. Create a request for a Sales Laptop.  
9. Impersonate a non-admin user, such as ITIL User.  
10. Go back to the item and make the request.  
11. View the request. If you are already impersonating the ITIL user, navigate to Service Catalog › Items.  
12. Open the item for the request.  

Note that the Additional software requirements variable is visible and the JavaScript console shows this error: js_includes_catalog.jsx:132 Uncaught TypeError: container.getAttribute is not a function
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management</td>
<td>Knowledge Management V3</td>
<td>Creating a new knowledge base article from the Application Navigator leads to a read-only page</td>
<td>In an instance upgraded from Knowledge v2 to Knowledge v3, navigating to Knowledge &gt; Create New in the Application Navigator opens a read-only page. Also, the instance does not have any V3 Knowledge Bases.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>UI Policy/Client Script</td>
<td></td>
<td>Geneva: onChange client script running on submit of form when no data has changed</td>
<td>An onChange client script is running on submit when the data has not changed since the last time it ran.</td>
<td></td>
</tr>
<tr>
<td>Project Management</td>
<td>Project Management</td>
<td>Project lag time is inaccurate if a project with tasks and relations is imported from Microsoft Project 2013</td>
<td>If a project created in Microsoft Project 2013 with multiple tasks and relationships is imported into the Project Management application, an incorrect lag value may be inserted.</td>
<td>1. Activate Project Management v3. 2. Import a project with relationships created in Microsoft Project 2013 format. Note that a lag of 95+ days is added to the relationships. This added lag extends the start dates of the tasks.</td>
</tr>
<tr>
<td>Service Catalog</td>
<td></td>
<td>Geneva upgrade - Catalogs have extra space between variables (variables within container are hidden by UI policy)</td>
<td>In the Service Catalog, if there is a variable set that has ‘Visible’ set to ‘false’, the UI policy does not hide the element and it displays as an empty space between the fields.</td>
<td>In a Geneva Patch 4 instance: 1. Create a variable set with 2 single line variables. 2. Set Order to Variables with two consecutive numbers. 3. Create a Catalog UI policy that Applies to Variable Set. 4. Within the Catalog UI policy actions, add the 2 variables and set Visible to false. 5. Add the variable set to a Catalog Item. 6. Set the Order number to place the variable set between the two existing fields. 7. Click Try it. Notice that there will be an extra space between the fields. If you “inspect the element” in that area, you will notice that the element is technically still there even though Visible is set to False in the UI policy.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>User Interface (UI) PRB667491</td>
<td>NG shared components</td>
<td>CC: field does not show up on activity formatter when using UI16, but it shows when using UI11 in the same instance</td>
<td>After configuring email on an instance with UI16, if you send an email from an incident, the emails will not show the CC field when displayed in the activity formatter on the incident.</td>
<td></td>
</tr>
<tr>
<td>Persistence PRB668394</td>
<td>fix_short_field_name_types and fix_short_table_name_types</td>
<td>sometimes take a long time to run</td>
<td>Several users have experienced long upgrades. This is due to the following fix scripts, which can take a considerable amount of time to run: • fix_short_table_name_types.xml • fix_short_field_name_types.xml</td>
<td></td>
</tr>
<tr>
<td>User Interface (UI) PRB618792</td>
<td>Personalize &gt; Configure list layout is broken on IE11 - slush buckets go blank / empty</td>
<td></td>
<td>On IE11, if you try to change the list layout (either through the Configure or Personalize options), it results in the slush buckets displaying as empty / blank.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| User Interface   | Lists v2         | Selecting multiple records on a list view updates unselected rows as well (List v2 only) | When multiple records are selected from the same column on a list view, not all selected records are updated, and other random records are updated. For example, selecting 4 records via the 'Category' field on the task table and then editing via list view also updates other records that were not selected to begin with. This only seems to occur when the system property 'glide.ui.list.detail_row' is set to true, and when you are editing a table (via list view) that is unaffected by that property. This seems to be somewhat related to previously fixed PRB634893 and PRB647724, but the opposite in that the tables affected here are the ones which are not influenced by this property. | 1. Navigate to sys_properties.list.  
2. Create the property glide.ui.list.detail_row and set it to true. By default, it applies the detail_row to short_description on the task table and related tables.  
3. Choose a different table that is not affected. (NOTE: Make sure this is NOT configured as a Detail Row. This issue as reported only happens if Detail Rows are not configured on the table you are editing.)  
4. Select multiple records from the list column (the list column must be editable). Notice that not all records selected are changed, and for every one that did not update, another unselected record seems to update instead.  

Note: There is also another related issue here where selecting an EVEN amount of records shows that an ODD number of records (usually X +1) will be updated. For example, selecting 4 records prompts the user that ‘5 rows will be updated.’ However, selecting 5 records prompts correctly for ‘5 rows will be updated.’ This also only occurs on tables unaffected by glide.ui.list.detail_row being set to true. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foundation</td>
<td>PRB668046</td>
<td>The upgrade from Fuji to Geneva Patch 4 does not create the group type ‘itil’</td>
<td>The group type (1cb8ab9b000200158bfffffffff62) is sys_user_group_type.name = “itil”. This group type is new to Geneva. Geneva version has this group type and a script to update all the null group types with itil. The upgrade missed the itil group type record but ran the script to update the null values. During the Geneva upgrade, the fix script ran and updated the sys_user_group records where type = null with itil type sys_id. The itil type record was not loaded into the instance. Due to this, the sys_user_group is showing the sys_id value instead of “itil”</td>
<td></td>
</tr>
</tbody>
</table>

All Other Fixes

<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management</td>
<td>PRB668065</td>
<td>Non-admin users receive an error that a mandatory field is not filled in on Standard Change Proposal form even when the field is populated</td>
<td>Non-admin users receive an error (“The following mandatory fields are not filled in: Change Request values”) on the Standard Change Proposal form when attempting to update the record even when the field is populated. The values are not visible to the user due to StdChangeUtilsSNC.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>KB0584475</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Change Management | Change Request | Inconsistent behavior in the ‘Planned Start/End Date validation’ business rule between Eureka and Geneva releases | The business rule ‘Planned Start/End Date validation’ is aborting the creation of change_request records in Geneva that it allowed in Eureka with the same criteria. Users with scheduled templates have their templates fail without any notification after an upgrade from Eureka to Geneva. | 1. Open a new change request.  
2. Set the planned start and planned end dates to be the same.  
3. Try to save the record.  

A warning message is shown stating that the planned end date needs to be after the planned start date. |
| Chat | Connect, UI11 - Navpage layout with multiple panes, NG shared components | UI16: If Language is set to Hebrew, users cannot close the Connect sidebar | In Geneva:  
1. Enable the Connect plugin.  
2. Enable the Hebrew language plugin.  
3. Create an ITIL user with Hebrew language selected.  
4. Log in as the newly created ITIL user.  
   Note that the Connect sidebar is open on the right side of the screen.  
5. Click the Connect Sidebar icon to collapse the Connect sidebar.  

The Connect sidebar does not close. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat PRB668543</td>
<td>Connect Support - Chat Queue Entry: Unexpected results for aggregate data (wait time and action) make reporting and tracking difficult/impossible</td>
<td>Chat queue entry data is generated in a way that seems strange to administrators and makes reporting difficult. Specifically, the wait time appears to be updated to match the total duration when the session is closed, and the action is set to abandoned when complete. However, this does not align with customer expectations. Additionally, in Helsinki, it does not appear that there is a way for a user to END a chat - that responsibility appears to be available only to the Support Agent.</td>
<td>1. Activate the Chat plugin. 2. Activate the Connect Support plugin. 3. Open two distinct browser sessions, one impersonating Joe Employee, the other impersonating Fred Luddy. 4. As Joe, navigate to this URL and start a chat: $chat_support.do?queueID=c54f0abf0a0a0b452db8464f409c79c2db8464f409c79c2db8464f409c79c2db8464f409c79c 5. As Fred, accept the chat, then:   • Bring up the chat queue for Service Desk chat.   • Find the Chat Queue Entry for the chat you just created in the related list.   • Note the wait time and action. The wait time should reflect the amount of time that the user waited for the chat to be accepted, and the action should reflect 'accepted'. These values make sense.   • Send a few replies to the chat. 6. As Joe, send a few replies to the chat, then:   • Realize that you no longer need assistance and attempt to close the chat. You cannot.   • Send a message to Fred indicating that you are good to go. 7. As Fred, end the chat, then:   • Navigate back to the chat queue entry for the chat.   • Note that the wait time matches the duration and that its status is 'abandoned'.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Chat PRB670509   |                  | A message with the prefix "_123STREAMENTRY321_" is showing up in a Connect Record conversation | In the record: after posting a message, changing the record, and saving the change, the previously posted message with the prefix "_123STREAMENTRY321_" is posted again. | 1. Start a record chat.  
2. Send a message.  
3. Go back to the record.  
4. Post a work note or comment (e.g. "posting a note").  
5. Change status or priority to another value.  
6. Click Save.  

Expected behavior: This message should not be re-rendering in the Connect activity stream with the specified prefix.  
Actual behavior: Notice how the previous post is reflected again in the Connect record conversation as "_123STREAMENTRY321_posting a note". |
| Chat PRB671433   | Angular AMB Services, NG shared components | Presence kill switch does not stop all Presence requests | The property glide.ui.presence.disabled does not shut off all presence requests. The presence system is looking for $window.NOW.presence_disabled but that value is only set if ng_amb_header.xml is included on the page in question. Not all implementations of presence are including this template. | 1. Set glide.ui.presence.disabled to false.  
2. Open the main frameset.  
3. Open Chrome developer tools and look at the network requests.  

Notice that requests for presence are still being executed. |
| Chat PRB673197   | Connect          | Unable to submit messages on iPad when using bluetooth keyboard | Users with bluetooth keyboards on iPads cannot submit messages in Connect. Pressing the return key has no effect. | 1. Use an iPad (tested on a Pro) with a bluetooth keyboard.  
2. Open or create a conversation from the navigator.  
3. Tap on the conversation input.  
4. Type a sentence and press the return key.  

Notice that nothing happens. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat PRB67388</td>
<td>Angular AMB Services</td>
<td>Angular AMB client and Vanilla JS AMB client do not have the same API</td>
<td>In Geneva, there are two versions of the AMB client. One is created by Angular apps and the other is created by Vanilla JavaScript apps. Only one client exists on the top frame, and it can be created by either an Angular app or a Vanilla JavaScript app (the client object can be used in either environment). There is, however, one difference in their APIs. The Vanilla JavaScript client has a method called “getState”, while the Angular client as a property called “state”. Some consumers of AMB (Record Presence in particular) rely on the connection state to decide if they should publish messages. A consumer of AMB will fail if it expects one variant of the state API but gets the other instead.</td>
<td>Open sessions as two separate users on a Geneva instance without Connect enabled. 1. View an incident in the navigator with User A. 2. View the same incident in the navigator with User B. Notice that Record Presence is not visible for either user.</td>
</tr>
<tr>
<td>Chat PRB674124</td>
<td>Magellan Navigator</td>
<td>snTabActivity loses track of primary tab when Connect is not installed</td>
<td>The tab tracker (snTabActivity) loses track of the primary (currently used) tab when Connect is not installed. The general UI does not include a unique key to keep track of the tab, which lets form pages override the “primary” tab when they load. This then causes presence to act inconsistently.</td>
<td>On a Geneva instance (without Connect installed): 1. Log in as System Administrator. Note the presence indicator in the top right is green. 2. Navigate to a form. 3. Wait 15-30 seconds. Notice the presence indicator disappears in the main nav. This may take a few tries of navigating to a form and waiting for at least 15 seconds.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Chat             | Connect Support  | When end user enters a support queue, conversation is not getting created but request comes in | | 1. As an end user, enter the HR support queue.  
2. As agent, notice the request comes in.  
The behavior is as follows:  
• End user’s side: Screen is blank and it says “Connecting”. In the console it says “conversation does not exist”.  
• Agent’s side: Request comes in, the agent accepts it, but the conversation looks empty. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Cloud Management Application PRB667899 | Auto-created variables from ARM template do not get update sync’d | As of Helsinki, variables created from ARM template parameters (auto-generated variable set) when you are in the global scope do not get put in an update set, causing loss of all these variables when moving update sets across ServiceNow instances during deployment. | If the scope is changed to ‘Azure’ or ‘Active Directory’, and records are inserted in azure_template through the UI, records get created in ‘azure_template_parameter’ and ‘azure_template_to_variableset’ programmatically. Records are also getting created in update sets in Azure/AD scope. However, the application of these records is ‘global’.

To reproduce:
1. Install the Microsoft Azure Management Application plugin.
2. Create an update set for Azure.
3. Change the application scope to Azure, and make sure you update set is the one created above.
4. Go to the ARM Template module and create a new ARM template.
5. Once record is created in ARM Template, ‘ARM Template Parameters’ and ‘Variable Set for ARM Template Parameters’ will automatically populated.
6. Now, go to the update set and populate the Application column in customer updates.

Notice that for tables mentioned, the above records are created in ‘global’ scope. Users cannot import the created XML in a different environment. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB</td>
<td>Configuration Management (CMDB)</td>
<td>CI Relationship Manager fails to create relationships if source CI name starts with #</td>
<td>1. Go to a CI that has a name starting with #.&lt;br&gt;2. Scroll down and click on the + to go to the Relationship Manager. You will see that on top it says Relationship Manager - (). This is already indicative of the problem because usually the CI’s name is between the parentheses.&lt;br&gt;3. Follow normal CI relationship addition and try to Save or Save and Exit.&lt;br&gt;&lt;br&gt;The RM will respond with “Failed to create relationships.”</td>
<td></td>
</tr>
<tr>
<td>Core Platform</td>
<td>Lists v2</td>
<td>Read ACLs on fields are being applied to related list v2 when a custom filter is defined on it</td>
<td>“Query results restricted by ACLS…” is displayed on a form, referencing a field in a related list. If this message appears on a list view, it is expected behavior. This ACL check is applied for security reasons. However, following PRB658078, read ACL checks should only apply to default lists and not to related lists.</td>
<td>1. On a form with a related list, edit the ACLs on that related list to restrict read access to a field to admin.&lt;br&gt;2. Navigate to System UI › Related Lists, and find the related list above. Add a filter on the related list to query the field we restricted the access to.&lt;br&gt;3. Impersonate a user who is not admin.&lt;br&gt;4. Navigate to that form.&lt;br&gt;&lt;br&gt;Expected result: The related list shows the records with no error.&lt;br&gt;Actual result: We get an error message saying that the query results have been restricted.</td>
</tr>
<tr>
<td>Core Platform</td>
<td></td>
<td>Creating a dictionary override on a table extending sys_metadata causes a loop and a stackoverflow when starting the system</td>
<td>A customer upgrading from pre-Helsinki to Helsinki with a dictionary override on a sys_metadata extended table may not be able to access the instance post-upgrade due to a stackoverflow in DBPreflight.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Currency</td>
<td>PRB669805 KB0584759</td>
<td>The getCurrencyDisplayValue returns null if a number format is used instead of string during price assignment.</td>
<td>A fix was introduced in Geneva to allow multiple fraction digits to be input for currency values in locales where the decimal separator is a comma (e.g. when the locale is German, the input value is 1.234,5678). This fix is causing assignment of some values to currency/price fields in script to not work.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>
| Data Certification | PRB667460 | When failing/passing a data certification and adding a comment, the tooltip displayed cuts off the text. | | 1. Install the Data Certification plugin.  
2. Go to cert_task.list.  
3. Select a task that is 0% complete.  
4. In the Certification formatter, click the checkbox next to the word Production on any Server.  
5. In the input box above the Server list, next to the Check/Exclamation mark where it says ‘Optional comment for checked elements’, type in a string (e.g. ‘Testing to see if the tooltip displays the full comment’).  
6. Click the exclamation mark to fail the certification on the checked box.  
7. The checked box now displays an exclamation mark after the list reloads. Hover over the exclamation mark. Notice the tooltip renders the comment but cuts off the text. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Date and Time    | Agile Development| ORA-01830: date format picture ends before converting entire input string | Currently, ‘date’ fields are not reformatted when sending the query to Oracle. | On any Eureka release (with Oracle DB):  
1. Create 2 fields on rm_sprint table with type Date:  
   - column name: start_date_1, type: date  
   - column name: end_date_1, type: date  
2. Set the glide.sys.date_format to dd.MM.yyyy.  
3. Go to rm_sprint.list, open one of the records, and fill in a date on each of the 2 fields created at step 1, like the following example:  
   - start_date_1 = '09.03.2016'  
   - end_date_1 = '10.03.2016'  
4. Save the record.  
5. Go to background scripts and run:  
   ```javascript  
   var gr = new GlideRecord('rm_sprint');  
gr.addQuery('start_date_1', '09.03.2016');  
gr.addQuery('end_date_1', '10.03.2016');  
gr.query();  
while (gr.next()){"  
    gs.print(gr.number);  
}  
   ```
   The following error is thrown:
   ```plaintext
   [0:00:00.018] Script completed: script FAILED TRYING TO EXECUTE ON CONNECTION 10: SELECT task0."sys_id" FROM task task0 WHERE lower(task0."sys_class_name") = lower('rm_sprint') AND task0."a_dte_1" = to_date(?, 'YYYY-MM-DD') AND task0."a_dte_2" = to_date(?, 'YYYY-MM-DD')  
General Data Exception detected by database (ORA-01830: date format picture ends before converting entire input string) 
   ```

Placeholders follow:
- '10.03.2016'
- '09.03.2016'
- 'YYYY-MM-DD'

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Management</td>
<td>PRB659820</td>
<td>Glidelist field not saving on record insert in Idea table when using the UI</td>
<td>The Idea table introduced through the Demand Management plugin does not save GlideList field values upon insert of a record through the UI. Please note that GlideList field values are saved correctly when doing an update to an Idea record, as well as inserting a new Idea record through a GlideRecord.</td>
<td>In an OOB Geneva instance: 1. Activate the Demand Management plugin. 2. Navigate to Self-Service &gt; Ideas &gt; Create New &gt; Configure &gt; Form Layout, and add the watchlist field. 3. Fill out the required fields and populate the watchlist field. 4. Save. Verify that the watchlist is empty.</td>
</tr>
<tr>
<td>Demand Management</td>
<td>PRB669642</td>
<td>Creating new idea submissions increments the record number by an additional number on Save/Insert</td>
<td>When submitting a new Idea via the Demand Management Ideation, the initial number of the idea is incremented by 1 on Save / Insert of the new Idea.</td>
<td>In a Geneva instance: 1. Activate the Demand Management plugin if it is not already activated. 2. Navigate to Self-Service &gt; Ideas &gt; Create New. 3. Add Number to the form layout. 4. Note the number of the new idea. 5. Fill in the details and click Save/Submit. Note the new idea number has incremented by one. The number changing on submit is causing confusion for the end users.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
<td>------------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>Discovery PRB666815</td>
<td>Configuration Management (CMDB)</td>
<td>NIC add/removal logic is merging distinct CIs</td>
<td>For the OOB product, it was decided not to enforce an exact count match for the network adapter lookup rule for cmdb_ci_hardware. This was to allow the same CI to be identified even if its NICs were changed (added/removed). A case occurred where two distinct CIs shared one network adapter, and the CIs had 4 other distinct NICs each. In Fuji, the legacy identification engine would only match on NIC if there was an exact count match. Currently, the IE logic will merge these two distinct CIs since they share one common adapter (i.e. thinking 4 NICs were replaced). This needs to be addressed.</td>
<td></td>
</tr>
</tbody>
</table>

Steps to reproduce:

1. Run Discovery on 2 CIs with one network adapter, and 4 other distinct NICs each.
2. Notice that the CIs were merged into one after matching on the cmdb_ci_hardware rule that looks on the cmdb_ci_network_adapter table.
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Discovery        | Integration - Microsoft SCCM 2007, Integration - Microsoft SCCM (Deprecated), Integration - Microsoft SCCM 2012 (deprecated), Integration - Microsoft SCCM 2012 v2 | Identifier issues with lookup and empty hostname | 1. Using legacy identifiers, any identifier could be disabled by setting ‘active = false’. This would skip that particular identifier from processing, but others would continue.  
   • Using the CMDB Identification Engine (Geneva +), if a lookup rule is disabled, processing will stop before any matching occurs.  
2. Using legacy identifiers, if two CIs match on name, only one CI will be created.  
   • Using the CMDB identification Engine (Helsinki +), it is possible for two CIs to be created - one with an empty name when two CIs match on name. | To reproduce issue #1 (lookup)  
1. Disable the identifier entry lookup on ‘cmdb_ci_network_adapter’ for the ‘cmdb_ci_hardware’ rule.  
2. Discover a device that uses rule from (1).  
3. Notice the following error in the Discovery log:  
   CMDB Identification Error:  
   Identity Rule 'cmdb_ci_linux_server' missing Lookup Rule for 'cmdb_ci_network_adapter'  
   To reproduce issue #2 (empty CI name)  
1. Make sure the ‘name’ identifier entry for the cmdb_ci_hardware rule is the only active rule.  
2. Discover two CIs with the same name.  
3. Notice that two CIs are created, and one has an empty name. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Edge Encryption  |                  | When using SAML via the Edge Encryption proxy, the AuthnRequest fails signature validation | When using SAML via the Edge Encryption proxy using a standard HTTP(s) port (80 or 443), the AuthnRequest fails signature validation. | 1. Install the "Integration - Multiple Provider Single Sign-On Installer" plugin.  
2. Make sure the Edge Encryption proxy is bound to port 80 or 443 if using HTTPS.  
3. Set up the identity provider on the ServiceNow instance (Multi-Provider SSO > Identity Providers).  
4. Enter the Edge Encryption proxy URL in the ServiceNow homepage field.  
5. Check the Sign AuthnRequest flag.  
6. Try to authenticate to the ServiceNow instance using an external login.  
Notice that login should fail with an error message indicating that the request failed signature validation. |
|                  |                  | With at least one tokenization pattern active, any filter on encrypted fields that uses terms with null values ("EQ for example) fails | List edit with List v3 fails when a pattern is active (the post request uses a query ending in "EQ"). | In List v3:  
1. Define an encryption configuration for problem.short_description.  
2. Activate a tokenization pattern (e.g. SSN).  
3. Navigate to Problem > Open and try to update a short description by list edit, on the list view.  
4. Note instead of the value getting updated and encrypted correctly, it is refused and the user gets an invalid insert error message.  
In List v2:  
1. Navigate to Problem > Open.  
2. See an error in the proxy log saying that the List Request Action rule has been disabled. |
| Event Management |                  | Activating vRealize connector stops event collection from all connectors |  | 1. Activate vRealize.  
2. Note no events are arriving from vRealize and other connectors. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Management</td>
<td>PRB670043</td>
<td>Improve SCOM groovyScript host (node) resolving</td>
<td>The MonitoringObjectPath property from SCOM should be used to set the node field if NetbiosComputerName and PrincipalName properties are empty.</td>
<td></td>
</tr>
<tr>
<td>Event Management</td>
<td>PRB670478</td>
<td>Cloudwatch alerts do not have a proper timestamp</td>
<td>Alerts coming into ServiceNow via evt_mgmt_proc.do are not properly translating the AWS timestamp. The date is correct, but the time always shows the same for a given day and set of alerts. This may be causing alerts to be deleted as duplicates, as well as preventing re-opening of Incidents that have been cleared by an operator based on recurrence of a similar event/timestamp.</td>
<td></td>
</tr>
<tr>
<td>Event Management</td>
<td>PRB670755</td>
<td>SCOM connector memory problem when large data is retrieved from SCOM</td>
<td>The OOB parameter (number of rows to retrieve) will be updated in Geneva and future releases to 500.</td>
<td></td>
</tr>
</tbody>
</table>
| Event Management  | PRB674256       | Multiple Timeline Visualization sliders are not visible in Event Management’s Timeline module | 1. Size your browser or display to 1440x900.  
2. Try to view the Alert Timeline within frames.  
The bottom line is cut off by the scroll bar. If you open it in a new tab/window, you can see both rows. | |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Facilities Service Management | Facilities Service Management, Facilities Move Management, Facilities Service Management Mobile, Facilities Visualization Workbench, Facilities Service Management Floor Plan Viewer | Changes to Facilities request assignment group are overwritten on update | When upgrading an instance, any changes made to ‘Facilities request assignment group’ are being overwritten and lost. | 1. In Geneva Patch 4, enable the Facilities core plugin.  
2. In Groups, find the “Facilities request assignment group” and mark it as inactive.  
3. Upgrade the instance to Geneva Patch 5.  
Expected behavior: “Facilities request assignment group” should remain inactive.  
Actual behavior: The “Facilities request assignment group” is active again as if no changes were made. |
| Forms | Magellan Navigator | Form performance is slower in Geneva due to form presence, form live updates, activity stream and template bar | 1. Template bar is loading when it should not (as opposed to template bar loading slowly, which is a different PRB).  
2. Activity stream load time when there are lots of entries (> 20), including when it freezes the screen.  
3. Form does lots of loading before the activity stream even starts to load. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Governance, Risk and Compliance | GRC Control Test Definition | loses the ‘Recipients’ field after upgrade to Geneva | In the Geneva release, the GRC plugin implemented the Recipients field differently, as stated in the release notes. For users who were using the GRC plugin in Fuji, the recipients field was part of the survey_creator UI macro, and now the field is no longer displayed in Geneva. For example, a user with 1600+ test records needs to be able to migrate the data from that field to the new user recipients list. | In a Fuji instance:
1. Activate the GRC plugin.
2. After activation, type GRC in the filter navigator and select Controls > All > click New.
3. Fill in the name field with ‘test’ and submit.
4. Under the control test definitions related list, click New:
   • Name field: test
   • Condition Type: Attestation
   • Check the collect supporting data box
5. The attestation questions formatter is displayed; you can add 1 question and fill out the “recipients” field.
6. Save.
7. Upgrade this instance to Geneva.
8. Go to the Control Test Definitions table and locate your test record.
Now there is an empty “User recipients” field. Under the “attestation questions” formatter area, there no longer is a recipients field. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| HI Administration | NG shared components | Out of the box - form widget issues | Outstanding issue:  
• GlideList field does not have an option of taking a new input from the user. For example, in legacy UI for a GlideList referring to sys_user, you can either select a record from the system or provide the email by yourself. This is not possible here.  
Fixed issues:  
• On setting the a reference field in an OnLoad script using `g_form.setValue` does not populate the field with the display value.  
• Message duration for the info messages (`g_form.addInfoMessage`, `g_form.addErrorMessage`) displayed on the top is very short. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Service Management PRB663149</td>
<td>PDF Generator</td>
<td>Generating HR template will not print Arabic characters</td>
<td>Generating the HR Employee verification letter will not output Arabic / Russian characters.</td>
<td>1. Activate the Human Resources Application: Core plugin. 2. Go to the OOB Employee verification letter: / hr_document_template.do? sys_id=5d295f26d7200200a322c257ed6103fa. 3. Add some Arabic / Russian text to it, for example: • ы это реальная жизнь? Является ли это просто фантазия? • ### ###### ######### ###### ##### #### ### ## 4. Create an HR case (hr_case.do), choose the template ‘Employment verification’ and any user and save it. 5. Click the Generate Letter button (if the UI action is not visible, delete the condition on it here: sys_ui_action.do? sys_id=63db0684d7333100a322c257ed61035b). 6. Look at the attachment. It will not contain the characters.</td>
</tr>
<tr>
<td>HR Service Management PRB672986</td>
<td></td>
<td>Double widgets are appearing on the HR Service Portal page</td>
<td></td>
<td>1. Activate the HR Service Portal plugin. 2. Navigate to the HR Service Portal page &gt; Benefits &gt; Beneficiaries. 3. Go back and click Benefits in the breadcrumbs. Note the double widgets.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------</td>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Human Resources PRB66455         | Human Resources Application: Core     | Populate case SLAs - potential looping when updating hr_case records, possibility of incorrect post back of SLA time remaining to hr_case records | This issue occurs because of how this business rule was designed: nav_to.do? uri=sys_script.do? sys_id=52e44382c3100200b599b4ad81d3aed0 The business rule processing engine can get into a loop if the right conditions are met. Additionally, since the business rule fires on all updates to task_sla records attached to hr_case records, and does not account for the possibility of multiple SLA definitions with different durations, as soon as there is more than one SLA definition attached to an hr_case record, it becomes a tossup as to which SLA will be posted back to the hr_case to populate the SLA field. | To trigger a loop:  
1. Create an SLA definition on the hr_case table with a short duration (e.g. 30 minutes).  
2. Create an hr_case record that will trigger your SLA definition.  
The hr_case is inserted, SLA processing will run, and the task_sla record will be attached. At that point, the populate case SLA business rule will run and update the hr_case record. This will cause SLA processing to run again. If the elapsed times on the SLA have changed, it will cause another update to the hr_case, creating an infinite loop.  
For the potential of lost data:  
1. Create two SLA definitions on the hr_case table.  
2. Create an hr_case record that will trigger both SLAs.  
View the hr_case record after updating - the SLA field will be populated, but from which SLA was it populated? |
| Knowledge Management PRB62922 KB0550855 | Knowledge Management V3, I18N: Knowledge Management Internationalization Plugin v2 | Activating I18N - Knowledge Management Internationalization does not import previous translations from the translation table | If the instance has a language plugin installed, knowledge article translations created prior to activating the I18N - Knowledge Management Internationalization plugin are lost. | 1. Activate any language plugin.  
2. Create a new article and modify an existing article using a non-English translation.  
3. Activate the I18N - Knowledge Management Internationalization plugin.  
4. Navigate to the articles you created and edited.  
Note that changes made using the non-English translation are migrated to English. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| **Knowledge Management** PRB648819 | Knowledge Management, Wiki Support | Links in a wiki field containing spaces do not function as expected | When clicking on a wiki link containing a space, the user gets a new kb_knowledge form rather than being linked to the appropriate wiki page. | 1. Create a new kb_knowledge record or open an existing one.  
2. Change the Article Type to Wiki to reveal the Wiki field.  
3. Click Wikitext to display the text box.  
4. Create a link using the following: `[[Bereavement Leave]]`  
5. Save the record.  
6. Click the Bereavement Leave link created in step 4.  

Expected Behavior: Clicking the link should redirect to the OOB article KB0000041, which has a short description of “Bereavement Leave”.  

Actual Behavior: Clicking the link opens a new kb_knowledge form with “Bereavement_Leave” as the short description. |
| Knowledge Management PRB663803 | Knowledge Management V3 | Geneva: Knowledge Category field drop down hangs in the Knowledge Import popup if the Kb_category values exceed approximately 89 in count | In Geneva, there is a new feature to Import Word documents into knowledge. This Import Knowledge popup has a Category field which freezes when the number of Categories in the drop down list exceed approximately 89 in count.  
When there are around 90 categories, the size of the request is around 8k, which seems to be the default for the Tomcat server. At this size, the Web Server itself rejects the request, and it does not even reach the application server. This makes it seem that we are sending a request that is larger than what the Web Server was initially configured to serve. | |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Knowledge Management PRB666632</td>
<td>Social Q&amp;A</td>
<td>Social Q&amp;A: When asking a question, the category list is empty and a 400 Bad Request error is encountered in the logs if the selected KB contains a large number of categories</td>
<td>When a Knowledge Base contains a large number of categories, the contents of the Category field on the “Ask question” Social Q&amp;A page does not load. Furthermore, a ‘400 Bad Request’ error occurs in the network logs on the browser. This appears to be caused by the large amount data in the GET request query string. For example, when 79 categories are active, the URL that the GET request is made to contains 7,532 characters.</td>
<td>In a Geneva Patch 4 instance with a Knowledge Base with many categories (e.g. 134 categories): 1. Navigate to Knowledge › Homepage. 2. Click the IT category. 3. From the ‘Create New’ dropdown, choose Question. 4. Click the Category field dropdown.</td>
</tr>
<tr>
<td>Knowledge Management PRB667232</td>
<td>Knowledge Management V3</td>
<td>Import from Word does not preserve formatting</td>
<td>Use the Import from Word feature. The formatting is not preserved.</td>
<td></td>
</tr>
<tr>
<td>Knowledge Management PRB673105</td>
<td>Knowledge Management V3</td>
<td>When there are many categories, drilling into a knowledge base from $knowledge.do is slow to load</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Knowledge Management | Knowledge Management v3 | Knowledge search results are limited to the user’s preferred language | In Geneva, Knowledge search results are limited to the user’s preferred language. This does not offer an option for customers to search articles in all languages. In a multilingual environment, where users may speak more than one language and articles may be written in English or any other language, it is not a desired and expected behavior to force searches to filter by language. Geneva introduced a dependency where I18N: Internationalization requires the I18N: Knowledge Management Internationalization Plugin, which does not leave an option for customers decide to whether or not to localize or the Knowledge Base. However, this is not stated in product documentation. To allow users to search all articles in all languages, there should be an ‘All’ option in the language picker and an option to force that as the default. | Scenario 1  
In a Geneva instance:  
1. Install the ‘I18N: Knowledge Management Internationalization Plugin v2’ plugin.  
2. Install an alternate language (e.g. German).  
3. Create and publish a new KB article in German.  
4. Browse to Self-Service › Knowledge.  
5. Search for the article created in step 3. Note that the article does not appear in searches.  
6. Switch to the German language, or impersonate a user that has German as their preferred language.  
7. Search for the article again. It will be visible, but the English language KB articles will not. |

| Scenario 2  
In Fuji, the ‘I18N: Knowledge Management Internationalization Plugin v2’ plugin is not activated, however I18N: Internationalization is active.  
1. Upgrade the instance to Geneva.  
2. Note that the I18N: Internationalization plugin requires I18N: and Knowledge Management Internationalization Plugin v2 due to the dependency. This does not give an option whether or not to have a translated knowledge base. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Knowledge Management | Knowledge Management V3 | UI page kb_find published knowledge does not show if glide.knowman.search.show_author is false | Even though glide.knowman.search.show_published is set to true, which should control if the published date is shown for kb_find search results or knowledge home page results, the published date does not show if the glide.knowman.search.show_author system property is set to false. | 1. Go to the UI page kb_find. Click Try it to view the page.  
2. Search a term such as ‘email’.  
3. If glide.knowman.search.show_published is set to true and glide.knowman.search.show_author is set to false, the published date does not show.  
4. Now set the glide.knowman.search.show_author system property to true and you will see all the information display.  
Expected behavior: Published date should show even though the client does not want to display the author information.  
Actual behavior: Published date information is dependent on author system property. |
| Knowledge Management | Knowledge Management V3 | Changing knowledge search properties does not immediately apply to UI knowledge search page |  |  |
| Language and Translations | PRB640226 | Italian Finnish translation missing on calendar | When clicking the calendar popup for a date/time field, there is no translation for the days of the week in Italian. It displays in English (SMTWTFS), and it needs to be translated to Italian (DLMMGVS). | 1. Navigate to Plugin › Activate Italian or Finnish.  
2. Change the language to Italian or Finnish.  
3. Navigate to incident (Incidente) › open (Aperto).  
4. Click the date/time type fields Aperto (Opened) or Chiuso (Closed).  
The Date/Time type fields Opened and Closed do not show the Italian translation. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Language and Translations PRB677194 |  | Days of the week in the Date picker do not get translated into Finnish | 1. Active the Finnish translations plugin.  
2. Change your language to Finnish.  
3. Open an existing change request.  
4. Find any date/time field, and click on the calendar icon to display the date picker. | Notice that the days of the week display as: M, T, W, T, F, S, S. In Finnish, they should be: M, T, K, T, P, L, S. The related UI message entry is being created when the plugin is activated, but the values are in English instead of Finnish. |
| Lists PRB669717 | UI16 | List v3 features are shown in What’s New in Helsinki popup | 1. Open What’s New.  
2. Notice that there are two slides dedicated to List v3. | |
| Lists PRB671306 | List v3 Components | System property glide.ui.list.edit not working in new lists | 1. Using List v3:  
1. Change "Incidents" table plural to "Incidents & things".  
2. Set glide.ui.escape_text system property to false.  
3. Restart the instance.  
4. Go to the list of Incidents. | See error "The entity name must immediately follow the ‘&’ in the entity reference." |
| Lists PRB673309 | List v3 Components | List v3 fails to render if glide.ui.escape_text = false and table plural has an ampersand | 1. Change "Incidents" table plural to "Incidents & things".  
2. Set glide.ui.escape_text system property to false.  
3. Restart the instance.  
4. Go to the list of Incidents. | See error "The entity name must immediately follow the ‘&’ in the entity reference." |
| Live Feed PRB670749 |  | After upgrading to Geneva Patch 5, Live Feed search is not working in public group and has latency issues | In a Geneva instance:  
1. Navigate to Live Feed \(\rightarrow\) Group Feeds.  
2. Click All Feeds.  
3. Enter "employees" in the search and press enter. | Instead of returning feeds that contain "employees", search returns all the feeds. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>MID Server PRB667651</td>
<td>MID Server should be able to handle dzdo as a privileged command</td>
<td>A Service Mapping user was able to use “dzdo” as a privileged command, but it is not supported by the MID Server. The fix for PRB667651 adds support for “dzdo”. Refer to these topics for details: • <a href="#">Privileged commands for Discovery</a> • <a href="#">Privileged commands for the MID Server</a> • <a href="#">Configure the MID Server to use specific privileged commands</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MID Server PRB670521</td>
<td>MID Server fails to parse the output of the sudoers file and prompts for a password when using SSHKEY’s</td>
<td>MID Server fails to parse the output of the sudoers file correctly when there is a long line in the sudoers file, and it prompts the user for a password. This happens when using SSH keys. When there is a very long line in sudoer file, you cannot really tell if you are able to run a command without password or not through the output of “sudo -l” because the sudo -l output will cut the single line into multiple lines.</td>
<td>In an instance that uses SSH keys in your credentials table: 1. Run Discovery on any Linux system which has a long line in sudoers file. 2. Look at the input from the Linux-Identity probe. Note the error message in the ECC queue saying that a password is not supplied.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Mobile PRB669406 | Mobile UI, NG shared components | In mobile web, linking to a date query displays incoherent string and causes error when attempting to edit date query | | 1. Navigate to Mobile Navigator Apps > Self-Service > Add module.  
2. Set the table to incident and add a query for the table that includes a date: Opened on 12 months ago.  
3. Save the form and view the mobile web.  
4. Click the new module and notice the bad display in the filter: Opened on 12 months ago@javascriptandmorejavascript.  
5. Click to edit the filter.  
6. Click to edit the date condition on the filter.  
Notice the JavaScript error on the page. The UI should be displaying a clean display without JavaScript. |
| Password Reset Application PRB669891 | OOB PW Reset - AD workflow not compatible with Minimum Age requirement in AD | The password history policy is enforced even though the ‘Enforce history policy’ flag is disabled on the credential store. | | 1. In Windows, select Switch User.  
2. Select the Ctrl+Alt+Del app.  
3. Select the pictures in the reCaptcha, then click Next.  
The generated random text cannot be copied (Ctrl+C) or right-clicked (no context menu). Only the ‘Cancel’ button is available. |
<p>| Performance Analytics PRB668058 | Performance Analytics | Dashboard breakdown sources are no longer accessible from child domains. In Fuji, these selectors were available. | | |</p>
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Performance Analytics | PRB668718 | When exporting to PNG, time series widget shows all scores when ‘show range selector’ is checked | 1. Create an indicator with a scores for 2 months.  
2. Add a breakdown to this indicator and add scores for 2 months.  
3. Create a time series widget with this indicator and 2 additional indicators with indicator/breakdown/element.  
   • Period: 1 month  
   • Show range selector=true  
4. Export to PNG.  
Instead of showing only 1 month of data, all scores are shown. |
| Performance Analytics | PRB669162 | Widget Indicators Label is not being used on List Widgets | On list type widgets, Additional Indicators (pa_widget_indicators) with a Label will display on the widget the Name of the Indicator and not the Label information. This feature works as expected with ‘Workbench’ and ‘Time Series’ widget types, and it is irrelevant to ‘Score’ and ‘Breakdown’ widget types. | 1. Make sure the sys_dictionary record for pa_widget_indicators.label is Display = true (OOB configuration).  
2. Create a list type widget, scorecard visualization, and save the record.  
3. Add new widget indicators to your list widget. Make sure to insert a label that differs from the Indicator Name.  
4. Add the list widget to a dashboard.  
The list widget displays the name of the Indicators, not the Label defined on the widget indicators record. |
| Performance Analytics | PRB669762 | Data collector fails when there is a script without facts table | Performance Analytics scripts that do not specify a Facts table cause data collection to fail. | 1. Navigate to Performance Analytics > Scripts.  
2. Create a new script.  
3. Leave the Facts table field empty.  
4. Run a data collection job. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Performance Analytics | Performance Analytics | When exporting to PNG/JPG, widget shows all scores and not the breakdown specific scores | | 1. Create an indicator with a scores for 2 months.  
2. Add a breakdown to this indicator and add scores for 2 months.  
3. Create a time series widget with this indicator and 2 additional indicators with indicator/breakdown/element.  
   - Period: 1 month  
   - Show range selector=true  
4. Export to PNG.  
Instead of showing only 1 month of data, all scores are shown. |
| Performance Analytics | Performance Analytics | Unable to drag Performance Analytics Scorecard to favorites in UI16 | In UI16, users are unable to drag the Performance Analytics Scorecard to favorites (using Chrome browser version 50.0.2661.94 and Safari 8.0.8). | 1. Navigate to Performance Analytics > Scorecards.  
2. Navigate to the Favorites tab.  
3. Select any scorecard and drag it to the Favorites tab.  
Note that the selected scorecard cannot be added to the Favorites tab. |
| Performance Analytics | | Russian translation is not working on PA widgets headings, etc. | In a Geneva Patch 5 instance:  
1. Enable the Russian language plugin.  
2. Using the English language, navigate to Performance Analytics > Dashboard.  
3. Select Incident Management from top list.  
4. Change the language to Russian.  
Notice the widget names, legends, etc. still appear in English. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics</td>
<td>Performance Analytics</td>
<td>Performance Analytics dashboards display ‘The reference to entity’ error when selecting a value with an “&amp;” (ampersand) in the name from the breakdown element dropdown.</td>
<td>1. Change the Value of the incident priority High choice from 2 to R&amp;D (no spaces surrounding the ampersand). 2. Add breakdown source incident.priority to a breakdown dashboard. 3. Navigate to the dashboard and select the high priority (with value R&amp;D).</td>
<td></td>
</tr>
</tbody>
</table>
| Persistence | | Oracle query issued in ElementMetadataQuerier joins lower(‘sys_id’), degrading performance because desired index is not used | 1. Invalidate cmdb_ci by running GlideTableManager.invalidateTable("cmdb_ci") in Scripts - Background. 2. Turn on SQL Debugging. 3. Navigate to /cmdb_ci_list.do.  
Note the large number of long-running queries such as: 19:51:25.789: Time: 0:00:00.111 id: SNC10111127[glide.8] for: SELECT * FROM sys_dictionary d left join sys_metadata m on lower(m."sys_id") = lower(d."sys_id") WHERE lower(d."name") = 'sys_ui_action_view'  
These take 100+ms because we are missing index utilization on the join, since the columns are being unnecessarily "lowered." |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Persistence      | Human Resources  | In Geneva, hr_change | According to the Geneva release notes: “In addition, the (hr_change) table is merged with the (hr_case) during the upgrade. All HR cases and changes are placed in the (hr_case) table and the (hr_change) table is removed. Any customizations you made to either table are applied to the (hr_case) table.”  

A user who upgraded from Fuji Patch 10 to Geneva Patch 4 had custom columns in their hr_change table that were deleted along with the corresponding data. This is caused by a defect in the upgrade script that fails to apply customizations that existed before the upgrade.  

The fix for this PRB now properly reparents the hr_change table to the hr_case table. Custom columns in the hr_change table are no longer deleted for customers that upgraded from Fuji Patch 10 to Geneva Patch 4. | Refer to the listed Known Error KB article for details. |
<p>| PRB670065        | Application: Core, Service Management Core | table does not reparent properly to hr_case table | | |
| PRB668234        | KB0565488        |                               | | |
| Persistence      | PRB668234        | Uncaught exception from RecordWatcherCache | Users are experiencing an intermittent blank white screen due to cache inconsistencies between nodes (node1 is sending messages in a different format than node2 is reading them). | Refer to the listed Known Error KB article for details. |
| PRB670065        | KB0584891        | due to inconsistent watcher configuration factories between nodes | | |
| Platform Performance | PRB677005 | Decrease AMB log volume | | |</p>
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Platform Security | PRB667582        | Monitoring: Remove login events | Existing login events need to be removed, but we still need to continue logging the events into app server logs.  
  • DB  
  • LDAP  
  • SAML | |
| Platform Security | PRB674503        | Performance degradation when using GlideRecordSecure when the record being queried contains fields such as variables, audio, userImage, currency, and possibly other fields. | Performance degradation occurs while using GlideRecordSecure when the record being queried contains fields such as variables, audio, userImage, currency, and possibly other fields. | 1. Create a new table.  
2. Add several currency fields to it, along with other dummy fields (e.g. name, description).  
3. Create an entry under sys_relationship table:  
   • Applies to table is incident  
   • Queries from table is the new table created in step 1  
4. Add a query such as  
   current.addQuery('&lt;SOME_FIELD_IN_THE_NEW_TABLE',  
   &lt;SOME_VALUE_THAT_MATCHES_A_LOT_OF_RECORDS);  
5. Add many records to the new table.  
6. Create a list_edit ACL on the new table, and add a condition and a query using some fields on the table.  
When you open an existing incident, note that the AJAX call to fetch the records under the new embedded list is taking a lot of time to get the response back.  
Enable SQL debugging. Note that for every currency field under every record under the new embedded list, a GlideRecord query is being made when getSpecificDisplayValue is done. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management PRB627580 | Project Workbench | Project tasks created through the Project Workbench automatically get added as guided boards to the VTB | According to the [wiki](#), a guided board can be created by right-clicking on a list column of type choice list or reference. It does not mention if there is any other way that these guided boards can be created. However, project tasks that are created using the project workbench are automatically created as guided boards on the VTB. A guided board is created when a project task is created. When a lot of project tasks are being created, the guided VTB gets flooded with boards, which can become a huge issue for some users. | 1. In a Fuji instance, activate the Project Management and Visual Task Board plugins.  
2. Create a project.  
3. Load this project on the Project Workbench.  
4. Click on the Project Detail icon on the header (the i within a circle icon).  
5. A window should pop up. Within this, scroll to the Project Tasks related list.  
6. Create a new project task.  
7. Navigate to the My Task Boards module.  
Note the new project task created was automatically added as a guided board. |
| Project Management PRB668286 | Project Management PRB668286 | Planning console security | The planning console is not available for users without CRUD on the project table. The planning console should be available as long as CRUD access is available in project, CRUD is on the project task table, and CRUD is on the planned_task_rel_planned_task table | |
| Project Management PRB668503 | Project Management PRB668503 | Actual End Date for parent project gets incorrectly set and/or updated even though all of the Projects Tasks for the Project are not complete | As per the Project Management design, a parent project’s Actual End Date should get set only when the Percent Complete for the project is at 100% and all of the child Project Tasks of the Project are complete. | 1. Make sure the Project Management v3 plugin is enabled.  
2. Create a Project with multiple Project Tasks and child Project Tasks.  
3. Close an existing Project Task from the Project’s list view in list edit mode.  
Notice that the Actual End Date of the EDP - Network Segmentation parent project gets set incorrectly even though not all of the project tasks are Closed Complete. The Actual End Date should not have a value if all of the Project Tasks have not yet closed and the percent complete of the parent project is not at 100%. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management PRB668519 | | A “24x7” schedule for projects result in unexpected planned duration and planned end date behavior | Once the planned end date is changed, it results in an unexpected calculated planned duration. Likewise, a change in planned duration results in an unexpected calculated planned end date. | 1. Create a “24x7” schedule.  
2. Schedule entries for it:  
   • When: check the All day checkbox  
   • Repeats: Daily  
   • Repeat every: 1 Day  
   • Repeat until: blank  
3. Create a new Project record.  
4. Set the daily schedule as 24x7 (repeats daily all day).  
5. Change the Planned end date.  
6. Go through it day by day. Note it works as expected until it hits a weekend, and the planned duration changes to an unexpected value.  
7. Reset the planned duration back to 00 00:00:00.  
8. Change the planned duration to a value such as 07 00:00:00.  
Observe the planned end date is now an unexpected value as well. For example, if the planned start is 04/04, the planned end should be 04/11, but it is something like 05/23 instead. |
| Project Management PRB668817 | | Users cannot create dependency when locale is not English | Users cannot create dependencies when locale is Swedish. | In an instance where the locale is Swedish:  
1. Create a new project.  
2. Create two task with the second starting next day after the first ends.  
3. Create a finish to start dependency between first and second.  
You will see the error: "Cannot add relation to a successor task which has already started". |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management | Resource Management | Omit new button not honored for Resource Plan related list on Project form | Users are unable to remove the ‘New’ list control for the Resource Plan related list on the Project form. | In a Geneva instance:  
1. Activate the Resource Management plugin with demo data.  
2. Navigate to Projects › All.  
3. Click into Demo Project for Resource Plan.  
4. Open the Resource Plan related list.  
5. Right-click the column header › Configure › List Control. Notice the OOB ‘Omit new button’ is checked (if for some reason it is not, check it and save the form).  
6. Go back to the Project form. Notice that the New button is there even though “Omit new button” is configured for that list control.  
The New button should be hidden, but it is not. |
| Project Management | Resource Management | Selecting ‘Project workbench’ context menu from the project list view does not display anything | When a user selects ‘Project Workbench’ from Project › Projects › All › right-click on a project record from the list view › Project Workbench, nothing appears. The browser inspect element shows: “Error running context menu ‘Project Workbench’: ReferenceError: g_form is not defined” | In a Geneva instance:  
1. Navigate to Project › Projects › All › right-click on a project record from the list view › Project Workbench.  
2. Note that nothing appears. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management            | Project Management PRB673178 | Latency issue with updating/creating/linking project tasks in a project with several layers of children tasks | Updating/creating/linking a project task within a project and/or parent project task can result in latency issues when the project has many tasks in its hierarchy.                                                                 | In a Geneva instance:  
1. Create a project.  
2. Create many project tasks for the project. Make some of those tasks dependent upon other tasks (parent:child relationships), with multiple children tasks for several parent tasks, etc.  
3. Go into one of the child projects task and try to update it (e.g. change state from WIP to Closed).  
   
This can take 15 seconds to several minutes.                                                                                                                                                                                                                           |
| Project Management            | Timeline Visualization PRB674348 | No scroll bar in the Alert Timeline balloon pop up                                    | There is no scroll bar in the Alert Timeline balloon pop up. If there are more than 4 alerts, list can only show 3-4 and there is no way to scroll down.                                                                 | 1. Make sure there are 10 major alerts for a day.  
2. Open Alert Timeline.  
3. Click on the balloon that has the 10 alerts.  
   
Only 3-4 alerts that fit into the screen, and there is no scroll bar.                                                                                                                                                                                                 |
| Project Portfolio Management  | Portfolio Workbench PRB671438 | Portfolio Workbench not displaying actual cost in the grid view                      |                                                                                                                                                                                                                                                                          | 1. Set up all the prerequisites for financial planning of projects.  
2. Create a Project for Portfolio and a Cost Plan for the project.  
3. Create an expense line for the cost plan and process the expense line.  
4. Open the portfolio workbench.  
5. Verify the actuals in the widget and the grid.  
   
Note that instead of both the widget and the grid displaying the actual cost, the grid does not display any value for the actual cost.                                                                                                                                 |

© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Reporting        | PRB669172        | Grouping by a field with a % in the data causes the drill down to error out with URI Malformed error | If you group by a field that has a % in the data and put that data into a bar chart, drilling down into the bar chart that has the % as part of the axis name will cause a URI Malformed error to occur. | 1. Navigate to incident.list.  
2. Filter assigned_to = Beth Anglin.  
3. Modify one of the short descriptions to have a % in it.  
4. Right-click the short description header and click Bar Chart.  
5. Click on the bar for the record where you added the %.  
Instead of being taken to that record in a list, nothing happens, and the user gets the URI Malformed error in the browser console. |
| Reporting        | PRB674530        | When exporting a Column report with stack by + Grouped Columns to PDF, it becomes a Stacked Columns report | | 1. Create a Column chart on incident grouped by priority (grouped columns), trend by created, per month, aggregation count.  
2. Save the report.  
3. Export to PDF.  
Notice that the exported chart shows as stacked, not as grouped columns. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Management</td>
<td>Resource Management</td>
<td>Installing <code>com.snc.resource_management</code> will not work as expected if <code>com.snc.project_management_v2</code> is already active.</td>
<td>If an instance has <code>com.snc.project_management_v2</code> activated and the instance admin manages the Resource Management plugin, the fix <code>com.snc.resource_management/update/install_project_management.xml</code> will NOT activate Project Management (<code>com.snc.project_management_v3</code>) as expected. This plugin contains several important dependencies for Resource management and will cause it not to work. One such dependency is the Common Workbench (<code>com.snc.common_workbench</code>) plugin and another is <code>/scripts/thirdparty/intro-v1.0.0/intro.js</code> file, which is required to load <code>/resource_workbench.do</code>.</td>
<td>1. On a pre-Geneva instance, activate <code>com.snc.project_management_v2</code> plugin and upgrade to Geneva. 2. Activate <code>com.snc.resource_management</code>. 3. Navigate to <code>/resource_workbench.do</code>. Notice the error in the browser console: WARNING *** WARNING *** Resource does not exist: /scripts/thirdparty/intro-v1.0.0/intro.js</td>
</tr>
<tr>
<td>SDLC</td>
<td>Agile Development</td>
<td>Sprint Burndown Chart is off by one day for users with GMT-timezones</td>
<td>All scrum tasks completed during sprints in GMT timezones show they were completed one day earlier than they should have been. The burndown chart on sprint shows the ‘Actual end date’ being a day behind.</td>
<td></td>
</tr>
<tr>
<td>Server Side Scripting</td>
<td>Syntax Editor</td>
<td>Service Portal script evaluation should support app scoping</td>
<td>All script evaluation within Service Portal currently executes in global.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Server Side Scripting</td>
<td>PRB680182</td>
<td>Instances which compile thousands of short JavaScript expressions may experience OOM after upgrading to Helsinki</td>
<td>When compiled to Java classes instead of being interpretatively executed, very short JavaScript expressions create larger Java class files in Helsinki due to an upgrade to the JavaScript compiler. Instances which compile very large numbers of very short JavaScript expressions to Java classes rather than interpreting them may experience OOM (Out Of Memory) issues after upgrading to Helsinki as a result. For example, filter expressions can cause a large number of short JavaScript expressions to be compiled. The Rhino JavaScript compiler operates in two distinct modes. It can compile JavaScript to Java classes and then execute the generated class, or it can compile the JavaScript into a simple stack-based pseudocode (pcode) and then interpretatively execute the pcode. If Java classes are generated, they are stored in a special area of JVM memory, which was historically known as ‘permgen’ and (since Java 8) is now known as ‘metaspace’. This area of memory is a limited resource, so compiling thousands of short scripts should be avoided, since it tends to cause the system to run out of permgen / metaspace.</td>
<td>There is no specific set of steps to reproduce. The only known case of this problem involved an instance which was using many SLAs and a large number of filter expressions. The expression cache contained thousands of slightly different entries for filter expressions.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Service Catalog</td>
<td>PRB666430</td>
<td>Cart Preview Screen pages can be slow to load if Lookup variables are empty</td>
<td>The cart layout Column Macro ‘sc_cart_view_column_expansible_desc’ uses script include ‘CatalogLabelEvaluator’ to provide the variable name and values for the edit cart, and checkout screens. If a variable is Lookup Select Box (type 18) and Lookup Multiple Choice (type 22), has the ‘Lookup Value Field’ set as sys_id, and has an empty value, then the code in the getDisplayValue function will still try to get a display value for this empty variable value. What happens is a get() on the referenced table with sys_id=''. This results in the whole table being returned. In Geneva, that means the form is slow to load. In Helsinki, the variables fail to load and there is an onscreen error: Illegal access to method getDisplayValue() in class com.glideapp.questionset.LookupSelectQuestion</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Catalog  | PRB668555 KB0584845 | SCStaleCacheListener causes sys_cache_flush table to bloat, stalling upgrades | SCStaleCacheListener listens to inserts/updates/deletes on the tables listed below. This affects user_items_cache and user_categories_cache for every domain in the system, potentially causing sys_cache_flush to have millions of records and stalling upgrades.  
  - sys_user  
  - sys_user_role  
  - sys_user_has_role | The defect affects instances that use User Criteria to control access to the items and categories in the Service Catalog within a domain-separated environment. The defect may cause very long upgrades and severe performance degradation.  
  Any update to a record in the sys_user, sys_user_has_roles, or sys_user_gm_table will trigger the USER_CATEGORIES_CACHE cache flush. When enough of these triggers in quick succession, the system is unable to process the cache rebuild, slowing down the system and leading to unresponsive behavior. This impact grows by a factor based on the number of domains.  
  The defect occurs under the following scenarios:  
  - Upgrade issue when com.glide.role_management.inh_count is not enabled and then com.glide.role_management adds multiple entries to the sys_user_has_role table. This can happen if a plugin upgrade adds a role or roles to other role or roles that are assigned to a large number of users.  
  - Plugin activation com.glide.role_management.inh_count can run into this issue.  
  - When a user adds a role or roles to another role or roles that are assigned to a large number of users.  
  - LDAP imports to update users or user roles can be affected by this issue. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog  | PRB669607        | Adding attachments to catalog item does not show the attachment, deletion progress bar shows indefinitely | After uploading an attachment to a Service Catalog item, it will not show the ‘Manage Attachments’ list. This works as expected in Geneva. In addition, deleting a catalog item’s attachment shows the deletion progress bar indefinitely even though the attachment gets deleted. These issues also exist for the record producer. | Issue #1: ‘Manage Attachments’ list does not appear 1. Go to the Service Catalog and open a catalog item. 2. Attach one attachment in the item ordering page. 3. Notice the ‘Manage Attachments’ list does not show up under the item header. 4. Drag and drop a file to the attachment list. 5. Notice the attachment is shown, but it is attached to the record. Clicking on the clip icon will not show the newly added attachment.  
Issue #2: Deletion progress bar is displayed indefinitely 1. Navigate to Service Catalog › Maintain items. Select one catalog item and try it. 2. Attach multiple attachments in the item ordering page. 3. Select any attachment and and click Remove. 4. Note that deleting a catalog item attachment shows the deletion progress bar indefinitely. 5. Close the the popup after a few seconds, and click on the attachment again. Note the attachment was deleted. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog  | PRB675472        | Explicit Roles plugin activation throws a StackOverflowError | Activating the Explicit Roles plugin throws a StackOverflowError, leading to unexpected behavior in sys_user_has_roles. This is related to the fix for PRB668555. | 1. Activate Explicit Roles (com.glide.explicit_roles) plugin.  
2. Note the following errors in the localhost logs: |

```
2016-05-04 16:15:44 (653) worker.1 worker.1 SEVERE *** ERROR *** Java Android evaluation error on: GlideSecurityManager.defaultRoleFix jobGR = new GlideRecord('sys_trigger'); jobGR. 'Fix Default Roles on ACLs'); jobGR.query(); if (jobGR.next()) { gs.print('Setting the scheduled job for fixing the default roles to ready state'); jobGR.setValue('state...
```

<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Management Designer PRB669179</td>
<td>Service Management Core</td>
<td>Facilities Service Management - Templates are not usable when changing language</td>
<td>If not already installed, install the Facilities Service Management and I18N: French Translations plugins. 1. Navigate to Facilities › Catalog &amp; Knowledge › Facilities Request Templates. 2. From the list of Templates, open one of the records. 3. Set the language to French. See the page is broken, and several errors are shown on the screen.</td>
<td></td>
</tr>
<tr>
<td>Service Mapping PRB668135</td>
<td></td>
<td>Service Mapping logging debug messages when MID Server debug is disabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Mapping PRB668827</td>
<td></td>
<td>History - incorrect graph</td>
<td>When the user views history one minute ago on business services, they are getting incorrect data.</td>
<td></td>
</tr>
<tr>
<td>Service Mapping PRB669743</td>
<td></td>
<td>Service Mapping selects a wrong default MID Server</td>
<td>When defining a default MID Server using mid.server.rba_default, Service Mapping picks up the defined MID as a potential MID, even if that server does not have SM capability. 1. Define at least 2 MID Servers on an instance (MID1, MID2). 2. Add SM capability to MID1. 3. Add an IP range to MID1. 4. Set MID2 as default MID, using the mid.server.rba_default MID parameter. 5. Create BS with an entry point outside of MID1’s range. Note MID2 is selected for the Discovery task, even though no MID Server should be selected.</td>
<td></td>
</tr>
<tr>
<td>Service Mapping PRB671441</td>
<td></td>
<td>MID upgrade occasionally fails due to lock on DLL used by Service Mapping (log4net.dll)</td>
<td>This occurs when there were multiple MID Servers on the same server or MID Servers and the legacy SW collector. Since the WMI collector is shared by both MIDs, it may be that once we stop the service, the other MID will start it again and possibly lock the DLL of the first MID.</td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB673960</td>
<td>BaseEndpointFullData calls isManualConnection and isTrafficBased even when the source ID is null. During the opening of the Discovery log, isManualConnection is called from BaseEndpointFullData with a null source ID. As a result, cmdb_rel_ci is queried with type only, which may cause large result sets in case there are many relations in this table. Calling this method, as well as isTrafficBased, is unnecessary when the source ID is null. They can both be skipped, which will improve performance in some cases.</td>
<td></td>
<td>Open the Discovery log. This triggers a call to EndpointFullData with null source and target IDs.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB674248</td>
<td>On the Service Portal ‘Export URL’ (e.g., &amp;PDF) is failing and preventing export of attached items. Certain types of attachments cannot be downloaded from Service Portal forms.</td>
<td></td>
<td>1. Attach a PDF to a record. 2. Try to click it. Nothing happens.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB674262</td>
<td>Errors processing Order Guide Rule Bases, dependent items are not shown.</td>
<td></td>
<td>1. In the Service Portal, bring up /sp?id=sc_cat_item_guide&amp;sys_id=6690750f4f7b4200086eeed18110c761 (new hire order guide). 2. See errors in logs.</td>
</tr>
<tr>
<td>Service Portal</td>
<td>PRB676622</td>
<td>NG shared components, Service Portal Configuration Pages. Branding editor does not load without a default portal specified.</td>
<td></td>
<td>1. Disable the default portal. 2. Go to the branding editor. 3. Note the UI is unusable.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Skills Mgmt / Timecards</td>
<td>Skills Management</td>
<td>When adding a member to a group with existing skills, the skills are assigned but with the ‘Inherited from’ field not set</td>
<td>sys_user_grmember Business Rules “Group Member Add - Skills” and “Group Member Delete - Skills” refer to a non-existing field, “granted_by”, in the {sys_user_has_skill} table. As a result, a user removal from any group removes all skills from that user, even if those skills were not granted to the group for which membership is revoked.</td>
<td>Failure of “Group Member Delete - Skills”&lt;br&gt;1. Activate “Skills Management” plugin with demo data.&lt;br&gt;2. Check that beth.anglin is member of Service Desk and Hardware groups.&lt;br&gt;3. Grant Skill “Backoffice” to Service Desk group. The user beth.anglin will get the skill.&lt;br&gt;4. Grant Skill “Apple Computer” to Hardware group. The user beth.anglin will get the skill.&lt;br&gt;5. Remove beth.anglin from Hardware group.&lt;br&gt;&lt;br&gt;Expected result: User should lose the skill “Apple Computer” only.&lt;br&gt;Actual: Use loses all skills even granted by group “Service Desk” where he still has membership.&lt;br&gt;Failure of “Group Member Add - Skills”&lt;br&gt;1. Repeat steps 1-5 from above. The starting point is that beth.anglin does NOT have any skills + no membership in “Hardware”.&lt;br&gt;2. Add beth.anglin to “Hardware”.&lt;br&gt;&lt;br&gt;Expected result: sys_user_has_skill record with “Inherited from” populated as “Hardware” should appear.&lt;br&gt;Actual: sys_user_has_skill record appears, but with “Inherited from” empty.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| SLA              | PRB66934         | Service Offering SLAs only attach if the Service Offering is populated into the Configuration Item field on the associated task. | If a user has activated the Service Portfolio Management - SLA Commitments plugin, and they follow the instructions for configuring it in the wiki, the Service Offering SLA will only be attached to the incident if the associated Service Offering is populated as the Configuration Item (cmdb_ci) in the associated task record. There is a Service Offering (service_offering) reference field available on the task, but if it is used, the Service Offering SLA will not attach. | 1. Activate the Service Portfolio Management - SLA Commitments plugin.  
2. Configure the Service Offering SLA, Service Commitment, and Service Offering per the instructions in the wiki.  
3. Personalize the incident form to add the Service Offering field to the form.  
4. Create a new incident which meets the conditions of your Service Offering SLA, and populate the Service Offering field with the Service Offering and save it.  
5. ISSUE: The Service Offering SLA will not be attached as expected.  
6. Now update the incident, and populate the Service Offering into the Configuration Item field (cmdb_ci) and save it.  
7. Your Service Offering SLA will now attach. |
| UI Policy/Client Script | PRB658197 | Eureka / Oracle: UI action visibility is opposite of expected behavior. | On a Eureka instance with Oracle, setting UI action visibility to “include” causes the UI action to be hidden from a view. Setting the visibility to “exclude” causes the UI action to show in a view. | 1. Create a new UI Action and make it a list banner button using default settings.  
2. Navigate to the list for the table where you created the UI Action. The button appears in the list.  
3. Go back to the UI action and click Edit in the related list for UI Action Visibility.  
4. Select Default View from the list and add it. The default operation is Include.  
5. Go back to the list. The button does not show up. This is opposite from what will happen on a normal Eureka Patch 12 Instance.  
6. Go back to the UI action and change the action visibility to Exclude.  
7. Go back to the list. The button shows up. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Update Sets      | PRB674866        | Reparenting of existing table via update set works when it should not | When an update set was applied to change the existing table table u_cmdb_ci_scanner and make it extend cmdb_ci, the reparenting seemed to work. It should not have. Note that the logs show a warning and error (see Steps to Reproduce). This can cause data loss when a table is incorrectly reparented by an update set, for instance when it already has a parent. | 1. In the target instance:  
a. Create a stand alone table named “u_my_extending_table” (initially, this table will not extend anything).  
2. In the source instance:  
a. Create an update set and set it as current.  
b. Create a table named “u_my_extending_table” (it is important that the table name is the same as target). Make this table extend CMDB_CI.  
c. Complete the update set.  
3. Back on the target instance:  
a. Verify table “u_my_extending_table” does not extend anything yet.  
b. Retrieve and commit the update set created in step 2.  
c. Commit logs will show a warning with the message “Prevented attempt to reparent u_cmdb_ci_scanner, from null, to cmdb_ci” or something similar. You will also see this error in the localhost logs.  
d. Verify table “u_my_extending_table” again after committing the update set. In ss_db_object, it now shows that it extends from cmdb_ci. Checking the DB, table schema, etc. confirms that the reparenting actually took place.  

Warning and error:  
2016-04-29 05:59:42  
(425) Committing update set: <name of update set>  
SYSTEM WARNING ***

2016-04-29 05:59:42  
(476) Committing update set: <name of update set>  
SYSTEM SEVERE  
*** ERROR ***  
removeChild - null  
java.lang.reflect.InvocationTargetException  
[ ... ]  
at com.glide.update.loader.DBObjectUpdateLoader.makePayloadParentMatchDBParent(DBObjectUpdateLoader.java:164)  
[ ... ]  
Caused by: org.w3c.dom.DOMException: NOT_FOUND_ERR: An attempt is made to reference a node in a context where it does not exist.  
[ ... ]
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Sets</td>
<td>PRB676814</td>
<td>“Submit and make current” UI action on update sets is not updating the update set selector</td>
<td>“Submit and make current” UI action on update sets is not updating the update set selector in the top right until refresh.</td>
<td>1. Create a new update set. 2. Click the UI action Submit and make current. This is not updating the Selection under Settings &gt; Developer &gt; Update Set (top right).</td>
</tr>
<tr>
<td>Upgrade Engine Issues</td>
<td>PRB668114</td>
<td>sys_choice for extended tables are being incorrectly detected as collisions</td>
<td>During plugin activation, new sys_choice entries are being skipped during table creation if the base table has an entry for sys_update_xml.</td>
<td></td>
</tr>
<tr>
<td>Usage Analytics</td>
<td>PRB670106</td>
<td>Access handler blocks licensing count configuration creation</td>
<td>Count configurations for licenses are not created because they are blocked by the access handler on the count configuration table. This functionality worked as expected in Fuji and Geneva.</td>
<td>1. Create a license. 2. Download it. 3. Look for count configurations.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| User Interface (UI) | PRB603337 | GlideDialogForm prevents editing text field on form | In IE11, triggering a GlideDialogForm via a UI Macro on the incident form prevents the user from editing text fields. | 1. Create a new UI Macro with the following information:  
   - Name: add_contact  
   - XML:  
     <xml  
       version="1.0"  
       encoding="utf-8"  
     >  
     <j:jelly  
       trim="false"  
       xmlns:j="jelly:core"  
       xmlns:glide="g"  
       xmlns:j2="null"  
       xmlns:g2="null">  
       <g:evaluate  
         var="jvar_guid"  
         expression="gs.generateGUID(this)"  
       >  
       <a id="${jvar_n}"  
         onclick="testPop('${ref}');">  
         <img border="0"  
           src="images/icons/task.gifx"  
           title="${gs.getMessage('Add/Edit Contact')}"  
           alt="${gs.getMessage('Add/Edit Contact')}"/>  
       </a>  
       <script>  
         function testPop()  
         {  
           var dialog = new GlideDialogForm('Add Contact', 'sys_user');  
           dialog.render();  
         }  
       </script>  
       </a>  
     </j:jelly>  
   2. Go to the incident form and personalize the dictionary entry of Caller (caller_id).  
   3. Remove all attributes and add the following attribute: ref_contributions=add_contact;  
   4. On Internet Explorer 11, open an incident record and click on the middle UI Macro next to the caller field. (This is the custom
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI)</td>
<td>PRB619775 <strong>KB0546762</strong></td>
<td>In Google Chrome, the catalog list collectors &quot;onChange g_filter.setQuery()&quot; apply to only one of multiple fields</td>
<td>When multiple list collectors are present on a catalog item and a catalog client script is defined to filter the results using g_filter.setQuery(), the script will apply to only one of the three list collectors in place.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB628925</td>
<td>Fuji: Broken image icon (red X) displays in Knowledge Base articles in UI15 with IE9</td>
<td>In Fuji using IE9, a red X (broken image) icon appears next to the Image Search magnifying glass in Knowledge form. This issue does not occur in Chrome, Firefox, or IE10 and later.</td>
<td>In a Fuji instance with UI15: 1. Open an IE9 browser. 2. Edit an existing Knowledge article or create a new one. Note that a Red X (or broken image icon) appears between the Image label and magnifying glass icon for adding a KB icon.</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>Lists v2</td>
<td>When creating a module and entering a sysparm_fixed_query in the Arguments field, user cannot export data from the list after using search headers</td>
<td>When creating a module and entering a sysparm_fixed_query in the Arguments field, users cannot export data from the list after using search headers. The sysparm_query is not generated correctly.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB657134 <strong>KB0564278</strong></td>
<td>Process flow arrows point in the wrong direction in Hebrew</td>
<td>When using right-to-left languages, the process flow is working as expected from right to left, however the arrows in the process flow are in the wrong direction (pointing to right instead of left).</td>
<td>1. Navigate to System UI  Process Flow. 2. Using the State field, create a couple of records for the Problem table. 3. Navigate to Problem  Open. 4. Configure the Format layout and add Process Flow. 5. Change the instance language to Hebrew. 6. Navigate to Problem  Open. 7. Select any record. Note that the process flow is pointing to the left.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| User Interface (UI) PRB657491 | Hebrew - export form as PDF shows in LTR | When exporting a report to PDF in Hebrew, the content is shown incorrectly from left to right, which makes it impossible to read. It needs to be displayed from right to left. | 1. Navigate to Plugins } install the Hebrew language.  
2. Navigate to a report, open it, and right-click to export it to PDF.  
Note the content is incorrectly displayed from left to right. |
| User Interface (UI) PRB658590 | In Geneva UI15 & UI16, form freezes in IE9 if there are a large number of templates available for the form | The sys_attachment read ACL is preventing images from rendering when a non-admin user views the OOB User Guide. | In a Geneva Patch 1 instance as any non-admin user:  
1. Open the User Guide.  
2. Click on any document link. Note that images do not render but appear as broken.  
3. Switch user to admin and repeat steps. Note all images render as expected. |
| User Interface (UI) PRB659008 | User Guide ACL preventing user guide images from rendering for non-admin users | The sys_attachment read ACL is preventing images from rendering when a non-admin user views the OOB User Guide. | In a Geneva Patch 1 instance as any non-admin user:  
1. Open the User Guide.  
2. Click on any document link. Note that images do not render but appear as broken.  
3. Switch user to admin and repeat steps. Note all images render as expected. |
| User Interface (UI) PRB659019 | Displaying a list of records in a dialog window has scroll issues when the language is Hebrew | Users cannot scroll horizontally when there are more columns to display. This works as expected in English. | |
| User Interface (UI) PRB659442 KB0565097 | The Related List Loading } After Form Loads option causes records not to display in related lists in the Default view | The System Setting option Related List Loading } After Form Loads causes records not to display in the related lists (Forms, Form Sections, Lists, Related Lists) in the Default view. | 1. Choose the System Setting option Related List Loading } With the Form.  
2. Navigate to System UI } Views } Open the default view record.  
The related lists for Forms, Form Sections, Lists, and Related Lists show a list of records.  
3. Choose the System Setting option Related List Loading } After Form Loads.  
The related lists for Forms, Form Sections, Lists, and Related Lists do not display any records. |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI) PRB659771</td>
<td>NG shared components</td>
<td>iFrame does not resize correctly for content pages showing forms with Activity Streams</td>
<td>A widget can be set to a specific size larger than what the iFrame should show, however the iFrame does not resize to fill.</td>
<td></td>
</tr>
<tr>
<td>User Interface (UI) PRB660190</td>
<td></td>
<td>The data field calendar in Hebrew is displaying incorrectly</td>
<td>In a Geneva instance: 1. Install the Hebrew language plugin, and set the language to Hebrew. 2. Open a new incident record. 3. Select one date field to choose the date in the widget. Note the time is showing from right to left, and after selecting the date, the system shows the date/time incorrectly.</td>
<td></td>
</tr>
<tr>
<td>User Interface (UI) PRB660196</td>
<td></td>
<td>Form View: date field calendar in Hebrew is clipped off</td>
<td>Open a calendar widget on a Hebrew form.</td>
<td></td>
</tr>
<tr>
<td>User Interface (UI) PRB660267</td>
<td></td>
<td>Tabs in forms need to be in the right side for Hebrew version</td>
<td>1. Install the Hebrew language. 2. Add a few related lists to the incident form. 3. Set the configuration for 'tabbed-form'. In Hebrew, the tabs should be to the right side.</td>
<td></td>
</tr>
<tr>
<td>User Interface (UI) PRB665947</td>
<td></td>
<td>g.form.setValue no longer works on currency fields</td>
<td>The error 'TypeError: Object doesn’t support property or method 'replace' function' will be thrown if it is applied to a currency field. 1. Make an onChange script on any currency field. 2. Use g.form.setValue to change the value. 3. Test the script. The following node error is thrown: <code>TypeError: Object doesn't support property or method 'replace' function.</code></td>
<td></td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td><strong>User Interface (UI)</strong>&lt;br&gt;PRB666020</td>
<td>Lists v2</td>
<td>In Hebrew, group by in list view gets left aligned</td>
<td>In Hebrew, group by on ‘incident.state’ field in list view gets left aligned. This is reproducible in Fuji Patch 11.</td>
<td></td>
</tr>
</tbody>
</table>
| **User Interface (UI)**<br>PRB666123 | | Unable to use duration fields as part of SLA conditions (caused by already having a duration type field on the form) | When adding a ‘duration’ type field in one of the conditions field of an SLA Definition (e.g. Start condition), although the field to select the comparison is displayed (e.g. is, greater than, not equal), the fields to enter the duration value to compare with are not shown. This only happens for UI15 (i.e. system property ‘glide.ui.doctype’ is true) and appears to be related to there being a ‘duration’ type field already on the form. | 1. Create a new SLA Definition (‘contract_sla’ table) and choose Incident in the table field.  
2. In Start Condition, add a new condition and select field name Time worked (which is a duration field). No additional fields are displayed to allow you to enter the duration value for that condition.  
3. Configure the form layout and remove the Duration field from the form.  
4. Repeat step 2. The fields to enter the duration value will be shown as expected. |
| **User Interface (UI)**<br>PRB666815 | Lists v2 | Rows render more slowly in Geneva compared to prior builds | Row rendering in Geneva is taking twice as long as it did in Eureka, which is causing list view response times to double. | |
| **User Interface (UI)**<br>PRB667422 | | Breadcrumbs order is wrong when one of the items is in Hebrew | When using an instance in Hebrew, on the Project task form, if one of the chain project tasks name is in Hebrew, the breadcrumbs order is incorrect. | |
| **User Interface (UI)**<br>PRB668587 | | Vertical scroll bars are deactivated when navigator and banner are not present in IE11 | In a Geneva instance using UI16:  
1. Navigate to a list of records (e.g. incident).  
2. Open a record so that just the content frame is displayed.  
3. Try to scroll vertically on the form by clicking on the scroll bar on the right hand side of the display.  
Notice that the scroll bar is visible, but it is deactivated. However, vertical scrolling can be achieved by using a mouse scroll wheel or a tactile touchpad. | |
<table>
<thead>
<tr>
<th>Problem category</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI)</td>
<td>NG shared components</td>
<td>Presence indicator missing on navpage header if Connect is not enabled</td>
<td>Customers who have UI16 enabled but NOT Connect will not see the presence indicator in the nav page header. This only affects the user’s avatar in the navpage header.</td>
<td>1. Upgrade an instance from Fuji to Geneva OR remove the Connect entry in sys_plugins.</td>
</tr>
<tr>
<td></td>
<td>PRB673069</td>
<td></td>
<td></td>
<td>2. Ensure presence is enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Load the navpage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Notice the green dot is missing. You should still see presence on VTB and on the form activity stream.</td>
<td></td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>TinyMCE HTML Field Editor</td>
<td>New attachments with the Tiny MCE Editor using the Insert/Modify image icon can be seen globally</td>
<td>Open the email icon from any existing incident, try to attach any image using the Insert/Modify image icon, and cancel the email (i.e. do not send). The attachment can be seen from different incidents when trying to perform the same steps. The problem is that the new inserted attachment rows in the sys_attachment table have Table Name and Table Sys ID as empty.</td>
<td>1. Navigate to Incident › Open.</td>
</tr>
<tr>
<td></td>
<td>PRB673508</td>
<td></td>
<td></td>
<td>2. Click any incident from the list to edit it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Click the email icon, and then click the image icon.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Inside the email editor, click the Insert/Modify image icon.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Choose an attachment from the Type LOV › New › Choose File.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Choose any image file from the file list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7. Click the Attach button, make sure that the image gets loaded to the screen, and click OK.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8. Close the email window - do not send the email.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If you try to edit another incident and repeat the steps above after step 5, you will notice that the image field has the attachment that you added in the original incident.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Query the sys_attachment table: https://&lt;instance&gt;/sys_attachment_list.do. The attachments inserted have the Table Name and Table Sys ID as empty.</td>
</tr>
<tr>
<td>Problem category</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>User Interface (UI)</td>
<td>PRB673920</td>
<td>There is no focus state for tabbed sections and related lists on forms</td>
<td>Accessibility features allow other applications such as VoiceOver (enabled by hitting Command+F5 on Mac keyboard) to activate the VoiceOver App to identify and get more voice enabled and on screen details and description of fields by tabbing into them within the ServiceNow platform. In order for VoiceOver to work, ServiceNow needs to assign roles to fields/objects within the user interface so that such applications can access these fields. However, there are a few objects such as related lists within forms when using Tabbed forms where these roles are not getting assigned, thereby rendering such fields/objects unaccessible to VoiceOver and other such applications.</td>
<td>1. Activate the VoiceOver application by clicking on Command+F5 from a Mac keyboard. 2. Go to any form within the platform with more than one related list. 3. Make sure that you are using tabbed forms. 4. Hit the tab key in the form. Observe that when you are on related lists, the system skips the remaining related lists on the form and only goes through the fields within the first related list on the form.</td>
</tr>
<tr>
<td>Web Services</td>
<td>PRB673025</td>
<td>REST API Provider</td>
<td>Following upgrade to Geneva, REST quota rules are added to instances that do not already have any</td>
<td>Instances that upgrade to Fuji and then to Geneva receive REST quota rules intended only for instances created on Fuji or later. Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Workflow</td>
<td>PRB667571</td>
<td>Financial Management, Contract Management</td>
<td>com.snc.contract_management.wf_workflow_version is overruling the current published workflow version</td>
<td>In a Fuji instance: 1. Make some updates to the ‘Contract Approval’ workflow and publish it. 2. Upgrade the instance to Geneva.</td>
</tr>
</tbody>
</table>

Other Helsinki Patch 1 information

Discovery and MID Server
- *Privileged commands for Discovery*
- *Privileged commands for the MID Server*
Configure the MID Server to use specific privileged commands

Service Portal

Widget scripting:

Note: Only client scripts set with the UI type as Both or Mobile run in Service Portal.

Fixes included with Helsinki Patch 1

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

* Helsinki Patch 0 Hot Fix 3

This release includes the HP0HF3 PRBs that were also fixed in HP1. *

- HP1: PRB677407, PRB680182, PRB680620, PRB670075
- HP2: PRB677407, PRB680182, PRB680620

* Helsinki Patch 0 Hot Fix 2
* Helsinki Patch 0 Hot Fix 1
* Helsinki Fixes

Helsinki Patch 0 Hot Fix 3

Helsinki Patch 0 Hot Fix 3 provides fixes for the Helsinki release.

For Helsinki Patch 0 Hot Fix 3: Build date: 06-06-2016_1539
Build tag: glide-helsinki-03-16-2016_patch0-hotfix3-05-31-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.
Fixed problems in Helsinki Patch 0 Hot Fix 3

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRB680620</td>
<td>After upgrading to Helsinki, POP/LDAP fail with a keystore exception, and users are unable to log in</td>
<td>Unable to load certificate.</td>
<td>SAML 2.0 SP Keystore - b88267271b01200f1129141be071393: java.io.IOException: Keystore was tampered with, or password was incorrect: sun.security.provider.JavaKeyStore.engineLoad (JavaKeyStore.java:780) sun.security.provider.JavaKeyStore $JKS.engineLoad (JavaKeyStore.java:56) sun.security.provider.KeyStoreDelegator.engineLoad (KeyStoreDelegator.java:21)</td>
</tr>
<tr>
<td>Problem</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Server Side Scripting PRB680182</td>
<td>Instances which compile thousands of short JavaScript expressions may experience OOM after upgrading to Helsinki</td>
<td>When compiled to Java classes instead of being interpretatively executed, very short JavaScript expressions create larger Java class files in Helsinki due to an upgrade to the JavaScript compiler. Instances which compile very large numbers of very short JavaScript expressions to Java classes rather than interpreting them may experience OOM (Out Of Memory) issues after upgrading to Helsinki as a result. For example, filter expressions can cause a large number of short JavaScript expressions to be compiled. The Rhino JavaScript compiler operates in two distinct modes. It can compile JavaScript to Java classes and then execute the generated class, or it can compile the JavaScript into a simple stack-based pseudocode (pcode) and then interpretatively execute the pcode. If Java classes are generated, they are stored in a special area of JVM memory, which was historically known as ‘permgen’ and (since Java 8) is now known as ‘metaspace’. This area of memory is a limited resource, so compiling thousands of short scripts should be avoided, since it tends to cause the system to run out of permgen / metaspace.</td>
<td>There is no specific set of steps to reproduce. The only known case of this problem involved an instance which was using many SLAs and a large number of filter expressions. The expression cache contained thousands of slightly different entries for filter expressions.</td>
</tr>
<tr>
<td>Problem Description</td>
<td>Description</td>
<td>Steps to reproduce</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Transaction and Session Management PRB6496 KB059470</td>
<td>MID Server stops communicating to the instance and continuously produces the socket timeout error: Accepted with code: 202</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Platform Performance PRB6700 KB059481</td>
<td>ServletTransaction does not account for recycled requests and leaves sessions in session sync.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Platform Performance PRB6774</td>
<td>Mean semaphore exhausted on HI</td>
<td>As a customer admin, try to change the Primary/Secondary Technical/Support contacts in the core_company table.</td>
<td></td>
</tr>
</tbody>
</table>

Recycled requests cause session leak issues. This results in either of these behaviors:

- MID Server stops communicating with the instance and continuously produces the socket timeout error: Accepted with code: 202, until the user upgrades to a fixed version.
- Stuck sessions in the transaction queue. In this case, users receive 429 “Rejecting request” errors due to the session leaks.

This is caused by the platform holding a session sync on a transaction that has been cancelled.

The RESTAPIProcessor throws an exception that causes the transaction to be cancelled, but not release the session sync on the session. This results in sessions “leaking” in the queue and can eventually, in a worst case scenario, consume the whole transaction queue. The affected end user(s) experiences HTTP 429 “Rejecting request” errors.

As a customer admin, try to change the Primary/Secondary Technical/Support contacts in the core_company table.
Fixes included with Helsinki Patch 0 Hot Fix 3

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.

- Helsinki Patch 0 Hot Fix 2
- Helsinki Patch 0 Hot Fix 1
- Helsinki Fixes

Helsinki Patch 0 Hot Fix 2

Helsinki Patch 0 Hot Fix 2 provides fixes for the Helsinki release.

For Helsinki Patch 0 Hot Fix 2:  
Build date: 05-21-2016_1736  
Build tag: glide-helsinki-03-16-2016_patch0-hotfix2-05-21-2016

For more information about how to upgrade an instance, see Upgrade to Helsinki.

For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.
Fixed problems in Helsinki Patch 0 Hot Fix 2

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog PRB668555 KB0584845 | SCStaleCacheListener.java causes sys_cache_flush table to bloat, stalling upgrades | SCStaleCacheListener listens to inserts/updates/deletes on the following tables:  
  - sys_user  
  - sys_user_role  
  - sys_user_has_role  
  SCStaleCacheListener affects user_items_cache and user_categories_cache for every domain in the system, causing sys_cache_flush to have millions of records and stall upgrades.  
  Note: This issue highly impacts customers with a large number of domains. For example, a customer with 50,000 domains will have millions of rows. Customers with few or no domains will not be severely impacted by this issue. | Refer to the listed Known Error KB article for details. |

Fixes included with Helsinki Patch 0 Hot Fix 2

* Unless any exceptions are noted, you can safely upgrade to this release version from any of the versions listed below. These prior versions contain PRB fixes that are also included with this release. Be sure to upgrade to the latest listed patch that includes all of the PRB fixes you are interested in.  
  - Helsinki Patch 0 Hot Fix 1  
  - Helsinki Fixes

Helsinki Fixes

The Helsinki release contains fixes to these problems.

This topic lists security-related and notable fixes. For a complete list of fixes (PDF), see [Fixed problems in the Helsinki release](KB0565309).

For the Helsinki release:  
Build date: 04-21-2016_1541  
Build tag: glide-helsinki-03-16-2016__patch0-04-09-2016

For more information about how to upgrade an instance, see [Upgrade to Helsinki].
For more information about the release cycle, see the ServiceNow Release Cycle. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.

Note: This version is approved for FedRAMP.

Security-related Fixes

Helsinki includes fixes for security-related problems that affected certain applications and the ServiceNow platform. We recommend that customers upgrade to this release for the most secure and up-to-date ServiceNow features. For more details on security problems fixed in Helsinki, refer to KB0564627.

Notable Fixes

The following problems and their fixes are ordered by potential impact to customers, starting with the most significant fixes.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistence</td>
<td>PRB657730</td>
<td>Hierarchy editor defect may cause column data loss on upgrade to Geneva</td>
<td>ServiceNow engineers have identified a defect that affects customers upgrading from earlier family releases to a Geneva release. The defect will cause data loss on certain CMDB tables and is considered a severe impact problem.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td></td>
<td>KB0563157</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Persistence</td>
<td>PRB658455</td>
<td>Reparenting from [cmdb_ci] to [cmdb] is causing a long upgrade completion time with the potential for data loss during the upgrade</td>
<td>ServiceNow engineers have determined that one of the maintenance activities executing during the upgrade, reparenting cmdb_ci to cmdb, is causing significant delays leading to extended upgrade durations. In limited situations, it is also possible to lose changes made to records on these tables while the upgrade is running. Instances with more than 2 million records in the CMDB tables have experienced extended upgrade durations of at least 30 minutes. During the table maintenance, new changes made to records in the affected tables may not be preserved. Because of the sensitivity to timing, we cannot reliably predict when the issue may occur. Since the change to the CMDB record is lost when the upgrade completes, we consider this defect to have a high impact.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Persistence</td>
<td>PRB662748</td>
<td>hr_case data lost during reparenting to sm_order</td>
<td>ServiceNow engineers have identified a potential data loss that involves the hr_case and hr_task tables during the upgrade to Fuji or later from a prior family release version. In situations where the hr_task or hr_case table is created as Table per Class prior to the upgrade and when the table is altered during the upgrade, a table conversion takes place that results in data loss.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistence PRB668234 KB0565488</td>
<td>Human Resources Application: Core, Service Management Core</td>
<td>In Geneva, hr_change table does not reparent properly to hr_case table</td>
<td>According to the Geneva release notes: “In addition, the (hr_change) table is merged with the (hr_case) during the upgrade. All HR cases and changes are placed in the (hr_case) table and the (hr_change) table is removed. Any customizations you made to either table are applied to the (hr_case) table.” A user who upgraded from Fuji Patch 10 to Geneva Patch 4 had custom columns in their hr_change table that were deleted along with the corresponding data. This is caused by a defect in the upgrade script that fails to apply customizations that existed before the upgrade.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>On Premise PRB665363 KB0564467</td>
<td>Upgrading to Geneva Patch 3 or later with insufficient Oracle privileges leads to the instance being zBooted</td>
<td>ServiceNow has identified an issue affecting customers with an Oracle database who upgrade to Geneva Patch 3 or later. When upgrading, if the Oracle user account that was used to execute the installation or upgrade is missing the “grant select on dba_users to snc” privilege, then the preflight check fails. The instance is unable to confirm the schema exists and a zBoot is triggered. When executing an upgrade, this results in catastrophic data loss.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Domain Support PRB645230 KB0551728</td>
<td>Database views are not honoring domain separation when domain paths is enabled</td>
<td>ServiceNow has recently discovered a vulnerability that affects customer instances with Domain Separation configured to use Domain Paths as the query method. When the domain plugin is enabled and the domain_paths query method is used, the database views are not honoring domain separation.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Platform Performance PRB656062 KB0562873</td>
<td>The PDF font library does not close file handles, which can lead to a node outage</td>
<td></td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
</tbody>
</table>
| Presence PRB665893 | When an instance encounters periods of resource stress (multiple long running transactions), the addition of presence requests can cause semaphore queue build up, resulting in 429 error responses | A separate semaphore (Presence) has been added to ensure that presence requests cannot cause queue build up. | The following are symptoms of this issue:  
• Once an instance gets slow and starts queuing up requests longer than usual, the fact that there are lots of presence requests lead them to fill the queue. This causes all requests after 150 are queued to be rejected with a 429 error response.  
• When requests are rejected, some parts of the user interface (e.g. navigator, activity stream) may be missing. Users may also encounter 429 errors on page requests. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presence PRB66353 KB0584123</td>
<td>Angular AMB Services, NG shared components</td>
<td>User presence causes performance degradation when Connect, UI16, Mobile Support, or VTB is installed due to transactions related to the Presence feature</td>
<td>ServiceNow has found an issue impacting instances configured with the Geneva release family and with the Presence feature enabled. Please note that this feature is enabled by default with UI16 in Geneva. Presence generates a high volume of requests per user. The individual presence requests are generally fast, but they are susceptible to slowness when an instance is under heavy load. A high volume of slow Presence requests will clog the default semaphore queue. In the UI, this will manifest itself as missing components (for example, the navigator does not load, or a blank page is shown). On the stats page, this will manifest itself as a default semaphore pool with a queue depth at or near 150. A large percentage of the active requests will probably be Presence transactions. Requests will return 429 errors (Too Many Requests) if they encounter a filled semaphore queue. This can lead to delays and significant performance issues for users on the instance.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Update Sets PRB636499 KB0551769</td>
<td>Update set updates system properties instance_id/instance_name and causes outage</td>
<td>A recurring activity can lead to the unintentional change of the instance_id or instance_name property. After the value in this property is changed, the instance may go offline or fail to function correctly.</td>
<td>Refer to the listed Known Error KB article for details.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Update Sets  |                  | Missing sys_update_version records can cause an update set back out to drop tables | If the bootstrap sys_update_version for a table is lost, an update set back out for a modification to that table will result in the table being dropped. This is due to a complete overhaul of the way update set back out is performed in Fuji. | 1. Create a new update set and mark it as your current set.  
2. Open the tables module, search for sys_user, and open the form.  
3. Under application access, check Delete and click Update.  
4. Complete the update set.  
5. Navigate to sys_update_version.list  
6. Find the “previous” version of the sys_db_object you just modified, and get the sys_id of the sys_update_version record.  
7. Embed the sys_id in this script and run it from Scripts - Background var gr = new GlideRecord('sys_update_version'); gr.get('SYS_ID'); gr.deleteRecord();  
8. Execute the script.  

Instead of having the sys_user table lose its ‘delete’ application access, the sys_user table and its metadata for most of its columns is dropped. Note: Steps 5-8 can be replaced with a number of different scenarios, including cloning with an exclude on the sys_update_version table. |}

<p>| Platform Security |                  | Unprocessed security log events build up and are assigned to a ‘null’ queue | ServiceNow has identified a defect in a feature backported to Eureka Patch 11 from Fuji. Events originating from the SAML SSO plugin are assigned to a queue named ‘null.’ These events are not processed, resulting in an increase in the event queue backlog and a potential disruption of the event queue system. | Refer to the listed Known Error KB article for details. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade Engine Issues</td>
<td>PRB658745</td>
<td>Upgrade can erroneously change</td>
<td>ServiceNow engineers have identified a defect affecting a limited number of customers with large task tables and either Demand Planning or Project Management installed. Once upgraded to Geneva, certain tables within Demand Planning and Project Management become unavailable.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td></td>
<td>KB0563413</td>
<td>extension model</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import / Export</td>
<td>PRB609920</td>
<td>Import/export sets overutilizes</td>
<td>Oversized or simultaneous Import/Export Sets over-utilizes instance resources and causes instance degradation or outage</td>
<td>All of the following conditions must be true for this issue to be reproduced:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>instance resources and causes</td>
<td></td>
<td>• The incident was caused by the running of over-sized or numerous simultaneous import/export sets</td>
</tr>
<tr>
<td></td>
<td></td>
<td>instance degradation or outage</td>
<td></td>
<td>• The import/export set affected the instance by over-utilizing instance resources</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• The user configured the import/update set</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• The cause has nothing to do with a possible defect with the import/export platform functionality</td>
</tr>
<tr>
<td>Workflow</td>
<td>PRB653097</td>
<td>Activity of type Workflow produces 2</td>
<td>The reprovisioning activity triggers Workflow, which produces 2 child workflows instead of one. This causes database or instance information to not be updated (i.e. ‘passwords’), which prevents functionality such as email or even an instance outage.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>child workflows, preventing</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>database updates and causing</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>instance outages during</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>reprovisioning</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Reporting   | PRB662085        | SummaryTableWriter creates a DB transaction before creating a dataset, causing outage | Every long-running job also has logs that contain warnings about a connection owned by that thread not being freed. This resulted in DB contention and an outage (a very long-running database transaction forced MySQL to start flushing its writes to disk, which tanked performance and led to the same kind of issue with scheduled jobs backing up). | 1. Create an INT for a USG Company.  
2. Post a comment to the INT so that an email is sent to the USG Caller.  
3. Reply to the email so that the comment is posted to the INT as the USG Caller.  
Notice that the activity lists a SNC Employee instead of the USG Caller. |
| User Interface (UI) | PRB650532 | ImpersonateEvaluator script include causes undefined behavior | The script include ImpersonateEvaluator was added to a recent Geneva build to support a HI requirement for impersonation of USG users. There is a bug where inbound email actions cause a random SNC employee’s name to be posted to work notes/comments when the email is sent by a USG user. This happens when the Script Include returns false for the canImpersonate() function. | 1. Create an INT for a USG Company.  
2. Post a comment to the INT so that an email is sent to the USG Caller.  
3. Reply to the email so that the comment is posted to the INT as the USG Caller.  
Notice that the activity lists a SNC Employee instead of the USG Caller. |
<p>| Service Catalog | PRB642841 | Two threads attempting to use the same HashMap in Service Catalog, which causes semaphores to hang | An issue is triggering semaphore exhaustion. When two threads on the same application server attempt to use CatalogItemCategory.populateCache() at the same time, two semaphores hang. As a result, multiple occurrences of this issue exhaust the available semaphores leading to resource issues that require the node to be restarted. | To reproduce the issue, a race condition must be met, which is extremely difficult to trigger on demand. Specifically, two user threads need to access the same Java code at nearly the same instant. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Lists PRB570571 | Lists v2         | Related list and embedded list personalization not working. Related List layout cached against user role instead of individual user | On related lists, if person A personalizes the related list, person B can see the change. However, if person B tries to reset to default, it does not allow this. Forms and related lists are cached per user role. When user A personalizes the related list on a form, all other users with user A role can see the personalized form. | 1. Log in to a base system where this issue is occurring.  
2. Add the same set of roles to two different users.  
3. Using related list mechanic, personalize the list layout (as user A).  
4. As user B, go to the same list, and you will notice the list layout personalized by user A.  
The Reset to Column Defaults will only show up when that user has already personalized the list. |
<p>|                 | KB0522575        |                                                                                    |                                                                                                                                                                                                              |                                                                                                       |
| Service Catalog | PRB639752        | Customers using &quot;Category.getItems&quot; have stuck &quot;/catalog_home.do&quot; transactions, causing instance functionality degradations | On some Fuji patches, Service Catalog pages cause the semaphores to hang. This is caused by the cache running out of memory because items are being cached multiple times, whether or not they were already there. Fuji Patch 3 up to Fuji Patch 8 instances may be affected. This issue can occur with just two users and a single item if both try to access the functionality at the exact same time. The majority of customers on the affected versions do not experience this issue as the issue is of concurrency where both the access must happen at exactly same time. | There are no clear steps to reproduce. This issue is more dependent on running out of memory than any particular process. |
|                 | KB0551348        |                                                                                    |                                                                                                                                                                                                              |                                                                                                       |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog</td>
<td>Service Catalog Plugin</td>
<td>Variables are not aligned on sc_req_item page if using variable set</td>
<td>Fields in variable set are not aligning with other variables on the sc_req_item page.</td>
<td>1. Open an instance with the Geneva release installed. &lt;br&gt;2. Navigate to Service Catalog › Catalog Definitions › Maintain Items. &lt;br&gt;3. Open the item Packing and Shipping. &lt;br&gt;4. In the Variable Sets tab or section, click New. &lt;br&gt;5. Fill in the following fields:  &lt;br&gt;• Name: Customer  &lt;br&gt;• Order: 100  &lt;br&gt;• Layout: 1 Column Wide &lt;br&gt;6. Click Submit. &lt;br&gt;7. In the Variables tab or section, click New. &lt;br&gt;8. In Type, select Single Line Text. &lt;br&gt;9. Click Submit. &lt;br&gt;10. On the Catalog Item record for Packing and Shipping, click Try It. &lt;br&gt;11. Fill in the mandatory fields. &lt;br&gt;12. Click Order Now. The variables are not aligned on the created sc_req_item.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Interface</td>
<td>TinyMCE HTML Field Editor</td>
<td>Geneva: TinyMCE image attachment option does not work on knowledge articles using IE11</td>
<td>It is not possible to add an image via attachment on a kb_knowledge record using TinyMCE.</td>
<td>1. Using IE11, navigate to a Knowledge article. &lt;br&gt;2. Click Add image. &lt;br&gt;3. Select Type: Attachment. &lt;br&gt;4. Upload an image. &lt;br&gt;5. Click OK. Nothing happens, console error is thrown.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Platform Security PRB631041 KB0552969 |                  | After cloning from an instance without MultiSSO to an instance with MultiSSO enabled, GlideRecord.addActiveQuery fails, preventing login access | A cloning issue affects instances where a source instance with MultiSSO disabled is cloned to a target instance with MultiSSO enabled. After the clone, the target instance experiences a NullPointerException that causes an outage. | 1. Activate MultiSSO on an instance that will be the target of a clone. The property glide.authenticate.multisso.enabled is set to true.  
2. Ensure that MultiSSO is not active on the source instance. The same MultiSSO property must be set to false, or, if you did not enable the MultiSSO plugin, the property does not exist in the Properties (sys_properties) table to begin with.  
3. Clone the source to the target.  
4. View the errors that occur in the system logs. For example:  

```java
ERROR ***
    java.lang.NullPointerException
    java.lang.NullPointerException
at com.glide.script.GlideRecord.addActiveQuery(GlideRecord.java:2233)
at com.glide.script.GlideRecord.addActiveQuery(GlideRecord.java:2176)
at com.glide.integration.sso.saml.SAMLAuthenticationUtil.getDefaultMigratedSSO(SAMLAuthenticationUtil.java:36)
at com.glide.ui.GlideServletUITransaction.useExternalAuth(GlideServletUITransaction.java:273)
at com.glide.ui.GlideServletUITransaction.getLoginAction(GlideServletUITransaction.java:323)
at com.glide.processors.Processor.runProcessor(Processor.java:393)
at com.glide.processors.Processor.processTransaction(Processor.java:192)
at com.glide.processors.ProcessorRegistry.process(ProcessorRegistry.java:146)
at com.glide.ui.GlideServletTransaction.process(GlideServletTransaction.java:36)
at com.glide.ui.GlideServlet$1.run(GlideServlet.java:414)
at java.util.concurrent.ThreadPoolExecutor.Worker.runTask(ThreadPoolExecutor.java:895)
at java.util.concurrent.ThreadPoolExecutor.Worker.run(ThreadPoolExecutor.java:918)
at java.lang.Thread.run(Thread.java:682)
``` |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog PRB654705 | Service Catalog Plugin | Alignment of Variable Question text/label moved to left of input box versus above the input box | The alignment of Variable Question text/label was moved to the left of the input box, as opposed to being above the input box. This makes multi-lined questions difficult to read. | The following steps use demo data.  
1. Open Service Catalog.  
2. Select Hardware.  
3. Select Sales Laptop.  
Note that the question Additional software requirements is to the left of the input box. In Fuji and previous versions, it is above the input box. |
| Service Catalog PRB655728 | Service Catalog Plugin | More information tag on Service Catalog Variables turns HTML into escaped text (expected behavior, although not in the past) | When attempting to use HTML in a help_text field on a service catalog variable, the content renders as escaped text. The HTML tags in variables ‘help text’ are only interpreted when the system property named glide.ui.escape_text is set to false. | 1. In the self-service portal, open the Something Broken record producer.  
2. Right-click the Open on behalf of this user field label and select Configure variable.  
3. Insert HTML into the Help text field (for example:  
   ```html
   <span style="color: red;">TEST</span>
   ```  
3).  
4. Go back to the Something Broken item in the self-service portal.  
5. Open the help text for the Open on behalf of this user field.  
Note that the content does not render as HTML. |

© 2019 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog PRB623458 KB0547362</td>
<td></td>
<td>HTML tags display in read-only multi-line text variable</td>
<td>HTML code is displayed in read-only, multi-line text variable.</td>
<td>1. Create a new Catalog Item or modify an existing one (for example, Apple iPad 3).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. In that item, create a new variable with the following parameters:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Name: test_text_variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Question: Test Text Variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Type: Multi Line Text</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Add admin as a write role. If the Write role field is not on the form, configure the form and add the field (Configure &gt; Form Layout).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Add a default value (with more than one line):</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• testing variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• new line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• another line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Click Try It to view the item in the Service Catalog.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Click Order Now.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7. In the Order Summary, click the Request Number (for example, REQ0010003) to view the request.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8. In the Requested Items related list, make a note of the RITM (for example, RITM0010003).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>9. Go into the RITM and make a note of the value of the Test Text Variable, such as:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• testing variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• new line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• another line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10. Impersonate the ITIL user and open the RITM (global text search should take you directly to the RITM).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>11. Make note of the value of the Test Text Variable, for example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• testing variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• &lt;br&gt;new line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• &lt;br&gt;another line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(Breaking up the br to see the tags here.)</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Catalog PRB660782 | | UI Policy does not work correctly (i.e. not making label and grouped variables visible when reverse is true) when label and checkboxes are all included in UI Policy | UI Policy does not work correctly (i.e. not making label and grouped variables visible when reverse is true) when label and checkboxes are all included in UI Policy. This occurred after an upgrade to Geneva Patch 3. | 1. Create a new Catalog Item.  
2. Create a Variable Set off that catalog item.  
3. Create a label and 3 check box variables underneath the label.  
4. Create another label under the 3 check boxes, and create 3 additional check box variables under the second label.  
5. Click Try It. Note that you see all labels and check boxes.  
6. Create a UI policy based on the choice you make for one of the first check boxes that hides the SECOND label and SECOND set of check boxes. Make sure Reverse is True.  
7. Click Try It. Notice the second group does not exist.  
8. Click the check box to show the second set and notice that nothing happens. |
| CMS PRB605118 KB0546515 | | iFrame does not resize correctly | When a portal page is rendered in an iFrame with the sizing option 'Expand to Fit content', the resize does not work. On a CMS page with catalog items, when clicking Preview to display additional information and then collapsing the information, the footer does not resize correctly. | 1. Open demo instance.  
2. Go to /ess/order_software.do.  
3. Click the Preview triangle choice list on a few different items.  
4. Collapse the information. Notice that the footer did not resize and there is extra white space. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) PRB641278 | TinyMCE HTML Field Editor | Table name and Table sys ID in sys_attachment are empty when attaching via TinyMCE editor | Table name and Table sys ID in sys_attachment are empty when attaching via TinyMCE editor, for example from task record email client. | 1. In the System Navigator, navigate to Knowledge > Create New.  
2. Populate any required fields:  
   - Knowledge base: Knowledge  
   - Short description: KB test attachment  
3. In the Text field, select the Insert/edit image button.  
4. Select Attachment for the Type in the Insert/Modify Image pop-up.  
5. Choose an image and click Attach. Then, click OK. The image is displayed in the TinyMCE editor and appears in the Manage Attachments section.  
6. Save changes to the kb_knowledge record. The attachment is no longer displayed in the Manage Attachments section.  
7. Retrieve the corresponding sys_attachment record. Note that the Table name and Table sys_id are not populated. |
| Forms PRB624424 KB0551086 | Hints (tooltip) for choice list values appear behind the values | The hints for choice list values appear behind the values themselves. This issue occurs on Firefox and Internet Explorer. Chrome does not display any tooltip or hint on choice list. | 1. Navigate to the Choice Lists module.  
2. Identify a choice list element, such as priority field on task table.  
3. Populate the Hint field with some values for all choice list values. Add a good amount of text so you get a good size for the tooltip.  
4. Navigate to any form that uses this choice list field, such as the priority field in change request.  
5. Click on the field to see the choice list values and point to each of them.  
Note that the tooltip is behind the choice list menu. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow PRB645417 KB0551503</td>
<td>Graphical Workflow Support</td>
<td>The glide.workflow.script.strict property may be set to true after an upgrade unless it was explicitly set by the customer</td>
<td>By default, the glide.workflow.script.strict property is set to false for upgraded instances so that an existing erroneous customer script continues to behave the same way it did before the upgrade. If the property is set to true, errors that were previously being ignored in customer workflows may cause the workflows to fail. This problem only occurs on the second upgrade. On the first upgrade to Fuji Patch 5 or higher, the property is set correctly.</td>
<td>ServiceNow engineers were able to reproduce this issue using the following steps: 1. Upgrade the instance to Fuji Patch 5. During the upgrade, the glide.workflow.script.strict property is created and set to false. 2. Upgrade the instance to Fuji Patch 6 or Fuji Patch 7. During the upgrade, the glide.workflow.script.strict property is changed to true.</td>
</tr>
<tr>
<td>Platform Performance PRB624995 KB0547566</td>
<td></td>
<td>Transaction cancellation fails intermittently on Oracle when the transaction is running a database query</td>
<td>Transaction cancellation fails intermittently on Oracle when the transaction is running a database query. This leads to stuck semaphores with the threads waiting on the database, but the database is not processing the query. Note that not every stuck semaphore is rooted in this problem, but this problem is one way that we arrive at stuck semaphores.</td>
<td>This issue is most likely to occur when reference auto-complete transactions get canceled by subsequent auto-complete transactions.</td>
</tr>
<tr>
<td>Forms PRB573028 KB0523218</td>
<td></td>
<td>Copy and paste from Word does not insert images into KB</td>
<td>When an image is copied and pasted into a KB article, the image will not appear. This issue also extends to any Record Producer with an HTML editor on it.</td>
<td>1. Launch any instance. 2. Navigate to Knowledge Base &gt; Edit. 3. Open an existing knowledge base article from the list. 4. Copy and paste the content from a Word document with images and text into the article Text field. The images do not display in the Text field.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| User Interface (UI) PRB654978 |                  | Activity Formatter lists Sent Email in wrong order and all emails are grouped in one entry | In the Activity formatter, Sent Emails all appear grouped together at the bottom of the Activity Formatter list instead of being listed in the correct chronological order. Even after multiple work notes, the activity formatter still places emails within a separate group in a random order with the rest of the history log entries. This issue has occurred on multiple tables after upgrading to Geneva.                                                                 | 1. On a table that includes notifications, configure the Activity Formatter to include Sent Emails.  
2. Generate emails/notifications.  
Note the locations in the Activity Formatter.                                                                                                                                                                                                                                                                                                                                                                      |
| Persistence PRB636463 |                  | When adding variables to a report, a Syntax Error or Access Rule Violation is detected by database | Users receive an error when adding variables to a report - Syntax Error or Access Rule Violation is detected by the database (not unique table/alias: ‘task0’).                                                                                                                                                                                                                                         | On an OOB instance:  
1. Log into an instance’s localhost (with “table per class” on task table setup).  
2. Create a report with the following:  
   a. Table: sc_req_item  
   b. Type: List  
   c. In ”Available” section: expand variables and select ‘Apple iPhone5’ and add all of its variables to ‘selected’ section  
3. Run the report.  
Note the following error: “Syntax Error or Access Rule Violation detected by database (Not unique table/alias: ‘task0’)”                                                                                                                                                                                                                                                                                                             |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog PRB664557 | Catalog UI policies not applying to variables in a RITM / Catalog Task variable editor when read-only (container.getAttribute is not a function) | Catalog UI Policies and Catalog Client Scripts that are set to ‘Applies on Requested Items’ or ‘Applies on Catalog Tasks’ can fail. This happens when a write-role has been specified on the variable and viewing the record while logged in as (impersonating) a user that fails on that role check. | 1. Navigate to Self-Service > Service Catalog or Service Catalog > Catalog > Hardware > Sales Laptop.  
2. Personalize the ‘Additional software requirements’ variable and give it a name (e.g. software_requirements). Update the ‘Write roles’ field and add ‘admin’.  
3. Create a Catalog UI policy and go back to the item.  
4. Right-click the header and select Personalize UI Policies.  
5. Create a policy such as:  
   • Short Description: hide software requirements  
   • On load: true  
   • Active: true  
   • Applies on a Catalog Item view: true  
   • Applies on Requested Items: true  
   • Applies on Catalog Tasks: true  
   • Actions:  
     • Name: software_requirements  
     • Read only: Leave alone  
     • Mandatory: Leave alone  
     • Visible: False  
6. Create a request for a Sales Laptop.  
7. Impersonate a non-admin user such as ITIL User.  
8. Go back to the item and make the request. View the request. If you are already impersonating the ITIL User, navigate to Service Catalog > Items.  
9. Open the item for the request.  

Note that the ‘Additional software requirements’ variable is visible, and the JavaScript console shows this error:

```javascript
js_includes_catalog.jsx:132 Uncaught TypeError: container.getAttribute is not a function
```
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) | PRB656315 KB0564214 | Column State in the table sys_user_has_role has two values for None | | 1. Navigate to sys_user_has_role.list.  
2. If the column State is not visible, personalize the list to have the State column.  
3. Double-click on any of the row and column’s State.  
Note that there are 2 None options in the dropdown. |
| UI Policy/Client Script | Data Lookup and Record Matching Support | Setter Field Definitions show empty choice list for 'Source table' field and 'Matcher table' field | Setter Field Definitions show an empty list of source/matcher tables, so one cannot be selected. The dependent fields below fail to pick up the tables list:  
• (dl_definition_rel_set). (matcher_table_field)  
• (dl_definition_rel_set). (source_table_field) | 1. Navigate to System Policy > Data Lookup Definitions.  
2. Drill down to base system Assignment Lookup.  
3. Scroll down to Setter Field Definitions.  
4. Drill down to Assignment Group.  
Observe the empty choice lists for Source table field and Matcher table field. Configuring the dictionary for these fields and changing the choice list specification from None to Dropdown or Suggestion shows the assigned table name, but still fails to populate the choice list. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Platform Performance PRB651349 KB0552197 |                  | Product help does not render successfully for non-CSH links in UI 15/16 | When accessing the ‘Search Product Documentation’ option from the Help button in UI 15/16, help links that do not have a context-sensitive target defined, result in a PHP search that returns unusable content. The search string that is created appears as a URL, like the following example: http://geneva-docs.servicenow.com/search-results.php?cx=005409823165138974380%3Abltnnmgfoek&cof=FORID%3A10&ie=UTF-8&ss=434j83818j4&q=Incident | 1. Log into a Geneva instance.  
2. Verify that the default properties are set for the help. These properties are defined as:  
   - glide.help.default.page: http://geneva-docs.servicenow.com/  
   - help.base.default: http://geneva-docs.servicenow.com/?context=  
   - help.base.servicenow: http://geneva-docs.servicenow.com/?context=  
3. Test the following CSH links. These should work successfully, rendering on geneva-docs.servicenow.com:  
   - Assessments > Assessable Records  
   - Assessments > Metric Definition > Types  
   - Assessments > Metric Definition > Categories  
4. Test the following non-CSH links. These result in the search query being performed and rendering garbage code:
   - Incident > All  
   - Collaborate > Feed Administration > Messages  
   - Asset > Portfolios > All Assets |
<p>| Text Search PRB586510 |                  | Text index events process job found Queued or Running, but it is not actually running in any node |                                                                                                                                                                                                          |                                                                                                      |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Persistence PRB660232 | | Report on variables (of type Reference) on sc_req_item results in 'Syntax Error or Access Rule Violation detected by database (Not unique table/alias: 'sc_item_option2')' | When defining a bar chart report on the sc_req_item table, grouped by Variables, and with a combination of 'Select Item' and 'Select Variable' (variables of type Reference), running the report results in the error 'Syntax Error or Access Rule Violation detected by database (Not unique table/alias: 'sc_item_option2')'. | This issue is reproducible in Fuji Patch 11 and Geneva.  
1. Log into a Geneva Patch 1 OOB instance.  
2. Create a new report.  
   • Table: sc_req_item (Requested Items)  
   • Type: Bar  
   • Group by: Variables  
   • Select Item: “Password Reset”  
   • Select Variable: “Whose password needs to be reset?”  
   • Aggregation: Count  
   • Number of Groups: System Default (12)  
   • Show other: Checked  
3. Click Run.  
4. Observe the error message.  

This issue is also reproducible in List Reports.  
1. Log into a Geneva Patch 1 OOB instance.  
2. Create a new report.  
   • Table: sc_req_item (Requested Items)  
   • Type: List  
   • Group by: None  
   • Select Variable:  
     • From the Available column, select Variables > Password Reset > Whose password needs to be reset?  
     • Add this variable to the Selected column.  
3. Click Run.  
4. Observe the error message. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Platform Miscellaneous PRBS94769 | | Field Label incorrectly pointing to a field label of the same element but different table | The Field Label of a field on a table extended from the task table is incorrectly pointing to a field label of the same element but different table also extended from task. See Steps to Reproduce for an example using the state element on problem_task and change_request. | 1. Go to an out-of-box instance.  
2. Navigate to sys_documentation > New.  
3. Create the following record:   
   - Table: change_request  
   - Label: State  
   - Plural: States  
   - Element: state  
   - Language: en  
   - Help:  
     - Hint: State of Change Lifecycle  
     - URL: http://google.com  
     - URL target:  
4. Create another sys_documentation record:   
   - Table: problem_task  
   - Label: State  
   - Plural: States  
   - Element: state  
   - Language: en  
   - Help: This is a problem task label  
   - Hint:  
   - URL:  
   - URL target:  
5. Go to change_request.form. Note that the tooltip showing the Hint for state, and the link is working properly.  
6. Go to problem_task, create a new record, and look at the form. The state field displays the Hint message and link of the field label that you created for change_request.  
7. Try creating a new field label for problem_task where the Hint and URL is blank. The change_request hint and link still displays for problem_task.state  
8. Delete the label that you created in Step 3. Note that the label is still there for change_request.state and problem_task.state |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog PRB648805</td>
<td>Activity formatter</td>
<td>Missing recipients from inbound emails in activity formatter</td>
<td>In Geneva and later releases, some recipients for an incoming email do not appear in the activity formatter.</td>
<td>1. Send an email to a Geneva instance that has an inbound action that will create an incident record. The email should include an extra recipient in the “to:” field besides the instance email address and one or more in the “cc:” field. 2. Once the email has been processed by an inbound action, check the record that it created and look for the received email in the activity formatter. Expected behavior: The email that is rendered in the activity formatter should display all of the recipients that are actually on inbound email. Actual behavior: The “From:” and “To:” addresses are both displaying the from address.</td>
</tr>
<tr>
<td>Service Catalog PRB665295 KB0565456</td>
<td>Service Catalog Plugin</td>
<td>In Geneva and Fuji, multi-line text field and UI macro variables no longer expand the width of both columns</td>
<td>A design change in Fuji and Geneva prevents Multi Line Text text field variables from expanding the width of the form. This change from the behavior in Eureka (see screenshots) can cause issues for customers who created their variable layouts expecting the old design.</td>
<td>1. Navigate to Service Catalog › Maintain Items. 2. Select the desired catalog item. 3. In the Variables related list, click New. 4. Add a container and in the Type Specifications tab, specify a Layout of 2 Columns Wide, alternating sides. 5. Add two variables of any type to the container. 6. Add a Multi Line Text variable as the third item in the container. 7. Click Submit. When you access the item, note that the text box is only 50% wide. The same problem occurs with the Macro and Macro with Label variables.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| User Interface (UI) PRB660641 | Activity formatter | LDAP imports and User Criteria enabled makes secondary nodes unusable | If User Criteria is enabled on instances with a very large number of users, this will make the secondary nodes unusable if there are very large imports on the user table (such as daily LDAP imports). | On an instance with a very large sys_user and domains:  
1. Enable User Criteria.  
2. Run an LDAP import, or update all users. This will create a huge amount of sys_cache_flush data for criteria_cache and user_criteria_cache.  
When this is picked up by the secondary nodes, they will become unavailable and eventually run out of memory. |
| UI Policy/Client Script PRB584334 KB0523069 | Data Lookup and Record Matching Support | Two data lookup definitions on the same source will not work | When you create two data lookup definitions and tables with the same source, the lookup will work for only one of the definitions but not for both. | Refer to the listed Known Error KB article for details. |
| System Applications PRB657662 | | Unable to download updates when sys_remote_app has a record with an undefined sys_id | When the scheduled updater runs for app-client, the response may sometimes be an error message. The message can result in the sys_remote_app table getting an entry with all fields set to ‘undefined’, which can prevent future updates from downloading until this record is removed. | 1. Run the ‘Check Scoped App Updates’ scheduled job when the store is very busy.  
2. If the sys_remote_app table ends up with a record with a lot of ‘undefined’ fields, try to load the $myapps_mgmt page.  
Notice that it never loads your applications. |
| Service Catalog PRB645433 KB0562882 | | When Compact View is enabled, it pushes the text down in single-line text fields within the Service Catalog | When Compact View is enabled, text is pushed down for single-line text fields in the Service Catalog. | 1. Using Internet Explorer, open an instance.  
2. Click the settings gear wheel and toggle the compact mode switch.  
3. Navigate to Service Catalog.  
4. Select any item that has a variable of type Single Line Text or Reference.  
5. Type some text in the input field.  
Note that the text is cut in half and the lower portion of letters like g and y is not visible. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Platform Security | Knowledge Management V3 | OOB read ACL is failing while on kb_feedback and dot-walking to kb_knowledge fields | The mandatory enforcement for the Additional Comment and Work Notes (journal input) fields is not enforced if the field content is cleared. After the form is saved, the value ‘undefined’ is shown in the Activity formatter. | 1. Go to a Fuji instance where the Knowledge Base is still v2.  
2. Go to kb_knowledge and navigate to an article in the Knowledge KB.  
3. View the article and submit a comment.  
4. Impersonate a user with the Knowledge role (e.g. Charlie Whitherspoon).  
5. Go to kb_feedback.  
Note that the Short Description (along with any field dot-walked through the article (kb_knowledge)) will fail read access. |

| Workflow | Slow memory leak due to KillSwitch() observer objects being created but not destroyed | App nodes experience gradual performance degradation, which may manifest as frequent symptomatic incidents such as 'Scheduler Workers Overloaded' and/or 'Mean Semaphores Exhausted' during periods of high user or job/worker activity. Application node resource profile exhibits a gradual increase in memory usage, without a corresponding increase in the number of transactions and sessions (load) over this time period. There is also a gradual increase (minimum of 100) of KillSwitch() observer objects within app node JVM memory. | On a Fuji instance (preferably with no other workflows running on the system):  
1. Create a new workflow on Global.  
2. Delete the transition between Start and End. Ignore the warning about the invalid workflow.  
3. Publish the workflow.  
4. Start the workflow.  
5. Go to the context record and click the Cancel button. The cancel will fail because the invalid workflow causes a NullPointerException. Repeat this several times.  
6. Search in the context log for "killSwitch" count.  
Note that the number of observers increases every time you try to cancel. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface (UI)</td>
<td>NG shared components</td>
<td>Mandatory comment/work notes fields not enforced if content deleted</td>
<td>The mandatory enforcement for the Additional Comment and Work Notes (journal input) fields is not enforced if the field content is cleared. After the form is saved, the value ‘undefined’ is shown in the Activity formatter.</td>
<td>1. Request a Sales Laptop from the Service Catalog.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Navigate to Requested Items list view via Service Catalog &gt; Open Records &gt; Items.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Find Sales Laptop requested item from step 1 and hover over first stage icon. This should read ‘Waiting for Approval by Approver’s Name’.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Approve requested item by impersonating approver or when logged in as sys admin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Return to list of Requested Items.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Find Sales Laptop requested item from Step 1 and hover over the stages icon. It now reads ‘Waiting for Approval’.</td>
</tr>
<tr>
<td>Workflow</td>
<td>PRB635427</td>
<td>Approver’s name is not displayed when hovering over stage icons after first approval</td>
<td>In the Requested Items list view, the approver’s name is not being displayed when hovering over stage icons after initial approval. The tooltip should read: ‘Waiting for Approval by Approver’s Name’. This works only on the first stage. Once approval is obtained on this stage, approver’s name no longer appears for subsequent approval stages.</td>
<td></td>
</tr>
<tr>
<td>Service Catalog</td>
<td>PRB655476</td>
<td>Labels above sets of checkbox variables are no longer automatically hidden when the checkboxes are all hidden</td>
<td>Labels above groups of checkbox variables are no longer automatically hidden when the checkboxes are all hidden. There is a clever feature in catalog items to automatically group sets of checkbox variables that appear after a label when rendered in the catalog or variable editor on forms. In Fuji, if all checkboxes in one of these groups are hidden by UI Policies, the label is also hidden automatically. In Geneva, the label remains on screen.</td>
<td>1. Create a Catalog Item that has these variables:</td>
</tr>
<tr>
<td></td>
<td>KB0563834</td>
<td></td>
<td></td>
<td>- Order 10: a Label variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Order 20: a CheckBox variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Order 30: a CheckBox variable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2. Create a Catalog UI Policy to set the two checkbox variables as visible=false.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3. Try the catalog item.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The Label variable is still shown, but it should be hidden.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Service Catalog PRB646241 | | Amazon: Even though Amazon resource catalog has VM approved, Cloud User does not see any items in cloud resource catalog in Amazon VM | 1. Enable Amazon and run Discovery.  
2. Create an catalog item for ec2 VM.  
3. Go to Cloud Resource Catalog > Amazon Virtual Machines to order the VM.  
Note that nothing shows up in the resource catalog. | |
| User Interface (UI) PRB636708 KB0551664 | | Reference popup does not always have the ‘X’ icon to close the window | 1. In the affected instance, hover mouse over a reference icon until popup window appears.  
2. Hold shift and move the mouse icon to keep the popup window open.  
Occasionally, you will see that the popup window does not have the ‘X’ in the upper right corner to close the window. | |
| Text Search Attachments PRB648973 | Text Index | Task collection record has unaudited change that turns off text indexing | The task collection dictionary record changes the text index record from true to false in an un-audited update. | 1. Go to the sys_dictionary record for task collection.  
2. Make sure Text index is checked, and take note of the Updated date/time.  
3. Create a new table named ‘child_task’ that extends Task  
4. Go to the sys_dictionary record for child_task collection.  
5. Observe that the Text index checkbox is unchecked.  
6. Add any attribute to the record such as ‘fakeAttribute=true’.  
7. Go to the sys_dictionary record for task collection.  
Observe that the Text index checkbox is now unchecked, and the Update date/time has not changed. All tables in the Task hierarchy will now have their Text index checkbox unchecked. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Reporting PRB655647 | | In Fuji, creating a report with a special character such as an apostrophe shows unescaped characters on report list | Creating a report with a special character such as an apostrophe in Fuji shows unescaped characters on report list. Reports then show incorrect characters in their titles. | 1. Go to Reports > Create new.  
2. Create a report with a title that contains an apostrophe, such as “Amy’s report.”  
3. Save.  
4. Go to View/run reports.  
Note that the title’s apostrophe is replaced by the unescaped characters. |
| Project Management PRB650703 | | Forms making calls to the GlideScheduleWithCache object experience latency loading the forms and charts | For the application separator module, new copies are created for different modules without any manual action. From the global domain, the user has more than one for an application menu. | |
| Mobile PRB648559 | | Navigation menu in the Mobile UI displays side-by-side with main content in iOS 9 | On iPhones using iOS 9, pressing the # icon to open the nav menu will open the nav pane side by side with the main content, causing the UI to be displayed oddly. | 1. Upgrade an iPhone to iOS 9.0.1.  
2. Open an instance using the iPhone.  
3. Tap the # icon to open the nav menu.  
The nav menu and main content will appear side by side, which reduces the size of both elements dramatically. This happens instead of the main content moving offscreen to the right when the nav menu appears. |
| CMDB PRB657305 KB0563994 | Configuration Management (CMDB) | ‘CI Relations’ related items header is missing in cmdb_ci_win_server form when ‘Tabbed forms’ is ON | When the ‘CI Relations’ field is added to the Configuration > Servers > Windows server form layout inside a tab (there should be multiple tabs present with other data), its header display depends on the state of ‘Tabbed forms’. If the ‘Tabbed forms’ state is ON, then the Related items header disappears. If the ‘Tabbed forms’ state is OFF, the Related items header appears. | 1. Navigate to Configuration > Servers > Windows and open a server.  
2. From the form layout, make sure you have ‘CI Relations’ in one of the sections.  
3. Make sure you have many tabs on this form.  
4. Make sure you see the ‘Related items’ header and related data.  
5. Make ‘Tabbed forms’ (found in the wheel/gear settings) is ON/OFF.  
Note that the Related items header is now in tandem with the ‘Tabbed forms’ state. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) | | List Collector does not display properly on catalog items | The list collector is misaligned on sc_cat_item. | 1. Go to Catalog > Office > Paper and Supplies.  
2. Right-click the header > Add variable.  
3. Create a list collector.  
4. Open the (sc_cat_item) table, locate your item with the list collector. Click Try It.  
5. Right-click the banner on the catalog item > select Configure Catalog Client Script.  
6. Create an onload client script, making the list collector read-only. For example:  
   
   ```javascript
   function onLoad() {
     //Type appropriate comment here, and begin script below
     g_form.setReadonly('variables.<yourVariable>,true);
   }
   ```  
7. Open the catalog item. Notice that the list collector displays incorrectly. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Knowledge Management | Knowledge Management V3 | Knowledge is inaccessible during Daylight Savings Time change periods | Users are unable to access knowledge articles either from knowledge search or from kb_home.do page from approximately 19:00 - 20:15 PDT. All other applications are accessible. | 1. Install Fuji or Geneva with the date/time set to 03/08/2015 19:40:00 PDT.  
2. Navigate to Knowledge Homepage. Note that everything works and there are no issues.  
3. In another tab, go to /kb_home.do. Note the following issues:  
   • No items are available under category  
   • Clicking each base still results in no items available  
4. Search in the kb_home.do page. Note that this works.  
5. Set the server time to 03/08/2015 20:40:00 PDT.  
6. Restart the instance.  
7. Repeat Steps 2-4.  
Note that all steps work with no issues. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) PRB632268 | PRB632268, KB0563950 | Show Related (ref_contributions) icon image in custom UI Macro is not rendered in Fuji | Show Related (ref_contributions) icon image in custom UI Macro is not rendered in Fuji. Switching between UI15 and back to UI11 shows the icon image difference. | 1. Create a custom UI Macro. For example, make a copy of the Show Related Incidents macro and name it User Show Computers.  
2. Modify the g:reference_contribution statement to:  
   `<g:reference_decoration  
   id="${jvar_n}"  
   field="${ref}"  
   onclick="showRelatedList('${ref}');"  
   title="${gs.getMessage('Show related computers')}"  
   image="images/icons/laptop.gif" / >`  
3. Update the ref_contributions for the incident.caller_id field and add the UI Macro:  
   `ref_contributions=<existing contributions>user_show_computers`  
4. Switch between UI11 and UI15 to compare. Note that the icon is not shown correctly in UI15. |
| System Applications PRB649148 | PRB649148, KB0562561 | Wrong error message on app-author when version is not updated while publishing an app | When the version is not updated while publishing an app, the wrong error message appears on app-author: ‘<app name> could not be uploaded due to the following error: User name or password invalid’ | 1. Create an app with a table. The version is auto assigned to ‘1.0’.  
2. Publish the app to the store.  
3. Make some changes to the app by adding a new table.  
4. Now try publishing the app again.  
   Note that the publish fails. The user sees an error message, which says invalid username or password. Instead, the user should see an error message which indicates that the Version number needs to be updated before publish. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Project Management   | Project Management | Project lag time is inaccurate if a project with tasks and relations is imported from Microsoft Project 2013 | If a project created in Microsoft Project 2013 with multiple tasks and relationships is imported into the Project Management application, an incorrect lag value may be inserted. | 1. Activate Project Management v3.  
2. Import a project with relationships created in Microsoft Project 2013 format. A lag of 95+ days is added to the relationships. This added lag extends the start dates of the tasks. |
|                      | PRB635702 KB0551944 | lightweight_glide_list macro is not working, watch_list variable from Create New incident record producer is not transferring to the incident record in Geneva |                                                                                                                                                                                                          |                                                                                                                                                                |
| Service Catalog      |                  | lightweight_glide_list macro is not working, watch_list variable from Create New incident record producer is not transferring to the incident record in Geneva | 1. Log into a Geneva instance.  
2. Open the OOB ‘Create an Incident’ record producer.  
3. Add a variable watch list (watch_list) macro with label type. Choose macro_watch_list for the type specification. Set the order to 200.  
4. Try the item.  
5. Select Abel Tuter and system administrator for the watch_list variable.  
6. Submit.  
7. Notice that the incident’s watch list is not updated.  
8. Repeat these steps in a Fuji instance and note that the incident’s watch_list is populated. |                                                                                                                                                                |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog PRB650795 KB0565514 | Service Catalog Plugin | When an out of box Service Catalog item (sc_cat_item) or category (sc_category) form is updated, the updates are not visible on other app nodes without performing a cache flush | When users update an out of box Service Catalog item (sc_cat_item) or category (sc_category) form, the updates are visible only on the application node where the user is logged in. They are not visible on other app nodes until the cache is flushed. | 1. Navigate to System Properties > Service Catalog and check Use "User Criteria" to define access to catalog items and categories, then click Save.  
2. Navigate to Service Catalog > Catalog Definition > User Criteria and click New to create a new record.  
   • Name: Only for ACME company  
   • Company: ACME in North America  
   • Click Submit.  
3. Navigate to Service Catalog > Catalog Definitions > Maintain items and select a Service Catalog item, for example, Apple iPhone 5.  
4. Under Available for, click Edit, select the criteria Only for ACME company that you created, and click Save.  
5. Impersonate a user who does not work for ACME in North America.  
6. Try to order the Service Catalog item.  
   On the application node where the company was removed, the item will not appear but it will still be visible on other nodes.                                                                                                                                 |
| Reporting PRB644326 | | Line reports show incorrect results when compared to List report | The same report with same filters shows different results. | 1. Create a report on the incident table.  
   • Type: line  
   • Group by: assigned to  
   • Trend by: closed by day  
   Instead of seeing all the users with closed incidents, you will see X users (lines) on the graph where x is the number of values on the x axis. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Mobile PRB650631 |                  | Reference field shows preview (ng_view) of the wrong record | When pressing the ‘>’ on a reference field to see a preview of the record, the preview of a wrong record appears. The issue was reproduced using several different reference fields in the platform, including the Approval for field on the sysapproval_approver form. | 1. Log into the Mobile UI.  
2. Navigate to the incident list and choose a random incident with a value in the Caller field.  
3. Observe the user in the Caller field.  
4. Click on the arrow on the right hand side of the Caller field.  
Note that a preview of a different user is visible. |
| Discovery PRB644436 | Configuration Management (CMDB) | Issues with discovering IBM Storage Volume Controller | Discover a IBM Storage Volume Controller.                                                                                                                                                                      |                                                                                                                                                                                                                       |
| Service Catalog PRB664348 |                  | Variables, type UI Macro render labels | In Geneva UI macro, variables are rendering labels.                                                                                                                                                           | 1. Create a UI macro and put some text in it.  
2. Go to the Office Desktop catalog item.  
3. Add a new variable:  
   - Type: UI Macro  
   - Macro: <macro you just created>  
   - Add short description and name  
4. Render the catalog item.  
Notice that you now see the Short Description rendered on the UI Macro.                                                                                                                                                   |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Web Services PRB649421 | REST API Provider KB0563346 | REST API Explorer does not always fully load | In the REST API Explorer, users cannot view the path parameter form fields or query parameter fields. This occurs inconsistently in Windows on various versions of Chrome, Internet Explorer, and Firefox. | 1. Install LastPass extension and sign in.  
2. Open the REST API Explorer.  
3. Verify Table API is selected. Note that there is no ability to select the table as the path parameters section is blank or missing. Additionally, no query parameters are listed. |
| User Interface (UI) PRB593474 | | Creating a bookmark from a module results in an absolute link, which breaks if the instance is cloned | If a UI11 bookmark is created from a module, its URL will be absolute. This breaks the bookmark when the instance is cloned because the user will have to be logged in to the old instance. | 1. Log into any instance earlier than Fuji Patch 10.  
2. Switch to UI11.  
3. Click Self-Service > Incidents to load the list.  
4. Drag the Self-Service > Incidents module to the UI11 bookmarks bar.  
5. Give the bookmark a name.  
6. Drag the filter link to the bookmark bar, and assign a unique name.  
7. Navigate to sys_ui_bookmark. Note the bookmark created via module is absolute. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Service Catalog PRB645993 KB0552819 | Help Tag on Service Catalog Variables turns symbols into escaped text | The Help Tag on Service Catalog variables does not honor basic HTML tags. It turns symbols into escaped text and also shows blacklisted tags and attributes. | 1. Log into Fuji Patch 7 or Fuji Patch 7 HF3.  
2. Verify glide.ui.escape_text = true.  
3. Go to Service Catalog > Catalog Definitions > Maintain Item > Password Reset.  
4. Add new variable:  
   • Type: Yes / No  
   • Question: This is a test  
   • Name: atest  
   • Show Help: true  
   • Help Tag: This is a single quote '  
   • Help Text: Test this too & ' "  
5. Click Save.  
6. Click Try It.  
7. Click on the variable.  
Note that the Help Tag does not show the quote, but it does show escaped text. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Reporting PRB652692 | Reporting on SC variables does not allow inclusion of variables in a variable set | Fuji introduced the ability to select Service Catalog variables to be columns on a list report or group by / stack by fields on a chart report for Requested Items (sc_req_item) (as an example). Consideration was not made, however, for the inclusion of variables that are contained within a variable set. | Set up item  
On an OOB instance with demo data:  
1. Navigate to Service Catalog > Catalog Definitions > Maintain Items.  
2. Open a record to target sc_req_item (e.g. Office Desktop).  
3. Under the Variable Sets related list, click Edit.  
4. Move common_comments over to the right, and Save.  
5. Note that there is one regular variable for the item: ‘Special software requirements’.  
Create a request (and requested item)  
1. Navigate to Self-Service > Service Catalog.  
2. Click into the Hardware category > select Office Desktop.  
3. Enter text into both input boxes.  
4. Click Order Now.  
5. Note that clicking into the create Request and the related Requested Item record also create both variables: ‘Special software requirements’ and also ‘Notes/Comments’, the variable contained within common_comments.  
Build a report  
1. Navigate to Reports > View / Run > Create a report.  
2. Select the Table as Requested Item (sc_req_item).  
3. In the built-in Available / Selected columns slashbucket, scroll down to the bottom of Available.  
4. Click once on the Variables (+) option, to highlight it.  
5. Click the (+) button that appears between the buckets.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting</td>
<td>PRB585117 KB0564332</td>
<td>HTML fields in a form are incorrectly rendered when exporting to PDF.</td>
<td>HTML that is contained within a form will not render when exporting the form in PDF.</td>
<td>Export a form that contains a HTML field. Note that instead of getting readable text without formatting and no HTML tags visible, text appears containing raw HTML.</td>
</tr>
</tbody>
</table>
| Discovery        | PRB641771        | If SNMP Discovery of an IP Switch happens to not pick up certain OID’s during a large scan, it can cause an IP Router record to get created instead and thus potential duplicates would be created | This issue was investigated in PRB586364. However, the solution that was made for this (having an additional Identifier that tries to find a matching record of a different class) does not always work, especially if we are missing the necessary Serial Number OID’s to match the existing record. | 1. Run a Discovery on an IP Switch server.  
2. Based on results from SNMP - Classify, we should see proper OID results for ‘dot1dBaseNumPorts’. This will help us to classify it as a Switch.  
3. Run a Large Discovery against multiple SNMP devices. You may even need to run some simultaneously to get the MID server and ECC queue to fill up with probes to process.  
On occasion, for this Switch, we are not getting the ‘dot1dBaseNumPorts’ OID. This prevents users from properly classifying this as a Switch, and eventually falling back to classifying it as a Router. |
| Visual Task Boards | PRB654094 | (Visual Task Boards) Script Include VTBGetBoardsByUser does not appear to be working as expected | When a user clicks a record in the list view and chooses the ‘Add to Visual Task Board’ UI action, the user is shown a popup of task boards. This list is filtered in part by the VTBGetBoardsByUser script include. This should return the boards that the user is an owner or member of, but it only returns the boards the user owns. | 1. Create a pair of vtb_board records - one where Beth Anglin is the owner, and another where Beth is a member.  
2. Impersonate Beth Anglin.  
4. Note that Beth can see and make changes to both of these boards.  
5. Open an incident list.  
6. Right-click an incident and select the Add to Visual Task Board UI action.  
In the pop-up list, note that the only the board owned by Beth is displayed. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory: Heap Space</td>
<td>RoleLists</td>
<td>Memory consumption is excessive</td>
<td>M2M list of RoleLists: Instead of reproducing role lists on a per user basis when presumably there is a lot of repetition from user to user, it would be helpful to store a reference to a role list.</td>
<td>1. Create a Project with associated tasks in Fuji (e.g. FP3HF1), and then upgrade to Geneva (e.g. GP0HF1).</td>
</tr>
<tr>
<td>Portfolio Management</td>
<td>Project</td>
<td>Percent Complete is not updated after when Project Task Percent Complete is changed after upgrade to Geneva because updates were not all applied</td>
<td>After upgrading from Fuji Patch 3 Hot Fix 1 to Geneva Patch 0 Hot Fix 1, updates to Project Tasks no longer update Percent Complete on the Parent Project. The sys_upgrade_history_log shows that there are two updates to sys_script_ac1a86557f0000014b9410b344d51224, and the updates are not the same. One appears to be the new code and the other appears to be the old code. The order that these are applied appears to be random. If the new code is applied last, then the bug does not appear, otherwise the bug appears.</td>
<td>1. Create a Project with associated tasks in Fuji (e.g. FP3HF1), and then upgrade to Geneva (e.g. GP0HF1). 2. Update the child’s percent complete. Notice that the project’s percent complete is not updated.</td>
</tr>
<tr>
<td>Surveys</td>
<td>Assessment</td>
<td>Updates are not captured in update sets</td>
<td>Tables related to assessments are not update_synched even though all similar platform tables are update_synched.</td>
<td>1. Create a new update set and mark it as your current set. 2. Update any assessments tables or forms. Notice that no updates are captured within the update set.</td>
</tr>
<tr>
<td>Service Catalog</td>
<td>Catalog Item</td>
<td>In a variable on a catalog item, the Help tag does not translate quotations and other special characters correctly</td>
<td>In a catalog item, if you add a variable and edit the Help tag, quotes are translated to the equivalent hex code.</td>
<td>1. Open a catalog item. 2. Add a variable that includes Show help. 3. Click on Show Help. 4. In the Help tag, type in a phrase that has quotes. (For example, This is an “example.”) 5. Submit the variable. 6. On the catalog item, click Try it.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------</td>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Persistence   | PRB646685 KB0551418 | Table Cleaner job runs longer than expected and runs periodically for some tables | The Table Cleaner job might periodically run much longer than its normal duration. Performance degradation across an instance might occur due to DB connections running for excessive amounts of time. To see slow DB connections, access the System Diagnostics homepage. There is a gauge on that page that shows your current active Database operations. Error messages may include:  
  • SYSTEM Pool: glide: Database connection obtained on retry 15  
  • WARNING ***  
  • WARNING ***  
  GlideServlet:Waited on HTTP Session synch for: 6202ms |                                                                                                                                               |
<p>| Discovery     | PRB665679         | vCenter sensor processing takes several hours for large vCenters | vCenter sensor processing can take several hours for extremely large vCenters, and the probe payload can be 25+ MB. Performance needs to be improved and the payload size reduced. | Discover a vCenter with 500 ESX servers, 5000 VMs, 3000 FC ports and 8000 FC disks. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Encryption PRB656283</td>
<td></td>
<td>Encrypted attachments do not download properly</td>
<td>In a Geneva instance:</td>
<td>1. Go to System Definition › Plugins.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4. Give it any Name and click Submit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5. Go to User Administration › Roles. Select admin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6. Right-click the form header. Choose Configure › Form Layout. Make sure Encryption Context is added to the form. Save.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7. In the Encryption Context field, choose your newly created Encryption Context. Click Update.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8. Go to User Administration › Users and select David Loo.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>9. Input any password into the Password field. Click Update.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10. Log off and log back in as david.loo with the password you set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>11. Go to the incident table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>12. Open an existing incident NOT in a closed state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>13. Click the Attachment icon and check the Encrypt box.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>14. Choose any file and click Attach.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>15. Download the file you just attached and try to open it.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| User Interface (UI) PRB653119 | Magellan Navigator | When using the navigator with Chrome on the Geneva release, there is a memory leak  | When using the navigator with Chrome on the Geneva release, there is a memory leak. The browser memory (Chrome) consumption increases until the end user experience is degraded, requiring a browser restart. | 1. Open Chrome.  
2. Navigate to the Chrome task manager > More tools > Task manager.  
3. Click various modules and wait for the page to load.  
4. Repeat steps 2 and 3 while monitoring.  
Note that the memory usage climbs. |
| Service Portal PRB636318 | Content Management | Adding gauge or report to a CMS page results in ‘You are not authorized to view this page’ | If a user adds a report to the a CMS page, once you load the page, the error message ‘You are not authorized to view this page’ appears. After a refresh, the message goes away. | 1. Navigate to Content Management > Sites.  
2. Select a Site (e.g. Employee Self-Service).  
3. On the ‘Pages’ related list, click New to create a new content page.  
4. Populate the Name of the new page (i.e. test_page) and save the record.  
5. Scroll down to Related Links and select Edit Page.  
6. Click the Add content link in the upper left and select any gauge (e.g. Gauges > Incident > All incidents By State).  
7. Test the new page by launching this URL: https://<instance>.service-now.com/ess/test_page.do.  
8. At the bottom of the page with the correctly rendered gauge, the message “You are not authorized to view this page” will appear. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Discovery       | PRB649556        | TransactionCancelledExceptions on ‘ASYNC: Discovery - Sensors’ jobs cause a TransactionCancelledLoopException. | 'ASYNC: Discovery - Sensors' jobs are not releasing semaphores upon completion, and exhausting worker threads are causing instance performance issues. Note that the transaction is killed; however, the semaphore is never released and the worker thread disappears. These build up over time and cause instance degradations. | 1. Create a transaction quota matching “ASYNC: Discovery - Sensors”.  
2. Set it to time out after a short period of time.  
3. Add some large payload ECC Queue event to the ECC Queue to trigger the above business rule.  
4. Look for the worker thread in stats.do and threads.do.  
5. SNAC Alerts might be received - glide.quota.manager WARNING Transaction: Cancelling transaction ASYNC: Discovery - Sensors - system (maximum execution time exceeded) : Thread glide.scheduler.worker.4 |
<p>| Data Certification | PRB645482       | Strict comparison used in the business rule in the plugin causes unexpected behavior in task records. | The strict comparison in the Certification Task Values business role within com.snc.certification_v2 has caused issues of task records not closing or behaving as expected.                                                                                                                                                                                                                     |                                                                                                                                                                                                                                         |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| User Interface (UI) PRB650422   | NG shared        | Work notes bar    | When the setting ‘Compacts the user interface’ is turned on in UI16 (from under the gear icon - General settings), the yellow stripe/bar appears slightly to the right and comes to the foreground, covering the text typed/being typed under the work notes section. This behavior is noticed in all forms (INT/CHG/PRB/ Tasks) When working in ‘compact interface’, the left bar highlighting color for a new comment or work note goes over the text being typed. | 1. Log into a Geneva instance.  
2. Navigate to Incident.  
3. Open an active incident form.  
4. Switch on the ‘Compacts the user interface’ setting from the upper-right-hand settings gearwheel.  
5. Input text as work notes.  
Observe that the text is overlapped by the yellow/highlight color bar. |
|                                 | components       | (yellow strip)    | is not aligned correctly on activity stream with compact mode, causing the comment / work note highlight color to overlap with input text                                                                                                                                |                                                                                                                                                                                                                 |
| User Interface (UI) PRB640467   |                  | Click to print    | The click to print button does not show images and the resulting printed document (paper or PDF) does not have images when the following is true: - The record contains images within HTML fields - You are using the printer-friendly version.                                        | 1. Upload an image to the database via System UI > Images.  
2. From the confirmation message, make a note of the image name.  
3. Create a knowledge base article.  
4. Add the image to the text field.  
5. Click Save.  
6. Navigate to kb_knowledge.list.  
7. Filter the list for the newly created knowledge base article.  
8. In the gear wheel in the top right, choose Printer friendly version.  
9. In the resulting page, click the Click to Print button in the top right.  
Note that the preview and the printed version do not show the image. |
|                                 |                  | function in       |                                                                                                                                                                                                                                                                  |                                                                                                                                                                                                                 |
|                                 |                  | printer-friendly  |                                                                                                                                                                                                                                                                  |                                                                                                                                                                                                                 |
|                                 |                  | version page      | does not print images                                                                                                                                                                                                                                          |                                                                                                                                                                                                                 |
|                                 |                  |                   |                                                                                                                                                                                                                                                                  |                                                                                                                                                                                                                 |
| Upgrade Engine Issues PRB650929 |                  | Upgrade History   | Upgrade History form will not render if glide.ui.escape_text is false.                                                                                                                                                                                       | 1. Set glide.ui.escape_text to false.  
2. View the Upgrade History form. Note the error.                                                                                                                                                                     |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Forms     | PRB630968        | Field labels that are URLs do not display hints | In Fuji, field labels which are URLs do not display hints.                                        | 1. Navigate to Incident > Create New.  
2. Right-click on any field and select Configure Label.  
3. Add a hint and a URL. Then, click Update.  
Note that if you hover over the field, the hint does not display. |
| Email     | PRB593012        | Users are unable to delete Notification Preferences even when the delete ACL allows this | When the delete ACL for cmn_notif_message evaluates to true, the users are still unable to delete notifications. Changing the write ACL to evaluate to true allows deletion. | 1. Create Notification Preferences for user Beth Anglin.  
2. Change the delete ACL for cmn_notif_message to evaluate to true.  
   • On the notification preferences screen for Beth, the notifications now have a red X on the left rather than a greyed out X. However it still can not be deleted.  
   • Note: You can open the individual notification, and delete it using the Delete button.  
3. Change the write ACL for cmn_notif_message to evaluate to true (i.e. remove the conditions and change the script to “true;”)  
4. Note that the notifications can now be deleted.  
The cmn_notif_message writes and deletes ACLs need to evaluate to true instead of only the delete ACL. |
| Update Sets | PRB593707  | Clicking ‘Commit’ multiple times causes multiple commit threads, duplicate update sets, and unique key violations during insert | While loading large update sets, users can click the Commit button multiple times and produce unique key violation errors. | 1. Open a large update set with many new records.  
2. Click the Commit button multiple times.  
Unique key violation commit errors occur. After the commit, you have N update sets (where N is the number of times you clicked Commit). |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog</td>
<td>PRB623955</td>
<td>Recursive ChoiceListGenerator calls can exhaust/throttle semaphores, causing a node to become unresponsive</td>
<td>A throttling mechanism was added in ChoiceListGenerator.java that uses a semaphore set of two semaphores to throttle generator calls. If a thread recursively calls the ChoiceListGenerator, the semaphore set is depleted after two iterations, and used semaphores are not released. Any other threads now also get stuck trying to acquire a semaphore and the node eventually becomes unresponsive.</td>
<td>There are three calls to ChoiceListGenerator.get(ChoiceListGenerator.java), and the third one gets stuck, waiting for a semaphore as the set is set to two by default: Private static GlideProperty: fThrottleSize = new GlideProperty(GLIDE_CHOICELIST_REFILL_RATE, 2)</td>
</tr>
<tr>
<td>Core Platform</td>
<td>PRB638262</td>
<td>Instance unable to complete SOAP requests when using HTTP/1.1</td>
<td>The following error message is returned when attempting to post a significant number of SOAP messages to the instance: ‘505 HTTP Version Not Supported at /opt/nimsoft/perl/lib/site_perl/5.14.2/ServiceNow/Connection.pm line 70’.</td>
<td>1. Create a script to loop through SOAP requests using HTTP/1.1. 2. Use a looping script to post 1000 getRecords SOAP calls to the instance. 3. The loop will break at some random number of calls.</td>
</tr>
<tr>
<td>Discovery</td>
<td>PRB660591</td>
<td>Async - Discovery Sensor jobs causing JVM memory exhaustion on the nodes. Shazzam sensor consuming more memory than usual.</td>
<td>High memory consumption by the Shazzam sensor in Discovery censors jobs most likely causing the JVM memory issue, which is causing nodes to recycle/restart. Even though Shazzam is working as expected, it is consuming more memory than usual.</td>
<td>There are no definitive steps to reproduce the issue; however, the following steps may cause this to reoccur: 1. Browse to Discovery &gt; Discovery Schedules. 2. Add the column Shazzam batch size. 3. For all the schedulers, change the Shazzam batch size from 500 to 5000.</td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>System Applications</td>
<td>PRB644929</td>
<td>System property ‘sn_appclient.repository_base_url’ has the wrong value</td>
<td>Instances upgraded to Fuji Patch 7 may encounter a bug that puts an incorrect value in the repository_base_url field for the ServiceNow Store. The system property sn_appclient.repository_base_url has the value <a href="http://localhost:8081">http://localhost:8081</a> instead of the expected value of <a href="https://apprepo.service-now.com">https://apprepo.service-now.com</a>.</td>
<td>Instances upgraded to Fuji Patch 7 may encounter a bug that puts an incorrect value in the repository_base_url field for the ServiceNow Store. As a result, an administrator on an instance may be unable to update an existing app or install new apps.</td>
</tr>
<tr>
<td>Service Catalog</td>
<td>PRB652048</td>
<td>Reference lookup in $tablet causes error, will not finish loading datatable</td>
<td>Reference lookup variable causes error in tablet view.</td>
<td>Reproduced on a Fuji instance: 1. Log into $tablet.do 2. Open Service Catalog and find the item ‘Report Outage’. 3. Select the magnifying glass next to “What application is down/unavailable?” and watch the console log. The error will appear and halt execution of datatable.do: Uncaught TypeError: Cannot read property ‘sEcho’ of null</td>
</tr>
<tr>
<td>Service Management Core</td>
<td>PRB639806</td>
<td>Custom columns from ‘wm_asset_usage’ did not get migrated to the new ‘sm_asset_usage’ after upgrade from Eureka to Fuji</td>
<td>ServiceNow engineers have identified an error that affects customers upgrading to Fuji or Geneva with the Work Management plugin active. Instances that have additional custom columns added to the tables in the Work Management module may lose those columns and any associated data during the upgrade.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>Update Sets</td>
<td>PRB663698</td>
<td>A StackOverflow during update set commit prevents the post-commit cache flush and causes instance performance degradations</td>
<td>The cache is not being flushed after an update set commit.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Service Mapping</td>
<td>PRB657892</td>
<td>When the CMDB contains large number of CI (millions), the service maps load time is a minute or more</td>
<td>When the CMDB has millions of CIs, the load time for Service Maps is more than a minute. This makes Service Mapping unusable.</td>
<td>Load any business service map.</td>
</tr>
<tr>
<td>Platform Security</td>
<td>PRB646854</td>
<td>NPE during zBoot</td>
<td>A zBoot failed on an instance with a NullPointerException in DefaultRoleUtils.</td>
<td></td>
</tr>
</tbody>
</table>
| Data Certification | PRB663598        | Change in the BR ‘Certification Task Values’ in Fuji causes performance issues      | The Fuji change to the Certification Task Values BR is causing performance issues. Certifying any task takes more than 2 minutes, and the UI becomes unresponsive during that time. This causes the table to handle a large result set. | 1. Navigate to Data Certification > Tasks > Open.  
2. Open any task. Under Activity, you will find the ‘Certifications required for Certification Task TSK0012468’ section.  
3. Pick a user and click the green tick to certify them.  
Note that the system hangs for up to 2 minutes, and the user gets an unresponsive browser popup message. |
| Update Sets        | PRB662273        | Backing out of an update set for a field that is modified that has no history version will result in the column being dropped | A user backed out of an update set where the task.state field was modified, and the field was dropped since there was no baseline history version in the sys_update_history table. It is unclear why the baseline version was missing. The logs from when that version would have been created are gone. | The steps below will require a new instance. The target instance should be a new instance/fresh install.  
1. Create an update set in one instance where the task.state dictionary is modified.  
2. Mark the update set as completed.  
3. Move the update set over to the freshly provisioned instance and commit the update set.  
4. Go to sys_update_version.list from the target.  
5. Do a search for: name contains sys_dictionary_task_state  
Notice that there is no baseline history version. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistence PRB646891</td>
<td></td>
<td>Prevent expensive/unnecessary field widening for table_name fields on typically large tables</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MID Server PRB656700</td>
<td></td>
<td>ECC queue unable to resolve a host with SNC SSH probes when the host contains a host name rather than an IP address</td>
<td>The source validation logic in SourceAsHostProbe is checking for a valid IPv4 address, whereas the configuration on the other side allows names as well.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Affected Plugins</td>
<td>Short description</td>
<td>Description</td>
<td>Steps to reproduce</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------</td>
<td>----------------------------------------------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Foundation PRB664764 |                  | SMTask script include doing cache flush and causing performance degradation on Facilities task | The cacheFlush() is causing high performance impact.  
|               |                  |                                                                | The steps below will require a new instance. The target instance should be a new instance/fresh install.  
|               |                  |                                                                | 1. Log into an application instance on Geneva 3.  
|               |                  |                                                                | 2. Create a Facilities/Service Management task.  
|               |                  |                                                                | 3. Move the task to WIP state and assign it to the user.  
|               |                  |                                                                | 4. Close the task.  
|               |                  |                                                                | Upon change of state from ‘WIP’ to ‘Closed’, the ‘Roll up changes’ business rule calls SMTask. Check the logs and you will see messages resembling the following:  
|               |                  |                                                                | 2016-02-29 14:37:44 (243) Default-thread-8  
|               |                  |                                                                | 4A63444F4F351240C52EB3318110C773 Slow business rule 'ValidateChanges' on facilities_request_task:FCRT0003418, time was: 0:00:01.065  
|               |                  |                                                                | 2016-02-29 14:37:44 (462) Default-thread-8  
|               |                  |                                                                | 4A63444F4F351240C52EB3318110C773 WARNING *** WARNING *** Starting cache flush  
|               |                  |                                                                | 2016-02-29 14:37:46 (508) Default-thread-8  
|               |                  |                                                                | 4A63444F4F351240C52EB3318110C773 Loading properties from DB  
|               |                  |                                                                | 2016-02-29 14:37:46 (540) Default-thread-8  
<p>|               |                  |                                                                | 4A63444F4F351240C52EB3318110C773 WARNING *** WARNING *** Cache flush complete |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Affected Plugins</th>
<th>Short description</th>
<th>Description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
</table>
| Event Management PRB655759 |                  | Upgrading instances with a large amounts of events are repeatedly being restarted by the Memory Watcher due to excessive memory usage in the EventsMigration class, preventing a successful upgrade. | Upgrade-related incidents are caused by instances with a large amounts of events being repeatedly restarted by the Memory Watcher, due to excessive memory usage in the EventsMigration class. This prevents a successful upgrade. | 1. Start an upgrade on an instance with a million or more events.  
2. Observe the memory utilization of the instance during the upgrade.  
Note that the memory is over-utilized, causes repeated restarts, and affects the upgrade. |
| Email PRB645294 |                  | On the notification preferences (notification_preferences) page, schedule reference icon popup closes immediately after opening existing record | This issue has occurred since Fuji and Geneva. When you try opening the reference field schedule on an already-existing record in the notification preferences page for a specific user, the pop-up automatically closes. However, if you do the same on a newly created record, the reference window will remain open until the user closes it. |                                                                                                         |

All Other Fixes
Refer to the PDF attached to [KB0565309](https://support.servicenow.com/tfs/KB0565309).

ODBC Driver patch release notes

The ODBC Driver is updated with each new family release, and problem fixes are included in driver patch updates.

[Download the ODBC driver](https://support.servicenow.com/tfs/KB0565309) from the HI Knowledge Base. For installation and configuration information, refer to [Installing the ODBC driver](https://support.servicenow.com/tfs/KB0565309).
ODBC Driver 1.0.14.01 release notes

The ODBC Driver 1.0.14.01 release contains fixes to these problems.

<table>
<thead>
<tr>
<th>Fixed problem</th>
<th>Short description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Database Connectivity (ODBC) PRB1282816</td>
<td>When a ServiceNow ODBC user types incorrect user credentials, 4 login.failed events are created instead of 1</td>
</tr>
</tbody>
</table>

ODBC Driver 1.0.14 release notes

The ODBC Driver 1.0.14 release contains fixes to these problems.

<table>
<thead>
<tr>
<th>Fixed problems</th>
<th>Short description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Database Connectivity (ODBC) PRB1162624</td>
<td>A ODBC query to a ‘string’ with the value of a field name will translate to the incorrect ‘same as’ query, returning incorrect rows</td>
<td>When using ODBC to query to a ‘string’ that matches the value of a field name, it translates to an incorrect ‘same as’ query. The incorrect query can return the incorrect rows.</td>
</tr>
<tr>
<td>Open Database Connectivity (ODBC) PRB1267497</td>
<td>The JRE was removed from ODBC installers</td>
<td></td>
</tr>
<tr>
<td>Open Database Connectivity (ODBC) PRB1278032</td>
<td>64-bit ODBC Driver fails to connect to instances hosted in FedRAMP datacenter due to TLSv1.2 requirements</td>
<td>FedRAMP data centers no longer allow for connections made with TLSv1.1 or lower. The 64-bit version of the 1.0.13 driver uses JDK 1.8.152, which has been known to have issues with TLS. As a result, the server rejects the connection when falling back to the next highest version. For symptoms, cause, and resolution information, see <a href="#">KB0563593</a> in the HI Knowledge Base.</td>
</tr>
</tbody>
</table>

- ODBC driver installation requirements
- Install the ODBC driver

ODBC Driver 1.0.13 release notes

The ODBC Driver 1.0.13 release contains fixes to these problems.

Download the 1.0.13 version of the ODBC Driver from the HI Knowledge Base.
### Fixed problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRB1110116</td>
<td>ODBC driver returns non-integer fields as NTEXT where varchar is expected</td>
</tr>
</tbody>
</table>

Users cannot use ODBC driver 1.0.11 correctly in combination with:
- SQL Version: Microsoft SQL Server 2014 (SP2-CU2-GDR) (KB3194718) - 12.0.5532.0 (X64) Oct 5 2016 20:28:25
- Copyright (c) Microsoft Corporation Enterprise Edition: Core-based Licensing (64-bit) on Windows NT 6.3 (X64) (Build 9600: ) (Hypervisor)

“SELECT INTO” queries cause the ODBC driver to convert fields to NTEXT where varchar is expected instead.

### ODBC Driver 1.0.12 release notes

ODBC driver product enhancements and updates in the 1.0.12 release.

Version 1.0.12 of the ODBC Driver uses Java 1.8. You may need to configure your Java path after installing this version. See [KB0597981](#) for more information.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRB708941</td>
<td>Querying more than 4MB with ODBC driver creates temp files</td>
</tr>
<tr>
<td>PRB747962</td>
<td>ODBC driver outputting incorrect number of records when using LEFT JOIN ON SELECT * query</td>
</tr>
</tbody>
</table>

### ODBC Driver 1.0.11 release notes

ODBC driver product enhancements and updates in the 1.0.11 release.

Version 1.0.11 of the ODBC Driver uses Java 1.8. You may need to configure your Java path after installing this version. See [KB0597981](#) for more information.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRB711960</td>
<td>When querying a table that has a string field whose value exceeds 65535 kb, the following error occurs: (SN) (ODBC ServiceNow driver) (OpenAccess SDK SQL Engine) Disk cache error. Field length:93238 exceeds maximum limit of 65535</td>
</tr>
<tr>
<td>PRB691056</td>
<td>ODBC query on Display Value for a state does not return the entire Display Value</td>
</tr>
</tbody>
</table>
ODBC Driver 1.0.10 release notes

ODBC driver product enhancements and updates in the 1.0.10 release.

New in the 1.0.10 release

*Improvements to timer and duration fields*  
The display format for timer and duration fields has been improved. Queries on timer and duration fields now return the field value in the UTC timezone. You can query the field display value, as shown in the UI, by adding dv_ to the field name. The property LegacyDurationTimeZone has been added to preserve compatibility with legacy integrations.

*Database schema and caching properties*  
The EnableDBSchema and ExtendedSchemaCache properties enable you to control how the ODBC driver queries and caches database schemas.

Fixed problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Short description</th>
<th>Steps to reproduce</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRB634397</td>
<td>ODBC driver fails to get data or connect when invoking multiple or parallel connections.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>KB0551938</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRB637895</td>
<td>ODBC select query does not return columns in the defined order.</td>
<td>1. Using the ODBC driver version 1.0.9, run a select query.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Note the returned column order is random.</td>
</tr>
<tr>
<td>PRB630646</td>
<td>ODBC driver caches schema between different connections.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>KB0549682</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRB630233</td>
<td>The ODBC driver doesn’t use the SOAP aggregate API for aggregate queries.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>KB0549578</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRB629818</td>
<td>ODBC driver does not optimize select top N queries.</td>
<td>Refer to the listed Known Error KB article for details.</td>
</tr>
<tr>
<td>KB0549557</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Upgrade to Helsinki

The upgrade process moves your instance to a new ServiceNow release version. Understand the difference between upgrading and patching, release definitions, rollback and backup options, and how to test your non-production and production instance upgrades.

Before you begin the upgrade process, review the upgrade and migration tasks for your applications and features. For an in-depth explanation of the upgrade process, refer to Upgrade your instance.

System upgrades can be significant projects. Each ServiceNow feature release includes major additions, and you should always consider the impact of new functionality on an instance. Upgrading implements enhancements to all features that are part of the base system or are already active, unless the feature is customized on your instance. Read the Helsinki Release Notes for information on new and changed features.

Careful preparation and knowledge of the available software, tools, and resources can contribute to a successful upgrade. In addition to the materials provided by ServiceNow, it is important to understand how your ServiceNow instance is currently operating and the performance level of key business functionality. Set the expectation with IT and business users that time must be dedicated to preparing for, implementing, and testing ServiceNow upgrades. For information about features of the ServiceNow platform that assist with upgrades, see Upgrades and conversions.

If you have any issues during the upgrade process, contact ServiceNow Customer Support. ServiceNow Customer Support is available 24 hours a day, 7 days a week to assist you with any questions or issues.

For additional help with upgrades, ServiceNow also offers various Production Readiness Services. These services specifically address challenges with instance upgradability, manageability, scalability, and performance. The reviews are performed by a ServiceNow-certified professional consultant, who provide recommendations to align customer configurations with ServiceNow best practices. Contact your ServiceNow sales representative for more details.

Supported upgrades

You can upgrade directly to the latest release family. If multiple software versions are involved in your upgrade, be sure to consult the release notes for each version between your current version and the target version. For more information about release terminology and availability phases, see the ServiceNow Release Cycle [KB0547244] article in the HI Knowledge Base.

Upgrades vs. patches

ServiceNow organizes its releases into families. A family is a set of releases that are named after a major city, such as or Helsinki. Within a family, releases are further differentiated by patch and hot fix number. For example, the following releases are both part of the Helsinki family:

- Helsinki Patch 6
- Helsinki Patch 3 Hot Fix 2

Upgrading is the act of moving to a release that is in a different family than your current release. For example, a move from Geneva Patch 7 to Helsinki Patch 5 is an upgrade because Geneva and Helsinki are different families.

Patching is the act of moving to a release that is in the same family as your current release. For example, a move from Helsinki Patch 1 to Helsinki Patch 5, is a patch because both versions are part of the Helsinki family.
In both cases, the target release is Helsinki Patch 5. It is the difference between your current and target release family that determines whether you are upgrading or patching.

Features, patches, and hot fixes

Each release family contains features, patches, and hotfixes.

A feature provides a complete solution that customers can implement to add value to their organization. New features are generally only available as part of a feature release. Features are supported with patches and hot fixes.

<table>
<thead>
<tr>
<th>Type</th>
<th>Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature</td>
<td>• Introduces new features&lt;br&gt;• Includes all available fixes to existing functionality&lt;br&gt;• Is production-oriented; quality and stability are of the highest priority throughout the life cycle</td>
</tr>
<tr>
<td>Patch</td>
<td>• Supports existing functionality with a collection of problem fixes&lt;br&gt;• Generally does not include new features</td>
</tr>
<tr>
<td>Hot Fix</td>
<td>• Supports existing functionality with a specific problem fix for a feature release&lt;br&gt;• May or may not include any previous fixes for a given release&lt;br&gt;• Does not include new features</td>
</tr>
</tbody>
</table>

For more information about release terminology and availability phases, see the ServiceNow Release Cycle [KB0547244] article in the HI Knowledge Base.

Rollbacks and backups

When you plan an upgrade, remember that ServiceNow does not provide a universal rollback option. Rollbacks are available for upgrades within the Helsinki family and future releases (for example, Helsinki patch-to-patch and Helsinki patch-to-hotfix). The rollback window is 10 days by default. You can customize this window by modifying the glide.rollback.expiration_days property. To request a rollback, contact ServiceNow Customer Support.

Avoid restoring a production instance from backup, when possible, due to downtime and data loss. When a problem cannot be solved using other methods, restoring a production instance from backup is a final option. ServiceNow can restore an instance to any point in time, regardless of when a backup is completed. ServiceNow provides customer support 24 hours a day, 7 days a week for assistance with critical post-upgrade issues.

Note: ServiceNow does not perform on-demand backups. Instances are automatically backed up daily during non-peak business hours on schedules defined by ServiceNow. The timing of existing backup schedules is not adjusted.

Testing throughout upgrades

Testing is an integral portion that occurs after each instance is upgraded. After you upgrade an instance, test and validate it.
This instance naming convention assumes that you have three ServiceNow instances. If you have three instances, upgrade your instances in this order:

1. Development
2. Test
3. Production

If you have more or less than three instances, or if you are using Team Development, these instance labels will be different. In general, upgrade your instances furthest from production towards your production instance.

<table>
<thead>
<tr>
<th>Instance</th>
<th>Type of testing required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development</td>
<td>• Run a validation test.</td>
</tr>
<tr>
<td>Test</td>
<td>• For extra testing coverage, you can also conduct user acceptance testing (UAT) on your non-production instances.</td>
</tr>
<tr>
<td>Production</td>
<td>• Conduct UAT.</td>
</tr>
</tbody>
</table>

If you encounter any post-upgrade issues, document the issue’s conditions, steps to reproduce the issue, and your customizations. Contact ServiceNow Customer Support to open an incident for each issue, and provide this information accordingly. ServiceNow Customer Support is available 24 hours a day, 7 days a week to assist you with any questions or issues.

Upgrade your instance

Upgrading and patching your instance requires planning, testing, and validation. To ensure a safe and effective upgrade, read the release notes, create upgrade plans, and test your upgrade on sub-production instances before upgrading your production instance.

These topics contain in-depth explanations about upgrades. For a step-by-step reference of upgrade steps, refer to the Upgrade planning checklist (Helsinki).

Phase 1 - Read the release notes and plan your upgrade

Before you begin the upgrade process, it is essential to read the release notes for your target version so you understand the required upgrade and migration tasks. This information helps you plan a safe and effective upgrade.

If multiple software versions are involved in your upgrade, be sure to consult the release notes for each version between your current version and the target version.

1. Read the release notes for your target version. Review upgrade and migration tasks that you will need to complete before or after your upgrade.

ServiceNow provides release notes for every release. The release notes offer valuable information about new functionality, notable changes, and fixes available in a particular version. Read the Helsinki Release Notes to determine whether the upgrade contains functionality you need and fixes that resolve any issues affecting your instance. The release notes can also help you determine whether items you previously customized are being upgraded. For Helsinki-specific upgrade considerations, see Upgrade and migration tasks by application or feature. Refer to the Known Error Portal to quickly locate Known Error articles related to the various releases. For a downloadable, sortable version of Helsinki fixed problems, see KB0598266.
2. Complete the preparation and planning tasks in Phase 2 of the Upgrade planning checklist (Helsinki).

The checklist contains a list of planning tasks that guide you through various aspects of upgrade preparation. You are guided through tasks such as scoping, gathering stakeholders, identifying features to disable and enable, and creating test plans to use throughout the upgrade. Follow these steps to ensure that all aspects of your organization are ready for the upgrade.

3. Create a comprehensive test plan that includes test cases for all core instance functionality and integrations, including any customizations you may have.

To efficiently test and evaluate system functionality, create a set of detailed test scripts for your testing team to use. You will use this test plan throughout each instance upgrade.

<table>
<thead>
<tr>
<th>Instance</th>
<th>Type of testing required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Development</td>
<td>• Run a validation test.</td>
</tr>
<tr>
<td>Test</td>
<td>• For extra testing coverage, you can also conduct user acceptance testing (UAT) on your non-production instances.</td>
</tr>
<tr>
<td>Production</td>
<td>• Conduct UAT.</td>
</tr>
</tbody>
</table>

Phase 2 - Prepare for the development instance upgrade

For a better understanding of your production upgrade duration, request a full clone of your production instance (including large tables and attachments) onto a non-production instance. Confirm your current and target release versions, because you will later use this information when scheduling your upgrade in HI.

1. On your production instance, create a system clone and select your development instance as the Target instance.

   The clone provides you with an exact copy of production. Performing an upgrade on your clone allows you to simulate an upgrade on your production configuration in a non-production environment. Refer to Use system clone for details.

   Important: For effective upgrade testing, use this clone to test on a system that reflects the production instance as closely as possible. If your non-production and production instances are the same size, include the production audit log and the attachment data on your production clone. To ensure that all production data is included with the clone, make sure that you clear all the Exclude check boxes on the Request Clone form. On your non-production instance, replicate typical user behaviors that occur on your production instance to enhance an estimate of your upgrade duration.

2. Set expectations for performance during upgrades.

   During an upgrade, your performance may be impacted because your nodes initiate the distribution upgrade. All nodes are restarted during an upgrade, but your multi-node instances are available during an upgrade because ServiceNow instances operate on a multi-node system. This multi-node system staggers node distribution upgrades, ensuring that there is at least one active pair of nodes for multi-node instances during an upgrade.

   To help you set accurate expectations for performance during upgrades, be aware of the differences between the nodes on your non-production and production instances. Instances with one node experience a short period of downtime during the upgrade, but multi-node instances
do not have UI downtime. For details on your nodes and their status, see the Upgrade Progress screen.

Phase 3 - Verify your upgrade configurations and schedule the development instance upgrade in HI

Check the configuration of the Upgrade scheduled job to view how often and when it runs. Review information about timing your upgrade in coordination with the Upgrade scheduled job. Then, schedule your upgrade in HI.

You must check the configuration of the Upgrade and Check Upgrade Script sys_triggers, which are essential to making sure your instance upgrades to the correct target version.

<table>
<thead>
<tr>
<th>sys_trigger</th>
<th>Function</th>
</tr>
</thead>
</table>
| Upgrade             | • Queries HI to ask whether an upgrade is going to happen in a given time interval, which is determined by the configuration for the Upgrade scheduled job.  
                     | • Asks whether the instance should be running a different version. If so, the distribution for that version is downloaded, and your instance upgrades to the target version. |
| Check Upgrade Script| • Runs after the distribution has been upgraded.  
                     | • Performs the database upgrade. |

Your upgrades are orchestrated out of your instance, not HI.

HI keeps records of what version you should be running, and your instance periodically queries HI to check its assigned version. When you designate a time for your upgrade, your instance begins the upgrade at that time. For example:

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>You schedule an upgrade to Helsinki Patch 8 to take place on June 10 at 3:00pm.</td>
<td>HI changes its records to reflect that you should be on Helsinki Patch 8 on June 10 at 3:00pm.</td>
</tr>
<tr>
<td>HI waits to get pinged by your instance after the scheduled time on June 10.</td>
<td>Your instance continues to operate on its current release version, and it periodically pings HI.</td>
</tr>
<tr>
<td>After the scheduled time on June 10, HI receives a ping from your instance.</td>
<td>HI tells your instance that it should be on Helsinki Patch 8.</td>
</tr>
<tr>
<td>Your instance receives HI’s notification that it should be running a different version.</td>
<td>Your instance starts the upgrade.</td>
</tr>
</tbody>
</table>

1. Check the configuration of the Upgrade scheduled job to view how often and when it runs.
   a) Navigate to System Scheduler Scheduled Jobs Scheduled Jobs.
   b) In the list, find the Upgrade scheduled job.
   c) View the Next action column to determine when the job next runs.

2. Verify that the Upgrade sys_trigger is set properly for upgrading.
   a) Navigate to System Scheduler Scheduled Jobs Scheduled Jobs.
   b) Find and click the Upgrade scheduled job.
   c) Make sure that the Trigger type is set to Interval.
d) Make sure that the System ID is set to None.

3. Verify that the Check Upgrade Script `sys_trigger` is set properly for upgrading.
   a) Navigate to System Scheduler Scheduled Jobs Scheduled Jobs.
   b) Find and click the Check Upgrade Script scheduled job.
   c) Make sure that the Trigger type is set to Run at System Startup.

4. Schedule the upgrade in HI.
   a) Log in to HI.
   b) Click Instances in the left navigation menu.
   c) Select Manage Instances.
   d) (Partners only) From the user menu, use the Switch Company feature to select a company.
   e) Select the instance that you want to upgrade or patch.
   f) In the Actions menu, click Upgrade Instance.
The Upgrade an Instance Service Catalog item opens up. It is prepopulated with the instance name and available versions to which you can upgrade or patch the instance.

g) To specify a date and time for the upgrade or patch, click the calendar icon next to the Start Date and Time field.

h) Click the clock icon to select the time for the upgrade or patch.

Note: Setting the time for an upgrade or patch is important. Set the upgrade or patch to start 10–15 minutes before the Upgrade scheduled job runs. This setting allows enough time for the upgrade or patch request to update HI’s records about which release version your instance should be on before the Upgrade scheduled job runs.

i) Click Submit.

A confirmation message appears. If you do not need an entitlement, a change request is created.
5. If applicable, request a version entitlement.
   a) In the Actions column, click Schedule. If the version does require an entitlement, this screen appears:

   ![Available Versions Table]

   ☀ Entitlement: This version requires entitlement approval. A request will be submitted for review & approval before the upgrade can begin.

   ![Start Date and Time]

   *Due to the additional review that is required, you must select a date at least 3 days from today

   b) Click the calendar icon and specify a date and time at least three days in the future.
   ServiceNow entitlement managers respond to your entitlement request within three days.

   Note: Setting the time for an upgrade or patch is important. Set the upgrade or patch to start 10–15 minutes before the Upgrade scheduled job runs. This setting allows enough time for the upgrade or patch request to update HI’s records about which release version your instance should be on before the Upgrade scheduled job runs.

c) Click Schedule.
   A confirmation message appears. If you need an entitlement, the entitlement request number is included. Click the entitlement request number to view the request.

d) If you have any questions about your entitlement, comment on your entitlement request after you have submitted it.

Phase 4 - Upgrade and validate the development instance

Track the progress of your upgrades with the Upgrade Monitor. For your first non-production instance upgrade (your development instance), use the Upgrade Monitor to process the skipped list of records that were not addressed in the upgrade. Then identify your update sets and perform functional testing.

The Upgrade Monitor helps you upgrade an individual instance. You can monitor the progress of an upgrade and resolve conflicts between the upgrade and customizations.

1. Using the Upgrade Monitor, monitor the upgrade to your instance and validate that the upgrade to your development instance is complete.

2. After the upgrade for your development instance is complete, process the skipped records list in the Upgrade Monitor.
As you are processing the skipped list, you may merge and revert records, resolve conflicts for an individual record, and make additional customizations. These changes go into the latest version, which goes into your current update set.

3. Identify your update sets.

You need these update sets for your subsequent non-production instances. If there are issues that must be addressed after the upgrade, make the appropriate changes and they will go into your current update set. Collect the update sets that:

- Were created while reviewing the skipped updates list.
- Were created while changing customizations to work with the latest release.
- Must go live immediately after your next upgrade.

Gathering these update sets before your upgrade expedites the process of exporting, importing, and committing them onto your other instances. After the correct update sets are identified, follow the standard process for moving and applying those update sets. Refer to Update Sets for details.

4. Before and after upgrading, run a validation test on your development instance. Use your comprehensive test plan to perform functional testing.

After upgrading, track any defects or deviations from the pre-upgrade testing results. Defect tracking can help identify root causes and create fixes. When a fix is identified, capture the fix in a single update set. The resulting update sets hold the cumulative fixes that should be applied to the production instance.

Phase 5 - If applicable: Upgrade and validate your other non-production instances, such as your test instance

If you have any other non-production instances in addition to your development instance, such as a test instance, request to upgrade these instances. Request these upgrades after you have configured and refined your development instance. Immediately after the upgrade is complete, apply the post-upgrade changes made to your development instance, including activating optional plugins, installing and upgrading applications, and applying update sets.

This instance naming convention assumes that you have three ServiceNow instances. If you have three instances, upgrade your instances in this order:

1. Development
2. Test
3. Production

If you have more or less than three instances, or if you are using Team Development, these instance labels will be different. In general, upgrade your instances furthest from production towards your production instance.

After you have applied your development update sets to your test instance, perform the following tasks on your test instance (and other non-production instances, if applicable).

1. Create a system clone down from your production instance.
2. Schedule the non-production upgrade in HI and verify your upgrade configurations.
3. Validate that the upgrade to your non-production instance is complete.
4. Install any optional plugins that were installed on your development instance.
5. Install any custom applications and post-upgrade fix scripts that you need.
6. Install update sets.

Use these update sets to move your initial changes into your subsequent non-production instances.
7. Perform functional testing and monitor the performance of your instance.

Phase 6 - Prepare to upgrade the production instance

After you have configured and refined your test environment to be a good representation of your production environment, prepare to upgrade your production instance.

To ensure that all stakeholders in your company are prepared for the final production upgrade, complete the administrative planning tasks in Phase 6 of the Upgrade planning checklist (Helsinki). When upgrading a production instance:

- Obtain confirmation from IT and management that all non-production instance defects have been fixed, validated, and included in an update set.
- Use the change management process established by your organization to track the upgrade.
- Communicate effectively with your user community regarding changes, new features, and process updates resulting from the upgrade.
- Negotiate a suitable upgrade time for all users of the ServiceNow system.

For example, schedule the upgrade after hours, to minimize impact to your users. Remember to schedule the upgrade to occur 15–20 minutes before the Upgrade scheduled job interval.

- Allow time in your change window to run all test cases and validate that all integrations, key business functionality, and system performance are acceptable. Add a time buffer for responding to errors without breaching the change window.

1. Profile the performance of your instance before upgrading.

   Pre-upgrade instance validation can provide a reliable benchmark of the current operating environment and alert you to any issues that may appear after the upgrade. For example, it sometimes appears that specific functionality is broken by an upgrade. Analysis might show that the functionality did not work properly in the production instance, even before the upgrade.

   Before performing the upgrade, analyze the current operating environment. Specifically, review:

   - Key functionality
   - Integrations
   - Instance performance

2. Use the ServiceNow Performance homepage to document the performance of your instance before the upgrade.

   You will later compare and contrast this information during your post-upgrade validation and testing. Benchmarks will be different for each of your instances.

   To access the ServiceNow Performance homepage:
   a) Log in to your instance.
   b) From the list in the top left of the instance homepage, select ServiceNow Performance.
3. On your clone, perform functional testing and monitor the performance of your instance. Replicate typical user behaviors that occur on your production instance. Assign a consistent core team of power users and key stakeholders to validate important functionality in the ServiceNow instance before and after upgrades.

Phase 7 - Upgrade the production instance

After you have upgraded your development, non-production, and test instances, upgrade your production instance last. Then validate that the upgrade was complete, apply update sets and fix scripts, and perform post-upgrade user acceptance testing (UAT).

1. Schedule the upgrade in HI.
   a) Log in to HI.
   b) Click Instances in the left navigation menu.
   c) Select Manage Instances.
   d) (Partners only) From the user menu, use the Switch Company feature to select a company.
   e) Select the instance that you want to upgrade or patch.
   f) In the Actions menu, click Upgrade Instance.
The Upgrade an Instance Service Catalog item opens up. It is prepopulated with the instance name and available versions to which you can upgrade or patch the instance.

g) To specify a date and time for the upgrade or patch, click the calendar icon next to the Start Date and Time field.

h) Click the clock icon to select the time for the upgrade or patch.

Note: Setting the time for an upgrade or patch is important. Set the upgrade or patch to start 10–15 minutes before the Upgrade scheduled job runs. This setting allows enough time for the upgrade or patch request to update HI’s records about which release version your instance should be on before the Upgrade scheduled job runs.

i) Click Submit.

A confirmation message appears. If you do not need an entitlement, a change request is created.
2. If applicable, request a version entitlement.
   a) In the Actions column, click Schedule.
      If the version does require an entitlement, this screen appears:

      ![Available Versions Table]

      | Available Versions |
      |-------------------|
      | Kingston Patch 3  |
      | Kingston Patch 2  |
      | Kingston Patch 1  |
      | Jakarta Patch 8   |

      **Entitlement:** This version requires entitlement approval. A request will be submitted for review & approval before the upgrade can begin.

      ![Start Date and Time]

      *Start Date and Time*  
      2018-04-19 17:26:28

      *Due to the additional review that is required, you must select a date at least 3 days from today

      b) Click the calendar icon and specify a date and time at least three days in the future.
      ServiceNow entitlement managers respond to your entitlement request within three days.

      Note: Setting the time for an upgrade or patch is important. Set the upgrade or patch to start 10–15 minutes before the Upgrade scheduled job runs. This setting allows enough time for the upgrade or patch request to update HI’s records about which release version your instance should be on before the Upgrade scheduled job runs.

      c) Click Schedule.
      A confirmation message appears. If you need an entitlement, the entitlement request number is included. Click the entitlement request number to view the request.

      d) If you have any questions about your entitlement, comment on your entitlement request after you have submitted it.

3. **Monitor the upgrade to your instance** and validate that the upgrade to your production instance is complete.
   There are several methods of verifying that your upgrade is complete:
   - Navigate to the System Diagnostics Upgrade Monitor.
   - Navigate to System Diagnostics Upgrade Log and locate the Notifying HI that upgrade has been completed message.
   - Navigate to System Definition System Upgrades. Information about all system upgrades is listed.
   - Navigate to System Diagnostics Upgrade History and search for the most recent upgrade.

4. Apply any update sets and post-upgrade fix scripts that you have.

5. Validate and test your instance by conducting user acceptance testing (UAT).
Troubleshooting and other upgrade resources

Use this information to troubleshoot post-upgrade issues and learn more about other aspects of ServiceNow’s upgrade process.

Evaluate log data

Performance and operating information is available in the system logs, which offer an excellent source of information for evaluating the inner workings of a ServiceNow instance. Use this information to help resolve as many errors as possible. To access the log data, navigate to System Logs System Log Errors.

Note: Not all errors in the error log are results of your upgrade. Error messages are often present in pre-upgrade instances, and many of these messages do not affect users or performance.

For a list of other helpful troubleshooting tips, refer to the Troubleshooting upgrade issues article in the HI Knowledge Base.

Other resources

- For an overview of the release cycle and release availability, see the ServiceNow Release Cycle article in the HI Knowledge Base.
- For details about entitlements and scheduled upgrades, see the How to manage entitlements and scheduled upgrades article in the HI Knowledge Base.
- For a list of FAQs about the Quarterly Patching Program (QPP), see the Quarterly Patching Program - Customer FAQ article in the HI Knowledge Base.
- For information about how to track quarterly patches and communicate with ServiceNow, see the Managing your quarterly patches and communicating with ServiceNow article in the HI Knowledge Base.

Upgrade and migration tasks by application or feature

Complete the upgrade tasks where necessary to prepare an application or feature for the upgrade process, and complete appropriate migration tasks after the upgrade to protect your data and customizations from changes to the system.

<table>
<thead>
<tr>
<th>Application or feature</th>
<th>Details</th>
</tr>
</thead>
</table>
| Change Management          | If you have completed an upgrade from a release prior to Geneva, you must perform the following tasks after you activate Change Management core to ensure that change types and customizations are updated.  
  • If you had created newer change types in addition to the default change types, then you must customize them based on the new change types being introduced.  
  • Modify the customizations that are affected to use the new change type values.  
  • If you had the Bulk CI plugin installed, then install the Mass updates CI plugin for enhanced user experience and alignment with the new plugins.  
  For additional upgrade considerations, see Change Management upgrade instructions. |

© 2019 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Application or feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect Support</td>
<td>When you upgrade to Helsinki, you have the option to use either the legacy chat feature or Connect Support. You cannot use the two concurrently. For configuration details, see <a href="#">Connect Support upgrade information</a>.</td>
</tr>
</tbody>
</table>
| Discovery             | • When you upgrade to Helsinki from a pre-Geneva release, you can still use the legacy identifiers provided with your instance or switch to the new CMDB identifiers by setting a system property. It is important to note that if Service Mapping is active on your instance, the CMDB identifiers are always used regardless of the property value. For details, see [Discovery identifiers](#).  
• Upgrades to versions prior to Helsinki Patch 10 can take an excessive amount of time if the Discovery Log (discovery_log) or TCP Connection (cmdb_tcp) table contains a very large number of records. Upgrade performance issues occur when the sys_domain or sys_domain_path fields, used by domain separated systems, are added and populated in these tables. To improve performance, reduce the number of rows in the discovery_log and cmdb_tcp tables prior to upgrading to ensure they contain somewhat less than 1 million rows.  

Important: If you remove records from the TCP Connection (cmdb_tcp) table, be sure to run any required Discovery after the upgrade to repopulate the table. |
| HR Service Management | The Helsinki release contains new items, including a new plugin and HR services. When you upgrade, you must reconcile your custom catalog items and categories with new ones provided in the release. For details, see [Human Resources upgrade information](#). |
| GRC: Policy and Compliance Management | In Helsinki Patch 7 and later releases, the GRC: UCF Import (com.snc.ucf_import_add_on) plugin was deprecated and replaced by the new GRC: Compliance UCF (com.sn_comp_ucf) plugin. See [Policy and Compliance UCF upgrade instructions](#).  

Note: If your GRC effective contract date is before December 1, 2016, you are entitled to a free UCF CCH account for the period of December 1, 2016 through November 30, 2018. For customers on Helsinki (Patch 7 and above), or Istanbul and whose effective GRC contract start dates start on Dec 1, 2016 or after, you need to arrange your own subscription if your organization plans on using Unified Controls Compliance as the provider of your controls library. For more information about establishing a UCF CCH account, see [Unified Compliance](#). |
| Knowledge Management  | Knowledge Management has changed with Knowledge v3, which is enabled by default for all instances. For migration information, see [Knowledge Management v3 migration](#).  
Some of the key differences between Legacy Knowledge and Knowledge v3 are:  
• Multiple knowledge bases (instead of one knowledge base)  
• Separate customizable workflows available for each knowledge base (instead of a single lifecycle shared by all articles)  
• Category structure that supports any number of levels (instead of a two-level organizational structure using Topic and Category)  
• Permissions defined per knowledge base and article, using user criteria (instead of per article, using roles and ACLs)  
For additional upgrade considerations, see the links under [Migrate](#). |
<table>
<thead>
<tr>
<th>Application or feature</th>
<th>Details</th>
</tr>
</thead>
</table>
| MID Server             | - To ensure that your MID Servers can upgrade successfully, run a series of manual tests for free disk space, access to the download server, and file permissions on the MID Server host. For details, see [Test the MID Server before an upgrade](#).  
  
  **Important:** After all MID Servers have been upgraded to Geneva or higher, complete the post-upgrade steps listed in the Workaround section of [KB0597396](#).  
  
  - The MID Server application is downloadable from the ServiceNow service instance. The MID Server is upgraded automatically when you upgrade the instance. However, you can configure the version number to control MID Server upgrades. The MID Server is configured to check with the ServiceNow instance hourly to determine whether it needs to upgrade. This configurable behavior allows the MID Server to upgrade automatically when the instance upgrades.  
  
  - In Helsinki, the MID Server can run SSH commands using either the J2SSH client or the proprietary ServiceNow SNCSSH client. When you upgrade from Dublin or earlier, the MID Server property that controls the SSH client selection is not active in your upgraded instance, and the MID Server will use the J2SSH client by default. To enable the SNCSSH client, you must add the mid.property.ssh.use_snc MID Server property and set it to true. Instances upgraded from Eureka or later have the SNCSSH client enabled by default, and no configuration is required. For details, see [MID Server properties](#). |
| Performance Analytics  | Review [Performance Analytics upgrade information](#) for information about deprecated properties and the potential impact on your configuration from the migration to the new properties. |
| Reporting               | Upgrades from earlier versions of the platform must activate the Report Security plugin manually to avoid overwriting custom ACLs. For instruction about enabling this plugin either before or after the upgrade, see [Reporting upgrade information](#). |
| Web Services            | After upgrading to Helsinki, ServiceNow does not support outbound connections to TLSv1-only endpoints. |

**Upgrade planning checklist (Helsinki)**

Plan and track the activities related to your ServiceNow® instance upgrade. To help ensure that you complete all the tasks for a successful upgrade, follow the step-by-step instructions in the upgrade planning checklist to track and plan the upgrade.

Before upgrading to Helsinki, review the [Upgrade and migration tasks by application or feature](#). For in-depth explanations about upgrades, refer to [Upgrade your instance](#).

The process for completing steps for self-hosted customers may vary (for example, requesting an instance clone or upgrades). These differences must be considered during planning.

To download a PDF version of this checklist, click here.
Phase 1 - Review the Helsinki Release Notes for the target ServiceNow feature release and patch, in addition to product and release documentation.
For Helsinki-specific upgrade considerations, see Upgrade and migration tasks by application or feature. Refer to the Known Error Portal to quickly locate Known Error articles related to the various releases.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Review the Helsinki Release Notes for the target ServiceNow feature release and patch, in addition to product and release documentation. For Helsinki-specific upgrade considerations, see Upgrade and migration tasks by application or feature. Refer to the Known Error Portal to quickly locate Known Error articles related to the various releases.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Phase 2 - Prepare for the development instance upgrade

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Confirm which ServiceNow instances are in-scope for upgrade.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Confirm the instance hosting model. For example, ServiceNow cloud, on-premise, or off-premise.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Based on the Helsinki Release Notes and other release materials, determine new functionality or notable changes that need to be validated after the upgrade.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Confirm plans to enable or disable features introduced in the new product release.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Review the Helsinki Browser support and Exceptions to general browser support to determine browser prerequisites. For example, versions and types supported, and additional requirements for new UI versions. Compare these supported browsers to your corporate standard and identify any gaps.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Create a project plan for cloning, upgrading, and testing.</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Identify the core team of testers, power users, and key stakeholders required to validate functionality in the ServiceNow instances before and after the upgrade.</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Confirm whether there are any internal or ServiceNow change freeze windows impacting the timing for environment clones or upgrades. For example, holidays.</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Confirm which of the following situations applies to your ServiceNow non-production instances: 1. Development and testing can be frozen until the production upgrade is completed. 2. Continued development (and testing) activities need to continue in a non-production instance while upgrade, remediation, and testing activities are performed in parallel on another instance. 3. Once the final upgrade to your production instance is complete, the cloning of your final production instance to your non-production instance will wait until after the production upgrade is complete.</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Confirm the availability of other systems required for integration testing (key resources and environments).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Yes</td>
</tr>
<tr>
<td>---</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>12</td>
<td>Confirm whether there are any restrictions in which ServiceNow instances can be used for integration testing. For example, an interfacing system is only set up to access a specific ServiceNow test instance.</td>
<td>![Yes]</td>
</tr>
<tr>
<td>13</td>
<td>Confirm the testing scope and approach.</td>
<td>![Yes]</td>
</tr>
<tr>
<td>14</td>
<td>Create a comprehensive test plan including test cases for all core instance functionality and integrations.</td>
<td>![Yes]</td>
</tr>
<tr>
<td>15</td>
<td>Confirm the method for tracking any defects identified during testing.</td>
<td>![Yes]</td>
</tr>
</tbody>
</table>
|16 | Create a high-level implementation plan that covers:  
• the sequence and timing to upgrade non-production and production instances  
• the instances to be cloned  
• the instance to be used for integration testing.                                                                                                                                                                                                                                                                                                                                                                         | ![Yes] | ![No] | ![N/A] |
|17 | Confirm whether there are any change freeze windows impacting the timing for environment clones or upgrades. For example, end quarter.  
Responsible: ServiceNow or Customer                                                                                                                                                                                                                                                                                                                                                                   | ![Yes] | ![No] | ![N/A] |
|18 | Determine whether existing internal training materials, Knowledge Base articles in the customer instance, or other supporting documentation must be updated to align with the upgraded version. For example, changes in functionality or user interface.                                                                                                                                                                                                                          | ![Yes] | ![No] | ![N/A] |
|19 | **Optional:** Schedule the ServiceNow Configuration Review, which provides recommendations to align the customer configurations with ServiceNow best practices.  
Note: There may be a service charge and require professional services engagement.                                                                                                                                                                                                                                                                                  | ![Yes] | ![No] | ![N/A] |
|20 | On your production instance, create a system clone and select your development instance as the Target instance. Notify impacted users and internal stakeholders of the scheduled date/time for cloning (from production) and upgrade of the non-production instance.  
Note: It is important to test on a system that reflects the production instance as closely as possible. If your non-production and production instances are the same size, include the production audit log and the attachment data, and ensure that you have deselected the exclude options.                                                                                                  | ![Yes] | ![No] | ![N/A] |

**Phase 3 - Verify your upgrade configurations and schedule the development instance upgrade in HI**

<p>|   | Check the configuration of the Upgrade scheduled job to view how often and when it runs.                                                                                                                                                                                                                                                                                                                                                     | ![Yes] | ![No] | ![N/A] |</p>
<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>Verify that the Upgrade sys_trigger is set properly for upgrading.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Verify that the Check Upgrade Script sys_trigger is set properly for upgrading.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Schedule the upgrade in HI.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>If applicable, request a version entitlement.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Using the Upgrade Monitor, monitor the upgrade to your instance and validate that the upgrade to your development instance is complete.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>After the upgrade for your development instance is complete, process the skipped records list in the Upgrade Monitor.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Identify your update sets.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Before and after upgrading, run a validation test on your development instance. Use your comprehensive test plan to perform functional testing.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>On your production instance, create a system clone and select your development instance as the Target instance.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>Schedule the non-production upgrade in HI and verify your upgrade configurations.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Validate that the upgrade to your non-production instance is complete.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>Install any optional plugins that were installed on your development instance.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Install any custom applications and post-upgrade fix scripts that you need.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Install update sets.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Perform functional testing and monitor the performance of your instance.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Confirm sign-off from IT and Business stakeholders that all non-production instance defects have been fixed and validated in update sets.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Phase 4 - Upgrade and validate the development instance

Phase 5 - If applicable: Upgrade and validate your other non-production instances, such as your test instance

Phase 6 - Prepare to upgrade the production instance
<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>38</td>
<td>Confirm the core team of key stakeholders required to validate functionality in the ServiceNow instance after the production upgrade.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>Confirm coverage for Day 1 support post-upgrade.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Create a Production Upgrade Implementation Plan that includes all upgrade steps, roles and responsibilities, communication plans, key contacts, support coverage for Day 1, and so forth.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>Schedule a walkthrough and sign-off of the Implementation Plan with key stakeholders and the core team.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Submit and obtain approvals for change records as required by the organization change process.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>Send a communication to key stakeholders and end users with details for the production upgrade, new features, and so forth.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Profile the performance of your instance before upgrading.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Use the ServiceNow Performance homepage to document the performance of your instance before the upgrade.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>On your clone, perform functional testing and monitor the performance of your instance.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Phase 7 - Upgrade the production instance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Schedule the upgrade in HI.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>If applicable, request a version entitlement.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td><strong>Monitor the upgrade to your instance</strong> and validate that the upgrade to your production instance is complete.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Apply any update sets and post-upgrade fix scripts that you have.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>Validate and test your instance by conducting user acceptance testing (UAT). Verify with all key stakeholders that the system is performing properly after production upgrade, and key functionality is available.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Upgrade to Helsinki from Fuji**

When you upgrade from the Fuji release to the Helsinki release, understand the fixes in each release version, notable changes for the user interface, browser support, plugin updates, and each feature’s upgrade and migration tasks if applicable.
Release notes for upgrade from Fuji to Helsinki

Before you upgrade from Fuji to Helsinki, read the release notes for information about new features, notable changes, and fixes to existing functionality.

New features and changes in Geneva and Helsinki

Each release family contains new functionality. Read to the release notes for details on the new features and changes in Geneva and Helsinki.

- Geneva release notes
- Helsinki release notes

Patch and hot fix release notes

Patches and hot fixes contain security fixes as well as fixes for products and applications. These fixes are listed in each family’s Available Versions.

- Available versions (Geneva)
- Available versions (Helsinki)

Patch release notes are organized into three sections.

<table>
<thead>
<tr>
<th>Release notes section</th>
<th>Type of information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security-related fixes</td>
<td>Contains a KB article with details on the patch’s fixed security bugs</td>
</tr>
<tr>
<td>Notable fixes</td>
<td>Lists important fixed PRBs in the patch</td>
</tr>
<tr>
<td></td>
<td>Important: Examine the notable fixes in each patch and consider adding them to your upgrade testing plans. For information on how to test different instances during upgrades, refer to Testing throughout upgrades.</td>
</tr>
<tr>
<td>All other fixes</td>
<td>Lists all other fixed PRBs in the patch</td>
</tr>
</tbody>
</table>

Upgrade instructions

After you have reviewed the release notes and patch information to understand all the changes that will be implemented in Helsinki, you can start upgrading your instance. For an overview of the upgrade process, release definitions, and upgrade testing, refer to Upgrade to Helsinki.

For a step-by-step guide through the upgrade process, refer to Upgrade your instance and the Upgrade planning checklist (Helsinki).

User interface and navigation changes in Helsinki

The user interface and some navigational elements have changed in the Geneva and Helsinki releases. List v3 was also introduced in the Helsinki release.
UI16: User interface

UI16 is the most recent of the supported UI versions. In Helsinki, there are no enhancements to the previous UI versions, called UI15 and UI11.

For a comprehensive overview of UI16 and UI15 differences, see the comparison of UI16 and UI15 styles.

UI16

The UI16 interface provides an updated look and usability improvements. Notable features include real-time form updates, user presence, a redesigned application navigator with tabs for favorites and history, and enhanced activity streams. UI16 is the default user interface for new instances. For upgraded instances, an administrator must activate UI16.
Figure 1: UI16 user interface
UI15

Features introduced in the UI15 interface included redesigned icons, the ability to specify when related lists load with a form, other new options on the system menu, and form personalization.

Figure 2: UI15 user interface

UI11

UI11 builds on the classic user interface by adding the Edge and several features including split screen, bookmarks, and flyout windows. UI11 is activated but disabled by default.
List v3 in Helsinki

List v2 is the default version of lists and is supported in all versions of the UI. Users with the admin role can activate List v3, which is supported in UI16 only. Even when List v3 is activated, some UI16 lists may display in List v2. For details, see List v3 compatibility.

For details on how to activate and administer List v3, refer to List v3 administration.

Visual differences between v2 and v3 lists

If you are unsure whether a list is v2 or v3, look for the following identifiers.

- The personalize list gear icon appears in the upper left corner of v2 lists. The personalize list option is located in the list title menu in List v3.
- Page controls appear in the list title bar of v2 lists.
- The list mode toggle appears in the list title bar of v3 lists. You can switch between the standard list mode, called Grid mode, and a Split list and form mode.
- Avatars appear by user names in v3 lists.
- Page controls appear in a footer at the bottom of the page for v3 lists.
- The response time indicator does not appear on the bottom, right of v3 lists. You can create a property to display the response time in milliseconds (ms) on the lower left in the List v3 footer.
Figure 4: List v2 identifiers
Figure 5: List v3 identifiers

For more information on the differences between List v2 and v3, see the [comparison of List v2 and List v3](#).

Navigation and UI components

The navigation and UI components in each UI version have some slight differences.
Table 2: User interface components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banner frame</td>
<td>Runs across the top of every page and contains a logo, global navigation controls, and tools. See <a href="#">UI16 banner frame</a>, <a href="#">UI15 banner frame</a>, or <a href="#">UI11 banner frame</a>.</td>
</tr>
<tr>
<td>Application navigator</td>
<td>Also called the left-navigation bar. Provides links to all applications and modules. See <a href="#">UI16 application navigator</a>, <a href="#">UI15 application navigator</a>, <a href="#">UI11 application navigator</a>.</td>
</tr>
<tr>
<td>Content frame</td>
<td>Displays information such as lists, forms, homepages, and wizards.</td>
</tr>
<tr>
<td>The Edge</td>
<td>A toolbar on the left side of the UI15 and UI11 interfaces that provides quick links to commonly used features. See <a href="#">The Edge</a>.</td>
</tr>
<tr>
<td></td>
<td>In UI16, the Favorites tab of the application navigator, represented by a star, replaces the Edge. The collapsed view of the UI16 application navigator is similar to the Edge.</td>
</tr>
</tbody>
</table>

**Notable changes in Helsinki**

Complete the upgrade tasks where necessary to prepare an application or feature for the upgrade process, and complete appropriate migration tasks after the upgrade to protect your data and customizations from changes to the system.

**Notable changes to applications and features**

<table>
<thead>
<tr>
<th>Application or feature</th>
<th>Details</th>
</tr>
</thead>
</table>
| Change Management      | If you upgraded from a release prior to Geneva, you must [upgrade old state labels](#) to new state labels after you activate the Change Management state model.  
                        | If you have completed an upgrade from a release prior to Geneva, you must perform the following tasks after you activate Change Management core to ensure that change types and customizations are updated.  
                        | • If you had created newer change types in addition to the default change types, then you must customize them based on the new change types being introduced.  
                        | • Modify the customizations that are affected to use the new change type values.  
                        | • If you had the Bulk CI plugin installed, then install the Mass updates CI plugin for enhanced user experience and alignment with the new plugins.  
<pre><code>                    | For additional upgrade considerations, see [Change Management upgrade instructions](#). |
</code></pre>
<p>| Connect Support        | When you upgrade to Helsinki, you have the option to use either the legacy chat feature or Connect Support. You cannot use the two concurrently. |</p>
<table>
<thead>
<tr>
<th>Application or feature</th>
<th>Details</th>
</tr>
</thead>
</table>
| Discovery                              | • The `cmdb_ci_san_disk.wwn` table is deprecated: The World Wide Node (WWN) information contained in the `cmdb_ci_san_disk.wwn` table did not support the discovery of multiple ports related to a single WWN on the storage server. A new table called Fibre Channel Target (`cmdb.fc_target`) replaces the `cmdb_ci_san_disk.wwn` table and supports multi-path connections with these new fields:  
  • WWNN  
  • WWPN  
  • FC Disk  
  • SNMP GETBULK probe parameter: A new parameter enables the use of SNMP GETBULK requests to retrieve large amounts of tabular data from SNMP devices instead of using multiple SNMP GETNEXT requests.  
  • Auto-generated process classifiers deprecated: Automatically generated process classifiers for application dependency mapping are deprecated. The system properties that controlled the creation of these classifiers, glide.discovery.auto_adm and glide.discovery.adm.map_local_connection, are no longer available for new or upgraded instances on the Geneva release. |
| Domain Separation migration to Domain Paths | The Helsinki upgrade migrates all Domain Separated customers to Domain Paths if they are not already running Domain Paths. Two deprecated Domain query methods still exist: Domain Spooling and Domain Numbers. All customers will be moved to the current domain query method, Domain Paths.  
  
To ensure a smooth upgrade, validate the current domain hierarchy before upgrading and fix any inconsistencies that the validation detects.  
  
If a current Domain Separation customer, your upgrade may run slightly longer than normal, but should be complete in one day or less. If your instance has very large tables or extensive customization, the upgrade may require some troubleshooting. Start the Helsinki testing process in your non-production instance as soon as possible.  
  
For more information, see the Helsinki upgrade taking a long time (Domain Separation) HI KB article and the Platform security release notes. |
| Email configuration                    | Starting from the Geneva release, the email accounts plugin is active. Email administrators need to set up their organization’s POP3, SMTP, or IMAP accounts through the Email Account form, rather than email properties. Existing properties for accounts are migrated to email accounts during the upgrade to Geneva. For details, see Email setup. |
| Event Management                       | During an upgrade to the Geneva release, a script converts and moves Event Management rules and events for the release. Even though this script runs automatically, there are additional upgrade tasks that you may need to complete after the upgrade. In addition, the following actions are also affected in Geneva:  
  • Import rules and events  
  • Review imported rules for Event Management  
  • Create a manual service  
  • Import a business service as a manual service  
  • Update manual service relationships  
  
For details, see Upgrade tasks for Event Management |
<p>| Field Service Management Mobile        | The plugin (com.snc.work_management_m) automatically installs or upgrades the Field Service and Mobile UI plugins. |</p>
<table>
<thead>
<tr>
<th>Application or feature</th>
<th>Details</th>
</tr>
</thead>
</table>
| Governance, Risk, and Compliance (GRC)     | • *Legacy functionality (com.snc.governance) has been deprecated.*  
• The common applications, **GRC: Profiles [com.sn_grc]** and **GRC: Common [cpm.sn.grc.common]** were rewritten to provide profiling, continuous monitoring, and issue management functionality to all GRC applications. |
| HR Service Management                      | The Helsinki release contains new items, including a new plugin and HR services. When you upgrade, you must reconcile your custom catalog items and categories with new ones provided in the release. |
| Human Resources                            | • In Geneva, the Human Resources Service Management Service Management: Employee Change plugin was merged into the Human Resources Service Management Service Management: Core plugin.  
• After the upgrade to Geneva, employee change catalog items and workflows will be installed in your instance, even if you did not activate the Employee Change plugin in Fuji.  
• The `{hr_change}` table is merged with the `{hr_case}` table. All HR cases and changes are placed in the `{hr_case}` table and the `{hr_change}` table is removed. Any customizations you made to either table are applied to the `{hr_case}` table.  
• The HR Catalog has been upgraded with a number of new HR catalog items.  
• HR Portal is a new module in the Self-Service menu.  
• Geneva introduces updated and new HR templates.  
• Only active Assignment Rules are preserved during a Fuji-Geneva upgrade. For details, see [Human Resources upgrade information](https://servicenow.com). |
| JavaScript Debugger                        | The JavaScript debugger is no longer available as a debugging tool because problems with breakpoints, data inconsistencies, and scope protections. |
| JavaScript engine update                   | The JavaScript engine used to evaluate scripts has been upgraded to support the ECMAScript5 standard.  
There are no plugins or properties needed to install the new JavaScript engine, and all Helsinki instances use the new JavaScript engine. The new JavaScript engine is part of the platform; and Express, MID Server, and Edge Encryption use the new JavaScript engine.  
The benefits include the following.  
• You can use modern library code, such as lodash.js and moment.js.  
• Your script will follow standard ECMAScript5 behavior.  
The new JavaScript engine is based upon Rhino version 1.7 R5. For more information, refer to [JavaScript engine upgrade](https://servicenow.com). |
<table>
<thead>
<tr>
<th>Application or feature</th>
<th>Details</th>
</tr>
</thead>
</table>
| Knowledge Management  | Knowledge Management has changed with Knowledge v3, which is enabled by default for all instances. For migration information, see Knowledge Management v3 migration. Some of the key differences between Legacy Knowledge and Knowledge v3 are:  
• Multiple knowledge bases (instead of one knowledge base)  
• Separate customizable workflows available for each knowledge base (instead of a single lifecycle shared by all articles)  
• Category structure that supports any number of levels (instead of a two-level organizational structure using Topic and Category)  
• Permissions defined per knowledge base and article, using user criteria (instead of per article, using roles and ACLs)  

For additional upgrade considerations, see the links under Migrate. |
| Legacy custom Discovery identifiers | Custom identifiers created in releases prior to Geneva must be converted to CMDB identifier rules after an upgrade to Geneva to use the new unified framework. When you upgrade to Geneva, your scheduled discoveries can continue to use the identifiers they were configured to use, including any custom identifiers you have created. You can use the CMDB identifiers provided with the Geneva release for new Discoveries or continue to use the legacy identifiers. |
| Import and export | The Sybase and DB2 JDBC drivers are no longer included by default with the MID Server, starting with the Geneva release. If you use the Sybase or DB2 JDBC drivers to access a remote database, you must install the appropriate driver .jar file to a MID Server. See Setting up JDBC with Sybase and DB2 drivers and Add the Sybase and DB2 driver options. |
| MID Server | • To ensure that your MID Servers can upgrade successfully, run a series of manual tests for free disk space, access to the download server, and file permissions on the MID Server host. For details, see Test the MID Server before an upgrade.  

Important: After all MID Servers have been upgraded to Geneva or higher, complete the post-upgrade steps listed in the Workaround section of KB0597396.  

• The MID Server application is downloadable from the ServiceNow service instance. The MID Server is upgraded automatically when you upgrade the instance. However, you can configure the version number to control MID Server upgrades. The MID Server is configured to check with the ServiceNow instance hourly to determine whether it needs to upgrade. This configurable behavior allows the MID Server to upgrade automatically when the instance upgrades.  

• In Helsinki, the MID Server can run SSH commands using either the J2SSH client or the proprietary ServiceNow® SNCSSSH client. When you upgrade from Dublin or earlier, the MID Server property that controls the SSH client selection is not active in your upgraded instance, and the MID Server will use the J2SSH client by default. To enable the SNCSSSH client, you must add the mid.property.ssh.use_snc MID Server property and set it to true. Instances upgraded from Eureka or later have the SNCSSSH client enabled by default, and no configuration is required. For details, see MID Server properties. |
<table>
<thead>
<tr>
<th>Application or feature</th>
<th>Details</th>
</tr>
</thead>
</table>
| OAuth email authentication  | **OAuth 2.0 support** is available starting with the Geneva release.  
- The OAuth implementation supports IMAP and SMTP accounts only.  
- POP3 is not supported.  
- OAuth 1.0 is no longer supported.  
You must activate the [Email - OAuth support for IMAP and SMTP plugin](#) to use OAuth with email. If you upgrade to Geneva or later and are already using OAuth 1.0, activate the plugin again. |
| Performance Analytics      | Review [Performance Analytics upgrade information](#) for information about deprecated properties and the potential impact on your configuration from the migration to the new properties. |
| Reporting                   | Upgrades from earlier versions of the platform must activate the Report Security plugin manually to avoid overwriting custom ACLs. For instruction about enabling this plugin either before or after the upgrade, see [Reporting upgrade information](#). |
| REST Table API version differences | Versions v1 and v2 of the Table API are available. Version v2 is available starting with the Geneva release. For details, see [KB0551763](#). |
| Service Catalog            | In Geneva, the Service Catalog UI changed from UI11 to UI15. |
| Service Level Management   | - The Planned end time field is the Breach time on the Task SLA form in Geneva and later releases.  
- The following SLA Engine properties have been removed in Helsinki:  
  - com.snc.sla.schedule.source  
  - com.snc.sla.timezone.source  
  - com.snc.sla.retroactive_pause  
  - If you are on the 2010 SLA engine, you cannot view the Retroactive pause field.  
  - The SLA properties you can view are based on the SLA engine that you are using.  
    For example, if you are on the 2011 SLA engine, then you can view only SLA 2011 properties. You cannot view SLA 2010 properties such as Compatibility Breach. |
| ServiceWatch, Service Mapping | In the Fuji release, ServiceWatch version 3.6 is a stand-alone product with its own infrastructure including a database, a collector component, the credentials store, and a user interface. In Geneva, the functionality of ServiceWatch is provided by the combined functionality of Event Management, Discovery, and Service Mapping. |
| User interface              | For upgraded instances, administrators may need to activate UI16, the User Guide plugin, and/or the Checklist plugin. For details, see the [User interface release notes](#). |
Changes to activities, identifiers, and tables

<table>
<thead>
<tr>
<th>Type</th>
<th>Product</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orchestration activities</td>
<td>Deprecated activities for Exchange, Active</td>
<td>Orchestration activity packs for Exchange, Active Directory, and PowerShell replace activities by the same name available in releases prior to Geneva. If you have a workflow created in a previous version that uses these deprecated activities, your workflow will continue to work normally after upgrading to Geneva.</td>
</tr>
<tr>
<td></td>
<td>Reactivate a deprecated activity</td>
<td>Orchestration activities that were converted to activity packs in the Geneva release are deprecated for upgraded instances but can be reactivated for use in new workflows.</td>
</tr>
<tr>
<td></td>
<td>Run SCP activity</td>
<td>This activity is deprecated in the Geneva release and is not available for use in new workflows. If you have a workflow created in a previous version that uses this activity, your workflow will continue to work normally after upgrading. The custom Secure Copy activity replaces the Run SCP activity in the Geneva release.</td>
</tr>
<tr>
<td>Discovery identifiers</td>
<td>• Configure Discovery to use CMDB identifiers</td>
<td>In the Geneva release, identifiers for new and existing discoveries are completely replaced for new ServiceNow instances with CMDB identifiers from the CMDB Identification and Reconciliation framework. Instances without Service Mapping that are upgraded to Geneva can still use the legacy identifiers for existing and new Discoveries. Both identifier versions are available in these instances, but only the legacy identifiers are used.</td>
</tr>
<tr>
<td></td>
<td>• Create a Discovery legacy identifier</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Discovery identifiers</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Discovery CMDB identifiers</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Legacy Discovery identifiers</td>
<td></td>
</tr>
<tr>
<td>Planned tasks</td>
<td>Planned Task_v2 plugin</td>
<td>If the Planned Task_v2 (com.snc.planned_taskv2) plugin is active when, the system adds the Task column to the Planned Task [planned_task] table. The Task column is of type Composite Field, and stores the Short Description and Number of the task. During the upgrade, the system updates all records in the Planned Task table to add a value for this column. Expect to see a new date in the Updated column for each task in the system.</td>
</tr>
</tbody>
</table>

Browser support in Helsinki

Browser support varies for each version of the user interface (UI). Most major browsers are supported.

Some features have additional browser requirements, which are noted in the appropriate documentation. Browser versions listed in the following table are the latest public release at the time of testing.
### Table 3: Browser support for each UI version

<table>
<thead>
<tr>
<th>UI version</th>
<th>Chrome support</th>
<th>Firefox support</th>
<th>Internet Explorer support</th>
<th>Microsoft Edge support</th>
<th>Safari support</th>
<th>Tablet mobile browser</th>
<th>Phone mobile browser*</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI16</td>
<td></td>
<td></td>
<td>9 and up</td>
<td>9.1 and up</td>
<td>Supported</td>
<td>Not supported</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Edge mode is supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UI15</td>
<td></td>
<td></td>
<td>9 and up</td>
<td>9.1 and up</td>
<td>Supported</td>
<td>Supported</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Edge mode is supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UI11</td>
<td></td>
<td></td>
<td>9 and up</td>
<td>9.1 and up</td>
<td>Limited support</td>
<td>Limited support</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Edge mode is not supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Mobile phone browsers do not support the desktop version of the UI. Instead, mobile browsers use the mobile browser UI.

### Internet Explorer web browser notes

**Important:** Due to significant performance issues, ServiceNow recommends that customers utilize a modern browser for its products and migrate away from Internet Explorer 11. For more information, refer to [KB0883275](#).

- Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.
- Compatibility mode is not supported.
- Setting Security Mode to High (via Internet Options Security tab) is not supported.
- While UI16 and UI15 are supported on Internet Explorer 9, the browser may be slow when performing some operations. This slowdown does not necessarily indicate a performance degradation in the instance.

### Safari notes

- There is a security issue in some versions of Safari. User credentials may be disclosed to an unexpected site via auto-fill. For more information, see the [Apple security update](#).
- Starting with Safari 9.1 and future versions of Safari, the leave page / stay on page pop-up message only displays once.

### Exceptions to browser support

Certain applications and features in the Helsinki release have browser requirements that differ from the list of browsers generally supported by the ServiceNow platform.
General browser requirements

- Generally supported browsers based on the UI version
- Mobile device requirements

Exceptions to the browser requirements

Table 4: Platform browser exceptions

<table>
<thead>
<tr>
<th>Platform features</th>
<th>Details</th>
</tr>
</thead>
</table>
| **Connect release notes**       | - The latest public release of Firefox or Firefox ESR<br>- The latest public release of Chrome<br>- Safari version 6.1 and later<br>- Internet Explorer version 10 and later  
  - Edge mode is supported.  
  - Compatibility mode is not supported.  
  - Setting Security Mode to High (via the Internet Options Security tab) is not supported.  
  - Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7. |
| **Dependency Views release notes** | The Dependency Views module supports the latest version or service pack of the following browsers:  
  - Firefox with the latest ESR  
  - Chrome version 25 or later (latest version recommended)  
  - Safari version 6 or later  
  - Microsoft Internet Explorer (IE), with these requirements and limitations:  
    - Dependency Views requires IE version 9 or later.  
    - You cannot export images from a Dependency Views map using Internet Explorer as your browser.  
    - When you save a map view, Dependency Views does not make a thumbnail image. You can navigate to the saved map view using the version number. |
| **Email and notifications release notes** | To preview notifications, Internet Explorer version 9 or later is required if you want to use Internet Explorer. |
| **Lists release notes**         | - The latest public release of Firefox or Firefox ESR  
  - The latest public release of Chrome  
  - Safari version 6.1 and later  
  - The latest public release of Microsoft Edge  
  - Internet Explorer version 10 and later  
  - Edge mode is supported.  
  - Compatibility mode is not supported.  
  - Setting Security Mode to High (via the Internet Options Security tab) is not supported. |
## Platform features

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Service Portal release notes</strong></td>
</tr>
<tr>
<td>• Modern browsers</td>
</tr>
<tr>
<td>• Internet Explorer version 10 and later</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Visual Task Boards release notes</strong></td>
</tr>
<tr>
<td>• The latest public release of Firefox or Firefox ESR</td>
</tr>
<tr>
<td>• The latest public release of Chrome</td>
</tr>
<tr>
<td>• Safari version 6.1 and later</td>
</tr>
<tr>
<td>• Internet Explorer version 10 and later</td>
</tr>
<tr>
<td>• Edge mode is supported.</td>
</tr>
<tr>
<td>• Compatibility mode is not supported.</td>
</tr>
<tr>
<td>• Setting Security Mode to High (via the Internet Options Security tab) is not supported.</td>
</tr>
<tr>
<td>• Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.</td>
</tr>
<tr>
<td>• Access Visual Task Boards on your mobile device using either a browser or the native mobile app. See Supported devices for the mobile browser or Supported devices for the mobile app for more information.</td>
</tr>
</tbody>
</table>

### Table 5: ITSM browser exceptions

<table>
<thead>
<tr>
<th>ITSM applications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Guided setup release notes</strong></td>
<td>Use one of the following browsers with the guided setup:</td>
</tr>
<tr>
<td>• Internet Explorer 10 or later</td>
<td></td>
</tr>
<tr>
<td>• Google Chrome 33 or later</td>
<td></td>
</tr>
<tr>
<td>• Mozilla Firefox 28 or later</td>
<td></td>
</tr>
<tr>
<td>• Apple Safari 6 or later</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ITSM applications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On-Call Scheduling release notes</strong></td>
<td>The updated calendar view is available on only Internet Explorer 10 or later. Any older versions of Internet Explorer display the legacy calendar view.</td>
</tr>
</tbody>
</table>

### Table 6: Business Management browser exceptions

<table>
<thead>
<tr>
<th>Business Management applications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Demand Management release notes</strong></td>
<td>If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the workbench.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Business Management applications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Financial Management release notes</strong></td>
<td>If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the workbench.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Business Management applications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project Management release notes</strong></td>
<td>If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the portfolio, program, and project workbenches.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Business Management applications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resource Management release notes</strong></td>
<td>If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the workbench.</td>
</tr>
</tbody>
</table>
Table 7: Service Management browser exceptions

<table>
<thead>
<tr>
<th>Service Management applications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Facilities Service Management release notes</strong></td>
<td>If you are using Internet Explorer, you must use version 9 or later to use the Enterprise Move Planning tool and the interactive maps. You can also use any of the other generally supported web browsers.</td>
</tr>
</tbody>
</table>
| **Field Service Management release notes** | The central dispatch feature is supported on the following browsers:  
  • The latest public release of Firefox  
  • The latest public release of Chrome  
  • Safari version 6 and later  
  • Internet Explorer version 10 and later |
| **HR Service Management release notes** | HR Service Portal requires Internet Explorer version 10 or later. The Manage HR Catalog and Manage HR Skills modules require Internet Explorer version 9 or later. |

Table 8: Performance Analytics and Reporting browser exceptions

<table>
<thead>
<tr>
<th>Performance Analytics and Reporting features</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dashboards release notes</strong></td>
<td>Responsive dashboards are not supported on Internet Explorer 7 and 8.</td>
</tr>
<tr>
<td><strong>Performance Analytics release notes</strong></td>
<td>The animations that play when a visualization loads are not supported in Internet Explorer.</td>
</tr>
</tbody>
</table>

Plugin name changes from Fuji to Helsinki

The Geneva and Helsinki releases contain changes to some existing plugin names.

<table>
<thead>
<tr>
<th>Plugin name before Geneva release</th>
<th>Plugin name in Geneva and later releases</th>
<th>Status in current releases</th>
<th>Changes in Geneva release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management</td>
<td>Change Request</td>
<td>No change in existing releases</td>
<td>Active by default in Geneva instances</td>
</tr>
<tr>
<td>IT Cost Management</td>
<td>Cost Management</td>
<td>No change in existing releases</td>
<td>Not active by default in new Geneva deployments</td>
</tr>
<tr>
<td>Human Resources Service Management core CMS Portal</td>
<td>Human Resources Application: Core</td>
<td>No change in existing releases</td>
<td>Replaced in Geneva by new plugin. This version is not supported in Geneva release. New deployments have only new version.</td>
</tr>
<tr>
<td>Integration – Microsoft SCCM</td>
<td>Integration – Microsoft SCCM 2007</td>
<td>No change in existing releases</td>
<td>After upgrade, existing customers can continue to use this plugin. New customers must use replacement plugin.</td>
</tr>
<tr>
<td>Plugin name before Geneva release</td>
<td>Plugin name in Geneva and later releases</td>
<td>Status in current releases</td>
<td>Changes in Geneva release</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------------------------</td>
<td>---------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Integration – Microsoft SMS / SCCM 2.0</td>
<td>Integration – Microsoft SCCM 2012v2</td>
<td>No change in existing releases</td>
<td>After upgrade, existing customers can continue to use this plugin. Disabled in Geneva. New plugin replaces existing plugin.</td>
</tr>
<tr>
<td>IT Finance</td>
<td>Financial Management</td>
<td>No change in existing releases</td>
<td>Not active by default in new Geneva deployments</td>
</tr>
<tr>
<td>Notify Now</td>
<td>Notify</td>
<td>No change in existing releases</td>
<td>Plugins can co-exist. New plugin is not activated by default. Customers can choose to upgrade to new version or continue to use existing version. New plugin is fee-based and requires activation by ServiceNow.</td>
</tr>
<tr>
<td>Netcool</td>
<td>N/A</td>
<td>Does not exist in Geneva release</td>
<td>Functionality replaced with Event Management, a fee-based plugin activated by ServiceNow upon entitlement verification. See KB0564889 for more information.</td>
</tr>
<tr>
<td>Oracle RAC Support</td>
<td>N/A</td>
<td>Does not exist in Geneva release</td>
<td>Does not exist in Geneva release</td>
</tr>
<tr>
<td>Query Stats</td>
<td>Stats Tools</td>
<td>No change in existing releases</td>
<td>Active by default in Geneva instances</td>
</tr>
<tr>
<td>SCOM</td>
<td>N/A</td>
<td>Does not exist in Geneva release</td>
<td>Functionality replaced with Event Management, a fee-based plugin activated by ServiceNow upon entitlement verification. See KB0564889 for more information.</td>
</tr>
<tr>
<td>SDLC - Scrum Process Pack</td>
<td>Agile Development</td>
<td>No change in existing releases</td>
<td>Not active by default in Helsinki release.</td>
</tr>
<tr>
<td>Service Modeling</td>
<td>Service Model</td>
<td>No change in existing releases</td>
<td>No additional plugin is required. Functionality is incorporated in base CMDB.</td>
</tr>
</tbody>
</table>
Plugin name changes

Changes to existing plugin names in the Helsinki release.

<table>
<thead>
<tr>
<th>Plugin name before Helsinki release</th>
<th>Plugin name in Helsinki and later releases</th>
<th>Status in current releases</th>
<th>Changes in Helsinki release</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDLC - Scrum Process Pack</td>
<td>Agile Development</td>
<td>No change in existing releases</td>
<td>Not active by default in Helsinki release.</td>
</tr>
</tbody>
</table>

Browser support

Browser support varies for each version of the user interface (UI). Most major browsers are supported.

Some features have additional browser requirements, which are noted in the appropriate documentation. Browser versions listed in the following table are the latest public release at the time of testing.

Table 9: Browser support for each UI version

<table>
<thead>
<tr>
<th>UI version</th>
<th>Chrome support</th>
<th>Firefox support</th>
<th>Internet Explorer support</th>
<th>Microsoft Edge support</th>
<th>Safari support</th>
<th>Tablet mobile browser</th>
<th>Phone mobile browser*</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI16</td>
<td></td>
<td></td>
<td>9 and up</td>
<td>9.1 and up</td>
<td></td>
<td>Supported</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Edge mode is supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UI15</td>
<td></td>
<td></td>
<td>9 and up</td>
<td>9.1 and up</td>
<td></td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Edge mode is supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UI11</td>
<td></td>
<td></td>
<td>9 and up</td>
<td>9.1 and up</td>
<td>Limited support</td>
<td>Limited support</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Edge mode is not supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Mobile phone browsers do not support the desktop version of the UI. Instead, mobile browsers use the mobile browser UI.

Internet Explorer web browser notes

Important: Due to significant performance issues, ServiceNow recommends that customers utilize a modern browser for its products and migrate away from Internet Explorer 11. For more information, refer to KB0683275.
• Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.
• Compatibility mode is not supported.
• Setting Security Mode to High (via Internet Options Security tab) is not supported.
• While UI16 and UI15 are supported on Internet Explorer 9, the browser may be slow when performing some operations. This slowdown does not necessarily indicate a performance degradation in the instance.

Safari notes

• There is a security issue in some versions of Safari. User credentials may be disclosed to an unexpected site via auto-fill. For more information, see the Apple security update.
• Starting with Safari 9.1 and future versions of Safari, the leave page / stay on page pop-up message only displays once.

Exceptions to general browser support

Certain applications and features in the Helsinki release have browser requirements that differ from the list of browsers generally supported by the ServiceNow platform.

General browser requirements

• Generally supported browsers based on the UI version
• Mobile device requirements

Exceptions to the browser requirements

Table 10: Platform browser exceptions

<table>
<thead>
<tr>
<th>Platform features</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect release notes</td>
<td>• The latest public release of Firefox or Firefox ESR</td>
</tr>
<tr>
<td></td>
<td>• The latest public release of Chrome</td>
</tr>
<tr>
<td></td>
<td>• Safari version 6.1 and later</td>
</tr>
<tr>
<td></td>
<td>• Internet Explorer version 10 and later</td>
</tr>
<tr>
<td></td>
<td>• Edge mode is supported.</td>
</tr>
<tr>
<td></td>
<td>• Compatibility mode is not supported.</td>
</tr>
<tr>
<td></td>
<td>• Setting Security Mode to High (via the Internet Options Security tab) is not supported.</td>
</tr>
<tr>
<td></td>
<td>• Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.</td>
</tr>
<tr>
<td>Platform features</td>
<td>Details</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------</td>
</tr>
</tbody>
</table>
| **Dependency Views release notes** | The Dependency Views module supports the latest version or service pack of the following browsers:  
  - Firefox with the latest ESR  
  - Chrome version 25 or later (latest version recommended)  
  - Safari version 6 or later  
  - Microsoft Internet Explorer (IE), with these requirements and limitations:  
    - Dependency Views requires IE version 9 or later.  
    - You cannot export images from a Dependency Views map using Internet Explorer as your browser.  
    - When you save a map view, Dependency Views does not make a thumbnail image. You can navigate to the saved map view using the version number. |
| **Email and notifications release notes** | To preview notifications, Internet Explorer version 9 or later is required if you want to use Internet Explorer. |
| **Lists release notes** |  
  - The latest public release of Firefox or Firefox ESR  
  - The latest public release of Chrome  
  - Safari version 6.1 and later  
  - The latest public release of Microsoft Edge  
  - Internet Explorer version 10 and later  
    - Edge mode is supported.  
    - Compatibility mode is not supported.  
    - Setting Security Mode to High (via the Internet Options Security tab) is not supported. |
| **Service Portal release notes** |  
  - Modern browsers  
  - Internet Explorer version 10 and later |
| **Visual Task Boards release notes** |  
  - The latest public release of Firefox or Firefox ESR  
  - The latest public release of Chrome  
  - Safari version 6.1 and later  
  - Internet Explorer version 10 and later  
    - Edge mode is supported.  
    - Compatibility mode is not supported.  
    - Setting Security Mode to High (via the Internet Options Security tab) is not supported.  
    - Internet Explorer 11 is susceptible to memory leaks, which may impact performance, especially in Windows 7.  
    - Access Visual Task Boards on your mobile device using either a browser or the native mobile app. See Supported devices for the mobile browser or Supported devices for the mobile app for more information. |
### Table 11: ITSM browser exceptions

<table>
<thead>
<tr>
<th>ITSM applications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Guided setup release notes</strong></td>
<td>Use one of the following browsers with the guided setup:</td>
</tr>
<tr>
<td></td>
<td>• Internet Explorer 10 or later</td>
</tr>
<tr>
<td></td>
<td>• Google Chrome 33 or later</td>
</tr>
<tr>
<td></td>
<td>• Mozilla Firefox 28 or later</td>
</tr>
<tr>
<td></td>
<td>• Apple Safari 6 or later</td>
</tr>
<tr>
<td><strong>On-Call Scheduling release notes</strong></td>
<td>The updated calendar view is available on only Internet Explorer 10 or later. Any older versions of Internet Explorer display the legacy calendar view.</td>
</tr>
</tbody>
</table>

### Table 12: Business Management browser exceptions

<table>
<thead>
<tr>
<th>Business Management applications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Demand Management release notes</strong></td>
<td>If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the workbench.</td>
</tr>
<tr>
<td><strong>Financial Management release notes</strong></td>
<td>If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the workbench.</td>
</tr>
<tr>
<td><strong>Project Management release notes</strong></td>
<td>If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the portfolio, program, and project workbenches.</td>
</tr>
<tr>
<td><strong>Resource Management release notes</strong></td>
<td>If you are using Internet Explorer, version 11 or later (including Edge) is required to use all aspects of the workbench.</td>
</tr>
</tbody>
</table>

### Table 13: Service Management browser exceptions

<table>
<thead>
<tr>
<th>Service Management applications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Facilities Service Management release notes</strong></td>
<td>If you are using Internet Explorer, you must use version 9 or later to use the Enterprise Move Planning tool and the interactive maps. You can also use any of the other generally supported web browsers.</td>
</tr>
</tbody>
</table>
| **Field Service Management release notes** | The central dispatch feature is supported on the following browsers:  
  • The latest public release of Firefox  
  • The latest public release of Chrome  
  • Safari version 6 and later  
  • Internet Explorer version 10 and later |
| **HR Service Management release notes** | HR Service Portal requires Internet Explorer version 10 or later. The Manage HR Catalog and Manage HR Skills modules require Internet Explorer version 9 or later. |
### Table 14: Performance Analytics and Reporting browser exceptions

<table>
<thead>
<tr>
<th>Performance Analytics and Reporting features</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dashboards release notes</strong></td>
<td>Responsive dashboards are not supported on Internet Explorer 7 and 8.</td>
</tr>
<tr>
<td><strong>Performance Analytics release notes</strong></td>
<td>The animations that play when a visualization loads are not supported in Internet Explorer.</td>
</tr>
</tbody>
</table>

### Accessibility 508 compliance

The instance includes features that support several specifications in Section 508 of the US compliance code to make the interface accessible to users with disabilities.

ServiceNow products are developed with the goal of adhering to the following accessibility guidelines and principles.

- Section 508 Amendment to the Rehabilitation Act of 1973
- Web Content Accessibility Guidelines (WCAG) 2.0 Level A

ServiceNow products are tested with the following assistive technologies.

- **JAWS**
- **NVDA**
- **VoiceOver**

### Voluntary Product Accessibility Template

This page details the level of accessibility support for the Helsinki release, according to Section 508 of the US compliance code. This information is extracted from the official Voluntary Product Accessibility Template (VPAT) document.

**Date:** October 2016

**Product Name:** ServiceNow Service Automation

**Product Version Number:** Helsinki

**Vendor Company Name:** ServiceNow

**Vendor Contact Name:** ServiceNow Compliance

**Vendor Contact Email:** compliance@servicenow.com

### Table 15: Summary table

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Section 1194.21 Software Applications and Operating Systems</strong></td>
<td>Supports with exceptions</td>
<td></td>
</tr>
<tr>
<td><strong>Section 1194.22 Web-based Internet Information and Applications</strong></td>
<td>Supports with exceptions</td>
<td></td>
</tr>
<tr>
<td>Criteria</td>
<td>Level of Support &amp; Supporting Features</td>
<td>Remarks and Explanations</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Section 1194.23 <strong>Telecommunications Products</strong></td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>Section 1194.24 <strong>Video and Multi-media Products</strong></td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>Section 1194.25 <strong>Self-Contained, Closed Products</strong></td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>Section 1194.26 <strong>Desktop and Portable Computers</strong></td>
<td>Not Applicable</td>
<td></td>
</tr>
<tr>
<td>Section 1194.31 <strong>Functional Performance Criteria</strong></td>
<td>Supports</td>
<td></td>
</tr>
<tr>
<td>Section 1194.41 <strong>Information, Documentation and Support</strong></td>
<td>Supports</td>
<td></td>
</tr>
</tbody>
</table>
Section 1194.21 Software Applications and Operating Systems - Detail

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
</table>
| (a) When software is designed to run on a system that has a keyboard, product functions shall be executable from a keyboard where the function itself or the result of performing a function can be discerned textually. | Supports with exceptions | • Header links, buttons, and search input are keyboard accessible.  
• The application navigator is keyboard accessible.  
• Lists and forms are keyboard accessible; Unintended scrolling or focus occurs on lists while navigating with keyboard.  
• Context menus, recent searches and some dialogs are not keyboard accessible.  
• Visual task boards are not keyboard accessible.  
• The default ESS portal is not fully keyboard accessible.  
• Some buttons and controls on the reporting homepage are not keyboard accessible.  
• Some buttons do not have proper text to be read by a screen reader.  
• The transaction timer widget cannot be read by a screen reader. Items cannot be removed from an embedded list on a form without a keyboard.  
• The “More information” link on catalog items is not accessible with a keyboard.  
• Some chat controls are not keyboard accessible.  
• Some form buttons and on-call Rotation are not keyboard accessible.  
• Some pickers are not keyboard accessible.  
• Some fields and links are not keyboard accessible.  
• News area automatically scrolls and cannot be paused.  
• Some interface elements are not keyboard accessible.  
• Legends for certain user interface elements cannot be read by screen readers.  
• Some text is not identified by screen reader.  
• Most pages do not use the LANG attribute to identify the language of the page. |
<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>(b) Applications shall not disrupt or disable activated features of other products that are identified as accessibility features, where those features are developed and documented according to industry standards. Applications also shall not disrupt or disable activated features of any operating system that are identified as accessibility features where the application programming interface for those accessibility features has been documented by the manufacturer of the operating system and is available to the product developer.</td>
<td>Supports with exceptions</td>
<td>• Form elements use default focus indicators.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Some specific pages do not display default focus indicators.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• On lists and forms, the keyboard focus moves to the first editable field on a loaded page. New users may find this confusing.</td>
</tr>
<tr>
<td>(c) A well-defined on-screen indication of the current focus shall be provided that moves among interactive interface elements as the input focus changes. The focus shall be programmatically exposed so that Assistive Technology can track focus and focus changes.</td>
<td>Supports with exceptions</td>
<td>• Visible focus indicators are exposed for the currently displayed element.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Focus state is accessible to Assistive Technology.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Visible focus indicators are not exposed for many items on the default ESS portal page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Form tabs do not have a visible focus state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The What’s New dialog does not handle focus appropriately and is difficult to close without a mouse.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Many dialogs move the keyboard focus appropriately but do not trap keyboard focus within them.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Visual focus is not provided for CMS portal header elements</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Focus is not moving to edit field when adding tags</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Focus does not remain in dialog box until closed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Some elements do not show the default focus indicator</td>
</tr>
<tr>
<td>Criteria</td>
<td>Level of Support &amp; Supporting Features</td>
<td>Remarks and Explanations</td>
</tr>
<tr>
<td>----------</td>
<td>----------------------------------------</td>
<td>--------------------------</td>
</tr>
</tbody>
</table>
| (d) Sufficient information about a user interface element including the identity, operation and state of the element shall be available to Assistive Technology. When an image represents a program element, the information conveyed by the image must also be available in text. | Supports with exceptions | • Alternative text is defined for most images.  
• Reference field autocomplete suggestions are not accessible to Assistive Technology. Users of Assistive Technology can use the reference lookup icon to fill in reference fields.  
• Some page messaging elements are not accessible to Assistive Technology.  
• Some supplementary buttons are not correctly identified to Assistive Technology.  
• Programmatic structure does not portray visual structure. Some pages do not have clear heading text elements. Examples include the email client, homepages, and the default ESS portal.  
• Some information is not provided while navigating home pages, such as the widget title, or how to edit or remove the widgets.  
• User presence status is not read by Assistive Technology.  
• Some changes are not read by assistive technologies  
• Some alternative text for image-links are not consistent  
• Screen readers can have confusing navigation for some page elements.  
• Some buttons do not have alternative text  
• Some elements and widgets do not have roles assigned making it inaccessible to Assistive Technology | |
<p>| (e) When bitmap images are used to identify controls, status indicators, or other programmatic elements, the meaning assigned to those images shall be consistent throughout an application’s performance. | Supports | The product uses a consistent set of icons throughout the interface. Where images are used to convey consistent meanings, the images display the same alternative text. | |
| (f) Textual information shall be provided through operating system functions for displaying text. The minimum information that shall be made available is text content, text input caret location, and text attributes. | Supports | Textual information is accessible to Assistive Technology. | |</p>
<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>(g) Applications shall not override user selected contrast and color selections and other individual display attributes.</td>
<td>Supports with exceptions</td>
<td>The product can be viewed with Windows High Contrast Mode and Mac OSX contrast features. In legacy ServiceNow interfaces, some bitmap images may display poorly with contrast features enabled.</td>
</tr>
<tr>
<td>(h) When animation is displayed, the information shall be displayable in at least one non-animated presentation mode at the option of the user.</td>
<td>Supports</td>
<td>Very few animations are used. Alternative text is specified for animations.</td>
</tr>
<tr>
<td>(i) Color coding shall not be used as the only means of conveying information, indicating an action, prompting a response, or distinguishing a visual element.</td>
<td>Supports with exceptions</td>
<td>In older versions of Microsoft Internet Explorer (IE7-8), mandatory fields are designated with a colored indicator. The field state is accessible to Assistive Technology. The indicator colors can be customized to be black and white. Alternative text is provided to convey information. Some info and error notifications cannot be differentiated by color blind. Some elements are indistinguishable when some dashboards or maps are in high contrast mode. Some color icons for differentiating state do not have corresponding message for screen reader. Color contrast ratio does not meet 4.5:1 Poor contrast on some items Missing underline for some link styles make links difficult to see for color blind users.</td>
</tr>
<tr>
<td>(j) When a product permits a user to adjust color and contrast settings, a variety of color selections capable of producing a range of contrast levels shall be provided.</td>
<td>Supports with exceptions</td>
<td>Many basic product colors can be customized, such as the banner, banner color, and certain elements in form headers. These may be used in a way that does not hinder contrast tools. Setting any of the colors on the BODY or A elements you must set all of them.</td>
</tr>
<tr>
<td>(k) Software shall not use flashing or blinking text, objects, or other elements having a flash or blink frequency greater than 2 Hz and lower than 55 Hz.</td>
<td>Supports</td>
<td>There are no flashing or blinking objects within the platform.</td>
</tr>
<tr>
<td>Criteria</td>
<td>Level of Support &amp; Supporting Features</td>
<td>Remarks and Explanations</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| (l) When electronic forms are used, the form shall allow people using Assistive Technology to access the information, field elements, and functionality required for completion and submission of the form, including all directions and cues. | Supports with exceptions                | • All form fields have labels and are accessible to Assistive Technology.  
• All form submission buttons are accessible to Assistive Technology.  
• Some read-only input fields are not focusable by assistive technologies  
• Some search controls, fields, buttons, and forms are not identified or have labels that do not adequately describe their use.  
• Some form fields disabled by system policy do not have proper labels or are not recognized.  
• The email client, the default ESS portal, homepages, and homepage gauges lack clear headings and labels. These pages, gauges, and popups are not accessible via screen readers or keyboard.  
• The list filter button does not properly indicate if it is collapsed or expanded.  
• Filter breadcrumbs are not read accurately by screen reader  
• For search results, the number of results in each category are not part of the link text  
• Some links, list items and reference fields cannot be read by screen reader. |

Table 16: Section 1194.22 Web-based Intranet and Internet information and Applications - Detail

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>(a) A text equivalent for every non-text element shall be provided (e.g., via “alt”, “longdesc”, or in element content).</td>
<td>Supports</td>
<td>Alternative text is specified for non-text elements.</td>
</tr>
<tr>
<td>(b) Equivalent alternatives for any multimedia presentation shall be synchronized with the presentation.</td>
<td>Not applicable</td>
<td>The product does not use video or audio.</td>
</tr>
<tr>
<td>Criteria</td>
<td>Level of Support &amp; Supporting Features</td>
<td>Remarks and Explanations</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>(c) Web pages shall be designed so that all information conveyed with color is also available without color, for example from context or markup.</td>
<td>Supports</td>
<td></td>
</tr>
</tbody>
</table>
| (d) Documents shall be organized so they are readable without requiring an associated style sheet. | Supports with exceptions | • Some pages display confusing/unnecessary elements without style sheets.  
• Use semantic markup like STRONG instead of using the CSS font-weight property  
• Some pages display text out of order with style sheet turned off |
<p>| (e) Redundant text links shall be provided for each active region of a server-side image map. | Supports | Alternative text is defined for image regions on reports. |
| (f) Client-side image maps shall be provided instead of server-side image maps except where the regions cannot be defined with an available geometric shape. | Supports | Client-side image maps are provided for charts and reports. |
| (g) Row and column headers shall be identified for data tables. | Supports | Tables use body tags appropriately to distinguish between headers and content. |
| (h) Markup shall be used to associate data cells and header cells for data tables that have two or more logical levels of row or column headers. | Not applicable | Multiple rows of column headers are not used. |
| (i) Frames shall be titled with text that facilitates frame identification and navigation. | Supports with exceptions | Frames have title attributes that accurately describe their purpose. |
| (j) Pages shall be designed to avoid causing the screen to flicker with a frequency greater than 2 Hz and lower than 55 Hz. | Supports with exceptions | There are no flashing or blinking objects within the platform with frequency greater than 2 Hz and lower than 55 Hz. |
| (k) A text-only page, with equivalent information or functionality, shall be provided to make a web site comply with the provisions of this part, when compliance cannot be accomplished in any other way. The content of the text-only page shall be updated whenever the primary page changes. | Not applicable | No such page is present because the content is sufficiently accessible to users. |</p>
<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
</table>
| (l) When pages utilize scripting languages to display content, or to create interface elements, the information provided by the script shall be identified with functional text that can be read by Assistive Technology. | Supports with exceptions | • Content created by script contains text that is accessible to Assistive Technology.  
• Chat messages received in real time are not accessible to Assistive Technology.  
• Some content reads confusing/additional information  
• Certain messages are not accessible for screen readers. |
| (m) When a web page requires that an applet, plug-in or other application be present on the client system to interpret page content, the page must provide a link to a plug-in or applet that complies with 1194.21 rows (a) through (l). | Not applicable | Applets, plug-ins, or other applications are not needed to use the product. |
| (n) When electronic forms are designed to be completed on-line, the form shall allow people using Assistive Technology to access the information, field elements, and functionality required for completion and submission of the form, including all directions and cues. | Supports with exceptions | • All form fields have labels and are accessible to Assistive Technology.  
• All form submission buttons are accessible to Assistive Technology.  
• Some fields and buttons are accessed out of order from their respective fields when using Assistive Technology  
• Some text fields are rendered as edit field  
• Some fields and buttons are not part of the tab order |
<p>| (o) A method shall be provided that permits users to skip repetitive navigation links. | Supports | Skip links are provided at the top of the page to lead users to significant areas of the interface. |
| (p) When a timed response is required, the user shall be alerted and given sufficient time to indicate more time is required. | Supports | The product requires no timed responses. |</p>
<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>(a) Telecommunications products or systems which provide a function allowing voice communication and which do not themselves provide a TTY functionality shall provide a standard non-acoustic connection point for TTYs. Microphones shall be capable of being turned on and off to allow the user to intermix speech with TTY use.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(b) Telecommunications products which include voice communication functionality shall support all commonly used cross-manufacturer non-proprietary standard TTY signal protocols.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(c) Voice mail, auto-attendant, and interactive voice response telecommunications systems shall be usable by TTY users with their TTYs.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(d) Voice mail, messaging, auto-attendant, and interactive voice response telecommunications systems that require a response from a user within a time interval, shall give an alert when the time interval is about to run out, and shall provide sufficient time for the user to indicate more time is required.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(e) Where provided, caller identification and similar telecommunications functions shall also be available for users of TTYs, and for users who cannot see displays.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(f) For transmitted voice signals, telecommunications products shall provide a gain adjustable up to a minimum of 20 dB. For incremental volume control, at least one intermediate step of 12 dB of gain shall be provided.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(g) If the telecommunications product allows a user to adjust the receive volume, a function shall be provided to automatically reset the volume to the default level after every use.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>Criteria</td>
<td>Level of Support &amp; Supporting Features</td>
<td>Remarks and Explanations</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>(h) Where a telecommunications product delivers output by an audio transducer which is normally held up to the ear, a means for effective magnetic wireless coupling to hearing technologies shall be provided.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(i) Interference to hearing technologies (including hearing aids, cochlear implants, and assistive listening devices) shall be reduced to the lowest possible level that allows a user of hearing technologies to utilize the telecommunications product.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(j) Products that transmit or conduct information or communication, shall pass through cross-manufacturer, non-proprietary, industry-standard codes, translation protocols, formats or other information necessary to provide the information or communication in a usable format. Technologies which use encoding, signal compression, format transformation, or similar techniques shall not remove information needed for access or shall restore it upon delivery.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(k) (1) Products which have mechanically operated controls or keys shall comply with the following: Controls and Keys shall be tactiley discernible without activating the controls or keys.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(k) (2) Products which have mechanically operated controls or keys shall comply with the following: Controls and Keys shall be operable with one hand and shall not require tight grasping, pinching, twisting of the wrist. The force required to activate controls and keys shall be 5 lbs. (22.2N) maximum.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(k) (3) Products which have mechanically operated controls or keys shall comply with the following: If key repeat is supported, the delay before repeat shall be adjustable to at least 2 seconds. Key repeat rate shall be adjustable to 2 seconds per character.</td>
<td>Not applicable</td>
<td></td>
</tr>
</tbody>
</table>
### Table 18: Section 1194.24 Video and Multimedia Products - Detail

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>(k) Products which have mechanically operated controls or keys shall comply with the following: The status of all locking or toggle controls or keys shall be visually discernible, and discernible either through touch or sound.</td>
<td>Not applicable</td>
<td></td>
</tr>
</tbody>
</table>

(a) All analog television displays 13 inches and larger, and computer equipment that includes analog television receiver or display circuitry, shall be equipped with caption decoder circuitry which appropriately receives, decodes, and displays closed captions from broadcast, cable, videotape, and DVD signals. As soon as practicable, but not later than July 1, 2002, widescreen digital television (DTV) displays measuring at least 7.8 inches vertically, DTV sets with conventional displays measuring at least 13 inches vertically, and stand-alone DTV tuners, whether or not they are marketed with display screens, and computer equipment that includes DTV receiver or display circuitry, shall be equipped with caption decoder circuitry which appropriately receives, decodes, and displays closed captions from broadcast, cable, videotape, and DVD signals. | Not applicable                         |                           |

(b) Television tuners, including tuner cards for use in computers, shall be equipped with secondary audio program playback circuitry. | Not applicable                         |                           |

(c) All training and informational video and multimedia productions which support the agency’s mission, regardless of format, that contain speech or other audio information necessary for the comprehension of the content, shall be open or closed captioned. | Not applicable                         |                           |
<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>(d) All training and informational video and multimedia productions which support the agency’s mission, regardless of format, that contain visual information necessary for the comprehension of the content, shall be audio described.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(e) Display or presentation of alternate text presentation or audio descriptions shall be user-selectable unless permanent.</td>
<td>Not applicable</td>
<td></td>
</tr>
</tbody>
</table>

Table 19: Section 1194.25 Self-Contained, Closed Products - Detail

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>(a) Self contained products shall be usable by people with disabilities without requiring an end-user to attach Assistive Technology to the product. Personal headsets for private listening are not Assistive Technology.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(b) When a timed response is required, the user shall be alerted and given sufficient time to indicate more time is required.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(c) Where a product utilizes touchscreens or contact-sensitive controls, an input method shall be provided that complies with 1194.23 rows (k) (1) through (4).</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(d) When biometric forms of user identification or control are used, an alternative form of identification or activation, which does not require the user to possess particular biological characteristics, shall also be provided.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(e) When products provide auditory output, the audio signal shall be provided at a standard signal level through an industry standard connector that will allow for private listening. The product must provide the ability to interrupt, pause, and restart the audio at anytime.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>Criteria</td>
<td>Level of Support &amp; Supporting Features</td>
<td>Remarks and Explanations</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>(f) When products deliver voice output in a public area, incremental volume control shall be provided with output amplification up to a level of at least 65 dB. Where the ambient noise level of the environment is above 45 dB, a volume gain of at least 20 dB above the ambient level shall be user selectable. A function shall be provided to automatically reset the volume to the default level after every use.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(g) Color coding shall not be used as the only means of conveying information, indicating an action, prompting a response, or distinguishing a visual element.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(h) When a product permits a user to adjust color and contrast settings, a range of color selections capable of producing a variety of contrast levels shall be provided.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(i) Products shall be designed to avoid causing the screen to flicker with a frequency greater than 2 Hz and lower than 55 Hz.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(j) (1) Products which are freestanding, non-portable, and intended to be used in one location and which have operable controls shall comply with the following: The position of any operable control shall be determined with respect to a vertical plane, which is 48 inches in length, centered on the operable control, and at the maximum protrusion of the product within the 48 inch length on products which are freestanding, non-portable, and intended to be used in one location and which have operable controls.</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>(j) (2) Products which are freestanding, non-portable, and intended to be used in one location and which have operable controls shall comply with the following: Where any operable control is 10 inches or less behind the reference plane, the height shall be 54 inches maximum and 15 inches minimum above the floor.</td>
<td>Not applicable</td>
<td></td>
</tr>
</tbody>
</table>
### Table 20: Section 1194.26 Desktop and Portable Computers - Detail

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>(j) (3)</td>
<td>Products which are freestanding, non-portable, and intended to be used in one location and which have operable controls shall comply with the following: Where any operable control is more than 10 inches and not more than 24 inches behind the reference plane, the height shall be 46 inches maximum and 15 inches minimum above the floor.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>(j) (4)</td>
<td>Products which are freestanding, non-portable, and intended to be used in one location and which have operable controls shall comply with the following: Operable controls shall not be more than 24 inches behind the reference plane.</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>(a)</td>
<td>All mechanically operated controls and keys shall comply with <a href="#">1194.23</a> rows (k) (1) through (4).</td>
<td>Not applicable</td>
</tr>
<tr>
<td>(b)</td>
<td>If a product utilizes touchscreens or touch-operated controls, an input method shall be provided that complies with <a href="#">1194.23</a> rows (k) (1) through (4).</td>
<td>Not applicable</td>
</tr>
<tr>
<td>(c)</td>
<td>When biometric forms of user identification or control are used, an alternative form of identification or activation, which does not require the user to possess particular biological characteristics, shall also be provided.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>(d)</td>
<td>Where provided, at least one of each type of expansion slots, ports and connectors shall comply with publicly available industry standards.</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>
### Table 21: Section 1194.31 Functional Performance Criteria - Detail

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>(a) At least one mode of operation and information retrieval that does</td>
<td>Supports with exceptions</td>
<td>The product can be used by users of Assistive Technology that has been implemented for use by the blind or visually impaired. Some fonts do not resize correctly. Some icons break when font is resized.</td>
</tr>
<tr>
<td>not require user vision shall be provided, or support for Assistive</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technology used by people who are blind or visually impaired shall be</td>
<td></td>
<td></td>
</tr>
<tr>
<td>provided.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(b) At least one mode of operation and information retrieval that does</td>
<td>Supports</td>
<td>The product can be operated by users of magnification software. Additionally, the product has been tested with magnification features of modern web browsers.</td>
</tr>
<tr>
<td>not require visual acuity greater than 20/70 shall be provided in audio</td>
<td></td>
<td></td>
</tr>
<tr>
<td>and enlarged print output working together or independently, or support</td>
<td></td>
<td></td>
</tr>
<tr>
<td>for Assistive Technology used by people who are visually impaired shall</td>
<td></td>
<td></td>
</tr>
<tr>
<td>be provided.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(c) At least one mode of operation and information retrieval that does</td>
<td>Supports</td>
<td>User hearing is not required to use the product.</td>
</tr>
<tr>
<td>not require user hearing shall be provided, or support for Assistive</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technology used by people who are deaf or hard of hearing shall be</td>
<td></td>
<td></td>
</tr>
<tr>
<td>provided.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(d) Where audio information is important for the use of a product, at</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>least one mode of operation and information retrieval shall be provided</td>
<td></td>
<td></td>
</tr>
<tr>
<td>in an enhanced auditory fashion, or support for assistive hearing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>devices shall be provided.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(e) At least one mode of operation and information retrieval that does</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>not require user speech shall be provided, or support for Assistive</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technology used by people with disabilities shall be provided.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(f) At least one mode of operation and information retrieval that does</td>
<td>Supports</td>
<td>Fine motor control or simultaneous actions are not required to use the product.</td>
</tr>
<tr>
<td>not require fine motor control or simultaneous actions and that is</td>
<td></td>
<td></td>
</tr>
<tr>
<td>operable with limited reach and strength shall be provided.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 22: Section 1194.41 Information, Documentation and Support - Detail

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level of Support &amp; Supporting Features</th>
<th>Remarks and Explanations</th>
</tr>
</thead>
</table>
| (a) Product support documentation provided to end-users shall be made available in alternate formats upon request, at no additional charge. | Supports                               | • Official product documentation is available on the [ServiceNow Product Documentation site](https://servicenow.com/product.documentation).  
• The product supports alternative sources to be specified for documentation. If specific documentation is needed, it may be authored to cater to specific needs of end-users. |
| (b) End-users shall have access to a description of the accessibility and compatibility features of products in alternate formats or alternate methods upon request, at no additional charge. | Supports                               | Electronic versions of accessibility features can be provided upon request. |
| (c) Support services for products shall accommodate the communication needs of end-users with disabilities. | Supports                               | Support is delivered via email, phone, or by accessing HI. |
Index

A
Accessibility 508 Compliance 612, 612
Activation
Plugin 50
Assessments
release notes 51
Asset Management
release notes 6

B
browser requirements 603, 609

C
Change Management
release notes 7
Cloud Management
release notes 13
CMDB
release notes 33
configuration management
release notes 33
Connect
release notes 38
Connect Support upgrade information 41
Core platform
release notes 41
credentials
release notes 14
Customer Service Management
release notes 55

D
Dashboards 65
Demand Management
release notes 23
Dependency Views
release notes 42
Discovery
release notes 14

E
Edge Encryption
release notes 43
email and notifications
release notes 44

F
Facilities Service Management
release notes 56
Field Service Management
release notes 57
Financial Management
release notes 29

G
GRC
release notes 25

H
Helsinki
release notes 5
how to upgrade 570
human resources
upgrade information 60
Human Resources
release notes 57

I
Import and export
release notes 42
Incident Management
release notes 8
ITSM Guided Setup
release notes 44

K
Knowledge
release notes 45

L
Lists
release notes 45

M
MID Server
release notes 18
migration procedures 570
mobile
release notes 47

N
Normalization Data Services
release notes 48
Notify
release notes 48

© 2019 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
O

ODBC
  release notes 568, 568, 569
On-Call Scheduling
  release notes 9
Orchestration Core
  release notes 19

P

Password Reset
  release notes 21
patching 570
Performance Analytics
  release notes 66
Performance Analytics upgrade information 68
  platform security
    release notes 49
Platform upgrades
  release notes 49
Plugin
  activation 50
plugin names 606, 608
pre-upgrade procedures 570
Procurement
  release notes 10
Project Management
  release notes 29

Q

QPP 570

R

Release Management
  release notes 30
release notes
    platform upgrades 49
    update sets 52
    workflow 54
Release notes
  Asset Management 6
  Change Management 7
  Cloud Management 13
  Connect 38
  Core platform 41
  credentials 14
  Customer Service Management 55
  Demand Management 23
  Dependency Views 42
  Discovery 14
  Edge Encryption 43
  email and notifications 44
  Facilities Service Management 56
  FeatureName 51
  Field Service Management 57
  Financial Management 23
  GRC 25

Helsinki 5
Human Resources 57
Import and export 42
Incident Management 8
ITSM Guided Setup 44
Knowledge 45
Lists 45
MID Server 18
mobile 47
Normalization Data Services 48
Notify 48
ODBC 568, 568, 569
On-Call Scheduling 9
Orchestration Core 19
Password Reset 21
Performance Analytics 66
  platform security 49
Procurement 10
Project Management 29
Release Management 30
Resource Management 30
Security Incident Response 62
Service Catalog 10
Service Level Management 11
Service Portal 50
Studio 31
Subscription Management 12
System Diagnostics 51
Threat Intelligence 63
Time Card 51
User interface 32, 590
Visual Task Boards 52
Vulnerability Response 64
Web services 53
Release Notes
  Service Mapping 22
release notes Event Management 16
release notes Service Analytics 16
Reporting 69
Reporting upgrade information 70
resolving upgrade conflicts 570
Resource Management
  release notes 30

S

Section 508
  US compliance code 612, 612
Security Incident Response
  release notes 62
Service Catalog
  release notes 10
Service Level Management
  release notes 11
Service Mapping
  release notes 22
Service Portal
  release notes 50
Studio
  release notes 31
Subscription Management
   release notes 12
Survey Management
   release notes 51
System Diagnostics
   release notes 51

T
Threat Intelligence
   release notes 63
Time Card
   release notes 51

U
update sets
   release notes 52
upgrade and migration tasks 583, 597
upgrade history 570
upgrade information
   human resources 60
upgrade instance 570
upgrade to Helsinki 589
US compliance code
   Section 508 612, 612
user interface
   browser support 602, 608
User interface
   release notes 32, 590

V
Visual Task Boards
   release notes 52
Voluntary Product Accessibility Template 612, 612
VPAT 612
Vulnerability Response
   release notes 64

W
Web services
   release notes 53
workflow
   release notes 54